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rnaBA 1

BeeneHue

1.1

MNMpeaoucnosue

Ho6po mnoxanoBaTh Ha Harl Kypc! Mbl OKaxeM BaM, Kak Jierko u 3gdgexkruBHo ucnonb3oBath QGIS. Eciu Bb
HOBHYOK B GIS, MbI paCCKaXX€M, 4TO BaM HYXXHO JIA Ha4daJia. Ecnu BBl ONBITHEII I0JIb30BATEJIb, Bbl YBUIUTE, KAK
QGIS BoinosHsAET Bce (PYHKIUU, KOTOPBIE BBl O:kUAaeTe oT mporpamMmsl GIS, u mHoroe apyroe!

1.1.1 MNMouemy QGIS?

IMockonbKy UH(pOpPMALIKS CTAHOBUTCS BCe 0oJiee 0CO3HABAEMOM POCTPAHCTBEHHO, TO 3[€Ch HET HEIOCTATKA B MH-
CTPYMEHTaX, KOTOpbIe MOTYT BBIMOJIHATh HEKOTOPbIE WM BCe (PYHKIIMM, IMPOKO uctonb3dyembie B GIS. Tlouemy
rcnosb3oBaTh uMeHHO QGIS u kakoBa 3Ta MporpaMMa Mo CpaBHEHUIO ¢ IPYTUMU MPporpaMMHbIMU Taketamu GIS?

Bor mumb HEKOTOPLIC MTPUYUHDIL:

Ona 6ecnaamuasi, kKaxk npu decnaamuom 0ob6ede. YCTaHOBKA 1 Mcnosib30BaHue rporpaMmbl QGIS He motpedyer
OT Bac HUKAKKX JEHEXKHbIX 3aTpaT. HUKakux nepBoHavalIbHBIX B3HOCOB, HUKAKHX MEPUOIIMUECKUX IUTATEXeEH,
HHYETO.

OHa becnaamuas, maxk Kax sA6aaemcst omkpuimoui npozpammoti. Eciu Bam HyXKHbI JOHNOJHUTESIbHbIE (DYHKIUU
B QGIS, BB MOXeTe He MPOCTO HAJEAThCs, UTO 3TH (PYHKIMH OyIyT BKJIIOUYEHBI B BHIXO]L CIIEIYIOIIEH BEPCHH.
Bbl MOXeTe CIIOHCHPOBAaTh pa3padoTKy (DYHKIMH WK JOOABUTH €€ CAMOCTOSITEJIBHO, €CJIH BBl 3HAKOMBI C ITPO-
IPaMMHPOBAHHEM.

Ona nocmosinio pazeusaemcsi. IIOCKONIbKY KaxXAblii MOXET H00aBIATh HOBble (DYHKLIMM M YJIydllIaTh CyIe-
creylome, QGIS Hukoraa He crout Ha Mecrte. Pa3spaboTka HOBOro MHCTpYMEHTa MOXKET MPOUCXOIHUTh Ha-
CTOJIBKO OBICTPO, HACKOJIBKO BaM 3TO HYXHO.

Jocmynna obwupras dokymenmauyusi u novmousp. ECn BB Ha 9e€M-TO 3aCTPsUIN, BBl MOXKETe OOPaTUThCA K
OOLIMPHON JOKyMEHTALMH, K JIpyruM noss3oBatensam QGIS um gaxe k pa3paboTunkaMm.

Kpocc-naamgpopmenrocmo. QGIS moxHo ycraHoBUTh Ha MacOS, Windows u Linux.

TCHCp]), KOrZla Bbl 3HAETE, IOYEMY Bbl XOTUTE HUCIIOJIbL30BATH QGIS, HJaHHBIC YIIPA)KHEHHA BAaC HAY4aT TOMY, KaK 9TO
CIOCJIaTh.
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1.1.2 MNMpennocbinku

B 2008 romy mbl 3anyctuim Kpartkoe BBeaeHue B GIS, aOcomoTHO GeCIIaTHBIA pecype ¢ OTKPBITHIM KOHTEHTOM JUIs
JIOJIeH, KOTOpbIe XOTAT NMoy4nTh MHpopmaimio o GIS, He neperpykeHHyI0 MpodecCHOHATBHBIM XaproHOM U HO-
BOW TepMHHOJI0rHei. [IpoekT 6bu1 cioHcHpoBaH npaBuTeabcTBoM FOx)HOM AdpuKy 1 nMen (peHOMEeHaIbHBIN yCTIeX:
JIOJM CO BCEro MUpa IMUCAIM HaM, YTOOBI paccka3arb O TOM? KaK OHH HCIIOJIB3YIOT ST MaTepUaIbl AJ1s1 IPOBECHUS
00y4aloIMX KypcoB B yHHBepcHUTeTax, camooOyuenus GIS u tak nanee. Kpatkoe BBelieHHe - 9TO He YYeOHUK IO
MPOrpaMMHOMY OOECIIEUCHHIO, a CKOpee COCTAaBJISAJICA KaK OOIIMA TEKCT i TeX, KTo u3ydaeT GIS (XoTs mMbl uc-
nosp3oBas QGIS Bo Beex npumepax). Takske umeercs: pykooactBo QGIS, B KOTOpoM NpejcTaBlieH NOIpOOHBIH
(pyakumonanbHbIil 0630p npunoxenus: QGIS. OnHako OH CTPYKTYpHpOBaH He Kak yyeOHoe rmocodue, a Kak CIpa-
BOYHOE pyKoBoncTBO. B xommanun Jluapuantn Koncantuar CuCw/ Linfiniti Consulting CC, Tak Kak MBI 4acTo
MPOBOJMM y4eOHBIE KypChl, MbI ITOHSIJIN, YTO HEOOXOIMM TPETUI pecypc - TOT, KOTOPBIN BEJET YHTaTe s OCeJ0Ba-
TEJIbHO Yepe3 u3yueHue KioueBbix acnekToB QGIS B popmarte «TpeHep-yueHHK», 4TO U NOOYANIIO HAC BBIIIOJIHHUTh
3Ty padoTy.

3t0 yuebHOE ocoOHe MpeaHa3HAYEHO VISl IPEeJOCTaBICHNsI BCEX MaTepHasloB, HEOOXOUMBIX ISl IPOBEICHUS 5-
nueBHoro kypea o QGIS, PostgreSQL u PostGIS. Kypc cTpyKTypHpOBaH TAKUM 00pa3oM, 4TOObI YIOBJIETBOPHUTh
NOTpeOHOCTH KaK HOBMYKOB, TaK M MPOABMHYTHIX HOJIb30BaTeNEH, U COAEPXUT MHOKECTBO YIIPAKHEHUH ¢ aHHOTH-
POBaHHBIMH OTBETAMH IO BCEMY TEKCTY.

1.1.3 JluueH3unsa

@00

BecruatHoe yue6Hoe nocoone Quantum GIS kommnanuu Linfiniti Consulting CC ocHOBaHO Ha paHHeW Bepcuu
ot kommanuu Linfiniti 1 umeet nmunensuio ot ~Creative Commons Attribution 4.0 International ~_. Pa3spemenus,
BBIXO[IAIINE 32 PAMKH IAHHOU JIUIIEH3UH, JOCTYITHBI 110 CChUTKE HITKE.

MBei onyOuiKoBasu 310 yyeOHoe nocodue o QGIS ¢ nuieH3upoBaHrueM Ha CBOOOJHBIX YCIOBUSIX, KOTOPAsi MO3BO-
JISIET BaM CBOOOJTHO KOIMPOBATh, U3MEHSITh M PACIIPOCTPAHATD 3Ty padoty. [loHas Bepcus JUIEH3MH JOCTYITHA B
KOHIIe 9TOro goKymeHTa. IIpoire roBopsi, pyKoBOJCTBO MO HCIIOJIb30BAHMIO 3aKJIIOYAETCS B CIISAYIOIIEM:

¢ Brl He MoxeTe NpeaACTaBJIATb JaHHYIO pa60Ty KaK CBOIO COGCTBéHHyIO, a TaK¥Ke yJaJIdTb Kakue-1ob0 aBTOPp-
CKME TEKCTbI NI CCBUJIKM Ha 3Ty pa60Ty.

* Bbl He MOXkeTe IepepacnpesessaTh 9Ty padoTy ¢ Gojiee OrpaHUYEeHHBIMU Pa3peLIeHUsAMH, YeM Te, B COOTBET-
CTBMU C KOTOPHIMU OHA Obl/Ia IIPEOCTABIICHA BaM.

 Ecnu BBI ITpojenany cyImecTBeHHYIO YacTh paOOTH, a 3aTeM BHOCHTE 3TO B IPOEKT (110 KpaitHe! Mepe, OuH
TIOJIHBI MOZYJIb), TO BBl MOXXETe JOOABUTh CBOE MM B KOHEI! CIMCKA aBTOPOB JJAHHOTO JOKYMEHTa (KOTOPHI
MOSIBUTCS Ha TIEPBOY CTPAHUIIE).

¢ Ecnu BBl BHOCUTE HEe3HAUMTE/IbHbIC U3BMEHEHUS U HCIIPaBJICHU A, Bbl MOXETE )106aBI/IT]) ce0s1 B CIUCOK y4dact-
HHUKOB HUIKC.

* Eciu Bbl IepeBouTe ITOT JOKYMEHT MOJHOCTBIO, BbI MOKETE JOOABUTH CBOE UMS B CIIMCOK aBTOPOB B (hopme
«IlepeBeneno ko buorre».

¢ Eciu BH CIIOHCHpYETE MOYJIb HITH YPOK, BBl MOXETE MOMPOCUTh aBTOPA BKJIIOYUTH OJIArOIapHOCTh B HaYase
KaXJIOTO YPOKa, Halpumep:

IIpumeuanue: CrioHCOpOM JAHHOIO Ypoka siBisieTcss komnanus MegaCorp.

* Ecnu BB He yBepeHbI B TOM, YTO IMEHHO BBl MOKETE JIeJIaTh B paMKax TOU JIMIIEH3UH, CBSKUTECh C HAMHU IO
anpecy office@linfiniti.com, Mbl MOACKakeM BaM, IIPUEMJIEMO JIM TO, YTO BBl COOMpPAETECH CIEIIaTh.

* Ecnu BB pazMmernaere JaHHYI0 paboTy Ha BeOcaiTe CaMOCTOSITEIbHOTO pa3MeleHus], TAKOM Kak https://www.
lulu.com, MbI IPOCKUM Bac MOKePTBOBAThH MPUOBLIL TpoekTy QGIS.
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* BbI He MOJKeTe UCIOIB30BATh JAHHYIO pab0Ty B KOMMEPUYECKHX LeJIsX, 32 HCKJIIOUEHHEM CITy4aeB, Koraa pas-
pelleHNs] aBTOPOB ObUIM UMU IpeJocTaBieHsl. 1 sICHOCTH, o] KOMMepLMaIu3anyell Mbl IoJpa3yMeBaeM,
YTO BBl HE MOXETE MPOJAABaTh MPOIYKT C LEJIbIO MOIy4YeHHs: TPUOBUIH, CO31aBaTh MPOU3BOJHbBIE KOMMEpYe-
CKHe paboThl (HarpuMep, poJaBaTh KOHTEHT VIS NCTIOJb30BaHMS B Ka4eCTBe CTaTeil B XypHase). Mckmoye-
HHUEM SIBIISIOTCS CTydad, KOT/Ia Best NpUOBUTH Harpapisiercs: mpoekTy QGIS. Bel MoskeTe (1 MBI peKOMEHyeM
BaM 3TO [eJaTh) UCHOJb30BaTh 3Ty pabOTy B KayecTBe YUeOHHMKa IIPH NPOBEACHNN Y4eOHBIX KYpCOB, Jaxe
€CJIM caM Kypc HOCHT KOMMEpUYecKHil Xxapakrtep. [Ipyrumu ciioBamu, Bbl MOXeTe 3apa0aThiBaTh JASHBIHU, IPO-
BOJs y4eOHBIH KypC, B KOTOPOM 3Ta paboTa MCIOJIb3yeTCs B KauecTBe YueOHHMKa, HO Bbl HE MOXETE TI0JIy4aTh
NpUOBLIH OT MPOAAXKU CAMOW KHUTH - BCsI Takasi MpUOBUIb J10JKHA ObITh Bo3BpaleHa B QGIS.

1.1.4 CnoHcopcKue rnasbl

JaHHas paboTa HU B KOEM Cllydae He SIBISETCs MOJHBIM TPAKTaTOM 000 BCEM, UTO Bbl MOxkeTe aenath B QGIS, 1 MbI
NPU3bIBaEM Bac JI00aBJISATh HOBbIE MAaTEPUAIbl, YTOOBI 3aMOTHUTS JoObie npodesbl. Kommanus Linfiniti Consulting
CC MOKeT TakKe CO3/1aBaTh JUIsl BaC JOMOJHUTENIbHbIE MaTEpHaAJIbl B KAUeCTBE KOMMEPUECKON YCIIYTH, C TIOHUMA-
HHMEM TOrO, YTO BCE TOJOOHBIE PadOTHI HOJKHBI CTATh YAaCThIO OCHOBHOIO KOHTEHTAa M Pa3MEINaThCs MOA TOH ke
JINIEH3UEN.

1.1.5 ABTOpbI
* Propurep Tune (rudi@linfiniti.com) - Pyau Hanmucan matepuaisl A1 uHCTpykimu o QGIS u yacTe Matepu-
anos PostGIS.

e Tum Carron (tim@linfiniti.com) - HaOMOOAT ¥ PYKOBOJUJ MPOEKTOM, & TakXke ObUI CO-aBTOPOM 4acTei
PostgreSQL u PostGIS. Tum Takke sIBIISIETCS aBTOPOM TEMBI «C(PUHKC», UCTIONB3YEMON STUM PYKOBOJICTBOM.

» Xopcr Hioctep (horst.duester@kappasys.ch) - XopcT sBisercs coaropoM B yactu PostgreSQL u PostGIS.

e Mapcenb CarroH (marcelle@linfiniti.com) - Mapcens obecrieurBaia BHIYMTKY ¥ peJaKIIMOHHBIE COBETHI BO
BpeMsI CO3JaHusI 3TON pabOTHI.

1.1.6 UHamBnayanbHble BKNag4Yuku

31ech JOJIKHO OBbITH Balle uMs!

1.1.7 CnoHcopbl

¢ Texnomornmueckuit yausepcutet Kevin [leanncyna Cape Peninsula University of Technology.

1.1.8 UcxomHble channbl M 0TYETHI O Npobnemax
Hcroynuk naHHOTO MOKyMeHTa joctyneH Ha GitHub “QGIS Documentation repository ~_. IIpokoHCYIbTHpPY#TECH
¢ "GitHub.com *_ jy1s osty4eHnst MHCTPYKLIMHA O TOM, KaK HCIIOJb30BaTh CUCTEMY KOHTPOJISI BEPCHH git.

HecmoTpst Ha Bce HallM YCUITHS, BbI MOXETe HAUTH KOe-KaKue OIMOKYU MM MPOIMYCTUTh KaKy0-HUOYab nHGOpMAa-
1LIUI0 B X0jie JaHHOTO Kypca. [Toxkanyiicra, coobiute o HuX Ha https://github.com/qgis/QGIS-Documentation/issues.
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1.1.9 MNMocnenHasa Bepcus

BbI Bcerzia MoXeTe oJy4uTh NOCJIEAHIO BEPCHIO JAHHOTO JOKYMEHTA, OHJIAWH BEPCHUIO, KOTOpast SIBJISIETCS YaCThIO
QGIS Ha BeO-caiite nokymeHtauu, nocetus (https://docs.qgis.org).

IIpumeuanne: Ha BeG-caiiTe JOKyMEHTAllMM MMEIOTCSI CChUIKM KakK Ha OHJIAH-Bepcuio, Tak U Ha PDF-Bepcuio
Yue6noro nocodust u apyryio nokymentanuu QGIS.

1.2 06 ynpaxHeHusIX

TCHCp];, KOr'la Bbl 3HACTE MOYEMY Bbl XOTUTC UCIIOJIb30BATb QGIS, MbI MOXKEM IIOKa3aThb BaM, KakK 3TO J€J1aThb.

Mpenynpexenue: [[aHHBIN KypC BKIIOYAET B ce0s1 MHCTPYKIIMU MO TOMY KaK H00aBUTh, YAAIUTh U H3MEHUTD
Habops! JaHHbIX GIS. B 9THX 11e/1aX Mbl IpeJoCcTaBiIM yueOHble HAOOPHI AaHHBIX. [Ipexie 4eM HCIoJIb30BaTh
OIMCaHHbIE 3[IECh METOJIBI [JTs BAIIIMX COOCTBEHHBIX JAHHBIX, BCET/Ia MPOBEPSITE HATMYKE HAUICKAIUX PEe3ePB-
HBIX KOITU!

1.2.1 Kak ucnonb3oBatb AaHHOe PyKOBOACTBO

JlioGoit TekcT, KOTopbiit looks like this OTHOCUTCS K YeMY-TO, UTO Bbl BUMTE B MOJIb30BaTeIbckoM uHTepdeiice QGIS.
TekcT, koTophii looks » like » this BefeT Bac yepe3 Bce MEHIO.

Takoro popatekcT This kind of text OTHOCHTCS K YEMY-TO, UTO Bbl MOKETE HaneanaTb/Ha6paTb, HarpuMmep,
KOMaHay.

Takoro/popa/Tekct.text This/kind/of . text OTHOCHUTCS K IyTH WIX UMEHHU (paiina.

Takoi+Takoit This+That OTHOCHTCS K KOMOMHALIMK KJIABMIII, COCTOSIIIEH U3 IBYX KHOIIOK.

1.2.2 Uenn MHOroypoBHEBOro Kypca

,HaHH])Iﬁ KYpC OPUEHTUPOBAH Ha PAa3HbIC [TOJIb30BATEILCKUE YPOBHU. B 3aBucumocTu ot TOrO, K KaKou KaTEeropuu Bbl
OTHOCHUTECH, Bl MOKETE OKNIAATh PA3HBIC Ha60pbl PE3YJIbTATOB KypcCa. Ka>1<11a51 KaTeropus COACpKUT I/IHq)OpMaIII/IIO,
KOTOpasA BakHa A1 Hocnenylou_lef/i, IMO3TOMY Ba’KHO BBIIIOJIHATH BCE YIIPA’KHCHU A, KOTOPBIC COOTBETCTBYIOT BAlLIEMY
TOJIb30BATEJIbCKOMY YPOBHIO WJIM HUKE BAILIETO IMOJIb30BATEILCKOI'O YPOBHA.

\ Ba3oBbin

B nanHHO¥ KaTeropuy Kypc IpearionaraeT, 4Yto y Bac MMeeTcsi HeOOJIbIION MM COBCEM OTCYTCTBYET OIBIT B TEOpe-
THYECKUX 3HaHusIX B obnactu GIS witu pabotsl ¢ mporpamMmmubiM obecrieueHrem GIS.

HaGounbiias teoperrueckas 6a3a Bce ke Oy/ieT npeocTaBiieHa [1J1st 00bsSICHeHHs LeJIU ASHCTBUS, KOTOpPOE Bbl Oyere
BBIMOJIHATH B MPOrpaMMe, HO YIOp JIE/IaeTcsi Ha 00y4YeHre Ha COOCTBEHHOM OITBITE.,

[To 3aBepiieHMH Kypca Bbl MOJYYUTE JIydlllee MpeacTaBlieHre 0 BO3MOXHOCTSX GIS 1 o ToM, Kak UCIOIb30BaTh €€
BO3MOXHOCTH ¢ rTomompio QGIS.
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/ CpenHun

B 1aHHOW KATeropuu MpEAIoJIaraeTcs, YTo y Bac eCTh padouue 3HAHKSI M OIBIT MOBCEAHEBHOIO HCIIOIB30BAHMUS
nporpaMmmuoro odecrieuenus GIS.

[MpuMeHeHne UHCTPYKIMIA ISl HAYaIbHOTO YPOBHSI IACT BaM 3HAKOMYIO 0a3y, a TaKKe PACCKakeT O Ciydasix, Korjaa
QGIS paboTaer HECKOJIbKO MHAYE, YEM JIPYroe MporpaMMHoe obecriedeHre, K KOTOPOMY Bbl, BOSMOKHO, IIPUBBIKJIN.
Brl Takke y3HaeTe, Kak IpUMeHATh (pyHKIMM aHamu3a B QGIS.

ITo oxOHYaHKMH Kypca Bbl HAyYHTeCh UCIIONIb30BaTh Bee (pyHKIMH QGIS, KoTophle 00BIYHO HEOOXOAMMBI IS TOBCE-
JTHEBHOT'O UCIIOJIb30BaHUS.

e [1pO00BUHYTbIN

B HaHHOfI KaTeropyuu npeanojaractcs, 4ro y BacC €CTb OIIbIT pa6OTI>I C IMPpOrpaMMHbIM obecrieueHreM GIS, 3HAHUA
" OIIBIT pa60TbI C IPOCTPAHCTBEHHBIMU Gazamu HJaHHBIX, IPUMEHCHUE JaHHBIX Ha YAaJICHHOM CEPBEPE, BO3BMOKHO,
HanmrcaHne CleHapueB JId aHaJIn3a U T..1.

[TpumeHneHre MHCTPYKIMI JUTS IBYX JPYTUX YPOBHEN MO3HAKOMHUT Bac C MOAXO0JOM, KOTOPOMY CiedyeT uHTepdeiic
QGIS, u obecrieunT BaM 3HaHHME TOrO, KaK MOJIyYUTh JOCTYI K OCHOBHBIM (DyHKIMSIM, KOTOpPbIE BaM HYKHBI. Bam
Takke OyJIeT MoKa3aHo, KaK MCIOJIb30BaTh cucteMy ruarnHoB QGIS, nocrym k 6a3e JaHHBIX U Tak Jajee.

Mo okOHYaHKUM Kypca Bbl JOJKHBI ObITH XOPOILIO OCBEJOMIIEHBI O MOBceaHeBHOU padote ¢ QGIS, a Takxke ¢ ee Gonee
CJIOKHBIMH (DYHKITHSIMU.

1.2.3 LlaHHble

O6pa3m>1 JaHHBIX, MTPUJIAra€MbI€ K 9TOMY PECYPCY, HAXOOATCA B CBO60,HHOM AOCTYIIE U NOCTYNAIOT U3 CIIEAYIOIUX
HUCTOYHHUKOB:

» Habops! qanneix Yiunsl 1 Mecta / Streets and Places u3 OpenStreetMap (https://www.openstreetmap.org/)

 I'panunpl codctBenHocTH / Property boundaries (ropoickue u cenbckue), BojgHble 00bekThl U3 NGI (http:
/lwww.ngi.gov.za/)

* PaguonokavionHas ronorpacdudeckas muccus martia / SRTM DEM or CGIAR-CGI (http://srtm.csi.cgiar.
org/)

3arpysure HOAroTOBJIEHHBI HA00P JaHHbIX U3 YueOHoro Perosutopusi / Training data repository ¥ pa3apXxuBupyiite
(paiin (Zip). Bce HeoOXoamMble JaHHBIE HAXOIATCS B Mallke exercise_data (ynpakHeHUs JaHHBIE).

Ecnu BBl HHCTPYKTOP M XOTHUTE UCIIOIB30BATh OOJIBIIIE COOTBETCTBYIOMIMX JaHHBIX, BBl HalijeTe MHCTPYKIIH IO CO-
3IAHUIO JIOKAIBHBIX JaHHBIX B MPIIOKeHUH [I0AroToBKa JaHHBIX s yIpaxkHeHul / [loozomoska Oanmbix ons 3a-
HAMUIL.
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FMABA 2

Mopynb: Co3naHue n ndyyeHne 6a3oBon kapTbl

B naHHOM MO[yJie BB co3mamuTe 6a30BYI KapTy, KOTOpas Oy/AeT MCHOJIb30BaThCs MO3KE B KAUSCTBE OCHOBHI JIJIS
JATBHENINX JeMOHCTpanuil (pyHKImoHansHOCTH QGIS.

2.1 3aHsiTne: 0630p MHTEpPChenca

Mei u3yurM noJib3oBatesbckuil nHTepdeiic QGIS, 4ToObl Bbl 03HAKOMUIIKCH C MEHIO, NAHEJbI0 UHCTPYMEHTOB, MO-
JIOTHOM KapThl ¥ CIIUCKOM CJIOEB, KOTOpbIe 00pa3yioT 0a30ByI0 CTPYKTYpy UHTepdeiica.

Ieanb 3TOro 3aHATHS: OHATH OCHOBBI N0JIb30BaTeNbCKOro UHTepdeiica QGIS..
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2.1.1 \ Monpo6ynte camu: OCHOBbI

*Basic Map - QGIS 0c62abed96 [tm] - @ x

Project Edit View Layer Settings Plugins Vector Raster Database Web Processing Help

BRRR @*LLsHPPA 1 e N -EH-LME%* S = 5 w-e
8 : 153 @ B
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D R ¢ e gy
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Layers | Browser 6
Typet X | 1.egend entres removes. Coordinate|20.3420,33.9989 |85 Scale 132869 |~ | @ Magnifier|100% 2| Rotation [0.0° |3| v/ Render @ EpsGia326 @)

DIeMeHTaMH, YCTAHOBJIEHHBIMHI Ha KAPTUHKE BBIIIIE, SIBJISIOTCS:
1. Crucok cnoeB / maHesb Opay3epa
. TlaHenm MHCTPYMEHTOB
. IonoTHO KapThl

2

3

4. Ctpoka COCTOSIHUSI

5. BokoBas maHesb HHCTPYMEHTOB
6

. Ilanemn JIOKaTopa

\ Cnucok cnoés

B Criicke c10eB Bbl MOXKETE YBHUAETH CITUCOK BCEX NOCTYIHLIX BaM CJIOEB B nodoe BpeMs.

Ecmu PACKPBITb CBEPHYTHIC SJIECMEHTBL (K)’II/IKHyB CTPEJIKY UJIM IUTIOCUK PAOOM C HI/IM), BbI IOJTYYUTE JONIOJTHUTEJIBHYIO
I/IHq)OpMaIII/IIO O TEKYIIEM BHCIITHEM BU/IE CJIOA.

ITpn HaBegeHNN Kypcopa Ha CJIOM Bbl MOJIyYHTE HEKOTOPYIO OCHOBHYIO MH(DOPMAIMIO: UMsI CJIOSI, TUI TEOMETPHH,
CHCTeMY KOOPAAMHAT U TIOJIHBINA MyTh MECTOIOJIOKEHHUS Ha BallleM YCTPOICTBE.

Kk HpaBOﬁ KHOITKOW MBIIIIH I10 CJIOI0 OTKPOET BaM MEHIO CO MHOKECTBOM HOINOJHUTEJIbHBIX Ol'[I_II/Iﬁ. Bhi CKOpO
6yHCTC HCTIOJIb30BATh HEKOTOPLIE U3 HUX, TAK YTO HpI/ICMOTpI/ITCCI)!

IIpumeuanne: BeKTOpHBIN CIIOW - 3TO HAOOP JIAHHBIX, OOBIYHO COCTOSIIIMA U3 OOBEKTOB OIMPEIEICHHOIO THIIA,
TaKMX KaK JOPOTH, AePeBbs U T.1. BEKTOPHBIN CJI0Il MOKET COCTOSATh U3 TOUYEK, TMHUIA MIIH MOJUTOHOB.

8 FnaBa 2. Mogynb: Co3naHue u ndyyeHne 6a3oBow KapTbl
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MaHenb 6pay3epa

Bpaysep QGIS - 310 nanenp QGIS, koTopast MO3BOJISET JIETKO MepeMeIaThcs Mo 0a3e JaHHBIX. Y Bac MOKET ObITh
JOCTYII K OOIIMM BeKTOpHBIM (haiinam (Hanpumep, aitiam ESRI Shapefile nimn Maplnfo), 6a3am naHHbIX (Harpu-
Mmep, PostGIS, Oracle, SpatiaLite, GeoPackage nmu MSSQL Spatial) u cszssm WMS / WES. Bbl Takkxe Moxerte
npocMoTpeTh cBoM JaHHble GRASS.

Eciu Bl COXpaHWIIM MPOEKT, MaHeb Opay3epa Takxke MPeJoCTaBUT BaM OBICTPbIN JOCTYIT KO BCEM CIIOSIM, XpaHsi-
o * .
IIIAMCSI TI0 TOMY K€ TIyTH K (hailily mpoeKTa Project Home.

Kpome Toro, Bbl MOXeTe cO3AaTh OJHY MJIM HECKOJIBKO Aok B KayecTse M30paHHBIX: BHIIOJIHUTE OKMCK 110 CBOEMY
MYTH U, KaK TOJIbKO Bbl HalJIeTe Marky, KIMKHUATE ee MPaBoil KHOIMKOW MBI U BbiOepute [J06aBUTh B M30paHHOE

Add as a Favorite. [locne 3TOro Bol CMOXKETE YBUJIETh CBOIO MArky B VI30paHHBIX Favorites.

Coet: MoXeT CIIyuuThCs TaK, YTO MANKH, JoOaBIeHHbIE B MI30paHHOe, MMEIOT OUeHb UIMHHbIE UMeHa: He Oecro-
KOWTECh, KJIMKHUTE TIPaBOM KHOIKOW MBIIIK TyTh U BeiOepuTe [lepenmeHoBaTh n3bpanHoe Rename Favorite.
. ., 4TOOBI 33]aTh APYroe MMsl.

\ MaHenb MHCTPYMEHTOB

Hawubornee yacTo ucrosb3yeMbie HAOOPbI HHCTPYMEHTOB MOKHO IPeoOpa3oBaTh B MaHEb UHCTPYMEHTOB ISl OC-
HOBHOTrO Joctyna. Hampumep, nanenb MHCTpYMeHTOB Paiil MO3BOJISIET COXPAHATh, 3arpykaTh, pacrevaThiBaTh U
3aIyCKaTh HOBBII MPOEKT. Bbl MOKETE JIErKO HACTPOUTh MHTEPGENC TaK, YTOOBI OTOOPAKATUCH TOJBKO HauboIee
YaCTO UCHOJIb3yeMble UHCTPYMEHTDI, JI00ABJIsIs WM yasisisl MaHeId MHCTPYMEHTOB [0 Mepe He0OXOIUMOCTH C MO-
MoIlpio MeHIo View » Toolbars.

Jlaxe eciim OHM He OTOOPAXKAIOTCs Ha TaHe M MHCTPYMEHTOB, BCE BAIllM MHCTPYMEHTBI OCTaHYTCs JOCTYITHBIMU Yepe3
MeHIo. Harmpumep, eciu Bbl yJaauTe naHeab MHCTPYMEHTOB File (B KOTOpoii ecTh kHoMKa CoxpaHUTb Save), BBl Bce
PaBHO CMOXXETe COXpaHUTh KapTy, KJIMKHYB MeHIo [IpoekT Project a 3aTteM HaxaB Save.

\ MonoTtHo KapThl
3pech oToOpaxaercs cama Kapra M 3arpyxaiorcst cjion. Ha rmosjoTHe KapThl Bbl MOXKETe B3aUMOJIEHCTBOBATH C BU-

JUMBIMH CJIOSIMU: IPUOJIMIKATD / OTAANATH, EpeMelaTh KapTy, BHIOMpaTh (PYHKIIMK MU MHOTHE JpYrHe olepaluy,
KOTOpbIE MbI IOAPOOHO PACCMOTPUM B CJIEAYIOLIUX pa3fieliax.

\ CTtpoka cocTosiHus

ITokaspiBaeT BaM MHGOPMALMIO O TeKyLel Kapte. Takxke M03BoJIsieT HaCTpauBaTh MacIuTald KapThl, HOBOPOT KapThl
U BUJIETh KOOP/IMHATHI KypCcOpa MBbIIIN Ha KapTe.

2.1. 3aHsatmne: 0630p MHTepcpenca 9
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\ MaHenb MHCTPYMEHTOB

Ilo YMOJTYaHUIO boxkoBas manenpb HUHCTPYMEHTOB COACPKUT KHOIIKU JIA 3arpy3KHU CJIOS U BCE KHOIIKU U1 CO3JaHNUA
HoBoro cjost. Ho TIOMHHMTE, YTO Bbl MOXETE NEPEMECTUTH BCE NMAHEIN MHCTPYMEHTOB B moboe y,HO6HOC IJId Bac
MECTO.

\ MaHenb nokaropa

Ha naHHO¥ naHe M Bbl MOXeTe MOJTyYHTh JOCTYII OUTH KO BceM oObekTam QGIS: ciosiM, hyHKIIMSM CJI051, aJITOPHT-
MaM, IPOCTPAHCTBEHHBIM 3aKJIafikaM U T.1. [IpoBepbTe Bce pas3inyuHble napaMeTpsl B paszesne Hactpoiiku okatopa
locator_options PykoBoacrtsa nosns3oBatens QGIS.

Coget: C nomorpio couetanusi KiaBuil Ct r1+XK yBbl MOKETE JIETKO HOJIYUYUTh JOCTYII K TaHEeH.

2.1.2 \ Monpobynte camm 1

[lommbiTaliTech OIPEAC/IUTD YETBIPE IJIEMEHTA, IEPEYNCIICHHBIX BbIIIE, HA COOCTBEHHOM 9KpaHe, HE 06pau1aacr> K 1ua-
rpaMMe BbIIIIE. HOCMOTpI/ITG, CMOJKETE JIX BbI OIIPEACTIUTh UX HAUMCHOBAHWA 1 (pyHK]_[I/II/I. Bu JIy4qlI€ NIO3HAKOMUTECH
C 9TUMH JIEMEHTAMM 110 MEPE UX UCIIOJIb30BAHUA B OnmKkanie JHU.

Hp06’€[7bl’l’[€ ceou pesynomamoul

21.3 \ Monpobynte camm 2

[MonbiTaiiTech HAWTH KaX bl MHCTPYMEHT Y ce0s1 Ha 9KkpaHe. Kakoe y HUX npeqHazHayeHue?

I
2 O
3. N

4. ERender

5. mm

IIpumeuyanne: Ecnu Kakod-1mO0 M3 3THMX MHCTPYMEHTOB HE OTOOpa)kaeTcsl Ha SKpaHe, MOMpOOyHTe 3aIyCTHTh
HEKOTOpBbIE TaHeJI HTHCTPYMEHTOB, KOTOPBIE B HAaCTOsAIIee BpeMs CKPBITHL. Takxke UMeiiTe B BUly, UTO €CJIM Ha SKpaHe
HEJJOCTATOYHO MECTa, [TaHeJIb THCTPYMEHTOB MOXET OBITh YKOPOUEHA M CKPhIBATh HEKOTOPBIE MHCTPYMEHTHI. Bbl Mo-
JKeTe YBHAETb CKPBIThIE MHCTPYMEHTHI, KIIMKHYB Ha KHOIIKY C ABOMHOM CTPEJIKOH BIPaBO Ha JI00O0 TaKOH CBEPHYTOM
MIaHe/IM MHCTPYMEHTOB. Bbl MOxeTe yBUIETh BCIUIBIBAIOLIYIO TIOJCKA3Ky ¢ Ha3BaHUEM JIIOOOTO MHCTPYMEHTa, yaep-
’KMBas1 KypCop MBIIIN HaJl THCTPYMEHTOM HEKOTOPOe BpeMsl.

Hpasepbme ceou pes3ynomdaniovl

10 MnaBa 2. Moaynb: Co3paHue n nsydyeHme 6a3oBomn KapTbl
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2.1.4 Yto panbwe?

Temneps, Korga Bel 3HaKOMBI ¢ ocHOBamM uHTepdeiica QGIS, B cienyomem 3aHATHM BBl YBUANTE, KaK 3arpy3uTh
HEKOTOPBIE PACIIPOCTPAaHEHHbIE TUIIbI JAHHBIX.

2.2 3aHsiTue: [lobasnsiem BaLiu nepBble CIION

Mmn 3allyCTUM MNPUJIOKECHUE U CO30a UM 6a3013y10 KapTy 4JId UCHIOJIb30BAHWA B IIPUMEPAX U YIIPAKHEHUAX.

Iless 3TOro 3aHATHS: HaUYaTh pabOTy C 0OPA3LIOM KapThl.

Ipumeuanne: [Ipexe yeM IPUCTYIHTH K STOMY YIIPAXXHEHUIO HA BallleM KOMITbIOTepe, HeOOXOJMMO YCTaHOBHUTh
QGIS. Kpome Tor0, BB IOJKHBI OBUTH 3arpy3UTh sample data sl ACTIONH30BAHHUS.

Banycrure QGIS c ero sipibika Ha paboyeM CToJie, IyHKTa MEHIO U T.[., B 3aBUCUMOCTH OT TOTO, KaK Bbl HACTPOWJIH
€ro yCTaHOBKY.

IIpumeuanne: CKPHUHIIOTH AJIs JaHHOTO Kypca Opun cienansl B QGIS 3.4 ma Linux. B 3aBucHMOCTH OT Bammmx
HACTPOEK, CKPUHBI, C KOTOPHIMH BBl CTAJIKUBAETECH, MOTYT BHIIVISAIETh HECKOIBKO MHAYe. OIHAKO BCE Te K€ KHOIKU
No-TIpexxHeMy OyyT JOCTYIHbL, & MHCTPYKIMs OyzeT padotars Ha modoi OS. Bam neodxoquma QGIS 3.4 (nocnen-
HsIsl BEPCUSI HA MOMEHT HATIMCAHUS) [Tl yYacThsl B IAaHHOM Kypce.

JaBaiiTe HaUHEM MpsIMO ceityac!

2.2.1 \ Upnem panbuie: NMoarotoBum Kapty

1. Otkpoiite QGIS. V Bac nosiBUTCS HOBasl, YKcTast Kapra.

Untitled Project - QGIS [new]

Project Edit View Layer Settings Plugins Vector Raster Database Web Processing Help
DheBEGEERX U@L p AP o0
L RV

Cror=s “® Recent Projects
ORYT®TO
Favorites
» [5] Home
» O
@ GeoPackage
# SpatiaLite
@ Postcls
P MssQL
2 pB2
@ WMS/WMTS
» @ XYZTiles
@ wes
@ WFS
© ows
& ArcGisMapServer
&) ArcGisFeatureServer
3¢ GeoNode

GIE )
B
X
B

Layers 2®
« i % T |F i gy

Q Type to locate (Ctrl+K) Ready Coordinate B sale| 11 ~| @ Magnifier| 100% < Rotation |0,0° = VIRender & EPSCi4326 @
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2. HuanoroBoe okHO JlucrieTyep UCTOYHUKOB JaHHbIX Data Source Manager No3BoJsieT BaM BbIOpaTh JIaHHBIC
JUIS1 3aTpy3KH B 3aBUCUMOCTH OT THIA JAaHHBIX. Mbl Oy[ieM UCHOJIb30BaTh €ro JJIs 3arpy3KH Hailero Habopa

JAHHBIX: KJIIMKHATE KHOTIKY JlycrieTdep OTKPBITHIX UCTOYHUKOB JIAHHBIX Open Data Source Manager

Eciu Bbl He MOXKETe HANTH UKOHKY, yOeAUTECh, YTO MaHesb MHCTPYMEHTOB JlucreTyep UCTOYHMKOB JAHHBIX
Data Source Manager 3anyiieH B meHio View » Toolbars.

Untitled Project - QGIS [new] o

Project Edit View Layer Settings Plugins Vector Raster Database Web Progessing Help
DEBRRRY Qe sp AP [N~ T # % am-o [0
Yol W = ® 2

©%  Recent Projects

Data Source Manager | Browser

Browser

QYo

@® WMS/WMTS
» @ xvzTiles

@ wes

@ wFs

- ¢ Vector
% Raster

o
A% Mesh

~ - Favorites
» [1 /media/TRAVAIL/2019/Controle
» 6 Home
=]
» @ GeoPackage

© ows o Delimited Text / spatiaLite
@ ArcGisMapServer @ Postals
& ArcGisFeatureServer 4 Geopackage » mssQL
st GeoNode Y @ pB2
7, spatialite » @ WMS/WMTS
» @ xvzTiles
4 PostaresQL @ wes
@ WFs
e MSSQL ) © ows
@ ArcGisMapServer
08, os2 @ ArcGisFeatureServer
Layers G irtual Layer % GeoNode

v @ . 23 -
S R = QWMS/WMTS

& wes

& WFs

&3 ArcGis Map Server

ATCGIS Feature
@ server

4 GeoNode

Q Type to locate (Ctrl+K) Ready Coordinate ¥ scle 11 ~| @ Magnifier | 100% | Rotation |00° 2|V Render @ EPSG4326 @

3. 3arpysure HaOOp BEKTOPHBIX JlaHHbIX OXpaHsieMble TeppuUTOpul protected_areas. shp:

1. Kinukaute no Bkiaagke Vector.

2. 3amycTute THI UICTOYHHUKA ® File.
3. Haxwmmure Ha KHOIKY MHOTOTOYHE ... psifioM ¢ Habop(bl) BEKTOpHBIX AaHHBIX Vector Dataset(s).

4. Boibepute ain exercise_data/shapefile/protected_areas.shp B BaleM y4eOHOM
Karajore.

5. Kmuknure OTkpbiTh Open. I1osIBUTCS ICXOAHOE ANAJIOTOBOE OKHO C 3aII0JIHEHHBIM ITyTeM K (aility.

12 FnaBa 2. Mogynb: Co3naHue u ndyyeHne 6a3oBow KapTbl
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B Browser

Vector

Raster

Mesh

Delimited Text

GeoPackage
¢ Spatialite

PostgreSQL

MSSQL

DB2

| virtual Layer

WMS/WMTS
wCs

WFS

ArcGIS Map
server

- ArcGIS Feature

Server

Data Source Manager | Vector
Source Type
(@ File ( Directory (' Database (' Protocol: HTTP(S), cloud, etc.
Encoding

System -

Source

Vector Dataset(s) exercise_data/shapefile/protected_areas.shp

@Help < Add # Close

6. Kiknure Taxxe Jo6aButh Add ciona. YkazaHHBIC BaMH JaHHbIE TeTIephb 3arpy3sATCs: Bbl YBUAUTE dJie-
MeHT protected_areas Ha nanenu Ciou Layers (BHU3Y, ClIeBa) C €ro (DyHKIMSAMH, MOKa3aHHBIMHU
Ha OCHOBHOM I10JIOTHE KapThl.

*Untitled Project - QGIS [new]

Project Edit View Layer Settings Plugins Vector Raster Database Web Processing Help

DEBRRESYN O L2L PR RAAEHBIRS &6 -H-a5-5,BE¥ I = [0

LA AN A N

Browser @R
LeT®HO
Favorites
» [& Home
» [/
@ GeoPackage
/# Spatialite
@ Postais
» MssQL
& pB2
@ WMS/WMTS.
» @ xyZTiles

& ArcGismapserver
& ArcGisFeatureServer
¢ GeoNode

Layers (S]]
o« @ ® T &- A0
[l protected areas

Q Type to locate (Ctrl+K) Ready

= % & @~ ®

Coordinate|20.3631,33.8948 | ¥ Scale 1:76050 ~ | & Magnifier | 100% | Rotation |0,0° | |¥| Render & EPsc43ze @
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IMozppasnsiem! Teneps y Bac ecth 6a3oBast kapra. Ceiiuac HEOOXOIMMO COXPAHHUTH Ballly padoTy.

=]
1. Kymknwure Ha kHOonKy CoXpaHUTb Kak Save As:

2. Coxpanute Kapty B manke Pemenue solution folder psmom ¢ exercise_data um Ha3oBUTE ee
basic_map.qgz.

2.2.2 \ Monpobywnte camu

[ToBTOpUTE LI1ary, ONKMCaHHbIE BbILLE IS nJoOaBiieHns cioeB Mecta places . shp u Pekn rivers . shp u3 toi
ke nanku (exercise_data/shapefile) B Kapry.

IIposepvme ceoti pezyrvmam

2.2.3 \ Unem panblue: 3arpyxaem BeKTOPHble AaHHble U3 basbl AaHHbIX
GeoPackage

Basbl qaHHBIX TO3BOJISIOT XPAHUThH OOJIBIION 00BEM CBA3AHHBIX JTAHHBIX B OMHOM haiiiie. BO3MOXHO, BbI yKe 3Ha-
koMbl ¢ Cucremoii ynpasienus 6azamu naHabix (CYBJL / DBMS), takoii kak Libreoffice Base nim MS Access.
IMpunoxenus GIS Takxke MoryT ucrions3oBath 0a3bl faHHbIX. Cucrembl CYB]I, opuentrpoBanssie Ha GIS (Harpu-
mep, PostGIS) nmeror nononHuTebHBIE (DYHKIMH, MOCKOJIBKY UM HEOOXOIUMO 00padaThiBaTh IPOCTPAHCTBEHHBIE
JaHHBIE.

OtkpwiThiid popMaT GeoPackage 3T0 KOHTEHHEP, KOTOPBIN MO3BOJISIET XpaHUTh AaHHbIe (cioun) GIS B ogHOM (paid-
se. B omune ot popmata ESRI Shapefile (Hanpumep, Habop 1aHHBIX protected_areas . shp, KOTOPBIHA BbI
3arpy3uiu paHee), oauH (aitn GeoPackage MoxeT coiepxkaTh pa3IMyHble JaHHbIE (KaK BEKTOPHBIE, TAK U PacTpoO-
Bble) B PA3HBIX CHCTEMax KOOPJMHAT, a Takke TaOiuLbl Oe3 IpOCTPaHCTBEHHOH MH(pOPMAlMK; Bee 3TH (PYHKIMH
MO3BOJISIIOT JIETKO OOMEHHMBATHCS JAHHBIMU M U30erath AyOaupoBaHust (DaiiioB.

YroOsl 3arpy3uth ciioil u3 GeoPackage, Bam cHayasia HyXHO CO3/1aTh K HEMY COeIMHEHUE:
1. KimmkauTe Ha KHOMKY JlpcrieTdep OTKPBHITOTO HCTOYHHKA JaHHBIX ‘5 Open Data Source Manager

2. KimuknHure crneBa Ha BKJIaJKy ['eonaker E‘g GeoPackage.

3. Knukaute Ha kHOmKy HoBoe New wu mepeiigure K (paitny training_data.gpkg B mamke
exercise_data KOTOPYIO BBl 3arpy3ujId paHee.

4. Boibepurte aitn u Haxkmute Open. Tenepb myTh haiiia go0aBiieH K ciucky cBszert Geopackage, OH MosABIS-
€TCs1 B PaCKpBIBAIOIIEMCsI MEHIO.

Termeps BB TOTOBHI JOOABISATH 0001 cioit u3 GeoPackage B QGIS.

1. Kymmknaure no xkHomke Coenuauth Connect. B leHTpabHON YacTH OKHA BBl JIOJDKHBI YBHJIETH CITHICOK BCEX
cioeB, xpaHsmmxcs B ¢aiie GeoPackage.

2. Bwibepure cinoii loporu roads layer u kmkHUTE Ha KHONIKY Add button.

14 MnaBa 2. Moaynb: Co3paHue n nsydyeHme 6a3oBomn KapTbl
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Data Source Manager | GeoPackage

B Browser Connections

- % Vector

training_data.gpkg@/media/sf_GitHub/QGIS-Training-Data/exercise_data/training_data.gpkg -

4 Raster New Remove

X/
e Mesh

4 Delimited Text

Table ~ Type Geometry column Sql
~ /media/sf_GitHub/QGIS-Training-Data/exercise_data/training_data.gpkg
buildings = MultiPolygon geom

% GeoPackage roads " LineString  geom

i’:_ SpatiaLite

+ PostgreSQL

+ MS5QL

Dﬁa_ DB2

m Virtual Layer

& wms/wmts
L5 wes

WFS 1 »

=

fr o
" ArcGIS Map Server
ArcGIS Feature

Also list tables with no geometry

Search options

* Server
& GeoNode @Help Set Filter «/ Add % Close

Croii roads nobaeineH Ha nanesb Ciount Layers ¢ GyHKIMSIMU, OTOOpakaeMbIMU Ha MOJIOTHE KapThl.

3. Kmuknure Close.

Iozapasnsiem! Bol 3arpy3uim nepsbii ciioil u3 GeoPackage.

224 \ |Mpem panbLie|: 3arpyxXxaeM BEKTOpPHble AaHHble U3 ba3bl AaHHbIX

SpatiaLite uepe3 6pay3sep

QGIS mpemocTaBseT AOCTYI KO MHOTUM JipyruM popmaTam 6a3 nanubix. Kak u GeoPackage, (hopmat 6a3bl JaHHBIX
SpatiaLite sBnsercs pacumpennem 6udmrorekn SQLite. Y nobasnenue ciost U3 mocrasimka Spatialite ciexyer
TEeM JKe TpaBUIiaM, YTo onucanbl Boie: Co3iath coeiHeHne —> 3amycTuth ero —> Jlo6asuTts cioii(u), T.e. Create
the connection —> Enable it —> Add the layer(s).

IT0 MOKa OJMH U3 COcOo00B H00aBIcHUs AaHHbIX Spatialite Ha Bally KapTy, JaBaiiTe paCCMOTPHUM ellie OJuH -
(exTUBHBIN crioco0 H0OaBIICHUs TaHHBIX: bpaysep Browser.

. Kivknute Ha MKOHKY ‘!, 4TOOBI OTKPHITH OKHO JlicrieTuepa ucTounuka aaHueix Data Source Manager.

1

2. KiukHuTE Ha BKJIAIKY F Browser.

3. B 3T0¥1 BKJIaJKe BBl MOXKETE YBUJIETh BCE KECTKHE TUCKH, MOAKIIOUCHHBIE K BallleMy KOMITBIOTEpPY, a TaKkxke
3aIKCH 151 OOJIBIIMHCTBA BKJIAJOK ClieBa. DT0 0OecrieurBaeT ObICTPBII IOCTYH K MOAKJIIOUYEHHBIM 0a3aM 1aH-
HBIX WJIU MAMKaM.

Hamprmep, KIMKHATE HA pacKpHIBAIOIIYIOCS UKOHKY PSIOM CO 3JeMeHToM [ eomakeT 0 GeoPackage. Bot
yBuguTe (paiin t raining—data . gpkg, KOTOPHIA MBI TPEABAPUTETHHO COSTMHIIIH (@ TAKKE ero CJION, eCITN
OH paclmpsercs).

4. TIpaBblii KUK IO 3JIEMEHTY f SpatiaLite en Beibepute HoBoe coennnenne New Connection. ...

5. Tepeninute k nanke exercise_data , BeiOepure daiin 3emienonb3oBanue landuse . sglite U KIMK-
Hute Open.

2.2. 3aHsatmne: JobaBnsiem Baluu nepsbie CoU 15
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OO6partuTe BHUMAHUE, YTO SJICMEHT @ landuse.sqlite nodasneH B SpatiaLite.

6. PasBepHuTE 3)1€eMEHT @ landuse.sqlite.

7. KnukHuTe IBaXabl Ha cioil ' landuse nmi BHIOEpUTE U TIEpeTAIMTE €10 Ha MONOTHO KapThl. HoBbIiA ciioit
Jo0aBJieH Ha aHesb Layers 1 ero (pyHKIMK OTOOpakeHbl Ha MOJIOTHE KapThI.

Data Source Manager | Browser

E Browser Browser
= O2THO
- g Vector i Favorites
» [® Project Home
Raster
L » [¢] Home
» O/
~ @ GeoPackage
& Delimited Text ¥ & training_data.gpkg
: =2 puildings
rd GeoPackage V" roads
~ / SpatiaLite
i"'; SpatiaLite ~ = landuse.sqlite
& PostgresQL @ PostGls
P mssQL
- MSSQL @ DB2
@ WMS/WMTS
082, D82 v @ XvZTiles
WA i OpenStreetMap
Lﬁ Virtual Layer @ wes
e & WFS
A A .
\ﬁ‘_ WMS/WMTS ) ows
£ wes & ArcGisMapServer
B &) ArcGisFeatureServer
+ WFS * GeoNode

- ArcGIS Map Server

ArcGIS Feature
#* Server

» GeoNode

Coset: 3anycrutb naHenb Browser B Bug-Tlanenn View » Panels » v ucrionb3yiite ee jjisi JOOABJISHUS BalliX
JAHHBIX. DTO YAOOHBIN SIPIBIK Uit BKIanKu Data Source Manager » Browser ¢ TOH ke (DyHKITMOHATBHOCTBIO.

IIpumeuyanne: He 3a0yapTe yacto coxpanaATh npoekt! Pailn mpoekTa He COOEPXKUT AAHHBIX, HO IOMHUT, KaKue
CJIOU 3arpy’KeHbl Ha KapTy.
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2.25 / |MonpobynTte camu|, 3arpy3ute 60bLue BEKTOPHbIX OaHHbIX
3any3I/ITe C.TIG,I[y}OH.[I/IfI Ha6op JAaHHBIX U3 ITaIIK1 exerci se_data Ha KapTy HpI/I IIOMOIIHU HIO6OF0 METOoaa, OInu-
CAHHOI'O BBIIIIC:

* 3panus buildings

e Bopa water

IIposepome ceéou pesyrvmamel

2.2.6 Wpem panbwe: MeHsieM nopsiooK cnoes

Crou B Bammem criicke Ciioes OTO6pa)KaIOTCH Ha KapTe€ B OIPEACIICHHOM MOPAIKE. Cront BHU3Y CITUCKA pUCYETCA
INepBbIM, a (S (0)7¢ BBEPXY PUCYETCA MOCJIECIHNM. Wamenss MopsAA0K, B KOTOPOM OHU OT06pa)KaIOTCH B CIIMCKE, BbI
MOKETE U3MCHUTH MOPAAOK, B KOTOPOM OHU OTO6pa)KaIOTCH.

IIpumeuyanne: Bbl MOkeTe U3MEHHUTD ITO MOBE/ICHNE, YCTAHOBUB (DJIaXOK YIIpaBJIeHHE MPEIOKEHHBIM MOPSIIKOM
Control rendering order non nanensio Iopsinok cnoeB Layer Order. OnHako Mbl TIoKa He OyneM oOcykJaTh 3Ty
(pyHKLIHIO.

IMopsiI0K, B KOTOPOM CJIOM ObLIM 3arpyKeHbl Ha KapTy, Ha IAHHOM 3Tarle, BEPOsITHO, He JIornieH. Bo3MoxHO, clloi
JIOPOTH TIOJTHOCTBIO CKPBIT, IOTOMY UTO JPYTHe CJIOW HAXOISATCS TIOBEPX HETO.

Hanpumep, Takoil mopsiiok ciioes. ..

Layers (E]ES)
« @ ® T & @& L0

v| ] water

! [ buildings

v/ [ landuse

v — roads

v/ — rivers

v| * places
v|[]| protected_areas

... IPUBEJET K TOMY, YTO JOPOT'H U MecTa OyIyT CKPBITHI, TOCKOJILKY OHH HAXOASTCS MO/ TOJIUTOHAMH CJIOST 3eMJle-
MOJIb30BAHUS.

UYToOH pemuTh JaHHYIO TPOoOIeMy:
1. Kimkaute u nepetamuTe cioi u3 cnmcka Crioes.

2. VI3ameHuTe UX MOPSIIOK, YTOObI OHU BHIIISIENH CIIEIYIOIM 00pa3oM:

2.2. 3aHgatne: [o6aBnsiem Baluv nepBeble CNoun 17
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basic_map - QGIS
Project Edit View Layer Settings Plugins Vector Raster Database Web Help

NERRRRY VAP HPPLALAEBRENR Q6 R-U-LHEZ &6 0-
MQV.A % /B R-FOer B “qEHwEssE R 2

Layers B
¢ BT G-E
places
v/ — roads
v| — rivers
v! [ buildings
V! [ water
v| [] protected_areas
v/ [l landuse

Layers | Browser

®

Q Type to locate (Ctrl+K) Coordinate| 20.4981,33.9741 |9 Scale | 1:56077 ~ | & Magnifier | 100% | Rotation 0.0* +| ¥ Render @ EPsc4326 @

Bol YBUOUTE, YTO KapTa TEIEPb BU3yaJIbHO 0oJiee MOHATHA: AOOPOTU U 3JaHus NMOABIAIOTCA Had TEPPUTOPUAMUA 3EM-
JICIIOJIb30OBaHU .

2.2.7 B 3aknouyeHvn

Tenepb BbI ,IIO6aBI/IJII/I BCE HGO6XOZ[I/IMBIC CJIOM U3 HECKOJIbKUX PA3HBIX UCTOYHUKOB U CO30aJIN 6330By10 KapTy!

2.2.8 UYrto panbwie?

Temneps Bbl 3HAKOMBI C OCHOBHBIMU (DYHKIIMSIMU KHOINKM YTIpaBJeHHE OTKPBITBIM UCTOYHUKOM AaHHbIX Open Data
Source Manager, HO Kak HacdeT Bcex ocTanbHbIX? Kak paboraer stor unrepdeiic? [Ipexae 4emM Mbl IPOIOJIKIM,
JlaBaiiTe B3TISTHEM Ha HEKOTOPBIE OCHOBBI B3auMOAeHCTBH ¢ MHTepdericom QGIS. DTo Tema crremyommero 3aHATHA.

2.3 3aHsiTMe: HaBuraums no NoNnoTHy KapTbl

B 3TOM paspere riaBHOe BHUMaHUe OyJIET y/IeJIeHO OCHOBHBIM UHCTpyMeHTaM HaBuraimu QGIS, ucrosb3yembiM st
HABHTAIMH TI0 MOJIOTHY KapThl. DTH HHCTPYMEHTHI ITO3BOJIAT BaM BU3YaIbHO M3YYUTh CJIOM B Pa3HbIX MaciTadax.

Ilens faHHOTO 3aHATHA: Y3HATH, KAK UCIIOIB30BaTh MHCTpyMeHTHl [TaHOpamupoBanue n MacmrabupoBanue / Pan
and Zoom B QGIS, u y3HaTh 0 MaciTabe KapThl.

2.3.1 \ Npewm panbuie: ba3oBble MHCTPYMEHTbI HaBUrauum

[Mpesxe YeM HayuUThCS HABUTALIMH TIO MOJIOTHY KapThl, IaBaiiTe JOOABUM HECKOJIBKO CJIOEB, KOTOPhIE Mbl CMOKEM
W3YYUTh B X0J€ 00y4YeHHUsI.

1. OtkpoiiTe HOBBIH IyCTON MPOEKT U, IPH MOMOILY IIaroB, OMUCAHHBIX B pasaene Co3paTs Kapty Create a Map,
3arpy3ure B IIPOEKT paHee IPOCMOTPEHHbIE CIION protected_areas, roads and buildings layers to
the project. Pe3ynpTaT qOmKeH BHINIAAETh IPUMEPHO TaK, KakK MOKa3aHo Ha Puc. 2.1 Huxe (11BeTa HE UMEIOT
3HAYEHUS):
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@

heoBRE QeLLHAPPL M A LT @ K-8-EE -
LL AN J =g RE - R A
9 12 px

Browser (=]
OR2THO
b [ VirtualBox =

1 .wscode
1 3D Objects

OO

1 Anaconda3
1 AppMods
1 Autodesk

| Contacts

» 5 Desktop

+ [ Documents

OO0

—

+ [J Downloads
+ [ Dropbox (BOSTON UMIVERSITY)
v [ eclipse
+ [ eclipse-workspace
Layers
¢ @l ® TV &-# O
v roads
v| [l buildings
v| [ protected areas

@

1leq 1| 20.2255-34.0416 |9 : 1:129050 |~ | @ r|100% SERLLE 3| VI Render < ppsGi43z6 @

Puc. 2.1: [loGaBieHHbIE OXpaHsieMble TEPPUTOPHH, TOPOTH U 3TAHUS.

JlaBaiiTe cHavyaa y3HaeM, Kak IpUMeHATh HHCTpyMeHT IlaHopamuposanue / PanTool.

1. Y6eaurecs, uro Ha Ilaneau uHcmpymennmos Haguzayuu no Kapme, akTHBUPOBaHa KHOIKA @ Pan,
2. TlepemecTuTe MBIIIIb B IIEHTP MOJIOTHA KAPTHI.

3. KimkH#HTE J1EBOH KHOIKOM MBIIIN H, YAEpKUBad €€, IEpeTalliiTe MbIIIb B JII000M HalpaBJICHUM JId [TaHOpa-
MUPOBAHUA KapThl.

3areM [JaBaiiTe yBeIMYMM MAcIITad 1 OAPOOHEee pacCMOTPHM UMIIOPTUPOBAHHBIE HAMH CJIOH.

LR
[
1. KiuknuTe KHOMKY YE™™M™ % Ha [laneau uncmpymenmos Hasueayuu no Kapme.

2. TlepemecTrTe KYpCOP MBIIIK IIPUMEPHO B JIEBYIO BEPXHIOI 00J1aCTh, I/Ie CaMasi BHICOKAs! IVIOTHOCTD 3[IAHUI 1
JIOpOT.

3. IllesnkHuTe JIEBOI KHOMKOM MBIIIH U YAepXKUBaiiTe.

2.3. 3aHsaTtne: HaBuraumsa no NonoTHy KapThl 19
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4. 3areM NepeTalinTe Mbllilb, YTO CO3/IACT IPSIMOYTOJIbHUK M 3aXBATUT IUIOTHO 3aCTABJICHHYIO MECTHOCTb 3/IaHUI
u popor (Puc. 2.2).

Puc. 2.2: Zoom in

5. OtmycTute JeByI0 KHOIKY MBIIIH. DTO NPUOINU3UT KapTy U BKJIIOUUT MECTHOCTb, KOTOPYIO BBl BHIOpAJIN CBOUM
IIPAMOYTOJIbHUKOM.

20 FnaBa 2. Mogynb: Co3naHue u ndyyeHne 6a3oBow KapTbl



QGIS Training Manual

@ *Untitled Project - QGIS
Project Edit View Layer

DB RE

Settings Plugins Vector Raster Database Web Mesh Help

- O s

OBPLHEPP Y J LB HEORQ ¢ -R-8-,EH -

M@V AW B VI EBRR-ZTE < B

(RN )

[Ecr

1y :

Browser

QRETHTO

[=]Es]

- -

[7 VirtualBox
[ .wscode

-

[ 3D Objects
[ Anaconda3
[ AppMods
[ Autodesk
[ Contacts
5 Desktop
+ [ Documents 7
+ [J Downloads L= .
+ [ Dropbox (BOSTON UNIVERSITY) -
v [ eclipse . s
|+ [ eclipse-workspace b i : A %
Layers 2l S - "
« BT &R0 S
~— roads : 7.6 -
M buildings ' - ol .-
[T protected areas ;

- v v v -

| & Type to locate (Ctri+K) ‘ |-‘ @riwo% 3o |+| v Render > EPSG:4326

1| 20.4849,-33.9843 | ¢[1:32458 @

6. YroObl yMeHbIIUTH MacITad, BoiOepruTe KHONKY OTaaInuTh }9 Zoom Out p pEITOITHATE TO XK€ JICHCTBHE, KOTOpOe
BbI BBIIOJTHSUTH JIJTSI TPUOJIVKEHHST KapThI.

B T0 BpeMst kak BbI MPOKpyUHBaeTe, NpuoOIMKkaete wiv otaaisgere kapry, QGIS coxpaHsieT Bce MPOCMOTPHI B HCTO-

pun. YTo MO3BOJISET BEPHYTHCSA K MPEbIAYIIEMY IPOCMOTPY.

1. Ha Ianeau uncmpymernmos nasuzauuu no kapme, KIMKHUTE 10 KHOMKe [loceunii Macitad «;‘a Zoom Last (g
YTO BBl PHOJIVKATN WM OTAAJISUTM B TIOCJIETHAN pa3), YTOOBI EPEHTH K MPeAbIIyIIeMy BUITY.

2. Kimknure no kHorke MaciitabupoBats jiaiee }a Zoom Next o Gpy MIPOJIOJUKUTH IBMKEHHE M0 UCTOPUU Ba-
LIero 3yma.

WHorna nociie u3yveHust JaHHBIX HAM HYXHO COPOCHUTH MPOCMOTP 0 YPOBHSI BCEX CJI0eB. BMecTo TOro, 4to0b
TBITATHCSI MHOTOKPATHO KCTIONB30BaTh MHCTpyMeHT Otnamuts, QGIS mpenocTapiser HaM KHOIIKY 1S BBITIOJTHEHUST
IAHHOI'O JEWCTBMA 3a HAC.

1. Click on the ﬂ Zoom Full Extent fy¢top

Ipy npuGIVKeHNN U OTAAICHUH, 0OpaTiTe BHUMaHKe, 4To 3HaYeHHe Macmrad Scale B CTpOKe COCTOSIHHSI UI3MEHS1-
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QGIS Training Manual

etcsi. 3Hauenune Maciutab Scale npesicrapisier MaciTad KapTel. B 0011ieM, YuciIo crpaBa OT JBOETOYHS * IIPEICTAB-
JISIET, BO CKOJIBKO pa3 00bEKT, KOTOPHIi Bbl BUIUTE HA MOJIOTHY KapThl MEHbIIIE (PAKTUIECKOro 00beKTa B pealbHOCTH.

L, a

Coordinate| 20.6324,-34.0757 | B Scale 1:128472 ~ | |&@ Magnifier 100% ~| Rotation |0.0° 2| v/ Render ¥ -}

BrI Takke MoXkeTe HCIIOJIb30BaTh HJaHHOE MOJIE J1d YCTaHOBKH Maciirada KapTbl BpPyYHYIO.
1. B CTPOKE COCTOAHUA, KIMKHUTE Ha TEKCTOBOC II0JIE Scale.

2. Beemure 50000 1 HaxmuTe Enter. D10 nepepucyer (PyHKLIMH Ha TOJIOTHE KapThl, YTOOBI OTPA3UTh Mac-
1ITad, KOTOPHIA BBl BBEH.

3. B kavecTBe aJIbTepHATUBBI, MOKHO KJIMKHYTh Ha CTPEJIKY NApaMeTpoB B Mose Scale, 9ToObI YBUAETD Mpes-
YCTaHOBJICHHBIE MACIITAOBI KapThl.

A
1:1000000 =

1:500000
1:250000
1:100000 | -
1:50000
1:25000 |
1:10000
1:5000
1:2500
1:1000 |~

$ Scale 1:50000 v

4. Beibepure 1:5000. D10 Takke OOHOBUT MaclITad KapThl Ha TIOJIOTHE KapThl.

Tenepb Bbl 3HaeTe OCHOBBl HABUIallMW II0 MOJIOTHY KapThl. O3HakoMbTech ¢ PyKOBOACTBOM moOJIb30Batess I10
Zooming and Panning (MacmrabupoBaHue U aHOPaMUPOBAHHKE), YTOOBI Y3HATh 00 AJIbTEPHATHBHBIX CIIOCO0aX Ha-
BUTALIMH TI0 TIOJIOTHY KapThl.

2.3.2 B 3aknouyeHun

3HaHKe HABUTAIMH IO MOJIOTHY KapThl BAKHO, IIOCKOJIBKY OHO ITO3BOJISIET M3y4aTh M BU3YAJIbHO MPOBEPSITH CJIOU.
Takoe ieficTBUe MOXKHO BBIIIOJHUTH ISl IPOBEICHNUS NIEPBOHAYATIBHOTO MCCIIEOBAHUS JAHHBIX WM VIS TPOBEPKH
Pe3y/IbTATOB POCTPAHCTBEHHOTO aHAIU3A.

2.4 3aHdatne: CumBonka

CJ0i cMMBOJIa - 3TO €r0o BHEITHUM Brj Ha KapTe. OcHOBHOe npenmyiiiecTBo GIS nepen qpyrumu criocodamu mpeji-
CTaBJICHUsI JAHHBIX C IIPOCTPAHCTBEHHBIMU aCIIEKTaMM 3aKJII0UYaeTcst B TOM, 4to ¢ nomorieio GIS y Bac ecth 1uHa-
MHUYECKOE BU3YaJIbHOE MPEJICTABIIEHNE JaHHBIX, C KOTOPBIME BB paboTaeTe.

[NosToMy BHEIIHUI BUJ KapThl (KOTOPBIN 3aBUCUT OT CHIMBOJIMKH OTIIEJIBHBIX CJIOEB) OUYEHb BakeH. KOHEeUHSIi MoJTb-
30BaTesIb CO3[aBAEMbIX BAMH KapT J0JKEH MMETh BO3MOXHOCTb JIETKO YBUJIETh, YTO MpeACTaBiser codou kapra. He
MeHee BaKHO, YTOOBI BbI MOIJIM U3y4aTh JAaHHBIC BO BPeMs PaOOThI C HUMHM, & XOPOIIIasi CAMBOJIMKA OYeHb [IOMOTaeT.

prFI/IMI/I CJIOBaMU, UMETH MPAaBUJIbHYI0 CUMBOJIMKY - 3TO HE POCKOILb U HE MMPOCTO XOPOIIO, YTO OHA €CTh. daxk-
TUYCCKHU, IJIA BAC OYCHb BaKHO ITPABUJIBHO MCIIOJIb30BATH GISm CO31aBaTh KapThl U I/IHCI)OpMaL[I/IIO, KOTOpBIE JTIOAN
CMOTI'YT UCIIOJIb30BATh.
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I_IeJIl: JAHHOT0 3aHATHA: UMCTh BO3BMOXHOCTBH CO3/1aBaTh IIIO6yIO CUMBOJIMKY IJIs JI000r0 BEKTOPHOIO CJIOA.

2441 \ Npem panblue: MeHsiem uBeTa
Ortkporite CoiicTBa ciiost Layer Properties, 9T0O0bl NI3MEHUTh CUMBOJIMKY cJIosl. HauHeMm ¢ n3MeHeHus 1BeTa ciiost
3emrenonb3oBanue landuse.

1. KiymmkauTe IpaBOoii KHONKOM MBIIIM HA CJIOH /anduse B CIIMCKE CJIOEB.

2. B oTkpbIBIIEMCS MEHIO BbIOepuTe yHKT CBOWCTBA. .. / Properties....

IIpumeuanne: Brl Takke MOXeTe MOTYIUTh JOCTYI K CBOMCTBAM CJIOSI TIO YMOJTYAHHIO, TBAK/IB KJIIMKHYB Ha
cior B cicke CIioeB.

Coser: Knomka d B BepxHeil yactu naHenu Layers oTKpeiBaeT na”eab Ctunu cnost Layer Styling. Bot
MOJXETe WCIOJIb30BaTh 3Ty MaHeJb JJIsi N3MEHEHUs] HEKOTOPHIX CBOICTB CJIOS: MO YMOJIYAHHUIO, U3MEHEHUS
BCTYIAIOT B CHJIy HEMeUICHHO!

3. Bnibepure, Bkiaaky CHMBOJIMKA d Symbology tab: B okomike CBoiicTBa cnost Layer Properties.

Layer Properties - landuse | Symbology
&= singlesymbol -]

',f Information

[ simple fill

A3 source

& symbology

€3 Labels

B masks Unit | Millimeters -
Opacity 1100,0% |-

[

b .
. Diagrams

Color |

Ng 3D View

E Fields

B8 Actributes Form | . Favorites ~| &

Joins

ﬁ Auxiliary Storage - -

@ Actions
. L
- Display plasma

Rendering

gradient gray 3 fill hashed black / hashed black,  hashed black X outline blue outline green outline red

wiHEBE

outline xpattern pattern dot pattern zelda simple blue fill  simple greenfill  simple red fill
black

Variables

a~ Metadata

|save Symbol... | Advanced - |

Dependencies

Legend » Layer Rendering
& qais server ~| @Help || style - | JApply | % Cancel ” JoK ]

4. KnukHUTE Ha KHOIIKY BbIOOpA 11BeTa psiioM c sipiibikoM Color. TTosiBUTCSI CTaHAAPTHOE AUATIOTOBOE OKHO I1Be-
Ta.

5. BuiGepure cepsiil et 1 Haxmute OK.
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6. Eme pa3 maxxvute OK B okne CBoiictBa ciiost Layer Properties, M Bbl yBUOWTE, 9TO U3MEHEHHUE [[BETA ITPAME-
HAETCS K CJIOIO.

2.4.2 \ Monpo6yite camm

W3menuTe 1IBET C10s1 water Ha cBeT/0 rostyooi. [TornpodyiiTe ucrosb3oBath naHe b Ctuib ciost Layer Styling BMecTo
MmeHIo CBoiicTBa cinost Layer Properties.

1] posepvIme ceou pe3y.iomdaniobl

243 \ Upem panbuie: MeHsieM CTPYKTYpYy CUMBONa
IToka 4yTO BCe HETUIOXO, HO CJIOW CHMBOJIA - 3TO HE TOJIBKO €ro mBeT. [lanee Mbl XOTUM yJajWuTh JIMHUM MEXIY pas-
JIMYHBIMHA MECTHOCTSIMHU 3€MJICTIONIb30BAHU S, UTOOBI CIe/IaTh KapTy MeHee 3arpOMOK/ICHHON BU3YaJIbHO.
1. Otkpoiite okHO Layer Properties nns cnos landuse.
Tlop BKJIaaKoR Symbology, BBl yBUUTE MOX0KEE JUATOTOBOE OKHO, KOTOPOE BbI BUIEIM paHee. OnHAKo,
Ha 3TOT pa3 Bh JieJlaeTe OoJIblie, 4eM IIPOCTO OBICTPO MEHsETe LBET.

2. B cnosix cuMBOJIa OTKPOWTE PacKphIBAIOIMIACS CIICOK 3anuBKa Fill v BbiOepute napamerp Ilpocrast 3ammBKa
Simple fill.

3. KnukHMTE pacKpbiBaomics crucok CTusib 00BoAKY Stroke style. Ha TaHHBIF MOMEHT OH JI0JI)KEH ITOKA3bIBATh
KOPOTKYIO JIMHMIO U ciioBa CrutonHas nunus Solid Line.

4. Wszmenute ee Ha bes nepa No Pen.
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Layer Properties - landuse | Symbology

| = Single symbol -]

(4 Information > [ Fill |E|

Simple Fill
N :
AN Source e
Q2]
d symbology
€3 Labels
5 Masks symbol layer type| Simple Fill -
: i .
" Diagrams Fill color | H =
Fill skyl Solid v
Wf 3D View syle | -| =
Stroke color | NN - =,
E Fields —
Stroke width | 0,260000 2| Mmillimeters  ~ | &,
E Attributes Form
Stroke style | No Pen '| LEH
o] Joinstyle | T Bevel M=
E_’. Auxiliary Storage X  0,000000 |:|
Offset ' Millimeters - |
@ Actions y  0,000000 2]
@ oisplay v| Enable symbol layer €=, Draw effects
q. Rendering
P Layer Rendering
Variables _| @nelp || style - | «/Apply || % cancel |[ < oK ]

5. Kimnkaute OK.

Teneps cnoii landuse 6yner 6e3 TMHUI MEXK Iy MECTHOCTSMH.

24.4 \ Monpob6ynte camn

» CHOBa U3MEHHTE CJIOK CUMBOJIA water, 4TOOBI OHa 00pesia 6oJiee TEeMHO-CHHHUI KOHTYP.
* M3MeHurte cJoi CUMBOJIA PEKHU Fivers, YTOOBI OH OTOOpaXkas BOJHbIE IyTH OoJiee MOAPOOHO.
ITomHuUTE: BBl MOKETE MCHOJIBL30BAaTh KHONKY OTKPHITh MaHeIb CTHIIEH CI0s d Open the Layer Styling panel y; ypyinery,

BCC UBMCHCHU A Cpa3sy. ,HaHHa.H MaHEeJIb TaKXKE MO3BOJIAET BaM OTMEHATDH OTACJIbHBIC U3MEHCHU S IIPU UCIIOJIb30BAHUN
CUMBOJIM3UPOBAHUA CJIOA.

IIposepvme ceou pezynvmamaol
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245 / Upoem panbwe: BuopumocTb Ha oCcHOBe MacLutaba

Bbl 00HapyX)uUTe, YTO MHOI/A CJIOW He Oy/eT MOAXOAWTH Ui AaHHOro macintaba. Hanpumep, HaGop JaHHBIX 110
BCEM KOHTMHEHTaM MOXET UMETh CKYJHYIO JAETAIM3ALMI0 U ObITh HE OYeHb TOYHBIM Ha ypoBHe yiuil. Korna takoe
MPOM3OM/IET, Bbl 3aXOTUTE MMETh BO3MOKHOCTh CKPBITh HAOOP TAaHHBIX HECOOTBETCTBYIOIIMX MACIITAOO0B.

B Hamem CJIy4a€ Mbl MOXXEM PEHIMTDL CKPLITh 3JaHUA OT IPOCMOTpPA B HeOOJIBIINX MacIITadax. HaHpHMep, 9Ta Kap-
Ta...

symbology - QGIS

Project Edit View Layer Settings Plugins Vector Raster Database Web Help

DEBERERRY Q2L RPPLALBBER 6 M-N-GEHE 2 & 6 [T
RV, AW #/BRR-ZT<a B mqEugEggE R 2 A

Layers (=[]
o I@ 5 T §,+& »
v| * places
v| — roads
V| — rivers
v! [ buildings
v| [ | water

[ protected areas

v landuse

Layers = Browser

Q. Type to locate (Ctrl+K) sordinal| 207122339589 |¥§ :al| 1150104~ | @ agnifit 100% </ otatic |0.0° <| v/ Render & gpsGazze @

... He OYeHb yI0OHas1. 30aHusI TPYIHO Pa3IMUYKUTh B TAKOM MaciiTale.

YroObl 3aIyCTUTh BU3yaIM3allMI0 HA OCHOBE MaciiTada:
1. Otkpoiite quanoroBoe okHo CBoicTBa cnost Layer Properties nis cnosi 3nanus buildings.
2. AKTuBHMpYWTE BKIAJIKY Rendering.

3. 3amycruTe BU3yalU3alvio HA OCHOBE MaciTada, KIMKHYB Ha (DJIaxkoK M0J] Ha3BaHHeM BUIUMOCTh B 3aBHCH-
MocTH OT MaciiTabda Scale dependent visibility:

4. N3meHnnte MUHMMAaJIbHOE 3HaYeHue Minimum Ha 1:10000.
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Layer Properties - buildings | Rendering >

Q v v Scale Dependent Visibility
Ve

Minimum (exclusive) Maximum (inclusive)
4= [1:10000 - |[&| P o - ||m

v Simplify Geometry

Information

i
" Source

% Symbology

Note: Feature simplification may speed up rendering but can result in rendering inconsistencies

S Simplification threshold (higher values result in more simplification) 1,00 <! pixels

€D Masks simplification algorithm Distance ~
Diagrams

‘4; 3D View Maximum scale at which the layer should be simplified (1:1 always simplifies) | 1:1 -

E Fields Force layer to render as a raster (may result in smaller export file sizes)

E Attributes Form Refresh layer at interval (seconds)

, Refresh layer on notification
Joins

ﬁ Auxiliary Storage
{;'.-Q Actions
, Display

@’ Rendering

5. Kimmkaute OK.

ITpoBepsTe naHHBIA 3(DQPEKT MyTeM OTAANCHUS U MPUOIMKEHHs KapThl, OTMeYasl, KOTJa CJIOW 3JaHHUi ncye3aeT u
TIOSIBJISIETCS] CHOBA.

HpnMeanne: Brl MokeTe UCIoIb30BaTh KOJECUKO MBI JJ1d IMTOCTECTICHHOI'O HpI/I6III/I)KeHI/IH, WJIN UCIIOJIb30BATh
HWHCTPYMCEHTBI MaCIIITa6I/IpOBaHI/IH, qTOOBI HpI/I6J'[I/I3I/IT]> OKHO!

e

2.4.6 / Upem panblie: [Lobasnsem ciom cumMBona

Tenepb, Koria Bbl 3HA€Te, KAK U3MEHUTh MPOCTYI0 CUMBOJIMKY CJIOEB, CIEAYIOLIMM IaroM OyeT co3naHue 6osee
cioxHor cuMmBosKU. QGIS 1o3BosIsIET 1e1aTh 3TO C MOMOIIBIO CJI0EB CUMBOJIA.

1. BepHuTech Ha maHesn b CBOWCTBA ciosi cuMBosa landuse (kiukHyB [Ipocrtast 3anuBka Simple fill Ha nepese
CJIOEB CUMBOJIA).

B nanHOM mpmMepe, TEKyIIUil CHMBOJ HE UMeeT KOHTypa (T.e. IMpUMeHsIeTCsl CTHIb TpaHuibl be3 mepa No
Pen).
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Layer Properties - landuse | Symbology

| = Single symbol -]

(4 Information > [ Fill |E|
Simple Fill
:{S,‘_- Source |ﬁ| |T|
L =
ﬂ' symbology -
€3 Labels
5 Masks symbol layer type| Simple Fill -
: i .
" Diagrams Fill color | H =
Fill skyl Solid ~
Wf 3D View syle | -| =
Stroke color | NN - =,
B Fielas B
Stroke width | 0,260000 2| Mmillimeters  ~ | &,
E Attributes Form
Stroke style | No Pen '| LEH
b Joinstyle | T Bevel M=
E_’. Auxiliary Storage x | 0,000000 E
Offset ' Millimeters - |
@ Actions y  0,000000 2]
@ oisplay v| Enable symbol layer €=, Draw effects
q. Rendering
P Layer Rendering
Variables _| @Help || style ~| | «/Apply || % cancel |[ «/ OK ]

2. BeiGepurte Fill Ha fiepeBe ¥ KJIMKHUTE HAa KHOMNKY JI00aBUTH CIOi CUMBOJIA EII-I}:I Add symbol layer - Tyra jorosoe
OKHO M3MEHHTCS ¢ JOOaBJIEHHEM HOBOTO CJIOSi CHMBOJIA, ¥ OyZIeT BBINVIAAETh IPUMEPHO TaK:
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Layer Properties - landuse | Symbology >

a = single symbol -
@ nformation ~ M Fill
Simple Fill =|[v
33 source [X simple Fill .
: L&
& symbology
€= Labels
symbol layer type Simple Fill -
D Masks Y v -
. i O
S Fill color <
Fill style I solid -
WF 3D View = =
stroke color | [ - <.
E Fields
Stroke width | 0,260000 @ |7 |Millimeters K =N
E Attributes Form —
Stroke style | ——Solid Line - | €
Joins Join style 1 Bevel K=
ﬁ Auxiliary Storage x | 0,000000 =
Offset Millimeters -
U_@ Actions y | 0,000000 =
® oisplay v| Enable symbol layer =, Draw effects
Qj,/ Rendering
» Layer Rendering
Variables @Help Style ~ « Apply || % cancel «/ OK

-

HaanMep, OHO MOJKET BBINIAAETh HECKOJIBKO MHAYE 10 IBETY, HO Bbl BCE PABHO 9TO U3MEHUTE.

Tenepb ecTh BTOPOIi cJ10i cUMBOJIa. [TOCKOJIbKY 3[1eCh CILUIOIIHOM IIBET, OH, KOHEYHO e, MOJHOCTHIO CKPOET MPE/Ibl-
Iymmii Bug cuMBoiia. Kpome Toro, y Hero ects ctvis rpanuns! CrutorHast tuHus Solid Line, KOTOPBIT HaM He HYKeH.
OueBHUIHO, UTO JAHHBIA CUMBOJI HEOOXOAMMO U3MEHUTD.

IIpumeuanne: BaxHo He myTaTh CJIOM KapThl U cioi cuMBoja. Cloil KapThl - 3TO BEKTOp (WM pacTp), 3arpy-
JKEHHBIN Ha KapTy. CJI0/ CMMBOJIA - 3TO YaCTh CUMBOJIA, MCIIOJIb3yEMOTO IS TPEJICTABICHNUS CJI0s KapThl. B TaHHOM
Kypce 00y4YeHHsI CJI0i KapThl OOBIYHO HA3bIBAETCSI IPOCTO CJI0EM, HO CJION CUMBOJIA Beeraa OyeT Ha3hIBAaThCS CII0EM
CHMBOJIa, YTOOBI U30€KaTh Iy TAHULIBI.

Bri6pas HOBbIH citoii cumBona [1pocrast 3anmuBka Simple Fill:
1. VYcranoBure ctuiib rpanuibl No Pen, Kak U paHblIe.

2. V3ameHuTe CTWIIb 3AJIMBKY Ha J1I000M, kKpome CrutomHast Solid v bes xuctu No brush. Hanpumep:
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Layer Properties - landuse | Symbology

- |

| = single symbol

fi' Information ~ [ Fill |@|
Simple Fill |g| |;|
':{:\\ Source [T simple Fill Bt A8
' =Nl
& symbology
€= Labels
@B Mask symbol layer type| simple Fill - |
asks
p—— Filcolor | (N | =
Fill skyl i cross -
WF 3D View term | _| =
stroke color | (. - <.
E Fields -
Stroke width | 0,260000 @ || Millimeters  ~ | &,
E Attributes Form
Stroke style | No Pen - &
Joins Joinstyle | T Bevel - &
E’. Auxiliary Storage x | 0,000000 |:
Offset | Millimeters - |
L Actions y |0,000000 S ——
® oisplay v| Enable symbol layer =, Draw effects

&  Rendering

» Layer Rendering
Variables _| @Help || style - | /Apply || %cancel H «/ OK ]

3. Kimknute OK.

Ter[epb Bbl MOKETE BUACTb CBOU PE3YJIbTAThI U IIPU HCO6XOZ[I/IMOCTI/I NOMpPaBJIATb UX. Bu JAXKE MOXETE HO6aBI/ITB
HECKOJIBKO JOITOJHHUTEIBHBIX CJIOEB CUMBOJIOB U TaKUM O6p330M CO3aTh CBOETO poJia TEKCTYPY MJIA CBOETO CJIOA.

O |- |
4 simple Fill
IF simple Fill
] simple Fill

3ro Beceno! Ho, BEpoSITHO, CIIUIIIKOM MHOTO [[BETOB, YTOOBI IPUMEHSITh K peabHOM KapTe. ..

24.7 / Monpo6yute camn

Co3paiite MpPOCTYI0, HO HE OTBJIEKAIOIIYI0 BHUMAHKE, TEKCTYPY IS CJIOs 3[IaHUM, UCIIOJIb3Y sl OITUCAHHBIC BBIITIC Me-
TOJIBI ¥ He 3a0BIBaeM MPHOMKATh, B CITy9ae HEOOXOAUMOCTH.

IIposepvme ceou pezynomamuol
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24.8 A WUnem panbuie: YnopsipoynsaeM ypoBHM CUMBOJa

B cnyuae, Koraa BU3yaIM3HUpYIOTCS CJIOW CHMBOJIOB, OHH TaKKe OTOOPaXaloTCs B IOC/IEJOBATEIbHOCTH, aHAJIOTUYHO
TOMY, KaK BU3YaJIM3UPYIOTCSI Pa3JIYHbIE CJIOU KapThl. DTO O3HAYAET, YTO B HEKOTOPBIX CIydasiX HAINYME MHOKECTBA
CJIOEB CIMBOJIOB B OIHOM CHMBOJIE MOKET MIPUBECTH K HEOKUAAHHBIM PE3yJIbTaTaM.

1. 3apaiite cioto roads TOTIOTHUATEBHBIA CJION CUMBOJIA (UCTIONB3YST METO JOOABJICHUs CIIOEB CUMBOJIA, ITOKa-
3aHHBIN BHIIIIE).

2. 3apaiite aiis 6a3oBoii iuHny Llnpuny mrpuxa Stroke width of 1.5 v YepHBIN LBeT.
3. Bapgaiite HOBOMY BEpXHEMY CJIOI0 TOMIUHY O . 8 U Oesblii LIBET.

Bot 3aMETUTE, CIIEAYIOIIEE:

Yro x, JOPOIr'v TENEPb UMEIOT CUMBOJIUKY, ITOXOXKYIO Ha yJIMIly, HO Bbl BUAUTE, YTO JIMHWU NIEPEKPLIBAIOT APYT ApYyra
Ha KaXXJ10M NEPEKPECTKE. STO COBCEM He TO, YTO MbI XOTUM !

Yrto6bl NOJOOHOTO HE MPOKCXOIUIIO, BHI MOKETE OTCOPTUPOBATh YPOBHU CUMBOJIOB M, TAKMM 00pa3oM, YIIPaBIATh
MOPSIIKOM, B KOTOPOM OTOOPAXKAIOTCS Pa3IMYHbIE CJIOM CUMBOJIOB.

YUTtoObl NI3MEHUTD MOPSIIOK CJIOEB CUMBOJIOB!
1. BuiGepure camblii BepxHuii ciioii JInHus Line Ha nepeBe CJIOEB CHMBOJIOB.

2. Kimkuaure Advanced w Symbol levels... B ipaBOM HIKHEM YIJTy OKHA.
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Layer Properties - roads | Symbology B

Q = single symbol =
@ information %
simple line
33 source == Simple line
& symbology
€€ Labels
Unit Millimeters >
B Masks .
Opacity _11100,0% v
", Disgrams Color | -
@& .
3D View
alg width | 1,50000 =RES
E Fields
. (73
E Attributes Form . Favorites a|~| 8
Joins
E_'i Augxiliary Storage
{;'.-® Actions dash black dash blue dash green dash red
- Display Sl v
i Save Symbol...
4 Rendering Symboly evels...

_ b Layer Rendering v| Clip Features to Canvas Extent
Variables _ | @Help Style ~ « Apply || % Cancel < OK

ITO OTKPOET AUATIOTOBOE OKHO:

Symbol Levels x

Enable symbol levels

Define the order in which the symbol layers are rendered. The numbers
in the cells define in which rendering pass the layer will be drawn.

@Help % Cancel

3. IIposepste Cif Bxutiouens! 1 ypoBHHE cuMBoda Enable symbol levels. 3atem Bbl MOXKeTe yCTAHOBUTH MOPSIOK
CJIOEB KaX/I0TO CUMBOJIA, BBE/Is1 COOTBETCTBYIOIMI HoMep ypoBHs. Houb (0) - HYKHUH clToH.
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B naem ciyuae, Mbl IPOCTO XOTHM aKTHBUPOBATh CJIEAYIOIIYIO OMLIHIO:

Symbol Levels

Enable symbol levels

Define the order in which the symbol layers are rendered. The numbers
in the cells define in which rendering pass the layer will be drawn.

Layer 0 Layer 1
= () 1

 cancet | x|

D70 0TOOPA3UT GETyIo JIMHHIO HAJl TPAHUIAMH TOJICTOH YePHOM JIMHHUM:
4. Iaxapl kimkHATE OK, 4TOOBI BEPHYTHCS K KapTe.

Kapra tenieps OyJeT BbITISAETh TaK:

N

Korna Bbl 3akoHUMTE, HEe 3a0y[bTe COXPAHUTb CaM CHUMBOJI, YTOObl HE MOTEPsATh padOTy, €CM Bbl CHOBa Oyzete
MEHSATb CUMBOJI. BBl MOkeTe COXpaHUTh TEKYILLMIA CTHJIb CUMBOJIA, Ha’kaB KHONKY CoXpaHUTb CTWIIb. .. Save Style...

B HIDKHEH JacTu auanoroBoro okHa CBovictBa ciost Layer Properties. Mbl Oynem nipumensite (popmat QGIS QML
Style File.
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CoxpaHHTe CBOHM CTHJIb B Manke solution/styles/better_roads.gml. Be Moxere 3arpy3uth paHee co-
XPpaHEHHBIA CTHIb B JII0OOE BpeMsl, KIIMKHYB Ha KHOIIKY Load Style.... IIpexie 4eM MeHATh CTH/Ib, UMENTe B BULY,
YTO JII0OOW HECOXPAHEHHbIN CTHUJIb, KOTOPBII BBl MEHsIeTe, OyIeT yTepsiH.

24.9 / Monpo6ynte camm

CHOBa U3MEHUTE BHEITHUH BUJI CJIOA 1 oads.

Crenaiite TOPOTH y3KUMHM U JKEJITHIMU, C TOHKAM OJIeIHO-CEPbIM KOHTYPOM M TOHKOU YEPHOM JIMHKUEH MOCepeTrHE.
[TomHuTE, YTO BaM MOKET MOTPEOOBATHCSI U3MEHHUTH NOPSIOK CJIOEB BU3yaIM3alluK B IMAJIOTOBOM OKHe Advanced
» Symbol levels....

IIpogepvme ceou pezynvmanul

2.4.10 == [lOnpobynTe camu

VPOBHHU CHUMBOJIOB Tak:ke paboTAIOT s KJIACCH(DUIIMPOBAHHBIX CIIOEB (T.€. CIIOEB, COAEPKAIIMIX HECKOIBKO CHMBO-
J0B). TTOCKOJIBKY MBI ellle He PpacCMOTpeSIH KJIacCU(PUKAIMIO, Bbl OyaeTe paboTath C HEKOTOPHIMU JIEMEHTAPHBIMU
MpeIBAPUTESIHHO KJIACCU(DUIIMPOBAHHBIMU JAHHBIMH.

1. Create a new project and add only the roads dataset.

2. Apply the style file advanced_levels_demo.qgml provided in exercise_data/styles to the
layer. This can be done through the Style » Load Style... combobox at the bottom of the Layer Properties
dialog.

3. pubnusure MectHOCTh roposa CeeiutennamSwellendam Swellendam.

4. Vicrionb3ysl CJIOM CUMBOJIOB, YOEIUTECh, YTO KOHTYPBI CJIOEB MIEPEXOAT JPYT B APYra, Kak MoKa3aHo Ha U300-
PaKeHUHU HUXKe:
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N RPN e 4
N Do =4
A A= % & Y

\‘%{@

IIpogepvme ceou peszynomaniol

2.4.11 / Upoem panblie: Tunbl cnost cuMBona

ITomumo YCTaHOBKHU LBETOB 3aJIMBKH U UCIIOJIb30BAHUA IMMPEAYCTAHOBJICHHBIX IJ_Ia6HOHOB, Bbl MOKETE UCIIOJIb30BATh
a0COJII0THO Pa3INYHbIE TUIIBI CJIOEB CUMBOJIOB. ,HO CUX IOP MbI UCTTIOJIL30BAJIN TOJILKO THUIT HpOCTOfI 3aJIMBKU Slmple
Fill. Bonee MNPOABHUHYTBIC THUIIBI CJIOEB CUMBOJIOB ITO3BOJIAIOT CIIE 0oJIbIIIEe HacCTpanBaTb CUMBOJIBI I10/] BacC.

Kasxpiii T BeKTOpa (TOYKA, JIMHKS U [IOJIMTOH) UMEET CBOM COOCTBEHHBIN HaOGOp TUIIOB cJIoeB CUMBOJIOB. CHauana
MBI paCCMOTpI/IM THIIBI, KOTOpLIe CyI_LleCTByIOT U1 TOYEK.

Tunbl ToyeuyHbIX cnoeB cCUMBONa

1. CHuMHTE OTMETKY CO BCEX clloeB, kpome Mecrta places.

2. VI3ameHuTe CBOMCTBA CUMBOJIA Jis1 Cllos places:
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Layer Properties - places | Symbology
| = single symbol

"i Information

@ Simple marker

-?& Source

Q’ Symbology

€3 Labels
B Masks Unit |Millimeter5 v|
_ Opacity 1/100,0% |7
. [MELEINE =
Color | I'|
- . -
ug 3D View Size  |2,00000 BKEE
E Fields Rotation | 0,00° EEKES
E Attributes Form . Favorites a ~| 8
Joins
ﬁ Augxiliary Storage ® O o O @] *
@ Actions
dot black dot white dot blue dok green dot red effect drop
. shadow
- Display
s Renderin
¢ pendering B ® o

Variables

. shield disability topo hospital  topo pop capital
H Metadata

'save Symbol... |Advanced -

m Dependencies

P Layer Rendering
.| @Help || style - JApply || Xcancel || JoK |

3. Bbl MOXeTe MOJyYTh JOCTYII K Pa3IMuHbIM TUIIAM CJIOEB CUMBOJIOB, BbIOpaB cioit [Ipocroii Mapkep Simple
marker Ha iepeBe CJIOeB CUMBOJIOB, a 3aTeM KJIMKHUTE Ha pacKkpeiBaloieecs: MeHio Symbol layer type:
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Layer Properties - places | Symbology

Q = Single symbol -

Ellipse marker

fi Information

Filled marker

15
W Source Font marker

(0t}

& symbology Geometry generator

Mask

€3 Labels .
Raster image marker —

O Masks symbol layer type[STiTE El TN

- : . SVG marker
. [MELEINE Size .
Vector field marker
Np 3D View Fill color N | S
E Fields stroke color | (I - <.
E Attributes Form Stroke style | —— Solid Line ~| &
. Stroke width | Hairline || Millimeters ~| &
Joins
. Join style 5 Bevel ~| S
ﬂ Augxiliary Storage
Rotation 0,00° = EL
o actions 0,000000 =
) X0, -
® Display Offset Millimeters ~| &
y | 0,000000 =
rd .
4  Rendering VCenter MRS
Anchor point
VELELIES . HCenter -~ &
[ Metadata
& OCO0AAKXT@++X 1| > D
ﬁ Dependencies £ a O O |_| I\ /] “ a -
L]

P Layer Rendering

@Help Style - «/ Apply || % Cancel

4. V3yunte pa3nuyHble AOCTYIHbIE BaM BApPHAHTHl M BHIOEPUTE CUMBOJI CO CTUJIEM, KOTOPBIH BBl CYUTAETE MOA-
XOMSIIM.

5. B ciydae comHenmii ucnons3yiite kpyrsiii [Ipoctoit mapkep Simple marker ¢ 6enoii pamKol u OyeHO-
3€JIeHOH 3aJIMBKOI, ¢ pa3MepoM Size B 3. 00 U mupuHOR mrpuxa Stroke width B 0 . 5.

Tunbl cnoeB NMHENHbIX CUMBOJIOB

Y0081 YBUACTD PA3JIMYHbIC ITAPAMETPhI, JOCTYITHBIC IJI JIMHEWHBIX JAaHHBIX HeO6XOHI/IMOI

1. M3menuts Tur cnost cumBoda Symbol layer type ¢ caMoro BEpXHETo CJIOsl CHMBOJIA roads Ha JInHIo Mapkepa
Marker line:
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Layer Properties - roads | Symbology
| = single symbol

G‘ Information ~ — Line | g |

3 | Simpleline
"W Source [E— 1
Q’ Symbology Geometry generator
Hashed line
€= Labels .
Marker line &
O Masks symbol layer type Simple line
- -
| Diagrams Color L JK="
N7 3D View Stroke width | 0,260000 a [3||Milimeters -~ | &,
E Fields Offset 10,000000 2| Millimeters  ~| &
E P — stroke style | ——Solid Line K=
: Join style | B Bevel -~ &
Joins
: Cap style | I square = | <
E" Augxiliary Storage
Use custom dash pattern
@ Actions 'Milimeters  ~ | €}
Display
" Rendering
Variables
{ Metadata
v| Enable symbol layer 4=, Draw effects

Dependencies

P Layer Rendering
.| @Help || style - | «/Apply || % cancel |[ oK ]

2. BwiOpath cioii Simple marker Ha nepeBe coeB cUMBOJA. VI3MeHHTE CBOWCTBA CMMBOJIA B COOTBETCTBUU C
JIAHHBIM JIMAJIOTOBBIM OKHOM:
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Layer Properties - roads | Symbology
| = single symbol

'ff Information ~ -+ Line |E|

=+« Marker line
{g_‘_- Source + - Marker — ==
°°°°°° =i
Q’ Symbology
€3 Labels
EED Masks symbol layer type Simple marker - 1=
'; Diagrams Size 0,500000 |$| | Millimeters ~| &
.r' 3D View Fill color | E| (=8
E e stroke color | (NI - <)
E Attributes Form Stroke style | ——Solid Line KEE
Soirs Stroke width | Hairline |f| | Millimeters MKEN
. Join style | B Bevel - &
5" Augxiliary Storage
Rotation | 0,00° | &
@ Actions =
x | 0,000000 2] TP Ter—— |
: Offset Millimeters -
O oisplay y |0,000000 B
4 Rendering \VCenter - &
Variables Anchor point 'HCenter aK=E
| Metadat:
AETN C000AAKXT@++X |5 D
"™ Dependencies Dd aoif hA M a -
: P Layer Rendering
.| @Help || style - JApply || Xcancel || JoK |

3. BuiOparts cioit Marker line v uamenuts nHTepBai Ha 1. 00:
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Layer Properties - roads | Symbology x

= Single symbol -
%) Information ~ . Line e
3
"W Source ~ + Marker =
simple marker L2
@' Symbology
€3 Labels
B Masks symbol layer type| Marker line -
: Diagrams Marker placement =,
.‘.’, 3D View (s with interval 1,000000 < | | Millimeters ~ &
E Fields ' on every vertex

_ on last vertex only

E Attributes Form ) )
' on first vertex only

Joins _) on central point
ﬁ Auxiliary Storage ("' on central point of segments
{;@ Actions | on every curve point
. Offset along line 0,000000 %! Millimeters ~| &
- Display
) ¥ Rotate marker to Follow line direction
4 Renderin u || TS
J Average angle over | 4,000000 < | Millimeters ~| &
R Line offset 0,000000 +| | Millimeters  ~ €L
E Metadata
v| Enable symbol layer 4=, Draw effects

ﬁ Dependencies

P Layer Rendering

@Help Style - «/ Apply || % Cancel

4. Ybenurhbcsi, 4TO ypPOBHU CUMBOJIA yKa3aHbl BEPHO (IIPH MOMOIIM AUATIOrOBOro okHa Advanced w Symbol levels,
KOTOpbIE MbI UCIIOJIb30BAJIU paHee) Mpell TeM, KaK 33a7aTh CTUJb.

ITocne Toro, kak BBl 33JaM CTWIb, IPOBEPHTE BAllM PE3YJIbTaThl Ha Kapre. Kak BUOUTE, 3TU CUMBOJIbI MEHSIOT
HaIpaBJieHHe BMeCTe C JIOPOroi, HO He BCera U3ruoarTcst BMECTe C Heil. DTO yJ00HO /JIsl HEKOTOPBIX LieJiel, HO He
1uts1 BeeX. [Ipu xketaHuy Bbl MOKETE U3MEHUTH CJION CUMBOJIA, O KOTOPOM MIET Peyb, Ha TOT, KOTOPBII ObLIT paHee.

Tunbl cnoes cUMBOJA NOJINFOHA

YrtoObl yBU/IETh PA3IMYHbIE MAPAMETPbI, IOCTYITHBIE s JAHHBIX [OJIUTOHA HEOOXOIUMO:
1. M3menuts ¢ Tun cnos cumBoina Symbol layer type Ha CIION water, Kak BbI IeaU paHee ISl APYTUX CJIOEB.
2. W3y4uTh, 4TO MOTYT ClIeJIaTh pa3InYHbIC BAPUAHTHI B CITHCKE.
3. BeiOpath OIMH U3 BAPUAHTOB, KOTOPHIN BaM MOAXO/IUT.
4

. Ecnm BB cOMHEBaeTech, TO MOKHO IPIMEHHUTH 3aIMBKY TOYSUHBIM y30poM Point pattern fill, co creqyiommumu
HapaMeTpaMH:
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Layer Properties - water | Symbology
& [Ssinglesymbol

"i Information - Fill |E|

- |

~ °  Point pattern fill
-?& Source ¥ © Marker — —
° =1
Q’ Symbology
€3 Labels
EED Masks symbol layer type Simple marker - 1=
: Diagrams Size 2,000000 |$||Millimeter5 ~| &
.r' 3D View Fill color | E| (=8
i re stroke color N - =
E Attributes Form Stroke style | ——Solid Line KEE
Soirs Stroke width | Hairline |‘| | Millimeters MKEN
. Join style | B Bevel - &
5" Augxiliary Storage
Rotation | 0,00° | &
@ Actions =
x | 0,000000 2] TP Ter—— |
: Offset Millimeters -
O oisplay y |0,000000 B
& Rendering \VCenter MRS
Variables Anchor point 'HCenter aK=E
 srctad
B vetesats OC00AARX T O+EFX ]| > D
"™ Dependencies Dd aoif hA M a -
P Layer Rendering
.| @Help || style - JApply || Xcancel || JoK |
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Layer Properties - water | Symbology
& [Ssinglesymbol

%) Information ~ . . Fill | |

5 . . Point pattern Fill
"W Source 8888 v © Marker — =
o000 © simple marker |E| |Q|
Q’ Symbology o000
€3 Labels
B Masks symbol layer type Point pattern fill - |
: Diagrams Distance
Horizontal | 4,000000 <| | Millimeters -
N7 3D View [ | Bl KE"
Vertical | 4,000000 2| Millimeters  ~| &
E Fields .
Displacement
B8 Attributes Form Horizontal | 0,000000 4| Mmillimeters  ~| &
Joins Vertical | 0,000000 4| Mmillimeters  ~ | &
ﬁ Augxiliary Storage Offset
Horizontal | 0,000000 2| Millimeters  ~| &
@ Actions - —
Vertical | 0,000000 2| Millimeters  ~| &
- Display
&  Rendering
Variables
E Metadata
M Dependencies v| Enable symbol layer 4=, Draw effects
P Layer Rendering
.| @Help || style - | «/Apply || % cancel |[ o OK ]

5. o6GaBUTbH HOBBII CJIOW CUMBOJIA C OOBIYHBIM pesxrMoM [Ipocroii 3anBku Simple fill.
6. Crenatb ero TaKUM Xke CBETJIO-TOJyObIM C TEMHO-CHHEH PaMKOA.

7. TlepeMecTHTh €ro MO CJIOH CHMBOJIA 3aIMBKAa TOYEYHBIM y30pPOM C MOMOIIBI0 KHOMKH [lepeMecTHTs BHU3
Move down:
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Layer Properties - water | Symbology X

Q = Single symbol -

fi Information ~ | Fill o
2 simple Fill = @

"% Source » . . Point pattern Fill Olla
& symbology -
€3 Labels
B Masks symbol layer type Simple Fill -
-

, Diagrams Fllcolor | M - (=,
N7 3D View Fill style I solid -la
E Fields stroke color | (I - =
E P — Stroke width | 0,260000 = | Millimeters ~| &

. Stroke style |—— Solid Line K=k
Joins
. Join style 5 Bevel ~| S
E_" Augxiliary Storage -
X | 0,000000 -
@ Actions Offset Millimeters -
. y | 0,000000 =
- Display
/ .
4 Rendering
Variables

E Metadata

ﬁ Dependencies v| Enable symbol layer <=, Draw effects
P Layer Rendering
@Help Style - «/ Apply || % Cancel o OK

B pesysbTate y Bac €CTh TEKCTYPHUPOBAHHBIN CUMBOJI JUIsI CJIOSI BOABI C JOTIOJHUTEILHBIM IPEUMYILECTBOM, 3aKJTIO-
YaIOIIUMCS B TOM, UTO Bbl MOXKETE U3MEHATh pa3Mep, (popMy U pacCTOsHKE A0 OTAEIbHBIX TOUYEK, COCTAB/IAIONIMX
TEKCTYPY.

24.12 / Monpobyite camu

IMprMennTe 3eNeHbI TPO3padHBIA [IBET 3aJIMBKU K CJIOI0 OXpaHseMble TEPPUTOPHHU protected_areas U N3MEHHUTE
KOHTYD, YTOOBI OH BBIIVISIAEI TaK:
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IIposepome ceou pesyrvmamol

2.4.13 == nem panbwe: CUMBONMKa reHepaTopa reometTpum
Bbl MOXeTe UCIIOIb30BaTh CHUMBOJIMKY IreHEpaTopa recOMETPrUU CO BCEMU TUIIaMU CJIOEB (TO‘-IKI/I, JIMHUU U l'IOJ'[I/II“OHbI).
HOJ‘IleeHHLIfI CUMBOJI HAIPAMYIO 3aBUCUT OT TUIIA CJIOS.

Bkpartiie, cuMBOJIFIKa TeHepaTopa eOMETPUH TO3BOJISIET BBHIIOJHITH HEKOTOPhIE MPOCTPAHCTBEHHBIEC OIEpaIiy
BHYTPHM CaMUX CHMBOJIOB. Hamprumep, BBl MOXeTe 3aITyCTUTh peaibHyI0 IEHTPOMIHYIO TPOCTPAHCTBEHHYIO OIepa-
LIMIO Ha CJIO€ MOJINTOHA, HE co3aBasd TOUEUHBIH CIIOM.

Bonee Toro, y Bac ecTb Bce BO3MOKHOCTH CTHJIM3AIMH 1J1s1 U3MEHEHHsT BHEIITHETO BHUIA MOJTYYHBIIIETOCs] CHMBOJIA.
Hagaiite nornpodyem!
1. BeiGepure cioii water.

2. Knuknure o Simple fill u uamenute Symbol layer type Ha Geometry generator.

44 FnaBa 2. Mogynb: Co3naHue u ndyyeHne 6a3oBow KapTbl



QGIS Training Manual

(] Centroid Fill
| Z single symbol

G‘ Information

Geometry ge'?eratcr
Gradient fill

Line pattern Fill
Point pattern Fill
Random marker Fill 3

-?& Source

Q’ Symbology

Raster image Fill
€3 Labels SVG Fill
Shapeburst Fill

B Masks symbol layer typ
simple Fill
-
, Diagrams Fill color | Outline: Arrow
.r' 3D View Fill style | Outline: Hashed line
- | Outline: Marker line
i Stroke color
E Fields Outline: simple line
E Attributes Form Stroke width | 0,260000 @ [7[|Millimeters ~ T &
. Stroke style | ——Solid Line -~ &
Joins
. Joinstyle | T Bevel -~ &
E" Augxiliary Storage -
x | 0,000000 - |—
@ Actions Offset |Millimeter5 v|
y | 0,000000 2] R
Display
" Rendering
Variables
{ Metadata
v| Enable symbol layer 4=, Draw effects

Dependencies

P Layer Rendering
.| @Help || style - JApply || Xcancel || JoK |

3. Tlepen Tem, Kak NPUCTYIUTh K HAMMCAHUIO MIPOCTPAHCTBEHHOTO 3aIpoca, Mbl JOJKHBI BBIOpaTh THIT reoMeT-
PUU Ha BBIXO/Ie, B pe3yJibTatax. B aTom npumepe Mbl coOrpaeMcsi co3aTh LIEHTPOUIBI TSI KXKJIOro 00bEeKTa,
nostoMmy u3Menute Tur reomerpuu Ha Point / Multipoint.

4. Ter[epb z(aBaﬁTe HaIMIIEM 3aIIpoC Ha MaHEJIN 3alIPpOCOB:

centroid ($geometry)
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Layer Properties - water | Symbology

| = single symbol

"i Information ~ @ Fill |

Geometry generator

-?& Source ~ @ Marker
® simple marker |

Q’ Symbology

€= Labels

B Masks symbol layer type Geometry generator - |

Diagrams Geometry type | " Point / MultiPaint - |

b
I —
\" 3D View centroid($geometry) |£|
E Fields

E Attributes Form

Joins

ﬁ Augxiliary Storage

@ Actions
- Display

" Rendering

Variables

| Metadata 4 L

Dependencies v/ Enable symbol layer <=, Draw effects

P Layer Rendering
.| @Help || style - | «/Apply || % cancel |[ o OK ]

5. Korna Bbl HaxkxmeTe OK, BBl YBUAUTE, UTO CIION water water 0TOOpaxaercst Kak TOUeUHbIN cJioi! MBI TOJIbKO
YTO BBITIOJIHWIM IPOCTPAHCTBEHHYIO OMEPALMIO0 B CAMOM CJI0€ CUMBOJIMKH, Pa3Be He YIUBUTEIHLHO?
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a *chapter_3 - QGIS [tm]

Project Edit View Layer Settings Plugins Vector Raster Database Web Progessing Help

BEBRR O:FEL2HPP R4 LR e Y E-LEE#IS-9 M
/ = 3 Qae ~9- B A " W
Layers o
e B3O TV E-RAD
S ]
Va °
®
water
1]
.
° °
° .
. °
. .
°
° °
°
. °
°
°
°
° e
.
°
Layers | Browser
Type to locate (Ctri+K

Coordinate| 20.4963.-33.9835 |® Scale|1:34265 |~ @ Magnifier| 100% | Rotation [0.0° :| v Render @ EPSG4326 @

Bnarouapﬂ CUMBOJIMKE IreHEpaTOpa rCOMETPUMN BbI HeﬁCTBHTeﬂbHO MOJKETE BBIATH 3a paMKun 00bIMHOTI CUMBOJIUKH.

mm= [TlOnpobynTe camu

['eHepaTop reoMeTpuH - TO ellie OJIH YPOBeHb CUMBOJIA. [TonpoOyiiTe 106aBuTh ettie ongut Simple fill nox Geometry
generator.

N3menuTe Takxke BHenHui Bu [IpocTtoro Mapkepa cuMBOJIMKY ['eHepaTopa reoMeTpuu.

OKoHYaTeIbHbIA PE3YIbTAT AJOJIKEH BBIITIAACTD CIEAYIOIIUM 06pa30M:
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IIposepvme céou pesyavmamol

24.14 = Npnem panbwe: Co3paem nonb3oBaTteNibCKy 3anMBKy cbopmMara
SVG

IIpumeuyanne: 15 BHIIOJHEHMs JJAHHOTO YIIPaXHEHHs BaM NOTPeOyeTCsl YCTaHOBUTH OECIUIATHYIO IIPOrpamMmy
JUIs1 pelaKTUPOBaHMUsI BEKTOPHBIX M300paxenuii ~Inkscape ~_.

1. 3amycrure mporpammy Inkscape. Bol yBuanTe cienyomuii uHTepeiic:
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0060 \ New document 1 - Inkscape
File Edit View Layer Object Path Text Filters Extepsions Help
DEEE Bk L&D @@Q nEE 9% FT208E
B 2 px =)
Bl A PP s AP |2 e WP i P AP PTTY 15, PETEPR (en PP T PN i AT PO TP A PRPN TP x PRPPNT s PYRTTNTN 7 PYPETTT i, ARPEPTIN v VTP i AT PT PN o ST PYPT TN d PEPETE N cod NPT (R
ME 3
N
£ &
Q -
P b
e -
O: @
& B
: 3
P ’
104 0}
A Bl
- o
g 5
2 (14]
B
s -
= Y
<€ -
. HE B U INN EEEEaS N | | L | |l . <
<E : ) .
e B @ % @ |-Layer L ¢ | No objects selected. Click, Shift-click, or drag around objects to select. ¥ 1ame 0 Z[3% [
BaM 3T0 10JKHO OBITH 3HAKOMO, €CJIM BbI KCTIOIL30BAJIH JPYTUe MPOrPaMMBbl /151 PeIaKTUPOBAHM ST BEKTOPHBIX
n3o0paxenuii, Takue kak Corel.
CHauasia Mbl I3MEHUM pa3Mep IMOJI0THA KapThI Ha pasMep, MOIXOISAIINHN 1T HEOOIBIIOW TEKCTYPHI.
2. Kimmkuaute Ha a1eMeHT MeHIo File » Document Properties. OTKpoeTcsi auanioropoe okHo Document Properties.
3. Usmenure Eqununpt Units Ha Tlukcenu px.
4. Wszmenute upuny Width u Beicoty Height na 100.
5. 3akpoiiTe qrasoroBoe OKHO IO 3aBEpIICHUN.
6. Kimknute Ha a5eMeHT MeHIo View » Zoom » Page, 4T00bI IPOCMOTPETH CTPAHUILY, C KOTOPOH BbI paboTaeTe.
7. Buibepure uncrpyment Kpyr Circle:
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0060 \ New document 1 - Inkscape
File Edit View Layer Object Path Text Filters Extensions Help
DEEéa Ak Dwb Q@@ Da@ d8 FPTeEE B
5} a = o] arec: (22T
P T I L T T T T T O L S RO - T O R - PR PR T o O A I TS T O O IO PR (TR R | P T T IO i RO I PR o AT TR e T S o SO B IO & e
o A
-
f" N ,
£ -
Q T
Olf: B
= >
3
B r >
T
= 3
59 B m |
W - ]
AT 4l
g (]
8 (1]
IE\: N
&
3 W
En
N
=
N
i
0
< € =) >
N HE B § NN EEEmaTT | | | | B | N
<€ B} >
e Na @ & @ [-Layer1 ¢ shift: dlick to toggle select; drag for rubberband selection; Al: click to select under: drag to move selected or select by touch Fom z e

8. KimkHMTE M TamuTe 1Mo CTpaHuLe, YToOB HAPUCOBATh SJUIHIC. YTOOBI MPEeBpaTHTh SJUIMIIC B KPYT YOEPKHU-
Baiite KHOMKY Ctr 1, 4TOOBI SJUIUIIC MPEBPATHIICS B KPYT, IIOKA BBl €T0 pUCYeTe.

9. KimkHMTE npaBoil KHOMKOW MBIIIM Ha TOJIBKO YTO CO3JAaHHBINA KPYI' M OTKPOWTE ero mapaMmeTps! 3ajMBKa U
O6Boaxa Fill and Stroke. Bbl MOXeTe N3MEHUTH €10 BU3yaIn3aluio, HallpuMep:

1. W3menuts et 3anusky :guilabel: Fill'Ha 61eaH0-cepo-romny6oit,
2. 3amath OoJiee TEMHBIN LIBET paMKH Ha BKJIaake Masku Stroke paint,

3. Hapucyiite TUHUIO ITPU MTOMOINK UHCTpyMeHTa Pyuka Stroke style.
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8.6.8 [x] New document 1 - Inkscape

Elle Edit View Layer Object Path Text Filters Extensions Help

OhBEE BB Dwld @Q@Q DEaE 28 PTaeEE « B

aQ qaeaa aeaa aa

\ e B BB B B B R TR B BB e @ [RF and Stroke (ShiftFCtr4+-F) ® &
e Fill|[stroke paint |=*stroke style o
I T p— +
. xOOOoBEO?

— % Flat color
|g| . @HSL CMYK | Wheel | cMS

@ - .

© - < M

o - : DG - | (7
&7 » COOODDDDNNNNNN - .|

7 .

@ - -

b ;
i? ¥ RGBA, [00065eff E;

iy Blur
lg ] D 0o |~
N: T Opacity, % EL|
ﬂ i {11 [100.0 |& 0
® . (in]
&

S - v

7
& -

N
< (= =) >

L HE N 0 NN EmEas | L L I
-+ — ) >
Sheve: T 0 (0] % @ [tayers ¢ X 878 2 o

10. Hapwucyiite THHUMIO TIPH TOMOIIM HHCTpYMeHTa Pyuka Pencil:

1. Kiukuute oquH pa3, 4ToObl HAYaTh JIMHUK. YepkuBainTe Ct r1 YToObBI CAeIaTh MPUBSA3KY K IIpUpAIlie-
HuIo B 15 rpagycos.

2. HepeMCCTI/ITC YKa3zaTeJib 10 TOPU30HTAIN U MOCTABbTE TOYKY MPOCTHIM HAXKATUEM Ha KJIMK.

3. Knukante n TMIPUBSKUATE K BEPIIMHE JIMHAA W IPOBEANTE BEPTUKAJIBHYIO JIMHUIO, 3aKaHYMBAIOIIYIOCA
IIPOCTBIM KJIMKOM.

4, Tenepb COCJUHUTE IB€ KOHEYHbIC BEPUINHBI.

5. Uzmenute HBET U IIUPUHY CUMBOJIa TPEYTrOJIbHUKA, 4TOOBI OH COOTBETCTBOBAJI 06BOJ]K€ Kpyra, u nepe-
MECTHUTE €ro 110 Mepe HCO6XO,I[I/IMOCTI/I, YTOOBI B UTOTE MOJIYYIHJICA CIIe,IIyIOH.lI/Iﬁ CHUMBOJI:
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000 %/ New document 1 - Inkscape
Eile Edit Wew Layer Object Path Text Filters Extensions Help
OhBdé& Bk Dwld Q@@ TEE H PTeRHE B
B 8 - (o s) o EEEE
‘T| o P B B B T e T I PR BT @ B3Rl and Stroke (Shift+Ctrl4+F) E@|§'\
N =2
"o 0 Fill | 'stroke paint \=2stroke style
N -
M-
q 3 No objects
(32
O : [
i R
T
] » 3
W -
¥ h
¥ - ‘
Al = o 5 +]
8- pacity, %
G x (58
S =
2 i
™ - ¥
/T
&b
=
8
I
8
o Y
= € : J >
L HE N U IEN EEmEaS | i L L I
+ P >
M T o & @[ -Layer1 2 | No objects selected. Click, Shift+click, or drag around objects to select T oz

11. Ecnu nonyuyuBIIMIACSA CUMBOJ Bac yJOBJIETBOPUII, TO COXPAHUTE €ro Kak landuse_symbol B katajore, B KOTO-

POM HaXOIUTCS TAHHBIA Kypc, B exercise_data/symbols, Kak ¢aitn SVG.
Brmosnaute crnenyioriee B QGIS:

1. Otkpoiite Layer Properties nns ciosi landuse.

2. Bo Bkiaake 'Q( Symbology, naMeHuTe CTpyKTypy CUMBOJIa uepe3 3ameHy Tuna cios cumBona Symbol Layer

Type na @aitn SVG Fill™, xak yka3aHO HUXeE.

3. KimkHHTEe KHOIKY ... M 3aTteM BoiOpath aiin Select File..., 4ToObI BHIOpaTh KapTHHKY SVG.

®aiin noGaBIeH B IepeBO CUMBOJIOB, U TEIEPh Bbl MOKETE HACTPAUBATh €r0 Pa3INYHbIE XapaKTEPUCTUKH (1[Be-

Ta, yroj, 3(ppeKThl, €AUHHULIBI U3MEPEHUS ... ).
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Layer Properties - landuse | Symbology

| = single symbol

%) Information ~ [ Fill | |
— A SVG Fill
-?& Source = :J:i v — Line —
vl l—‘ — simple line |23
Q’ Symbology E —
€3 Labels
B Masks symbol layer type SVG fill -
: Diagrams Texture width | 10,000000 |:| | Millimeters - &
lr' 3D View Fill color r=h
E Fields Stroke color
BB Attributes Form Stroke width | || Millimeters  ~| &
: Rotation 0,00° i &
Joins
SVG Groups SVG symbols
E" Augxiliary Storage ~ [ App Symbols - ~ _ . : il F
@ : [1 accommodation o =
e} Actions 3 amenity . B
@ oisplay | arrows : 2= Wy W .
[ backgrounds . P,
& Rendering [ components 1 A O~ '
[ crosses ) o _
Variables [J emergency i _ K
[7 entertainment e  llwe |
E Metadata [0 food [ I i |
[ gpsicons . | A | ﬂ%
E Dependencies [ health O m A
= Lecend 1 landmark = A\ </~ ’(:}‘ [E— - =
egen —
d snts/GIS/QGIS/TrainingManual/exercise_data/symbols/landuse_symbol.svg @ || ... [+ &
& qais server
v| Enable symbol layer <, Draw effects

ﬂ Digitizing

» Layer Rendering
| @Help || style -  Japply | %cancel |[ ok |

I[Mocne TOro, Kak Bbl MOATBEPAUTE JCHUCTBUE B TUAIOTOBOM OKHe, (DYHKLIMHU B ciioe landuse Ternepb NOJKHBI OBITh
HabOpPOM CUMBOJIOB, IOKA3BIBAIOIIMX TEKCTYPY, MOJOOHYIO TOH, YTO Ha cleaylomel kapte. Ecim Tekctyp He BUAHO,
BaM MOJKET IOTpeOOBaThCS MPUOIM3UTH MOJIOTHO KAPThl WM YCTAHOBUTH B CBOMCTBaxX ciios Gosbiuyio lupuny
TeKCTypol Texture width.
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symbology - QGIS o

Project Edit Wiew Layer Settings Plugins Vector Raster Database Web Help

NEERREY Q@ LLpHPPRAANRS &G E-N-EET -
BV AR V/BRR-ZT >0 B =qEHuemgn R 4

Layers (=)
o @ ® T g~ »

C

Layers = Browser

Q Type to locate (Ctrl+K) di| 20.4301,-33.8939 |9 /11109148 |~ | @ n|100% 2 |00° +| V| Render & EPSG:4326 @

2.4.15 B 3aknwuyeHuUm

M3mMeHeHne CHMBOJIOB [JIs1 Pa3HBIX CJIOEB, IPEBPATUIIM KOJUICKLMIO BEKTOPHBIX (Daii/IoB B yAOOOUHUTAEMYIO KapTy.
BbI HE TOJIBKO BUANTE, YTO IPOUCXOAUT, HO U Jaxe JIIoOyeTech STUM!

2.4.16 [ononHutenbHblie Matepuanbl AN YTeHUs

[Ipumeps! kpacuBbix Kapt Examples of Beautiful Maps

2.4.17 Yto panbwe?

M3meHeHne CUMBOJIOB 1151 LIE/IbIX CJIOEB MOJIE3HO, OHAKO MH(OpPMALIH, CoAepxKalasics B KaxI0M CJIOe, eIle He JJ0-
CTyTIHA JUIs TeX, KTO YUTaeT 3T KapThl. Kak HasbBatoTca yauupl? K kakum aJMUHUCTPAaTUBHBIM paiioHaM OTHOCATCS
onpejeseHHble paiionsl? KakoBa oTHOcuTenbHaS Mutonaas epM? Bes sta nHbopmanus no-npexHeMy ckpoita. Ha
CJIeyIOIIEeM 3aHsATHI MBI pa30epeM, Kak IpeCTaBUTh 3TH JaHHbIE Ha Ballel Kapre.

IIpumeuanune: Bbl He 3a0bUIM COXPAHWUTH Ballly KapTy HeJaBHO?
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FMABA 3

Moaynb: Knaccmdmkaums BeKTOPHbIX AaHHbIX

Knaccndrkanmst BEKTOPHBIX AaHHBIX TO3BOJISIET MIPUCBANBATh Pa3JIMUHble CUMBOJIBI (PYHKIUSIM (pa3Hble OOBEKTHI
B OJHOM U TOM € CJIO€) B 3aBUCHMOCTH OT UX aTpuOyToB (aTprOyTOB). DTO MO3BOJISET JIIOOOMY, KTO UCIIONB3YeT
KapTy, JIETKO BUJIETh aTPHOYTHI Pa3IMYHbIX (DYHKLIIH.

3.1 3aHsATHe: ATPUOYTbl BEKTOPHbIX AaHHbIX

BekTopHble 1aHHbIe, BEPOSITHO, SIBJISIOTCS HanOoJiee pacpOCTPaHEHHBIM BUJIOM JAHHBIX B [IOBCEAHEBHOM HCIIONb-
3oBaHuM GIS. BekTopHas Mojels mpeAcTaBiiseT pacnooxeHue u ¢gopMy reorpapuyeckux (PyHKIUI ¢ TOMOUIBIO
TOYEK, JIMHUI 1 MOJIMTOHOB (a JJIs1 TPEXMEPHBIX AaHHBIX TaKKe MOBEPXHOCTh M 00bEM), B TO BpeMsI KaK Jpyrue ee
CBOFCTBA BKJIIOYEHBI KAK aTPUOYTHIATPUOYTHI (4aCTO MpeCTaBlieHbl B Buje tabnuis B QGIS).

Jlo cux Mmop HU OJHO M3 N3MEHEHHUH, KOTOpoe MBI BHECIH B KapTy, HE MOBJIMSAJIO Ha OToOpaxaeMble 00beKTHL. py-
TMMH CJIOBAMH, BCE YUYACTKM 3€MJIM TTOXO0XH JIPYT Ha Apyra, ¥ Bce JOPOTH MOXO0XH JIpYyT Ha Apyra. [ a1 Ha Kapry,
CMOTPAILIMIA HAYEro He 3HaeT O JOpOorax, KOTOpble OH BUIWT, TOJBKO TO, YTO HA OIPE/ICICHHOW MECTHOCTH €CTh
Jlopora ornpeJeseHHON (hOpMBl.

Ho Best cuna GIS cocrout B TOM, YTO BCe 0OOBEKTHI, KOTOPbIE BUAHBI Ha KapTe, Takke MMeIoT aTpuOyThl. KapThl B
GIS - 310 He npocTo u306paxenusi. OHU MPEJICTABISIOT He TOJILKO OOBEKTHI HA MECTax, HO M MH(OPMAIHIO 00 3THX
0OBEKTax.

Ilens qaHHOTO 3aHATHS: Y3HATH O CTPYKTYPE BEKTOPHBIX JIAaHHBIX ¥ N3Y4YHTh aTPUOYTHI JaHHBIX OOBEKTA.

3.1.1 \ Npem panblie: O630p atpubyToB cnos
BaxHo 3HaTh, 4TO JaHHbIE, C KOTOPHIMU BbI 6y,ueTe pa60TaTL, HE TOJIKO MOKa3bIBAIOT, I/1€ HAXOIATCA OOBEKTHI B
MPOCTPAHCTBE, HO TaKkKe FOBOPSAT BaM, YUTO 3TO 3a OOBEKTHI.

Hcxons U3 mpepIaymero ynpaxHeHrsl Ha Ballly KapTy JIOJDKeH ObITh 3arpykeH ciloil protected_areas. Eciu
OH He 3arpyeH, TO Bbl MOXeTe HailTh Habop gaHHbIX popmaTa ESRI Shapefile protected_areas.shp ESRI
Shapefile B kaTanore exercise_data/shapefile.

INonuroHs!, peACTaBIIAIONME OXpaHseMble TEPPUTOPUH, COCTABISAIOT MPOCTPAHCTBEHHbIE JaHHbIE, HO MBI MO-
KeM y3HaTh 00Jibllle 00 OXpaHSIEMbIX TEPPUTOPUSIX, U3YUMB TAOJINIy aTPHOYTOB.

1. Ha manemu Ciiou Layers KIIMKHUTE Cllodl protected_areas, YTOOBl BHIOPATh €T0.
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2. Ha IManenu MuctpymenTsl atpudyToB Aftributes Toolbar xivkHUTe Ha KHOMKY OTKPBITH TAOAMIY aTpHOYTOB

[==]
Open Attribute Table  yrpoercst HOBOe OKHO ¢ TabyMIIel aTpuOyTOB cllosi protected_areas.

\
y o f LT E & D P E = A &
full_id osm_id osm_type boundary is_in leisure name type wikidata wil
1/ 12855697 2855697 relation protected_a... Western Ca... nature_reser... Bontebok N... boundary Q892884 en:B¢
2 w187055916 187055916 way protected_a... Western Ca... nature_reser... Marloth Nat... N

1

T show All Features _

Crpoka Ha3bIBaeTcs 3anuch, oHa cBsa3aHa ¢ @ynknmeit Ha [Tonotae KapThl, Hanpumep, kak moiurod. CToi-
6e1 HazbiBaeTcsi [loJre (1 ATprOYTHI) M MMEeT HaMMEHOBaHUE, KOTOPOE OMOTaeT OIUCATh €ro, HAIlpUMep
Nms name wm Unentudukarop id. 3HaueHus B si9efikax Has3blBalOTCS 3HAYeHHs1 aTpuOyToB. [laHHbIE
orpeeeHus] OOBIYHO UCTIONB3YI0TCA B GIS, T03TOMY MOJIE3HO C HUIMU O3HAKOMUTHCS.

B cioe protected_areas uMenTcs aBe (DyHKIMH, IIPEACTaBICHHBIE IBYMsI MTOJIUTOHAMH, KOTOPBIE MBI
BuauM Ha [looTHE KapThl.

IIpumeuyanne: YtoObl MOHSATH, YTO MPECTABISIOT COOON noAsi U 3HAUEHUS ampudymos, MOKET ToTpedo-
BaThCs JOKYMEHTALMs (MM METa/IaHHBIE), OIMCHIBAIOIIAsT CMBIC] 3HAUSHHUH aTprOyTOB. OOBIYHO OHA JIOCTYII-
Ha y co3jatesst Habopa JaHHbIX.

,Ila.nee paccMOTpHUM, KaK 3aIll1Chb B Ta6m/1ue anI/I6yTOB CBdA3aHa C ITOJIMI'OHOM, KOTOpLIﬁ MbI BUJIMM Ha IIOJIOTHE KapPThI.

1.

Bepnurecsh k rimaBHoMy okHy QGIS.

JR—

Ha nanemu Attributes Toolbar xnMkHUTE Ha KHONKY BbiOpath (pyHKIIHIO [,§ Select Feature
Y6eaurech B TOM, 4TO CJION protected_areas no-npexHeMy BHIOpaH Ha aHen Layers.
p y

HepeMeCTI/ITG MbIb Ha [TonoTHO KaprI Y KJIMKHUTE JIEBOM KHOIKOM MBIIIIY HA MEHBIIIEM U3 ABYX ITIOJIATOHOB.
Tlonuron craner KEJITBIM, YKa3blBas Ha TO, YTO OH BbI6paH.
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@ basic_map - QGIS — O %
Project Ed

IEBRRH 9PALNPP Q. BN ¢ Mie %
BQV.ARD ./ - =4%-@ B
Q 2 2] px Y -

ugins Vector Raster Database Web Mesh Help

Layer Settings

Browser =
D&THO
v Favorites =

v [[" Spatial Bookmarks
[ Project Home
¢ [él Home
v Gy
v @ GeoPackage
v /# Spatialite
& PostGIS
P MssaL
@ Oracle
¥ pB2
@ WMS/WMTS
» & XYZ Tiles =
Layers (=]E3]
« [ ® T & -8 & O
v/ — roads
v/ — rivers
v ® places
v [l protected areas

| & Type tolocate (Ctri+K) | 1 fea ordin| 20.5436,-34.0557 |¥ 2/1:162003 |~ | @ gni(100% 3| at (0.0° |3/ V/Render X @

5. Bepnurech k okny Tadnmua atpubytoB Attribute Table, Bbl yBUANTE BBIICIEHHYIO 3aIMCh (CTPOKY). DTO 3Ha-
YeHHsI aTPUOYTOB BHIOPAHHOTO MOJIUTOHA.

Q protected_areas ©: Features Total: 2, Filtered: 2, Selected: 1 - [l *
/ (] 2 € A T ESD PE =8 &
full id osm id 0sm type boundary is in leisure name tvpe wikidata Wi

) r2855697 protected_a... |Western Ca... |nature_reser... |Bontebok M... |boundary (892884

2/w187055916 187055916 way protected_a... Western Ca... nature_reser... Marloth Mat... NULL NULL NULJ

q y
| 7 show All Features _ 2|8
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Mo3kHO Takxke BbIOpaTh (DYHKIIMIO C OMOIIIbI0 Tabauiibl aTpubyTOB.

1. B okne Attribute Table B xpaiiHeM JIEBOM YIIIy KJIMKHUTE IO HOMEPY CTPOKM 3aIllCH, KOTOpas B JaHHbINA
MOMEHT He BHIOpaHa.

(R protected_areas : Features Total: 2, Filtered: 2, Selected: 1 - O X
> ® 0§ LV E D PE = 56

full id osm id osm tvpe boundary is in leisure name tvpe wikidata wi
() r2855697 2855697 protected_a... |Western Ca... |nature_reser... |Bontebok M...

187055916 187055916 way protected_a... Western Ca... nature_reser... Marloth Mat... NULL NULL MNULI

K] L3

T show All Features _

2. Bepnurech k rmaBHOMy okHy QGIS n nmocmotpute Ha IMosotHo Kaptsl. Bel josmkHBI yBUAETh OosbImil U3
JIBYX TTOJTUITOHOB, OKPAIIICHHBIN B KEJITHIN ITBET.

3. YroObl OTMEHHTDH BblesIeHue (DYHKIMHU, uaute K okHy Aftribute Table v kKavKHWTEe Ha KHONKY «OTMEHUTh
BBIIEJICHHE BCEX (1)}7HK].[I/II‘/)I W3 CIIOS» Du'] Deselect all features from the layer.

WHorna B MOJIOTHE KapThl 0TOOpakeHO MHOTO (DYHKIM, M MOXKET ObITh TPYAHO YBHIETh, Kakast (DyHKLIMS BhIOpaHa
n3 Tabmuus! aTpudyToB. [IpyruM crocoOOM ONpesieseHnsl MECTONONOKeH!Us (DYHKLMU SABJISETCS UCIOJIb30BaHUE
uHcrpyMenTa Flash Feature.

1. B A#tribute Table knMKHWTE NPaBOM KHONKOHM MBIIIM JIIOOYI0 STYEHKY B CTPOKE CO 3HAUYeHWEM arpulyTa
r2855697 mmanong full_id.

2. B koHTeKCTHOM MeHIo Bbioepure Flash Feature 1. w npocmotpute IlonotHo KapTsi.

() protected_areas : Features Total: 2, Filte
/ ~ B 5
~full id osm id osm tvpe
1 - Select All
2|w1870559 Copy Cell Content
Zoom to Feature
Pan to Feature

Flash Feature

Open Form

BbI JOKHBI YBUZETh, KK MOJIATOH HECKOJIBKO Pa3 MUTHET KPacHbIM. EC/M BBI POITYCTIIIM MUTAHKE, [IOTIPO-
OyiiTe elie pas.

Ouepe/tHOI 1M0JIe3HBI UHCTPYMEHT — 3T0 [1pndmsuts 1o dpyHkimu Zoom to Feature kotopas coobmaer QGIS o
HEeoO0X0OMMOCTH MaCIITaOMPOBaHKUS O UHTepecyoIeil (hyHKIUH.
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1. B Ta6nuue Attribute Table xMKHUTE PaBOi KHOMKOM MbIIIHN JIIOOYIO TYEHKY B CTPOKE, KOTOpasi UMeeT 3Ha-

YyeHue aTpuoyTa r2855697 misg nonst full_id.

2. B KOHTEKCTHOM MEHIO KJIMKHUTE Ha Zoom to Feature.

]
I R 5]

JOCCCOT

N r2855697 -
' Select All

2 w1870559
Copy Cell Content

Zoom to Feature

Pan to Feature

Flash Feature

Open Form

0] protected_areas :: Features Total: 2, Fi

3 E]

full id osm id osm tvi

HOCMOTpI/ITC Ha [lonotHO KaprI. TCHGPI) TMOJIMT'OH JOJIZKEH 3aHUMATh BCIO TUIOIIA/Ib IMOJIOTHA KaPThI.

Tenepb Bbl MOXKETE 3aKPBITh TAOJIHILY ATPHOYTOB.

3.1.2 \ Monpobynte camu: n3yunte atpubyTbl BEKTOPHbIX AaHHbIX

1. CkousbKo MoJieil JOCTYIHO B cJoe rivers?

2. Pacckakute HAM HEMHOIO O MECTax l"opona town B BallleM Ha60pe JAaHHBIX.

3. Ortkporite Tabnuity aTpuOyTOB 151 ciiost places. Kakoe mosie Ob110 Ob1 HanboJ1ee MOJe3HO MPEeICTABUTh B (hop-

Me HaJnucen u nodemy?

IIpogepvme ceou pezynvmanmuol

3.1.3 B 3aknouyeHumn

Tenepb BbI 3HaeTe, KaK UCIOJB30BaTh TAOIUILy aTPUOYTOB, YTOOBI YBUJIETh, YTO HA CAMOM JIeJie COAEPKHUTCS B HC-
MOJIb3yeMbIX BaMU JaHHbIX. JI000# HAOOp JaHHBIX OyAeT BaM IOJIE3eH TOJIBKO B TOM CJIydae, €CIi B HEM eCTh MHTe-
pecyrorue Bac aTpuOyThl. Eciiv BBl 3HaeTe, Kakoi aTpuOyT BaM HyKeH, Bbl MOKeTe ObICTPO PEIIUTh, MOXKETE JIM BbI
WCTIOJIb30BaTh NAHHBIA HAOOP MAHHBIX WIM BaM HY)KHO HAUTU NPYTrOi, UMEIOIINIA HeOOXOJUMBIE JTaHHbIC aTPUOYTOB.

3.1.4 Yro panblue?

Pa3nble aTpuOyThl MOJIE3HBI AT pa3HBIX Lieteld. HekoTopble U3 HUX MOTYT OBITh OTOOpaKeHB! HEMOCPEICTBEHHO B
BUJIE TEKCTa JAJIs IPOCMOTPa M0JIb30BaTeIeM KapThl. Bbl y3HaeTe, Kak 3To clieaTh, Ha CJIEJyIOIEM 3aHATHH.

3.1. 3aHsTne: ATpubYThl BEKTOPHBIX HAaHHbIX
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3.2 3aHatne: Hapnucu/meTku

Mo:XHO 100aBUTh HAJIIKCH/METKH JUTsl OToOpakeHus modor nH(opMarmu 00 oobekte. Haamucu MoryT ObITh CBSI-
3aHbI C JTIOOBIM BeKTOpHBIM citoeM. CoflepaHus1 3TUX HAMIKCEN 3aBUCST OT JIAHHBIX ATPUOYTOB CJIOSL.

I_IeJll) JAQHHOTI0 3aHATHA: Hcmonp30Bath B clioe HYXHBIE 1 KPACUBBIE H&,I[HI/ICI/I/ MCTKHU.

3.2.1 \ WUnem panbuwe: Ucnonb3yem Haanucu/meTku

B niepByio ouepenp yoenurtech, 4To BaM BUHA KHOMKa "3kt B cucteme GUI:
1. Ilpoiinute k snemeHnTty MeHio View » Toolbars.

2. Ybemutech, UTO PSAOM C MaHENbI0 HHCTpyMeHToB Label Toolbar ycranoBmneH ¢naxok. Ecim ero Her, KIMK-
nure Ha Label Toolbar, 4ToObl akTHBUPOBATh (PIIAKOK.

3. KnukHuTe Ha ClIOM places Ha naHenu Layers, 9ToObl €r0 BbIIEIUTD.

4. KnMkHUTE Ha KHOIKY Ha MaHeJIM MHCTPYMEHTOB “2E2|, yToOBl OTKPHITh BKIAJIKY Labels Ha naneny CTHIIb criost
Layer Styling.

5. Tlepexsmountech ¢ No Labels Ha ‘2tz Single Labels (OnuHOYHBIE HAAIICH/METKH).

Bawm HyX)HO OyaeT BbIOpaTh, Kakoe 1oJjie B aTpuoyTax OyIeT UCIOb30BaThes /sl Haamucen. Ha mpepiyiem
3aHATUM BB PEIIWIIH, 4TO nosie ViMsi name HanbGosiee MOAXOMUT YISl IAHHOH LeJIH.

6. BriOepute name u3 cnucka 3HaYeHUS:
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Layer Styling )
o places -

=1 Single Labels - | |4
- Value |abc name -~ || &

abe i abe abc . J

-

Text

Font | MS ShellDig 2 | S

Style Regular = @
UE[sE BE I€&

Size | 10.0000 | &
Paints | S

coor | (GGG - <.

Dpaﬂt? __l IDD.D E‘ru -

Tl Favorites v | 8
= Save Settings...

| e v Live update apply

7. Kimkuaure [pumenuts Apply.

Ha kapTe JOKHBI TIOABUTHCS HAMUCKH/ METKY CJIEAYIONIAM 00pa3om:
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() *basic_map - QGIS 3efaefidf1 - [m] x
Project Edit View Layer Seftings Plugins Vector Raster Database Mesh Processing Help

DEEBRER Qe RPRP A RBULNOR o -KRra-H-EE#I=-9 M-
RV AW @SS = = Q qE P RY a

Browser =165 Layer Styling @
qz*ao |.,"plaoes vl
= '+ Favorites = “l @ Single Labels a | ‘Fl
» 5 QGIS-Training-Data'e =
~ [ QGIS-Training-Data\s ___value | abc name M| \£|

v [ styles
v @ basic_map
1" Spatial Bookmarks
[ Project Home
[é2] Home
e
" GeoPackage
f SpatiaLite
@ postGls
P mssaL
DB2
B wms wmTS
ﬂ Wector Tiles
55 NVZ Tiles
@ wes
() WFS / OGC API - Feature
) ows
& ArcGisMapServer

AR e e :
4 »
Layers (=15
[« & ® 7 &~ »

v| @ places
v roads
v rivers
v| M buitdings
v ¥ water

v . protected_areas
v landuse

e
it abe al

g

9 | O

|

Font  |Ms Shel Dig 2 MK =S

v vy owow

Style |Regu|ar - ‘ El,
uese s8la/&
Size | 10.0000 BESE

| Paints - | S

-

L Favorites L <] '| 4

‘Sava Settings... |

v liveupdate |  Apply |

| A Type to locate (cul+) Coordinate| 20.5409,-33.3522 | W Scale umes10 v | (@ Magnifier| 100% |2] Rotaton [0.0° 2| W/Render @ EpsGiazes @

3.2.2 \ Npem panble: MeHsiem napameTpbl Haanucewn

B 3aBucuMocTH OT CTHJIEH, KOTOPbIE Bl BHIOPAJIH JUIsl CBOEH KapThl Ha MPEIbIAYyIINX 3aHATHAX, BB MOXeTe OOHapy-
KUTh, 4TO HAANKCKH/ METKY UMEIOT HEeTTPaBUJIbHBIN (DOPMAT M OHU JIMOO MEPEK PhIBAIOTCS, TMOO HAXOATCS CIIMIIKOM
JAJIEKO OT CBOMX TOUYEYHBIX MApPKEPOB.

IIpumeuanue: Panee, BbI IPIMEHSIIA KHOIIKY Ha niaHesu Label Toolbar, ato6bt OTKpBITH NaHe b CTUIH CIOs
Layer Styling. Taxxe, kak u ¢ CumBosukoit Symbology, Te ke mapameTpsl HAAITHCEH JOCTYIHBI Uyepes maHen b Layer
Styling v uepe3 ntuanoroBoe okHo CBoiicTBa cios1 Layer Properties. 37ech Bbl OyeTe UCTIONIb30BATh JMAJIOr0BOE OKHO
Layer Properties.

1. Otkpoiite guanoropoe oKHO Layer Properties DBOIHBIM Ha)XaTueM Ha cliod places.
2. BwiGepurte BKIAIKY Labels.

3. Y6emurech, uto BbIOpaH Text B CIVICKE MapaMeTPOB CJIeBa, 3aTeM OOHOBUTE MapamMeTps! (POPMATUPOBAHUS
TEKCTa, YTOOBI OHM COOTBETCTBOBAJIU [TOKA3aHHBIM 3/1ECh:
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@ Layer Properties - places | Labels

Information

Source

Symbology

Masks

Diagrams

Attributes Form
Joins

iliary Storage
Actions
Display
Rendering
Variables
Metadata
Dependencies
Legend
OGIS Server

Digitizing

=1 Single Labels

Value | abc name

w Text Sample

Lorem Ipsum

Larem Ipsum

abe Text

2% Farmatting
abe Byffer

abc! Mask

. Background
- Shadow
}” Callouts
1-:0 Placement

_,"’ Rendering

-|[e
4 | | 1:59510 B |- -

Text
Font |Arial Vl E,
Style Regular - @.
u € s & B & I|E€
Size | 13.0000 A ER
Points | S
coor | (. - <.
Opacity 1| 100.0 % 3| €
L Favorites >~ | 8%

oK Cancel

Save Settings...

Help

4. Knuknure I[Ipumenuts Apply.

Takoii pudT MoKeT ObITh KPyIHEe ¥ G0Jiee 3HAKOMBIM ITOJIb30BATENISIM, HO €r0 YNTa0eTbHOCTb NO-IIPeKHEMY
3aBHCUT OT TOTO, KaKKe CJION 0TOOpakaloTcsl NoJ HUM. UToObl peruTh 3Ty NpobieMy, JaBaiTe B3IJIsHEM Ha
omuio Bydep Buffer.

. Buibepute Buffer u3 cnucka napameTpoB ciieBa.

. YcraHoBuTe (hiaxoK psiioM ¢ Haanwuckio HapucoBaTh TekcToBbild Oydep Draw text buffer, 3atem BeiGepute
rapaMeTphl, COOTBETCTBYIOIINE MOKa3aHHBIM 3/1ECh:

3.2. 3aHsiTMe: Hagnucun/meTtkn
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@ Layer Properties - places | Labels

*
Q =1 Single Labels = | |E|
= Value |ib< name - | |E|
w Text Sample
Lorem Ipsum
{@be| Labels _— B— !
|Loren1 Ipsum |3| |1;59510 - | |m|v| | |v|
b .l W S
e abe Text Buffer
e Formatting v | Draw text buffer @,
= = Size | 1.0000 2 €
= abe’ Mask
-0 @ Background | Millmeters ~| S
=0 _
J Shadow Color | ==t
abe =
/ Callouts
Y V| Color buffer's fill
#y¥ Placement
7 Rendering Oparity 1] 100.0 % | &
) Pen join style | B Bevel = | =l
Blend mode |Normal - | @
Draw effects
L%
%}
= | style - | oK | | cancel || Apply [ Help |

7. Kiuxnure Ipumenuts Apply.

Bbl yBUIMTE, YTO TOSIBIISIETCS LIBETHOW Oydep MM IpaHuLia K HAOIUCAM MeCT, UTO YIPOIIAeT UX BHIOOP Ha

Kapre:
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Q *basic_map - QGIS 3ebaefidf1 - O X
Project Edit View Layer Settings Plugins Vector Raster Database Mesh Progessing Help
DoAY Uer,prRPPRPra i BL0OR I -K-B-H-BEERXT=-0 W~

RV AW @SS S = REaqgeaas  ‘a il
Browser (=]
Qvme
- j,z Favorites =l
3 QGIS-Training-Data'
~ [ QGIS-Training-Data\s
¥ [ styles
3 Q basic_map
Lm Spatial Bookmarks
Project Home
[é2] Home
[ ca
" GeoPackage
f Spatialite
@ postGls
P mssaL
2 oe2
B wms wmTS
H Wector Tiles
55 NVZ Tiles
@ wes
() WFS / OGC AP! - Feature |
) ows
& ArcGisMapServer -
pey -
< [ [»

Layers (=15
o« B3O T &E-F »

v vy owow

-

%

| Q Type to locate (cul+k) Coordinate | 20.4841,-33.3781 | % Scale 142259 v | (@ Magrifier | 100% |+] Rrotaton [0.0° 2| ViRendsr @epsciazs @

Teneps Mbl MOKEM 3aHATHCS TO3UIMOHUPOBAHUEM HAJIUCEH OTHOCUTEIBHO X TOYEUHBIX MapKepOB.
8. Bnibepure Paszmectuth Placement U3 Criucka napaMeTpoB ClieBa.

9. BuiGepurte Bokpyr Touku Around point v u3meHuTe 3HaueHue Paccrosiaue Distance Ha 2 . 0 MUITAMETpa:
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@ Layer Properties - places | Labels
- =1 Single Labels =

Information Value | abc name - || &

w Text Sample
Source

Lorem Ipsum

'- Symbology

Lorem Ipsum | (142258 |- | |BF|~ v

Masks
abe Text Placement

Diagrams "% Formatting

abe Byffer

Fields abe) Mask Cartographic (@) Around point Offset from point
. Background

- Shadow

Joins ?bo Callouts

Attributes Form

+ Distance | 2.0000
#y¥ Placement

Auxiliary Storage

& @

/' Rendering Millimeters M

Actions Quatraxt EL

Display

Rendering
__ v Geometry generator
Variables

Metadata

Dependencies

Point / MultiPoint
Legend

w Data defined

Coordinate X E, ¥ E,

Digitizing -
Style * 0K, Cancel Apply Help

QGIS Server

10. Kiuknute [Mpumenuts Apply.

Bu YBUOUTE, YTO Ha,Hl'II/ICI/I/ METKH OOJIbIIE HE NEPEKPLIBAIOT CBOU TOYCYHBbIE MaPKEPHI.

3.2.3 / Wpoem panblie: NMpumeHsiem Haanucu/meTku BMecTo Cl1I08 CUMBO-
NNKU

Bo MHOIuX ciyyasx pacrnojiokeHue TOUKH He 00s3aTesIbHO HOJKHO OBbITh OYeHb KOHKpeTHhIM. Hampumep, 60i1b-
HIMHCTBO TOUEK B CJI0€ places OTHOCATCS K LIEJIbIM FOpPoJaM WM IPUropoaM, a KOHKPETHAas! TOUKa, CBS3aHHas C
TaKUMH (PYHKLMSAMH, He SIBJISIETCS TAKOW YK KOHKPETHOM B OoJbIINX Maciitabax. Ha camom siernte, korna 3amaercst
CIIMIIIKOM KOHKPETHAs TOUKA, OHA YacTo COMBAET C TOJIKY TOTO, KTO YMTAET KapTy.

Hanpumep, Ha kKapTe Mupa Touka, 3ajaHHast kak EBponeiickuii Cowo3, MoxkeTr ObiTh Tie-To B [lonbine. Yenoseky,
KOTOPBIA «UUTAeT» KapTy U BUIUT TOYKy ¢ Haamuceio EBporeiickuii Coro3 Ha [lojble, MOXET MOKa3aTbCs, YTO
cronnna Egponeiickoeo Coroza, Takum o0pa3oM, Haxoautces B [Tosbire.

HOSTOMy, IUIA IpEJOTBPpAllIEHU A TAaKOIro poJa HeﬂOpaByMeHHﬁ, HacCTO MOJIE3HO JCAKTUBUPOBATL CUMBOJIBI TOYEK U
IOJIHOCTBIO 3aMECHUTDH UX HAOIMUCAMMU.

B QGIS 3T0 MOXHO cliesiaTh, U3MEHHB MOJIOKEHUE HAAITHCEH TSI MX BU3YaJIH3ali HENOCPEICTBEHHO Ha/l TOUKaMH,
Ha KOTOPbIE OHU CCHLIAIOTCS.
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1. OtkpoiiTe BKIAAKY Labels B muanoroBom okHe Layer Properties B cnoe places.
2. Buibepute Placement W3 CIIMCKa NMapaMeTPOB.
3. Kiuknure Ha kHonKy CMmelenue ot Touku Offset from point.

310 oTKpoeT napameTpsl KBanpanta Quadrant, KOTopble Bbl MOXETe UCIIOIB30BaTh Ul YCTAHOBKHU TIOJIOXKE-
HUS HaUCH/ METKHM OTHOCUTEJIbHO Mapkepa TOYKH. B JaHHOM citydae Mbl XOTHM, YTOOBI HAJMNCh PacroJa-
rajiach 1o LEHTPY TOYKH, [I03TOMY BHIOEPUTE IEHTPAJIbHBIA KBaPAHT:

() Layer Properties - places | Labels
Q = Single Labels -
f'i' Information Value | abc name - || &
w Text Sample
J{s_\ Source
% ymbology Lorem Ipsum
Labels b
Lorem Ipsum # | |25 |~ | | K|~ -
(abc JVERS o E—
'I Diagrams "% Formatting
888 Buffer
E Fields abe hask g Cartographic ) Around point (®) Offset from point
Back d
E Attributes Ferm . ackgroun
-/ Shadow
Joins ;bo Callouts
+ Quadrant E,
#.¥ Placement
iary Storage _.‘r Rendering
@ .
e Actions
OffsetX,Y | 0.0000 +| | 0.0000 DR E"
- Display
_ Millimeters = E,
lendering
Rotation | 0.00% =
Variables
E Metadata v Geometry generator
ﬁ Dependencies
Legend . =
& qcis server Point / MultiPaint -
B oigitizing w Data defined -
> Style b Ok Cancel Apply Help
N 4 i —

4. CkpoiiTe CUMBOJIBI TOUKHM Ype3 peJakTHpoBaHue ciost Symbology Kak oObIUHO, U 3ajaiite pazmep Mapkepa
Marker 1o 0. 0:
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@ Layer Properties - places | Symbology x
Q E Single symbal - |
= - Marker |¥|
Simple marker —

¥ Symbology
abe
abs Unit | Milimeters - |

Opacity | 00.0% <l

Color | I:l

= Size | 0.00000 BEEE
B Rotation | 0,00 ° B ="
. Favorites a |~ | 8
® ° ® O ® ® ¥
dot black dot white dot blue dot green dot red effect drop
shadow
& ® ©
shield disability topo hospital topo pop capital
i/ |_| E Save Symbol . | | Advanced ~ |
v b Layer Rendering
= | style - | oK | | cancel || Apply [ Help |

5. Kiuknure Apply v Bbl yBUAWTE CAEAYIOUIUIA PE3Y/IbTAT:
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(2 *basic_map - QGIS 3e6aebidf1 - O X

Project Edit View Layer Seftings Plugine Vector Raster Dstabase Mesh Progessing Help
I PERRY DL, ERPRP AL RENOR 60 -H-ra-R-EE# =0 Wy
-4 - im e qEm g gge e ]

MeVvse @D
Browser
T TO

b T:? Favorites
v 5 QGIS-Training-Data\e
~ [ QGI5-Training-Data\s
b [ styles
3 Q basic_map
(" Spatial Bookmarks
(% Project Home
[&] Home
[(mE=Y
e GeoPackage
# Spatialite
@ rostcls
P wmssaL
2 pe2
@B WMSWMTS
ﬂ Vector Tiles
55 XVZ Tiles
& wes
7 WFS/ OGC API - Feature,
ows

)] ArcGisMapServer
| & s,
4 | 3

|‘

Layers
V.@‘i,? VRGN
places

roads
rivers
B buitdings

e St
st ies]igaallRestCamp
landuse /“

o

| Q Type o locate (Ctrl+Q) Coordinate | 20.4857,-33.9804 | Scale | 1:42256 "| & Wagrifier | 100% |2] Rotation (0.0° [2] [V Render @ Epsciazzs @

Ecnu Obl BB OTIAJIMIIN KAPTY, TO BbI Obl yBUJIEIIH, YTO HEKOTOPbIE HA/IIKUCH UCYE3AI0T PH OOJIbIIIEM MaciiTade, 4To0bI
u30exaTh HepeKkpeiBaHust. FIHOrga 9T0 MMEHHO TO, YTO BaM HYXHO, KOTJa Bbl HMEETe 10 C HaOOpaMH JaHHbIX,
KOTOpBIE COIEpXaT MHOIO TOYeK, HO B APYTHX CIydasX, Bbl [OTepsieTe mosiesHylo nngopmarmio. EcTs eine oxHa
BO3MOXKHOCTb JJIs1 paGOThI C MOJOOHBIME CITy4asiMU, O KOTOPBIX MBI IIOTOBOPHUM I03X€ HA TOM 3aHATHU. A TOKa

{ahg] o
OTHATIUTE KapTy, KIMKHUTE KHOIIKY Ha MaHEJIM THCTPYMEHTOB U IOCMOTPUTE, YTO ITPOU3OUIET.

3.24 / Monpobynte camu: Hactponte Hagnucu
hd C6p001>Te HaCTpOfIKPI Haamnumcu /METKH U CUMBOJIA, 4100 NOJIy4YUTh TOYEYHBIN MapKep U CMECHICHNUE HAAITUCHU
0 2 . 0 MIJIJIUMETPOB.
IIposepome ceéou pezyavmanmol

* Vcra"osure macitad Kapthl 1 : 100000. Bel MOxeTe cienaTth 310 4epe3 BBOJ, B I10J1€ Maciura6 Scale B Status
Bar. I3MeHuTe CBOM HA/INMCH, YTOOBI OHM TTOJXOAMIIH JIJIsl TPOCMOTpPa B JAHHOM MaciiTade.

IIpoeepome ceéou pezynvmanmoi

3.2. 3aHsiTMe: Hagnucun/meTtkn 69



QGIS Training Manual

3.25 / NUpem panbwe: HapnucbiBaeM NNHUN

Ternepb, Kor/ia Bbl 3HaeTe, Kak paboTaeT HaMUCh/ MEeTKa, BOSHUKAET JA0TOIHUTE bHAst IpoOemMa. TOUKY U MOIUTOHbI
JIETKO HA/IIKCaTh, HO Kak HacueT JiuHui? Ecii Bbl HA/IIKCHIBAETE MX TaK e KaK TOYKH, TO BAIIM PE3yJIbTAThl OyAyT
BBIIVISIIETH TAK:

(2} *basic_map - OGIS 3e6aebidf1 — O x
Project Edit View Layer Settings Plugins Vector Raster Database Mesh Processing Help

NEBRRY M*LLPHPRLF ALBLEOR 6C -H-6-G-ME#I =~ 0~

@V AawmE 4y N B e g 4 |

Browser
LeT=®HeO
~ ¢ Favorites
» [ QGIS-Training-Data\e
~ [ QGIS-Training-Data\s
b [ styles
b (2 basic.map
%) Spatial Bookmarks
[® Project Home
[¢] Home
e
@ GeoPackage
,’ Spatialite
W@ postals
P mssoL
2 ps2
G WMSWMTS
ﬂ Vector Tiles
£52 XVZ Tiles
@ wes
7 WFS/ OGC API - Feature
@ ows
& ArcGisMapServer =
-

L [
Layers
o 1@ w, ? gE-& »

[] ® places

roads

~— rivers

B buildings

. water

[ protected_areas

landuse

| Q Type to locate (Cirl+K) | Coordinate | 20.5130,33.3845 | Scale [1:35434  ~ | (@ Magnifier 100% 2| Rotation | 0.0° |2 ¥ mender @ Epsciazs @

Tenepsb Mbl niepehopMaTUpyeM HaJIUCH Cilost roads, YToObl UX OBUIO JIerye HOHSITh.
1. Ckpoiite cioit places, 4TOObI OH Bac He OTBJIEKAL.
2. AktuBHMpy¥WTe Single Labels nnst cnost roads, Kak BHI AeJIaJiv BhIIe 1Jis ¢iost Mecta places.
3. VYcranoBute Pazmep Size mipudra Ha 10, 4TOOBI BBl MOIJIM BUJIETh OOJIbIIIE HAITHCEH.
4. Tlpubmmzute MecTHOCTH ropoaa Ceesuiennam Swellendam.

5. Bo Bkyanke Labels ectb BKi1agka Pasmenienue Placement, nanee BeiOeprTe CISAYIOIIIE HACTPOUKH:
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@ Layer Properties - roads | Labels x
Q =1 Single Labels = | |E|
3 Value |ib< name - | |E|

w Text Sample

Lorem Ipsum
{@be| Labels _— S =
|Lorem Ipsum |2| | 1:8860 - | |E|:| | |:|
abe
abe Text Placement

2% Farmatting

8Be [uffer
abc) Mask (®) Parallel () Curved () Horizontal
=0 . Background
=
- Shadow
abe
Callouts
/* Allowed positions Above line || On line Below line @
#y¥ Placement
‘( Rendering Line orientation dependent position
(v} Distance | 0.0000 s €&
Millimeters hd L
Repeat | No repeat |:| @,
| Points K=t
Qverrun feature |No OWErrun |:| E.
|Mil|imeters - |
v Geometry generator
L%
L -

= | style - | oK || cancel | | Apply | [ Help |

Bel, BeposiTHO, OOHAPYKUTE, YTO JJIST CTHIIS] TEKCTA MCIOJIB3YIOTCS 3HAYCHMS TI0 YMOTYAHUIO, ¥ TIOSTOMY Hajl-
MUCH OYeHb TPYIHO uuTath. OOHOBUTE Text, YTOOBI UCMOIBL30BATh TEMHO-CEPBIi WK YepHbii 11BeT Color, n
Buffer, 4ro0bI UCITOJIB30BATH CBETIIO-KeNTHIH 1BET Color.

Kapra GyzeT BBIIIAAETh IPUMEPHO TaK, B 3aBUCMMOCTH OT MaciuTada:
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- *basic_map - efael -
Q *b p - QGIS 3e6aeidf1 O X

Project Edit View Layer Settings Plugins Vector Raster Database Mesh Progessing Help

T EBRRH QPP EPRP I QL BLEIOR &0 - H-E-G-EEHF =0 Wy

REVL AW B 4/ ~ =4 {9 RFgRFR 4
Browser ) &

T TO

~ ' Favorites =

v 5 QGIS-Training-Data\e

~ [ QGI5-Training-Data\s
b [ styles
3 Q basic_map

%] Spatial Bookmarks

(% Project Home

[&] Home

[(mE=Y

e GeoPackage

# Spatialite

@ rostcls

P wmssaL

2 pe2

@B WMSWMTS

@ Vector Tiles

55 XVZ Tiles

& wes

7 WFS [ OGC API - Feature

) ows

)] ArcGisMapServer

A e me

4 3
Layers
o« @ e T EG-F »
® places

roads

rivers
I buildings
¥ water

D protected_areas
landuse

<L LSS

3 = AR
M R Y

[Faroes HRs) o Soel M S

Coordinate | 20.46253,-34.02814 %% Scale 18850 | v | (@ Magnifier 100% |2] Rotation (0.0° [2] [V Render @ Epsciazzs @

Q, Type to locate (Ctrl+)

Bbl yBrmTe, 9TO HA3BAHMsT HEKOTOPBIX JOPOT MOSBIISIIOTCS O0Jiee OfHOTO pasa, U 3TO He BCeraa HeoOXOAMMO.
YroObl 3TOrO HE MPOU3OIILIO:

6. Bo Brianke Labels ectb auasioroBoe okHO Layer Properties, BbiOepute napametp Busyanuzauus Rendering u
BhIOepuTe «OOBEAMHNUTD COETMHEHHbIC JIMHUY, YTOOBI U30eXkKaTh JTyOIMpOBaHus HAAIUCei» Merge connected
lines to avoid duplicate labels, xak TIOKa3aHO HIKe:
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@ Layer Properties - roads | Labels
- =1 Single Labels =

Information Value | abc name - || &

w Text Sample

Source
Symbology Lorem Ipsum
Lorem Ipsum | | 1:8860 - | | B~ v
Masks abe Text Rendering
¥ o - a
Diagrams 2% Farmatting
abe B ffer Pixel size-based visibility (Jabels in map units) E,
Fields abc) pqask
Minimum 3 px - o
Background
Attributes Form . g 5
J Shadow Maximurn 10000 px - L
Joins ?bo Callouts
¢:’ Placement Label zindex | 0,00 - E.
Auxiliary Storage / Rendering Show all labels for this layer (induding colliding labels)
. Data defined
Actions
Show label @ Always show @.
Display Show upside-down labels
: 8 never when rotation defined always
Rendering
o Featu i
Variables bt re options
Label every part of multi-part features
Metadata vea e E’
v Merge connected lines to avoid duplicate labels
Dependencies Limit number of features to be labeled to
Legend 2000 -
Suppress labeling of features smaller than
QGIS Server =
5.00 mm -
Digitizing -
Style * 0K, Cancel Apply Help

7. Kmnkaute OK.

Eme ogna mose3Hass (pyHKIMS —3TO TO, YTO MOXHO TPEJOTBPATUTh PHCOBAaHWIE HANMWMCEH IS (DyHKITHM,
CJIMIIIKOM KOPOTKUMH, YTOOBI KX MOXHO ObLIIO 3aMETHTh.

8. Ha Toii ke manenu Busyanusauus Rendering ycraHoBuTe 3HaueHue [ogaBUTh MapKUpPOBKY (DyHKIIMI MeHee
yeM. .. Suppress labeling of features smaller than... 5.00 mm 1 oOpaTuTe BHUMaHKE Ha Pe3yJIbTAThI, KOTIA
BBl HAKMeTe KHOIIKY Apply.

TonpobyiiTe Takxke japyrue HacTpoiiku mecta Placement. Kak mbl Busienu panee, Bapuant [1o ropuzoHTanu
Horizontal B 1aHHOM Cily4ae He Jy4LIMil BApUAHT, IOSTOMY AaBaiiTe onpodyeM BMECTO STOro BapuaHT M3o-
rHyTbIA Curved.

9. Bwibepure napamerp M3ornytsiii Curved Ha nanenu Pasmernenue Placement Bo Bkiaake Hanmucu Labels.

Bor pesynbrar:
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() *basic_map - QGIS 3e6aeb3df1 — [m] x
Project Edit View Layer Seftings Plugins Vector Raster Database Mesh Progessing Help
IR e RPP A O & -H-B-H-BEERIsS-P D
REVL AW B 4/ - =4 {9 RFgRFR 4
Browser (=] | k )

LETTO

¥ 57 Favorites

» 5 QGIS-Training-Datale

= [ QGIS-Training-Data\s
b [ styles
3 G basic_map

Y Spatial Bookmarks

(% Project Home

[&] Home

[(mE=Y

‘5 GeoPackage

# Spatialite

@ rostcls

P wmssaL

2 pe2

@ WMSWMTS

ﬂ Vector Tiles

55 XVZ Tiles

& wes

/) WFS / OGC API - Feature

& ows

)] ArcGisMapServer

A e me

[ b SR @
R
Layers B b oF e

® places
V| roads
v rivers
v| [ buildings
V| ¥ water
v D protected_areas
v landuse
N
RS
Q, Type to locate (Ctrl-+) Coordinate | 20.46062,-34.02842 % Scale |1:88s0 | v | (@ Magnifier 100% %! Rotation | 0.0° 3| V| Render @ Ersciazs @

Kak Bumute, Takoe AeiCTBUE CKPHIBAET HEKOTOPhIE HAIKCH, KOTOPbIE ObUIM paHee BUJHBI, U3-3a CIOXHOCTH 3a-
CTaBUTh HEKOTOPBIE U3 HUX CJIEAOBATh M3BIIIMCTHIM JIMHUSM YJIUII, OCTaBasICh MPUA 3TOM YATAEMBIMH. DTO JieslaeT
Jpyrue HajIvcK ropaso 0oJiee Moie3HbIMU, TIOCKOJIbKY OHM OTCJIEKHMBAIOT JOPOTH, a He IUIABAIOT B IPOCTPAHCTBE
MeXJy HUMU. Bbl MoKeTe peliuTh, KaKoil U3 9TUX BApUAHTOB IPUMEHUTH, B 3aBUCUMOCTH OT TOTO, UTO, M0 BallleMy
MHEHUIO, KaKeTcsl 60Jiee TIOJIe3HBIM, FUTH UTO BBHITJISAUT JTyYIIIe.

3.2.6 ‘ -—-" Wpem panble: HactpavBaeM napameTpbl AaHHbIX

1. OTxioYnTE HAAMKCH CJI0ST roads.

2. TIoBTOpHO aKTHBUpYHTE HAAMUCH Cllost places.

[==—]
3. Otkpoire Tabauily aTpuOyTOB places ¢ MOMOIIbI0 KHOMKU .

B tabumiie ecTb 0OHO noste, KOTOpOE HAC ceildac MHTepecyeT: 310 Mecto place, OHO OIpesielisieT THII Io-
POJCKOW MECTHOCTH JIJTs1 KaXKI0U 3anucu. Mbl MOKXEM HCIOJIb30BaTh STH JaHHbIC, YTOOBI MTOBJIUSITH HA CTUIIA
HaAICeH.

4. Tlepetinute Ha aHeNb Text HA TaHen places Labels.

5. KimkHHTE Ha KHOIKY = PSAIOM C KHONKOH KypCHMBHOTO TeKCTa 1oj Haanucelo Ctuib Style 1 BbiOepuTe
PenaktupoBats. .. Edit..., 4ToObl OTKpbITH KOHCTPYKTOD CTPOK BhIpaskeHuid Expression String Builder:
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@ Expression String Builder
Expression Function Editor
= L+ - Ay i
Expected format: bool [1=True|0=False]
Feature < Mational Park Reception & Shop | ~ [ 3
Preview:

&, Search...

T T T T T YT YT T YTTYTTTTTTYTTTTTE

symbol_color
value
Aggregates
Arrays

Color
Conditionals
Conversions
Date and Time
Fields and Values
Files and Paths
Fuzzy Matching
General
Geometry

Map Layers
Maps

Math

Operators
Rasters

Record and Attributes
String

User expressions
Variables

Recent (generic)

Show Help

Ok Cancel Help

6. B none Fields and Values nBaxapl KIMKHUTE Ha place, a 3aTteM KiukHuTe Bee yHukanwubie All Unique.
OTKpoeTCs CIUCOK BCEX YHHUKATbHBIX 3HAUEHWH IMOJIs place AaHHOrO ciosl. JJoOaBbTe = B TEKCTOBOM pe-
JAKTOpe, a 3aTeM ABAXKIbI KIIMKHATE t Own.

Kpome Toro, Bel MOKeTe BBECTH: «MecTo=ropon» / "place" =

7. Kmuknaute gsaxasl OK:

'town' MpsAMO B TEKCTOBOM PEHAKTOPE.

Q Expression String Builder
P 9

Expression Function Editor

B8 bt
:I ‘town'

=L+ - A v
Expected format: bool [1=True|0=False]
Feature < Mational Park Reception & Shop | ™ F‘
Preview: 0

Q Search...

i vy v v v wvow

rF v rF T T vy orw

symbol_color
value
Aggregates
Arrays
Calor
Conditionals
Conversions
Date and Time
Fields and Values
abe full_id
abc psm_id
abc gsm_type
abc js_in
abc name
abc place
abc cagns_id
abc wikidata
abe wikipedia
Files and Paths
Fuzzy Matching
General
Geometry
Map Layers
Maps
Math

Show Values

group field

Double-click to add field name to expression
string.

Right-Click on field name to open context
menu sample value loading options.

Jotes

Loading field values from WFS layers isn't
supparted, before the layer is actually
inserted, ie, when building queries,

values | O, search...
All Unique 10 Samples
hamlet
locality
suburb
town
OF; Cancel Help
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OOpaTrTe BHUMAHKE, YTO HAJIIUCH Il BCEX MECT, B KOTOPBIX 1M0Jie place COOTBETCTBYET t own, OTOOpakaiTCs
KypPCHUBOM.

(2 *basic_map - QGIS 3ebaeh3df1 - O X
Project Edit View Layer Settings Plugins Vector Raster Database Mesh Progessing Help

DeERERXNrrr,EAPRPr QALLBLlOR G- K-B-R-BE#Is-0 0
EEQ@VE.’uﬁE’. ‘s MR~ & (Y RE EgRRR: e |

Browser
LRT®O
~ 7 Favorites [=]
» 5 OGIS-Training-Data\e
~ [ QGIs-Training-Data\s
b [ styles
b (3 basic_map
U' Spatial Bookmarks
[% Project Home
[¢] Home
e
e GeoPackage
’ Spatialite
@ postals
P mssaL
2 ps2
@ WhMSWMTS
ﬂ Vector Tiles
EEE XVE Tiles
@ wes
7 WFS /[ OGC API - Feature
@ ows
&9 ArcGisMapServer ]

-

1] [ [»
Layers ¢
« @ T&E-® »
roads
rivers
B buitdings

water

[ protected_areas v : “ \Lang|Elsies|Kraal!Rest/€amp!

landuse '

| Q Type to locate (Cir-+) | Coordinate| 20.5470,-34.0350 | % Scale |1:35428  ~ | (@ Magnifier | 100% 2| Rotation 0.0° |2] ¥ render S Ersciazs @

3.2.7 A Monpo6yite camu: NMpuMeHUTe HAaCTPOWKY NapamMeTpPoB AaHHbIX

IIpumeuanne: Mepl HeMHOro 3a0eraeM BIiepesl, YTOObI IIPOJEMOHCTPUPOBATh HEKOTOpBIe OoJiee MPOJBUHYTHIC Ha-
crpoiiku Haanuceil. [Ipeanonaraercs, 4To ecim Bbl Ha MPOABMHYTOM YPOBHE, BBl 3HA€TE UTO HMKEC/IEAyOIIee O3Ha-
yaeT. Eciu BBl He cMOkeTe 9TO caeaTh, IPOITyCKaiTe JaHHBIA pa3/ieN i BEPHUTECH N03Xe, KOT/a Bbl U3y4UTe HE0O-
XOJIMMBIE MaTepHaIbL.

1. Otkpoiite Tabauiy aTpuOyTOB I places.
2. BoiiauTte B pexuM peJakTUPOBAHHsI, KIMKHYB HA KHOTIKY y .

[
=
3. JIoGaBbTe HOBBIH CTOJIOEL] C IIOMOIIBI0 KHOITKH .

4. Hacrpo¥ite ero cieiyiomunm o0pa3om:
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=) Add Field >
Name FONT _SIZE

Comment

Type Decimal number (real) -

Provider type double

Ll

Length 3

qip

Precision 1

K Cancel

5. Hcnone3yiite 310, 4TOOB yCTAHOBUTH COOCTBEHHBIN pazMep IpUQTa AJIs1 KKIOTO THIA MecTa (KaX/IbIH KJTI0Y
B Hojiec place).

sz)eepbme ceou pesynomamnoul

3.2.8 mm= JlOMOJ/IHUTE/NIbHbIE BO3MOXHOCTN Haanucemn

Mgl He MOXKeM OXBATHTh BCE BAPUAHTHI B JJAHHOM Kypce, HO MMeHTe B BUAY, YTO BO BKJaake Label ecTb MHOTO
JPYTUX TOJIE3HbIX (PYHKLMIA. Bbl MOKeTe yCTaHOBUTH BU3YaJIM3alMI0 HA OCHOBE MacliTtaba, U3MEHUTh IIPUOPUTET
BU3YaJIM3alMK JIUTsI HAAMMCEH B CJIOE M YCTAHOBHUTH KaK[bIi MapaMeTp HAIKCU C TIOMOLIBIO CJIOsI aTpHOYTOB. Bb
Jia)e MOXKeTe YCTAHOBHUTD POTALIMIO, HoJIoxkeHUe XY U Apyrue CBOMCTBA HAUCH (€CIH Y Bac ecThb MoJis aTpudyToB,
BBIIEJICHHBIE JUIs1 JAHHOH 11eJIH), & 3aTeM OTPEeJaKTUPOBATh STH CBOMCTBA C IOMOLIBI0 HHCTPYMEHTOB, PaCIIOJIOKEH-
HBIX PSIIOM C OCHOBHOM KHOIKOU [lapamerpsl Hagmucelt cnost Layer Labeling Options:

a ab abe| Cal abcl ‘abc
abc E & [ > G|

([laHHBIE UHCTPYMEHTBI OyyT aKTUBHBI, €CJIM CYIIECTBYIOT 0053aTeNIbHBIE MOJIsE AaTPUOYTOB M BBl HAXOAUTECH B pe-
’KHM€E PeAAKTUPOBaHUA).

He CTCCHHﬁTeCB HUCCJIeA0BaTh 60J'H>H_IC BO3M0)KHOCTCﬁ CUCTEMBbI Ha)mnceﬁ.
3.2.9 B 3aknouyeHun

Bbl y3HaIIN, KaK UCIOIb30BATH aTPUOYTHI CJIOS JUIS CO3IAHHS JUHAMUYECKNX HAJMUcel. DTO MOXKET C/ie/aTh Ballly
KapTy 6osee MH(OPMATUBHON U CTUILHOM !

3.2.10 YT1o panbwe?

Ter[epb, KOrJ1a BBl 3HACTEC, KaK anI/I6yTbI MOT'YT HOBJIMATH Ha Ballly KapTy, KaK HACYET UX UCIOJIb30BAHUA ]I U3ME-
HCHUA Ha,I[HI/ICCﬁ caMHx 00beKTOB? DTO TeMa cjeaynomero 3aHATHA!
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3.3 3aHsaTtue: Knaccudpumkaumsa

Hapnwicu - 310 X0pommii crioco0 rmepeaaTh Takyo HHGOPMAIU, KaK Ha3BaHUS OTAEIbHBIX MECT, HO UX HEJb3sI UC-
TMOJTB30BATh LTS Bcero. Hampumep, MpearmonokuM, 94To KTO-TO XO4eT 3HATh, IS Yero HCTIONb3YeTCsl Kakaast MecT-
HOCTh 3emutenionb3oBanus 1anduse. Vcmomp3ys HaAIUCH, BB MOMYIHTE CIIEIyIOIIee:

A

A

1 - - |
n:,iﬂ[

310 AEJIA€T HAAIMMCU Ha KapTe TPYAHBIMU JI1 YTEHUA U JaXE€ HENIPEOJOJIMMBIMH, €CJIM Ha KapT€ MHOI'O Pa3jIMYHbIX
YYaCTKOB 3€MJICIIOJIb30BaHUS.

]_IeJlb JAAHHOTO 3aHATHS: HAYUUTbCA S(b(l)eKTI/IBHO KJ'[aCCI/I(l)I/IIII/IpOBaTb BEKTOPHBLIE JaHHBIC.

3.3.1 \ WUpem panbuwe: Knaccnduumpyem HOMUHanbHble AaHHbIe

1. Otkpoiite guanorosoe okHO CBo¥icTBa cnosi Layer Properties st cinost 3emiernosnb3oBanre landuse.
2. Tlepeiinute BO BKIaAKy Symbology.

3. KimkHUTEe Ha pacKpHIBAOIIMICSA CIUCOK ¢ Haammuchio Single Symbol n w3menute ero Ha [lo kateropusm
Categorized:
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| = Categorized

Layer Properties - landuse | Symbology

"i Information Value | a
;{:\? Source symbol | '|;|
Color ramp | Random colors H

& symbology

€€ Labels

B Masks

- .
. [MELEINE

N7 3D View

E Fields

Attributes
Form

Joins

% Auxiliary
< B storage

@ Actions
- Display

symbol = Value Legend

P Layer Rendering
@Help || style -

- |

| Classify | |E| |E| | Delete All |

|Advanced ~ |

| /Apply || % cancel |[ & OK ]

4. B HoBoi1 maHenn usMenute Value Ha landuse u usmenute LperoBas mkana Color ramp Ha CiydaiiHbIi
uset Random colors.

5. Knuknure Ha kHonky KiaccupuumpoBats Classify.

= Categorized

Layer Properties - landuse | Symbology

(2 information value a6 [anduse - | |E|
3,'@ Source Symbol L '|;|
Color ramp | Random colors H

Q’ symbology

Symbol = Value Legend
€ Labels v/ [l cemetery cemetery
v [l conservation conservation
€D Masks vl farmland farmland
. v [l forest fForest
,/ Diagrams v [l grass grass
v Il industrial industrial
ﬁ 3D View vl orchard orchard
v [l reservoir reservoir
E Fields vl residential residential
Attributes v [l v?llage_green v?llage_green
— v [l vineyard vineyard
v [ all other values

Joins

-~ Auxiliary
b Storage

@ Actions

| Classify | |£| |E| | Delete All |

» Layer Rendering

|Advanced ~ |

- Display

.| @Help || stle -  JApply | %cancel || ok |

6. Kimnknute OK.

Bs! yButMTE IPIMEPHO Takoe:
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7. KimkHute Ha cTpesiky (WM 3HaK IUToca) psgoM ¢ landuse B maHenu Layers, BBl yBUIUTE OObsICHEHUE
KaTeropuit:
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Layers (&) )
o [ ® T &~5 & [

» v o places -
v| ] buildings
v — roads
water |
rivers

.~ landuse

I cemetery

. conservation

B farmland

. Forest

I grass
B industrial

I orchard
. reservoir

B residential

I village_green
"] vineyard

-

v
v

e e e e e L

Tenepp HAIIM MOJUTOHBI 3EMJIETIONB30BAHNS OKPALIEHBI M KJIACCU(DHUIIMPOBAHBI TAKMM 00pa30M, 4TO MECTHO-
CTH C OJIIHAKOBbIM 3€MJIENIONb30BAHIEM UMEIOT OJMH LBET.

8. Tlpu kenaHuM Bbl MOKETE U3MEHUTb CUMBOJI KaX/I0l MECTHOCTH 3€MJIETIOJIb30BAHUS, ABAK/Abl KJIMKHYB Ha
COOTBETCTBYIOIINI [IBETHOM OJIOK Ha naHenu Layers uin B iuanioroBom okHe CBovicTBa ciost Layer Properties:
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Symbol Selector

(%]
Unit | Millimeters - |
Opacity ~1/100,0 % |:_|
Color | H
| ©. Favorites a|~| &
| Z/ BN

gradient gray 3 fill hashed black/  hashed black,

plasma
|| B |save Symbol... | | Advanced ~|
| @Help | | % cancel H « oK ]

O6paTI/ITC BHUMAHHE, YTO UMECTCA OJAHA KATCrOpHrA, KOTOpas IyCTa:
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Layer Properties - landuse | Symbology B

Q = Categorized -
q Information  BENCI abc [anduse || €
[ ]
‘:{:\‘_- Source S M
Color ramp Random colors M
& symbology
symbol = Value Legend
€3 Labels v [ cemetery cemetery
v/ [l conservation conservation
EED Masks v/ [l farmland farmland
- v/ [l forest forest
, Diagrams v/ [ grass grass
~ v Il industrial industrial
g 3D View vl orchard orchard
v [ reservoir reservoir
E Fields v/ [l residential residential
Attributes v/ [l village _green village green
Form v [ vineyard vineyard
B all other values
Joins
L Auxiliary
<N st
& orage Classify | @ || = | Delete All Advanced ~
i Acti
o HOnS P Layer Rendering
@ Display —| @Help Style - « Apply || % cancel

Sra mycrasi KaTeropysi KCTOJIb3yeTCs 17151 OKPACKH JIIOOBIX OOBEKTOB, JUIsI KOTOPBIX HE ONPEE/IeHO 3HAUeHUE 3eMITe-
TI0JIb30BAHU 1 MM KOTOpble nMeloT 3HaueHne NULL / HOJIb. MoxeT ObITh IOJIE3HO OCTaBHUTb 3TY IYCTYIO KATETOPHIO,
YTOOBI MECTHOCTH CO 3HaueHueM NULL Bce ellie 0ToOpaxkainch Ha Kapte. Bel MOXxeTe U3MEHUTH 1IBET, YTOObI OH
6oJiee YETKO MPECTABIISLT IIyCTOe 3HaYeHue Wi 3HaueHne NULL.

He 3a6ym>Te COXPAaHUTDH KapTy ceﬁqac, YTOOBI HE MOTEPATb BCE BHECEHHBIC TAXKEJIBIM TPYJIOM n3MeHeHus !

3.3.2 \ Monpobynte camu: 6onbie Knaccudmkaumm

[TpumMeHuTe MOTyYeHHbIE BbILEe 3HAHMSI, YTOOBI KJacCUpUIIPOBaTh clioi 3aanus buildings. YcraHoBuUTE KaTe-
ropusanuio Ha nosie building u UCHosip3yiTe NBETOBYIO mKany CrnekrpaibHas Spectral.

IIpHMeqal-me: He 3a6y)15Te HpI/I6HI/ISI/ITI) MECTHOCTb ropoja, YTOOBI YBUACTL PE3YJIbTATHI.

3.3.3 / WUnem panbue: Knaccndgpumkaumsa COOTHOLLEHUN

CylecTByeT YeTblpe TUIA KJIACCU(DUKALINN: HOMUHANbHAS, NOPAOKO8AS, UHMEPBANbHASL U COOMHOUEHULE.

B HoMHUHaAJILHOKH KJ'IaCCI/I(I)I/IKa]_[I/II/I KaTeropuu, rno KOToOpbiM KJ'[aCCI/Iq)I/IHI/IpyIOTCH 06’I>GKTI>I, OCHOBAaHbI HA HA3BaAHUAX
Y HUX HET OIIPEACICHHOI'O MOPAJAKaA. Haan/IMep, Ha3BaHUS rOpOJAOB, KOIbI paﬁOHOB uT.o. CI/IMBOJ’IH, HCIIOJIb3yEMBIC
JUIA HOMUHAJIBHBIX TAHHBIX, HE JOJUKHBI IOAPAa3yMeEBATh NMOPALOK WX BEJIMINHBIL.

® HJ'I?I TOYECK MBI MOKEM HUCII0JIb30BaTh CUMBOJIBI pa3JII/I‘{HOﬁ Cl)OpMI)I.

° II,J'IH TMOJIMTOHOB Mbl MOKEM UCIIOJIb30BATb PA3JIMYHLIC TUIIBI IITPUXOBKU WM PA3JIMYHBIE IIBETA (I/I36Cl"&ﬁT€
CMEIIMBAHUA CBETJIBIX U TEMHBIX I_IBETOB).

o Iyl IMHUIA MBI MOKEM HCTIONB30BATh Pa3IMYHble ITyHKTUPHBIC Y30PBI, pa3invHble IBeTa (M30eras cMelnBa-
HUS CBETJIBIX ¥ TEMHBIX LIBETOB) U Pa3JIMUHbIE CUMBOJIBI BOJIb JIMHUI.
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B nopsiakoBoii kiaccuuKaMy KaTeropiy pacrosiokeHsl B onpeenéHHoM nopsigke. Hanpumep, ropogam mMupa
MMPUCBAUBACTCA paHI' B 3aBUCUMOCTH OT UX 3HAYUMOCTH IJIA MPIpOBOfI TOProBJiu, HyTCmeCTBHﬁ, KYJbTYPHI U T. 1.
CHMBOJIBI, HCTIONIb3YEMBIE /TSI TIOPSIIKOBBIX JAHHBIX, IOJKHBI MOJIpa3yMeBAaTh MOPSIOK, HO HE BEJTMUKHY.

[ TOYeK MBI MOKEM HCTIONIh30BaTh CUMBOJIBI CO CBET/IBIMU W TEMHBIMH [IBETAMHU.
¢ 1711 HOJIMTOHOB MBI MOKEM HCIIONIb30BaTh TPaAyHpPOBAaHHBIE [[BETA (OT CBETIOTO 0 TEMHOTO).
e Jlns TMHUAN MBI MOXKEM HCIIOJIb30BaTh IPaAyHpOBaHHbIE I[BeTa (OT CBETJIOrO JI0 TEMHOTO).

B mHTEpBaNbHOIl Kilaccu(UKaAUK, YMCIIa HAXOATCS B IIKaJIE C MOJIOKUTEIbHBIMH, OTPULIATEbHBIMU U HYJIEBBI-
MU 3HaueHusIMA. Hanpumep, BbicoTa BbIIIe/HIKE YPOBHS MOpsI, TeMIlepartypa B rpagycax o Llenscuio. CumBosl,
WCIIOJIb3YEMBIE AT JaHHBIX MHTEPBaJIa, JOJDKHBI TOJpa3yMeBaTh MOPSIOK U BEJUUMHY.

o 1715l TOYEK MBI MOKEM UCIIOJIb30BATh CUMBOJIBI C PA3JIMYHBIM pa3MepoM (OT MaJioro 10 OGOJIBIIOrO).

b ﬂﬂﬂ TMOJIMTOHOB Mbl MOKEM HCIIOJIL30BATh I'PAAYyUPOBAHHBIC IBETA (OT CBETJIOI'O 10 TCMHOI‘O) nim HOGaBJ’IHTL
ArarpaMMbl pas3jiIngYHOro pasmepa.

e Jlns TMHANA MOKHO MCTIONIb30BATh TOJIIMHY (OT TOHKOM JIO TOJICTOM/IIMPOKON).

B Knaccnq)nxaunu COOTHOIICHUS YMCJIa UMEIOT HIKAJTY TOJIBKO C IMOJIOXKUTEIbHBIMA U HYJIEBLIMU 3HAYCHUSAMMU. Ha-
NpUMep, TeMrieparypa Bbiie adcomoTHoro HyJis (0 rpamycos o KenbBuHy), paccTosiHUE OT TOUKHU, CPEeAHUN Tpaduk
IO JJaHHOU yJIHLe B MecAl U T. J. CUMBOJIBL, UCIIOJIb3yeMBlE AJIS1 JAHHBIX «COOTHOLIEHUS», TOJIKHBI IOJpa3yMeBaTh
MOPSIIOK U BEJIMUMHY.

e I TOYEK MBI MOKEM MCIHOJIb30BaTh CUMBOJIBI C Pa3JIMYHBIM Pa3MepoM (OT Majoro A0 OOJIBIIOrO).

® ,HI[H TMOJIMTOHOB Mbl MOKEM HCIIOJIb30BaTh I'PaAyUPOBAHHBIC IBETA (OT CBETJIOro A0 TCMHOFO) i )IOGaBJ'IHTb
AruarpaMMbl pas3jiIMgYHOro pasmepa.

e 7151 TMHAN MOKHO HMCTIONIb30BATh TOJIIMHY (OT TOHKOM JIO0 TOJICTOM/IIIMPOKON).

B npuBeeHHOM BBIIIIE TPUMEPE MBI HCHOJIB30BATTM HOMUHAIBHYIO KJIACCH(DHKALIUIO TSI OKpAIIMBaHUs KaX IO 3a-
mUcH B clioe 1anduse Ha ocHOBe ee arpudyta 1landuse. Tenepb Mbl OyzieM NPUMEHSTH KJIACCU(UKAIIUIO COOT-
HOIIIEHH S, YTOOBI KJIACCH(PHUIIUPOBATH 3aITUCH [0 MECTHOCTSIM.

MBI coGrpaemMcst nepeKiaccurIMpoBaTh CJIOH TAKMM 00pa3oM, UTO CYLIECTBYIOIINE KJIACCH OYAYT YTEPSHBI, €CIH
UX HEe COXPaHUTb. YTOOBI COXPAHHUTh TEKYIIYIO KJIACCU(PUKALIIO HEOOXOAUMO:

1. OTkpHITH TUas0oroBoe okHO CBOICTB crosl.

2. KiuknyTb Ha KHONIKY COXpaHUTb CTHIIb... Save Style ... B packpbiBaoiemcs MeHio Ctuib Style.

3. BuiOparts [lepenmeHoBath TeKymmid... Rename Current..., BOWTH B land usage u KIMKHYTh OK.
Kareropun 1 ux CMMBOJIBI TETIEPh COXPAHEHbI B CBOMCTBAX CJIOSI.

4. Tenepb HEOOXOAUMO KJIMKHYTh Ha KHOMKY [lo6aBUTh... Add... B pacKpbIBaioleMcs MeHIo Style u co31ath
HOBBIN ¢TI ¢ MMeHeM CooTHomeHue rat io. Takum oOpa3om OyzeT coxpaHeHa HOBasl KylaccupuKanysl.

5. 3akpeiTh quanororoe okHo CBoWCTBa ciost Layer Properties.

MBI XOTHM KJIACCH(PUIIMPOBATh MECTHOCTH 3€MJIETIOIb30BAHUA MO pa3Mepy, HO eCTh IpodieMa: Y HUX HeT MOJs
pa3mepa, Mo3TOMY MPHIETCS CO3aTh TAKOBOE.

1. Otkpoiite Tabmuiy ATpuOyThl 1j1si ciiost Landuse.

2. BoiiiuTe B peUM peJaKTHPOBAHHUA, KIMKHYB Ha KHOMKY ITepekmounTh pefakTupopanue  Toggle editing

3. ﬂ06aBbT€ HOBBIA CTOJ'I66LI JIECATUYHOrO THUIIA MO Ha3BaHMeM MecTHOCTh AREA ¢ noMollblo KHoNKu Hoeoe

roJje New field:
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Add Field )

AREA

Name

Comment

Type

Decimal number (double) -

Provider type FLOAT

4. Kmuknaure OK.

# Cancel «/ OK

Byzner no6asieHo HOBOe 1oJjie (B KpaiHeM IPaBoM YIIy TaOJMIbl, BaM MOXeET IOTPeOOBAThCS MPOKPYTHUTh
0 TOPU3OHTAIIH, YTOOBI €ro yBUIeTh). OHAKO Ha JIaHHBIH MOMEHT OHO HE 3alOJIHEHO, B HEM MTPOCTO MHOTO

3HauyeHuit NULL.

YroOBbl pemmTh 3Ty IpobiieMy, HaM MoTpeOyeTcsl pacCUnTaTh MECTHOCTH.

1. OTKpo¥iTe KaJIbKyJIATOP MO ¢ KHOIKOR =.

Bu TMOJIYYUTE TAKOE AHUAJIOIOBOE OKHO:

(2} landuse — Field Calculator 4
Only update 0 selected features
v | Create a new field Update existing field
Create virtual field
Qutput field name
Qutput field type | Binary object (BLOB) -
Cutput field length | 0 Precision
Expression Function Editor
A Q, se..|| Show Help
row_number
» Aggregates
» Arrays
+ Color
b Conditionals
b Conversions
b Date and Time
b Fields and Values
»  Files and Paths
¥ Fuzzy Matching
F General
b Geometry
» Map Layers
b Maps
k Math
¥ QOperators
- +  Rasters
= Jl+J- I/ I CJ) [ ¥ Record and Attribu...
b String
T - b ¥ User expressions
Preview: b Variables
0K Cancel Help
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2. YcraHoBure (prazkok g Update existing fields OGHOBUTH CYILIECTBYIOIINE TTOJIS.

3. Bribepure AREA B TOJNISIX PacKphIBAIOIIETOCS MEHIO.

Field Calculator O

Create a new field v| Update existing Field

1.2 AREA -

4. Bo BrJajike Boipaxenue Expression pa3BepHUTE CIIMCOK C Ipymmoi pyHkiwii Geometry v Haiiute $area.

5. JIBaXkIpl KJIMKHUTE HA Hee, YTOOBI OHA MOSIBUIIACH B ToJie Expression.

landuse — Field Calculator o

Create a new Field v Update existing Field
1.2 AREA -

Expression | Function Editor

] Lt Q search... function $area
$area > e . “ | Returns the area of the current feature. The
» Date and Time . .
» Fields and Values area calculated by this function respects both
» Files and Paths the current project's ellipsoid setting and area
» Fuzzy Matching unit settings. For example, if an ellipsoid has
» General been set for the project then the calculated
~ Geometry area will be ellipsoidal, and if no ellipsoid is
anale at_vertex set then the calculated area will be
planimetric.
area
azimuth Syntax
boundary ¢
bounds area
=LA A A ) bounds_height
bounds_width Examples
Feature |1 - [ 2 buffer
Preview: 1312821.1395745648 buffer_by_m - * jarea 42

@Help  cancel

2

o]
10
-

6. Kimmknute OK.

7. TpokpyTtute 10 oA AREA B Tabiuile aTpuOyTOB W BBl 3aMETHTE, YTO OHO 3allOJHEHO 3HAUECHUSIMHU
(BO3MOXHO, BaM MOTpeOyeTCst KIIMKHYTh Ha 3aroJIOBOK CTOJIONA, YTOObI OOHOBUTD JIAHHBIE).

HpnMeanne: ,HaHH])Ie MECTHOCTU COOTBETCTBYIOT HaCTpOfIKaM €IUHUIBI MECTHOCTH ITPOEKTA, TIOITOMY OHU
MOryT OBITh B KBaJAPAaTHBIX METPAX WJIN KBAJPATHBIX I'pagycax.

5. Kiukaute B, YTOOBI COXpaHUTb U3MCHEHUA U BBIATU U3 pexKrUMa peAAKTUPOBAHUA C TOMOIIBI0O KHOIIKKA

A L
TepekmounTh pelakTupoBanue  Togele editing

6. 3akpoiiTe CIMCcOK aTpUOYyTOB.
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Temneps, KOrIa y HaC ecTh AaHHbBIE, JaBalTe BOCIIOIB3YEMCS UMH AJIs1 BU3yaIn3anuu cnos landuse.

1. Otkpoiite BKIAAKY Layer properties B AUAIOTOBOM OKHe Symbology nuisi ciost landuse.

2. Wzmenure ctuib kiaccudukauuu ¢ [o kateropusim Categorized vHa Bennmuuna Graduated

3. Usmenure Value Ha AREA.

4. B pazpmene llperoas mkana Color ramp'evibepume napamemp Co30amv HO8YH UBEMOBYHD WIKANY...
:guilabel:'Create New Color Ramp...:

(2} Layer Properties - landuse | Symbology

Q

" Symbology

P4
= Graduated - |
Value |12 apea - |E|
—— g

Legend format |%1— %2

| precision 4 || [v| Trim

Color ramp | -
ELLH | Classes | d Invert Color Ramp
et Random Color Ramp
Masks Symbol |Vl
- | I Blues
Diagrams I Greens
G
Fields M Greys
. Magma
Attributes Form I | RdGy
I Reds
Joins
I |Spectra|
iliary Storage . Viridis
All Color Ramps J
Actions
Create Mew Color Ramp...
Display Edit Color Ramp...
’ —] Save Color Ramp..,
Rendering Mode | # £ # EquarconnTiguamey =T Classes | 5 =
Temporal | Classify | |i| |E| | Deleteal | | Advanced - |
V! Link class boundaries
Variables
p Layer Rendering
Mistadsta o[ s ok || canca || appy || e |
5. Buibepure Gradient (eciv OH eilie He BHIOpaH) U KimkHUTe OK. BBl yBUIMTE Clieqyloliee:
3.3. 3aHsatune: Knaccudpumkaums 87



QGIS Training Manual

() Select Color Ramp >
color 1 | (N |- coor 2 | |~ Type | Continuous M
] )
w Gradient Stop -
Relative position | 0.0 %G Delete Stop
% * _
LK G ¢ IR N o
Standard colors * | .. 5 _ 100% |2
- U :
= [ -5 -
] ~| | Opadty R o -
& | = HTML notation | #0000fF
Current *
w Plot
Information oK Cancel Help

Be1 OyeTe 1cnosp30BaTh 9T0 4J11 0003HaUeHU MECTHOCTH, HeOoJIbllMe Tepputopuu Kak Color 1, a Gonbliue
Teppuropuu kak Color 2.

6. BeiGepuTe COOTBETCTBYIOIIHE 1IBETA.

B nmpumepe Huke, pe3ysbTaT BHIVIAIUT CIELYIOLIMM 00pa3oM:
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(&) Select Color Ramp >

Color 1 - Color 2 _ - Type | Continuous =
| I |~ | O | o | |

w Gradient Stop |~
Relative position |IZI.III %% "‘| Delete Stop
& |e 8 |/ ST X '
[Standard colors - | Os T O = :

_‘ — -
. o D [ -

O« I T (230 3

[ _|*| | oOpadty T w00% |3

|@"E| HTML notation | #b2dfaa ol

ot o eI
Y OO ]

Information oK ] | Cancel | | Help

7. Kmuknaute OK.

8. BBl MOXeTe COXPAHUTh LIBETOBYIO IMIKAITY BHIOpaB KHONMKY CoxpaHuTh BETOBYIO mKaly Save Color Ramp...
Bo Bkyaake Color ramp. BoiOepure noaxonsiee UMs JUTsl IIBETOBOH IIKaJIbl M KIMKHUTE Ha Save. Tenepb Bb
CMOJKETe JIETKO BHIOpaTh Ty e caMmylo IIBETOBYIO IKany BeiOpaB All Color Ramps.

9. Knuknure Ha Classify

Teneps y Bac OyaeT 4To-TO MMOJOOHOE:
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@ Layer Properties - landuse | Symbelogy x
Q = Graduated - |
Value |1-2 AREA - | | £ |
Symboal | |'|
Legend format |%1— %2 | |Precision 0 |$| V| Trim
‘ Symbology _———  __
Colorramp | ~TTNINSS—S—S————————
abe! ————
| Classes | Histogram
e Symbol ™ Values Legend
¥ 131.30 - 10512.65 131-10313
¥ . 10512.65 - 35728.06 10513 - 35728
= v . 35728.06 - 132271.73 35728 - 132272
= ¥ . 132271.73 - 362220.57 132272 - 362221
- ¥ . 362220.57 - 112894046.06 362221 - 112894046
=0
Mode | H:EHEquaI Count (Quantile) ~ | Classes | 5 3|
| Classify | |¥| |;| | Delete Al | | Advanced '|
V| Link class boundaries
O

B Layer Rendering

| stye - ok || cancel || Appy || hHep |

OcraBbTe BCE OCTaJIbHOE KaK €CTb.

10. Kinukuute OK:

Bontebok &¥Shop)
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3.3.4 / Monpo6ynte camu: TouHo onpepenutb Knaccudpukaumo

 Uzmenure 3nauenus Pexumvel Mode n Knacest Classes, Toka He TOJy9rTe JIOTHYHYIO KJIACCU(DHUKALIIO.

IIposepvme ceou pesyavimamot

3.3.5 == Vpnem pansbiue: Knaccudpukaumsa Ha ocHoBe npasun
YacTo ObIBaET MOJIE3HO KOM6I/IHI/IpOBaTI> HECKOJIBKO KpUTEPHUEB I KJIaCCI/I(l)I/IKaLlI/II/I, HO, K COXaJIEHUIO, OObIYHAA
KJIaCCPI(bPIKaLII/Iﬂ YYHUTBIBAET TOJIBKO OJUH anI/I6yT. Bor 34€Chb U IMMPUTOANUTCA KJ'IaCCI/I(bI/IKaLlI/IH Ha OCHOBE IIpaBUJI.

Ha stom 3aHsTMM MBI IpeAcTaBUM ciloll landuse TakKUM 00pa3oM, YTOOBI MOXKHO OBUIO JIETKO OTJINYUTH FOPOJL
ICestengaml oT APYrux XWIbIX TEPPUTOPUI M APYTHX THIIOB 3EMJIETIONB30BAHMS (HA OCHOBE UX TEPPUTOPHH).

1. Ortkpoiite muanoroBoe okHO CBoiicTBa ciosi Layer Properties 1isi cnost 3emiernonb3oBadre landuse.
2. Tlepeiinute BO BKIAAKY Symbology.
3. TlepekmounTe CTIIb KiIaccuuKauuu Ha Rule-based.

QGIS ABTOMATUYECKHU IMOKAXKET IIpaBUJId, KOTOPBIC MPEACTABIAIOT TEKYLYIO KJ'[aCCI/I(l)I/IKaLlI/IIO, BBITTIOJIHEHHBIC
IJId JAaHHOI'O CJIOA. HaanMep, TIOCJIE BBIIIOJTHEHWS BBIIIEYIIOMAHYTOI'O YHNPaXHEHWS Bbl JOJDKHBI YBUICTH
YTO-TO BPOAE ITOr'0:

() Layer Properties - landuse | Symboelogy P4
Q E Rule-based hd
f}’ Information = Label Rule Min, scale Max.
v 131 - 101924 "AREA" »=131,200240 AND "AREA" <= 101924.495748
-T-,‘& TrrmEr v 101924 - 308418 "AREA" » 101824.459748 AND "AREA" <= 308417.846808
: v 309418 - 839955 "AREA" » 309417.846808 AND "AREA" <= 839954777508
v . 839955 - 1578789 "AREA" » 839954.777508 AND "AREA" <= 1578748.863263
v . 1578789 - 34452227 "AREA" » 1578788.863263 AND "AREA" <= 34452226.958486
€= Labels v . 34452227 - 112894046 "AREA" » 34452226,958486 AND "AREA" <= 112894046.060455
LD Masks
- -
. Diagrams 7 3
E Eislds g FIZ Symbol Levels...

Refine Selected Rules

Attributes Ferm

p Layer Rendering

Joins Style  ~ 0K Cancel Apply Help

4, KIMKHMTE U MepeTaluTe MBIIIKY, 4TOObl BHIOPATh BCE MPABUIIA.
o =
5. Vcnonb3yiiTe KHOMKY YIaTuTh BHIOpaHHBIE TIpaBuIa  Romove selected rules qro65r ynanuTs Bee cymecTByomme
TpaBua.

JlaBaiiTe Teriepb J0OaBUM HaIll COOCTBEHHBIE TIPaBUIIA.

1. Kiuknute Ha KHOMKY JJoOaBUTH MPaBUIO o Add rule
2. TosButcs auanoroBoe okHO Penaktupoats npasuiio Edit rule.
3. Benute ['opog Ceesienaam Swellendam city kak Label.

4. K/IuKHUTE KHOIIKY € PAIOM C TeKCTOBOH 06sactbio PuibTp Filter, 4ToObl OTKPHITH KOHCTPYKTOP CTPOKM
BblpaskeHull Expression String Builder.
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5. Beenure kputepuii "name" = 'Swellendam' u mogTBEpOUTE.

Expression String Builder 3

Expression | Function Editor

=] L)L Q search... group field ;
= Sweltendan ' Condltlc!nals | Double-click to add field name to expression string.
b Conversions . N
» Custom ngh.t—(illck on field name to open context menu sample value
» Date and Time loading options.
~ Fields and Values Notes
NULL =
123 ogc_fid
ave full_id values | @ search...
abc psm_id
abc osm_type All unigue 10 samples
=< landuse Fynbos Heights -
Gaikou Lodge
< type Koloniesbos
ane wikipedia Koornland
=0+ g ac boundary Marloth Nature Reserve
abe s in Railton
Feature |1 -J[<[@ = Ieisure
Preview: 0 e name:de - Wamakersbos -

@Help *® Cancel

6. Bepnutech B quanororoe okHO Pegaktuposath npaBuiio Edit rule, Ha3HaubTe eMy 00Jiee TEMHBIN CepO-CUHUIA
LIBET, YTOObI 0003HAYUTH BAXKHOCTh TOPOJIA B PETHOHE, U YAAUTE TPAHMILY.

Label swellendam city =
e Filter "name" = 'Swellendam’ & Test
Else Catch-all For other Features

Description

Scale range
v symbol
o
B simple Fill
Unit Millimeters -
Opacity _11100.0 % -
Color v

-

@Help *® Cancel

7. Kmnkaute OK.
8. TloBTOpHUTE BHINICYKA3aHHBIC IATH, YTOOBI JOOABHUTH CIIEAYIONIFE IPABHJIA:

1. Hagmuce dpyrue skmible ¢ KputepueM "landuse" = 'residential' AND "name" <>
'Swellendam' (wm "landuse" = 'residential' AND "name" != 'Swellendam').
BriGepure Oiie/iHbIN CHHE-Cephld LIBET 3aiMBKU B Fill color.

2. Hagnuce Bosbmme Hexxniable MeCTHOCTH ¢ KputepreM "landuse" <> 'residential' AND
"AREA" >= 605000. Beibepure cpenHe-3eIeHbIN 1IBET.

92 asa 3. Mopaynb: Knaccndoukaums BEKTOPHbIX OaHHbIX



QGIS Training Manual

Layer Properties — landuse (basic) — Symbology B

= Rule-based -
fz' Information * |Label Rule Min. Scale Max. Scale  Count Duplicate Count
v| [l swellendam city "name" = 'Swellendam’
a\:\\ Source v Other residenttial "landuse” = 'residential' AND "name" <> 'Swellendam'
v| [l Big non residential areas "landuse” <> 'residential’ AND "AREA" >= 605000
d Ssymbology
W# 30 View
-
4 Diagrams
g J[|Z Symbol Levels...
E Fields

E Attributes Form

» Layer Rendering
Joins @Help Style -

«/Apply | % cCancel +/ oK

JlaHHBIE (DUITBTPHI SBIISIOTCS SKCKIIIO3UBHBIMHU, TIOCKOJIBKY OHH MCKJIIOYAIOT MECTHOCTH Ha KapTe (HeXH-
Jple parioHbl pazmMepom MeHee 605000 (KBapaTHBHIX METPOB) HE BKJIIOUEHBI HU B OTHO M3 ITPABWI).

3. MBbI «JIOTOHMM» OCTaBIIHECS (pyHKI_II/II/I, HCIOJIb3Y s HOBOE IPABUJIO C HAAIIMCHIO Heo0oJblnne He;KHIbIE

MecTHOCTH. BMecTo BhipakeHusl (pUibTpa IPOBEPHTE | ® ' Else. [puaaiite 9TOR KaTeropuy MOAXO/s-
LM OJIeIHO-3€JIEHBIN LIBET.

Label small non residential areas =
Filter

) Else Caktch-all For other Features

Description

Scale range

v| Ssymbol

o
simple Fill

Unit Millimeters -

Opacity _11100.0 % -
Color v

-

@Help *® cancel

Bamm IpaBwWia TENEPh BbIIVIAAAT CIICAYIOIINM 06pa30M:
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Layer Properties — landuse (basic) — Symbology

= Rule-based

7) Information Label Rule Min. Scale Max. Scale  Count Duplicate Count
M swellendam city "name" = 'Swellendam’
"\;\ Source [ Other residenttial "landuse” = 'residential' AND "name" <> 'Swellendam'
M Big non residential areas "landuse” <> 'residential’ AND "AREA" >= 605000
‘ Ssymbology small non residential areas ELSE

€= Labels

[abc JELS

# 3D View

Diagrams

i rielos

E Attributes Form

|§| x|z |symbol Levels...|

P Layer Rendering
Joins _| @relp || style - | /Apply || % cancel H JoK I

9. TlpyMeHHTE HaHHYI0 CUMBOJIUKY.

Bama kapra OyaeT BbIIIAETh IPUMEPHO TaK:

< BontebokiNationallRark Reception &{Shop! =

Teneps y Bac ecTb Kaprta, Ha Kotopoil CeejuieHaam Swellendam — camas u3BecTHasi Xujiasi MECTHOCTb, a Ipyrue
HEXIJTbIe MECTHOCTH, OKPAIIICHBl B COOTBETCTBHU C MX Pa3MEPOM.

3.3.6 B 3aknrouyeHun

CuMBOJIMKA TI03BOJISIET HAM TIPECTABUTh aTpUOYTHI CJI0S1 B YIOOHOH sl uTeHus (popme. DTO MO3BOJISAET HAM, a
TaK)Ke YMTATENIO KapThl MOHSATh 3HaUeHHUe (DYHKIMI, UCHIOJb3Ysl 000 BHIOpAHHBIA HAMU COOTBETCTBYIOIIMIA at-
pubyT. B 3aBucMMoOcTH OT Npo6JIeM, ¢ KOTOPBIMU BBl CTaJIKMBAETECh, BbI OyeTe MPUMEHSTh Pa3IMYHble METObI
KJIaccuUKALNHY JUIS UX pELICHNSI.
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3.3.7 Yto panblue?

Temneps y Hac ecTh KpacuBasi KapTa, HO Kak Mbl cooupaemcst Boisect ee u3 QGIS B hopmat, KOTOPBI MbI MOKEM
pacrnieyarats Win Ipeodpa3oBaTh B m3o0paxkenre wi PDF? 1o Tema cieaymomero 3aHsaTus !
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rnasa 4

Mogynb: CoctaBneHune 6a30B0oi kapTbl

B JaHHOM MOZAYIJIC, Bbl Y3HACTE, KaK MPUMCHATb MAKET JId MeYaThu QGIS IUIL CO3JaHUsl KQYE€CTBEHHbBIX KapT CO
BCEMU H€O6XOI[I/IMI>IMI/I KOMIIOHCHTaMH.

4.1 3aHdatune: CospaHne ouHamMmuyeckoro makerta ne4yartm

Tenepp, korma y Bac eCTh KapTa, y Bac JOJKHA ObITh BO3MOXKHOCTb pacreyaraTh e WM BHIIPY3UTb B JIOKYMEHT.
[MpuunHa 3aKmo4aercs: B ToM, uto ¢aiin kaptsl GIS He siBisiercst uzodpaxeHuem. Ckopee, OH COXpaHsIeT COCTOSIHUE
nporpammbl GIS, co ccbiikamu Ha Bee CJI0M, MX HaIUCH, IBETa U T.4. Takum o0pa3oMm, [Uis TeX, Y KOro HeT JJaHHbIX
WM OIHOH 1 To# ke nporpammsl GIS (ranpumep, QGIS), daiin kapts 6yzner 6ecrnioneseH. K cuactsio, QGIS moxer
BBITPY3UTh (haiis1 KapTel B (hOpMAT, KOTOPBIH MOKET IMPOYMTATh JIOOOH KOMIIBIOTEp, a TaKXke pacriedaraTh Kapry,
€CJIM y Bac €CTb NMOAKJIIOYEHHBIH npuHTep. Kak BRIrpy3Ka, Tak M MedaTh BHIOJHSIOTCS € MOMOIIbI0 Makema 0ast
neuamu.

**[enb maHHOTO 3aHATHS: ** TpumenuTs Maxem ons newamu QGIS st co3nanust 6a30BOi KapThl cO BCeMH HE00-
XOOMMBIMH HACTPOMKAMHU.

411 \ Upem panbuie: [lucnetyep MakeToB
QGIS no3BoJseT BaM co3/1aTh MHOXECTBO KapT, MCIOJIB3YsI OAMH U TOT ke pailsl KapTel. [ 3TOrO0 MMeeTcs MH-
CTPYMEHT IO/l Ha3BaHUeM JJucnenuep Makemos.

1. Knmknure Ha Project » Layout Manager... , 9T00bI OTKPBITH STOT MHCTPYMEHT. [10sIBUTCS TycTO€ MaJIoroBoe
okHo [lucnietuep makeToB Layout manager.
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Layout Manager B

w New from Template

Empty layout -

Open template directory User

@Help % Close

2. B pasnesne HoBblii u3 mabiaona New from Template Boibepurte Ilycroit maker Empty layout v KIIMKHUTE Ha
KHOIKY Create....

3. IlIpucsoiite HoBoMy MakeTy ums CeesuteHgam Swellendam u kiukauTE OK.

4. Tlosutcst okHO Makem Oast newami:

Layout Edit View [tems AddItem Atlas Settings

BRERDE G @ &bk $® B @~

|a |5a |1uu |150| |zuu |250 ‘300 Iltems =
v et et b s b Eec e r e e 5 -
2 - ltem

‘ 0
Ll

50

Layout | Item Properties | Guides

Item Properties (E]ES]
= Page Size
_E Size A4 K ER
i Orientation Landscape K =R
a_: width 297,000 =g =0
§ Height 210,000 &S

Exclude page from exports (<,

200|

Background v

Pl FIATANTEBG

X:169.559 mm y: 86.6092 mm page: 1 43.4% > [LF

BrI Takke MOKeTe CO3AaTh HOBBII (popMaT ¢ MOMOILBI0 KOMaHABl MeHIo Project » New Print Layout....

Kakoii 661 MapiipyT Bbl He BBIOpaJIM, HOBBIH MakeT JJIsl Ie4aTh Tenephb AOCTYIIeH U3 MeHlo Project » Layouts »
Kak TMOKa3aHO Ha PUCYHKE HIKE.

98 FnaBa 4. Mogynb: CocraBneHue 6a3oBow KapTbl



QGIS Training Manual

Edit View Layer Settings Plugins Vector Raster Databa

" New Ctrl+N ;] g_j g__) &q

New from Template ’
Qpen... ctrl+o
Open From b
Open Recent »
Close
= save ctrl+s
| Save As... Ctrl+Shift+s
save To »
Revert...
Properties... Ctrli+Shift+P
Snapping Options...
Import/Export »
i New Print Layout... ctrl+P

) New Report...

% Layout Manager...

Swellendam
Exit QGIS crl+Q

41.2 \ Mpem panble: CocraBnsieM 6a3oBylo KapTy

B JaHHOM NMPpUMEPE KOMITIO3UIUS KAPThI YKE ObL1a TaKOﬁ, KaKOU MBI €€ XOTeJIN BUICTD. y6eIlI/ITeCI), YTO Ballla TOXeE.

1. KiMkHKTE MPaBOil KHOIKOW MBILIM Ha JIUCT B LICHTPAJILHON YacTH MakeTa OKHa U BbiOepute CBOMCTBA CTpa-
HULBL. .. Page properties... B KOHTEKCTHOM MEHIO.

2. Ybenutech, uto Bo BKjIajake CBOMCTBA 3j1eMeHTa ltem Properties yCTaHOBJICHBI CJIEAYIOIIUE 3HAYCHHUS:
* Size: A4
e Orientation: Landscape Opuenrarnus: Jlanmmadpt
Teneps y Bac ecTh MaKeT CTPAHUIIBI TAKOM, KaK BB XOTEJIH, HO 3Ta CTpaHMIIA Bee erle mycta. KapTel siBHO He
xBaTaeT. JlaBaiite ucripaBum 310!
3. KimkHute Ha KHOTIKY JI00aBUTh KapTy ”_—IE AddMap
AKTHBHUPOBAB JaHHBII HTHCTPYMEHT, BBl CMOETe Pa3MECTUTh KapTy Ha CTPaHHUIIE.

4. KnukHuTe M nepeTamuTe paMKy Ha MyCTYIO CTPaHUILy:
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*Swellendam

Layout Edit View [tems AddItem Atlas Settings

BRLURORE B @ikt e | | BE H- @

|o |50 |1on |150 |2ﬂn |250 | ‘300 ltems E®
v bbb b bvraoa b bvooo v bvvoar b bl vrah g —
@ 3 = & Item
el
ﬁ 3
5 EE Layout = Item Properties = Guides
!f;’ = Item Properties =]
8| :
L2
]
) .
E_
. |23
=._n ]
= ]
he <
3
width: 289.104 mm height: 202.495 mm X:292.763 mm y: 206.154 mm page: 1 43.4% v [

Ha crpanuiie nosiBurcs Kapra.
5. TlompuraiiTe KapTy, KJIMKasl ¥ IepeTacKUBas ee:

*Swellendam

Layout Edit View [tems AddIitem Atlas Settings

BRLRDR oy e | | B® H- B

300 Jtems

|0 |50 |100 ||150 |200 |250
s oo b b oo b b oo boode b rcoac oo b ocoa v boroa vl

@ = ltem

Layout | Item Properties | Guides

8l &7 =
I O P

I’R’ Item Properties @
a Map 1
& 2R ERMLE =
¥ Main Properties [
Scale 38108 | &
R- -
i-'u = Map rotation 0,00 ° |v| LET
- = CRS Use Project CRS - | |§|
A} : v Draw map canvas items
N
¥ 2 w Lavers E
1 item selected X: 140.892 mm y: 101.247 mm page: 1 |43.4% v | (———

6. M3menute ee pa3Mep, KJIMKas 1 IIEPETACKUBAsA PaMKy IO KpasM:
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Layout Edit View [tems AddItem Atlas Settings
=] YTk =] L [
BRRREDEB @ ®REge B8 S- @
|n ] |50 |1nn |150 |2nn |250 ‘300 ltems E®
o oo b bbb brroe b oo brrec b orrrbrver b rroa vl —
. @ - ltem
}FJ B u | Map 1
I -
+ | 2
lg EE Layout | Item Properties | Guides
R = Item Properties =]
- Map 1
I'E‘z_: S ER ER B =
-
- :‘ -
- ¥ Main Properties
= - P
: Scale 38108 =l
2 Map rotation 0,00 ° 1
- CRS Use Project CRS - || &
— S| v Draw map canvas items

A

width: 270.196 mm height: 187.247 mm

10.

11.

200

w Lavers

X: 25.0069 mm y: 20.7374 mm page: 1 43.4%

IIpnmeuanne: KoHeuHo, Bamla KapTa MOXET BBIIAAETh COBCEM MHAYe! DTO 3aBUCUT OT TOTO, KaK HACTPOEH
Ball coOcTBeHHBII npoekT. Ho He BosHyiitech! [laHHbIE MHCTPYKIMH SABJSAIOTCS OCHOBHBIMH, [T03TOMY OHH
OyayT paboTaTh OIMHAKOBO HE3aBUCHMO OT TOTO, KaK BBIIVISIAUT caMa KapTa.

O06s13aTeNLHO OCTAaBbTE T'paHULIBI IO KpasAM U MPOCTPAHCTBO BBEPXY IJIA 3aroJIOBKa.

[pubnukaiTe U OTAANANRTE CTPAHUILY (HO He KapTy!) ¢ IOMOIIBIO CIIETYIOIUX KHOIOK:

Hep

MaciraGupyiite 1 NpoKkpyuuBaiTe kapty B raBHoM okHe QGIS. Kapty Takke MOXHO MPOKPYTUTD C TIOMO-
& .

IbI0 MHCTPYMEHTa TIepeMecTTh CONEPKUMOE 3JIEMEHTA [E Move item content

By kapThl OOHOBJISIETCS TIPU MTPUOIIMKEHUHU U OTIAJICHHN.

Ecam mo kakoii-To npu4nHe BUA KapThl He OOHOBJISIETCS IPABUIIBHO, Bbl MOXETE NPUHYAUTEBHO OOHOBUTH

| .
KapTy, KJIMKHYB Ha KHOTKY OGHOBUTH B Mew Refresh view

[TomawmTe, YTO pazMep U MOJIOKEHHE, KOTOPHIE BB 3aJaIi HA KapTe, He 00s13aTeIbHO JOJKHBI OBITh OKOHYA-
TeJIbHBIME. Ecin BBl HE yAOBJIETBOPEHBI, TO BBI BCErja MOXETE BEPHYThCS M MI3MEHHUTH X To3xke. Ha maHHbII
MOMEHT BaM HYXHO YOeIUTbCsI, YTO Bbl COXPaHMIIM CBOIO paboTy Ha 31oii Kapte. [Tockosbky Maker st ne-
yatu B QGIS siBiisieTcs 4acThio OCHOBHOTO (paiisia KapThl, Bbl JOJKHBI COXPAHUTH CBOH MPOEKT.

=]
[epeitnure B Layout » Save Project. 10 ya0OHBII SIPJIBIK [Vl IEPEX0/ja Ha TOT, KOTOPBI HAXOAUTCS B
[JIABHOM JUAJIOTOBOM OKHE.
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41.3 \ Noem panble: Job6aBnsieM 3aronoBokK

Tenepp Bailia KapTa BHIISIAUT HA CTPAHUIIE XOPOIIO, HO YHUTAIOIIUM ee TOJIb30BATENsIM OHa €llle He TOBOPHT, YTO
Ha Hell ecTb. IM HyXeH KaKON-TO KOHTEKCT, KOTOPBIA Bbl MM IPEIOCTaBUTE, J00ABUB J1eMeHTh KapThl. CHauana
100aBHM 3arojIOBOK:

1. Kiukuure Ha KHOMKY JI00aBUTH HA/IIKChH @: Add Label

2. KimkHWTE HA CTpaHUIly HaJ KapToi, IPUMHTE MpeJIoKEHHbBIE 3HAUCHUS B TUaJIoroBoM okHe CBOMCTBa HO-
BOrO 371eMeHTa New [ltem Properties, U B BepXHEeH 9aCTH KapThl MOSIBUTCS HAIKC.

3. M3meHure pa3Mep U MOMECTHUTE €T0 B LIEHTP BBEPXY CTpaHUIlbl. MOXHO MEHATh pa3Mep U NepeMelaTb ero
TaK e, KaK Bbl I3MEHSUIN pa3Mep U IepeMeItaii KapTy.

Korna Ber TIEPEMECTUTE 3aroJIOBOK, Bbl 3AMETUTE TTOSABJIEHNE peKOMGH,HaI_II/Iﬁ, KOTOPBIE IIOMOT'YT BaM pa3me-
CTUTD 3ar0JIOBOK B LIEHTPE CTPAHUIIBI.

O)lHaKO Ha IMaHeJI1 UTHCTPYMEHTOB HeﬁCTBHﬂ €CTb UHCTPYMCHT, KOTOprﬁ TMOMOTracT pacCroJIOKUTh 3aroJIOBOK
OTHOCUTEJIbHO KapThbl (a HEC CTpaHI/II_[I)I)Z

|I:|
4. KnukHuUTE Ha KapTy, 4ToOBI BHIOPATh €ro.

5. VaepxwuBast Shift Ha KJIaBUaType, KJIMKHUTE HA HA/MKCh, YTOOBI BHIIEIUTD U KAPTY, U HAMIIKCH.

| .
6. Haiimute KHONKY BHIpOBHATH BHIOpaHHBIC JIEMEHTHI BICBO | Align selected items left yy y yyrxppTe Ha CTpenKy
PACKPHIBAOIIETOCS CIICKA PSIIOM C Hel, YTOOBl OTOOPa3UTh MapaMeTpsl MO3UIMOHIPOBAHUS, U KIMKHUTE

BBHIpOBHATH 1O LIEHTPY ﬁ Align center:

9 &[5 hht N > 9

| Align Right
“7 Align Top
-= Align Center Vertical

Layi - Align Bottom

Teneps paMka HaIMCH PACIIOJIOKEHa 110 LEHTPY Ha KapTe, HO He colepkuMoe. UToObl pa3MeCTUTh COAEPXKH-
MO€ HaJIIMCH [0 LEHTPY HEOOXOAUMO:

1. BuiOpaTh HaAIKCh, KJIIMKHYB Ha Hee.
2. KnuknyTts Ha BKiaaky CBoiicTBa nipeamerta ltem Properties Ha G0KOBOW IaHEJI OKHA MaKeTa.

3. N3menuTs TekcT Haamucu Ha «CeesuteHgaM» «Swellendam»:
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Layout | Item Properties | Guides

Itemn Properties @
Label

¥ Main Properties

Sswellendam

Render as HTML

Insert an Expression...

v Appearance

Font r
Font color I (-
Horizontal margin | 0.00 mm =
Vertical margin 0.00 mm =

Horizontal alignment

Left Center Right (e Justify
Vertical alignment
e Top Middle Bottom

Position and Size

>

P Rotation

3 Frame

3 Background
P Item ID

4. Vcnone3yiiTe AaHHBINA MHTepdeiic a1 HACTPONKHU IIpUdTa U MapamMeTpoB BbIpaBHUBAHUSA B pasjelie
Appearance:

1. BeiOepute KpymHBIH, B pa3yMHBIX Ipejesax, MpuQT (B JaHHOM IpuMepe OyAeT MCTIOIb30BaThCs
MIpIQT MO YMOTYAHUIO pa3MepoM 3 6).

2. Ycranosure ['opusoHTanibHOe BhipaBHUBaHue Horizontal Alignment nio Llentpy Center.

Bbl Takke MokeTe UBMEHUTh LIBET I_HpI/ICl)Ta, HO, CKOpEE€ BCETO, JIy4lll€ OCTaBUTh €ro Y€PHbIM I10 YMOIJI-
YaHUIO.

5. HacTpoiiku o yMOJIYaHHIO He MOTYT HOOABHUTh PAMKY B TEKCTOBOE IOJIe 3arosioBKa. OQHAKO, €CIIM BbI
XOTHUTE J0OABUTH PAMKY, BBl MOXKETE CIEJIATh 3TO CIIEYIOIINM 00pa3oM:

1. Ha Bxnanke Item Properties TpOKpyTUTe BHU3, TIOKA He yBUAUTe MapameTp Pamka Frame.
2. Haxwmwure Ha Frame, 9T0ObI BKJIIOUMTH PaMKYy. BBl Takke MOXeTe N3MEHUTSH IIBET ¥ IMPHHY PAMKH.

B sTOM IprMepe MBI He BKJIIOYAEM PaMKy, IOTOMY Hallla CTPaHHIIA TTOKA BBHIITISIUT TAKKMM 00pa3oM:

41.
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*Swellendam
Layout Edit View [tems AddItem Atlas Settings

BRLRDR B ®kimlke BB Q9 &E A - L -

|n |50 |1nn |150 | |2nn |250 ‘300 ltems E®
v dvven bbb boraoa b bvoaoalbcooao brvoaborooboror ol —

| @ - Item
) [ | | Swellendam
Ll I Swellendam v 0] Map 1
m —
I

2- Layout | Item Properties | Guides
R = Item Properties =]
|
IS

=
A5

X:173.218 mm y: -4.26947 mm page: 1 43.4% > | F

Brl moxeTe 33(1)I/IKCI/Ip0BaTL 9JIEMCHTBI Ha MECTE, YTOOBI cnyqaﬁﬂo HE NIEPEMECTUTD UX TTOCJIE BbIpABHUBAHU AL

1. BeiOepute HAAMMUCh U IEMEHTHI KapThl.

fiin!
2. Kiuknute Ha KHOTIKY 3a0JI0KMPOBATh BHIOPAHHBIE SJIEMEHTHI % Lock Selected Items

TOB /leiicmaus.

Ha IMaHeJIM UHCTPYMCH-

IIpumeuyanne: Kimukxure Ha Pa3z6iokupoBarh Bce 31eMEHTHI [9 Unlock All Ttems 3 japesin mECTpYMeH-
TOB Jeticmeus 4T0OB BHOBb OTPEJAKTUPOBATH SJIEMEHTBHL.

41.4 \ Unem panbue: [lobasnsiem nereHabl

Yurarommii KapTy Takke JIOJDKEH UMeTh BO3MOKHOCTh BHIETh YTO Ha CAaMOM Jiejie O3HAYAIOT Pa3JINUHble OOBEKTHI
Ha KapTte. B HEKOTOpPHIX CiTyyasx, Kak M B Ha3BaHHUSIX MECT, 9TO COBEpIIIECHHO OUeBHIHO. B Ipyrux ciy4asx yragats
CIIOXKHee, HAITpUMeD, 11BeTa Jieca. J[00aBUM HOBYIO JIETeH/L.

-
1. Kimkuute Ha KHONKy JoGaBUTH Nereny =-c3 Add Legend,

2. KiukHuTe Ha CTPAHUILY, YTOOBI pA3MECTHTh JIETEH/TY, IPUMUTE MPEJIOKEHHbIe 3HAYEHHUSI B THATIOTOBOM OKHE
CaoiicTBa HOBOTO 5teMeHTa New Item Properties.

3. Jlerenpa mobaBiieHa Ha CTpaHMIy MakeTa, OHa OTO6pa>KaCT CHUMBOJIBI CJIOEB, 3aJJaHHBIE B OCHOBHOM AHAJIOIO-
BOM OKHE.

4. Kak O6LI'~IHO, Bbl MOKETE KIIMKHYTb U IEPEMECTUTD JIEMEHT B HY’KHOE MECTO:
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*Swellendam

Layout Edit View Items AddIitem Aklas Settings

BRUROB & @ik o BB QL9 LE, N - L -

|o |50 |1on |150 |2ﬂn | ‘250 ‘300 ltems =5
oo b bbb bbb bovon b boern ol
@ 8 ltem
p | | Legend
; Swellendam v swellendam
| " v ] Map 1
I training_ dats buldings

[0 training gata restaurants
Eraining data reads.

[ training data schoals

nlaces

Layout | Item Properties | Guides

)

IRRR: Y P

5
!f? Item Properties 3
ears
watar Legend
f& =Df:h(m v a8
= dus O ¥ Main Properties [
Idfzz B
] [ fami
q 3 W Title |Legend | & |
] S
= ndusia
—  |B Map | EIMap 1 - |
9 0 rusidensi
2= =z -m'::":rlm Wrap text on | |
I-n ; W seeyard
& - - Arrangement | 3= Symbols on Left - |

v Resize to fit contents

“« nH
2ou|

0 —
X:243.36 mm y: 29.2763 mm page: 1 |43.4% ~ |

41.5 / WUnem panbuie: HactpamBaem aneMeHTbl nereHm,

He Bce B JIETCHAEC, ABJIACTCA O6H3aTe.HI>HbIM, MO3TOMY ;[aBaﬁTe YAaJIMM HEKOTOPbIE HEHYKHBIC JICMEHTHI.

1. Bo Briaake Item Properties BBl HaliieTe TpyMITy DiieMeHTHI JiereHn Legend items.

2. Cuumure ¢iaxok ¢ ABTOOOHOBJICHUS ) Auto update, 9TOOBI HATIPSIMYIO U3MEHSTh JIEMEHTHI JIETSH/IBI.

3. Bwibepure buildings.

4. Vpanute ero u3 JereHpl, KJIMKHYB Ha KHOIKY
Bbl Takxe MOXeTe neperMeHOBBIBATh SJIEMEHTHI.

1. Bribepurte ciioii U3 TOTO Xke CIVCKA.

2. Kimknute Ha KHONKY PenaktipoBath CBOMCTBA BHIOPaHHOTO SJIEMEHTA @ Edit selected item properties
3. Ilepenmenyiite cion Places, Roads and Streets, Surface Water,and Rivers.

Bprl Takske MokeTe N3MEHUTh TIOPAIOK JIEMEHTOB:
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*Swellendam

Layout Edit View Items AddIitem Aklas Settings

BRORER R eRREe ¢ B© 00 QR bbb > ®P -

||||D||||I|||||5|D|||I|||||1|D?||I|||||1|5?||I|||||2|ﬂ?||llll|l‘2|5?||\||||‘3|ﬂ? ltems B
@ ] @ ™ Item
p o= N
; : Swellendam O Swellendam
|m s P O v O I Map 1
T 4 B surface watar
5 EE ) famand Layout  Item Properties | Guides
FA’ ] =:;::ma| Item Properties @
!“-_{; E Emmn O Legend R
e e b Main Properties
IRNEESY e
= = e v Legend Items
7 _— -
3 e oo | __ Auto update | Update All |
Fz ~ Rivers E
E M surface water
] v (2 landuse
7 [ farmland
EE [ grass
N: M Farect ; b

[4]
X:242.75mm  y:-0.609924 mm page: 1 |43.4% - | (e

IockosbKy JlereHna, BeposiTHO, OyIeT paciiipeHa HOBbIMU UMEHAMH CJIOEB, Bl MOXKETE EPEMECTHTh U U3MEHHUTh
pa3mep JiereH 1l 1 / Wik KapTel. Bot pe3ysnbrar:

*Swellendam

Layout Edit View [tems AddIitem Atlas Settings

BRLRERE b ®kknine B8 C QLR hHE ~ L -

R P P P9 ttems =
@ & Itern
Swellendam ] Swellendam

O ] Map 1

meYae

| Layout | Item Properties | Guides

I(;’ Layout )
. d =
? 2} - » General Settings
I surface wakar
E 2- e P Guides and Grid
= = v Export Settings
q . 0 residential
E [ industrial
= B comarien Export resolution | 300 dpi =
- [0 resorvir
g 3 I e e || Print as raster
e
— | Roac and treets || Always export as vectors
. Places
A} | 2 A || save world file
F
H . w Resize Layout to Content A

x:237.87mm  y: 11.5885mm page: 1 |43.4% | O——vru

106 FnaBa 4. Mogynb: CocraBneHue 6a3oBow KapTbl



QGIS Training Manual

41.6 \ WUnem panblie: 9kcrnopTupyem (Bbirpyxaem) Kapty

IIpumeuyanne: Bbl 4acTo BCIIOMUHAETE O COXPAHEHUH Balllel paboThI?

HakoHelI-To KapTa rotopa K BHIrpy3ke! Bbl yBUIMTE KHOIIKY KCIOPTMPOBATh B BEPXHEM JIEBOM yIUTy OKHA MaKeTa:
* Tleuats makera P28 Print Layout, gyapvonefictyer ¢ mpriTepoM. [TocKOTBKY MapaMeTphi IPHHTEpa pasIHIaoT-
¢ B 3aBUCUMOCTH OT MOJIE/IM TIPUHTEPA, C KOTOPOH B paBoTaeTe, BEPOATHO, JTydIlle 0OPaTUTLCA K PYKOBO/I-
CTBY /Ul IPUHTEPA WIK K OOIIEMY PyKOBOJICTBY TIO TIeUaTH /Ul MOMyYeHUs JOTIOTHUTEMbHOI HH(OpMAITIH
10 JaHHOU TEME.

Jpyrue KHOIIKY MO3BOJISAIOT SKCIOPTAPOBATh CTPAHUILY KapThl B (haidl.

¢ DKCIOPTUPOBATh KakK M300pakeHHne Eg Exportas Image JlaeT BaM Ha BHIOOP pa3JIMYHbIC PacHpOCTpaHECHHBIE
opmatsl M300pakeHNd. DTO, HABEPHOE, CAMbBII IPOCTOM BapHAHT, HO N300pa)eHHe, KOTOPOe OH CO3/IAcT,
«MEPTBOE» M €ro TPYJHO PEAaKTHPOBATb.

* Dkcropruposath Kak SVG Exportas SVG: ecnip phl oTnIpaBisiete KapTy Kaprorpady (KOTOpPOMY MOKET TI0-
TpeOOBaThCS OTPEAAKTHPOBATh KapTy IS ITyOJIMKALMN ), JIy4Ille BCETro SKCIopTupoBaTh ee B hopmare SVG.
SVG o3Hauaer «Maciitabupyemasi BeKTOpHast rparka», Takke ee MOXHO MMIIOPTHPOBATh B TAKUE MPO-
rpammsl, Kak ~Inkscape *_ wim Jipyroe nporpaMMHoOe oOecrieueHue Uil peJaKTHPOBAHMUS BEKTOPHBIX M300-
paxkeHU.

* Dkcrnopruposath kak PDF /g Bxportas PDF. Eg iyt pay HY’KHO OTIIPABUTh KAPTY KJIMEHTY, Yallle BCEro UCTOMb-
3yetcst PDF-caiis1, OCKONBKY JU1s1 HEro Mpollie HaCTPOUTh TapaMeTpsl neyatu. Hekotopele kapTorpadsl Tak-
ke MoryT npeanodects PDF, eciu y HUX ecTh Iporpamma, ro3BoJisiolasi UMIIOPTUPOBATh U PEIAKTUPOBATh
3TOT popMar.

151 HAIMX 1iener Mbl OyieM ucrolb3oBath PDF.

= as
1. Kiknute na Dxcnopt B PDF £ 5 Exportas PDE,

2. Kak 00bpr1HO, BRIOEpUTE MECTO IS COXpaHeHus u uMs aiina. [losBuTtcs cienymoinee AUaIoroBoe OKHO.
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PDF Export Options 0

lw| Export Options

Always export as vectors
v Append georeference information

v Export RDF metadata (title, author, etc.)

Text export | Always Export Text as Paths (Recommended) -

v Advanced Options

Disable tiled raster layer exports

v Simplify geometries to reduce output File size

@Help % cancel | Psave |

Ter[ep}, BBl MOXkeTe 0e30I1acHO UCIOJIb30BaTh 3HAYEHHUS 110 YMOJTYaHUIO U KIIMKHYTb Save.

QGIS mpogomkuT IKCHOpPT Kapthl. KIMKHUTE Ha cOOOIeHre B BEPXHEH YaCTH JUAJIOrOBOrO OKHA IeYaTh
MaKeTa, KaK TOJIbKO IKCIOPT 3aBEPIIUTCS.

KiMKHHTE Ha TUIEPCCBUIKY B COOOIIEHUH, YTOOBI OTKPBITh MaIKy, B KOTOpor Obl1 coxpanen PDF-caiin, B
(paiinoBOM MeHeKxepe Balllell CUCTEMBI.

OTKpOWTE ero U MOCMOTPUTE, KK BBIIVISAUT BAIll MaKeT.
Bce HopmanbHO? [To3/1paBisieM ¢ MepBBIM 3aBEpIIEHHBIM IpoeKToM KapTol QGIS!

Bac 4ro-10 He yIlOBJ'IeTBOpHeT? BepHI/ITeCI) B OKHO QGIS, BHECUTE COOTBETCTBYIOIIINME U3MECHECHUSA U CHOBA
BBITIOJIHUTE DKCIOPT.

. He 3a0yapTe coxpaHuTb (haiiin mpoeKTa.
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4.1.7 B 3aknouyeHumn

Tenepb Bbl 3HaeTe, Kak CO3/1aTh 0a30BbI MAKET CTATMYHOW KapThl. Mbl MOKEM MOKTH Aajibllie ¥ CO3[aTh MaKeT
KapThl, KOTOPHI JUHAMUYECKU aalITUPYETCs], C OOJIBIIMM KOJIMIECTBOM JIEMEHTOB MaKeTa.

4.2 3aHdatne: Co3paHme ouHaMmMyecKoro makerta ne4yaTtm

Teneppb, KOraa Bbl HAYYHJIUCh CO3[aBaTh 0A30BBIA MaKeT KapThl, Mbl CAeJIaeM ellle OOWH IIar U CO3/aJuM MakKeT
KapThl, KOTOPBIH ANHAMUYECKH aJATUPYETCS K pa3Mepy KapThl M CBOMCTBAM CTPAHHLIBI, HAITPUMED, IPH N3MEHEHNH
pasmepa crpanuubl. Taxoke gaTa co3panus OyaeT JUHAMUYECKU afanTHPOBAThCS.

4.2.1 / WUpem panbuwe: Co3pnaem auHammnyeckoe MNMonotHo Kaptbl

1. 3arpysure HaGopsl naHHbIX opmata ESRI Shapefile protected_areas.shp, places.shp,
rivers.shp and water. shp B [losotHo KapTsl 1 HacTpoiiTe MX cBOMCTBA JUIs Ballero yfnoocTsa.

2. Iocne Toro, kak Bce OyzeT 0ToOpakeHo 1 0003HAUEHO CHMBOJIAMH Ha Balll BKYC, KIIMKHUTE Ha MKOHKY HoBas

nevath Makera | -C) NewPrintLayout ya pageny uncrpymentoB ni BhiGepute File » New Print Layout. Bam
OyJIeT TIpe/TIOKeHO BHIOPATh 3aroJOBOK /1l HOBOTO MaKeTa JIisl IeyaTy.

3. M5l XOTHM cO3/1aTh MaKeT KapThl, COCTOSIIIMI U3 3aT0JIOBKA M KapThl perrioHa Bo3ne CreiuteHnama, FOxHas
Adpuka. Y makera JOJDKHBI ObITH Kpasi 7,5 MM U BBICOTA 3arojIoBKa - 36 MM.

4. Cospaiite 31leMEHT KapThl HA3bIBaEMbIll main map B MOJOTHE KapThl U nepeiaute Ha nanenb Layout. [Ipo-
KpyTuTe BHU3 J0 pasaena [lepemennsie Variables n navinute paspen Layout. 31ech Mbl yCTAHOBAM HEKOTOPBIE
TIepeMeHHbIE, KOTOPBIE BBl MOXKETE MCTIOIb30BaTh HAa BCEM AMHAMHMYECKOM MakeTe a1 nevyatu. [epeiinure Ha
naHenb Layout v IpoK pyTHTe BHU3 10 pazzena Variables. TlepBas nepemeHHas Oyziet onpenessats kpasi. Kink-

HUTE Ha KHOIIKY EI'II}J U BBEJIUTE B CTPOKE UMEHM sw__layout_margin. YcraHnoBure 3HaueHue 7 . 5. CHoBa
KJIMKHUTE Ha I:II-II-I:I U BBeAuTe UM sw_layout_height_header. YcraHoBute 3HaYeHue 3 6.

5. Tenepb BBl TOTOBBI ABTOMAaTHUYECKH CO3JATh MOJIOKEHUE U Pa3Mep MOJIOTHA KAPThI C MOMOUIBIO EPEMEHHBIX.
Y6eautech, 4TO Ball JIEeMEHT KapThl BLIOpaH, NepeluTe Ha NaHemb ltem Properties , IpOKPYTUTE BHU3 U

'ﬂF, Data defined override

oTkpouTte paszaen [lonoxenne u pasmep Position and Size. KnmukanTe Ha s X U u3

Variables Boibepute @sw_layout_margin.

'd F, Data defined override

6. Kimmkaute Ha ans Y, v BeiGepute Edit... v BBequte hopmyIy:

’to_real(@sw_layout_margin) + to_real (@sw_layout_height_header)

7. Bsl MOXeTe 3a7aTh pa3Mep IeMeHTa KapThl, HCHOJIb3Ys1 IepeMeHHbIe A71s1 INUPHUHBI 1 BEICOTEl Width u Height.

-t]E. Data defined override

Knuk Ha st Width v cHoBa BbiGepute Edit .... 3anoaute ¢hopmyy:

’@layout_pagewidth - @sw_layout_margin * 2

-l!] E Data defined override

Kiuknute Ha 1uis1 Height v cHoBa BeiGepure Edit .... 3anonaure hopmyIy:

’@layout_pageheight - (@sw_layout_height_header - @sw_layout_margin * 2

8. Mbl Tak:ke co3JauM CEeTKY, B KOTOPOH CoAepKaTcsi KOOPAMHATHI Bcell OCHOBHOM KapThl. CHOBA nepenante

B Item Properties v BoiOepute paszaen Grids. BcTaBbTe CeTKy, KJIMKHYB Ha I:II'II-I:| Knukuure na Modify grid ...
u ycraoBute Interval nns X, Y u Offset B COOTBETCTBUM C MacIiTaboM KapThbl, KOTOPHIA Bbl BHIOpAIN Ha
ocHoBHOM nonotHe QGIS. Tlepekpectneiii Tun cetku Grid type Cross 0O4eHb XOPOIIO MOAXOJUT AJIS HAIINX
LEJIEN.
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422 / NUpem panbue: Co3paeM ouHaMmyeckum 3aronoBokK

34 Add Shape

1. BcraBbTe MNpAMOYTOJIbHUK, B KOTOPOM 6yII€T 3aroJIOBOK, C IIOMOMIbIO KHOIIKHU . BBG,[II/ITC nMA

3arojioBka header Ha maHenu Items.

2. CuoBa niepeiinute K Item Properties u oTkpouite pasnen Position and Size. Vicionb3ys 4E pata definea override ' ppy-

OepuTe nepeMeHHylo sw_layout_margin kak ais X, tak u ais Y. Hlupuna Width nomxHa orpeiensTbest
CJIEIYIOIIUM BhIpaXKEHUEM:

@layout_pagewidth - @sw_layout_margin * 2

a Beicota Height nepemenHoll sw_layout_height_header.
3. MB&I BCTaBUM rOPH30HTATIBHYIO JIMHUIO U JIBE BEPTUKAJIbHbBIC JIMHUM, YTOOBI pa3/e/ITh 3ar0JI0BOK Ha pasHble

ceKIuu rpu riomouy JIoGaBUTb SMEMEHT y3a IEI Add NodeItem ' Co31ajiTe ropU3OHTAIBHYIO JIMHUIO BE BEp-
TUKaJIbHbIE JIMHUU Ha30BUTE UX Horizontal line,Vertical line 1 Vertical line 2.

1. 17151 rOpU30HTAJILHOM JIMHUU:
1. 3apaiite X Ui mepeMeHHOM sw_layout_margin.

2. 3apaiite BbIpaxeHue 1 V-

’@sw_layout_margin + 8

3. 3apaiite Beipaxkenue st Width:

’@layout_pagewidth - (@sw_layout_margin * 3 - 53.5

2. Jlns nepBO BePTUKAIBHOM JTMHUU:

1. 3apnaiite BeIpaxeHue 1 X:

’@layout_pagewidth - @sw_layout_margin * 2 - 53.5

2. 3apaiite Y 1715 nepeMeHHOM sw_layout_margin.

3. BbicoTa JIOJKHA COBMAIATH C CO3JAHHBIM HAMH 3ar0JIOBKOM, 03TOMY 3ajiaiite Beicoty Height st
nepeMeHHol sw_layout_height_header.

3. Bropas BepTHKaJIbHAs JIMHUS, YCTAaHOBJICHA CJIEBa OT MEPBO.

1. 3apaiite BblpaxxeHue 11 X:

@layout_pagewidth - @sw_layout_margin * 2 - 83.5

2. 3apaiite Y 1715 nepeMeHHOM sw_layout_margin.

3. BbicoTa JOJKHA COBMAAATh C IPYroi BEPTUKATIBLHOM JIMHKEH, M03TOMY 3ajaiite Height nnsi nepe-
MEHHOI sw_layout_height_header.

Ha PUCYHKE HMKE IOKa3aHa CTPYKTypa HAIIEro JMHaMHUYE€CKOro MaKeTa. MBbl 3anoIHUM HEKOTOPLIMU dJI€-
MCHTaMU TE 06]'[21CTI/I, KOTOPBIE CO3JaHbl TMHUSAMMU.
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Layout Edit View Items AddIitem Atlas Settings
BELOEEE b @Rk e &
LLALHAT BEE G LR AL

TN =P 1 PN FR st BBt Fobbt Bt e s ot o

{”J _ il i 111 | Items | Undo History

E Items BE
p CE @ & Item [~

T v ™ logo organisation
h E v v {7 vertical line 2
[E = v v {7 vertical line 1
EE v map description
-["\’ E v = scale
e v = north arrow
[E E v [T] project title (Variable)
EE v [T] organisation information (Variables)
B~ 204 204 205 205 206 206 v vl horizontal line
E o i 1 _hearder
i = 339 + + + + + + 339 Layout II:.em Properties | Guides = Atlas
= Item Properties @
8| = < | Map Grid Properties
2y |3 w Appearance =
= =
o Zojms 4 + + + + 4+ a9 Grid type Cross -
=1 RS EPSG:4326
Interval units Map unit -
X 0,050000000000

-+ 4+ 340 Interval

g; 'Y 0,050000000000 a (s
E X 0,050000000000 e
= Offset
(g3 'Y 0,000000000000 B
z R . + + -34.0 Cross width 3,00 mm >
= ’ Line style Il
8- E
=3 » Blend mode Normal | -
1 item selected x:124.577 mm y: 92.8866 mm page: 1 96.8% v =k

4.2.3 / Upem panblie: Co3paeM Hagnucn onsi AMHaMMYecKoro 3arosos-
Ka

1. Haspanue Barero ITPOEKTa QGIS MOJKET BKJIIOUaThCSl aBTOMaTHyecku. Ha3BaHue 3arojioBka 3ajaercs B

CsoiictBax npoekTa Project Properties. BcTaBbTe HaIICh C TOMOIIBIO KHOMKI E!: Add Label o ppemtte UMs
project title (variable).B OcHoBHBIX cBOiicTBax Main Properties Ha manen CBONCTB 9JIeMEHTOB
Items Properties BBeIuTe ClieylOlIee BbIpaXkeHuUe:

[$@project_title%]

3ajanTe MoJIOXKEHNE HAIINCH:

1. Jna X, ucrnions3yiTe BhIpakeHUe:

@sw_layout_margin + 3

2. Ins Y, UCoyb3yiTe BHIpakeHHe:

@sw_layout_margin + 0.25

3. Hns Width, nicnons3yiiTe BeIpaKeHHe:

@layout_pagewidth - @sw_layout_margin *2 - 90

4. Beegure 11.25 nus Height.
B paznene Buermnmit Bun Appearance ycranosure pa3mep mpudta 16 pt.

2. Bropas Hagmuch COZIEPXKUT ONMCAaHKUE CO3/IaHHOW BaMu KapThl. [IoOBTOpHO BBeIUTE HAJANKCh U HA30BUTE €€
map description. Onucanue kaptel. B Main Properties BBeaute TekcT map description. Mbl Takxke
BKJI0YUM B Main Properties:

printed on: [%format_date (now (), 'dd.MM.yyyy') %]

3nech Mbl Ucnionb3oBau e pyHkumu Date and Time functions (now u format_date).

3ajanTe NoJIoKEeHUE HAIIHCH:
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1. Jnsa X, ucrosp3yiTe BHIpakeHHe:

’@sw_layout_margin + 3

2. Ins Y, UCoNb3yiTe BHIpakEeHHE:

’@sw_layout_margin + 11.5

3. TpeTbs HaAIKCh BKJIIOYAET MH(MOPMAIHIO O Barliei opranm3anyi. CHavaia Mbl CO3a M HECKOJIBKO IepeMeH-

HbIX B MeHI0 Variables u3 Item Properties. [leperinure B MeHIO Layout KaxIplil pa3 KJIMKaWTe Ha KHOMKY EI-IE-J u
BBOJIWTE Ha3BaHM: o_department, o_name , o_adress U o_postcode. Bo BTOpOfI CTPOKE BBEIUTE
uHpopmalmio o Baiei opranuzanun. Mbl Oy1eM NPUMEHSTh 9TU NepeMeHHbIe B pasieiie Main Properties.

B paznene Main Properties BBegUTe CIEAyIOIIEE:

o

@o_name 5]
Qo_department %]
@o_adress %]
@o_postcode %]

o° o° o o

3ajanTe NOJIOKEHUE HAIINCH:

1. Ins X, ucnosib3yiTe BbIpaKEHUE:

’@layout_pagewidth - @sw_layout_margin - 49.5

2. [na Y, ucnosib3yiTe BbIpaKEHUE:

’@sw_layout_margin + 15.5 ‘

3. Hna Width uctions3yiite 49 . 00.

4. Jns Height ucnionb3yiTe BEIpakeHNE:

’@sw_layout_height_header - 15.5 ‘
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Layout @ Item Properties = Guides = Atlas

Item Properties (3]
Label

¥ Main Properties

[% @o_name%]

[% @0 department]
[% @o_adress%]

Pﬁ @o_postcode%|

Render as HTML

Insert an EKPFEESiGﬂ...

4.2.4 / Npem panbuwe: [lo6aBnsieM naobpaxeHus K oUHaMU4ECKOMy 3a-
ronoBky

1. Vcnonb3yiite KHOMKY & AddPICWe "yro6rr pasmMecTuTh KapTHHKY Hajl Balleil HAAMUCHI0 organisation
information. Ilocne BBoja Ha3BaHusi organisation logo, onpenenure MoJoKEHUE U pa3Mep J0ro-
TUIA:

1. Insa X, ucnionb3yiTe BEIpakeHHe:

’@layout_pagewidth - @sw_layout_margin - 49.5

2. Ilns Y, UCoNb3yiTe BHIpakeHHE:

’@sw_layout_margin + 3.5

3. Jns Width ucnonb3yiite 39.292.
4. JIna Height ucnione3yiite 9. 583.

YroObl 106ABUTH JIOTOTHUII BAIlleld OPraHU3AlMH, BbI JIOJKHBI COXPAHUTh €r0 B CBOEM JOMAIITHEM KaTtajore u
BBECTU IyTh B Main Properties » Image Source.

2. HameMy MAKETy MO-NPEKHEMY HY)KHaA CTPEJIKA, YKasblBalomlasd Ha CEBEP. CTpenKy MOJKXHO BCTaBUTHb TaKXKEC

¢ niomotipio JJ00aBUTH CTPENIKY Ha ceBep A] Add North Arrow -\ g GyzeM HCHIONB30BaTh CTPENKY HA CeBep 0
yMo4anuio. Onpeenire MoJokeHue:

1. Ina X, ucnionb3yiiTe BeIpakeHHe:

@layout_pagewidth - @sw_layout_margin * 2 - 78
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2. Ins Y, NCHIONB3YHTE BHIpaKEHHE:

@sw_layout_margin + 9

3. Hnsa Width uctions3yiite 21 . 027.

4. Jina Height ucnions3yiite 21 .157.

4.25 / Mpnem panble: Co3naem LWKany AUHaAMUYeCKOro 3aroioBka

=]
1. YToOBI BCTABUTH LIKATY B 3ar0JIOBOK, KJIMKHUTE Ha KHOIIKY Add Scale Bar i oMecTuTe ee B MPAMOYTOJBHUK

HaJ| CTpesikol Ha ceBep. B Map B pasnene OcHoBHbIe cBOlcTBa Main Properties BbiOepuTe main map (Map
1) . D10 03HAYAET, YTO MACHITA0 U3MEHSIETCs] ABTOMATHUYECKH COIVIACHO pa3Mepy IMPOTSKEHHOCTH, KOTOPYIO
BBI BHIOpaJI Ha 0cHOBHOM moJioTHe QGIS. Bribepurte Style Numeric. 910 03HA4aeT, YTO Mbl BBOAUM MPOCTOR
MaciuTab 6e3 mkaibl. Tak Kak JuIst HIKaJIbl HY)XKHO MOJIOKEHUE 1 pa3Mep.

1. dnsa X, ucnionb3yiTe BHIpakeHHE:

@layout_pagewidth - @sw_layout_margin * 2 - 78

2. Jns Y, ucnonb3yiTe BRIpaKeHUe:

@sw_layout_margin + 1

3. Ina Width ncnons3yiite 2 5.
4. Jnsa Height ucnions3yiTe 8.
5. Pasmectute Reference point mo HeHTpy.

IMoznpasnsio! Bel co3nanm cBoi NMepBblil JMHAMUYECKUI MaKeT KapThl. B3IIsiHUTe Ha MakeT M MpoBepbTe, BCE JIH
BBIIJISIZINT Tak, KaK Bbl XoTesnu! MakeT AMHaMUYECKOH KapThl aBTOMAaTUYECKH pearnpyeT Ha u3MeHeHne CBOICTB
CTpaHHUIIbl page properties. Hanipumep, ecit Bel m3MeHuTe pa3mep crpanuiisl ¢ DIN A4 va DIN A3, ximkHuTe Ha
OO6HOBUTH pocMOTp REFTEShVIEW 'y nysajin cTpanmiel GyeT aganTupoBaH.

Layout Edit View Items AddIitem Atlas Settings

=) =) ol
E (b @ Blbyls ih ©
~al G e et Lt
PLPRC BHEEE O bHEL
@ ,‘D\HHHH‘zwulHI\H\l“\oluIHl\lswou\IHH‘B\G\H\HH“P\DHMHl“lzw?\l\lul“\qwou\uu'\EPH\HHl'\sluulwlulzxuxuulu Items | Undo History
E Items @
p = ® & Item =
a1 = v v £ vertical line 1
5| = The area of Swellendam 1:116495 < [l map description
@ = v v == scale
map description v v = north arrow
[»} “Your department’ v v [T] project title (variable)
"Your organisation’ . - - . .
E ( ‘ “Your adress’ v v [T] organisation information (Variables)
[E & pintad on: 16.05.2019 ‘ "Vour pastcode! v v " horizontal line
ER v v [] header
= E 204 20.4 20.5 205 20.6 206 I8 main map (Map 0)
= 339 33, Layout | Item Properties | Guides & Atlas
o 5 + o+ o+ s | e e
= Item Properties BE
e = <« Map Grid Properties
rj‘a =_: ¥ Appearance =
EE
= -339 + + + -|— + + -33.9 Grid type Cross -
E CRS EPSG:4326
=
= Interval units Map unit -
; X 0,050000000000

-+ + 340 Interval

'Y 0,050000000000 =
E X 0,050000000000 <
3 Offset
? 'Y 0,000000000000 5
= + + -34.0 Cross width 3,00 mm s
L= Line style I*|
E:« » Blend mode Normal ~| -
1 item selected x:124.577 mm y: 63.6546 mm page: 1 96.8% v =k
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4.2.6 Yto panbwe?

Ha cnenyromeii crpanuie Bam OyaeT NpeyIoKeHO BBIIOJIHUTD 33/laHNe. DTO TIO3BOJIMT BaM IPaKTUKOBATh METO/IBI,
KOTOPBIE BBl YK€ U3YUMJIH.

4.3 3apaHue 1

OTKpO¥iTe Balll CYIEeCTBYIOIINIA IPOEKT KapThl U TIIATEIBHO €ro OTpeJakTupyiite. Eciu BB 3aMeTHIIN MeJIKHe OIno-
K{ WJIM BEIIW, KOTOPBIE XOTEJM UCTIPABUTh paHee, ClIeJIaiTe 3TO cerJac.

I[Tpu HacTpoiike KapThl MPOJOJDKANTE 3aJaBaTh ceOe BONPOChL. JIErKo Jin YhTaTh U MOHUMATh ITY KapTy TeM, KTO He
3HaKoM c JanHbiMu? Eciim Obl 51 yBHIE 3Ty KapTy B MIHTEpHEeTe, Ha TUT1aKkaTe WK B )KypHaJsIe, IPUBJIEKa Obl OHa MOe
BHUMaHMe? XoTel OBl sl TPOYUTATh Ty KapTy, eciiv Obl OHa He OblIa Moeii?

Ecnu BH n3yuaere JaHHBIA Kypc Ha \ 6azoBoM MM / CpeHEM YPOBHE, O3HAKOMBTECh C METO-
JaMH U3 GoJiee «IPOJBUHYTHIX» pasnesoB. Eciu BBl BUIHMTE Ha KapTe YTO-TO, YTO BBl XOTEJHM OBl CIe/IaTh, OYEMY
OBl He TIOMPOOOBATh PeaIu30BaTh 3T0?

Eciu BaM nipenoaloT JaHHbIH Kypc, TO IpernoaaBarelib Kypca MOKET NOTpeOoBaTh, YTOObI Bbl OTIIPABUIA OKOHYA-
TeJIbHYIO BEPCHIO Balllell KapThl, 3kcrioptupoBanHyio B PDF, nis onenku. Ecnu Bbl poXoauTe AaHHBIN Kypc camMo-
CTOSITEJIbHO, PEKOMEHIYETCs OLIEHUTh COOCTBEHHYIO KapTy IO TeM ke KpuTepHsiM. Baia kapra OyzieT orieHUBaThCs
1o o0IIeMy BHIY M CIMBOJIMIKE CaMOW KapThl, a TAK)Ke N0 BHELITHEMY By M MaKeTy CTPAHHUIIBI U JIEMEHTaM KapThl.
INomHMTE, YTO ITPU OLEHKE BHELIHETO BUJA KapT YIOP BCETAa JEIaeTCs Ha npocnonty uchons3osanus. Yem mydiie
KapTa BBIVIAAUT U YEM JIETYe €€ MOHATH C IIEPBOIO B3IVIAJA, TEM OHA JIyYIle.

VpayHoi HacTpoiku!

4.3.1 B 3aknoyeHvun

B niepBbie 4eThIpex MOAYJISIX Bbl HAYUMIIMCh CO3/IaBaTh M CTUIM30BATh BEKTOPHYIO KapTy. B cieayonmx yerbipex
MOJYJISIX BBI y3HaeTe, Kak ucroab3oBaTh QGIS mis mposenenus nonHoro aHanmusa GIS. Ciopa BXOIAT co3aHue U
pC,H,aKTl/IpOBaHl/Ie BeKTOprIX JAaHHBbIX ; aHAJIN3 BCKTOpHI)IX JAaHHBIX ; UCITIOJIb30BAHUE U aHAJIU3 paCTpOBI)IX JAaHHBIX; 1
ucnofb3oBanue GIS uist perieHrs MpoOJieMbl OT Havdasia JI0 KOHIA, MCIOJIb3ysl KaK pacTpOBbIe, TAK U BEKTOPHBIE
WCTOYHUKU JaHHBIX.
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Module: Moaynb: CosnaHne BEKTOPHbIX AaHHbIX

CO3,IIaHI/Ie KapT [pu NMMOMOUIN CYHIECTBYIOIIMNX JAHHBIX — 9TO TOJILKO HAa4aJio. B sTtom MOJYJI€ Bbl Y3HAE€TE, KaK MO-
,E[I/I(I)I/ILII/IPOBaTL CYHIECTBYIOIINE BEKTOPHbIC JaHHBIC U KaK IMOJIHOCTBHIO CO31aBATh HOBLIC Ha60pbl JAaHHBIX.

5.1 3aHsaTne: Co3paHue HOBOro Habopa BEKTOPHbIX AaHHbIX

JlaHHBIE, KOTOPBIE BBl HCTIONB3YETE, JOJIKHBI OTKYJA-TO IOCTYIAaTh. [JaHHBIE yXe CYLIEeCTBYIOT IJ1s HauOoJIee pacIpo-
CTpaHEeHHBIX NPUJIOKEHU; HO YyeM OoJiee KOHKPETEeH U CIelMaiu3upoBaH MPOEKT, TEM MeHbIIe BEPOSITHOCTh TOTO,
YTO JIaHHBIE YK€ OyIyT JOCTYIHBI. B Takux citydasix BaM HYXXHO Oy/IeT co3[aTh CBOM COOCTBEHHbIE HOBBIE IaHHbIE.

He.m; JAHHOTI0 3aHATHA: CO3IaTh HOBBIN Ha60p BEKTOPHBIX JaHHBIX.

511 \ Upem panblie: [lmanorosoe OKHO AJ1IS CO30aHNSA CNosi

Ipexe yeM Bbl CMOKeTe J0OABUTh HOBbIE BEKTOPHbBIEC JaHHbIE, BAM ITOHAJI0OMTCS] HAOOP BEKTOPHBIX JAHHBIX, IS
TOr0 4TOOBI MX TOOABUTH. B HallleM ciTyuyae Bbl HAYHETE C CO3JaHuUsI aOCOIOTHO HOBBIX JIAHHBIX, & HE C PEIaKTHPOBa-
HUS CYIIECTBYIONIEro Habopa AaHHbIX. ClieloBaTeIbHO, BAM CHavasla HeOOXOAUMO OIPEACUTh CBOM COOCTBEHHBIN
HOBBII HAOOp TAHHBIX.

1. Otkpoiite QGIS u co3maiite HOBBHII ITyCTOM MPOEKT.

2. TlepeiinuTe U KJIMKHUTE MEHIO, Boiinute B Layer » Create Layer » New Shapefile Layer v kiiukauTe ero. Bam
OyJeT npeicTaBlIeHO quasioroBoe okHo HoBwlii croit mein-aitna New Shapefile Layer, 9To TIO3BOJIUT BaM
OIPENIENUTh HOBBIH CIIOM.
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N
File name
File encoding UTF-8 >
Geometry type Point v
Additional dimensions ‘@' None Z (+ M values) M values
EPSG:4326 - WG5S B4 v ||

New Field

Name

Type | abc Text data v

Length |80 Precision

Add to Fields List

Fields List

MName Type Length Precision

id Integer 10

Remowve Field

OK Cancel Help

Kmmkawnte Ha ... B ione File name. TIoBUTCS T1aoroBoe OKHO COXpPaHEHHS.
[lepetigute B Katanor exercise_data.
CoxpaHuTe HOBBII CJIOI Kak school_property.shp.

Ha stom 3Tane BaxxHO PpeIInTh, KaKOH THII Ha60pa JaHHBIX BaM HYJKCH. Ka>1<11},11?1 BCKTOpHLIﬁ THII CJIOA «CTPO-
HTCA I10-CBOEMY» B (bOHOBOM PEEKUME, TIOITOMY ITOCJIE CO3AaHUA CJIOA Bbl HC MOKETE U3MEHUTD €r0 TUII.

B cnenyromiem yrnpaxHeHHH Mbl COOMpaeMcsi Co3aTh HOBbIE (DYHKIIMH, OIMCHIBAIOIME MECTHOCTH. Bam 1o-
TpebyeTcsi co3maTh HaOOP TAHHBIX TTOJIUTOHA IS TAKUX (DYHKIIUH.

B nosne Tun reomerpuun Geometry Type, Beioepute [Tomuron Polygon B packpbIBaloIEMCs] MEHIO:

Geometry type ~ Polygon -

ITO He BIMLET HA OCTaJIbHYIO YaCTh JUAJIOrOBOro OKHa, HO MPUBECAET K UCIOJIb30BaHUIO ITPABUJIBHOI'O TUIIA
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TeOMETPUH TIPU CO3IaHUM Ha0opa BEKTOPHBIX JaHHbIX.

B criepyromiem nosie MoxHo ykazath Cuctemy koopausat (CK-CRS). CCK - 31o MeTos CBSI3bIBAaHUS YUCIOBBIX
KOOPJIMHAT C MMOJIOXKEHUEM Ha MOBEPXHOCTH 3emit. YToOk! y3HATH O0JIbIe, CM. PyKOBOICTBO MOJIb30BATENS
o pabote ¢ mporHo3amu - Working with Projections.

B nanHOM mpumepe Mbl Oy/IeM KCIOb30BaTh, CBSA3aHHbIN ¢ 3TUM npoektoM, CCK mo ymonuanuio, T0 eCTh
WGS84.

EP5G:4326 - WGES 84 v ||

Hanee uaer Habop nosielt, crpynnupoBaHHbix B HoBom mone New Field. Tlo ymon4aHuio, HOBbIN CJIOH HMeeT
TOJIBKO OAMH aTpHOYT — mojie 1d (KOTopoe B JOJUKHBI YBUAETH B crMCKe moneit Fields list) Hike. OnHAKO
JJI TOI'O, ‘{T06I)I co3aaBacMbI€ BaMU JaHHBIC 6bI.HI/I II0JIE3BHBIMU, BaM ﬂeﬁCTBHTeJ’[bHO Hy)KHO YTO-TO OnucaThb O
(yHKIMSIX, KOTOpBIE BBl OyJIeTe CO3aBaTh B JAHHOM HOBOM cJjioe. [[Jis1 HalmX TeKyIuX Ieliel Oyaer 1ocTa-
TOYHO JOOABUTH OJHO TT0JIe, KOTOpOe Ha3bIBaeTcs name , KoTopoe OyzeT cofgepxkath Text data u Oyner
OrPaHUYEHO JUTMHOW TeKCcTa B 80 CUMBOJIOB.

7. TloBTOpHTE HACTPOWKY HUKE, 3aTeM KJIMKHUTE KHOMKY J100aBuTh B ciucok nonen Add to Fields List:

New Field

Name | name
Type | ab<Text data -
Length 80 Precision

Add to Fields List

8. Yb6eautech, 4TO Ballle JUAIOrOBOE OKHO BBINISANT CJACAYIOLIMM 00pa3oM:
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G
File name aining-Data-2.0\exercise_data\school_property.shp
File encoding UTF-8 >
Geometry type ~ Polygon -
Additional dimensions ‘@' None Z (+ M values) M values
EPSG:4326 - WG5S B4 v ||

New Field

Name

Type | abc Text data v

Length |80 Precision

Add to Fields List

Fields List

MName Type Length Precision

id Integer 10

name String a0

Remowve Field

OK Cancel Help

9. Kmmkaute OK

JloJKeH TOSIBUTHCS HOBBIM CJIOM Ha Balueil nmanenu Layers.

5.1.2 \ Npem panbuie: UCTOYHUK OaHHbIX

Korza BBl co3/jaeTe HOBBIE JIJAaHHBIE, OUEBUIHO, YTO Peydb HIET 00 00bEKTaX, KOTOPhIE ASHCTBUTEBHO CYLIECTBYIOT
Ha 3emJie. Clie[oBaTeIbHO, BaM HYKHO OyJIeT OTKY/1a-TO MOJTy4YaTh HH(GOPMAIIHUIO.

Cy1mecTByeT MHOTO pasHbIX CIIOCOOOB IMOJTYy4YHTh AaHHBIE 00 oObekTax. Hampumep, Bb MosxeTe ucrosbzoBath GPS
IUIS1 ChEMKH TOUYEK B peaJIbHOM MHUpe, a 3aTeM UMIIOpTHPoBaTh JaHHble B QGIS. M BBl MOxeTe 00Cie10BaTh TOUKU
C TIOMOIIIBIO TEOZIOJIUTA ¥ BBECTH KOOPAMHATHI BPYYHYIO, YTOOBI CO3/1aTh HOBBIE (DYHKLMK. Vn BB MO3KeTe UCTIONb-
30BaTh Ipouecc OHHq)pOBKPI JJI1 OTCJIIC)KUBAHU A O6T:CKTOB IO JaHHBIM JUCTAHITMOHHOTO 30HIUPOBAHUA, TAKUM KaK
CITyTHUKOBBIE M300paXeHHsI WM a3p0(POTOCHEMKA.
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B Hamrem npumepe Bbl OygeTe UCII0JIb30BaTh MOAX oA oL poBKY. Bam npenocTasieHs! 00pa3ib HAG0POB PaCTPOBBIX
JaHHBIX, I03TOMY, ITPY HEOOXOIUMOCTH, BaM HYXHO OyJIeT UX UMIIOPTUPOBAT.

1. Knuknute Ha JJyucrieTdep HCTOUHMKOB JAHHBIX g Data Source Manager

Bribepure Pactp :'. Raster cnesa.
Ha nanenu Wcroynuk Source, KIMKHUTE KHOIIKY ...:
[epeiinute B (paiin ynpaxHeHuil exercise_data/raster/.

Bridepure daiin 3420C_2010_327_RGB_LATLNG.tif.

S

Kimknure Open , 4TOOBI 3aKPBITh JUAJIOTOBOE OKHO.

Source type
(® Fle () Protocol: HTTP(S), cloud, etc.

Source

- Delimited Text Raster Dataset(s) lercise_data\raster\3420C_2010_327_RGB_LATLNG.tf

‘& GeoPackage
;_—;l:

. Spatialite
. PostgreSQL
¢ MssaL
- Oracle
DB2. DB2
m Virtual Layer
tﬁl“_ WMS/WMTS
L5 wes
g WFS
ArcGIS Map Server
ArcGIS Feature Server

* GeoMNode

Close Add Help

7. Knukuure Add u Close. I3o0pakeHue 3arpy3urcs Ha Bally Kapry.
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@ *Untitled Project - QGIS - [} X
Project Edit View Layer Settings Plugins Vector Raster Database Web Mesh Help

NEBRR: (2L RIPRPALBLNR 66 -1-5-4 = -

LA AN AN i =y @ ® 2
Layers (E2]E3)

o @ ® T O -0
v ¥ 3420C 2010 327 RGB LATLNG
v! [ school_property

[ & Typetolocate (cul+k) | Ready Coordinate| 20.5018,34.0192 |% Scale 1:27241 |~ | @ Mognifier 100%  |*| Rotation [0.0° %/ [v/Render @ EPsGia3zs @

8. Eciu BbI He BUuTE a9pO(POTOCHUMOK, BLIOEPUTE HOBBIH CJIOM, KIIMKHUTE MTPABOI KHOMKOW MBIIIN U BHIOEpUTE
[pubnusuts 10 cnost Zoom to Layer. Layer B KOHTEKCTHOM MEHIO.
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() *Untitled Project - QGIS

Project Edit View Layer Settings Plugins Vector Raster Datab:

DEBRRY QPRI PR
B@V.Aam @ /7 :

Layers &
v [l ® T - O

3420C ?2n1n 227 par 1LATING |
sl '® Zoom to Layer

o2 Show in Overview

Copy Layer
Rename Layer
1 Zoom to Native Resolution (100%)
Stretch Using Current Extent
L] Duplicate Layer
[l Remove Layer...
Change Data Source...
Set Layer Scale Visibility...
Set CRS
Export
Styles

Properties...

9. KJMKHHTE Ha KHOTIKY }: ZoomIn npuoIMKanTe MaciTad 0 MECTHOCTH, BbIjICJIEHHOM CUHHIM [[BETOM HUKE:
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(@ *Untitled Project - QGIS - O x

Project Edit View Layer Settings Plugins Vector Raster Database Web Mesh Help

NEBRRE N@LRIPPRALBLNR e -K-6-5 &= 9[-
: | ® o

L LY AN
Layers (E2]E3)
o @ ® T O -0
v ¥ 3420C 2010 327 RGB LATLNG
v! [ school_property

[ & Typetolocate (cul+k) | Ready Coordinate| 20.4529,-34.0291 |¥ Scale 1:27241 |~ @ Magnifier 100%  |%| Rotation [0.0° *|v/Render @ epsGi36 @

Temneppb BbI TOTOBHI OLM(POBATH ITU TPH MOJS:
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IMpesxne yeM Bbl HauUHETe OLU(pPOBKY, JaBaiiTe epeJBUHEM clloll school_property Hal a3po(pOTOCHUMKOM.

1. Boibepure cioli school_property Ha maHemw Layers W TIepeTaluTe ero HaBepx.

Layers e
o [l ® T &§~3 F 4

v [ school property
v 2 3420C 2010 327 RGB LATLNG

YroOsl HayaTh onM(pPOBKY, BaM HYKHO BOWTH B PeXKMM peaakTupoBaHusi. [Iporpammuoe obecrieuenne GIS
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OOBIYHO TpeOyeT TOro, YTOOB NPEAOTBPATUTH CIyYaliHOE PeJaKTHPOBAaHUE WM yaJleHHe BaXHbIX JaHHbIX. Pexum
PEeAaKTUPOBaHUsI BKJIIOUAETCS WM BBIKJIOYAETCs MHAUBUAYAIBHO AJIS1 KOO0 CIIOA.

UtoOBl BOWTH B PeXXUM PeAKTUPOBAHUS IJIs1 CJost sSchool_property HEOOXOAUMO:

1.

KiukHyTh crioit school_property Ha naHenu Layers, 4ToObl BBIOPATD €r0.

&
¥ .y
2. KiMKHHTE HA KHOIIKY f/ Toggle Editing

Ecnm BBl He MOXeTe HalTH 3Ty KHOIKY, yOeIuTech, 4To MaHesib MHCTpyMeHToB OrmdpoBka Digitizing BKITO-
yeHa. Psisiom ¢ nyHkToM MeHIo View » Toolbars » Digitizing Digitizing [oJikeH ObITh YCTaHOBJIEH (hIIakKOK.

Kax TosbKO BBl BOIETE B PEXMM PeaKTUPOBAHUS, Bbl YBUIUTE, YTO HEKOTOPbIE HHCTPYMEHTBI OLIU(POBKU
CTaJIi AKTUBHBIMU:

Capture Polygon
¢ 3axBaTUTh NOJIUTOH  LJ ~2P e

* Uncrpyment Vertex / 7% Vertex Tool

prrI/IC COOTBETCTBYIOIIUE KHOIIKU MO-TIPEKHEMY HCAKTUBHBI, HO CTAHYT daKTUBHbIMU, KOI'’Ia Mbl HAYHEM B3a-
HMOHCﬁCTBOBaTL C HalllMMX HOBBIMHU JTaHHBIMU.

OGpaTrTe BHUMaHKE, YTO Y cJ1os1 school_property Ha naHenm Layers Tenepb eCTh 3HAUYOK KapaH/aia,
YKa3bIBAIOIIHIA, YTO OH HAXOAUTCS B PeXKUME peJaKTHPOBAHUS.

&2 Capture Pol o
KimkHute Ha KHOMKy £ “2PMe FOVEON yroBpr HauaTh OLUGPOBKY IIKOJIBHBIX TOJIEH.

Bbl 3aMeTHTe, YTO KypCop MbIIIY IIPEBpaTUICS B IepeKpecTye. DTo MO3BOJIAET OoJiee TOUHO pa3MelaTh TOu-
KM, KOTOpBIE BBl OyneTe ol poBbiBath. [IoMHUTE, YTO JaXke KOT/Ia BbI UCIIONB3YeTe MHCTPYMEHT OLIM(PPOBKH,
BBl MOJKETe MPUOIIMKATD M OTIAJISTH BAIly KapTy, IPOKPYYMBasi KOJIECUKO MBIIIH, ¥ Bbl MOXETe IepeMelaThb-
csl, yAepXK1Basi KOJIECHKO MBI U TIEPEeTacKuBasi Kapry.

HepBoe, YTO BaM HYXXHO OI_II/I(I)pOBaTL - 9TO CIOPTUBHAA IJIOIIAgKa:

4. Haunwute onuppoBKy, KIMKHYB TOUKY rie-HUOYAb Ha Kpalo MOJIs.

5. Pa3smecture GoJblle TOUeK, KJIMKasl AAJbIIe 10 Kpalo, MoKa (pUrypa, KOTOpyio Bbl pUCyeTe, OJHOCTBIO He

TOKPOET IOJIE.
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Q *Untitled Project - QGIS a - .
Project Edit View Layer Settings Plugins Vector Raster Database Web Mesh Help
NEBRRE 02APLPHRPP QAL BLNR 66 K5 L5 -

BR@V:Z2Rm @ 4/ 8BR - b =G A R A
Layers
« il & T &~ i C

v! [ school property

v/ I 3420C_2010_327_RGB_LATLNG

| Q Type to locate (Ctri+K) | i 20.444140,-34.024140 | ¢[1:1308 <| @rfwowe |33 00° |2 VIRender @ epsGiaszs @

6. Tlocne pazmenieHus NOCIEAHEN TOYKH KJIMKHUTE MTPABOM KHOIMKOM MBIIIH, YTOObI 3aKOHYUTh PUCOBAHUE T10-
JIMTOHA. DTUM BHI 3aBepIINTE (DYHKIUIO ¥ YBUAUTE IUAJIOTOBOE OKHO Affributes.

7. BBCHI/ITG 3HAYCHHUA, KaK ITOKa3aHO HUXKE!

school_property - Feature Attributes

d 1 |
name | Athletics Field a |
OK | | Cancel |
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8. Kmmkaute OK. Bbl co3nanu HOBYIO (DyHKIHIO!

Q@ *Untitled Project - QGIS - O X

Project Edit View Layer Settings Plugins Vector Raster Database Web Mesh Help

EERRY 0APLPNPP R RBLNR @& -N-8-%8E -
RQV.Am B 2/B%x- 6o mqRqE - @ A

Layers
o e Ta-BAO

v [# school property
v! ¥ 3420C_2010_327_RGB_LATLNG

| Q. Type to locate (Ctri+K) | i) 20.447232,-34.023345 | ¥ ¢ 1:1308 v @rlwoe 3]s looe  [f| VIRender @ epsci43s @

9. Ha nanesnu Layers BoiGepute clioil school_property.

10. KnukHUTe MpaBoil KHONKO# Mbliu U BeiOepute Open Attribute Table B KOHTEKCTHOM MEHIO.
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() *Untitled Project - QGIS

Project Edit View Layer Settings Plugins Vector Ras

NEERREY U 2K
RSV Z @B 47

Layers e b
[l ® T § -3 & L
7 school prisa l

v % 3420C 2( + Zoom to Layer

Zoom to Selection
“2 Show in Overview
Show Feature Count
Copy Layer
Rename Layer
L Duplicate Layer
[4 Remove Layer...
8 Open Attribute Table
|;.i" |TDggIe Editing
; Current Edits
Filter...
Change Data Source...
Set Layer Scale Visibility...
Set CRS
Export
Styles

Properties...

B tabamie BB yBUIUTE TOJIBKO YTO JOOABIEHHYIO (DYHKLMIO. B pexrMe pefakTHpoBaHHs BB MOXeTe OOHOBHUTb
JaHHbIe aTpUOYTOB, JBAX/bl KIMKHYB SUEHKY, KOTOPYIO BBl XOTHTE OOHOBHUTb.
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id name
1 1| Athletics Field

T show Al Features _

B & s T ES D BREZE »

* || Update All || Update Selected

11. 3akpoiite Tabnuily aTpuOyTOB.

12. Kiuknaute kHOnKy COXpaHUTb U3MEHEHUS n Save Bdits q106p1 cOXpaHUTh HOBYIO (ByHKILIMIO, KOTOPYIO MbI

TOJIBKO 4YTO CO3JaJIn.

[TomMHUTE, YTO €CIIM BbI JAOMYCTHIIM OIHMOKY MpHU OLM(POBKE 0OBEKTA, BBl BCETIA MOKETE OTPEIAKTUPOBATH €€ MOoCie
TOrO, KaK 3aKOHYHUTE ee Co3/1aBarh. ECM Bbl OMIMOINCH, MPOJOIDKaiTe OlM(pPOBKY, OKA HE 3aKOHYUTE CO3/IaHUE

00beKTa, KaK yKazaHo Bbiie. [lasnee:

B
1. KymkHure kHorky / 76 Vertex Tool

2. HaBemute Kypcop MbIIIM Ha Vertex, KOTOPBIM Bbl XOTUTE MePEMECTUTD, M KJIMKHUTE Ha HETO JIEBOM KHOTIKON

MBIIIN.

3. TlepemecTHTe MBIIIb B IPABWIILHOE MECTO VerteX ¥ KIIMKHUTE JIEBOM KHOMKOM MBIIIH. DTO NEpeMeCTUT Vertex

B HOBOE€ MECTO.
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DTy Ke NpoLenypy MOXKHO HCHOJIb30BaTh IS MepeMElIeHus] IMHEHHOTO CerMeHTa, HO BaM HYXHO Oyner
HAaBECTH KypcOp MBIIIN HA CPEAHIO TOYKY JIMTHEHHOTO CErMEHTa.

IEcmu BBl XOTUTE OTMEHHUTHh U3MEHEHHE, BBl MOXKeETe KIMKHYTh Ha KHOIIKY b Undo ymy Ctr1+2.
4. He 3a0yabTe COXPAHUTh U3MEHEHUS, KJIMKHYB Ha L= Save Edits,

5. To3aBepuieHnyn peJakTHPOBaHMS KIMKHATE Ha [lepekmounTh peaak THpoBaHye y Toggle Editing qro6p1 BRIATI
U3 peKUMa PeaKTUPOBAHMSI.
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513 \ Monpo6ynte camu, oundpynTe NONUroHbI

Ouudpyiite caMy IKOJTY ¥ T0JIe BBepXy. Mcronb3yiTe JaHHOE N300pakeHue ISl OJICKA3KH:

HOMHI/ITe, YTO KaxXJgad HOBadA (1)yHKIII/I$[ JO0JI)KHA UMETb YHUKAJIbHOC 3HAYCHUE id!

IIpumeuanne: Korzma Bbl 3aKoHUMTE 00aBIATh (PYHKIUH K CIIOIO, HEe 3a0y/IbTe COXPAHUTh U3MEHEHHS], a 3aTeM
BBIITH U3 pekUMa peJakTUPOBaHHUS.

IIpumeuanne: Bpl MoXeTe CTHIM30BaTh 3aJIMBKY, KOHTYp W pa3MelleHWe Hagmuced W (popMaTHpOBaHHE
school_property HCHOIb3Ys IPUEMBI, U3yUYeHHbIE Ha O0Jlee paHHEM 3aHSATHH.
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514 / Mpem panblwe: Ucnonb3oBaHue Tabnuubl pepakropa Vertex
Ipyrum croco00M peflakTUpOBaHust (DYHKIMHU SIBASIETCS] BBOJ BPYYHYIO (haKTUUECKUX 3HAYEHUH KOOPAMHAT JIsl
KaXJOH BEpIIMHBI ¢ ToMoInsio Vertex Editor.

1. Ybenutech, 4TO Bbl HAXOAUTECH B PEKUME PEJAKTUPOBAHUS Ha cioe school_property.

>
2. Eciu oHa elue He aKTUBUPOBAHA, KIIMKHUTE KHOIKY / % Vertex Tool

3. Hagenure Kypcop MbIIIH Ha OHY U3 (DYHKLIMH TOJIMTOHOB, CO3JIAHHBIX Ha cJloe school_property U KJUK-
HHTE TPaByI0 KHOMKY. TakuMm oOpa3zom OyzieT BhIOpaHa (yHKIWS U OSABUTCS NaHesb Vertex Editor.

Wertex Editor (& )
X Y r

0 20.4456 -34.0226 |
oo s |
2204457 -34.0251

3204453 -34.0247

4 20.4450 -34.0250

5/ 20.4441 -34.0241

6 20.4456 -34.0226

IIpnmeuyanne: Dta Tabauia coAEpKUT KOOPAMHATHI BEPUIMH 3eMeHTa. OOpaTute BHUMaHKE, 4TO B 9TON
(byHKIIMM MMeeTCsT ceMb BEpILMH, HO TOJIBKO IIECTh BU3YaJIbHO MICHTH(UIIMPOBAHbI B OJIOTHE KapThl. [Ipn
GmmKaifIeM 0CMOTpe MOXXHO 3aMETHUTh, YTO cTpoku 0 ¥ 6 MMEIOT UACHTUYHbIe KoopauHaThl. OHU SIBJISIOTCS
HaYyaJIbHOM M KOHEYHOW BEPIIMHAMY FeOMETpUH (DYHKIIMH M HEOOXOIUMBI TSI CO3/IaHMSI 3aMKHYTON (DYHKIIMU
TIOJIUTOHA.

4. KnukHUTE U nepetamuTe paMKy HaJl BEPIIMHOKN WM HECKOJIBKMMU BEPIIMHAMU BHIOpPAaHHOH (DyHKIMH.
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)

BbiOpaHHBIe BepIIMHBI IOMEHSIOT LIBET Ha roi1y0oii, a B Tabuuue Vertex Editor GyayT BbleI€Hbl COOTBETCTBY-
IOIIMe CTPOKH, COfiepiKaliie KOOPAUHATHI BEPIIIHH.
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Q@ “basic_map - QGIS - O X
Project Edit View Layer Settings Plugins Vector Raster Database Web Mesh Help

DEBREH 08ALNI PPA BEESD
RQV. LMD H T EEY

Browser (=]
ST®HO
<+ Favorites =

» IV Spatial Bookmarks
’ Project Home
+ [a] Home
v OC\
+ @ GeoPackace
Layers (=]
o @l®To-#FTDL

roads

[#] school_property

¥ 3420C 2010 327 RGB LATLNG

[

Vertex Editor 3]
X ' r

0 20.4456 34,0226

1 20.4469 -34.0238

2 20,4457 -34.0251

-34.0247

-34.0250

-34.0241

| @ Type tolocate (Crrl+k) | valid: rdi| 20.447353,-34.025117 | ¢ 1:1521

d

5. YtoObl OOHOBUTH KOOPIMHATY, JBAX/Ibl KJIMKHUTE JIEBOH KHOIKOM MBIIIM Ha SYEHKY B TaOJuIEe, KOTOPYIO
TpeOyeTcsi OTPelaKTHPOBATh, M BBEAUTE OOHOBJIEHHOE 3HaYeHHe. B 9ToM nprmepe KOOpAMHATa X CTPOKH 4
oOHOBneHa U3 20 . 4450 Ha 20.4444.
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Vertex Editor )
X y r
0| 20.4456 -34.0226
1) 20,4469 -34.0238
2| 20,4457 -34.0251
3/ 20.4453 -34.0247
e |
5 20,444 -34.0241
6| 20.4456 -34.0226
Q Type to locate (Ctri+K) Validi rdii| 20.4441

6. Iocne BBOJa OOHOBIEHHOTO 3HAUEHNs KJIMKHUTE KiaaBuiny Enter, 4ToObl IpUMEHNUTh N3MEeHeHne. BepimHa
OyZeT nepeMelleHa B HOBOE PACIOJIOKEHUE B OKHE KapThl.

SF
Y/ . .
7. Korpma 3akoHunte pefiakTupoBanue Kimkaure  TosgleBditing “yrogrr prijitn w3 pexuma pesaktupoBaHus,
COXpaHHTE CBOW M3MEHEHNI.

5.1.5 \ Monpobynte camu: Ouncppynte NMHUN

MsI coGupaemcst olidpoBaTh JBa MapIIpyTa, KOTOphIE ellie He OTMEYUEeHbI Ha CJI0e JJOPOT: OIMH 3TO MyTh, APYIOW -
Tpek. Hatil mmyTh MpOXOAUT BOJIb I0KHOTO Kpasi mpuropojia PaiiitoHa, HAUMHASCh U 3aKAHYUBASICH OTMEUEHHBIMU
JOPOraMH:
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Ham TPEK HEMHOTI'O JaJIbIIC K 0Ty
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1. Ecm cnoit dopoeu eme He yka3zaH Ha Bamled Kapre, goOaBbTe cioil roads m3 ¢aitma GeoPackage
training—-data.gpkg, KOTOPBII BKIIIOYEH B MKy exercise_data Bamed yueOHOI 0a3bl JaHHBIX,
KOTOPYIO BbI 3arpy3uwin. [Ipourure raBy Hoem Oanviue: 3azpyoicaem eexmoprole dannble uz bazvl danmwlx
GeoPackage ninst MHCTPYKIH.

2. Cozpaiite HOBBI HaOop maHHbIX cTpoku Shapefile ESRI ¢ umeHem routes.shp B aupeKkTopuu
exercise_data,carpubyramu id ¥ type (MCIONB3YHTE MPUBEICHHBIN BHIIIE TOXOMI, YTOOB HAYIUTh-
cs).

3. AKTHBHpYHTE peXUM pPeIaKTHPOBAHUS HA CJIOE routes.

\'fa Add Line

4. TlockonbKy Bbl paboTaete ¢ (hyHKIMEH JIMHUH, KITMKHATE KHOTIKY IUs1 3aITyCKa pesknma ol poBKU

JIMHUU.

5. OuudpoBsIBaiiTe 10 OJHOMY IIyTh M TPEK Ha ciioe routes. CTapaiTech Kak MOKHO TOYHEE CJIeI0BAaTh MapIl-
pyTam, noGapJisisl JOMOJHUTEIBHBIE TOUKH BIOJb YIJIOB MM IOBOPOTOB.

6. 3apaiite 3HaYeHHe aTpuOyTa t ype id path wm track.

7. Vcnone3yiite qUanoroBoe okHO Layer Properties 94to0Obl 100ABUTH CTWIIb K MapiipytaM. He crecHsiiTech uc-
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IOJIb30BAaTh PA3JIMYHBIE CTUIIN IJIA HyTefI 1 TPEKOB.

8. CoxpaHuTe M3MEHEHHs 1 OTKIIIOUNTE PEKUM PeJaKTUPOBaHHsl, HakaB KHorky # Tosele Editing

[Iposepome ceou pe3yavmamol

5.1.6 B 3aknouyeHun

Teneps BbI 3HaeTe, Kak co3aBaTh (PYHKIMU. DTOT Kypc HE OXBAThIBAET J0O0ABJIEHNE TOYEUHBIX (DYHKIIMH, TOTOMY
YTO 3TO HE TaK Yy’ HEOOXOAMMO, KOT/a Bbl paboTaeTte ¢ Gosiee CJIOKHBIMM (DYHKIMAMY (JINHUM M TIOJIUTOHBI). 311eCh
BCe pabOTaeT TOYHO TaK ke, 38 UCKIIOYEHUEM TOTO, UTO BBl HA)KMMAaeTe TOJIBKO OJHMH pas3, Ha TO MECTO IZie Bbl XOTHTE,
YTOOBI Ballla TOYKA PacIoliaraiach, NpUIanTe ed aTpuOyThl, Kak OOBIYHO, U TAKUM 00pa3oM (hpyHKIIMS CO3[IaHa.

3HaHue TOro Kak ol poBHBATh BAXKHO MOTOMY, YTO 9TO OUEHb paclpocTpaHeHHoe JefcTBue B rporpammax GIS.

5.1.7 Yto panbLie?

Pynkimu Ha cioe GIS — 370 He TOJIbKO KapTHHKH, HO OOBEKTHI, PAcHoJIOKEeHHBIE B TpocTpaHcTBe. Harpumep, cMex-
HbIE TIOJIMTOHBI 3HAIOT I7Ie OHU HAXOASITCSI OTHOCUTENBHO JAPYT Apyra. DTo Ha3bBaeTcs Tonosornei. Ha cienyromem
3aHSTUH Bbl yBUUTE IIPUMEP TOTO, IOYEMY 3TO MOXKET ObITh MOJIE3HO.

5.2 3aHsaTue: Tononormsa oyHKLUN

Tomosorust sABISIETCS TOJE3HBIM aCIIEKTOM CJIOEB BEKTOPHBIX JJAHHBIX, TOCKOJIbKY MUHUMU3UPYET OMIMOKHU, TaKUe
KaK HepeKphITHE MU MTPOOEJIBL.

Hanpumep, eciu iBe (PyHKIMHM UMEIOT OOIIIYIO IPaHHULLY, ¥ BBl peIAKTUpyeTe IPAaHHILLy C IOMOIIBIO TOIIOJIOTHH, TO BaM
He HYXHO OyJIeT pelakTHpOBaTh CHavasa oJHY (PYHKLIHIO, a 3aTeM JPYTYIO U TIIATEIbHO BHICTPAUBATh IPAHHUIIbI TAK,
YTOOBI OHM COBITaJa M. BMECTO 3TOr0 MOXHO peJakKTHPOBATh UX OOLILYIO I'PaHHUILY, M 00 (PYHKIMK Oy 1y T U3MEHSThCS
OJHOBPEMEHHO.

I_IeJIb JAAQHHOTO 3aHATHA: TIOHATH TOIIOJIOTHIO C TIOMOIIBIO ITPUMEPOB.

5.2.1 / Unem panbuie: NMpuesaska
[TpuBsi3Kka ynpoIaeT TonoJIOrMIeckoe pelakTUPOBaHUE. DTO MO3BOJUT KYPCOPY MBIIIU MPUBS3BIBATHCS K IPYTUM
oObeKTaM BO BpeMst olupoBKU. UTOOBI 331aTh OIMIVMY IPUBSI3KHY, BHIIOJTHUTE CJIEAYIONIHIE ICHCTBHUS.

1. Ilepeiinute k MeHI0 Project » Snapping Options....

2. Hacrpoiite auanoroBoe OKHO Snapping options, 4ToObl aKTMBUPOBATh CJIOW 1anduse ¢ MOMOIIBIO 8ePUUUHb
Type vertex v AOTIYCK B 12 MUKCeNEN:
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Projeck Snapping Settings x

«) | ‘& Advanced Configuration | v Topological Editing Snapping on Intersection

Layer Type Tolerance Units Avoid overlap

® places
[ buildings
— roads
I water
rivers
v landuse vertex 12 pixels v
[l protected_areas

Q, Filter layers...

3. Y6eautech uTo moJie B KOJIOHKe Avoid overlap poBepeHo.

4. BpliguTe U3 OKHA JUAaJIOra.

5. BeibGepure cinoii landuse v BBeute pexum ( é’ )
6. IIposepste (B View » Toolbars) ato Advanced Digitizing THCTPYMEHT aKTUBHPOBAH.

7. 3yMupoBaHUe 3TOW MECTHOCTH (BKJIIOYANTE CJIOW U HAJIMUCU MPH HEOOXOAUMOCTH):

*example - QGIS <

Project Edit View Layer Settings Plugins Vector Raster Database Web Mesh Progessing Help

DEERRY OAPLHPRFALEEDR

AR T RE RERRR 572 B G PR K-
ee o REE¥EI=I0 LB BOIRBANCS FRE” - - @
Layers @@
Q@ vawva-ann
v| ® places =
V; ! [ buildings
v/ — roads
'ﬂ v| [ water
v rivers
?’ landuse |G
e ¢ »
% Browser @®
-~ LRETHO
» Favorites

'ﬂv » " spatial Bookmarks
[*¥ Project Home

»
@' b [ Home

& gl

n @ GeoPackage

Q@ ~ | v /# spatiaLite
@ Postals

V; | P MssqQL

o @ pB2

%]

v v v

@ WMS/WMTS

@ XYZ Tiles

@ wcs

) WFS / OGC API - Features

) ows
@ ArcGisMapServer
& ArcGisFeatureServer

¢ GeoNode

v v wwow

Q Type to locate (Ctrl+K) Coordinate| 20.48982,34.00907 % Scale|1:14392 ~ | @ Magnifier| 100% | Rotation |0,0° < ¥ Render # EPSG:4326 Q

8. Ouudpyiite HOBYIO (BBIMBIIUIEHHYI0) MECTHOCTb:
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Project Edit View Layer Settings Plugins Vector Raster Database Web Mesh Processing Help

NoERRE V@2 NP R RENRS
FAVAEL B SQ NS (EBRED G- B-R PRE[FX K-
0 B3 LEH#IsT LB ITOARNTAINCS HFE2L2” - @
Layers
@ vawmva-aan
v/ ® places
V; ! [ buildings
v| = roads
'ﬂ v| [ water
v rivers
& landuse |G
% It
/% Browser
navte
Y
» Favorites
'uv » " spatial Bookmarks
» [¥ Project Home
@' b [ Home
» [0/
% » @ GeoPackage landuse - Feature Attributes
G,Qv » /# SpatiaLite Actions
+ @ postais -
| » MssqQL ) =
;:. @DBZQ ogc_fid [999\ a|v
S8 | @ wMs/WMTS Full_id NULL
b @ XYZTiles )
» & wes osm_id NULL

» @ WFS / OGC API - Features
» O ows

@ ArcGismapServer

& ArcGisFeatureServer

¢ GeoNode

QA Type to locate (Ctrl+K)

Coordinate| 20.49231-34.00731 |9 Scale| 1:14392 ~ | @ Magnifier| 100% = | Rotation |0,0° | |v/ Render # EPsG4326 @

9. B otBer Ha 3anpoc, npucsoiite emy OGC_FID 999, HO MOXeTe OCTaBUTh OCTaJIbHbIE 3HAYEHHS Oe3 N3MeHe-

HUH.

Ecim npu onuippoBke co601aTh OCTOPOKHOCTh U pa3pelinTh MPUBA3KY Kypcopa K BEpIIMHAM CMEXHBIX
MECTHOCTEH, TO BBl 3aMETHUTE, YTO Meky HOBOH MECTHOCTBIO M CYLIECTBYIOIMMU CMEXHBIMA MECTHOCTAMU
He OyJeT HUKAaKHX IIPOMEXYTKOB.

10. OGparute BHUMaHHE HAa MHCTPYMEHTHI !3 undo py (ED redo 5 Advanced Digitizing na TlaHeJ i HHCTPYMEHTOB.

5.2.2 / NUnem panbue: NpaBunbHble TOoNonorndeckue MyHKLUN

WHorna Moxet notpeboBaThcsi OOHOBIIeHHe (PyHKIMI Tonoyiorn. Ha Hamem yyactke paGoThl, 3Ta MECTHOCTb Obla
npeBpalleHa B Jiec, II09TOMY CJIOM 3eMJIENIONB30BaHUs 1anduse Hyxkaaercs B oOHOBJIeHHH. [ToaToMy MBI Gynem
PacIMPSATh U IPUCOEAUHATh HEKOTOPbIE JIECHBIE (DYHKIIMM HA 9TOH MECTHOCTH:

142

aea 5. Module: Moaynb: Co3naHne BEKTOPHbIX AaHHbIX



QGIS Training Manual

*example - QGIS

Project Edit View Layer Settings Plugins Vector Raster Database Web Mesh Processing Help

DEERRY OAPLHPRFALEEDR

AV o = Qe g RRY Q- B-Gr [PRE

Q8- -N-8-LEE¥IsT LB BOARBARPS  F2 P
Layers @@

@ vamva-aan

v| ® places =

! [ buildings

v| — roads

v| [ water
v rivers

Fd landuse IS

1 »
Browser @®
LET®O

» Favorites

» " spatial Bookmarks
» [¥ Project Home

» [&] Home

» [0/
»
»
13

-

4

@ GeoPackage
# spatiaLite
@ Postals

4

a @'@@u‘ﬂn\o":‘:ﬁ:’cﬁ

4
v
=
n
)
o
2

i
a
o
B

&

@ WMS/WMTS
@ XYZ Tiles
& wes

7 WFS / OGC API - Features
) ows

@ ArcGismapServer

& ArcGisFeatureServer

¢ GeoNode

v vy wvow

| @ Type to locate (Ctrl+k) Coordinate| 20.48982-34.00907 |9 Scale|1:14392 = | @ Magnifier 100% | Rotation |0,0° %[V Render 4 gPsGi4326 @

Bwmecto CO3aH1 A HOBBIX IOJIMTOHOB JIA IPUCOCANHEHUS K JICCHBIM YYdCTKAM MbI 6yH€M HCIIOJIb30BaTh I/IHcmpy -
Mmernm Vertex JUIA pEOJAKTUPOBAHUA U IIPUCOCANHEHN A CYIIECTBYIOINX ITOJIMTOHOB.

1. Tlepexon B pekuM peAaKTHPOBAHU (€CJIH OH elle He aKTUBEH).

2. BoiGepure nHcTpyMent / 7% Vertex Tool

3. BriGepure y4yacTok jieca, BRIOEpHTe BEPIIMHY 1 IEPEMECTUTE €€ Ha CMEXHYIO BEPIIHY, YTOOBI ABe (DyHKINH
Jleca COBMECTUIIHCH:
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*example - QGIS

Project Edit View Layer Settings Plugins Vector Raster Database Web Mesh Processing Help

DEERRY OAPLHPRFALEEDR

LAVAL B 13 00 “Q R LY 6-Q - B-G @]V
06 -5-LEE%Z =l
Layers @R ~rh
@ vawva-zaL L _
v ® pla e . :
Vé v [ :ulf:l:gs b
v| — road:
'ﬂ v.:::esr
v rivers
?’ landuse |
L v
Browser @® |
4 nevte ;

\V /
l’*‘ » ¢ Favorites f
'u « | » [ spatial Bookmarks |
» [® Project Home [

» |zl Home S
€ | o ‘
»
»
]

(]

@ GeoPackage
# spatiaLite
@ Postals

& b @ WMS/WMTS — N\ |
» B XYZ Tiles
r B wcs
71 WFS / OGC API - Features I
» ) OWS
@ ArcGismapServer
& ArcGisFeatureServer
¢ GeoNode

| @ Type to locate (Ctrl+k)

4. KnukHUTe Ha Apyryie BEpPIINHBI U MIPUBSIKUTE UX K MECTY.

Tononoruyecky MmpaBuibHasi TPAHULA BBIIJISUT CIIEIYIOIIIM 00pa3oM:

*example - QGIS

Project Edit View Layer Settings Plugins Vector Raster Database Web Mesh Progessing Help

NEERES U2 PP QL@ IR
VAL B o @Y REFGFRFPF QR B-@ [SRm[FIX X~
Q- N5 LEAREI=(]T LR BOARBARPS FRR

Layers @69 \
RO TE~-BAOL | '
v/ e places sl

v; v| [ buildings
' v| — roads

] ! [l water
Eg v rivers

P4 landuse 15

2% s g
f Browser @R

[+] .

erv®e

» 57 Favorites
'ﬂ + | » [ spatial Bookmarks

» [® Project Home

@ ¥ | » [& Home |

@ el
» @ GeoPackage
@v » / Spatialite
» @ postGis
VS | P mssqQL
@ pB2
K@ @ wMS/WMTS F—
» @B XYZ Tiles
» @& wes
» & WFS [ OGC API - Features
» O ows
& ArcGisMapServer
Q;':' ArcGisFeatureServer
¢ GeoNode

/ A \

\ A A i

/ y ‘ /
Q Type to locate (Ctrl+K) | Validati Coordinate| 20.52152,34.01776 | ¥ Scale| 1:6588 ~ | @ Magnifier| 100% 2| Rotation |0,0° % |V Render @ EPSCa32e @
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[IponoskaiTe M MPUCOSTUHUTE elrle HECKOJIbKO MECTHOCTEH ¢ moMotpio Hrcmpymenma Vertex.

&
MozxeTe UCHIONB30BATh MHCTPYMeHT L. Add Polygon Feawre npg 1oro qro6hI 3am0MHUTS MPOGE MEKTY ABYMS
HIOJIMTOHAMH «Jiec». Ecnu BKmoveH napametp Hzbexcamov nepekpvimusi, He Hy)KHO JOOABIATh KakKIy0 Bep-
IIVHY - OHM OyAYyT H0OABJIATHCS aBTOMATUYECKH, €CIIM BAlll HOBBII MTOJIUTOH NIEPEKPBIBAET CYIIECTBYIOLINE.

Ecnu Bb HMCIIOJIL3YETE HAlll MPUMEDP JaHHLIX, TO Balll JIECHOM Y4aCTOK JOJIKEH BBIIVIAACTD IPUMEPHO TaK:

*example - QGIS B

Project Edit View Layer Settings Plugins Vector Raster Database Web Mesh Progessing Help

0 ¥ OURARLHAPPR I AARBELIER

J e RE g E Q)% &[] X X~
@ @-[HS-0.EE ¥ X -0 - @
s )
o @ % T e~ FL
Vi | ) M butiings ]
e | o
?’ T —
A= -
m O2THO

3 Favorites
- | » [" spatial Bookmarks
» [® Project Home
b @ Home
y [/
» @ GeoPackage
» / Spatialite
» @ PostGis
| P MssqQL
o @ pB2
» B WMS/WMTS
» @ XYZ Tiles
» & WS
» &% WFS / OGC API - Features
»

) ows

& ArcGisMapServer
@ ArcGisFeatureServer
¢ GeoNode

Q Type to locate (Ctrl+K) Coordinate| 20.48916-34.00526 |9 Scale| 1:14392 ~ | @ Magnifier| 100%

~| Rotation |0,0° | |v/ Render # EPsG4326 @

He BOJ'[HyfITCCL, €CJIM Bbl TPUCOECNUHUIIUCH K 6OJII)HleMy, MCEHbIIEMY WJIA Pa3HbIM Y4aCTKaM Jieca.

5.2.3 / Npem panbue: UHCTpyMeHT: YnipolwieHne oyHKLUN

TIpoomkaeM Ha TOM 3Ke ClIoe, TIPOTECTUPYEM MHCTPYMEHT YTIpoluenue (hyHKIIH %) Simplify Feature,
1. KimkHMTE Ha HETO U aKTUBUPYMTE.

2. KimkHHTE Ha OUH U3 Y4aCTKOB, KOTOPBII BbI YK€ IPUCOEANHUIIN WX ¢ oMOUIbI0 HHempymenma Vertex uiau
nHcTpyMeHTa Add Feature, Bbl yBUIUTE 3TO IUATIOTOBOE OKHO:
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|J¢§ancel|l «/ OK ]

- |

Method | simplify by distance

Tolerance ’ oloooo00
1 feature(s): 17 to 17 vertices (100%)

:] Layer units

3. Usmennre Tolerance v BBl YBUOUTE YTO MPOU3BOMICT:

|X§ancel|[ «/ OK ]

- |

Method | Simplify by distance

A
“ | Tolerance ’

1 feature(s): 17 to 5 vertices (29%)

|:] | Layer units

STO MO3BOJIIET YMEHLIINTb YUCJIO BEPIINH.

4. Kmukaute OK
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The advantage of this tool is that it provides you with a simple and intuitive interface for generalization. But notice
that the tool ruins topology. The simplified polygon no longer shares boundaries with its adjacent polygons, as it
should. So this tool is better suited for stand-alone features.

HpC)KHC YEM MPOAOJIKUTH, BEPHUTE MMOJIMT'OH B UCXOAHOE COCTOSTHUE, OTMEHUB IMOCJICAHECEC NU3MCHEHUE.

5.2.4 / Monpobynte camm UHCTpyMeHT: [Lo6aBUTb KONbLO

WHcrpyment AddRing no3pongeT 106aBUTH BHYTPEHHEE KOMBLO K (DyHKIMH MOJTMIOHA (BHIPE3aTh OTBEPCTUE B
TIOJIUTOHE), €CJIM OTBEPCTHE MOJTHOCTHIO HAXOAMTCSI BHYTPH MOJIMIOHa (eciu ecTh KacaHue rpanunsl, 31o OK). Ha-
TIpUMeED, eCJM BBl Ol pOBaIM BHENTHIE IpaHuLbl FOxxHOM ADPUKH 1 BaM HyKHO J0OaBUTh OTBepcTHe Aj1s JlecoTo,
BbI OBl NCIIOJIb30BAIM 3TO UHCTPYMEHT.

HpI/I IKCHEPUMEHTE C UHCTPYMEHTOM Bbl MOXKETE 3aMETUTD, YTO OIIWU IPUBA3KU MOTYT MOMENIATh CO3JaHUI0 KOJIb-

i@ BHYTpU NOJIMT'OHA. HOSTOMy PEKOMEHAYETCA OTKIIOUNTD NIPUBA3KY IEPEI BBIPDE3AHUEM OTBEPCTHUA.

1. OTKIIOYNTH TPUBSA3KY I c10s1 Landuse C IOMOIIBI0 KHOIIKU @ Enable Snapping (1111 ycrionb3yiiTe ApIbIKY
s).
2. Ucnomnb3yiite HHCTPYMEHT AddRINg 119 cO3aHMSA OTBEPCTHSA C CepeIMHE FeOMETPUH MOJUIOHA.

3. Hapucy¥iTe HOJIMIOH Ha/JI LIeJIeBOi (DYHKIIMEH, KaK eCJiv Obl BbI MCTIOJIb30BAI MHCTPYMEHT JJ0OaBUTh MOJIMIOH

Add polygon

4, Korna Bbl HAXKMETEC HpaBbIﬁ KJIMK, OTBEPCTUE CTAHET BUJUMBIM.

5. VYpamute TOJBKO YTO CO3JaHHOE OTBEPCTHE C IOMOIIBIO KHOIIKA £ Delete Ring

IIpnmeuyanne: KivkHUTE BHYTPU OTBEPCTUS, YTOOBI YIATIUTD €T0.

IIposepome ceéou pesyrvmamel

5.25 / Monpobynte camm UHcTpyMeHT: [L06aBUTb YacTb

WHCcTpyMeHT 8: Add Part o3posiser 106aBUTH HOBYIO YACTHIETANb K (DYHKIMH, KOTOpas He CBA3aHa HANpAMYIO ¢
ocHOBHOH (pyHKIHEH. Hamprvep, ecii BB onmdpoBav TpaHUIIbl MaTeprkoBoi dactu IOxHON Adpuku, HO erme
He o6aBuiM octpoBa I[IpuHia Dayapaa, Bl Obl UCIIOIB30BAIM STOT HHCTPYMEHT [JISl UX CO3IAHUS.

1. BriGepurTe MOJIUIOH, K KOTOPOMY TpeOyeTcst JoOaBUTh AETallb, C IOMOIIBIO MHCTpYMeHTa Bribepure hyHKIMIO

panmnamy

10 MECTHOCTH HJTH OTHAM KJIHKOM "7_;3 Select Features by area or single chck.

2. HWcnone3yiite uncTpymeHT Add Part 1uisi noOGaBlIeHs BHELITHeH 00J1acTH.

3. Viamre TOIbKO YTO CO3AHHYI0 YaCTh C IOMOILIBIO HHCTpyMeHTa £ b Delete Part,

IIpnvmeuyanne: KivkHUTE BHYTpU JETajd, YTOOB! YIAJIHUTD €€.

Hpoaepbme ceou pesyromaniol
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5.2.6 / WUnem panbue: UHCTpyMeHT: U3aMeHUTb chopMmy DYHKLMU

Uucrpyment 6 Reshape Features yenonp3yerca s paciumpeHns (byHKIMM MOJIMIOHA MIM BBIPE3AHHS €r0 YacTu

(B1OJIb TPAHULIbI).
Pacmmpenue:

-1
1. BriOepuTe MOJIUTOH C IOMOIIBI0 HHCTPYMEHTA l::[h?: Select Features by area or single click |

2. KimkHHTE JIeBOM KHOIKOM MBIIIY BHYTPH ITOJIMTOHA, YTOOBI HAYaTh PHCOBAHHME.

3. Hapucyiite hopmy BHe nosuroHa. ITocsieqHsis BepIHA JOJKHA OBITh CHOBA BHYTPH TIOJIUTOHA.

4. KiukHUTE MpaBoil KHOMKOW MBIIIH 7S 3aBepIleHUs (PUTypBI:

ufour - basic_map.

]
o
(]

QGIs 2.0.

DeBEEBLRR O PHRPLRAMRS & & B p e BE =0 50 /o B %
A MB B R A<D = E6%8%%%
PRI RRRARRRBOR® L

00 Layers b
Vé » ™ - places 2

» ™ O buildings *2 & “
'u » & ' roads o L0

> @ O water = ¥ y
® & " routes % N
4 1 .
B, @ e > s P
@2 ¥ school_property
=] 14" 3420C_2010 327 RGB_LATLNG
@ <
% %
v Eontelet e Pats Gves €t

v . PN
3 x N\
N
x
v
7 P tone) P Recapen & Shep
)
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Validation finished. There is a new plugin available || Coordinate: 20.4945,-34.0787

) [&/] @ Render EPSG:4326 (] y

10 AacCT pe3yJibTar, AHAJIOTMYHBIN HUKECIEAYIOUIEMY
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0006 QGIS 2.0.1-Dufour - basic_map

DBELR O LLOHPLLALR & & W GEBE =D 32 1 BW
PIUB RR &L B EE %5 % w9

CROBRRB@OR® L C

00 Layors 3

» &  places

» @ C buildings

» &\ roads

» & 0 water

v &V routes

> & V rvers 4 s

» (4 (- school_property

) 14" 3420C_2010_327_RGB_LATLNG

NG ABDBINARS ¢

S o R G

=N Browser

Validation finished.

There is a new plugin available Coordinate: 20.4430,34.0604 Scale [1:19951 |+ [&/] @ Render EPSG:4326 @]

Buielegeaar

BeipexbTe yacTh:

.
1. BoiGepuTe MOJUIOH ¢ TIOMOIIbI0 HHCTPYMEHTA Eij?a Select Features by area or single click

2. KimkHMTE 32 mpeiesiaMy TOJIUTOHA.

3. Hapucyiite purypy BHyTpH mosurona. [locieaHsist BepiirHa JOKHA OBITh BO3BpAIIIEHA 32 TPEIEIThI MOJTATO-

Ha.
4. KimKHUTE MPaBOi KHOIKOW MBIIIH BHE MOJIMTOHA:
) TR R
DBRLDR 0SS PpL o HPOLRLAR & @ e BE =0 3o 1 BN
AT EEEY RN 2IBDS
PRI RRRRBOR® L C
o6 Layers
» & . places
B
b [
2
B, g e
@ » @  school_property
% [ 14" 3420C_2010_327_RGB_LATLNG
@
%
Ve
o g
Lo
Validation finished. There is a new olugin available [Q5] Coordinate: Sosle (19957 1) [5Y] & Render EPSGi4326 [@)] |
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Pe3ysbTaT TOro, 4to ObLIO BIIIE:

QGIS 2.0.1-Dufour - basic_map.

| BRERODR 0 P2L o H0PPLLKALRE & @ Ny & B E = B Ty B W
PIAB R B & ke “Ff %% %3 |
S RIBRAUBROR® L
006 Layers
N / : J
> ings = & “
© v &  routes % %
VA £ J
. e * ' -
o —
@ i
% .
Viv e .
3 N ° Buisrgeier
Ld ¥ N
AN
¢ ettt et s Resep i O i

X

bt

§ /

/ 3/\_/_\\\ e

J
X 7 (
—=J

Validation finished. There is a new plugin available Q5| Coordinate: 20.4733,34.0967 Scale (1110957 [+ [§Y] & Render EPSG4326 (]
5.2.7 / Monpobynte camm UHCTpyMeHT: Paszpenntb PyHKLMN

do_ . GD
Uncrpyment g SPHtFeaures ayanorpyen nactpymenty U Reshape Featres yhove onHoro, Toro uto o He yaanser Hu
OIHOM U3 IBYX 4acTedl. VI Ha000poT, coxpaHseT ode.

MBsI OyeM UCIIOJIB30BaTh MHCTPYMEHT,

1. Cunauana BbiGepuTe ciort landu

BriGepute HHCTPYMEHT

Gag Split Features

YTOOBI OTACJIUTDH YIroJI OT IOJIUTOHA.

S€& U MOBTOPHO BKJIIIOYUTE 1A HETO MMPUBA3KY.

1 KJIIMKHUTE HAa BEPHIMHY JIS TOTO, YTOOBI HAYATh pUCOBATH JIMHUIO.

Hapucyiite orpaHU4IMBaIOLIyIO JIMHUIO.

Kiuknure BEPUIMHY Ha <<Hp0THBOHOJ'IO>KHOﬁ>> CTOPOHC IOJIUT'OHA, KOTOprfI BbI XOTUTE Pa3/iC/INTh, U KIIMKHUTE

npaBoﬁ KHOITIKOI MBIIIIH IUIA 3aBEpHICHUS JIMHUN:
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oY) QGIS 2.0.1-Dufour - basic_map
DEBRBOR IS ALARNPLALR & 6 e BE = 52 O, BY
PUB R & e DS E YRR
P RIVBUVRRPORB® L C
00 Layers < e % R
» & - places 3 . X
w g = buldings Pt
» & V" roads % ARX
@ e XX x g X
v & V" routes ) ‘ i K by X)}({"
= R - VI P
» ST R
» & rvers T X% k3
@ @ school_property e x
X
a [ 14" 3420C_2010_327_RGB_LATLNG . - Ki
%
X
) ettt et s s €t A
% 5 ) N .
X Xx < R
03 P
‘,( X ottt ettt e Reoepen & Shep X
x
) %
X ) * . @R R x
¥ ) ‘ X
% 7 x
Sox > x X
so0c % . x
X x x
XX e A < |
x
Browser
Validation finished. Thereis anew plugin available Q5| Coordinate: [ 204318340737 | Scale [1:19950 - |&/] ¥ Render EPSG:4326 )] y

5. Ha jaHHBIA MOMEHT MOXET MOKa3aThcsl, YTO HUUETO He rpousonuio. Ho momauTe, uto ciioil 1anduse BU3Yy-
anusupyetcs 0e3 JIMHUIA IPaHuIbl, TO3TOMY HOBasl JIMHUS pasfie/ieHUs] He OyeT MoKa3aHa.

6. Hcnonb3yiiTe MHCTPYMEHT -
JIeTallb; Terlepb HOBBII 3JIEMEHT OYIeT BbIIENICH:

]
«]

QGIS 2.0.1-Dufour - basic_map

;
Ei*u Select Features by area or single click yro Gy ppi1eMTh TOTBKO UTO pas/ieleHHYIO YacTh-

P

BELOR OB LLslPLLRAAR & ¢S e B & 0 5 = /7, BR
’vu%%fx.g*ﬁ B8 E %28 % %%
PRV RBARSPAR® L C
o6 Layers a
W paens
[ i ™ buildings
» & ' roads
> & O water
." v @ \/ routes I\ ‘
X
- N\
)1 IR
@ » (¥ (9 school_property
@ ) o sm0c 2010 027 RaB LATLNG
@
ottt taned P Beo @eto
% %
i "
Vax XS xR
Ld X X * e
L WA Ko XK x
e, X Xy x
O o Sentefels emoed Pers Reseplen @ Shap.
X
%
%
x X
K N St R e i
o x %
i o
% x y
o0 K X < *
A x
X
= Broweer |
1 feature(s) selected on layer landuse. Thereis a new plugin available Q] Coordinate: | 204487,340607 | Scale [1:19950  |-) [&/| (¥ Render EPSG:4326 ()] y
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5.2.8 e [lonpo6ynte camu: UHCTPYMEHT: Cnutb PyHKLUM

TCHCp]; MbI CHOBA IIPUCOEJUHNM DJICMEHT, KOTOpHﬁ BbI TOJIBKO YTO pa3/iejiniiv, K OCTABILIEHCS YaCTH MOJIUTOHA:

1. HOSKCHepI/IMeHTI/IpyﬁTe C UHCTPYMEHTaMH @Merge Selected Features U= Merge Attributes of Selected Features'
2. OTMeTbTE pa3HHULLY.

[Iposepvme ceou pesynvmamol

5.2.9 B 3aknouyeHvun

PeHaKTI/IPOBaHI/Ie TOIIOJIOTHH - 9TO MOIIIH])Iﬁ HWHCTPYMCHT, KOTOpLIfI IIO3BOJIACT 6I)ICTpO " JICTKO CO3JaBaTb U U3ME-
HATH 06’bCKTBI, obecrieunBas IpH 3TOM UX TOHOJIOTUYCCKYI0 KOPPEKTHOCTbD.

5.2.10 YT1o panbwe?

Teneps Bbl 3HaeTe, Kak Jierko onugpoBath GopMy 0ObEKTOB, HO J00aBUTH aTPHOYT - TO MOKa ele 3amopouka! [a-
Jiee MBI IOKaKeM, KaK MCIIOIb30BaTh (hopMbl, [Iejiast peJaKTUpOBaHue aTpuOyToB 6oJiee MPOCTHIM U 3((EKTUBHBIM.

5.3 3aHatue: Dopmbli

[pu 106aBIEHNM HOBBIX JAHHBIX C TMIOMOIIBIO OIU(PPOBKH TOSBISETCS JUANOTOBOE OKHO, MO3BOJISIOIIEE 3aIlo-
HHTb aTpUOYTHI 1JIs1 9T0M (pyHKIMA. OJHAKO STOT JUAIOTOBOE OKHO M0 YMOJIYAHUIO BHIIJISAUT HE OYEHb ITPUSATHO.
3TO0 MOXET BbI3BaTh MPOOIEMY 1JIs1 yJ00CTBA UCIIOJIb30BAHUS, OCOOEHHO €CJIM BaM HaJ|0 CO31aTh OOJIbIIMe HabOpbI
JaHHBbIX WU €CJIN Bbl XOTUTE, ‘{TO6I)I ﬂpyrne JIIOIW ITOMOraJii BaM OI_[I/lCl)pOBbIBaTb, a OHU CYUTAIOT, YTO q)Oprl 10
YMOJITYAHUIO 3aITyTaHBI.

K C4HacCThIO, QGIS IIO3BOJIACT CO3/1aBaTh COOCTBEHHbBIE JUAJIOIOBBIC OKHA JIA CJIOA. Ha sTom 3aHsTHM MOKa3bIBaETCS
Kak 3TO CIOcjaTh.

Ieaw 3TOrO0 3aHATHA: CO3/1aTh (DOPMY IS CIIOSL.

5.3.1 \ MUnem panblie: Ucnonb3yem MyHKLUOHaNbHOCTL Au3sanHa dop-
mbl QGIS

1. Bwibepure cnoit roads Ha nanenu Layers.
. Tlepexomute B pedtcum pedaxmuposanusi, Kak U paHee.

. Orkpoiite TabnuIbl aTPUOYTOB CJI0s1 roads J0por.

A~ W

. KiimkHuTe npaBoii KHOMKO#M MBIIIH JOOYIO sTYerKy B Tabsuiie. [losiBUTCs: KOPOTKOE MeHI0, BKlovaromiee Open
Sform.

5. Kiuknure ero, utoOsl yBujieth hopmy, kotopyio QGIS co3naer ajist 3Toro ypoBHsi.

O4eBUAHO, YTO OBLTO OBl HETIOXO JIENIaTh 3TO, MIAA Ha KapPTy, BMECTO TOTO, YTOOBI MOCTOSTHHO MCKATh KOHKPETHYIO
yJuiy B Tabnune atpuoyroB Attribute Table.

1. Bribepure cioli roads Ha maHemu Layers.

Identify Features

2. C nomompio nHCTpyMeHTa M nenTndukanus GpyHKumi KJIMKHHTE JIOOYI0 YJIMIY Ha KapTe.

3. Tlanens Identify Results OTKpoeTCsl, HA KOTOPOH OTOOpa)aeTcsl «JepeBO» 3HAYECHUH MOJiel 1 Apyrasi o0rmas
uHpopMalus o BHIOpaHHON (PYHKIIUH.
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4. B BepxHe# yacTH aHeJn IpoBepbTe Auto open form for single feature results B MEHIO XN sup:ldentify Settings
(Mpentudukaiyss HACTPOeK).

5. Tenepp KIMKHHTE ellle pa3 Ha JIIOOOHW yIUIle Ha KapTte. B mpenpinyimem quanoroBoM okHe Identify Results
otoOpaxaetcst 3HakoMasi hopma:

0080 Attributes - roads
osm_id  |47587910) @
name NULL
highway  unclassified a|
waterway  |NULL
aerialway | NULL
barrier NULL
man_made NULL
other_tags | "lanes'=="2" a|
| Cancel | @

6. Kaxplii pa3 Korjaa Bbl KJIMKAeTe MO OAHON (PYHKIMM C MOMOIIBI0 HHCTpYMeHTa Moenmudbuyuposams ero
(opma mnosiBiISIETCS PH YCIIOBHMH, YTO YCTAHOBJEH (pyiaXkok ABTOMATHYECKH OTKPBIBATH (hopMy Auto open
form.

5.3.2 \ Monpobynte camu, ucnonb3yinte ¢oopMbl Ans penakTMpoBaHuUs
3HayeHun

Eciv BB HAX0OUTECH B PEKMUME PeJaKTHPOBAHUS, 3TY (POPMY MOKHO HCIIOIB30BATh AN PelaKTHPOBAHMUS aTPHOYTOB
¢yHK1IHN.

1. AKTUBHpOBaTb PEXKUM peJaKTUPOBAHUSA (€C/IU OH ellle He AKTUBUPOBAH).

p
2. C nomolnpio HHCTpyMeHTa OnpeaenuTh (pyHKIUI a& Identify Features

yepe3 Swellendam Swellendam:

KJIMKHUTE TIIABHYIO YJIMILY, TPOXOIALLYIO
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X 0 *,
v x )% 50 3 csm_id  |238808188 al

name |Vbannak Strest ‘

highway |tertiary |

waterway | NULL ‘

aerialway | NULL |

barrier [nuLe |

man_made |NULL |

other_tags |"Ianm"=>"2“

3. Pepaxtupyiite ero 3HaueHue highway kak secondary.

4. BI)IXOZ[I/ITG 13 peKUMa p€IAKTUPOBAHUA N COXpaHHﬁTe HU3MCHCHUA.

5. Ortkpoiite Tabnmuiy atpubyToB Aftribute Table n oTMeTbTe 4TO 3HAUeHHE OBUIO OOHOBJIEHO B TaOJIHLIe aTpH-
OYyTOB U, CIIE0BATEIBHO, B UICXOJHBIX JaHHbIX.

5.3.3 / WUnem panbuie: Hactpoika tTunos noneu doopmbl

TpusATHO peTAKTUPOBATH BEIIY C TIOMOIILI0 (POPMBI, HO BCE PABHO HAJIO0 BBOJUTH Bee BpyuHyl0. K cuactbio, popmbl
MMEIOT Pa3jinyHbIe BUJIBI TAK HA3BIBAEMBIX GUOJICENO8, KOTOPBIE MO3BOJISIOT PEIAKTUPOBATh JAHHBIE PA3TMYHBIMU
CII0COOAMH.

1. Otkpoiite roads cnos Properties...

2. Tlepeenute Ha BKIAAKY Fields. Bol yBumute 310:
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'ri Information

8 source

% symbology
€2 Labels
€ED Masks

d Diagrams

N# 3D View

E g Fields

Attributes
Form

Joins

.’l Auxiliary
Storage

{;,I_GI Actions

[ @ve | syle -

Layer Properties - roads | Fields

(/] (8]

id -~ Name Alias Type Typename Length Precision Comment WMS WFS *
122 0 [fid glonglong Integer64 0 0 v v
abe 1 Full_id Qstring  String 255 0 v v
abc 2 osm_id Qstring  String 255 0 v v
abc 3 osm_type QString String 255 0 v v
N S P O N N
ac 5 lanes Qstring  String 0 v v
ac §  maxspeed Qstring  String 255 0 v v
abc 7 oneway QString  String 255 0 v v
abc 8 | ref QString String 255 0 v v
abc 9 | surface Qstring  String 255 0 v v
ac 10 | name Qstring  String 255 0 v v
abc 11 embankment Qstring  String 255 0 v v
abc 12 | maxweight Qstring String 255 0 v v -

| «/Apply || % cancel H &/ OK ]

3. Tlepeiinute Ha BKIaAKy Aftributes Form. Bbl yBuanTe 310:

fi Information
':-‘\S_\ Source
%~ symbology
€3 Labels

€O Masks

Diagrams

-
]

Wg 2D View

E Fields
Attributes Form

Joins

." Auxiliary
Storage

(;‘.-GI Actions

Autogenerate

“ |Available widgets =

~| @Help || sile -

Layer Properties - roads | Attributes Form

- | |E\ | Show form on add feature (global settings) ~ |

Fields

osm_type

highway

lanes

maxspeed

oneway

ref

surface

name

embankment
maxweight
destination:back...
destination:Forward
destination:ref:ba...
destination:symb. ..
cutting

access

- </Apply || % cancel H oK ]

4. Knuknute Ha psig oneway U Boibepute Checkbox kak Widget Type B criicke BADUAHTOB:

5.3. 3aHsaTtune: dopmMbl
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Layer Properties - roads | Attributes Form X

Q Autogenerate

“ Available widgets

~ Fields
fid
full_id
osm_id
osm_type
highway
lanes

ref

surface

name

embankment
maxweight
destination:backw...
destination:forward
destination:ref:ba...
destination:symbo...
cutting

access

hgv

foot

sac_scale

name:af
lanes:backward
lanes:forward
reg_ref

bicycle

cycleway

sidewalk

service

bridge

layer

@Help Style -~

‘i
@ d
-‘\- |
L abc
(abc]
-

1
N

-

5. Kmmknaute OK

maxsEeed

v General

Alias

Comment

v| Editable Label on top

Show form on add feature (global settings) ~

-

_

Classification
Color
Date/Time

w» Attachment
Hidden

Relation Reference
Text Edit

Unigue Values

¥ Uuid Generator
Value Map

Value Relation

</ Apply || % cancel

6. Ilepexon B pexxuM pelaKTHPOBAHHUS (€CIM CJIOH roads He HAXOOUTCS yXKe B PEKUM PeJaKTHPOBAHUS)

7. KIMKHUTE HAa MHCTPYMEHT Q& Identify Features

8. KiMkHHTe Ha Ty e [JIAaBHYIO JOPOTY, KOTOPYIO BBl BHIOpaJM paHee.

Teriepb Bbl yBUJIUTE, UTO Onewdy OIHOHAIIPABJIEHHBIH aTpUOYT UMeeT (bJIaXoK PsiIoM ¢ HUM, 0603Havannmi True
(pnaxok) wm False (Her yaxkka).

5.3.4 .ﬂ—. Monpo6ynte camn

3apgaiite 6oJee MOIXOIAINI BUIKET (POPMBI TS 10N highway.

IIposepvme ceou pesyavimamot
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5.3.5 s [lONpo6yiTe camMmn, co3panTe TECTOBbIE AaHHbIe

Takke MOXXHO MOJTHOCTBIO CO3AaTh COOCTBEHHYIO TOJIb30BATEIBCKYIO (popMy.
1. Co3spaiite mpocToii cioil Touek ¢ UMeHeM test—data ¢ AByMs aTpuOyTamu:
* Ha3BaHHeE (TEKCT)

* BO3pacT (LEJIOE YUCIIO)

New GeoPackage Layer x

Database training_data.gpkg
Table name test-data

Geometry type Point >

Include Z dimension Include M values
EPS5G:4326 - WGS 84 v ||
New Field
Name
Type 123 \Whole Number (integer) -
Maximum length
Fields List
Name Type Length
name text 80
age integer

v Advanced Options

Layer identifier test-data
Layer description

Feature id column | fid
Geometry column geometry

V| Create a spatial index

@ Help Ocancel Sok

2. 3aduKcHpyiiTe HECKOJIBKO TOUEK Ha HOBOM CJIOE C IIOMOIIBI0 MHCTPYMEHTOB ONU(DPOBKHU, UTOOBI Y Bac ObLIO
HEMHOTO JJAHHBIX [UTS BOcIipon3BeneHus. [Ipy kax o 3anvcicheMKe HOBOM TOYKY BaM JIOJDKHA OBITh TIpe-
craBiieHa (popMa 3aImcy aTpuoyToB, creHeprpoBaHHBIX QGIS mo ymomanmo.

HpHMeanne: MoxeTt HOTpC6OBaTbCH OTKJTIOYUTD MPUBA3KY, €CJIM OHA BCE €1IE BKIIOYCHA JTA IMTPEAbIAYIINX
3agad.
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test-data - Feature Attributes X

fid Autogenerate a| v
name richard a
age 23 @ 3

cancel QoK

5.3.6 == W pem panbiue: CospnaHne HoBon oopMbl

Terneps MbI XOTHM CO31aTh COOCTBEHHYIO TOJIb30BaTEIbCKYI0 (popMy [ist (hasbl cOOpa JaHHBIX aTprOyTOB. [IJ1s1 9TOr0
HeoOxoaumo ycranoButh {uzaitnep QT (ToNbKO [UIs JTHIA, CO3AA0NIEr0 (POPMBI).
1. 3anycrute QT Designer.

2. B nosiBuBIIEMCS IMAJIOrOBOM OKHE CO3JANTE HOBOE AUATIOTOBOE OKHO:

20060 New Form

templates/torms
Dialog with Buttons Bottom

Dialog with Buttens Right
Dialog without Buttons
Main Window
Widget
Widgets
Cancel Ok
Embedded Design
Device: None s
Screen Size: | Default size s
[ Show this Dialog on Startup
| Open.. | | Recentw | | Close | [ Create ]

3. Haiigure Widget Box B ieBOi 4acTH 3KpaHa (1o ymoa4anuio). OH COAEpKUT JIeMEHT ¢ UMeHeM Line Edit.
4. KJIMKHUTE U TIepeTanuTe STOT JIeMeHT B hopMy. DTO co3AacT HOBBIH Line Edit B popme.

5. Tlpu BeIOOpE HOBOTO 3JIEMEHTA PEIaKTUPOBAHHUS CTPOKHU €ro CBONCTBA Oy1yT 0TOOpaxaThcsi Ha OOKOBOM CTO-
pOHe 9KpaHa (0 YMOITYAHHIO CIIPaBa):
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13.

14.

0060 Property Editor

[Filier | + =/

lineEdit : QLineEdit

Praperty Value
L)
| objectName [T [«]
b

enabled ™

» geometry [(80, 40), 113 x 21]

» sizePolicy [Expanding, Fixed, 0, 0]

»  minimumSize 0x0

» maximumSize 16777215 x 16777215

» sizelncrement 0x0

» baseSize 0ox0
palette Inherited

» font A [Lucida Grande Ul, 13]
cursor | I1Beam
mouseTracking ™
focusPolicy StrongFocus
contextMenuPolicy | DefaultContextMenu
acceptDrops ™

» toolTip

b statusTip

» whatsThis

» accessibleMame

» accessibleDescrip...
layoutDirection LeftToRight
autoFillBackground | |
styleSheet

¢ locale English, SouthAfrica

p inputMethodHints ImhNone

» inputMask
b text
maxLength 32767
frame E
echoMode Normal
cursorPosition 0
» alignment AlignLeft, AlignVCenter
dragEnabled ]
readOnly ]
p placeholderText
curanridoveShila | nnicalMovaShila

. 3apganite mid €ro UMEHU 3HAYEHHUE name.
. Wcnonb3ys TOT e MoIxXo[, co3aanTe HOBBI Spin Box Box u 3agaiiTe 11 ero UMEHU 3HAUCHUE age.

. HobGaswte Label ¢ mexcmom scuprvim wipugpmom “Add a New Person” (pocMOTpUTE c8olicmea 00beKTa, UTo-

OBl y3HaTh, KaK 9TO 33/1aTh). MOXKHO TakXe 3a/1aTh 3ar0JIOBOK CAMOT'0 JIMaIOr0BOrO OKHA (BMECTO JI00aBJICHUS
HA/JIIIICH).

. Ho6aBbre Label k Bamemy Line Edit n Spin Box.
10.
11.
12.

VYHOPSII0YUTh JIEMEHTHI [0 COOCTBEHHOMY KEJIAHUIO.
KnukHure B 11000M MECTE JUAJIOrOBOrO OKHA.

Haiinure xnonky Komnonoexka 6 maxeme ¢popmwi (IO yMOTYAHUIO B MHCTPYMEHTAX BJOJb BEPXHErO Kpas
aKpana). [Ipr 3TOM IHAIOroBoe OKHO OyIeT pa3MeneHO aBTOMATHYECKH.

YcraHoBUTE MaKCHMAaITBHBIN pa3Mep JUAIOrOBOrO OKHA (B €ro cBOMcTBax) paBHBIM 200 (mmpuHa) Ha 150
(BBICOTA).

Tenepb q)opMa AOJIKHA BBIIVIAAECTD IPUMEPHO TaK:

5.3.
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8 -add_people.ui* |- [X

15. Coxpanute cBoIo HOBYIO (hopmy Kak exercise_data/forms/add_people.ui

16. Koraa 3akoHYMTCS cOXpaHEHHe, MOXeTe 3aKpbITh Of Designer

5.3.7 ﬂ'—- Nnem panbue: CesizbiBaHUEe hOpMbI CO CNOEM

1. Bepnutecs B QGIS.
Kimknute /1Ba pa3a Ha CiioH test-data B JiereH[ie sl TOrO YTOObl OTKPBITh CBOUCTBA.
Knuknute Ha Attributes Form B quanoroBoM okHe Layer Properties.

B packpeiBatoriemcs crivicke Attribute editor layout Beidepute Provide ui-file.

A

KimkHWUTE KHOMKY MHOTOTOUMS M BRIOEPHTE TOJIBKO YTO CO3JaHHBIN (paitn add_people.ui:

Layer Properties - test-data | Attributes Form x

Q Provide ui-file ~ | @ | Show form on add feature (global settings) ~

G’ Information = Editul [home/qgis-user/forms/add_people.ui
Available widgets

s v General
\§ Source ¥ Fields
fid ;
4 Al
& symbology name ias
g Comment
- gﬂa::"::?dgets v/ Editable | | Labelon top
QML Widget
HTML Widget v Widget Type
Diagrams
Text Edit -
Wp 3D View
Multiline
E Fields
P .
== Attributes Form
Joins w Constraints
L Auxiliary
0 storage Mot null
(;‘.-G) Actions Unique
. Expression ~|| €
. Display
- Expression description
& Rendering
Enforce expression constraint
Variables
_ v Defaults
a Metadata
Default value £
ﬁ Dependencies Prane

Apply default value on update

@Help Style -~ « Apply || % cancel

Legend

QGIS Server

6. Kimuknute OK B 1uanoroBoM okHe Layer Properties.

7. Tlepexomure B peXKUM pelaKTHPOBAaHUsI U OepHUTE HOBYIO TOUKY.
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8. Ilpu 3TOM OyzIeT Mpe/ICTABIEHO Ballle MOJIb30BATEIbCKOE TMATIOr0BOE OKHO (BMECTO OOIIIEro, KOTOpoe OOBIYHO
co3gaer QGIS).

9. Ecnu BBl KJIMKHUTE 110 OJHOW U3 TOUYEK C MOMOIIBIO UHCTPYMEHTa ﬁk Identify Features penepy, MOKHO BHI3BATH
(opmy, KIMKHYB NPaBO KHOTIKOW MBIIIN B OKHE OIpE/IeJICHHs! pe3yJIbTaToB, U BEIOpath View Feature Form
B KOHTEKCTHOM MEHIO.

10. Ecau Bbl HAXOAUTECH B PEKUME PEAAKTUPOBAHHUS ISl STOTO CJIOSI, TO BMECTO 9TOIO KOHTEKCTHOE MEHIO Oy/ieT
otobpaxats Edit Feature Form. Ilociie 3TOro MOXHO CKOPPEKTHPOBATh aTpUOyT B HOBOH (pOopMe JIaxe Moclie
MEePBOHAYATLHON 3aITUCUCHEMKE TOUKU.

5.3.8 B 3aknouyeHun

C nomompio popM MOKHO 00JIErYuTh ceOe KU3Hb IIPU pelaKTHPOBAHNH MM CO3/IaHUU JAHHBIX. PeqakTupys TUITBI
BUJDKETOB WJIM CO3/aBasi COBEPIIEHHO HOBYIO (hOpMY C HYJIs, MOKHO KOHTPOJIMPOBATh padOTy TOTr0, KTO OLU(POBHI-
BAaeT HOBBIE IAHHBIE JUISI STOTO CJIOSI, MUHUMU3UPYSI TEM CaMbIM HeZIopa3yMeHHsI M HeHYXKHbIE OLTHOKH.

5.3.9 [lononHuTtenbHble MaTepuasnbl O YTEHUA

Eciu BB 3aBepIlviM YCIOKHEHHBIA pa3fien Bblllle U 3HaeTe o nporpamme Python, Bel Moxkete mocMmotpeTs this
blog entry ~_ 3anmuch 6yiora 0 CO3AaHUU MOJIB30BATENILCKUX (hopM (PYHKIME ¢ Jiorukoii Python, kotopas nmo3pouisier
WCIIOJIb30BaTh PaCIIMpeHHbIe (DYHKIIMH, BKJIOYAs IPOBEPKY JAHHBIX, aBTO3ABEPILECHNE U T.JI.

5.3.10 Yto manbLue?

OtkpbiTie GOpMBbI [T MACHTUDHUKAIMN (PYHKIIMK SIBJISIETCS OJHUM U3 CTAHJAPTHBIX JIEUCTBUM, KOTOPHIE MOKET
BeIIOTHUTE QGIS. OgHAKO ero MOXKHO TaKke HallPaBUTh Ha BBIIOJHEHNE ONIpe eI ieMbIX IT0JIb30BaTeIeM AeHCTBUN.
ITO Tema CJIEAYIONIEro 3aHsATHsI.

5.4 3aHsiTne: Ilencreus

Termeps, KOr/Ia BB BUIEIH JEUCTBHUE [0 YMOJIYAHHIO B IPEIBIIYIIEM 3aHSATHH, IIPHUIIUIO BPEMsI OIIPE/IeIUTh COOCTBEH-
HblE IENCTBUS.

JleficTBHE - 9TO TO, YTO MPOUCXOJUT KOT/IA BB HaXUMaeTe Ha (pyHK1M0. OHO MOXKeT JOOABUTh MHOTO JIOTIOJHUTE b-
HBIX (QYHKIIOHATbHBIX BO3MOXHOCTEHN Ha KAPTY, MO3BOJISIS MOJYYUTh JTOMOTHUTEIBHYIO HH(pOpMALUO 00 00BEKTE,
IUist ipuMepa. Ha3HadeHue IeficTBUI MOKeT OOABUTh Ha KapTy COBEPILEHHO HOBOE M3MepeHue !

Hem; 9TOro 3aHATHA: Hay‘{I/ITI)CH IIO6EIBJ'[HTI) I10JIb30BATCJIbCKHUE HeﬁCTBHH.

Ha stom 3aHsTHM BBl OyzieTe UCIIOIB30BaTh CIOH school_property, KOTOPBI BBl paHee cozaaBaiu previously. Ilpu-
Mepbl JaHHBIX BKJIOYAOT (poTorpaduu KaxIoro u3 Tpex oludpoBaHHbIX CBOKCTB. MBI coOMpaeMcst CBsA3aTh Kax-
Jioe CBOJICTBO € ero u300paxeHreM. 3aTeM CO3JaauM AeHCTBUe, KOTOpOe OTKPOeT U300paKeHue s CBOMCTBA IIPH
IIeJTYKE HA CBOVICTBE.

5.4. 3aHsiTne: Odencreus 161



QGIS Training Manual

5.4.1 \ Npem panble: [lo6aBneHue nons ans nsobpaxeHumn

B cioe school_property Moka He yaeTcst CB3aTh n300paxeHue co cBoictBoM. CHavaia co3/1a/iuM moJie st

3TOU LIEJIH.
1. Otkpoiite quanoroBoe okHO Layer Properties.
2. Knuknure Fields.

3. PexuM pegakThpOBaHUSL:

Layer Properties - school_property | Fields

Q _»{}1 |@|

‘:{:\1_- Source

% symbology
€3 Labels

B Masks

' Diagrams

N7 3D View

E Attributes Form

Joins d

L Auxiliary .| @Help Style ~

4. IloGaBbTe HOBYIO KOJIOHKY:

d - ‘Toggle editing mode Lpe Type name  Length Precision = Comment

0 |id glonglong  Integer64 10 0 v
abe | name Qstring  String 80 0 v

b

«/ Apply || % Cancel

Layer Properties - school_property | Fields

- Ly |E| Iil lg
(i' Information M me Alias Type Type name Length Precision Comment
= 1220 |id glonglong | Integer64 10 0 v
A Source . :

: abc name Qstring String 80 0 v
-

& sSymbology
€5 Labels

B masks

- .
1 Diagrams

Ng 3D View

f g Fields

E Attributes Form

5. Hwuxe BBeauTe 3HAYEHUS:
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Add Field

Name |image|

Comment

Type Text (string) v
Provider type string
Length 255

il
-

% cancel | o OK |

6. Tlocre Toro Kak BB CO3JaJM TOJIe TiepeiianTe K Attributes Form M BHIOepHTE TIONE image .

7. 3amate Tun BumkeTa Widget Type nns Bioxenus Attachment:

Layer Properties - school_property | Attributes Form x

Autogenerate ~ | @ || show form on add feature (global settings) ~
@ information [ ivaliil:::::i widgets v General =
‘:{:\} Source id Alias
name
%" symbol Comment
bothiederl Relations ditabl bel
~ Other Widgets v| Editable Label on top
QML Widget
HTML Widget v Widget Type
- Attachment -
" Diagrams -
Path
W# 3D View
ﬁ " Default path |/home/tveite/Downloads/QGIS/QGISTrainin... || ... | €
Fields
— Relative paths
2| Attributes For
Joins
L Auxiliary
&M Storage
Storage Mode
{@ Actions
) @ File paths
® oisplay Directory paths
o .
L4 B v Display Resource Path
Variables v| Display button to open file dialog
l Metadata Filter
ﬁ Dependencies Use a hyperlink For document path (read-only)
Legend e
W qaisserver PRI Style - /Apply || % Cancel

8. Kinuknure OK B quanoroBoM okHe Layer Properties.
9. Hcnone3yiite MHCTpyMeHT Identif'y 11t KJIMKa Ha OJHY M3 Tpex (PyHKIMH B cinoe school_property.

TockoubKy BBI BCE €llie HAXOIUTECh B PEKUME PEJaKTUPOBAHUS, JUAIOTOBOE OKHO JIOJKHO OBbITh AKTHBHBIM
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Y BBITJISIIETH CIIEYIOIINM 00pa3oM:

school_property - Feature Attributes

Actions

id |2 |

name |school campus

image

% cancel | o/ OK |

10. KiukHUTE Ha KHONKY MPOCMOTpa ( ... PSJIOM C TIOJEM image).

11. Beibepure MyTb K BaleMy N300pakeHuIo. W3zob6paxenus B exercise_data/
school_property_photos/ W HUMEOT TO € MMs, YTO W (PYHKIMH, C KOTOPHIMM OHH HOJIKHBI
OBITH CBSI3aHBI.

12. Kymuknure OK.
13. Cespxute Bee M300pakeHHs C IPABUIBHBIMU (DYHKIMSMH C TOMOIIBIO STOr0 METO/A.

14. CoxpaHnTe U3MEHEHHUS 1 BHIMANTE U3 PEXMMa PeIaKTHPOBAHMSL.

5.4.2 \ Upem panblie: Co3paHve nenucreus

1. OrtkpoiiTe BKIaAKy Actions ans cnost school_property 1 KJIMKHUATE Ha KHOIIKY I:I-I:I-II:I Addanew action

Layer Properties - school_property | Actions x

¥ Action List
ff Information Description Short Title Action  Capture Action Scopes On Notification Only when editable
'?C\\ Source
% symbology
€ Labels
abc VFT

Diagrams

W# 3D View

E Fields

E Attributes Form

Joins
] »

ﬂ Auxiliary Storage ik Create Default Actions

actions
d » | | Show in Attribute Table

2. B nuanoroBom okHe Add New Action BBenuTe ciioBa Show Image B noje Description:
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Add New Action -~

Type Generic - Capture output

Description |Mandatory description
Short Mame |Leave empty to use only icon
lcon

Action Scopes

Field Scope
Layer Scope
v Canvas

v Feature Scope

Action Text

The action text defines what happens if the action is triggered.
The content depends on the type.

For the type Python the content should be python code
For other types it should be a file or application with optional parameters

1 3
| E Insert
Execute if notification matches

Enable only when editable

@Hel ¥ cancel
p c

Yro nenarb JaJIblIC, 3aBUCHUT OT OHepaHI/IOHHOﬁ CUCTEMBI, [TO3TOMY BI)I6epI/ITC HO)IXOHHHII/Iﬁ Kypc:

¢ Windows
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Knukuure Type u BoiOepute Open.
¢ Ubuntu Linux

B nonte Action, Hanmmre eog i CpezictBa npocMoTpa n3odpaxennit Gnome Gnome Image Viewer,
WM Hanimre display 4rtoObl UCTIONB30BaTh lmageMagick. TIoMHHTE, YTO HY)XHO CTABUTH HPOOEI
ocJie KOMaHObI!

e MacOS
1. Kmure Ha Bbimagatomuii T'ype n Boibepure Mac.
2. B Action, nuimte open. [ToMHHUTE, 9TO HY)XHO CTaBUTh MPOOEIT MOC/Ie KOMaH/Ib! !
Teneps MOKHO MPOAOIKUTH 3AIUCh KOMAHIbI.

Bs1 xoTHTe OTKPHITH U300paxeHue, 1 QGIS 3Haer, rme oHO HaxoauTcs. Bee, 4TO eMy HyKHO CHieNaTh, 3TO
CKazaThb Action TaMm, Tiie U300paxkeHue.

3. BoiOGepure image 13 CucKa:
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Add New Action i3

Type Generic - Capture output

Description |Mandatory description
Short Mame |Leave empty to use only icon
lcon

Action Scopes

Field Scope
Layer Scope
v Canvas

v Feature Scope

Action Text

The action text defines what happens if the action is triggered.
The content depends on the type.

For the type Python the content should be python code
For other types it should be a file or application with optional parameters

1 eoq- [%imageS]

4 b
123 id

abc name

@Help % Cancel

4. Kinukuute Ha KHOTIKY Insert field. QGIS no6asur dpasy [$ "image" %] Bmoine Action Text.

5. Kimknure Ha KHONKY OK, 4TOOBI 3aKPBITH IMATIOrOBOE OKHO Add New Action.
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6.

Kimknure Ha KHOMKY OK 4TOOBI 3aKPbITh AUATIOrOBOE OKHO Layer Properties.

Temneps NpHUILLIO BpeMsI IPOTECTUPOBATh HOBOE AEHCTBHE:

1.

2.
3.

o ) lem B i
&Q 'Q{L'i--.h:' =~ @) :

Knukaute Ha cnoit school_property Ha ianenu Layers YTOOBI OHO BBIJICITHIIOCH.

i .
Haifnure kHOTIKY 'g\-'& Run feature action (g Agribytes Toolbar).

KnmkauTe CcTpesky BHU3 cIpaBa OT 9TOW KHOMNKH. [JIs 3TOTo CJI0s1 Ha JaHHBIA MOMEHT OIIPEeSICHO TOJBKO
OJIHO JIHICTBHE, KOTOPOE TOJBKO UTO CO3JaHO.

%EETG Il~

O o imaoe os IR

4.
5.

KimkHUTE KHOIKY, YTOOBI aKTUBUPOBATh MHCTPYMEHT.
C noMoIbI0 3TOro0 MHCTPYMEHT KJIMKHHTE JII000€ M3 TPEX CBOHCTB IIKOJIBI.

IIOII)KHO OTKPBITbCSA 1/1306pa>1<eH1/Ie JJIA 3TOro CBOJCTBA.

543 / WUnem panbue: Nouck B UHTEepHeTe

JlormycTiM, MBI CMOTPUM Ha KapTy ¥ XOTHM y3HATh OOJIbIIIE O paliOHe, B KOTOPOM Haxoautcst (pepma. [Tpearnosnoxim,
BBl HUYETO HE 3HaeTe O JaHHON MECTHOCTH M XOTUTE HAWTH OOIIyI0 MH(OpMAIUIO O Hell. Banr nmepBhiii uMityJibe,
YUUTHIBASI, YTO BBl UCTIOJIb3YeTe KOMITHIOTEP IPSIMO CeUac, BEpOSITHO, OyzeT HaiT B Google Ha3BaHMe MECTHOCTH.
Hagaiite morpocum QGIS crenats 310 aBTOMaTHYECKH 111 Hac!

1.

Ortkpoiite TabuIy aTpuOyTOB B cioe landuse.

M5! OyeM UCroIb30BaTh MoJIe name JUld KaxIoro paiioHa 3eMJIeNob30BaHusA yToOb! HaiTi B Google.
3akpoiite Tabauiry aTpuOyTOB.

Bepnurecs k Actions B Layer Properties.

Knukuute Ha kHOTIKY Create Default Actions, 9T00bI JOOABUTh Psifi IPEABAPUTEIILHO OIPE/ICICHHBIX JICHCTBHI.

. Ynmamute Bce neiictBus kpome Open URL c kopoTkuM umeneM Search Web ¢ TOMOIIBI0O KHOIKH

Remove the selected aclion, KOTOpas PacroNokeHa HUKE.

KiukHuTe nBa pasa Ha ocTaBiieecs ISUCTBUE, YTOOBI PEeIaKTHPOBATh €ro.

Iomensiite Description Ha Google Search, u yganure copepxumoe noius Short Name.

Y6enurecs, uro [onotHo Canvas Haxooutcst cpeau Action scopes ¢ iaxKamu.

Yro menaTh AabIile, 3aBUCUT OT OINEPALIMOHHON CHCTEMbI, IOSTOMY BHIOEPUTE MOIXOIAIINA KypC:
¢ Windows

B Type BriGepute Open. D1o no3Bosmt Windows OTKphITh agpec MHTepHeTa B Gpay3epe [0 YMOIYaHHIO,
Hanpumep Internet Explorer.

¢ Ubuntu Linux

B Action Hanmmmte xdg—open. 310 no3posut Ubuntu OTKPHITE MHTEPHET-aJpec B Opay3epe 1o yMoJI-
yanuio, HanipuMep Chrome nm Firefoxhis.

¢ MacOS

B Action nanuiute open. D10 nmo3BouT MacOS OTKpBITE HHTEPHET-aJpec B Opay3epe M0 yMOJUaHHUIO,
Hanpumep Safari.
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Tenepb MOXKHO ITPOJAOJIKUTDH 3alIUCh KOMaHbI.

He3aBucumo ot TOr'o, KaKylo KOMaHy Bbl UCTIOJIb30BAJIA BBIIIE, Bbl JOJIKHBI COO6I_[II/IT]> 6171, KaKou aapec Wn-
TEPHETA OTKPLITH CJICAYIOIIUM. Bol XOTHUTE, yTOOBI OHA MOCETHUIIA Google " UCKaJia q)paay AaBTOMATHUYCCKU.

O6pryHO TP UcToNb30BaHUM (Google BB BBOIWTE CBOIO TOMCKOBYIO (ppa3y B CTpoKy moucka Google. Ho B
9TOM CJTy4ae Bbl XOTHTE, YTOOBI BAIl KOMITBIOTEp cliesiall 3To s Bac. To, kak B 3agapute Google nouck yero-
TO (€cM BBl HE XOTUTE UCIIOJIB30BATh €r0 CTPOKY MOKCKA HAMPSIMYIO) SBJISIETCS IyTeM MPeJOCTaBJIeHUs afl-
peca BaleMy UHTepHeT-Opay3epy https://www.google.com/search?g=SEARCH_PHRASE, riue
SEARCH_PHRASE" 370 TO 4TO BbI uiniere. [lockonpKy Mbl MOKa He 3HaeM, Kakylo (hpa3y UCKATh, MbI IPOCTO
BBEJIEM TMEPBYIO YacTh (6€3 MOUCKOBO# (ppasbl).

9. B nosie Action Brmiiute https://www.google.com/search?g=. He 3a0biBaiite 106aBUTh TIpOOE
MocJie HavYaIbHOW KOMaH/bI Tepe] TeM Kak BIUIIUTE 3TO!

Teneps BbI x0THTE, 4T0OB QGIS cKazan Opaysepy, uroos Google Mckan 3HaYeHre UMEHH name sl JII0O0H
(byHKIIMHM, KOTOPYIO BBl MOXKETE HaXKaTh.

10. Beibepurte none name.

11. KnukHute KHOTKY Insert:
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Edit Action -~

Type Generic - Capture output

Description |Google Search
Short Mame |Leave empty to use only icon

lcon

Action Scopes

Field Scope
Layer Scope
v Canvas

Feature Scope

Action Text

The action text defines what happens if the action is triggered.
The content depends on the type.

For the type Python the content should be python code
For other types it should be a file or application with optional parameters

1 xdg-open-http://www.google.com/search?q=[%name%]

1 b

| E Insert

Execute if notification matches || |

Enable only when editable

@Help % Cancel « OK

Orto o3HavaeT, yto QGIS cobupaercss OTKpHITh Opay3ep M OTIPABUTH €ro Mo agpecy https://www.
google.com/search?g=[% "name" %].Komanga [$ "name" %] roBoput QGIS ucnosnb3oBars
COZIEpPKHMMOe TIOJIS name Kak (ppa3y IoucKa.
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Tak, HanpuMep, €ClIM MECTHOCTb 3€MJIETIONIb30BAHKA, HAa KOTOPYIO Bbl HaXKMMAaeTe, HaspiBaeTcd Marloth
Nature Reserve, QGIS cobupaercsa oTmpaBuTh Opay3ep Ha https://www.google.com/
search?g=Marloth%20Nature%20Reserve, 4TO NpPUBEAET K TOMY, YTO Ball Opay3ep MOCETHT
Google, KoTopbIii B cBOI0 ouepenb Oyaer uckath «Marloth Nature Reserve».

12. Eciu BHI ellie He CAEJa 9TOr0, HACTPOUTE BCE, KAK OMKCAHO BBIIIE.
13. Kimmkaute Ha KHOMKY OK, 9TOOBI 3aKPhITh qUATOroBoe OKHO Add New Action.
14. Knmknute Ha KHONKY OK 4TOOBI 3aKPBITH JUAJIOrOBOE OKHO Layer Properties.
Tenepb, 4TOOB! IPOBEPUTH HOBOE JICHICTBHE.
1. Cnoii landuse noyxeH ObITh aKTUBEH Ha NaHe M Layers, Tellepb KIMKHUTE Ha CTPEJIKY BHU3 CIIPaBa OT KHOIKH
ng\: Run feature action

, ¥ BHIOEpHTE eIMHCTBEHHOE JelicTBHIe (Google Search), onpeaenaeHHOE Il 3TOTO CIIOS.

2. KiukHute Ha JTI00OM y4YacTKe 3eMIIEIONb30BaHMsI, KOTOPBI MOXHO YBU/IETh Ha Kapte. Bari Opaysep oTKpo-
eTcs ¥ HauHeT nonck B Google MecTa, 3aIMCaHHOTO KaK 3HAYSHHE name Ha 9TOH MECTHOCTH.

IIpumeuanne: Eciu peiicTere He paboTaeT, yOeIuTech, 4TO BCe BBEACHO MTPABUIILHO; ONIEYaTKU YaCcTO BCTPEYaloTCs
NP Takux padorax!

5.4.4 s Klpem panble: OTKpbiTUE BeO-CTpaHULbI HENOCPenCTBEHHO B
QGIS

Bbliite, BbI BUIENH, KAK OTKPBITh BEO-CTPAHUILy BO BHEIIHEM Opay3epe. ECTh HEKOTOPbIE HEIOCTATKH B TAKOM IO/
X0[ie, TaK KaK OH JI00aBJIsIeT HEM3BECTHYIO 3aBUCUMOCTb - OY/IET JIM y KOHEYHOT'O MOJIb30BATE s IPOrpaMMHOe 0Oec-
NevYeHne, HeOOXOMMMOE TS BHITIOJIHEHHS NeiicTBYsI B cBoeil cucteme? Kak BB BHIENH, OHU HE 00A3aTENBHO Jake
MMEIOT OJMH M TOT ke BUJ GA30BOM KOMaHIbl ISl OJHOTO W TOTO K& BUIA NEWCTBHH, €CITM Bbl HE 3HAETe, KAKYI0
OS onu GyyT KCIONb30BaTh. B HEKOTOPBIX Bepcusix OS BhlllleyKa3aHHbIE KOMAH/IBI IJTsT OTKPBITHsI Gpay3epa MOTYT
BOOOIIIE He PaboTaTh. DTO MOKET ObITH HEMPEOIOIUMON MPOOIEMOH.

Opnnako QGIS HaxoauTesl B TONe HEBEPOSITHO MOIIHON M yHUBepcabHOI 6ndmmorekn Qt. Kpome Toro, nerictBus
QGIS moryT OBITh TPOU3BOJIBHBIMU, MAPKMPOBAHHBIMU (T.€. C MCIIOIb30BaHUEM MH(OPMALIMK IEPEMEHHOM Ha oc-
HOBE COIIEpKUMOT0 aTprOyTa MoJist) KoMaHgamu Python!

Tenepb Bbl yBUIMTE, KAK UCIIONB30BATh IEUCTBHE python 1151 0TOOpakeHU s BeO-CTpaHUIIbL. 3/1eCh JIEKUT Ta JKe camast
o0Imas uaesi, YTo ¥ OTKPHITHE CaliTa BO BHEIIIHEM Opay3epe, HO OHa He TpeOyeT Opay3epa B CUCTeMe T0JIb30BaTelI,
MOCKOJIbKY OH Hcrnofib3yeT kiaacc Qt QWebView (kotopwiil siBnsiercss HTML-BumkeroM Ha ocHOBe webkit) 1ist
OTOOpaXEeHUS CONIEPKUMOTO BO BCILTHIBAIOIIEM OKHE.

Masaiite ucrosb3yeM Bukumnenuio Ha 3ToT pa3. Takum oOpa3om, 3anparmmBaeMsiii URL OyaeT BBIISAETD CIeiyo-
MM oopaszom:

https://wikipedia.org/wiki/SEARCH_PHRASE
Yr1oOBI CO31aTh IENUCTBUE CIIOS:
1. OtkpoiiTe tuanoroBoe okHO Layer Properties i iepediuTe K BKJIagKe Actions.
2. Hacrpoiite HOBOE JeWCTBUE, UCNIOJb3YsI )il HETO CIIEAYIOIINE CBONCTBA IEHCTBUS:
e Type: Python
e Description: Wikipedia

* Action Text (Bce B OJIHY JINHUIO):

from ggis.PyQt.QtCore import QUrl; from ggis.PyQt.QtWebKitWidgets import._
—QWebView; myWV = QWebView (None); myWV.load (QUrl ('https://wikipedia.org/
—wiki/ [$name%] ")) ; myWV.show ()
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Edit Action (]

Type Python - | | Capture output
Description Wikipedia
Short Name |Leave empty to use only icon
Icon
Action Scopes

Field Scope

Layer Scope

v Canvas

v Feature Scope

Action Text

The action text defines what happens if the action is triggered.

The content depends on the type.

For the type Python the content should be python code

For other types it should be a file or application with optional parameters

fron-qgis.PyQt.QtCore import -QUrl; from -qgis.PyQt.QtWebKitWidgets -inport-QWebViels; - -myWV = -QWebView(None); myWV.load(QUIL( https://wikipedia.org/wiki/ [Enanes] )); myWwV. show()

L] v

~|& Insert

Execute if notification matches || |

Enable only when editable

@Help % cancel

'y
[e]
=

31ech IPOUCXOAUT HECKOJIBKO BeIel:

* Becp ko Python HaxoauTcst B OAHOW CTPOKE ¢ pa3fessioMMI KOMaHJaAMU TOYKA C 3aIaTol (BMECTO
HOBBIX CTPOK, 9TO OOBIYHBIN crIOCO0 paszesieHus komana Python).

* [%name$%] Oyzer 3aMeHEHO (paKTHMUECKUM 3HaYeHNEM aTpruOyTa IpY BEI30BE JEHCTBUS (KaK U paHee).

» Kopx mpocTo co3maet HOBBIH K3eMIUTAp QWebView, 3amaer ero URL, a 3aTem BBI3BIBaeT show () - Ha
HeM, 4TOObI C/IeNaTh €ro BUAMMBIM B BUJIE OKHA Ha paboyeM CToJie OJIb30BaTeIsl.

3ameTbTe, YTO 3TO HECKOJILKO HaJyMaHHbIi puMep. Python pabortaeT ¢ ceMaHTHYECKH 3HAYUMBIM OTCTYIIOM,
MO3TOMY pa3/iesIsiTh BEIM TOUKOH C 3aIlsITOH He JIyUIlHii criocod ero Haricanus. Takum o6pa3oM, B peaslbHOM
MHpe BbI ¢ OOJIbIIEH BEPOSITHOCTHIO UMIIOPTUPYETE JIOTUKY U3 MoayJisi Python, a 3ateM BbI3oBeTe (DYHKIIMIO C
aTpuOyTOM MOJIS B KaYeCTBE MapaMeTpa.

DTOT MOAX0 MOKXHO TaKKe HUCIOJIb30BATh JIJIs1 TOTO YTOOBI [TOKa3aTh U300paxeHue Oe3 HeOOXOIUMOCTH Ha-
JIMYKs Y TIOJIb30BaTeIel OnpeeIeHHOrO CPeCTBa MPOCMOTPA H300PaKEHUI B MX CHCTEME.

3. TlompoOyiiTe UCTIOIb30BATh OMTMCAHHBIC BBIIIIE METOIBI JITSI 3aTPY3KU CTPAHUIIBI BUKUTIEINY C TOMOIIBIO TOJTh-
KO YTO CO3JaHHOIO JeNCTBUA Bukunenun.
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5.4.5 B 3aknouyeHumn

JleficTBUS MO3BOJIAIOT MPEAOCTABUTH Ballleil KapTe JOMOJIHUTENbHbIE (DYHKIMOHAIbHBIE BOZMOKHOCTH, TMOJIE3HbIE
JUIsl KOHEYHOTO MOJIb30BaTelisd, KOTOPBIA MpocMaTpuBaeT Ty ke kKapTy B QGIS. brarogaps ToMy, 4To MOXKHO UC-
TI0JIB30BaTh KOMaHbl 000JIOUKHM JUIs JTI000H ONepalioHHOM CUCTEMBI, a Takke i Python, Bamm BO3MOXHOCTH
0e3rpaHUYHBI C TOUKH 3peHHUs1 (PYHKIMI, KOTOpbIE Bbl MOIJIM OBl BKJIIOYUTH !

5.4.6 Yto panbwe?

Temneps, korga Bbl OCBOWIN BCE BUJIBI CO3/1aHUSI BEKTOPHBIX JAHHBIX, BBl HAYYUTECh aHAIM3MPOBATh AAaHHbIE IS
peleHus1 mpodieM. A 3TO TeMa CIIelyIOIero MOIyJIs.

5.4. 3aHsiTne: Odencreus 173
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Mogaynb: BekTopHbI aHanna

Termeps moce TOoro Kak Bbl OTPEIaKTHPOBAIN HECKOJIBKO (DYHKITHIA BaM HABEPHOE 3aX0UETCs y3HATD, UTO eIlle MOKHO
¢ HuUMHU caenath. To, 4To y Bac ecTh (PyHKIIMU € ATPUOYTAMH - STO XOPOIIIO, HO KOTJIa BCE C/IENIAHO U CKA3aHO, 3TO He
CKaKeT BaM HUYETO TAKOTo, Yero He MOXET c/iesiaTh OObIYHAs KapTa, He BXojsimas B cuctemy GIS.

OcHOBHOE MpeEnMyuieCcTBO GIS 3akouaeTcs B TOM, UTO OHA MOJHcem damv omeemnl Hd 680onpocwol.

B CJIEAYIOIUX TPEX MOAYJIAX Mbl MOMNbITAEMCH AaTh OTBET HAa BOIPOC UCCJICAOBAHUSA, UCTIOJIb3YA beHKHI/II/I I'mcC.
Haan/IMep, Bbl ABJIACTECh Ar€HTOM IIO NPOJAa)K€ HEABUAKMMOCTU U HIIETE KUJIOE IMOMENIICHUE B CBCJUI@H}I&MG /
Swellendam JUIA CBOMX KJIMCHTOB CO CJIEAYIOIMUMU KPUTECPUAMU:

1. Kunoe nomertenue A0kHO Haxoautbes B Ceeutenaame / Swellendam.

2. OHO JOJIKHO HAXOAUTHCS B MpeJielax yMEPEHHOTO pacCTOSTHUS OT IIKOJIBI (Harpumep 1 km).
3. Ero mwiommaae gowkHa 0biTh 60iee 100 KBaJpaTHBIX METPOB.

4. HaxomutbCs Ha paccTosIHMM MeHee 4yeM 50 MeTpoB OT IJIABHOW JIOPOTH.

5. Haxomutbcs Ha paccrosiHun MeHee 4eM S00 MeTpoB OT KaKoro-HUOY/Ib pecTopaHa.

B paMKax CJICAYIOIMUX HECKOJIbKHUX Monyneﬁ MbI BOCHIOJIb3YEMCA BO3MOKHOCTAMU MHCTPYMEHTOB FI/IC-aHEU'II/ISa,
YTOOBI HANTH noaAXOodAIIHNE (bﬁpMBI JJIA 9TOTO HOBOTI'O JKHUJIOT'O KOMIIJIEKCA.

6.1 3aHsiTMe: Nnepe-npoeunpoBaHue U npeobpa3oBaHne OaHHbIX

Hagaiite eme pa3 moroBopuM o cripapouHoi crcreme koopauHat (CCK). Mbl BKpaTiie Kacaanuch 3TOM TEMBI paHbIIe,
HO He 00CykJaJlH, YTO 3TO O3HAYAET Ha IIPAKTHKE.

Hean 3TOro0 ypoka: Ilepe-npoernmpoBanue U nmpeodpa3oBaHre BEKTOPHBIX HAOOPOB TAHHBIX.
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6.1.1 \ WUnem panbuie: NpoeuupoBaHue

CCK, B KOTOpOI1 ceiiyac HaXOAATCS Bce JaHHbIS, a TAKKe caMa KapTa, HazbiBaeTcss WGS84. D1o odeHp pacripocTpa-
HeHHas reorpaguueckas cucrema koopaunat (I'CK) myis npeacranenust fanHbix. Ho nmeercst npo6iema, KoTopyo
MBI J1ajiee U3yUrM.

1. CoxpaHuTe Bally TEKYIIyIO KapTy.
2. 3areM OTKpOITe KapTy MUpa, KOTOPYIO BBl HaiaeTe 371eck exercise_data/world/world.ggs.
3. Mpubnmxkaiite FOxHyio AGpuKy ¢ oMol KoMaHabl Zoom In.

4. TlonpoOyiiTe ycTaHOBHUTH MacIiTad B mojie Scale, kotopast Haxomurtcs B Ianeau Cocmosinusi B HUKHEH da-
ctu 3kpaHa. Haxonsce Hag FOxxHON Adpukoi, yctaHoBute 3HadeHue 1:5 000 000 (OT 0gHOro J0 MSTU
MIJITAOHOB).

5. Tlepememaiitech Mo KapTe ¥ OAHOBPEMEHHO CMOTPHTE Ha 1ofie Scale.

Bsl 3ameTiin u3MeHeHue Macirada? ITotoMy, 4To Bbl yaajisseTech OT TOM TOYKH, Ha KOTOPYIO Bbl YBEJIUYMIN Mac-
mrad 1:5 000 000, KOTOPHII HaXOIWJICS B LIEHTpe 9KpaHa. Bokpyr 3T10ii Touky MaciTad Apyrou.

,HIISI TOro, YTOOHI TIOHATH No4YeMy TaK MPOUCXOOUT, NPEACTABbTE cebe 3eMHOM map. Ilo HEMY IPOXOJAT JIMHUM C
CEeBEpa Ha Ior. ITU TMHUA JOJITOTHI AAJIEKO APYT OT ApYyra Ha 9KBATOPE, HO BCTPEYAOTCA Ha MOJIIOCAX.

B I'CK B paboTaeTe Haj1 3TOM chepoii, HO Balll 9KpaH I1ockuii. Korna Bel biTaetech M300pasuTth cepy Ha IIOCKOH
MOBEPXHOCTH, BO3HHUKAET UCKaKEHHE, OI0OHOE TOMY, UYTO POU3OIILIO Obl, €CIIN Obl BBl pa3pe3aJii TEHHUCHBIN M4 1
TIOMBITAJINCH €70 PACTUTIONTG. Ha KapTe 9T0 03Ha4YaeT, YTo JIMHUM I0JITOTH HAaXOATCS Ha OJIMTHAKOBOM PACCTOSIHUM
Jpyr OT Jpyra, Jaxe Ha IMoJjocax (TaMm, IIeé OHM JOJDKHBI IepeceKaThcs). DTO O3HAYaeT, YTo MO Mepe TOro Kak
BBI yJaJisieTech OT 9KBATOpa Ha Balllell KapTe, MacliTad 0ObEKTOB, KOTOPHIE BBl BUIUTE, CTAHOBUTCS BCe OOJIbIIe U
6osbine. Ha mpakTrike 3TO O3HAYAET, YTO Ha HaIllel KapTe HEeT MOCTOSTHHOrO MaciiTada!

YToOHI penuTh 3Ty MPOOJIeMy, IaBaiiTe BMECTO STOr0O UCTIOIb3yeM poeKImoHHyo cuctemy koopaunat ([ICK). [ICK
«IPOEIUPYET» MO0 KOHBEPTUPYET JAHHbIE TAKUM 00pa3oM, YTOOBI yUUTHIBATH U3MEHEHUE MacCITaba U KOPPEKTH-
pyer ero. Ilostomy, 4ToObI MaciTad ObUT MOCTOSIHHBIM, MbI JIOJIKHBI TIEpe-IIPOSMPOBATh HAIM JAHHbIE JIJIsI TOTO
4106k McTosb30BaTh [ICK.

6.1.2 \ WUnem panbuie: Nepe-npoeunpoBaHue «Ha nety»

Mo ymosruaruio QGIS nepe-npoenupyeT JaHHbIE «Ha JIETY». ITO O3HAYAET, UTO JAAKE ECITH CAMH JTAHHBIE HAXOIATCSI
B ipyroii CCK, QGIS mosxeT npoenupoBaTh ux, Kak eciiv 061 onu Haxoauch B CCK, KOTopyio Bbl BRIOpau.

B mozkere usmenuts CCK npoekra, HaxaB Ha ! Current projection p phapom HukHeM yrimy QGIS.

1. B amanoroBoM OKHe, KOTOpOe TOSIBIIsSIeTCs, BBeAUTe cIoBO global B mone Filter. Heckombko CCK momKHEL
MOSABUTHLCA B TIoJie Predefined Reference Systems HUXe.

2. Buibepute WGS 84 / NSIDC EASE-Grid 2.0 Global | EPSG:6933, KIMKHYB 110 Hel, a 3aTeM KJIMKHUTe Ha OK.

O6paTrTe BHIMaHUe, Kak roMeHsuicst 06k F0xHoi Adprku. Bee npoekimm paboTaior, n3MeHsisi BUANMbIE
(opmbl 06BEKTOB Ha 3emte.

3. YBemmubte MacmTab 10 1:5 000 000 cHOBa, KaK U paHbIIIe.
4. TIpokpyTuTe KapTy.
OO0parute BHUIMaHUE HA TO, YTO MACIITA0 OCTAJICS TPEKHUM !

[Nepe-npoenpoBaHue «Ha JIETy» TaKke HCIOJIb3yeTcs s 00beAMHEHU] HAOOPOB JIAHHBIX, KOTOPbIE HAXOIATCS B
paszubix CCK.

1. JloGaBbTe Ha KapTy ellle OJMH CJION BEKTOpa, KOTOPhIA COMCPKUT JaHHbIE TOJIbKO 1o FOxHoM Adpuke. OH
HosABUTCA KaK exercise_data/world/RSA. shp.
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2.

3arpysure ero. MoxHo ObicTpo nocmoTpeth Ha ero CCK rocinie HaBeieH!s yKa3aTelisi MbIIIM Ha CJIOH B Jie-
reqne. Ona Takasg EPSG:3410.

Yto BHI 3aMeTIIIH ?

Croit BuzieH, naxe ecmu oH nmeet apyryio CCK, koropas ommiaaercs ot CCK continents.

6.1.3 / Npem panbwe: CoxpaHsiem Habop AaHHbIX B APYron cnpaBo4YHOMN

cucteme KkoopauHat (CCK)

WHoraa BaM HEOOXOIMMO KCIIOPTUPOBATH CYLIECTBYIOIIMIA Habop naHHbix ¢ apyroii CCK. Kak mMbl noToM yBoauM
B MOCJIEAYIOIEM YPOKE, €CJI BaM Halo PaCCUMTATh PACCTOSIHUSA Ha CJIoe, BCEra JIyydllle UMEeThb CJIOH B IIPOeLHpo-
BaHHOI1 CHCTeMe KOOPJUHAT.

Nmeiite B BUIy, YTO Mepe-MPOeUPOBAHIE, OCYIIECTBICHHOE «HA JIETy», UMEET OTHOIIEHHE K MPOEKTY, a He K
OT/ICJIBHBIM CJIOSIM. DTO 03HAYAET, YTO CJI0H MoxeT mMeTh Apyryio CCK, koTopasi omIM4aeTcst OT MpOeKTHOTO, Jaxke
€CJTH Bbl BUJJUTE €T0 B NPAGUNLHOM TIOJIOKCHUU.

Bbl cmoxeTe sierko akcnoptupoBarts ciioit ¢ apyrum CCK.

1.
2.

HobaepTe HaOOp HaHHHIX buildings w3 training_data.gpkg.
KnmkauTe TpaBoil KHOMKOHM MBI Ha ol buildings B manemu Layers.

Bribepure Export » Save Features As... B TIOSIBUBILIEMCS] MEHIO. Bbl yBUaMTE quanoroBoe okHO Save Vector
Layer as....

KiukHu Ha kHONKY Browse psinoM ¢ nosieM File name.

[epeiinute k exercise_data/ u yKaxkuTe UMs HOBOTO cilos Kak buildings_reprojected. shp.
N3mennte 3HaueHue CRS. B packpbiBaiolieMcs: MEHIO MOSIBUTCS TOJIBKO HelaBHO ucrosb3oBaHHble CCK.
KnvkanTe Ha KHOIIKY T4 Select projection PSAOM C pacKpHIBAIOIIMMCS MEHIO.

TostBuTcs quanoroBoe okHo Coordinate Reference System Selector. B mone Filter cnenaiite mouck 34 S.

Bribepure WGS 84 / UTM zone 34S | EPSG:32734 w3 cniucka.
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Coordinate Reference System Selector

Select the coordinate reference system for the vector file. The data points will be transformed fraom the layer
coordinate reference system.

Filter | ©. 345

@ |
Recently used coordinate reference systems
Coordinate Reference System Authority 1D
WGS 84/ UTM zone 345 EPSG:32734

1

[»

Coordinate reference systems of the world Hide deprecated CRSs
wordinate Reference System Authority ID [
RGRDC 2005 / UTM zone 345 EPSG:4062
WGS 72 [ UTM zone 345 EP5G:32334
WGS 72BE / UTM zone 345 EP5G:32534
WGS 84 f UTM zone 345 EP5G:32734
4] >
Selected CRS |WGS 84 / UTM zone 345
N ™ W g u
Extent: 18.00, -80.00, 24.00, 0.00 \ o
Projd: +proj=utm +zone=34 +south .’I = .
+datum=WGS84 +units=m +no_defs - g
| [@lHelp | | @cancel || Fok |

9. OcranbHble IapaMeTpsl OcTaBbTe Oe3 M3MeHeHui. [luanoroBoe okHoO Save Vector Layer as... BHIIIAAUT TeNEpPb
TakK:
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Save Vector Layer as...

Format ESRI Shapefile

File name |ome/matteojexercise_datafexercise_data/buildings_reprojected.shp

Layer name
CRS EPSG:32734 - WGS 84 7 UTM zone 345 - | &
Encoding UTF-8 v

v | Add saved file to map

b Select fields to export and their export options
v Geometry

Geometry type Automatic =

» Extent (current: layer)
P Layer Options

P Custom Options

Help @ Cancel oK

10. Knuknute Ha kHONKY OK.

Teneps BB CMOXeTe CPAaBHUTD CTAPYIO M HOBYIO IIPOEKIIMH CJIOSI M YBUJIETh, UTO OHM HaxoAATcs B ABYX pa3Hbx CCK,
HO OHH BCE €Ille IEPEKPHIBAIOTCSI.
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6.1.4 == /inem panbwe: Co3zpaem COGCTBeHHyIO npoeKuuro
Kpome Tex mpoekimii, kotopsie BKIoUeHH B QGIS 1o ymoruaHuio, CyImecTByeT ere MHOTO IPYTHX MpoeKImid. Ber
TaKKe CMOXETEe CO3/IaBaTh CBOU COOCTBEHHBIE TPOEKIIHH.

1. 3amycTuTte HOBYIO KapTy.

2. 3arpysure Habop JaHHBIX world/oceans. shp.

3. Ilepeiimute Kk Settings » Custom Projections... ¥ BH YBUIUTE 3TO TUAJIOTOBOE OKHO.

Custom Coordinate Reference System Definition X

v Define

You can define your own custom Coordinate Reference System (CRS) here. The definition must conform to a WKT or Proj string format for specifying a CRS.

Name Parameters &
=
Name
Format WKT (Recommended) -
Validate
Parameters
¥ Test

Use the text boxes below to test the CRS definition you are creating. Enter a coordinate where both the lat/long and the transformed result are known (For example by
reading off a map). Then press the calculate button to see if the CRS definition you are creating is accurate.

Geographic / WGS84 Destination CRS

Calculate

@Help Ocancel Qok

4. K/IuKHUTE Ha KHONKY ':I'I:I-II:I Addnew CRS 519 co31aHMA HOBOI MPOEKITHH.

5. EcTb uHTEpecHas MpOeKIMs ISl UCTIOJIb30BaHMs, KOTopas Ha3bBaeTcss Van der Grinten I. Beemute
ee Ha3BaHME B Name.

Sra NpoeKIMs MPe/ICTABIsIeT 3eMIII0 B KPYIJIOM I0JIe BMECTO MPSIMOYTOJIBHOTO Kak B OOJIBIIMHCTBE JPYTUX
MPOEKIHSIX.

6. B mone Format seibepure WKT (Recommended,).

7. HobGaBbTe clieyolyio CTpoKy B niosie Parameters field:

PROJCRS ["unknown",
BASEGEOGCRS ["unknown™,

DATUM[ "unknown",

ELLIPSOID["unknown", 6371000,0,
LENGTHUNIT["metre", 1,
ID["EPSG", 90011111,

PRIMEM["Greenwich", O,
ANGLEUNIT ["degree",0.0174532925199433],
ID["EPSG",8901]111,

(continues on next page)
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(IPOJIOJIKEHNE C MTPEbIIYLIEH CTPaHULIBI)

CONVERSION["unknown",

METHOD ["Van Der Grinten"],

PARAMETER["Longitude of natural origin", 0,
ANGLEUNIT ["degree",0.0174532925199433],
ID["EPSG",8802]],

PARAMETER["False easting",0,
LENGTHUNIT["metre", 1],
ID["EPSG",8806]],

PARAMETER["False northing", 0,
LENGTHUNIT["metre", 1],

ID["EPSG", 8807111,
CS[Cartesian, 2],

AXIS[" (E)",east,

ORDER[1],
LENGTHUNIT["metre", 1,
ID["EPSG", 9001111,

AXIS[" (N)",north,
ORDER[2],
LENGTHUNIT["metre", 1,

ID["EPSG",9001111]

Custom Coordinate Reference System Definition x

v Define

You can define your own custom Coordinate Reference System (CRS) here. The definition must conform to a WKT or Proj string Format for specifying a CRS.

Name Parameters o
Van der Grinten | PROJCRS["unknown",BASEGEOGCRS["unknown", DATUM["unknown",ELLIPSOID["unknown",6371000,0,LENGTHUNIT["metre",1,ID[... -
Name Van der Grinten |
Format WKT (Recommended) -
PROJCRS["unknown", = Validate
BASEGEOGCRS["unknown",
DATUM["unknown",
ELLIPSOID["unknown",6371000,0,
LENGTHUNIT["metre",1,
Parameters ID["EPSG",2001]]]],
PRIMEM["Greenwich",0,
ANGLEUNIT["degree",0.0174532525199433],
ID["EPSG",8901]]],
CONVERSION["unknown",
METHOD["Van Der Grinten"], -
b Test =
@Help Ocancel Qok

8. Kimmkawnte Ha KHOTIKY OK.

9. Kinkau Ha kHonKy Teky1as mpoekuus 'm—! ¥ Current CRS

CCK.

CIlpaBa OT CTPOKHU COCTOAHUSA IJII UBMEHEHHM A ITPOCKTA

10. BeiGepuTe CBOIO HOBYIO TIPOEKIIUIO (ClIeIalTe MOKCK 10 Ha3BaHMUIO B rone Filter).

11. TIpu npumMeHeHUH STOM MPOEKIMK KapTa OyJeT nepe-IMpoepoBaHa CleyoIuM 00pa3oM:
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L] *Untitled Project - QGIS 9e45223d42 [tm] = o x
Project Edit View Layer Settings Plugins Vector Raster Database Web Processing Help

 DERBREY Qe rRPPRLALRBIER e K-U-EE#I=-0 0

P /BRAR-Fox0Doe "qEH%ES92 QAR a90- B "« L

Layers

e o @O T &AL
oceans

Va
7~
L]

Browser ‘ Layers |
| @ Type to locate (ctr+k) 1 legend entries removed Coortinate | 2652139.4502093) | scale | 1218427020 ‘-I & Magnifier | 100% 2] Rotation [0.0° [3][v] Render @ userao0o2s @

6.1.5 B 3aknouyeHun

PazHble MpoeKIMK MOoNe3HB! I Pa3HBIX Lieseld. BriOpas MmpaBuiIbHYIO IPOEKIMIO, Bl MOKETe ObITh yBEPEHbI, YTO
00BEKTHI Ha Ballleil kapTe OyayT IPeACTaBIeHBI TOUHO.

6.1.6 [ ononHUTeNbHble MaTepuasnbl ONA YTEHUA

Matepuainst pasnena [Ipoosurymulii Yposers 3TOT0O ypoKa ObLIU B3SIThl U3 ~9TOM CTaThU _

O3HaKOMUTHCS JONONMHUTENBHOM nH(popMarmeit o Cipapounoit Cruicteme KoopauHar.

6.1.7 Yto panbwe?

B cnenyioniem ypoke Bbl Hay4MTECh aHAIM3MPOBATH BEKTOPHBIE JaHHbIE C MOMOIIBI0 PA3IMYHBIX MHCTPYMEHTOB
BeKTOpHOTO aHamm3a QGIS.

6.2 3aHsATUe: BeKTOpHbIN aHanu3

BekTopHbIe JaHHbIE TAKKE MOXHO aHATM3UPOBATH, YTOOBI y3HATh, KAK PA3JINYHbIe 00bEKThl B3AUMOICHCTBYIOT IPYT
C IpYroM B rpocTpaHcTBe. ECTh MHOKECTBO Pa3IMYHBIX (DYHKIIMIA, CBSI3aHHBIX C aHAJIM30M, HO MbI He Oy/IeM UX BCe
paccmarpuBaTh. MBI JTydllie 3aaquM BONIPOC U MOTMBITAEMCS HAWTH Ha HErO OTBET C IOMOILbI0 MHCTpyMeHToB QGIS.

Iean 3TOrO0 Ypoka: 3amath BONPOC U PEIIUATH €r0 C TOMOIIBI0 MHCTPYMEHTOB aHAIN3A.
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6.2.1 \ Mpouecc GIS

IMepen TeM Kak HayaTh ObUIO OBl XOPOLIO ClieJIaTh KpaTKUid 0630p Mporecca, KOTOPBIA Halo NPOMTH ISl pelleHHs
npo6iemsl. OH IpecTaBIeH HIKe:

1. O603HauUTh IPOOIIEMY.
2. Tlony4uTh JaHHBIE.
3. IMpoaHanu3upoBath MpodiemMy.

4. TlpeactaBuUTb pe3yJIbTaThI.

6.2.2 \ Mpobnema

Haunewm c onpenenenus mpo6ieMsl, KOTOPYIO HYXKHO pelnTs. Harrpumep, B SIBJIsIETECh areHTOM I10 IPOJIaKe HeBH-
’KUMOCTH ¥ MIIeTe kujioe noMernieHre B CeesuieHaame / Swellendam as1st CBOMX KJIMEHTOB €O CIIEAYIONIMMU KpUTe-
pusAMu:

1. JKwoe nomelieHyie JOJKHO HaxoauThest B Swellendam.
OHO JIOJKHO HAXOJUTHCS B TIpeJieNiax YMEPEHHOTO PACCTOSIHUS OT IIKOJIBL (HarpuMmep, 1 Km).
Ero momiaae nomkHa 661tk 6osiee 100 KBagpaTHBIX METPOB.

Haxoautbcst Ha paccTostHUM MeHee yeM 50 MEeTpOB OT IJIABHOM JOPOTH.

A

Haxomuthest Ha pacctosinuu MeHee yeM 500 METPOB OT KaKOro-HUOY/Ib peCTOpaHa.

6.2.3 \ JaHHble

UYToObI OTBETUTH HA STH BOIPOCH], HAM HYKHBI CJIeIyIOIIHe JaHHBIC:
1. JKuble nomeneHus (31aHusI) B 3TOM paiioHe.
2. Jloporu BHyTpH ropojia U BOKPYT HEro.
3. MecTopacnonoKeHre MIKOJI M PeCTOPaHOB.
4. Pa3mep 3maHU.

StH JaHHBle MOXHO noyuutsh yepe3 OSM (OpenStreetMap) u Bbl y3HaeTe, 4To HaOOp AaHHBIX, KOTOPbIH BB HC-
MOJIb30BAJIM B 3TOM PYKOBOJCTBE, TaKKe MOXKHO MCIOJIb30BATh AJIS1 BBINOJHEHUS 9TOTO YpOKa.

Ecnu BB XOTHTE 3arpy3uTh JaHHBIE M3 IPYrOil MECTHOCTH, Tiepeiiaute B Pazden Bsederie N1 03HAKOMBTECH, KaK 9TO
MOJKHO CJIIEJIaTh.

IIpumeuanne: Xorts 3arpyxkaemsie daitisl OSM copepikaT corlacoBaHHbIE MO JaHHBIX, OXBAT U AeTalnu3alus
MOTYT ObITh Pa3HBIMU. Eciii Bbl OOHAPYKHJIM, YTO BHIOPAHHBI BAMU PETHOH, K IPUMEPY, HE COICPIKUT CBEACHHUS TI0
pecropaHam, TO BaM, BO3MOXHO, HaJI0 BHIOPATh JPYroi PeruoH.
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6.2.4 \

CnHayvana HaMm HaJ0 3arpys3uTb JaHHbIE, C KOTOPbIMH MbI 6y,IlCT pa60TaTb.

1. Hauvatp HOBBII ipoekT QGIS.

Upem panbuie: Havyatb NMPOEeKT U NoNy4YnTb oaHHbIe

2. Ecmu xotute, Moxete 00aButh (hoHOBYIO Kapty. OTKporiTe Browser u 3arpy3ure (oHOBYIO Kapty OSM u3

mento XYZ Tiles.

*Untitled Project - QGIS [

Project Edit View Layer Settings Plugins Vector Raster Database Web Mesh Processing Help

DEBRRY OPLLHI PRRA.BENR
Q
Dm_‘ %} Z m- T R
Layers @
& [ ® T B B L N
v |v| ¥ OpenStreetMap
Vo |
L X «
&
%
.\"a
/% ok -,
Swellendam .&ka,_
@a Browser (=]E3] bt
QD, ORaT®O J ™™ f Lt
» @ Postals = —
@~ » mssaL A

% & pB2
S @ WMS/WMTS
&)~ |~ @ XYZTiles
Q\/z Ty @& wecs
P &0 WFS / OGC API - Features
K8 |y @ ows
& ArcGisMapServer
& ArcGisFeatureServer
s}t GeoNode

1 3

QA Type to locate (Ctrl+K)

i

1| 2271701,-4029807 % 2/ 1:53228 v | @ r|100%

-2 |00° | ¥/ Render & EpsGi3gsT @

3. B 6aze mannbx Geopackage training_data.gpkg BBl CMOXeTe HAUTH OOJIBITUHCTBO HAOOPOB IaHHBIX,
KOTOpBIE MbI Oy/IEM MCIIOJIB30BaTh B 3TO pasjele:

1. buildings
2. roads
3. restaurants

4. schools

3arpysute X, a Takxke landuse.sqglite.

4. YBenmubTe MaciTad ciosi, yToObl yBuaeTh CeesteHnam B HOxHoN Adpuke.

Hpemne yeM IMONTH JaJIbIIC, MbI JOJI2KHBI OT(bI/UII;TpOBaTB CJION 7 OleS, YTOOBI pa60TaT1> TOJIBKO € HEKOTOPbIMU
KOHKPETHBIMU THUITAMHA JOPOT.

Hexkoropsie noporu B Habopax ganHbix OSM nepeunciiensl kKak unclassified, tracks, path, a Takxke
footway. Ham Haio MCKITIOUYMTB MX W3 Halllero Habopa JaHHBIX U COCPEAOTOUYNTHLCS Ha JPYTUX THIAX JOPOT,
KOTOpBIE OOJIbIIIE MOAXOAT AJIS STOTO YHPaKHEHUSI.

Kpowme Toro, He Bce manHbie OSM MOTyT OBITh aKTyaJIM3UPOBAHBI U MBI TAKKe HAJ0 MCKJIIOUMTh 3HAUECHHS

NULL.

5. Kimknute npaBoii KHOMKOW MBI Ha cJIoif roads u BeiOepute Filter....
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6. B quanoroBoM okHe, KOTOPOE MOSIBUTCS, Mbl JIOJIKHBI OT(HIBTPOBATH 9TH OOBEKTHI C MOMOILIBIO CJEAYIOIIErO
BBIPQKEHUST:

"highway" NOT IN ('footway', 'path', 'unclassified', 'track') AND "highway" IS.
—NOT NULL

OO0beauHeHne JByX KoMaHJ NOT u IN MCKJIIOYacT Bce OOBEKTHI, KOTOpPBIC UMEIOT 3T anI/I6yTI>I 3HAYEHU B
noje highway.

IS NOT NULL B couetaHuu ¢ AND HUCKJIIOYaET A0pOru, HE UMEIOIINE 3HAYCHHUA B T10JIE highway.

[Ipumevanue: 3HaUOK ﬁ pszoM co crnoeM roads. OH TOMOXET BaM 3alIOMHHTb, YTO Ha STOM CJIO€ aKTHBH-
poBaH (GWIBTP ¥ IOTOMY HEKOTOpbIe (PYHKIIMK MOTYT OBITh HEIOCTYITHBI B IPOEKTE.

Kapta co Bcemu JJaHHBIMU JI0JIKHA BBIJISAETD CIIELYIOIUM 00pa3oM:

tm_ch72 - QGIS B

Project Edit View Layer Settings Plugins Vector Raster Database Web Mesh Processing Help

DEERR Oe2LAPP " K4 LI

=4 ] 9| »
G\g %"Dg@‘gé}'zﬁ'o m' » @
Layers (=23
@ vamvi-man
~ v [@ training_data
VS v| [l training_data schoo|
w v|[7] training_data restat
[+] v! — training_data roa™’
ﬁ] v| [l training_data buildi | <
&
v| [ landuse b
’Q - ¥ OpenStreetMap . N
ﬁ . [
L > ~ N\
M Browser @ AN )
@ . OR_2THO | :
o -
» / SpatiaLite E S
@' » @ PostGis —
@ P MssQL T
n 2 pB2 I
&5~ v @ wms/wmTs
- @ XYZ Tiles
[+l == OpenStreetMap
» @& WCs
S0y @ WFS/OGC API - Features
» ) ows
& ArcGisMapServer
& ArcGisFeatureServer
sl GeoNode 1=
Q Type to locate (Ctrl+K) 1| 2275926-4028540 |z 1:53229 ~ | @ r|100% S 2 00" - v/ Render & gpsg3asT @

6.2.5 \ Monpobywnte camu: CkoHBepTupoBatb CCK cnoes

Tak kKak Mbl cOOMpaeMcsl UI3MEPUTh PaCCTOSIHUSI BHYTPH HAIMX cJIoeB, HaM Hajo uamenuth CCK cioes. [1yist sToro
HaM HaJ0 BBHIOpATh KaXABIA CJIOW MO OYepe/ir, COXPAHUTD CJIO MO-HOBOMY C HAIllell HOBOM MpPOEKIMEH, a 3aTeM
MMITOPTHPOBATh STOT HOBBIH CJIOW Ha HAIY KapTy.

Y Bac MOsIBUTCSI MHOTO Pa3JIMYHBIX OIIHI, HATPUMEP, Bbl CMOXKETE SKCIOPTUPOBATh KaXK/Iblii CJION Kak HA0Op JlaH-
HbIX (popmata ESRI Shapefile, Bb MoxeTe 106aBUTH ciiou B cyniectByommii paiin GeoPackage uiu co3nats Apyroi
(aiin GeoPackage ¥ 3amoJTHUTh ero HOBHIMHU Tepe-IPOSIPOBAHHBIME CIIOSIMH. MBI TIOKakeM MOCJIeHIOK OIIIHIO,
4t0o0Bl t raining_data.gpkg ocrancs 4ucThiM. Bel cMokeTe BHIOpaTh sl ceOs1 CBOU JydIUi paboduii mpo-
1ecc.

IIpumeuanne: Ha stom nmpumepe mel ucniosnszyem CCK WGS 84 / UTM zone 34S, HO BBl IOJKHBI UCTIOJIB30BATh
UTM CCK, KoTOpBIii O0JIbIIIe TOAXOIUT JUIsl BAllIero PerioHa.
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1. KimkHuTE mpaBOii KHONKOM MBIIIM HA CJIOH roads B maHenu Layers.

. Kimuknure Export —> Save Features As...

B nnanoroBom okne Save Vector Layer As Buidepute GeoPackage B kauectse Format.
Kmvkawure Ha ... 1 File name v Ha3oBuTe HOBBIM GeoPackage vector_analysis.
W3amenuts Layer name Ha roads_34S.

Msmenute CRS Ha WGS 84 / UTM 30my 34S.

N o A W

Knukuure Ha OK:

Save Vector Layer as... X

Format GeoPackage -

File name ning-Data-release _3.10/exercise_data/vector analysis.gpkg

Layer name roads 34S

CRS EPSG:32734 - WGS 84 / UTM zone 345 - | |

Encoding

[#| Select Fields to export and their export options
v Geometry

Geometry type Automatic -

3 Extent (current: layer)
b Layer Options

P Custom Options

©@Help v| Add saved file to map | % Cancel +/ OK

IT0 MO3BOJMT CO3/1aTh HOBYI Oa3y maHHbIX GeoPackage u 106aBuTh ciioit roads_34S.

8. TloBTOpuTe TOT mpolecc Al KaXIOro Cliosi, CO3[aB HOBBIM cJIOM B vector_analysis.gpkg daiine
GeoPackage ¢ _34 S kak MpuIokeHre K ICXOJHOMY HA3BaHUIO M YOPaB KaX bl U3 CTAPBIX CIIOEB U3 ITPOCKTA.
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IIpumeuyanne: Korna Bbl pelute coxpaHuThb cioi B cymectBylommii GeoPackage, QGIS mo6aBur stoT
cioit B GeoPackage.

9. Iocne Toro, Kak Bbl 3aBEPIIMJIM MPOLECC TI0 BCEM CJIOSIM, BaM HAJI0 KJIMKHYTb IPABOi KHOIKOHW MBILIIM Ha
Mo0O# cior u HaxkaTh Zoom to layer extent, 4T00bl c(hOKYCHPOBATH KAPTY HA MECTHOCTh, KOTOpAsi BaC MHTeE-
pecyer.

Teneps, korna Mbl npeodpazoBanu gaHusie OSM B YHUBepcabHYIO MonepeuHylo mpoekirio Mepkaropa (YIIIIM),
MBI MOKEM HAYaTh HAIM BHIYHMCIICHHSL.

6.2.6 \ Moem panbwe: AHanusupyem nNpobneMbl: pacCToOsiHUE OT LUKOJ U
popor
QGIS no3BoJIsieT pacCUNTHIBATH PACCTOSTHUS MEKY JIOOBIMU BEKTOPHBIMHU OOBEKTaMHU.

1. VmocroBepbTech B TOM, UTO TOJIBKO CJIoM roads_34S mbuildings_34S OBLTH BUIHBI (17151 YIIPOLIEHHS
KapThl BO BpeMsi paboTh).

2. Kiukuu Ha Processing » Toolbox 1jist TOro, 4toObl OTKPBITh aHaIMTHYECKOe AP0  QGIS. B ocHOBHOM, B
9TOM HaOOpe UHCTPYMEHTOB MMEIOTCSI BCE AITOPUTMBI ()11 BEKTOPHOTO W PACTPOBOTO aHAJIH3A).

3. MBbI MOXeM HauyaTh pacCUUTHIBATH IUIOMIAM BOKPYT roads_ 34 S UCOob3ys anroput™ Buffer. Bel Mmoxere
HaiTH ero B rpymme Vector Geometry.
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Processing Toolbox

"ne0 A

Q

1 b . . . . A

() Recently used
(2 Cartography

(2} Database

() File tools

(2 Graphics

(2} Interpolation

(2} Layer tools

()} Network analysis
()} Raster analysis
() Raster terrain analysis
() Raster tools

() Vector analysis
(2} Vector creation
() Vector general
() Vector geometry

me Add geometry attributes
4% Aggregate

4% Boundary

4% Bounding boxes

= Centroids

+ Check validity

&% Collect geometries

# Concave hull (alpha shapes)

¥ Concave hull (k-nearest neighbaor)

4% Convert geometry type
& convex hull

4% Create layer from extent
4% Create wedge buffers

@ Delaunay triangulation
¥ Delete holes

4% Densify by count

4% Densify by interval

P Dissolve

4% Drape (set z-value from raster)
4# Drop M/Z values

¥ Eliminate selected polygons
4% Explode lines

4 Extend lines

¥ Extract specific vertices
"'* Extract vertices

4% Filter vertices by m value
4% Filter vertices by z value
4F Fix geometries

4% Geometry by expression
4 Interpolate point on line

i vrnn M hisensck ek

-

You can add more algorithms to the toolbox,
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Wnu Bbl MOKeTe HAOpaTh B MEHIO MoUcKa buf fer B BepXHEl YacTu MaHeI UHCTPYMEHTOB:

Strumenti di Processing &
® e 0B B
| 2 buffer| & |

allc.

* () Geometria vettore
Buffer multi-anello {distanza costante)
Buffer su singolo lato
Create wedge buffers
Tapered buffers
Variable width buffer (by m-value)
» = GDAL
+ Geoprocessing di Vettori
& Buffer su singolo lato
w Vettori buffer

- g GRASS
= Raster (r.*)
@ r.buffer

& r.bufferlowmem

* Vettore (v.*)
@ v.buffer

-~ & SAGA

* Raster tools
& Raster buffer
& Raster proximity buffer
& Threshold raster buffer

= Wlmrtor aeneres |

4. Jlpa pa3a KJIMKHHUTE [I0 HEMY, YTOObI OTKPBITH JUAIOrOBOE OKHO aJIrOPUTMA.

5. Buibupaere roads_34S B KauectBe Input layer, ykaswsiBaete Distance 1o 50 v ucrosnb3yiiTe 3HaUSHUS 10

YMOJTYaHHMIO UIA OCTAJIbHBIX ITapaMeETPOB.
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Parameters | Log Buffer
Input layer . .
P y This algorithm computes a buffer area for all the
W/ roads_34S [EPSG:32734] v ||...|| @ features in an input layer, using a fixed or dynamic
distance.
Dist. The segments parameter controls the number of
Istance line segments to use to approximate a quarter circle
50,000000 @ % |meters K =N when creating rounded offsets.
Segments The end cap style parameter controls how line
s — endings are handled in the buffer.
d l The join style parameter specifies whether round,
el s miter or beveled joins should be used when
Round - offsetting corners in a line.
Join style The miter limit parameter is only applicable For
miter join styles, and conkrols the maximum
Round M distance from the offset curve to use when creating
Miter limit a mitered join.
2,000000 -

Dissolve result
Buffered

[Create temporary layer]

¥| Open output file after running algorithm

@Help Run as Batch Process... # Close

6. Tlo ymomyanuio Distance u3mepsieTcsi B METpax, IOTOMY UTO Halll BXOJHOW HabOp IaHHBIX HAXOAUTCS B CHCTe-
Me KOOpAMHAT MPOEKINH, KOTOPasl UCMOJIb3YeT METP B KAUeCTBE OCHOBHOM €TUHUIIBI U3MepeHUs. Bbl MoxeTe
HCIIOTH30BaTh T0JIE CO CITUCKOM, YTOOHBI BHIOPATh JPyTrHe MpoelupyeMble eIVHUIIb, TAKHe KaK KIJIOMETPHI,
SApIBL U T.1I.

IIpumeuanne: Eciu Bbl nbiTaetech co3nars Oydep Ha ciioe ¢ reorpaduyecKkoil cucTeMoi KOOpUHAT, CUCTe-
Ma rpu 00paboTKe TpelypeiUT Bac U MPEJIOKHUT NeperpoeupoBaTh CJI0OH B METPHUYECKYIO CUCTEMY KOOp-
IAHAT.

7. Tlo ymonuaHuio rmpu 00padoTKe CO31AI0TCsI BpeMEHHBIE CJIOM M OHM J100aBIisieTcs B aHe b Layers. Bbl Takxke
MO>KeTe NPUJIOKUTH pe3ysbTaT B 0a3y naHHbix GeoPackage:

1. HaxaB Ha KHOTIKY ... ¥ BEIOpaB Save to GeoPackage...
2. Haszsas HOBBIN clloil roads_buffer_ 50m.

3. CoxpanuB ero B (aiine vector_analysis.gpkg.
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Parameters ‘ Log

Input layer

/" roads_34s [EPSG:32734]

-|[..][2]

Distance

'50,000000 @ 3| |meters

MR =2

Segments

'5

rF
-

End cap style

'Round

Join style

'Round

Miter limit

12,000000

Fe
-

Dissolve result
Buffered

okg' table="roads_buffer_50m" (geom) |:|

¥| Open output file after running algorithm

Buffer

This algorithm computes a buffer area for all the
features in an input layer, using a fixed or dynamic
distance.

The segments parameter controls the number of
line segments ko use to approximate a quarter circle
when creating rounded offsets.

The end cap style parameter controls how line
endings are handled in the buffer.

The join style parameter specifies whether round,
miter or beveled joins should be used when
offsetting corners in a line.

The miter limit parameter is only applicable For
miter join styles, and conkrols the maximum
distance from the offset curve to use when creating
a mitered join.

0%

| @Help || RunasBatch Process... |

| %Close |l «/Run ]

8. Kiuknute Ha Run, a 3aTeM 3aKpoiTe JUaJIOroBoi OKHO Buffer.

Bama KapTa Ternepb 6y)1eT BBIIVIAACTD IPUMEPHO TaK:

6.2. 3aHsTMe: BeKTOpHbLIN aHanus3
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*tm_ch72 - QGIS

Project Edit View Layer Settings Plugins Vector Raster Database Web Mesh Progessing Help

NEERERS O L BPR Q0L LM

/ RS | @ ¥ e T
@ M-o-EEK =0 . R

Layers =)
« @ ® T &vE AL
v| — roads_34S

V; v| [l schools_34s
-] V! [[] restaurants_34S

2 roads_buffer 5om |
ﬁg ! [] buildings_34s

v [ landuse_34s

,n v [| ® openstreetMap
fa
Fﬁ- Browser B&
@ . OR2THO

]

» 7 |Favorites e
@v » " spatial Bookmarks

» [¥ Project Home
% » [l Home

@-|" o/
» @ GeoPackage
\Gv » # spatialite
= » @ postcis
€50 » MssQL
DB2
b B WMS/WMTS
b XYZ Tiles
B oare -
4 »
| @ Type to locate (ctrl+k) Coordinate| 2271541,4028794 |9 Scale|1:51359 |~ | @@ Magnifier 100% \:| Rotation |0,0° |2V Render @ Epsc3ss7 @

Ecy Bann HOBBIIA CJTOW HaXOOUTCSl B BEPXHEW YacTH CIHCKa Layers, OH, CKOpee BCEro, 3aKpoeT OOJIBIIYIO YacTh
Balllel KapThl, HO BBl CMOXETE YBUIETb BCE MECTHOCTHU B BallleM PETHOHE, KOTOPBIE HAXOIATCS Ha paccTosiHUM B 50
M OT JOPOTH.

O6patute BHUMaHUE, 4TO B BameM Oydepe ecTb OTAeNbHEIC MECTHOCTH, COOTBETCTBYIOIIHE KaXI0H OTIEIBHOM J0-
pore. YToObI yCTPaHUTH 3Ty MPOOIEMY HEOOXOUMO:

1. Y6patb Haamucsk roads_buffer_50m B crioe 1 cHOBa co3iath Oydep ¢ BKIoueHHo# Dissolve results KoMaHI01.
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Input layer

Parameters ‘ Log

"/ roads 345 [EPSG:32734]

1

- |

Distance

| 50,000000

@ 3| |meters

MR =2

Segments

'5

-

End cap style

'Round

Join style

'Round

Miter limit

12,000000

|4

issolve result

By Dissolve result

ok{ Python identifier: ‘ DISSOLVE

geom)| ..

¥| Open output file after running algorithm

Buffer

This algorithm computes a buffer area for all the
features in an input layer, using a fixed or dynamic
distance.

The segments parameter controls the number of
line segments ko use to approximate a quarter circle
when creating rounded offsets.

The end cap style parameter controls how line
endings are handled in the buffer.

The join style parameter specifies whether round,
miter or beveled joins should be used when
offsetting corners in a line.

The miter limit parameter is only applicable For
miter join styles, and conkrols the maximum
distance from the offset curve to use when creating
a mitered join.

0%

| @Help || RunasBatch Process... |

| %Close |l «/Run ]

2. CoxpaHnute BbIXOA Kak roads_buffer_50m_dissolved.

3. Kiuknute Ha Run v 3aKpoiiTe JUajoroBoi okHo Buffer.

IMocie Toro, Kak Bbl JOOABUIN CJIOH B MaHe b Layers, oHa OyIeT BBIIJISAIETh TAK:

6.2. 3aHsTMe: BeKTOpHbLIN aHanus3
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*tm_ch72 - QGIS

Project Edit View Layer Settings Plugins Vector Raster Database Web Mesh Progessing Help

oA nRy (0o RPPRPE g B D
g w G ey & Q| ¥ . [1.00 =
@, Gi-E-, EE % I =0 -

Layers (@S]
o« @l ® T &vF AL
roads_buffer 5om |
v — roads_34S
v [l schools_34s
v [[] restaurants_34s

Va
L3
ﬁg W roads_buffer_s0m
%
/e

¥ [ buildings_34s
v [l landuse_34s
- ¥ OpenStreetMap

]  Browser
R ORTHO
S ') ¢ Favorites
@' » " spatial Bookmarks
» [¥ Project Home
% » |4 Home
%- |
» @ GeoPackage
\/Sv » / SpatiaLite
» @ PostGis
€ P MssQL
= pez
b B WMS/WMTS
b & XYZ Tiles

S e

4

s

Q Type to locate (Ctrl+k) Coordinate 2271575-4030207 |9 Scale 1:51359 ~ | @ Magnifier| 100% ~ | Rotation |0,0° +||vl Render & EPSG:3857 @

Ternepp JMIIHNX JETIEHAN yXke HeT.

Ipumevanne: Kpamxas cnpaska (nomouip) B IPaBOR YaCTU JUAJIOTOBOTO OKHA OOBSCHSAET, KaK padoTaeT aro-
putM. Eciii Bam Hy’kHa JonosiHUTENbHASI MH(OpMaIysi, POCTO KJIMKHUTE Ha KHOTIKY Help B HU)KHEH 4acTH, YTOObI
OTKPBITh O0JIee ITOAPOOHOE PYKOBOICTBO IO aJITOPUTMY.

6.2.7 \ Monpobynte camu: PaccTosiHMe OT LLKON

Crenyiite TOMY e MOJIXO/Y, KOTOPBIH OITUCAH BHIIIIE, U co3/iaite Oydep A BalKX MIKOJI.

Vkazatp 1 km B pamuyce. CoxpaHure HOBHI cloil B dpaille vector_analysis.gpkg Kak
schools_buffer_1lkm_dissolved.

IIposepvme ceou pesyavimamot

6.2.8 \ Npem panblue: 30Hbl NepekpbITUS

Termnepp Mbl OIpeJeMIN MECTHOCTH, TZIE€ AOPOTa HAXOAUTCS Ha PACCTOSIHUM MeHee ueM B 50 MeTpax, a Takke MecT-
HOCTH, PacoJIOKEHHBIE OT IIKOJIHI B ITpeAenax 1 KM (1o mpsMoit TuHuY, a He 1o gopore). EcTecTBeHHO HaM HYXKHBI
TOJILKO T€ MECTHOCTH, KOTOPbIE OTBEYAIOT 0OOMM 3TUM KputepusiM. JIj1st Toro HaM HyKHO OyZleT MCHOJIb30BaTh
UHCTPYMEHT Intersect. Bol cMoxeTte Haiitu ero B rpymne Vector Overlay B Processing Toolbox.

1. Ucnone3yiite aBa OydepHsix ciost Kak Input layer u Overlay layer Boibepute vector_analysis.gpkg
GeoPackage B Intersection ¢ Layer name road_school_buffers_intersect. OcraqbHOe OCTaBbTE
Kak mpejasiaraercs (Mo yMOJTYAHHUIO).
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Intersection B

3 .
Parameters = Log Intersection
Input layer

This algorithm extracts the

-~ schools_buffer 1km [EPSG:32734] ||...|| @ overlapping portions of features
in the Input and Overlay layers.
Features in the output

Overlay layer Intersection layer are assigned
the attributes of the overlapping
~'roads_buffer_50m [EPSG:32734] = || .- [|®]| |Features from both the Input and

Overlay layers.

Input fields to keep (leave empty to keep all fields) [optional]
Overlay fields to keep (leave empty to keep all fields) [optional]

v Advanced parameters

Overlay fields prefix [optional]

Intersection

lysis.gpkg' table="road_school buffers_intersect" (geom)

¥| Open output file after running algorithm

@Help Run as Batch Process... # Close

o Pl e M e ma

2. KiukHuTe Ha KHONKY Run.

Ha H306pa)KCHI/II/I HUXE MECTHOCTH, OKPAILIEHHBIE CUHUM LIBETOM 3TO T€ MECTHOCTH, II€ 00a COOTBETCTBHS I10
KpUTEPUAM PACCTOSAHUA CO6J'HOJICHI>I.
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0 *chapter_7 - QGIS 9e45223d42 [tm] - 8 x
Project Edit View Layer Settings Plugins Vector Raster Database Web Processing Help

BERRH [Qapps PRI Y S -R-REE#I s M-
24 / @ ¢ ) Qa® ~9- B " X
Layers
. ¢ BeTVE-BAD
3 v [l road _school_buffers.
roads buffer 50
ya p—
" ]
v [l schools_buffer_1km_dissolved
]
-]
=
|
~Or

Browser | Layers

X Type to locate (Ctri+K) 1legend entie removed. Coortinata [2265496,4035853 | 9§ Scue 12255 |~ | @ Wagnier| 100% 2] Rotation (00" 2 V] Render @ wsc38T @

3. Bnl Moxete y6paTb JBa 6y(pepH1>1X CJIOA U OCTaBUTH TOJIBKO TOT, KOTOprﬁ IMOKa3bIBACT, I'/IC OHU IEPEKPLIBA-
I0TCA, TaK KaK MbI ,E[eﬁCTBI/ITeHLHO XOTEJIK ITO BBISICHUTL B IIEPBYIO OYCPE/Ib:

o *chapter_7 - QGIS 9e45223d42 [tm] - o x
Project Edit View Layer Settings Plugins Vector Raster Database Web Processing Help
BRERBRHX QL0 51 B0 @ S-D-LEE %I sS-9 M-
/ /@ ¢ QaR 29~ K
Layers
¢ BOTE BADL
v [l road school buffers intersect
Vi roads 345

v [ schools_34s
VI [l restaurants_3as

INSAS

V! [] buildings_3as
v [l 1anduse _34s
~OF

Browser | Layers

X Type to locate (Ctr+K) Tlagend enties removed. Condnate[ 2657594033115 | 9§ scae 132255 |+ | @ Magntr | 100% 2 notaten [00 5|V e @ wscoe @

196 Mnaesa 6. Mopaynb: BekTopHbI aHanu3



QGIS Training Manual

6.2.9 \ Npnem panbwe: U3BneueHue 3pgaHun

Tenepsb y Bac ecTb MECTHOCTb, HA KOTOPOH 3/IaHUsI JOJKHBI IIEPEKPHIBATh Apyr apyra. Terneph BaM HAJI0 WU3BJICYb
30aHKAA B 9TON MECTHOCTH.

1. Wmute nyHKT B MeHI0 Vector Selection w Extract by location B [laneau uncmpymenmos 06padomxu.

2. Buibepure buildings_34S B Extract features from. IlpoBepbTe intersect B Where the features (geometric
predicate), BiOepute OydepHBIil ol nepecedenust B By comparing to the features from. CoxpaHuTe B
vector_analysis.gpkg u HazoBuTe cliol well_located_houses.

Extract by Location £

h L]
Parameters | Log Extract by location

Extract features from . .
This algorithm creates a new

-~ buildings_34S [EPSG:32734] - ... vector layer that only contains
maktching features from an input

Where the Features (geometric predicate) layer. The criteria for adding

v intersect touch Features to the resulting layer is
defined based on the spatial
contain overlap relationship between each
disioi - feature and the features in an
isjoint are within

additional layer.
equal cross

By comparing to the features from

“'road_school_buffers_interse: ~ || ... | @

Extracted (location)

.g' table="well_located houses" (geom)

¥ Open output file after running algorithm

| 0%

@Help Run as Batch Process... % Close </ Run

3. KnukHMTe Ha KHOIKY Run M 3aKpoiTe AUaJIOrOBOE OKHO.

4. Bel, ckopee Bcero, 06HapykuTe, 4To Majo 4yTo n3MeHmIock. Ecim tak, nepemectute cnoit well_located_houses
B BEPXHIOIO YacTh CIIMCKA CJIOEB, 3aTeM YBEJIMYbTe MACIITAOD.
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0 *chapter_7 - QGIS 9e45223d42 [tm] - 8 x
Project Edit View Layer Settings Plugins Vector Raster Database Web Progessing Help

BEBRRY M*LerRPPR TR S-E-LEE¥ =9 M-
@ - QEHNERS Qee ~29- B % X

Layers
¢ BeTE-BAD
v [l well_located_houses

v [l road_school_buffers_intersect
buildings 345

ENSBHS

=HEE

Browser | Layers

Type to locate (Cut+K Conranate|[2763880.4071005 | sce[11633 |+ | @ Magniter| 100% 2 e TS

3,U,aHl/I$l KpaCHbBIM LBETOM OTBEYAIOT HAILIUM KPUTEPUAM, a 3€JICHBIM - HET.

5. Temnepb y Bac 1Ba OTAENIBHBIX CJIOSI ¥ BBI cMOXeTe yopaTs buildings_34S U3 CIMcKa CIIoeB.

6.2.10 / Monpo6ynte camu: Oanblue oT¢punbTpoBaTh HaLLWN 30aHUSA

Temneps y Hac ecTh CJIOM, KOTOPBII MOKA3bIBAET HAM BCE 3[aHUs B Ipefiesiax | KM OT HIKOJBL U B ripefesax 50 M ot
joporu. Ham Teneps Hafio COKpaTuTh 3TOT OTOOP M MOKa3aTh TOJBKO Te 3[aHMsl, KOTOpble HAXOIATCS B Ipesieliax
500 m ot pectopana.

Crenyss mpolieccaM, OINKMCAHHBIM BbIIIIE, BaM HAJ0 CO3[aTh HOBBIA CJIOM, KOTOPHIA OydeT Ha3bIBATHCS
houses_restaurants_500m 1 KOTOPBIA JOTIOJHATEIHHO TPOMIIBTPYET Balll cioil well_located_houses s Toro, 4rto-
OBI MOKA3aTh TOJILKO Te, KOTOPBIe HaxosATcs B peaeax 500 M oT pectopaHa.

IIpogepvme ceou pezynvmanmuol

6.2.11 \ Npem panblie: Boibnpaem 3paHus nopxonsiiero pasmepa

YrtoObl yBUIETH, KAKKE 3aHUsI UMEIOT MPaBUIbHbINA paszmep (6oee 100 KBagpaTHBHIX METPOB), HAM HAJI0 PACCUMTATH
UX pa3mep.
1. Boibepure cnoit houses_restaurants_500m u otkpoiite Kaavkyasimop noas, HaxaB Ha KHOIKY ==
Open Field Caleulator ya rapHOfi MaHe M MHCTPYMEHTOB MM B OKHE TAGIUIIbL

2. Bwibepure Create a new field, ycranosute Output field name na AREA, BoiOepute Decimal number (real) kak
Output field type, v BoiGepute Sarea us rpymmst Geometry.
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Field Calculator 3

v Create a new Field Update existing Field

Create virtual field
Output field name |AREA
Output field type | Decimal number (real) -

Output field length Precision

Expression | Function Editor

=+ A LD e | O B Q searc... function $area 3
$area d - - = Returns the area of the current
» Date and Time
b Fields and Values fe.lature. T!’\e area calculated by
» Files and Paths this function respects both the
b Fuzzy Matching current project’s ellipsoid setting
» General and area unit settings. For
~ Geomektry example, if an ellipsoid has been
anﬂle at_vertex set for the project then the
calculated area will be ellipsoidal,
Output preview: 1501.0355253089597 area ~| | and if no ellipsoid is set then the |~
o You are editing information on this layer but the layer is currently not in edit mode. If you click

OK, edit mode will automatically be turned on.

2

-~
(o]
-~

@Help % Cancel

B HOBOM 110J1€¢ AREA 6y,ueT IUIOIIaAb KakJI0ro 3JaHNA B KBaJIpaTHBIX METpax.
3. Kiknure Ha OK. Tlosne AREA n06aBjieHO B KOHIIE TaOJIuUIIbl aTPHOYTOB.
__,:'o_n' L.
4. KukHWTe MbIIIKOM Ha KHonky  TogeleBdiing nng 1oro, yro6hpl 3aBepInTh peJaKTHPOBAHUE U COXPAHHUTE
Ballll U3MEHEHM S TIPH MOSIBJIEHUU 3a11poca.

5. Bo Briazike Source B CBOMCTBax ciosi ycranoBute Provider Feature Filter na "AREA >= 100.
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Query Builder .

Set provider filter on houses_restaurants_500m
Fields Values

old_name = Q search...
addr:erf

internet_access

level

sport

man_made

layer Sample All

height
= Use unfiltered layer

v Operators

= < > LIKE % IM MNOT IN

<= = 1= ILIKE AND OR NOT

Provider specific Filter expression

== 100

©@Help Test Clear * cancel

6. Kimmkante Ha KHOTIKY OK.

Barma KapTa TErepb JO/IKHA IMOKAa3bIBAaTh TOJIBKO T€ 3aHN A, KOTOPLIE COOTBCTCTBy}OT HaluvM N€pBOHavYaJIbHbIM KpH-
TepUsM 1 UMeloT pasmep Gostee 100 KBagpaTHBIX METPOB.

6.2.12 \ Monpobynte camu

CoxpaHuTe Balll BADUAHT KaK HOBBIH CJIOH, clelys MOAXOIY, KOTOPOMY Bbl HAyYWJIKCh Bbile. Daiin 10keH ObITh
COXpaHeH BHYTpHU Tou ke 6a3bl JaHHbIX GeoPackage ¢ HazBanueM solution.

6.2.13 B 3aknwuyeHuUm

Crenyst moaxony petenust npodsiem GIS BMecte ¢ mHCTpyMeHTamu BekTopHOro aHaimmsa QGIS, Bbl cMorim GbICTpO
U JIETKO PEIINTh MPOOJIeMy ¢ HECKOJIBKMME KPUTEPUSIMH.
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6.2.14 YTto panbwe?
Ha cnepyioniemM ypoke Mbl U3y4uM, Kak paccudTaTh HauKpaTyaiilee pacCTOsTHUE MO JOPOoram OT OJHOUN TOYKH JI0

JIpYro.

6.3 3aHaTune: CeteBOM aHanu3

Pacuer KpaTyaiinero pacCTOsIHUS MEXJ1y JByMsl TOUKaMK 3TO oObIuHast 3a1aua GIS. MHCTpyMeHTSI [Uist pelieHust
9TOM 3314 MOKHO HaTh B Processing Toolbox.

Iean 3TOrO Ypoka: Hay4UThCS UCIOIB30BATh ATOPUTMBL Network analysis.

6.3.1 \ Unem panbuie: UHCTPYMEHTbI U AaHHble

Bbl MOXeTe HaliTH Bce allrTOPUTMBI CETEBOTO aHAIM3a B MEHIO Processing » Network Analysis. Kak Buaute, TaM ecTbh
MHOKECTBO MHCTPYMEHTOB:
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Processing Toolbox B

L RON SRR

Q, kearch...

() Recently used

) Cartography

() Database

(2} File tools

(2 Graphics

) Interpolation

() Layer tools
MNetwork analysis

Service area (from layer)

Service area (from peint)

Shortest path (layer to point)

Shortest path (point to layer)

. Shortest path (point to point)

v (2} Raster analysis

¢ () Raster terrain analysis

b () Rastertools

v () Vector analysis

b (2 Vector creation

v (3 Vector general

b () Vector geometry

4

k

b

¥

b

¥

j‘-ﬂ

¥
b
¥
b
k
b
r

FEF F F

) Vector overlay
() vector selection
) Vector table

i GDAL

W GRASS

& SAGA

You can add more algorithms to the toolbox,

OTkpoiite MpoekT exercise_data/network_analysis/network.ggz. OH COCTOUT U3 ABYX CIOEB:
* network_points.
* network_lines.

Croit network_lines yxe Moka3blBaeT HallpaBJIeHHs, KOTOpbIE TIOMOTAIOT MOHATH JOPOKHYIO CETh.
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WHCTpyMeHTHI MOMCKa KpaTYarIlero MyTH TO3BOJISIOT PACCUMTaTh KPATYaNIIMN WJIA CaMblid OBICTPBIH MyTh MEXLy
JIBYMsI TOUKaMH CETH P yCJIOBHH, UTO:

¢ Ha KapTe BLI6paHLI HavaJIbHas 1 KOHEYHasA TOYKH,
¢ HayvaJlbHasd TOYKa BbI6paHa Ha KapTe€, a KOHEYHbIEC TOYKU B3AThI U3 CJI0A TOYCK,
¢ HaydaJIbHbIC TOYKH B3ATHI U3 CJIOA TOYKH, KOHCYHAsA TOYKa 0T06paHa Ha KapTe.

IlaBaiiTe HAUHEM.

6.3.2 \ PaccuuTatb Kpar4yanimi nytb (OT TOYKU K TOUKE)
Network analysis w Shortest path (point to point) TO3BOJISIET BaM pacCUUTaTh KpaTJaiilliee pacCTOsTHUE MEXAY IBYMs
BPYYHYIO BRHIOpaHHBIMU TOYKAMH Ha KapTe.
Ha jaHHOM mpuMepe Mbl paccurTaeM KpaT4Yalinuii (He caMblil ObICTDBIN) ITyTh MEX/1y JABYMS TOUKAMH.
1. Otkpoiite anroputm Shortest path (point to point).
2. Buibepurte network_lines 8 Vector layer representing network.
3. Ucnonw3yiite Shortest B Path type to calculate.

I/ICHOHLE}yI‘/JITC 9TU ABE€ TOYKU KaK HAYaJIbHYIO 1 KOHEYHYIO TOUKHU IJI aHAJIA3A:
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Starting Point

4. KJIMKHU Ha KHOIKY ... psiioM ¢ Start point (x, y) ¥ BHIOEpUTE MECTO M MOMeThTe Starting Point Ha
KapTuHKe. KoopnHaTh 0TOOpaHHOW TOUKU JT0OABJICHBI.

5. Cpenaiite To *e camoe, HO BHIOpaB MecTo, oMedeHHoe Ending point mis End point (x, y).

6. KimkHHUTE Ha KHOTIKY Run:

Shortest Path (Point to Poink)

4

Parameters | Log Shortest path (point
Vector layer representing network to po in I;)
" network_lines [EP5G:3857] v || ||®

This algorithm computes optimal
(shortest or Fastest) route

between given start and end
Path type to calculate points.

Shortest -
Start poinkt

-337683.413243,14891795.812691 [EPSG:32734]

End point

-338395.362613,14891385.191690 [EPSG:32734]

P Advanced parameters
shortest path

[Create temporary layer]

¥| Open output file after running algorithm

| 0%

@Help Run as Batch Process... # Close
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7. HoBblii TMHEWHBIN CJIOKH CO3[aH, KOTOPBIH MPECTABIISET KPATUYAMIINK TyTh MEX/1y BHIOPAHHBIMU TOUYKAMHU.
VY6epure Haanucsh B cnoe network_lines, 4yToObl JTydllle yBUIETh Pe3y/IbTart:

[} *network - QGIS 9e45223d42 [tm] - a x
Project Edit View Layer Settings Plugins Vector Raster Database Web Processing Help
BERRY PP rHpPpPLiBRER @ G-R-2EE: s
/ /@ ¢ “4FBY9e2ee QAR A9 B kW
Layers B8 Processing Toolbox [
RO TE-BAL L XX

o Q search
Shortest path
>

@ Recently used

Q@ cartography

Q Database
File tools

EXNSHS

Graphics

Q
Q
Starting Point Q@ Interpolation
@ Layer tools
Q@ Network analysis
. Service area (from layer)

.. Service area (from point)
. Shortest path (layer to point)

v
»
»
»

. Shortest path (point to layer)
| B Shortest path (pointtopoint) |
» @ Raster analysis
» Q Raster terrain analysis
» Q Raster tools
» Q@ Vector analysis
» @ Vector creation
» Q Vector general
» Q@ Vector geometry
» Q@ Vector overlay
» @ Vector selection
,
,

Ending Point Q@ Vector table
& ooAL
\ Y & Grass
\ & sacA
Browser | Layers
Q Type to locate (Ctri+K) I — Coontinte|_399065,14091703 | Q5 Scae| 15074

8. Ortkpoiite TabiuIly aTpuOyTOB BHIXOIHOTO CJI0s. Tam ecTh TpH MOJisl, MPEACTABIIAIIME KOOPAUHATHI HAYa Ib-
HOW M KOHEYHOH TOYEK U CTOHMMOCTh/3aTPaThl.

Mmi BeIOMpaem Shortest B Bune Path type to calculate, 94T00bI CTOUMOCTD TIPECTaBIIsIA COOOH paccTo-
sSIHHE B ¢IMHULAX CJIOSI MEXAY JBYMS MECTOIOJIOKEHUIMUAY YaCTKAMU.

B Hatem ciyuae kpamuatiuiee pacCTOsIHUE MeXy BHIOPAaHHBIMU TOUKaMH COCTaBIIsIeT 0KoJIo 1000 MeTpoB:

Shortest path :: Features Total: 1, Filtered: 1, Selected: 0

W, > g LT ES D PE = P E|
start end cosk |

11/1180615.65735, 5419749.1849|1179718.97878, 5419066.15762 906,1796167959806
[}

T show All Features :

Tenepp, korza Bbl 3HaeTe, KaK MOJIb30BATHCS STUM HHCTPYMEHTOM, BBl MOXeTe OMPOOOBaTh C APYTUMH YIaCTKAMU.

6.3. 3aHsiTne: CeteBon aHanus 205



QGIS Training Manual

6.3.3 / Monpo6ynte camu: Cambin 6bICTPbIA NYTb

Hcnonb3ysi Te ke IaHHbIe, YTO U B IPEbIAYIIEM YITPAXKHEHUH, MOMPOOYHATE BHIYUCIUTD CAMbINA OBICTPBIH TYTh MEXK/Ty
JBYMS TOUKAMH.

CKOJIBKO BpEMEHH BaM HY>KHO, YTOOBI IIPOUTH OT HAYaJIbHOMW /10 KOHEUHON TOYKU?

IIposepome ceéou pesyrvmamol

6.3.4 / Uoem panbwe: JononHUTenbHbie onuuu

IaBaiiTe U3y4uM ellle HECKOJIbKO OIMIUI MHCTPYMEHTOB CETEBOro aHaim3a. B npedvioyuiee ynpasicrenuu mMbl pac-
CUUTAII CaMblil OBICTPBIA MapIIPYT MKy AByMs Toukamu. Kak Bbl MOHUMAaeTe, BpeMsl 3aBUCUT OT CKOPOCTH
JIBYKCHISL.

MBpI BCHOJIb3YeM Te JKe CJIOW, HaualbHble U KOHEUHbIe TOUKY MPEAbIAYIINX YIPaKHEHUH.

1. Otkpoiite anroputm Shortest path (point to point).
3anonuure Input layer, Start point (x, y) a Takxe End point (x, y) Kak Mbl JeJlaJld paHee.
Bribepute Fastest B Path type to calculate.

Otkpoit MeHIo Advanced parameter.

A I

Nsmenure Default speed (km/h) 3Ha4eHue 1o ymondyanuio 50 Ha 4.

Shortest Path (Point to Point)

Parameters Log

Shortest path (point to
Vector layer representing network point)

/" network_lines [EPSG:3857] Tl This algorithm computes optimal
(shortest or fastest) route between
given start and end points.

Path type to calculate

Fastest v
Start point (x, y)

-337692.99174418324,14891793.808113473 [EPSG:32734]

End point (x, y)

-338431.3080566399,14891487.742442127 [EPSG:32734]

¥ Advanced parameters

Direction field [optionall

Value for forward direction [optional]

Value for backward direction [optionall

Value for both directions [optionall

Default direction
Both directions v

Speed field [optional]

Default speed (km/h)
4.000000 >
Topology tolerance

0.000000 S| | meters -

Shortest path

V| Open output file after running algorithm

[@|Hel Run as Batch Process... # Close #Run
P &
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6. KimmkauTe Ha KHOTKY Run.

7. Tlocne 3aBeplueHHs] AJITOPUTMA 3aKPOUTE UATOrOBOE OKHO M OTKpPOTE TabJIMIly C aTpUOyTaMU BBIXOJHOTO
CIIOSL.

Ilone croumocTtu COACPIKUT 3HAYECHHC B COOTBETCTBHU C BbI6paHHBIM BaMU [IapaMeTpOM CKOPOCTH. ME1 mokeM

npeoGpa3oBaTh MoJie CTOMMOCTH U3 YacoB ¢ APoOsMU B OoJjiee yI000UNTAEMbIC 3HAUCHUS - MUHYMbL.

8. OTKpoWTE M0JIe KAbKYJIATOPA, HAKAB HA 3HAYOK ] U 100aBbTE HOBOE TOJIE minutes, YMHOKUB TOJIE COSt HA
60:

Field Calculator

V| Create a new field Update existing field

Create virtual field

Output field name | minutes

Output field type | Decimal number (real) >
Output field length | 10 + | Precision 2 ;
Expression | Function Editor
Q, search... group field
= + . / = ~ || { ) “n' d group f 2ld
"cast" * 6O + Conversions ~|| Double-click to add field name to

b Date and Time
= Fields and Values

expression string.
Right-Click on field name to open

abe start context menu sample value loading

abe end options.

NULL o
T - e
val Q. Search Loading field values from WFS layers

L) - -ocarch... isn't supported, before the layer is
- tually inserted, ie. when buildi
All Unigue 10 Samples R —
queries.

Output preview: 60.32885332564259

Help i@ cancel

ok

Bor u Bce! Tenep}, BbI 3HA€TE, CKOJIbKO MUHYT l'[OTpe6yeTC$I, YTOOBI )106paTLC$[ us3 OIlHOfI TOYKHU B APYTYIO.
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6.3.5 e KpaTyanllinm NyTb C OrpaHN4YEeHUEM CKOpPOCTHU

Ha manemu HMHCTPYMCHTOB CETEBOI'O aHAJIN3a UMEIOTCA U APYIr€ MHTEPECHBIC OIIINU. HOCMOTPI/ITC Ha 3Ty KapTy:

MBgI XxoTes Obl y3HATH CAaMbIi OBICTPBII MapLIIPYT C y9€TOM OrpaHHYeHHil CKOPOCTH Ha KaXI0M YYacTKe JOPOTH
(HaamnMcy 0003HAYAIOT OTPAHUYUEHHS] CKOPOCTH B KM / 4). Haukparyaiiinmii myTh 6e3 yueTa OrpaHuueHUi CKOPOCTH,
KOHEYHO e, (prosieToBblil MapupyT. Ho Ha 3TOM yyacTke JOpOTrM orpaHuyeHre cKopocTu coctasisgeT 20 kM / 4, a
IO 3eJIEHOI Jopore MOXKHO exaThb co ckopocThio 100 km/4!

Kak 1 B mepBoM ynpaskHeHUH, Mbl Uctionb3yem Network analysis » Shortest path (point to point) n Bpy4HyIo BelOepeM
HavyaJIbHYI0 U KOHEYHYIO TOUKH.

1. Otkpoiite anroputm Network analysis » Shortest path (point to point).
Bridepure network_lines B mapamerpax Vector layer representing network.
Bribepute Fastest B Path type to calculate.

KJIMKHM Ha KHOIIKY ... pSIOM ¢ Start point (X, y) 1 BHIOEpPUTE HAYAIIbHYIO TOUKY.
To xe camoe tnipogaenaiite o End point (x, y).

Ortkpoiite MeHIo Advanced parameters.

NS R » N

Beibepurte mojie ckopocmu B KadyectBe napamerpa Speed Field. C 3toi oriueid anroputm OyeT y4uThIBaTh
OrpaHMYEHUs] CKOPOCTH JJISl KaKI01 JIOPOTH.
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Shortest Path (Point to Point)

Parameters | Log

Shortest path (point to
Vector layer representing network point)

| /" network _lines [EPSG:3857] M | |_| |2| This algorithm computes optimal
(shortest or fastest) route between
given start and end points.

Path type to calculate

| Fastest - |

Start point (x, y)
|-337820.19072083227,14891659.982354421 [EPSG:32734] [[-]

End point (x, y)
|-338212.2892150455,14891490.388367647 [EPSG:32734] [[-]

w Advanced parameters

Direction field [optionall

| - ‘

Value for forward direction [optionall

Value for backward direction [optional]

Value for both directions [optional]

Default direction

| Both directions - |

Speed field [optionall

| 1.2 speed -]
Default speed (km/h)
| 50.000000 |:

Topology tolerance

| 0.000000 |=| | meters  ~

Shortest path

|[Create temporary layer] | |:|

v Open output file after running algorithm

\ 0% |

‘ [@|Help || Run as Batch Process... # Close |[ @Run ]

8. Haxwmure Ha KHOTIKY Run.

9. BoikiounTe clioii network_lines, 4ToOB JIyullle YBUIETh Pe3yJIbTaT.
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0 *network - QGIS 9e45223d42 [tm] _—
Project Edit View Layer Settings Plugins Vector Raster Database Web Processing Help

B8 ¢ Y pprHNPPA tUR e ~E-REE T&E-
LQ@R ~2o9- B X

Browser | Layers

Typet K T Conrtnate| 2300203 100010068 | scole 11138 |+ | @ Mg 1005 2] Rotaton (00" 5| henter @ osca @

Kak Buzute, camplii ObICTPBI MApIIPYT HE COOTBETCTBYET CAMOMY KOPOTKOMY.

6.3.6 / 3o0Ha obcnyxumnBaHust (M3 cnos)

Anroput™m Network Analysis » Service area (from layer) MOXeT OTBETUTh Ha BOIIPOC: KaKH€ MECTHOCTHU JIOCTYITHBI
C yYeTOM 3HAUECHUS PACCTOSIHUS WM BpeMeHH?

IIpumeuanue: Network Analysis » Service area (from point) SBIS€TCSI TEM k€ aJITOPUTMOM, HO OH IO3BOJISIET
BPYUHYIO BHIOpAaTh TOUKY Ha KapTe.

C yuetom paccTosiHue 250 MeTpPOB, Mbl XOTUM Y3HaTh, KaK JTAJIEKO Mbl MOXEM MPOUTU B CETU OT KAKAOU TOUKU
cnos1 network_points.

1. CHumute (paaxok co BCEX CJIOEB, KpoMe network_points.
Ortkpoiite anroputm Network Analysis w Service area (from layer).
Bridepute network_1ines mns Vector layer representing network.
Bribepure network_points mis Vector layer with start points.
Beibepute Shortest B Path type to calculate.

Ha6epure 250 mist mapamerpa Travel cost.

N o AR

KnukauTe Ha KHONKY Run 1 3aKpoiTe AUAJIOTOBOE OKHO.
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Parameters

Log

Service Area (From Layer)

Vector layer representing network

'/ network_lines [EPSG:3857]

Wector layer with start points

*" network_points [EP5G:3857]

Path type to calculate

| Shortest

Travel cost (distance for "Shortest”, time for "Fastest")

| 250.000000

p Advanced parameters

Service area (lines)

[[Create temporary layer]

v Open output file after running algorithm

Service area (boundary nodes)

|[Ski|:| output]

0%

| [&|Help | | Run as Batch Process... |

# Close |[ «Run l

BbIXO/IHO# CJIOH MTpe/ICTaBIIsIeT COO0M MAKCUMAIIbHBIN Ty Th, KOTOPHINA Bl MOXETE MPOUTH OT TOYEUHBIX 00b-

eKTOB Ha paccTossHnU 250 MeTpoB:

Project Edit View Layer Settings Plugins Vector Raster Database Web Processing Help
D@ pprruPPRABBINR ¢ K-

DBRD®X
P/ BYGR-F T
Layers
Y RBOTE-BADL

Vi ® network points
» OV

sNSAS

I |

['Q Type to locate (ctri+K)

*network - QGIS 9e45223d42 [tm]

-amE*=-eER

“4FH499%9% QAR ~29- B " %

Service area (lines)

1legend enris removed.

Conranate|_aes1tmo1e5z |95 scue| 13996

| @ vagnier 300%

3| V| Render @ EpsG28 @
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KpyTo, He npaBaa mm?

6.3.7 B 3aknoueHun

Teneps BBl y3HaJIH, KaK M0JIb30BATHCS ATOPUTMOM Network analysis niisi peniieHus 3a/1a4, CBI3aHHBIX C KpaTJaiIIim
Y CaMbIMU OBICTPBIM MapIIPyTOM.

Mei Tenepb CMOKEM BBITOJHUTh HEKOTOPbIE ISHCTBUS TI0 MPOCTPAHCTBEHHOMN CTATHCTUKE C JIAHHBIMU BEKTOPHOTO
cinost. [Toexamu!

6.3.8 Yto manblue?

Mp&1 nokaxem BaM, KaK 3aITyCKaTb aJITOPUTMbI HpOCTpaHCTBCHHOﬁ CTaTUCTHUKU [JIAA BEKTOPHBIX Ha60pOB JAaHHBIX.

6.4 3aHatue: lpocTpaHCcTBEeHHasi cTaTUCTMKA

IIpumeuanne: Ypok nogrotorneH Linfiniti u S Motala (TexHonorudeckuit yausepcuteT Keiin-Ilenuncyna).

HpOCTpaHCTBCHHaH CTAaTUCTHUKA MO3BOJIACT BaM CIAEJIATh aHAJIM3 U MOHATD, YTO IIPOUCXOAUT B JAHHOM Ha60pe BCK-
TOPHBIX JaHHBIX. QGIS HUMECT MHOKECTBO IOJIC3HBIX MHCTPYMCHTOB JId CTATUCTUYICCKOI'O aHAJIN3a.

Ieab 3TOro ypoka: Y3HaTh, KaK HCIOJIb30BaTh MHCTPYMEHTH NMPOCTPaHCTBEHHOM craTucTUKU QGIS BHYTpHM
Processing Toolbox.

6.4.1 \ Npem panble: Co3paem TecToBbI HA6OP AaHHbIX

MBbI co30aquM CITyYaiHbIA HAOOP TOUEK U MOTYyYHM HaOOp JaHHBIX I PaOOTHI.

YT0ObI 3TO CI¢cJ1aTb BaM HOHa,HOéI/ITCH Ha6op JAaHHBIX ITOJIMT'OHA, YTOOBI OIpeaeINTb MECTHOCTD, B KOTOpOfI BBI XOTUTE
CO31aTb TOYKH.

Mei OyzieM UCHOJIb30BATH TUIOIIA/lb, IOKPHITYIO YIIHLIAMH.
1. HauHuTte HOBBIN MPOEKT.

2. Jlo6aBbTe CBOM HAOOp MaHHBIX roads, a Takke srtm_41_19 (IaHHBIE O BHICOTE) B exercise_data/
raster/SRTM/.

Ipumeuanne: Boi Bo3MoxHO 00Hapysxute, uyto ot SRTM DEM umeet npyryio CCK, koTopas oTinyaercs
ot cnos popor. QGIS nepe-npoenupyer o6a ciost B ogqaoit CCK. [jis1 cneyomux yrnpaxHeHUH 9Ta pa3HULa
HE UMeeT 3HAYCHUsI, HO BBl MOXETe Mepe-IpoelpoBaTh (Kak ObUIO MOKA3aHO paHee B 3TOM MOJIYJIe).

3. OTkpo¥Te MUK AT UHCTPYMEHTOB Processing.

4. Ucnonwsyiite uHcTpyMeHT Vector Geometry w Minimum bounding geometry nisi CO3JaHUs1 MECTHOCTH, MPU-
BsI3aB BCE JOPOTH, BhIOpaB Convex Hull B kadectBe Geometry Type:
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Minimum Bounding Geomekry x

Parameters | Log
Input layer
/" roads [EPSG:4326]

Field (optional, set if features should be grouped by class) [optional]

Geometry type
Convex Hull
Bounding geometry

[Create temporary layer]

¥| Open output file after running algorithm

@Help Run as Batch Process...

0%

2

-

Minimum bounding
geometry

This algorithm creates geometries which
enclose the features from an input layer.

Mumerous enclosing geometry types are
supported, including bounding boxes
(envelopes), oriented rectangles, circles
and convex hulls.

Optionally, the features can be grouped by
a Field. If set, this causes the output layer
to contain one Feature per grouped value
with a minimal geometry covering just the
features with matching values.

Kax u3BecTHO, ecim Bbl He yKakeTe Bbixol, Oopadomka co34acT BpEMEHHBIE CJION. Bl MokeTe cpasy coxpa-

HUTD CJIOU WM COECJIATDh 3TO IMO3XKE.

CoapaHue cnyyanHbIX TOYek

¢ Cozpgaiite 100 ciyyallHBIX TOYEK B TOW MECTHOCTH, UCIIOJB3Ysl UHCTpYMeHT B Vector Creation » Random

points in layer bounds ¢ MUHUMaJIbHBIM paccTosiHueM O . 0:

6.4. 3aHsaTue: MNMpocTpaHCTBEHHasA cTaTUCTUKA
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Parameters Log

Input layer

.~ Bounding geometry [EPSG:4326] ~

NMumber of points

| 100

Minimum distance between points

0,000000

Random points

[Create temporary layer]

v Open output file after running algorithm

@Help Run as Batch Process...

degrees /I\

Random Points in Layer Bounds

Fe

Random
points in
layer bounds

This algorithm
creates a new point
layer with a given
number of random
points, all of them
within the extent of
a given layer. A
distance factor can
be specified, to
avoid poinkts being
too close to each
other.

IMpumeuanne: JKenTslil mpeaynpex AN 3HAK TOBOPUT BaM, YTO ITOT MapaMeTp OTHOCHUTCS K paccTosi-
HusiM. Cnoit Bounding geometry HaXOAUTCS B reorpapuieckoil cucreMe KOOpIUHAT U aJITOPUTM MPOCTO Ha-
MOMHHAET BaM 00 3TOM. B 3TOM mpumepe Mbl He Oy[ieM UCIOJIb30BATh ITOT MapaMeTp, MOITOMY Bbl MOKETE

€ro MPOUTHOPHPOBATb.

Ecmu Hazao, NepeMECTUTE CreHEPUPOBAHHBIC CJ'Iy‘IaIL/'IH])IC TOYKHU B BEPXHIOKO 4aCTb YCJIIOBHOI'O 0603Ha‘{eHI/IH, YTOOBI

JIyquie€ ux yBUICTb:

214
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*Untitled Project - QGIS 0

Project Edit View Layer Settings Plugins Vector Raster Database Web Mesh Progessing Help

O

EXCENS o o

R OLLLRAPPD N Q00 G ¥ . [1o000 : 5
I abe] 'I. Q »
N-B-,EE ¥ Z =60 > &
Layers @
« [l ® T | =
v ® Random points (=] =
v|[] Bounding geometry (=]
— roads
- B cckm A1 14 b
Browser (]3]
ORTTO

4 Favorites

» " spatial Bookmarks
» [¢] Home

» O/

» @ GeoPackage

» # spatialite

Q Type to locate (Ctrl+K)

Bbibopka maHHbIX

-

@ n|100% >3 |0o° % [v| Render

rdil| 20.083,34.046 | :[1:324314 |~ 4 EpSGi432e @

JI7151 co3nanusi BHIOOPOYHOro Habopa AaHHBIX U3 PacTpa, BaM HAJIO KCIIOIb30BaTh JITOPUTM Raster Analysis » Sample
raster values. DTOT IHCTPYMEHT IIPOU3BOJUT BHIOOPKY PACTpa B MECTAX PACIIOJIOKEHHUS TOUEK U I0OABJISET 3HAYCHH S
pacTpa B HOBOE IoJ1e (II0JIs1) B 3aBUCHMOCTH OT KOJIMYECTBA KaHAJIOB B pacTpe.

1. OtkpoiiTe AUanOroBoe OKHO anroputMa Sample raster values.

2. Bwibepute Random_points Kak cjoW, coepxauumil Touku BeiOopkH, U pactp SRTM kak nuanasoH, u3
KOTOPOTO HYKHO HOJIy4uTh 3HaueHHs. HazpaHue HOBOro nons no ymomauaHuio: rvalue_N, rae N - Homep
TIOJIOCH! pacTpa. Bel MokeTe M3MEHNTh Ha3BaHUE MPHUCTABKH, €CJIM XOTHTE.

6.4. 3aHsaTMe: MNpocTpaHCTBEHHAasA cTaTUCTUKA
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Sample Raster Values *

»
parameters | Log Sample raster
Input Point Layer values
©" Random points [EPSG:4326] - 2 This algorithm creates
a new vector layer
with the same
Raster Layer to sample attributes of the input
" srtm_41_19 [EPSG:32733] w||...|| |layerandthe raster
values corresponding
|w| Advanced parameters on the point location.
Output column prefix If the raster layer has
more than one band,
rvalue all the band values are
sampled.

sampled Points

[Create temporary layer]

v Open output file after running algorithm

| 0%

@Help Run as Batch Process... # Close

3. Knuknute Ha KHONIKY Run.

BbI Tenepb cMoskeTe IPOBEPUTH BRIOOPOUHbIE JaHHBIE U3 PacTpOBOro dhaiia B Tabiuie aTpuOyToB ciiosi Sampled
Points. OHHU MOSBATCS B HOBOM HOJIE C HA3BaHHUEM, KOTOPOE BbI BHIOPAIIH.

Bo3MoXxHBIH 06paseu CJIOA ITOKa3aH 3/1€Ch.

216 Mnaesa 6. Mopaynb: BekTopHbI aHanu3



QGIS Training Manual

BriG0poUHbIE TOUKK KJIACCU(PUIIPYIOTCS C MCTIOIb30BAHUEM TMOJIs1 rvalue_ 1 Tak, YTOObI KPACHBIE TOUKH HAXO-
IIAIACH Ha OOJIBIIEN BBICOTE.

Be1 Oyziere UCIIO/Ib30BaTh STOT CJIOH U1 OCTAJIBHBIX CTATUCTUYECKUX YIPaKHEHUH.

6.4.2 \ Npnem panblwe: Ba3zoBasa cratuctuka
BaM Tenepb Haa10 HOJ‘Iy‘II/ITL 6a30By10 CTaTI/ICTI/IKy JJI 9TOro CJIOsI.

1. Kiuknu Ha 3Ha40k TTokasaTh CTaTUCTKY E Show statistical summary g Asrjbytes Toolbar. TlosBUTCA HOBAsA MaHEb.
2. B nosiBUBIIEMCS IMATOrOBOM OKHE YKa)uTe clloit Sampled Points B KauecTBe HCTOYHHKA.
P

3. BoibGepure none rvalue_I B 1osie co CIIUCKOM MoJiei. DTO Moie, AJisi KOTOPOTo Bbl Oy/IeTe pacCUMTHIBATD CTa-
THCTHUKY.

4. Tlanens Statistics aBTOMaTU4eCK OOHOBHUTCS C PAaCUETHBIMU CTaTIaHHBIMHU:
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Statistics (&) (]
. sampled Points v |

1.2 rvalue_1 v | |E|

Statistic Value

Count 100

sum 14148

Mean 141.48

Median 122.5

st dev (pop) 89.4792

st dev (sample) 89.93

Minimum 18

Maximum 737

Range 719

Minority 18

Majorikty 120

Variety 78

Q1 97

Q3 163.5

IQR 66.5

Missing (null) values 0

Selected featuresonly 7 &2

| Statistics | Layers

|

W g

Browser

| Q Type to locate (Ctrl+K)

218
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Copy Statistics To Clipboard

HpnMeanne: Brl Mmoxere CKOIMUPOBATh 3HAYCHU S, HA’)KaB Ha KHOIIKY " BCTaBUB

Ppe3yJIbTaThl B TAOIHILY.

5. 3akpoiite naHenb Statistics KOTAa 3aKOHYUTE.
[MosiBsITCSI MHOTO KOMAH]I, CBA3aHHBIX CO CTATUCTHUKOI:
Count/Cuntars KomrmyectBo BHIOOPOK /3HAYEHUIA.
Sum/Cymma CrnoxeHrie 3HaYeHUT.

Mean/Cpennee 3nauenne CpepHee (CpefiHee) 3HAUECHUE - TO MPOCTO CyMMa 3HAYEHHUIL, pasfieJieHHasl Ha KOJIU-
YeCTBO 3HAYEHHUI.

Median/Meaunana Eciu Bbl pacrionioxkuTe Bce 3HAYSHHsI OT HAMMEHbIIIETrO K HauOoJIbIlieMy, 3HAUYeHHE B Cepe/IiHe
(um cpejiHee U3 IBYX CpPeIHMX 3HaueHuM, eciiv N - yeTHoe 4ucio) Oy/ieT MeAMaHHbIM 3HAUEHHUEM.

St Dev (pop)/CrangapTHoe oTKJIOHeHHe CTaHAapTHOE OTKJIOHEHHEe. YKa3blBaeT, HACKOJIbKO OJIM3KO 3HAYCHUS
CTPYIIUPOBAHBI BOKPYT CpeiHero. Yem MeHbIlle CTaHIaPTHOE OTKJIOHEHHUE, TeM OJIHKE 3HAYEHHSI K CPETHEMY.

Minimum/MuanmMym MuHNMaTbHOE 3HAYCHUE.

Maximum/Makcumym MakcumasabHOE 3HaUSHUE.

Range//Ilnanazon Pa3nuiia Mex1y MUHUMaIbHBIM U MAKCUMAJIbHBIM 3HAUEHUSIMHU.
Q1 TIlepsblii KBapTUIH TAaHHBIX.

Q3 Tpernit KBapTHIb JaHHBIX.

Missing (null) values/IIponymiennsie (HyJeBble) 3HaueHus1 KoimuecTBo MpoIyIeHHbIX 3HAYEHHH.

6.4.3 \ Npem panblue: Boluucngem ctratuctuyeckme gaHHble OTHOCUTE b~
HO PacCTOSAHUN MeXAy ToYKamu

1. CozpaiiTe HOBbII BPEMEHHbII TOUEUHBIN CJION.
2. 3aiiguTe B peXXrM pelaKTHPOBAHUS U OIU(MPYHTE TPHU TOUKH TIe-HUOYAb Cpequ IPYTUX TOUCK.

B kauectBe AJIbTEPHATUBBI BbI MOXKETE HUCIIOJIB30BATh TOT K€ METOA T€HEpaAlluU C.Hy‘laﬁHbIX TOYEK, KaK paHEe
MbI I€J1aJIM, HO Ha10 YKa3aTb TOJILKO TPH TOYKH.

3. CoxpaHHTe Balll HOBBIII CJION Kak distance_points B TOM (popMate, K KOTOPOM BaM XO4eTcsl.
YTOOBI MOTYYUTh CTATHCTHKY PACCTOSHUI MEky TOUKaMH B IBYX CJIOSIX HEOOXOAMMO CHeJIaTh cleayoiee:
1. Otkpoiite uactpyment Vector Analysis » Distance matrix.

2. BuiGepurte cioit distance_points B KauyecTBe BXOJHOIO CJIOs, a ciod Sampled Points - B KauecTse
EJIEBOTO CJIOSI.

3. Cnenmaite 3TO Tak:
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Distance Matrix

Parameters | Log Distance matrix
T s o0 This algorithm creates a table
Distance Points [EPS5G:4326] || . ||D containing a distance matrix, with
distances between all the pointsin a
points layer.

Input unigue 1D field
123 id -
Target point layer
Sampled Points [EP5G:4326] (.|| D

Target unique ID field

123 id -
Output matrix type

Summary distance matrix {mean, std. dev., min, max) -
Use only the nearest (k) target points
[2] a |;

Distance matrix

v Open output file after running algorithm

| 0%

&2 he un as Batc rocess... ase un
@|Help R Batch P % Cl @R

4. Eciu xoTuTe, BBl MOXETE COXPAHUTh BBIXOJHOM CJIOHM Kak (paiyr Wi MPOCTO MOXKETe 3aIyCTUTh AJITOPUTM H
COXPaHUTh BPEMEHHbIN BBIXOAHOM CJIOH MO3Ke.

5. KimkHuTe Ha KHONKY Run 4TOOBI ITOJYUUTh CJION MaTpUIIbl PACCTOSTHHM.

6. Otkpoiite TabuIly ¢ aTpUOyTAMHU CTEHEPUPOBAHHOTO CIIOST: 3HAUEHUS OTHOCSITCS K PACCTOSTHUSIM MEKy 00b-
eKTamu distance_points M X qByMsl OJIMKAWIIUMU TOYKaMu B ciioe Sampled Points:

] Distance matrix :: Features Total: 3, Filtered: 3, Selected: 0 - o x
/) 2B R BT e & s VT E &P B E e
InputiD MEAN STDDEW MIN MAX
1 1 401.87013 235.74757 166.12256 637.61770
2 2 653.19728 229.72430 423.47299 882.92158
3 0 1005.87036 296.03133 709.83903 1301.90169

T Show All Features _ = |

C NOMOULIBIO TUX [MAPAMETPOB MHCTPYMEHT Mampuua paccmo;muﬁ pacCcunTaCT CTATUCTUKY paCCTOS{HI/Iﬁ JJIA Ka)K,[IOﬁ
TOYKHU BXOIOHOIO CJIOA ITO OTHOIICHHUIO K OIIMKANIIAM TOYKAM nesieBoro ciost. Ilomsa BBIXOJHOI'O CJIOA coAepkat
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Cpe€aHEE 3HAUYCHNE, CTAHJAPTHOE OTKJIOHEHNE, MUHNMAJIbHBIE I MAKCUMAJIBHBIE 3HAUYEHN A B OTHOLIEHUN paCCTOHHI/Iﬁ
J0 1V %:171111704 COCCOHUX TOYEK BXOJHOIO CJIOA.

6.4.4 \ Mpem panbwie: AHanu3 MeToaoM «6nuxanwmm cocepn» (BHYTpU
cnos)

YUToObI BHIIIOJIHUTH aHATIM3 METOJIOM «OJIVKAUIINI COCe/» TOUSUHOTO CJIOsI, HEOOXOIUMO CIeaTh CleIylolee:
1. Bwibepure Vector analysis » Nearest neighbor analysis.
2. B nosiBuUBIIIEMCS JUAJIOTOBOM OKHe BbiOepuTe ciioil Random points v KIIMKHUTE Run.

3. Pesynbratsl nosiBsAtcs B nanen «O6padotka» Result Viewer.

Processing Toolbox ®
ﬁ;r q "1- I-:;I 3 ¥ -_t;}
() Recently used =

() Database
() File Fanls i

Results Viewer E3

" Mearest neighbour [04:51:51]

b
» (2 Cartography
b
b

Algorithm: Nearest neighbour =
File path: /tmp/processing MXcuYE/
6aa2320aecdf41d4adbesed45440f23
be/OUTPUT HTML FILE.html -

4. KIMKHUTE CHHIOIO CCHUIKY, YTOOBI OTKPBITh CTPaHUIly html C pe3ysbTaTamMu:
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Mozilla Firefox

Jtmp/processing MXcuYE/« X

=
|

G | @ File:///tmp/processing MXcu' =+ X =

Observed mean distance: 1408.03338044153
Expected mean distance: 0.01577808561
Nearest neighbour index: 89239.81118148957
Number of points: 100

Z-Score: 1707201.00974689284

6.4.5 \ Npem panblie: CpeaHue KoopavHarhbl

Jns Toro, 4ToOBI HOMYYUTh CpeIHUE KOOPAUHATH HAOOpa JaHHBIX HEOOXOAUMO CIENATh CIIeyolIee:
1. 3anycrure Vector analysis w Mean coordinate(s).

2. B mnosiBUBIIIEMCs IMAJIOTOBOM OKHE YKaxute Random points Kak Input layer, u ocTaBbTe HeoOsi3aTelIbHbIC
BapUaHThl 03 U3MEHEHUIA.

3. Knuknute Ha KHOTIKY Run.

JlaBaiite CpaBHUM 3TO C LIEHTPAIBLHON KOOPIMHATOM MOJUTOHA, KOTOPBII OB HCIIONIB30BAH JUTS CO3aHMSI CITyYalHON
BBIOOPKU.

1. 3anycrure Vector geometry » Centroids.
2. B nosiBuBIIIEMCS JMATIOTOBOM OKHe BhiOepHTe Bounding geometry B Ka4eCTBE BXOJHOIO CJIOSI.

Kak BuauTe, cpeiHre KOOPAMHATHI (PO30BAst TOUYKA) U LIEHTP MCCIIEAyeMO MECTHOCTH (3eJIeHbI) He 00s3aTeIbHO
COBITAJAIOT.

Llentpoun - 310 GapuLeHTp cios (0apuLIeHTp KBafpaTa - 3TO LIEHTP KBajpara), a CpeAHUEe KOOPIUHATHI IPE/ICTaB-
JISIIOT COOOM CpefiHee 3HaYeHNEe BCeX KOOPANHAT Y3JIOB.
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*Untitled Project - QGIS 0

Project Edit View Layer Settings Plugins Vector Raster Database Web Mesh Processing Help
M () HE @ 5.3 ﬂ‘) )9 ;:: g: ;: }a I3 t M & S ::3:' “."_[1,00000 + degrees ~ 7 -
Q, H-B-,EE % I = ©

Layers (=]
@ vaswva-aan
» Sampled Points (=]
VS ® Random points (=]
' v e Centroids =]
&l ®  Mean coordinates [3]]
gg v [_] Bounding geometry =)
— roads
Yo | = [ W srtm_a1_19
Al ™
[+] 1548
M — vector_analysis roads_34S
@, -
&~
AVARS
&
Browser

¥ Layers
Coordinate| 20.1914,33.9933 | Scale 1:159115 = | @ Magnifier| 100% - Rotation 00° < V| Render ¢ EPSG4326

Q Type to locate (Cerl+K)

6.4.6 \ Npem panblie: N’Mcrorpammbl n3obpaxeHumn

I'ucrorpaMma Habopa JaHHBIX MOKa3bIBAeT pacrpeesieH e ero 3HaueHuid. CaMblil MPOCTOM CIOCO0 MOKa3aTh 3TO B
QGIS - yepe3 UcnoIBL30BaHKUE TUCTOrPAMMBI M300pakeHMs1, KOTOPasi UMEETCs B AIMAJIOTOBOM OKHe Layer Properties

mo0oro ciost n300pakeHus (HaOOp PacTPOBBIX JaHHBIX).

1. B Bameit manenu Layers KJIMKHATE MpaBOi KHOMKOM MBI HA coi srtm_41_19.

2. Bwibepure Properties.

3. Bwibepure Histogram. Bam Hano KIMKHYTh Ha KHONIKY Compute Histogram 1jist TOro, 94to0bl co31aTh rpacuk.
Bel yBunuTe rpacdhuk, MoKa3pIBAIIMN YACTOTHOE pacipe/ie/icHue 3HAYSHUIA pacTpa.
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Layer Properties - srtm_41_19 | Histogram

Information Raster Histogram
¥ Source 6000 g
%" symbology 5000 ]
Transparency ]
. 4000 -

{*~ Histogram =
> ]
0] : ]
Rendering 8 1000 -
c -
. @ T
Pyramids r -
2000
Metadata ]
Legend 1000 -
QGIS Server 1
n _' _J_,...--—-—w-..,_“_ L.

0 200 400 600 800 1000 1200 1400
Pixel Value
® Band 1
& PrefsfActions. [ |
Set min/max style For Band 1 -
Min 0 EW
Max 1548 EW
©Help Style - « Apply || % Cancel  OK

=]
4. T'papvk MOKHO IKCTIOPTHPOBATH KaK N300pakeHUe C TOMOLIBIO KHOIKH C Save plot |

5. Boree noapoGHy0 HHPOPMAIIMIO MOXKHO MONTYIUTh O CIIOE HAKAB HA BKIAAKY Information (cpenHee U Mak-
CUMAJIbHOE 3HAUEHUS SIBIIAIOTCS PACYETHBIMU M MOTYT OBITh HETOUHBIMH).

Cpennee 3Hauenue 332 .8 (pacuetHas 324,3), a MakcMMajbHOE 3HaUeHHWe paBHO 1699 (pacyerHas 1548)! Bul
MOXeTe yBEJIMUUTh ructorpaMmy. [1ocKosIbKy TaM MHOIO MHKCesel co 3HadeHueM O, TUCTOrpaMMa BBIIISIIUT CKa-
TOH 10 BEPTUKAIH. YBeaU4ybTe MacuTad 4ToObl OXBATHTh BCE, KpOMe MMKa Ha O, ¥ BBl YBUAUTE OoJiee MOAPOOHYIO
nH(POPMALUIO:
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Layer Properties - srtm_41_19 | Histogram x

G’ Information

Raster Histogram

A% source .

% symbology 150 -

I8 Transparency i

{*~. Histogram - i
2 100
7 ) (<
4 Rendering g
o
B8 Pyramids E

m Metadata

Legend

QGIS Server

200 400 600 800 1000 1200 1400

Pixel Value
® Band 1
@ prefs/Actions., H
Set min/max style for Band 1 -
Min 1 &
Max 1548 EW
©@Help Style ~ « Apply | % Cancel & OK

Ipumeuanne: Ecnu cpeqHue u MaKCUMaJTbHbIE 3HAUECHHsSI HE TAKKe, KaK BBIIIIE, 9TO MOKET OBITh U3-3a BHIUUCIICHUS
MUHUMAaJIbHOr0/MakcUMasbHOTO 3HaYeHus. OTkpouTe BKiaaky Symbology u pacumpbre menio Min / Max Value

Settings. Buibepute ® ' Min / max v xmakHuTe Ha KHOTIKY Apply.

ITomHuTE, YTO TMCTOrpaMMa IOKa3bIBAET BaM paclipe/ie/ieHre 3HaYeHUH 1 He Bce 3HaYeHHs! 00s13aTeNbHO JOJIKHBI
oToOpaxarbcst Ha rpacuke.
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6.4.7 \ NUnem panbuie: NpocTpaHcTBeHHas UHTepnonsauus

[Tpeamnosoxum, 94To y Bac HaOOp TOUYEK BHIOOPKH, Ha 6aze KOTOPOro Bbl XOTUTE SKCTPAIIOIMPOBATh JaHHbIe. Hanpu-
Mep, y Bac MOXKeT ObITh HOCTYI K HaOOpy JaHHBIX Sampled points, KOTOPBIA Mbl CO3QIM paHee, U Bbl XOTEIH Obl
HUMETh HEKOTOPOE MPE/ICTABICHUE O TOM, KaK BBIIVISIIUT MECTHOCTb.

1. Jlna Havana BaM HaJIO 3allyCTUTh UHCTpYMeHT GDAL w Raster analysis »- Grid (IDW with nearest neighbor
searching), KoTopblil Haxonutcsl B Processing Toolbox.

B kauectBe Point layer BoiOepute Sampled points.
Ycranosute Weighting power Ha 5 . 0.
Buytpu Advanced parameters, ycranosute Z value from field na rvalue_1.

U HakoHel, KJIMKHUTE HA KHOMKY Run U MOJ0XK/IUTe 10 OKOHYAHHUsT 00pabOTKH.

A

3akpoiiTe AUaJIOroBoe OKHO.

Bol cmoxere CpaBHUTDH I/ICXOJIHHﬁ Ha60p JAaHHBIX (CJ'ICBa) C TEM, KOTOpri/JI OBLT MOCTPOCH Ha 0a3e HaIIMX TOYEK
BbI60pKI/I (cnpaBa). Bam Ha60p JAaHHBIX MOJKET BBIIVIAACTL MHAYC U3-3a cnyqaﬁﬁoro PacIioJIOKEHUA TOUCK.

Kak Bbl Moxete BuAeTh, 100 BEIOOPOUYHBIX TOYEK HEZOCTATOYHO, YTOOBI MMOJYUUTh MOAPOOHOE MPEACTABICHUE O
MECTHOCTH. BBl IoJTyunTe TOJIBKO OYeHb 00IIee Tpe/ICTaB/IeHHe, HO OHO MOXKET BBOAUTD B 3a0)TyKICHHUE.

6.4.8 / Monpobynte camu: PaannuyHble MeToabl UHTEPNONALUN

1. CrnepyiiTe onmMcaHHOMY BbIllie TIPOIIECCY JUIst TOTO, YTOOBI co3aaTh Habop u3 10 000 ciryyaliHBIX TOYEK.

IIpnmeuyanne: Eciu Touek NEHCTBUTENILHO MHOTO, 00pabOTKa MOKET 3aHSTh MHOTO BPEMEHU.

2. Hcnone3yiiTe 3T TOYKHU [T TOTO ClieaTh BBIOOPKY rcxoaHoit DEM / Iudposoit Mogenu peibeda.
3. Ucnonb3yiite uncrpyment Grid (IDW with nearest neighbor searching) B 3ToM Habope TaHHBIX.
4. YcranoBure Power u Smoothing Ha 5.0 u 2 . 0, COOTBETCTBEHHO.

Pe3ynbraThl (B 3aBUCUMOCTH OT PACIIOJIOKEHUS BAlMX CIyJalHbIX TOUEK) OyayT IPUMEPHO TAKUMHU:
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Sr0 Gosiee yIIydllIeHHOE Mpe/iCTaBIeH e JaHamadTa, Tak Kak IUIOTHOCTh BIOOPOYHBIX TOUEK Bhille. [IoMHuTE, UTO
YyeM O0JIbIe BRIOOPKA, TEM JIydllle pe3ybTar.

6.4.9 B 3aknouyeHumn

Y QGIS ecTb psig MHCTPYMEHTOB /IS aHAJIM3A IIPOCTPAHCTBEHHBIX CTATHCTHYECKUX CBOIMCTB HAOOpa JaHHBIX.

6.4.10 Yto panbwe?

Tenepp, NOC/Ie TOrO Kak Mbl PACCMOTpEJIM BEKTOPHBIN aHAIM3, TIodyeMy Obl He TIOCMOTPETh, YTO MOKHO CHEJIATh C
pacTpamu? DTUM MBI ¥ 3aiMeMCs B CIEAYIOIEM MOIyie!
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rNABA /

Moaynb: PacTtpbl

M5 paHbIIle HCTIOJIB30BAU PACTPHI T ONIU(POBKH, HO pACTPOBBIE JaHHBIE MOXHO TAKXe UCIIOh30BaTh HAMIPSMYIO.
Bul y3Haete kak 310 genaercs B QGIS B aTom MonyJe.

7.1 3aHsaTne: PaboTta ¢ pacTpoBbIMU OaHHbIMU

PacTpoBble faHHBIE CYITIECTBEHHO OTJIMYAIOTCS OT BEKTOPHBIX JAHHBIX. BEKTOpHBIE JaHHBIE IMEIOT AUCKPETHBIE Xa-
PaKTEPUCTHKY C TEOMETPUEN, KOTOPBIE IIOCTPOEHBI U3 BEPILIUH U, CKOPEE BCETO, CBSI3aHbI C JINHUSAMHU U/WII MECTHO-
cramu. Tem He MeHee pacTpOBbIe JaHHbIE IOXO0XKU Ha Mo0oe n300pakeHue. X0Tsl OHU MOTYT OTOOpaxaTh pa3InyHble
CBOICTBa OOBEKTOB B PEAJIbHOM MHpE, 3TH OOBEKTHI HE CYILECTBYIOT KaK OT/JEJIbHbIe OOBEKTHI, a MPEACTABIIEHBI C
TIOMOIIBIO TIMKCEJIEH C Pa3HBIMU 3HAYCHUSMH.

B atom Mopysne BBl OyieTe HCIOJIb30BaTh PACTPOBBIE JaHHBIE KaK JOIOJHEHNE K cyliecTByomemMy anamzy GIS.

eaw 3TOr0 Ypoka: Hayuutbcs pabotaTs ¢ pacTpoBeiMU AaHHbIMEU B QGIS.

711 \ Unem panblie: 3arpyxaem pacTpoBbie AaHHble
PacTpoBbie JaHHBIE MOXHO 3arpy3UTh, HCTIONB3YSI TE K€ METO/IBI, KOTOPBIE Mbl HCTIOB30BAIH 1JIs1 BEKTOPHBIX JIaH-
HbIX. TeM He MeHee NpeIaraeTcs UCIoIb30BaTh NaHe b Browser.
1. OtkpoiiTe maHenb Browser M paclMpbTe MaNKy exercise_data/raster.
2. 3arpysure Bce JaHHbBIE B 3Ty MAIKY:
¢ 3320C_2010_314_RGB_LATLNG.tif
¢ 3320D_2010_315_RGB_LATLNG.tif
e 3420B_2010_328_RGB_LATLNG.tif
e 3420C_2010_327_RGB_LATLNG.tif

BbI yBUHTE Crieayolyio KapTy:
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*Untitled Project - QGIS X

Project Edit View Layer Settings Plugins Vector Raster Database Web Mesh Progessing Help

DEEmRY QLL2LRI PP LA (L EDRZ Q¥ [0 : >
Q »
e w8 #* 2 =L))o » G
Layers @6
@ vasvy 3L
- 3320C_2010 314 RGB_LATLNG|
V; v ¥ 3320D_2010_315_RGB_LATLNG
' v! ¥ 3420B_2010_328_RGB_LATLNG
[+] v| " 3420C_2010_327_RGB_LATLNG
0
%
Va
¥ Layers = Browser
Q, Type to locate (Ctrl+K) 1 203412340054 |9 = 1:98281 ~ | @ r|100% =2 [00° < |V Render & EPsG4326 @

Bor u Bce - YETbIPE aSpO(l)OTOCHI/IMKa MECTHOCTHU, KOTOPYIO MbI 6yneM n3y4arb.

7.1.2 Upem panbuwe: Co3paeM BUpPTyarnbHbIW pacTp

Kak BbI BUsIMTE TETiepb, BALII CJIOW PACTIONIOKHUIICS HA BCEX YEThIpeX N300paXeHUsIX. 3HAUUT BaM BCE BPeMsI ITPUJIETCSI
paboTath ¢ YeThIpbMsl pacTpamu. TO KOHEUHO He WJIeaIbHbIN BapuaHT. Bbito Obl XOpoIIo paboTarh JIUIIb C OJHUM
aitiom.

K cuacteio, QGIS jaet BaM BO3MOXHOCTb CI€JIaTh MMEHHO 3T0, 63 HEOOXOAMMOCTH CO3/IaBaTh HOBBIA PACTPOBBIM
(baitn. Bel MOXkeTe co30aTh BUPTYAJIbHBIH PACTP, KOTOPBIH TAK)KE YaCTO HA3BIBAIOT KAMAA0ZOM, YTO U OODBSICHSI-
eT ero (byHKIMIO. DTO HE COBCEM HOBBIM PaCTp, a COCOO OPraHU3allMK BaIllMX CYLIECTBYIOIUX PACTPOB B OJHOM
KaTajore: oJuH (ain i obJaerdyeHust J0CTyra.

It co3panusi Katajiora Mbl UCNOJNb3YeT Processing » Toolbox.
1. Otkpoiite anroput™ Build virtual raster u3 GDAL w» Raster miscellaneous;

2. B nosiBUBIIEMCsI IMAJIOTOBOM OKHE KJIMKHUTE Ha KHOIIKY ... PSIOM C rapaMeTpoM Input layers v mpoBepbTe
BCE CJIOW WM UCTIONB3YiTe KHOTIKY Select All;

3. Cummure naxok ¢ Place each input file into a separate band. O6patvite BHUMaHHe Ha TEKCTOBOE TOJIE HIKE.
DTO IMAJIOTOBOE OKHO HAa CaMOM JieJie MUILET 3TOT TEKCT 3a Bac. DTO JIMHHAsA KoMmaHza, kotopyio QGIS
coOupaeTcs 3aIyCTUTh.

IIpumeuanue: [ToMHuUTE, YTO BBl CMOKETE CKOIMPOBATh U BCTABUTb TEKCT B O0SGeo Shell (Moab30BaTelb
Windows) wmi Terminal (momb3oBaTens Linux u OSX) mns toro, 4toObI 3ayCcTUTh KOMaHIY. BbI Takxke
MOJXKeETe CO3JaTh 3alpoc 1is Kaxa0i koMaHapi GDAL. D710 oueHb yI0OHO B TeX CilydasiX, KOIJa Mporeaypa
3aHMMAaeT MHOTO BPEMEHH WU KOT/Ia BBl XOTHUTE 3aIUIAHMPOBATh ONpeiesIeHHbIe 3a1a4ull. VIcrosb3yiiTe KHONKY
Help nuist Toro, 4To0bl OJIYYUTh JOTOJHUTENBHYIO CIIPABKY MO CHHTAKCHUCY KOMaH/IBI.

4. U xIuKHUTE Ha KHONIKY Run.

IIpumeuanne: Kak n3BeCTHO U3 IpeIbIAYIIUX MOAYJEH, Processing cO3MaeT BpeMEHHBIE CIOU IO YMOTYAHHIO.
YtoObl COXpaHUTH (haiisl, KIMKHUTE HA KHOIIKY ....
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Build Virtual Raster X

Parameters | Log

Input layers E

Resolution
Average
v Place each input file into a separate band

Allow projection difference

v Advanced parameters

Add alpha mask band to VRT when source raster has none

Override projection for the output file [optional]

Resampling algorithm
Nearest Neighbour -

Nodata value(s) For input bands (space separated) [optional]

Additional command-line parameters [optional]

Virtual
[Save to temporary File]
v Open output file after running algorithm

GDAL/OGR console call

gdalbuildvrt -resolution average -separate -r nearest -input_File_list /tmp/
processing_waXvap/9e7966068f424564a9ca71decadc15F9/buildvrtinputFiles.txt /
tmp/processing waXvap/219f32d6606644108251F5ad770a7945/0OUTPUT.vrt -

| 0%

@Help Run as Batch Process... % Close «/ Run

Tenepb Bbl MOXeTe yOpaTh YeThIpe HCXOAHBIX PacTpa U3 MaHeau Layers U OCTaBUTh TOJILKO BBIXOJAHOM PacTp BUPTY-
aJIbHOTO KaTajora.
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713 am= [Ipeobpa3oBaHMe pacTpOBbIX AaHHbIX

MerTozipl, YIIOMSIHYTHIE B BbIIIE, TIO3BOJIAT BUPTYAIbHO OOBEAUHST HAOOPHI JaHHBIX C MOMOLIBIO KaTaJIora U nepe-
NPOELPOBaTh UX «Ha JIeTy». TeM He MeHee, e/ Bbl HACTpauBaeTe NAaHHbIE, KOTOPble COOMpaeTech UCTIOb30BATh
HaJI0JITO, BaM JIy4llle CO3/IaTh HOBBIE PACTpPhl, KOTOPbIE Yke 0ObEUHEHbI U Tepe-ITPOSIMPOBaHbI, HO [Isl IEPBOHA-
YaJbHOM HACTPOWKM MOKET IOTPeOOBaThCSl HEKOTOPOE BpeMsl.

Mepe-npoeuunpoBaHue pacTpoB

Hapno otkpeite Warp (reproject) B8 GDAL w Raster projections.

BpI Takke MoskeTe nepe-npoenpoBaTh BUPTyalbHBIE PACTPHI (KaTaJorH), aKTHBUPOBATh MHOTOIIOTOYHYIO 00paboT-
Ky ¥ MHOTOE JIpyTOE.
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Warp (Reproject) o

Parameters Log

Input layer
" Virtual [EPSG:4326] -
Source CRS [optional]

Target CRS [optional]

Project CRS: EPSG:4326 - WGS 84 v ||
Resampling method to use

Nearest Neighbour -
Nodata value for output bands [optional]

Not set -
Output file resolution in target georeferenced units [optional]

Not set -

P Advanced parameters
Reprojected

[Save to temporary file]
¥ Open output File after running algorithm
GDAL/OGR console call

gdalwarp -t_srs EPSG:4326 -r near -of GTiff /tmp/
processing E3t0r2/4d43521175294d8a8F7935de8c0d5¢ca3/OUTPUT.vrt /tmp/
processing_E3t0r2/cf35Ff6625870499798aa2930475ab4b1/OUTPUT.LIF

| 0%
©@Help Run as Batch Process... % Close «' Run

O6bepunHeHUe pacTpoB

Ecnau Bam Hago co3aTh HOBBIM paCTPOBBINA CIIOM M COXPAHHUTh €r0 Ha AWCKE, BBl MOXETE FCHOJIB30BATh AJITOPUTM
CIIASTHAA.

IIpumeuyanne: B 3aBUCHMOCTH OT TOTO, CKOJIBKO PacCTPOBBIX (PaiiyioB Bbl OObEJUHSIETE M KAKKE Y HUX pa3pelleHHus],
HOBBII pacTpOBBIN (haiisl, KOTOPBIA BBl CO3/aHUTE, MOXKET ObITh JIOBOJIBHO OOJIBIIOrO pa3Mepa. Bam syumie BMecTo
3TOTO CO3/1ATh KATaJIor pacTpa, KaK OMKCaHo B pazaeie Cozdamb eupmyansvhbviii pacmp .

1. Bam Hapo kiMKHYTH Ha anroputM CimtbO0beHuTh Merge B MeHio GDAL w Raster miscellaneous.
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2. Kak u B ciiyvae ¢ Cozdanuem UpmyansHozo pacmpd, ACTIONb3yHTe KHOIIKY ... U151 TOTO, YTOObI BHIOPATh, KAaKUe
CJIOU BBl XOTUTE OOBEIUHUTD.

BbI Takke MOXeTe yKa3aTh BUPTYaIbHbIA PACTpP B KAUECTBE BXOAHbIX JAHHBIX, M TO/IA BCE PACTPBI, U3 KOTOPBIX
OH COCTOUT, Oy/yT 00pabOTAHBL.

3. Ecnu Bbl 3Haete 6ubmoreky GDAL, Bbl Takke MOXeTe JOOaBUTh CBOM COOCTBEHHbIE OIIIUK, OTKPHIB MEHIO
Advanced parameters.

Parameters Log

Input layers

Grab pseudocolor table from First layer
Place each input file into a separate band
Output data type
Float32 -

b Advanced parameters
Merged

[Save to temporary file]
v Open output file after running algorithm
GDAL/OGR console call

gdal _merge.py -ot Float32 -of GTiff -o /tmp/

processing E3t0r2/517F150854b344bc9f4588a6e9884e32/OUTPUT.LIf --optfile
Jemp/processing E3t0r2/44e87c4b7bdf44533a9552e0d6695F3b/
mergelnputFiles.txt

| 0%

©@Help Run as Batch Process... # Close «/ Run
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7.1.4 B 3aknouyeHumn

QGIS obuieruaer BKIIIOUEHUE PACTPOBBIX JAHHBIX B BalllM CYLIECTBYIOIIME TPOEKTHI.

7.1.5 Yro panblue?

I[anee MBI co614paeMc5{ HCTIOJIb30BATh PACTPOBBLIC JAHHBIE, KOTOPbIC HE ABJIAIOTCA aSpO(bOTOCHI/IMKaMI/I, YTOOHI YBU-
J€Th, KaK CUMBOJIBI MOT'yT OBITh TIOJIE3HBIMU U B cJiydgae ¢ paCTpaMu.

7.2 Wpem panblue: UameHeHsieM CUMBOJIUKY pacTpOBOro Cnos

He Bce pactpoBble JaHHBIE SBIAAIOTCS a3pOOTOCHUMKAMH. EcTh MHOTO Apyrux ¢opM pacTpOBBIX AAaHHBIX, U BO
MHOTHX TaKHX CJIy4asix HEOOXOAMMO 0O03HAYNTh X CUMBOJIAMH, YTOOBI X MOKHO OBUIO IOTOM COOTBETCTBYIOIIUM
00pa3oM BUJIETh U UCTIOJIB30BATb.

HeJIL 9TOro ypoka: H3MeHeHne CHMBOJIOB JJIs1 paCTpOBOI'O CJI0A

7.2.1 \ Monpobyite camu

1. Ucnone3yiite mnaHens Browser pna 3arpy3ku srtm_41_ 19.tif, KOTOpBII HAaXOAUTCA BHYTPU
exercise_data/raster/SRTM/.

2. VBenuubTe MacHITad 3TOro CJI0si, KJIMKHYB Ha HEro MpaBoil KHOMKOUM MbIH B Layers panel n BoiOpaB Zoom
to Layer.

1ot HAGOP JAHHBIX MpeacTaBisieT coool Lugbposyro Modenw Peavepa (LIMP) / Digital Elevation Model (DEM). 910
KapTa BO3BBIIIICHHOCTH (BBICOTA) MECTHOCTH, KOTOPast IO3BOJISICT HAM, K IPUMEpY, YBUCTb, I HAXOIATCS TOPHI U
JIOJIUHBI.

B 1O BpeMst Kak Kak[Iblii IMUKCeJIb HaOopa AaHHBIX MPEBIIYIIEero pasjesia Coiepxkall cBeleHus o 1Bere, B [[PM,
Ka)K,Z[bIﬁ ITUKCECJIb conepmm 3HAYCHU S BBICOTHI.

Kax 3arpysku LIMP BbI 3ameTHTe, 4TO KapTHHA NPEJCTABIAETCS B OTTEHKAX CEPOro:
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QGIS aBTOMaTHYeCKH pacTsIHYJI 3HAUYEHUsI ITUKCellel N300paXeHus 11 1iesel Busyanusauuu. Mel 60Jiee noipoOHO
M3YYMM Kak 3T0 paboTaeT, o Mepe MPOIBIKEHUST IAJIbIIIE.

7.2.2 \ Upnem panbuie: MeHsieM CUMBOJIUKY pacTPOBOro CNnos

Ectp 1Ba cioco6a M3MeHeH!sI CHMBOJIOB pacTpa:
1. Buytpu gmanoroBoro okHa Layer Properties - KIMKHYB MPaBO KHOIKOM MBIIIM Ha BHYTPH ApEBa CJIOEB U

BBIOpaB omiuio Properties. 3ateM Hal0 MEPEKIIOYUTHCS Ha BKIAAKY Symbology.

r
2. HaJlo KIMKHYTh Ha KHOTIKY d Open the Layer Styling pancl o gy gayt manestsio Layers (apabik F 7). Takum o6pa-
r

30M OTKpoeTcs maHenb Layer Styling, rrie BBl MOXeTe MEPeKITIOUYNTHCS Ha BKIIAJIKY Symbology

Bribepute MeTo/1, KOTOPBIM BbI 3aXOTHTE UCIHIOJIb30BATh.
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7.2.3 \ WUnem panbwe: OgHononocHas cepas

3arpykeHHbII pacTpoBbIid (haii He sABisteTcs: (POTOM300paKEHUEM MOJOOHO TeM, KOTOpbie ObUTH B MPEABIIYIIEM
pazzene. [To yMoJI9aHMIO 3TO IPaiMeHT B OTTEHKAX Ceporo.

JIaBaﬁTe N3Yy4YUM HEKOTOPBIC 0COOEHHOCTH JAHHOTO CPECTBA BU3YyaJIU3allin.

Layer Properties - srtm_41_19 | Symbology

v Band Rendering

f';i Information

Render type Singleband gray -
{ﬁ. Source Gray band Band 1 (Gray) -
@f Ssymbology Color gradient | Black to white -
l_ﬂ Transparency Min |0 Max 1548
= Histogram grt:ll;.;;isetment Stretch to MinMax -
G/ Rendering ¥ Min [ Max Value Settings
M Pyramids User defined
‘ Metadata E&T\i?ﬁ?e 20 [5/-[980 -/%
Legend ®' Min / max
QGIS Server ::::E;rfd_ deviation x 200 |
Statistics extent Whole raster -
Accuracy Estimate (Faster) -

w Color Rendering

Blending mode | Normal -  Reset
Brightness —F 0 = [Cnntrast —F 0 =
Saturation e— | 0 > [Grayscale Off -
Hue Colorize Strength il

¥ Resampling

Zoomed: in | Nearest neighbour = | out | Nearest neighbour -  Owersampling 2,00 =
Thumbnail Legend Palette
@Help Style - </ Apply || % cancel  OK

Mo ymomuanuto Color gradient HacTpoeH Ha Black to white, M 3To 03Ha4YaeT, YTO HU3KUE 3HAYECHU S IIUKCeTeH
SIBJISIIOTCS] YEPHBIMH, & BHICOKME 3HaYeHUsI - OesibiMu. Bam HaJio monpo6oBaTh M3MEHUTD 3TOT HapameTp Ha White
to black ¥ IOCMOTPETH YTO MOJIYUUTCS.
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Hano ormetuts BaxkHOCTs apamerpa Contrast enhancement parameter: o yMOJYaHHUIO OH HACTPOEH Ha Stretch
to MinMax, 1 3TO O3HAYaeT, YTO 3HAYECHU S MUKCEJIEH PacTAHYThl JO MUHUMAJIbHBIX U MAKCUMAJIbHBIX 3HAUCHU.

INocmoTpuTe Ha OTIMYHS C YIydIIeHHeM (ClieBa) U Oe3 (crpaBa):

Ho xakoBbl MUHMMaJIbHBIE M MaKCHMaJIbHbIE 3HAYEHHsI, KOTOPBIE CJIEyeT UCTIOJIb30BaTh AJs pacTsikku? Te, koto-
phle B HacTosiIee BpeMs oxBaueHsl Min / Max Value Settings. ECTb MHOTO cIOCOOOB BBIUKCIEHNS] MUHUMAJIbHBIX 1
MaKCHUMAaJIbHBIX 3HAYEHUI U UCTIOIb30BAHUS MX IJISl PACTSIKKHU:

1. OnpeneJisseMble caMUM MOJB30BaTeNEM: BaM HaJI0 BPYYHYIO BHECTH 3HaYeHus1 Min u Max.

2. Cpe3 KymMyJsATHBHOIO MOJCYETA: 3TOT CIOCOO XOPOII, KOrJa Y Bac UMEIOTCS SKCTPEMAaIbHO HU3KYE WA
BBICOKHE 3HAUYEHHUsL. DTOT CIIOco0 cpesaem 2% (AU BBIOPAaHHOE BaMM 3HAUYCHHE) STUX 3HAYCHUI.

3. Mun / Makc: Peanvtvie umu Pacuemmvlie MUHIMaJIbHOE 1 MaKCUMaJIbHOE 3HAUSHUS pacTpa.

4, CpenHee +/- CTAaHJAaPTHOE€ OTKJIOHEHME: 3HAUCHUA PACCUUTHIBAIOTCA B COOTBETCTBUU CO CPEOAHUM 3HAYEC-
HUEM U CTaHAAPTHBIM OTKJIOHCHUEM.

7.2.4 \ NUpem panbwe: OpgHononocHas ncesno-UBeTHas!

OTTEHKH ceporo He Bceraa MoAXOAsT Uisl pacTpoBbix cioeB. [Tonpodyem caenats [IMP Gosee kpacouHo¥.

* Hano usmenuts Render type na Singleband pseudocolor. Ecivi BaM He HpaBsITCS 3arpy>KeHHbIE 1IBETA [10 YMOJI-
YaHMUIO, BBl MOXkeTe BbIOpaTh apyroit Color ramp.

» Kymmknawure Ha kHOTIKY Classify IJist IOJTyYeHUs] HOBOM KJIACCHU(DUKAITMH [IBETOB.

» Eciu nBera aBToMaTuuecKky He CreHepUpOBaHbl, KIMKHUTE HA KHOMNKY OK st TOro, 4toObl IPUMEHUTH 3TY
KJ1accuuKaImio 1o otHomenuio k [IIMP.
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Layer Properties - srtm_41_19 | Symbology

o :
@ Information Render type |Singleband pseudocolor v|

bl ;
‘& Source Band |Band 1 (Gray) -

& symbology Min 0 | Max 1548 |
P Min / Max Value Settings

!g Transparency

(et Interpolation ' Linear - |
. Color ramp | [ - H
4 Rendering =
Label unit | |
B Pyramids sufFix
, value Color  Label
! Metadata
Legend
387 387
E QGIS Server
774 774
1161 1161
1548 . 1548
Mode  Continuous  ~ | Classes | |

Clip out of range values

v Color Rendering -

. @Help || style - | JApply | %cancel || JOK |

Bu YBUAWTE, YTO Balll pacTp 6yneT BBITTIAECTH TaK:

7.2. Upem panbiue: U3MeHeHsieM CMMBOJIMKY pacTpOBOro crosi 239



QGIS Training Manual

ITO0 MHTEpEeCHBIN crocobd npencrapienuss LIMP. Bel BumuTe Tenepsp, 4To 3HAUCHUS pacTpa CHOBA OTOOPaeHBI CO-
OTBETCTBYIOIIMM 00pa3oM: OT CHHEroO I[BeTa, KOTOPbIi MOKa3bIBAeT HU3MEHHBIE MECTHOCTH, JJO KPACHOTO IIBETa —
MECTa, PacroJioKeHHbIe Ha 00JIee BBICOKMX TOUKAX.

7.2.5 Wpem panblie: MeHsieM npo3payHOCTb
H3menenne MIPO3PAaYHOCTU BCETO PACTPOBOIO CJI0A MHOIrJa MO3BOJIACT BaM YBUIACTb APYIre€ CJIOU, TOKPLITHIE CaMUM
PacTpoMm, U JIy4vlle NOHATb UCCTIENYEMYIO MECTHOCTbD.

YroObl U3MEHUTH MPO3PAYHOCTh BCETO PACTpA, HAJIO MEPENTH Ha BKIAAKY Transparency v UCTIONb30BaTh MOJI3YHOK
Global Opacity, njist TOro 4To0b YMEHBILUTH HEPO3PAYHOCT:
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Layer Properties - srtm_41_19 | Transparency
w Global Opacity

Information _F 55.6 % =
Source ¥ No Data Value
Symbology
Additional no data value
. Transparency
: w Custom Transparency Options
Histogram
Transparency band | None -
Rendering o
Transparent pixel list
Pyramids From To Percent Transparent &
Metadata [
=
Legent
QGIS Server
5]

[B|Help Style - W Apply @ cancel

M3mMeHeHre MPO3payHOCTH AJIs1 HEKOTOPBIX 3HAYEHMI MHKCeNel SABJISeTCsl Takxke 0oJiee MHTEPECHBIM CIOCOOOM.
Hanpumep, B HCIIO/Ib3yeMOM HaMU PacTpe Bbl MOKETE YBUETb OJHOPOJHBIN LIBET MO yrilaM. YTOOB HACTPOUTH TH
MUKCeNU KaK Mpo3payHble BaM Hajlo nepeit Ha Custom Transparency Options Bo Bkiajke Transparency.

HaxaB Ha KHOIKY G Addalues manually - pr1 cMoskeTe J06aBUTh HAOOP 3HAYEHHUIT M HACTPOUTH MX MPOLEHT
TPO3PavYHOCTH.

) o i
Yro KacaeTcsl eIMHMYHBIX 3HAYEHUIA JTydllle MCTIOb30BaTh KHOMKY [ Add vatues from display

L&

Hajio KJIMKHYTh HA KHOIIKY Add values from display ~ TTpra joroBoe OKHO MCUE3HET U BBI CMOXKETE B3aMMOMCH-

CTBOBATh C KapTOH.
Hano ximkHMTE Ha OOHOPOIHBIN LBET B yriry LIMP.

But YBUAUTE, YTO Ta6m/1ua IMPO3pavYHOCTH 6y)]CT 3aIll0JIHECHa BLI6paHH])IMI/I 3HAYCHUAMMU:
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w Global Opacity

Layer Properties - srtm_41_19 | Transparency

£ Information
o -
& Source ¥ Mo Data Value

symbology ]

1/100,0% |+

Additional no data value |

! Transparency

Histogram [w| Custom Transparency Options
Rendering Transparency band |Ncne ~ |
~ Transparent pixel list

@R Pyramids P P -
From To Percent Transparent |$|
B Metadata 1/o 0 100 -
2]
Legend |=|
W Qais server ||
]

| @Help || style -]

| «/Apply || % cancel |[ o OK ]

° Ha)10 KJIMKHYTb Ha KHOIIKY OK JJ1d TOro, YTOOBI 3aKPBbITh IUAJIOTOBOE€ OKHO U YBUJACTb U3MEHCHUS.

Bupnute? Yrisl Teneps npospaunsl Ha 100%.
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7.2.6 B 3aknouyeHumn

MBeI paccMOTpeu HEKOTOpblE OCHOBHBIE (DYHKIIMH, KOTOPbIE TOMOTYT BaM Ha4yaTh paboTy ¢ pacTpOBBIMH CUMBOJIA-
Mu. QGIS Takke MOXKET MPEeAIoKUTh BaM MHOXKECTBO JIPYTMX OINIMM, TAKMX Kak 0O03HAUYEHHUE CJIOSI C TIOMOIIBIO
MAJIMTPbl/YHUKAJIbHBIX 3HAYEHHH, NIPEJICTABICHNE PA3INYHbIX T0JIOC PAa3HBIMM IIBETAMH Ha MYJIBTHUCIIEKTPAIbHOM
N300pakeHNH WM CO3/IaHNe aBTOMATHIECKOTo 3(hheKTa OTTeHKa XOJIMOB (TOJIBKO ¢ pacTpoBbiME (paitnamu LIMP).

7.2.7 CcblUikKMn

Ha6op nanubix SRTM 6bu1 nostyuen u3 ~http://srtm.csi.cgiar.org/ " _

7.2.8 Yto panblue?

Tenepb Mbl MOKEM BUJIETh, YTO HAIIM AaHHBIE OTOOPAKAIOTCS COOTBETCTBYIOIIMM 00pa3om. [laBaiiTe U3y4uM, Kak
MBI CMOEM ITPOAHATU3UPOBATH X JAJIBIIE.

7.3 3aHatue: AHann3 penbeda MECTHOCTHU

OTesnbHBIE BB PACTPOB MO3BOJIAIOT BaM JIydllle U3Y4uThb JaHamadT, KOTOPEIA OHU npeacTaBiaoT. Ludposse
Monemu Pembea (LIMP)/ DEM 0coGeHHO 1oJ1e3HbI B 3TOM OTHOIIEHNWH. B 3TOM ypoke Bbl OyzeTe UCHOJIb30BaTh
WHCTPYMEHTHI aHaJIM3a MECTHOCTH, YTOOBI y3HaTh GoJbllle 00 M3y4aeMold MECTHOCTH IJIS TPeIJIaracMom >KUJIOH
3aCTPOHKH, O KOTOPOW FOBOPHJIOCH PaHee.

Iean 3TOro ypoka: Vcrop30BaTh HHCTPYMEHTHI aHAJTN3a MECTHOCTH JIJI51 TOTO, YTOOBI IIOJTyYHMTh JOMOTHUTEIbHbIE
CBEJIEHUS O MECTHOCTH.

7.31 \ Npnem panblwe: Bbluncnsaem oTMbIBKU

Me1 6y1eM UCTIoNb30BaTh Bee TOT ke ciioit LIMP, KoTopsIit ObLT MCMOTB30BaH B IpeIbIIyIeM ypoke. Eciy Bol HaUun-
HaeTe TOT pa3Jiell C HyJIA, BaM HaJO UCIIOJIb30BaTh MaHEb Browser v 3arpy3uTh raster /SRTM/srtm_41 19.
tif.

Cooti LIMP nokassiBaeT BaM BBICOTY MECTHOCTH, HO MHOT/A 3TO MOXKET MOKa3aThCs HEMHOrO ad0CcTpakTHbIM. OH
COJIEPKUT BCIO HEOOXO/IMMYIO BaM TPEXMEPHYI0 MH(OPMALIMIO O MECTHOCTH, HO OHa HE BHIIJISIUT IIOX0XEHN Ha TpeX-
MEpHBIN 00beKT. [J1s1 TOro, YToOBI MOJTYyYHTh JTydIliee MPEACTaBIeHHE O MECTHOCTH, MOKHO BBIUHCIIUTh OMMbIGKY /
Hillshade, koTopasi npeacrapisieT co60oi pacTp, OTOOpaKaIOIKMA MECTHOCTb C UCHOJIb30BAHUEM CBETa M TEHU AJIS
CO3/IaHMSI TPEXMEPHOTO U300PaKEeHHUS.

Ham Hano ucnoss3oBaTh aJITOPUTMBI B MEHIO Raster » Raster terrain analysis.
1. Hano ximkHyTh Ha MeHto Hillshade.

2. AnropuTM NO3BOJIUT BaM YKa3aThb MMOJIOKEHUE MCTOUHHMKA cBeTa: Azimuth umeet 3Ha4ueHus ot O (ceBep) 10
90 (Boctok), 180 (tor) u 270 (3aman), a Vertical angle HacTpauBaeT BHICOTY MCTOYHMKA cBeTa (oT 0 mo 90
IpagycoB).

3. Ham HaJ1o MCHOJIB30BATh CIIEAYIONIHe 3HAUCHUS:
e Zfactorna 1.0
e Azimuth (horizontal angle) Ha 300 . 0°

* Vertical angle na 40 . 0°
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vertical

300g

angle

4. CoxpanuTe (pails1 B HOBOH Mamnke exercise_data/raster_analysis/ c Ha3BaHueM hillshade.
5. W xkJIMKHUTE Ha KHOMIKY Run

V Bac OyeT HOBBII CJIO¥ 0[] Ha3BaHueM hillshade, KOTOPbIN BBIISAUT TAK:

244 nasa 7. Mopynb: PacTpbl



QGIS Training Manual

KpacuBo BBHIJIAAUT ¥ TPEXMEPHO, HO MOKEM JIM Mbl YJIy4IIUTh KapTHHKY? Cama 1o cebe OTMbIBKa BBIIIAIUT Kak
TUIICOBas MOBA3KA. Pa3Be MBI He MOXeM KaK-To HCIOIb30BaTh €0 BMECTE C APYIUMH, 60Jiee KPaCOUHBIMU pacTpamu?
KoHnedHo, MOxeM, UCTOJIb3YsI OTMBIBKY B KAUECTBE HAJIOKEHHUS.

7.3.2 \ Wpoem panblwe: Ucnonb3yem OTMbIBKM B KayecTBe HalOXeHUs

(oBepnen)

OTMBIBKA MOXET ITPEIOCTABUTh OYEHb ITOJIE3HYI0 MH(OPMAIIMIO O COJTHEUHOM CBETE B ONPE/ICJICHHOE BPEMS CYTOK.
Ho oTMBIBKY Takke MOXHO HCIIOJIB30BATh B CTETHYECKUX LENsAX IJIs TOro, YToOBI KapTa BRINVIAENA JIydile. DTo
MOJXHO CeJIaTh, HACTPOUB OTMBIBKY TaK, YTOObI OHA OblIa B OCHOBHOM IIPO3PayvHOM.

1.

wook wn

HaJ1o n3MeHUTb CUMBOJIBI UICXOIHOTO CJI0s1 srtm_41__19, 94ToObl UCTIONB30BaTh cxeMy Pseudocolor Kak B ipebi-
IyIeM yIpaXHEHUH.

Hapo ckpsITh Bee cllou, 3a UCKITIoUeHNeM ciioeB srim_41_19 u cinoes hillshade.
Knukuute Ha srtm_41_19 v nepeTaiyre ero 1 noMmecture mnof ciout hillshade B manenu Layers.
Hactpowurte cnoii hillshade Ha mpo3padyHoCTb, KJIIMKHYB M0 BKJIajKe Transparency B CBOMCTBaxX CJOSL.

Hacrpoiite Global opacity nHa 50%.

Bs! nonmyunTe Takoi pe3ysbpTat:

6. Orximouute ciou hillshade v BkIloUnTE CHOBA B NaHesn Layers, 4TOObl YBUIETb Pa3HUILY.
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Hcnosnb3yst OTMBIBKY TAKUM 00pa30M, Bbl CMOXETe YJIydIIUTh Tororpaduio tanamadra. Eciu adekt kaxercs Bam
HEIOCTATOYHO CUJIbHBIM, BBl MOKETE U3MEHHUTD MPO3PAYHOCTh Cllosl hillshade; HO, KOHEYHO, YeM sipue CTAHOBUTCS
OTMBIBKA, TEM TycKJiee Oy/yT [jBeTa 3a Heil. Bam Hajo HaiTh GajlaHC, KOTOPBIN Bac YCTPOUT.

He 336y}ZII>T€ COXPAaHUTD IIPOEKT, KOrla 3aKOHYUTE.

7.3.3 UWpem panbwe: Nonck HaMny4yLmx Mect

BcriomHuTe 0 npo6iemMe areHTa o HeIBHKUMOCTH, KOTOPYIO MBI B TIOC/IETHUAIN pa3 pacCMaTpHBAIM HAa YPOKE I10
sexmopromy anaauzy. [IpenonoxuM, 4To MOKYyNaTeH Ternephb XOTAT NPHOOPECTH 3/1aHNE U IOCTPOUTH Ha ero Tep-
puTOpHUN HeOOMBIION KOTTeI K. MBI 3HaeM, uto B KOskHOM MOJTyImapiy uiaeaitbHbIM MECTOM JIJISI 3TOTO JIOJKEH OBITh
YYaCTOK, KOTOPBIA:

* CMOTPHT Ha ceBep,
* C YKJIOHOM MeHee 5 TpajycoB,
* HO eCJIM YKJIOH MeHbllIe 2 TPalyCoB, TO ACHIEKT He MMeeT 3HAUCHHSI.

JaBaiiTe HaifneM Jrydiiee MecTo ISl HUX.

73.4 / Npem panblie: BoluucnsieM yKnoH
Viao0m nokaspiBaeT, ypoBeHb OTBECHOCTH penbeda. Ecim, HanpuMep, BBl XOTHTE ITOCTPOUTD Ha 3TOH 3eMJIe JoMa, TO
BaM HY’KHA OTHOCHUTEJILHO POBHAsI 3eMJISL.
YroOBI BBIYMCINTD YKJIOH, BAM HAJIO MICTIONIb30BaTh anroputM Slope B Processing w Raster terrain analysis.
1. Bam Hagio OTKpPBITH QJITOPUTM.
2. Buibepure srtm_41_19 B xauectBe Elevation layer.
3. YcraHosute Z factor Ha 1. 0.
4. CoxpaHuTe BBIXOJ KakK (paily1 ¢ Ha3BaHWEM S 1 ope B TOH e Mamnke, 4to 1 hillshade.
5. KimkHUTe Ha KHOMKY Run.

Teneps BB yBUAUTE YKJIOH pesbecha. Kaxaplil mikcenb NOKa3blBaeT COOTBETCTBYIONIEE 3HAUEHNe yKJIOHa. YepHble
MIHKCEN TIOKAa3BIBAIOT POBHBIN pebed, a Oelrble — KpyTol perbed:
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7.3.5 / Monpobynte camm BbIYUCNIUTD acnekT
Acnexm - HanpaBJIeHHe 110 KOMITacy, K KOTOPOMY OOpallieH YKJIOH MEeCTHOCTH. 3HaueHue acrnekra ) o3Havaer, uTo
YKJIOH oOpariieH Ha ceBep, 90 Ha BocTok, 180 Ha tor u 270 Ha 3amaj.

HOCKOIII)Ky 9TO UCCJIEAOBAHUE MPOBOAUTCS B IOxHOM MNnoJymapuu, 1oMa JOJIKHbBI OBITh IMOCTPOCHBI HA CEBEPHOM
YKJIOHE, YTOOBI OHM MOTJIM OCTaBaThCS TI0[ Jiy9aMM COJIHLIA.

Bam HaJio UCIIOJIb30BaTh AITOPUTM Aspect B Processing » Raster terrain analysis IJisl TOTO, YTOOBI COXPaHUTD CJIOR
aspect BMecrte ¢ slope.

IIposepvme ceou pezynvmanivl

7.3.6 / Upem panbuie: Haxoamm ceBepHYHO CTOPOHY
¥V Bac Tenepb eCTh pacTphl, KOTOPBIE IIOKA3bIBAIOT YKJIOH, a TAKKE aCIEKT, HO BBl [TOKA HE 3HAETe, KAKOBBI H/eaJIbHbIE
yenoBust. Kak MOxHO ObUIO OBl IPOBECTH TOT aHAM3?
OtBet cuauT BHYTpH Raster calculator.
V¥ QGIS ectb pa3znuyHble KaJbKYJIATOPHI pacTpa:
* Raster » Raster Calculator
* B npouecce:

— Raster Analysis » Raster calculator
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— GDAL » Raster miscellaneous » Raster calculator

— SAGA » Raster calculus » Raster calculator

Kamnmﬁ HUHCTPYMEHT OAa€T OAUH U TOT XK€ PE3yJIbTaT, HO CUHTAKCUC MOKET HEMHOI'O OTJIMYATbhCS, a HAJTUMYUE OIIe-

PaToOpPOB MOKET OTINYATbCA.

Hawm Hago ucnonb3oBath Raster Analysis » Raster calculator B naneau uncmpymenmog o0pabomiu.

1. Hano OTKPBITb UHCTPYMEHT, ABAX/bl KJIIMKHYB 10 HEMY:

B BCpXHCfI JIEBOM YacTH AHAJIOrOBOIr0 OKHa MEPEYUCIICHbI BCE 3arpyK€HHBbIC PACTPOBLIE CJIOU KaK

name@N, rae name 3TO Ha3BaHMe CJIOsI M N 3TO rpyIma.

* B npaBoii BepxHel 4acTH Bbl yBUJUTE MHOTO pa3HbIX oneparopos. Ha MrHoBeHue nopymaiite u rnpes-
CTaBbTE, YTO PACTP - ITO M300paKeHue. Bbl IOKHBI MPeCTaBUTh ero Kak 2D-maTpuily, 3aroIHEHHYIO

YUCJIaMHU.

2. Cesep Haxoautcs oA yriaom O (HOJIb) TpajsycoB, O3TOMY, YTOOBI MECTHOCTh CMOTpEJIa Ha CEBEp, €r0 acreKT
JoJokeH ObTh Oosbite 270 rpagycoB nim Menbe 90 rpagycos. Ilostomy, dhopmyia Takosa:

aspect@l <= 90 OR aspect@l >= 270

3. Tenepb BaM Hy>KHO HACTPOUTH ETAJIN PacTpa, Harpumep, pazmep siueiiku, Macirad u CCK. MoxHO Bpy4HYyO
WM aBTOMaTU4eCKH, BbIOpaB Reference layer. Boibepure 3Ty MOCISIHION OMIMIO, HAXAB Ha KHOIIKY

... pAoM ¢ mapameTpoM Reference layer(s).

4. B JAHUAJIOrOBOM OKHE Haa0 BbI6paTb [ (0)7¢ aspect Tak KaKk Mbl XOTUM IOJTY4YUTh CJIOU C TAKHAM XK€ pa3peuICHHUEM.

5. CoxpaHnurte cjoif kKak aspect_north.

JInanoroBor OKHO JOJIKHO BBIIJIAIETD TaK:

Q Raster Calculator

Parameters Log

Expression
Layers Operators
aspect@1 + = cos sin
hillshade@1
slope@1 s / acos asin
srtm_41_19@1
o~ sqrt tan atan
Py = = I=
abs mirn max
Expression

aspect@] <= 90 OR. aspect@1 »>= 270

Expression is valid
Predefined expressions

MNDVI

Reference layer(s) (used for automated extent, cellsize, and CRS) [optional]
1linputs selected

Cell size (use 0 or empty to set it automatically) [optional]

0.000000

Qutput extent [optional]

Mot set

Output CRS [optional]

Output
D: fdev /github/QGIS-Training-Data/exercise_data/raster_analysis/aspect_north. tif

v | Open output file after running algorithm

| 0%

Run as Batch Process..

Raster calculator

This algorithm allows performing algebraic operations using
raster layers.

The resulting layer will have its values computed according to
an expression. The expression can contain numerical values,
operators and references to any of the layers in the current
project. The following functions are also supported:

-sin(), cos(, tanQ, atan2(), InQ, log10(

The extent, cell size, and output CRS can be defined by the
user, If the extent is not specified, the minimum extent that
covers selected reference layer(s) will be used. If the cell size
is not specified, the minimum cell size of selected reference
layer(s) will be used. If the output CRS is not spedified, the
CRS of the first reference layer will be used.

The cell size is assumed to be the same in both X and ¥ axes.

Layers are referred by their name as displayed in the layer list
and the number of the band to use (bazed on 1), using the
pattern layer_name@band number'. For instance, the first
band from a layer named DEM will be referred as DEM@1.

When using the calculator in the batch interface or from the
consale, the files to use have to be specdified. The
corresponding layers are referred using the base name of the
file (without the full path). For instance, if using a layer at
path/to/my/rasterfile. if, the first band of that layer will be
referred as rasterfile, if@1.

Cancel

Run | Close Help
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6. U HakoHel HAaJO KJIMKHYTh Ha KHOIIKY Run.

Bbl nosyunTe Takoi pe3yJibTar:

Brixoanble 3HayeHus 0 wim xe 1. Yrto 310 03Havaet? [Ij1s kaxa0ro NuKcess B pacTpe HalcaHHas Hamu hopMya,
TIOKa3bIBaeT, COOTBETCTBYET JIM OHA YCJIOBHAM Wi HeT. [oatoMy okoHuaTebHbIN pe3ynbrar 0yaer Hesepro (0) u

Bepro (1).

7.3.7 / Monpobynte camu: BonbLie KpuTepues

Tenepb mocie TOro Kak Bbl 3aKOHYMJIN ACHEKT, CO3JaiTe 1Ba HOBBIX ciosi u3 LIMP.
* TlepBslii cito¥i IOJKEH OMPENeiATh YYaCTKH, T YKJIOH MEHBIIE HJIA PaBeH 2 rpaLycaM.

¢ Bropoii aHaJIOrHYeH, HO YKJIOH JIOJKEH OBbITh MEHBIIIC WJIM PaBeH 5 rpagycam.

e CoxpaHure uX BHYTpU exercise_data/raster_analysis kak slope_lte2.tif mu
slope_lteb5.tif.
IIposepvme ceou pesyrvmamoi
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7.3.8 / Npem panble: O6bennHsieM pe3ynbTaTbl aHanM3a pacrtpa

Bel Tenepp nosnyuniy Tpu pacTpoBbix cios u3 LIMP:
* aspect_north: MECTHOCTb, OOpallleHHasl Ha CeBep
* slope_lte2: ykJIOH, paBHbII 2 TpagyCy UM HUXKE
* slope_lte5: ykiioH He 6oiee 5 rpagycoB

Eciu ycioBue BBINOIHACTCS, 3HAYEHNE MUKCeNs paBHO 1. B octanpHbIX citydasx oH paseH 0. IToatomy, eciu B
YMHOXHTE TU PacTpsbl, MUKCEIM CO 3HAYEHHUEM 1 IJIs BCEX OHU IOJIydaT 3HaueHue 1 (ocTayibHble moaydaT 0).

VcnoBust, KOTOpbIE JOJKHBI ObITh BBITIOJHEHBI:
* TIpH YKJIOHE 5 IPajiyCoB WM HIKEe MECTHOCTb JOJIKHA OBITh OOpallieHa Ha ceBep,
* IIpU YKJIOHE 2 Ipajlyca WX HUXE HalpaBIeHUe MECTHOCTU HE UMEET 3HaYCHMS.

ITosToMy, BaM HyXHO HAWTH MECTHOCTb, IT/ie YKJIOH He ITPEBBIIIAeT IATH rpaycoB AND MECTHOCTb CMOTPHUT Ha CEBD,
OR yKJIOH He Gosiee 2 rpaaycoB. Takast MeCTHOCTh ITOJOUJIET JIJIS IIOCTPOVKY.

YrtoObI BBIYUCIIUTH TY MECTHOCTD, KOTOPast COOTBETCTBYET ITHM KPUTEPHUSAM, HEOOXOIMMO CHEJATh CleIylolee:
1. Hamo oTkpeITh cHOBa Raster calculator.

2. Hcnonp3yiiTe 91O BhIpaxeHue B Expression:

( aspect_north@l = 1 AND slope_lteb@l = 1 ) OR slope_lte2(@l = 1

3. Hapno HacTpouts apameTp Reference layer(s) Ha aspect_north (HeBaxHO, BEIOEpeTe JIU BbI IPYroil — OHU
BCe ObUIM BHIUUCIIEHBI M3 srtm_41_19).

4. CoxpaHure BBIXOJ1/pe3yJIbTaT BHYTpU exercise_data/raster_analysis/ Kak
all conditions.tif.

5. KimkHMTE Ha KHOTIKY Run

Pesynbrar:
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Houcxa31<a: HPCILHI[YH.II/IC IIIar¥ MOKHO OBLIO YIPOCTUTH C TOMOLIBIO CHCIIyIOH.[eﬁ KOMaH/bI:

((aspectl@l <= 90 OR aspectll >= 270) AND slope(ll <= 5) OR slopell <= 2

7.3.9 / Upnem panbLue: YnpowiaeMm pacTtp

Kaxk nokasbiBaet I/I306pa)KeHl/lC BBIIIC, KOM6I/lHl/lpOBaHHb1ﬁ AaHaJIM3 BblJaJI HAM MHOXXECTBO OY€Hb MAJICHbKUX Yy4acCT-
KOB, KOTOPbI€ OTBEYAIOT YCJIOBUAM (BI)II[EJ'ICHI)I OeNbIM HBCTOM). Ho oHu He coBceM 1oJIe3HbI JJIsl HAlllero aHaJIu3a,
TaK KaK OHH CJIMIIKOM MaJlbl, YTOOBI HA HUX YTO-THOO CTPOUTH. IIaBaﬁTe n30aBMMCSI OT BCEX ITHUX KPOLIEYHbIX
HEIPUTOJHBIX IJII UCTTOJIb30BAHNA YIaCTKOB.

1. Hago oTkpbITh UHCTpYMeHT Sieve (GDAL w Raster Analysis BHyTpu Processing Toolbox).

2. Hacrpoiite Input file na all_conditions, a Sieved Ha all_conditions_sieve.tif (BHyTpu
exercise_data/raster_analysis/).

3. Ycranosute Threshold no 8 (MUHIMYM BOCEMb CMEXHBIX ITUKCENEl) 1 oTMeThTe Use 8-connectedness.
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Sieve
Parameters | Log
Input layer | ==
| " all_condition [EPSG:32733] - | IZI
Threshold
8 a s

v Use 8-connectedness

Do not use the default validity mask for the input band
Validity mask [optional]

Sieved

|,.fhnmefmatteo,.fexerci&e_datafexercise_data,.’ra5ter_analy5i5£all_cnnditiuns_ﬁieue.tif || |

v | Open output file after running algorithm

GDAL/OGR console call

| 0% |

| [&|Help || Run as Batch Process... # Close H #Run ]

Tocne 3aBepieHust 00padOTKK OyAeT 3arpykeH HOBBIH CIIOH.
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Yro npoucxogut? OTBET KpOETCsl B METaJaHHBIX HOBOTO PacTpOBOro (haiia.

4. TIpocmoTpute MeTaJaHHble BHYTPU BKJIAIKU Information nuanoroBoro okHa Layer Properties. TlocmoTpuTte
Ha 3HaueHue STATISTICS_MINIMUM:

Layer Properties - all_conditions_sieve | Information

Information from provider
@ Information
Mame  all_conditions_sieve

‘J{g- Source Path  [omeln :

CRS EPSG:32733 - WGS 84 / UTM zone 335 - Projected
Extent 9469491.2754000000422520,61%60%9.34080000035486476 ¢
1038119.773099999991 2454 62502946 9956000000238419

%" symbology

l._g Transparency Unit meters
Width 837
u Histogram Height 661
Datatype Float32 - Thirty two bit floating point
"/ Rendering GDAL Driver Description  GTiff
GDAL Driver Metadata GedTIFF
‘ Pyramids Dataset Description  /home/mattec/exercise_data/exercise_data/raster_analysis/

all_conditions_sieve.tif
Compression
Band 1 * STATISTICS_APPROXIMATE=YES
* STATISTICS_MAXIMUM=1
* STATISTICS MEAMN=-266696862.2513
e NSNS =-2147483648
QGIS Server * STATISTICS_STDDEWV=708237202.43956
More information * AREA_OR_POINT=Area
Dimensions  X: 837 ¥: 661 Bands: 1
Origin  269491.6.2503e+6
Pixel Size 8§1.9934.-81.9934

ldentification 3

[E|Help Style - o Apply @ cancel
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ITOT pacTp, Kak U TOT, U3 KOTOPOTO OH IOJIyYeH, JOKEH COAepKaTh TOJBKO 3HaueHrs 1 1 0, HO OH UMeeT
OYeHb OOJIbIIIOE OTPHULIATEIbHOE YUCIO. M3ydeHne MaHHBIX MOKAa3bIBAeT, YTO ITO YKCIIO MPEICTABJICHO Kak
HyJleBoe 3HaueHue. [T0CKOIbKY HaM HYKHBI TOJIBKO T€ YUYACTKU, KOTOpPBIE He ObUTH OT(OUIBTPOBAHBI, HaBaiiTe
HACTPOWM 3TH HYJIEBbIC 3HAUCHIS HA HOJTb.

5. Hago otkpeite Raster Calculator v TOCTpOUTH 3TO BHIPaKeHHUE:

(all_conditions_sieve@l <= 0) = 0

10 COXPaHUT BCEC MTOJIOKUTECIIbHbIC 3HAYCHN A U TICPECBEACT OTPULATEIIbHBIC YUCJIa Ha HOJIb, OCTaBUB BCE Y4aCT-
KU CO 3HAYEHUEM 1 HETPOHYTBIMU.

6. Coxpanute BBIXOJ1/pe3yJibTaT BHYTpU exercise_data/raster_analysis/ Kak
all_conditions_simple.tif.

Bam B]:»IXOII/ PE3YJIbTAT BBIIVIAANT TaAK:

UYro 1 cnefoBano 0kKKUAATh: YIPOIIEHHAS BepCcus NMPpeblIyIUX pe3yIbTaToB. [IoMHUTE, 4TO €CIIU pe3yIbTaThl, KOTO-
pBIe BB [IOJIyYaeTe, He COOTBETCTBYET BAIIMM OKUIAHHSM, HAJJO IOCMOTPETh Ha METaJlaHHbIe (M aTpHOYThl BEKTOPA,
€CJIM €CThb), KOTOpbIE MOMOYb PELIHUTH ITH MPOOJIEMBI.

7.3.10 / Unem panbue: MNMepe-knaccudukauma pacrpa
MEI BCITOJTE30BAIA KaJIBKYJIATOP pacTpa AJ1d BBIYUCICHUA PACTPOBBIX CJIOCB. Ectp €I1ec OAuH Ha,):[e}KHbIﬁ HUHCTPYMEHT,
KOTOprfI MBI MOXKEM HUCIIOJIB30BaTh 4JId TOrO, 4TOOBI U3BJIEYD I/IH(bOpMaI_[I/I}O 13 CyHICCTBYIOIINX CJIOEB.

Bepnemcs k crnolo aspect. Ham n3BecTHO, 4TO OH MMeeT YKCIIOBble 3HaUeHus B quanazoHe ot 0 1o 360. Ham Hamo
nepe-Kaaccuguyuposams TOT CJIOW Ha Pyrue JUCKpeTHbIe 3HaueHus (0T 1 10 4) B 3aBUCUMOCTH OT acleKTa:

* 1 =cesep (or 0 1o 45 u ot 315 o 360);
¢ 2 = Bocrok (ot 45 go 135);
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¢ 3=10r (or 135 o 225);
e 4 =3amag (ot 225 go 315).
STy onepanuio MOXHO BHIIOJIHATD C TIOMOUIBIO KaJIbKYJISITOpa pacTpa, HO (popMyJia CTaHET OYeHb JUTMHHOM.
AJbTepHATHBHBIN HHCTPYMEHT 3TO HHCTPYMEHT Reclassify by table B Raster analysis BuyTpu Processing Toolbox.
1. Hazio OTKpPBITh 9TOT UHCTPYMEHT.
2. BwiGepurte aspect kak Input raster layer.

3. KnmkHUTE Ha KHOTIKY ... U3 Reclassification table. TlosBUTCS IMaoroBoe OKHO B BHE TAOJUIIEL, B KOTOPOM
BBl MOXETe BHIOpATh MUHUMAJIbHBIE, MAKCUMAJIbHBIE M HOBbIE 3HAUEHMS [IsI KXK/IOrO Kjacca.

4. KnukHute Ha KHOTIKY Add row 1 [oGaBbTe 5 CTPOK. 3aroIHUTE KaXIylo CTPOKY, KaK OKa3aHo Ha CJIE/IyIOIIeM
PUCYHKE, ¥ KJIMKHUTE Ha KHOMKY OK:

Minimum  Maximum Value | o OK |

10 45 1 * Cancel

2/ 315 360 1 Add Row

3|45 135 2 Remove Row(s)

4 135 225 3

Mo

Meron, UCIoIb3yeMblii AJITOPUTMOM JJIs1 0OpaOOTKH ITIOPOTOBBIX 3HAYEHHMI KaXI0ro KJlacca, ONpeaessieTcs
Range boundaries.

Remove All

5. Coxpanute cioif Kak reclassified.tif BHyTpu manmku exercise_data/raster_analysis/.
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Reclassify by Table .

b

Parameters | Log Recla 55":}'
Raster layer hy table
=" Aspect [EPSG:32733] - This algorithm
Band number reclassifies a
g raster band by
Band 1 (Gray) - assigning new

class values
based on the
ranges specified
in a fixed table.

Reclassification table

v Advanced parameters

Output no data value

-9999 000000 -
Range boundaries
min < value <= max -

Use no data when no range matches value
Output data type
Float32 -

Reclassified raster

rcise_data/raster_analysis/reclassified.sdat

v Open output File after running algorithm

| 0%

@Help Run as Batch Process... ¥ Close

6. Kimknute Ha KHONIKY Run.

Ecv BB cpaBHUTE CXOIHBII CIOH aspect co cnoeM reclassified, Bbl He yBuauTe 60pmx pasnnunii. Ho mocmMotpes
Ha CHMBOJIBI, BBl yBUIWTE, UYTO 3HAYEHHS HAUMHAIOTCS OT 1 710 4.

JlaBaiiTe yaydIlIuM CTHJIb TOTO CJIOSI.
1. Hapo otkpsiTh aHenb Layer Styling.

2. Bwibepure Paletted/Unique values, Bmecto Singleband gray.
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3. Knuknute Ha kHoOnKy Classify muis Toro, 4toObl aBTOMaTHYECKM MOMYYUTh 3HAYEHHS] U IPUCBOUTh MM CIIy-

YyaHbIe IIBETOB:

Layer Styling (&
| ¥ reclassified -
o 5= Paletted/Unique values v | 3
Band 'Band 1 (Gray) - |
Color ramp | Random colors |;|
Value Color Label _
1 . 1
2 2
3 . 3
4 4
| Classify | | G | | = | | Delete aAll | | _|
Layer Rendering
Blending mode 'Normal - | _

[o][e]

| Layer Styling | Processing Toolbox

v Live update | v Apply |

Boixon/| PE3YJIbTAT AOJIKEH BBIIVIAACTDL CJICAYIONIUM o6pa30M (I_[BCTa Yy Bac MOryT OBITH PpasHbIMH, €CJIK OHU ObLTH

CreHEepHpOBaHbI CIIy4aiiHBIM 00pa3oMm):

7.3. 3aHsaTtue: AHanu3 penbecpa MECTHOCTH
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HpI/IMeHI/IB K CJIOIO IaHHYIO nepe—maccmbnxaumo 1 CTWUJIb ITAJIMTPBI, BBl MOKETE CPpa3y pa3nvaThb 00J1aCTH acIeKTa.

7.3.11 \ WUpewm panbLue: 3anpoc K pacTpy
B omimmune ot BEKTOPHBIX CJIOEB, paCTPOBLIE CJIOU HE UMEIOT Ta6HI/I].[y anI/I6yTOB. Ka)KﬂBII‘/JI TNHUKCEJIb COAECPKUT OAHO
WJIA HECKOJIBKO YHUCIIOBBIX 3HAUEHUHA (OHHOHOHOCH}JC NI MHOT'OIIOJIOCHBIE paCprI).

Bcee PacTpOBBIE CJIOH, KOTOPbIE Mbl MCIIOJIb30BAJIA B 9TOM YIIPAKHEHNH, COCTOAT TOJILKO U3 O)JHOfI roJsiockl. B 3aBu-
CHUMOCTH OT CJIOsI 3HAYEHUS MHKCeleH MOTYT ITIOKa3bIBaTh 3HAYEHUA BBICOTHI, aCIIEKTa WX YKJIOHA.

Kak mbI MOXEM 3arpoCUTh paCTPOBbIﬁ CJIOM, YTOOBI TOJTY4YUATh 3HAYCHUE ruKcess1? Mbl MOKeM HCIIONTb30BaATh KHOIIKY
Q;% Identify Features |
1. Hapmo BbI6paTb HUHCTPYMEHT B IIAHEJIM MHCTPYMEHTOB «ATpI/I6YTbI».

2. Kimmkuaute Ha ciiy4aitHoe MecTo B ciioe srtm_41_19. Tosisutcs Identify Results co 3HaYeHHUEM IOJIOCH B MECTe,
KOTOPOE BbI BHIOpAJIH:
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Identify Results E]ES)
% 2@ % &~

Feature Value
* 0 srtm 41 19
srtm 41 19
Band 1 592
b (Derived)

Mode Current layer -

View Tree - Help

3. BBl cMOXeTe I3MEHUTD BbIXOJ NaHe I Identify Results U3 TEKYILEro pexuMa t ree Ha pexuM table, BHIOpaB
Table B meHI0 View BHU3Y TIaHEH:

Identify Results e
Layer FID Attribute Value

1/srtm_41 19 1 Band 1 592

View Table ~ Help

Uepe3 HEKOTOpPOE BpeMs BaM MOXKET HAJI0eCTh HAKMMaTh Ha Kax/blil MUKCENb IS NOJIy4YeHnsl 3HAYeHUs pacTpa.
MBI MOXeM UCHOJIb30BaTh IWarkH Value Tool 1j1s pelieHus 3Toi poOJIeMBl.

1. Hamo nepeiitit Ha Plugins » Manage/Install Plugins...
2. Bo Briaze All Habepute value t B IOJ€ TIOKCKA.

3. Bwibepure miaruH Value Tool, kukuute Ha Install Plugin , a motom Close IuaaoroBoe oKHO.
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Plugins | All (539)

A value t &«

e Value Tool qk

e A

F ] Installed

bl Qgis plugin to display in table or plot values from raster layers

(or mesh layers, from version 3.0.5) at the current mouse

Install from ZIP o
position

.ﬁ SEEEGE Qgis plugin to display in table or plot values from raster layers (or mesh layers, from
version 3.0.5) at the current mouse position

If this plugin is useful for you, please consider to make a donation of any value to the
Maintainer

WIWWWW 84 rating vote(s), 136917 downloads

Tags raster, mesh
More info homepage bug tracker code repository
Author Jorge Almerio (maintainer)

Available version 3.06

Install Plugin
@Help % Close

TTosiButcsa HoBast ma”enb Value Tool.

CogeT: Eciu Bbl 3aKkpoeTe MaHeb, BBl CMOXETE CHOBA OTKPBITh €€, aKTHUBUPOBAB ee B View » Panels » Value
Tool vy KJIMKHYB Ha 3HA4YOK Ha MTaHEJM MHCTPYMEHTOB.

4. Yto0Obl UCIIONB30BATh TUIATHH, MTPOCTO KIMKHUTE HA (hiiakok Enable u yoenurech, 9to cioit srtm_41_19
SIBJISIETCS] aKTUBHBIM (OTMEUeH) B ITaHenu Layers.

5. HaBepute Kypcop Ha KapTy, 4ToObl yBUETh 3HAYCHHE ITUKCENIeH.

Layers @
o« il ® T &, - @0

RN

Browser Layers
Value Tool [E5]
V| Enable

Table | Graph = Options

Decimals |2 |5

Layer Value
1/srtm_41.19  76.0

Coordinate: (997960.378142, 6216696.900344)
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6. Ho ects eme xoe-uto. Imarnu Value Tool mo3Bossier 3amnpamuyBaTh Bee aKTHBHBIE PACTPOBBIE CJIOM B ITAHEN
Layers. Cnenaiite ciiou aspect 1 slope CHOBa akTUBHBIMU M HaBE/IUTE yKa3aTeJlb MBILIN Ha KapTy:

Layers [E]ES]
o [ ® T £ g
b v B slope

b |V ¥ aspect

b s

b -

3 :.'

3 :.'

3 -

2 -

bV B srtm_41_19

Browser Layers
Value Tool (G

v Enable

Table Graph

Decimals |2

Options

-

Layer Value
1|slope 56.08386993...
2|aspect 173.8803253...

3/stm 41 19 328.0

Coordinate: (1001434.695838, 6227891.924031)

7.3.12 B 3aknoyeHuu

Bel mocMoTpesu, Kak MOXKHO IOJYYUTh BCE BUIbl aHAIMTHUYECKUX NpogyKToB u3 [IMP. K HuM oTHOCATCS BBIUMC-
JIeHUe OTMBIBKH, YKJIOHA M acreKTa. Bbl Takke y3HaId, KaK UCIOJIb30BATh KAIBKYJISATOP pacTpa AJis JalbHEeHIero
aHanmm3a U 00beIUHEHUS STHX Pe3yJIbTaToB. M HaKkOHeIl, BHl y3HAIHU, KaK Mepe-KIacCU(pUIMPOBATh CJION M KaK 3a-
MPaIINBaTh Pe3yTbTATHL.

7.3.13 YTto panbwe?

Terepb y Bac ecTh [IBa aHaJIM3a: BEKTOPHBIN aHAIN3, MOKA3BIBAIOIIMI BaM MOTEHIIUATBHO MOAXOAAIINE YIACTKH,
Y PACTPOBBII aHAJI3, KOTOPHII MMOKA3bIBAET MOTEHITUAIBHO MOAXO/SIYI0 MECTHOCTh. Kak MX MOKHO OOBEVHUTS,
YTOOBI TOTYYUTh OKOHYATEIIBHBIA Pe3yJIbTaT ISl pelIeHHs 3TON MpodaeMsl? DTo OyIeT TeMOH CllelyIoNIero ypoka,
KOTOPBII HAYMHACTCS CO CIIEIYIONIEero MOIYJISI.
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rnABA 8

Mogaynb: 3aBeplueHne aHannsa

Bu TEIIEpb UMECTE IBC MOJIOBUHBI aHAJIN34: BeKTOprIfI u paCTpOBbeI. B sTom MOJYJIE Bbl Y3HACTE, KaK UX O6'I)€,HI/I-
HUTb. BBl cMOXeTe 34BEPHINTH aHAJIM3 U IPEACTABUTb OKOHYATCJIbHBIE PE3YJIbTAThI.

8.1 3aHsTtme: NpeobpazoBaHne pacTPOBOro B BEKTOPHOE

[TpeoGpa3oBaB MeX 1y paCTPOBBIMU M BEKTOPHBIMU (hOpMaTaMu, Bbl CMOXKETE HCIIOIB30BATh KaK pacTpoOBbIe, TaK U
BEKTOpHbIE TaHHbIE TTpU pelieHuy 3aaa4 GIS, a Takxe NPUMEHUTb pa3MyHble METOIbl aHAIN3a, KOTOPbIE YHUKATbLHBI
VTSt 9TUX JABYX (hopM reorpapuyeckux JAaHHbIX. Takum 0Opa3oM Bbl CMOXKETE MOBBICHTh THOKOCTh IPH PACCMOTpE-
HUH UCTOYHUKOB JIAHHBIX ¥ METOJIOB 00paOOTKY TS pereHus 3agad GIS.

Jnst 0ObeIMHEeHHsT pacTPOBOrO M BEKTOPHOTO aHANIM3 BaM HaJo NMpeoOpa3oBaTh OAMH THI JaHHBIX B Jpyroi. [a-
BaiiTe Momnpodyem Mpeodpa3oBaTh pe3yIbTaThl pabOThl ¢ PACTPOBBIMU JAHHBIMU MPEABLIYLIETO YPOKa B BEKTOPHYIO
TUIOCKOCTb.

Ileas 3Toro ypoka: IlepeBectu pe3ysbraThl pabOTHI C paCTPOBBIMHU JAHHBIMH B BEKTOPHBIH, KOTOPBIE MOXHO HC-
T0JIB30BATh 1151 3aBEPIICHMS aHAIH3A.

8.1.1 / WUnem panbwe: UHCTpyMeHT Raster to Vector
Haunute padoTy ¢ KapThl U3 NpeIplAYyIIEero Moayns, raster_analysis.qggs. Y Bac TaM JIOJDKeH ObITh (haiin
all_conditions_simple.tif, BHIUMCICHHBII BO BpeMs BHIIOJIHEHUS NPEABAYIINX YITPaKHEHUI.

» Knuknure Ha Raster » Conversion w» Polygonize (Raster to Vector). Y Bac NOSIBUTCSI TUAJIOTOBOE OKHO HH-
CTpYMEHTA.

 Hacrpoiite ero takum o6pazom:
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Polygonize (Raster to Vector) X

Parameters | Log
Input layer
# all_conditions_simple [EPSG:32733] -
Band number
Band 1 (Gray) -
Name of the field to create
suitable
Use 8-connectedness

v Advanced parameters

Additional command-line parameters [optional]

Vectorized
ease_3.10/exercise_data/residential_development/all_terrain.shp

v! Open output file after running algorithm
GDAL/OGR console call

gdal_polygonize.py /home/hari/Desktop/QGIS-Training-Data- =
release_3.10/exercise_data/raster_analysis/all_conditions_simple.tif
/home/hari/Desktop/QGIS-Training-Data-release_3.10/
exercise_data/residential_development/all_terrain.shp -b 1 -f "ESRI

Shapefile" all terrain suitable -
| 0%
[ElHelp Run as Batch Process... # Close #Run

* TlomensiiTe Ha3BaHMe MO (OMKCHIBAIOIEe 3HAYCHUsI pacTpa) Ha suitable.

e Coxpanute cioil BHyTpu exercise_data/residential_development kak all_terrain.
shp.

Y Bac Tenepb ecTh BEKTOPHHI (haiisl, KOTOPHIA UMeET Bce 3HAUEHHS pacTpa, HO BaM HYKHBI T€ MECTHOCTH, KOTOpBIE
ABJISAIOTCS OIXOIAIIKMMHE; T.€. T€ ITOJIMTOHBI, TIe 3HaueHue suitable snasercs 1. Bel MoXxeTe U3MEHUTDH CTUJIb 3TOI'O
CJI0s1, eC/iM XOTUTe 00Jiee YEeTKO ero BU3yalu3UpOBaTh.

8.1.2 / Monpo6ynte camm

BepHI/ITCCb K MOJYJII0O BEKTOPHOI'O aHaJIN3a.

¢ CozpgaiiTe HOBBIN BEKTOPHBIH (hailsl, KOTOPHIN COAEPKUT TOIBKO MOJIMTOHBI, B KOTOPHIX 3HaUeHNe suitable paB-
HO 1.

* CoxpaHute HOBBII aiin B exercise_data/residential_development/ Kak
suitable_terrain.shp.

[Iposepvme ceou pezyavmamot
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8.1.3 / Upnem panbue: UHcTpyMeHT Vector to Raster

XOTs 9T0 U He SIBJISIETCs 00s13aTe bHBIM IS HAlllel TeKylen 3a1auu, ObuIo Obl XOPOLIO 3HaTh 0OpaTHOE Mpeodpa-
3oBaHue. [IpeoOpasyiiTe B pacTpOBbIN MPEABLIYIINIA BEKTOPHBIN (pailn suitable_terrain. shp, KOTOPHIA BbI
CO3/1aJIM B IIPEABIIYIIEM 3alaHHN.

¢ Hano ximkHyTh Ha Raster » Conversion » Rasterize (Vector to Raster) 9ToObI 3aITyCTUTh 9TOT HHCTPYMEHT,
3aTeM HaJ0 HACTPOWTH €ro, Kak MOKa3aHO HUXKe:

Rasterize (Vector to Raster) x

Parameters | Log
Input layer
all_terrain [EPSG:32733] || .. | @

Field to use for a burn-in value [optional]
122 SUITABLE -
A fixed value to burn [optional]

0.000000 =
Output raster size units

Pixels -
Width/Horizontal resolution

837.000000 =
Height/Vertical resolution

616.000000 =
Output extent (xmin, xmax, ymin, ymax)
54,1037709.8059691756,6196099.3408,6250051.015321028 [EP5G:32733]
Assign a specified nodata value to output bands [optional]

0.000000 =

v Advanced parameters

Additional creation options [optional]
Profile Default v

Name Value

0%
[BHelp Run as Batch Process... # Close &Run

* Input layer 3710 all_terrain.

* Wwms nons suitable.

* Qutput raster size units 310 Pixels.

o Width n Height cocTaBisioT 837 1 661, COOTBETCTBEHHO.
* Bosbmurte Ouiput extent u3 cnos all_terrain.

e VcraHoBuTe BHIXOAHON hailln Rasterized Ha exercise_data/residential_development/
raster_conversion.tif.
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Ipumeuanne: TPa3Mep BHIXOJHOTO M300pakeHNs], yKa3aHHbIN 31€Ch, ABJISETCS TAKUM e, KaK UCXOIHBIN pacTp,
KOTOPBIA OB TPe0Opa3oBaH B BEKTOPHBIN. [{J1s1 TOTr0, YTOOBI HPOCMOTPETH MapaMeTphbl U300pakeHuUsl, OTKPOUTE ero
Metananuele (Bknagka Metadata B Layer Properties).

* Hajo kimkHyTh Ha KHONKY OK B JUaJIOTOBOM OKHE JIJIsI 3aIyCKa Ipoliecca peodpa3oBaHusl.

¢ Korma nporiecc OyeT 3aBepilieH, OLIEHUTe ero yCIeX, CPABHUB HOBBIA PacTp ¢ MCXOAHBIM. OHH JIOJKHBI OBITh
MOJTHOCTBIO OJJMHAKOBBIMH, TTUKCEITh K MUKCEIIO.

8.1.4 B 3aknruyeHumn

ITpeoGpa3oBaHue MexJy pacTPOBBIMU U BEKTOPHBIMH (hOpMaTaMM JacT BaM BO3MOXKHOCTb OoJiee IUpe NPUMEHSTh
JAHHBIE U 9TO HE JIOJUKHO MPUBOJUTH K YXYALIEHHIO KaUecTBa JaHHbIX.

8.1.5 Uto panbLie?

YV Hac Tenepb ecTh pe3yJIbTaThl aHAIN3a MECTHOCTH B BEKTOPHOM (hOpMaTe M MX MOKHO HCIIONIF30BATh IS PEIICHUS
3aJaun, KaKve 3[aHus CJIeLyeT pacCMaTPUBATh IS JKMJIOW 3aCTPOMKH.

8.2 3aHaTue: O6beanHeHne aHannM3oB

Hcrosib30BaHre BEKTOPU30BAHHBIX Pe3yJIbTATOB PACTPOBOrO aHAJIM3a IMO3BOJIUT BaM BHIOPATh TOJIBKO Te 3/1aHKS Ha
MOJIXOIAIIEN MECTHOCTH.

He.m; 9TOro ypoka: Hcmonb30Bath PE3YJIbTAThl AaHAJIN3d BEKTOPU30BAHHOT'O JIaHJlIHa(i)Ta JJIA BbI60pa 18(0)10,€0216:111170,€
Y4aCTKOB.

8.2.1 / Monpo6yite camm

1. Coxpanute Bally TeKylylo Kapty (raster_analysis.ggs).

2. OTkpoliTe CO3MaHHYI0 BaMH KapTy BO BpeMsl BEKTOPHOT'O aHAJIN3a, IPOBEICHHOTO paHee (BBl JOJIKHBI ObLTH
COXpaHUTh (pailsl Kak analysis.qggs).

3. B manenu Layers BaM HaJJO aKTUBHPOBATh T CJIOU:
e hillshade
e solution (wmm buildings_over_100)

4. Kpome 3Tux cJI0eB, KOTOpbIE yKe TOJKHBI OBITh 3arpyKeHbl Ha KapTy, KOT/Ia Bbl paboTaM Haj Heil paHblIle,
HaJIo Takke Habop JIaHHBIX suitable_terrain.shp.

5. Eciu BaM He XBAaraeT HEKOTOPHIX CJIOEB, BbI JIOJUKHBI HAWTHM WX BHYTpU exercise_data/
residential_development/

6. Bam Ha/10 UCnosb30BaTh MHCTPYMEHT Intersection tool (Vector » Geoprocessing Tools) mist Toro, 4rodsl co-
3/1aTh HOBBIM BEKTOPHBIH CJIOH, KOTOPBIN Ha3bIBaeTCA new_solution . shp U COAEPKUT TONBKO Te 3IaHKUA,
KOTOpBIE TIepeceKaloT Cioit suitable_terrain.

VY Bac TEIEpb AOJIKECH OBITH CJ'IOfI, noxa%maxoumﬁ Balll BApUaHT ONPEICJICHHBIX BHHHHﬁ, Harmpumep:
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8.2.2 / Monpobynte camu: NMpoBeputb pesynbTaThbl

IMocMoTpuTe Ha KaxJoe U3 3/1aHuil B BalleM cjioe new_solution. CpaBHUTE UX CO cJIoeM suitable_terrain, N3MEHUB
CHUMBOJTBI TS CJTOSI new_solution Tak, 4TOOBI Ha HeM ObLTH TOJIBKO KOHTYPHI. UTO BB 3aMETHIIH B HEKOTOPHIX 3AaHUIX ?
Bce i1 OHU NOAXOAT TOJIBKO TTOTOMY, YTO MEpeceKarnTcst co cioeM suitable_terrain? Tloyemy win novemy Het?
Kakue u3 HUX BBI CUMTAETE HE MTOIXOIAT?

IIposepvme céou pezynvmamaol

8.2.3 / Monpo6yite camu: YTOUHUTb aHanNu3
Brl moskeTe YBUIETH U3 PE3YJILTATOB, YTO HEKOTOPLIE N3 BKIIOYEHHBIX BHaHHﬁ Ha cCaMOM [I€JI€ HE IOXOAT U TIO3TOMY
HaM HaJ10 YTOYHUTb aHAJIU3.

Msbl XOTUM YOEAWTBCs, YTO HAIl aHAJIHM3 BBIIACT TOJBKO T€ 3[JaHHWs, KOTOPBIC MOJHOCTHIO CHUAST BHYTPH CIIOS
suitable_terrain. Kak Bam 3toro noouthcsa? Hago uUcnonib30BaTh OAWH WM HECKOJIBKO MHCTPYMEHTOB BEKTOPHOTO
aHaIM3a ¥ MOMHUTE, YTO BCE HAIIM 31aHUs UMEIOT Tuomans 6osee 100 KBagpaTHbIX METPOB.

IIposepvme céou pezynvmamaol

8.2.4 B 3aknoyeHvun

Bu TEIepb OTBETUJIN Ha I/ICXO,HHHﬁ BOIPOC UCCIIEJOBAHNA U MOKETE BbICKA3daTh CBOE€ MHEHHE (C YKa3aHUEM MMPUYNH,
TIOAKPETITIEHHBIX aHEUII/ISOM) OTHOCHUTEJIBHO TOTO, KaKo# OOBEKT HEABUXKUMOCTHU CIIEAYET YITYyUIINTD.
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8.2.5 Yto panbLie?

IIanee BbI IPEACTABUTE ITU PE3YJIbTAThl KaK YaCThb BAIlIEro BTOPOro 3alaHuA.

8.3 3apmaHue

Hcronp3yst MakeT 1is leyatH, Co3aiTe HOBYIO KapTy ¢ pe3y/IbTaTaMHy Balllero aHas3a. BkimouuTte 3Tu ciou:
¢ places (c HamUCAMM),
e hillshade,
e solution (um new_solution),
e roads,
e wmm aerial_photos wim DEM.

Hamnumure kpaTkuii MOsICHUTEIBHBIN TEKCT K HeMy. B TekcTe mpomnuiimTe KpUTEpHil TP OLIEHKE KUJIbsI AJIS OKYTI-
KU U TIOCJIEAYIOLIEro YJIy4llIeHus], a Takke 0ObsSCHEHNE CBOMX PEKOMEHIALMii OTHOCUTENILHO TOTO, KaKHe 3[aHHs
HOAXOIAT.

8.4 3aHaTtue: [ononHUTenbHoOeE ynpaxHeHue

B aToM ypoke BbI npoiinere nosnsii aHamm3 GIS B QGIS.

IIpumeuanne: Copepxanue ypoka paspadorano Linfiniti Consulting (FOAP) u Siddique Motala (TexHonornye-
ckuil ynusepcuret Kein-Ilenuncyna).

8.4.1 MNocTaHoBKa 3apgauu

INepen Bamu mocTaBiIeHa 3aJaya HAWTH paioHBI Ha MOJTyocTpoBe Keln 1 BOKpYr Hero, KOTopsle SABJISIOTCA MOIXO0-
JSIIer cpeloll oOuTaHus Uil peaKUX BUIOB pacteHuii (punooc. [IpoTskeHHOCTh 001acTH Balllero Ucciie0BaHUs
oxsatbiBaeT KeiinrayH u nosyoctpos Kefin mexny Menk6occrpannom Ha ceBepe M CTpaHioM Ha iore. BotaHukn
MIPEIOCTABMIIM BaM CJIEYIOIIHE MTPeAOYTEeH s, IPUCYIINE PACCMAaTPUBAEMbIM BU/IaM PACTEHH:

* Pactenue pacter Ha CKJIOHaX BOCTOUYHOTO HAIPABJICHUS.

* Pactenue pacteT Ha CKJIOHaX C YKJIOHOM OT 15% 1o 60%.

¢ Pacrenue pacter B MECTHOCTH C OOIIMM IOIOBBIM KOJIMIECTBOM 0CaAKOB > 1000 MM.

* PacreHne MOXHO HaWTH TOJIBKO Ha pACCTOSHIM He MeHee 250 M OT JII060r0 YeI0BeYeCKOro IMOCENICHHS.
* Tlnomans pacTUTEILHOCTH, HA KOTOPOM pacTeHHe BCTpevaeTcs, 10KHA ObITh He MeHee 6000 m2.

Kaxk cTyneHT yHuBepcHUTeTa, Bbl COIIACUINCH UCKATh PACTEHUE HA YEThIPEX Pa3HBIX MOAXOIAIIMX yYacTKax 3eMIIN.
BpI X0THTE, 9TOOBI 3TH YETHIPE MOAXOASAIIMX yIacTKa ObuTH OMvkaliniMu K KelinTayHCKOMY YHUBEPCUTETY, B KOTO-
POoM BHI xuBeTe. Bocronbayiitech cBOMME HaBBIKaMH padoTsl ¢ GIS, 4TOOB! ONpeeiThes, Tae BaM CIeIyeT UCKATh.
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8.4.2 OnucaHue pelueHnsa

HaHHble [1J1s1 3TOTO YIpakHEHHUS MOXHO HAalTH B Marnke exercise_data/more_analysis.
Bam Haio HalTH YeThIpe MOAXOASIIIX YIaCTKa, KOTOPhIe HaXOATCs Onke Bcero K KelinrayHCKOMY YHUBEPCHTETY.
L7151 TOrO, YTOOBI PELIUTD ITY 33434y, HEOOXOIUMO CHEJATh CleIylollee:

1. Anami3 pactpoBoro ciost [IMP 11s1 morcka CKJIOHOB BOCTOUYHOTO HAMPABJIEHUS U C COOTBETCTBYIONIUM YKJIO-
HOM.

2. Anamms pacTpoBOro cjoda 0CaikosB, YTOOBI HAUTH Y4aCTKHU € COOTBETCTBYIOIINUM KOJIMYECTBOM OCAIKOB.

3. AHanu3 BEKTOPHOTO CJIOSI 30HUPOBAHMSI TSI TOTO, YTOOB! HAWTH YYaCTKH, YAAJICHHBIE OT HACEICHHBIX ITyHK-
TOB, U UMEIOLINE COOTBETCTBYIOIINIT pa3Mep.

8.4.3 Unem panbuie: Hactpoika KapTbl

1. Hapmo K1MKHYTh Ha KHOIIKY ! Current CRS g 1papomM HUKHEM yTiTy 9KpaHa. ITox Bknaakoii CRS nosBuBIerocs

JIAJIOTOBOTO OKHA HCTIOJIB3YHTE MHCTPYMEHT «PrtbTp» miist oucka «33S». Beibepure 3armice WGS 84 /UTM
zone 33S (c konom EPSG 32733).

2. Kiuknure OK.

=] .
3. CoxpaHnute (haily1 MPOEKTa, HA)KAB H KHOIKY MTaHEIN Save Project 11 gocronb3yiiTech MyHKTOM MeHo File
» Save As....

CoxpaHHTe ero B HOBOM KaTajiore oji Ha3BaHHeM Rasterprac, KOTOPBIA Bbl JOJKHBI CO3/IaTh Ie-HUOY/Ib
Ha CBOEM KoMIIbloTepe. B 9TOM KaTasiore Bbl JOJKHBI TAKXKE COXPAHAThH BCe co3/laBaeMble Bamu ciion. Coxpa-
HUTE IIPOEKT KaK your_name_fynbos.ggs.

8.4.4 3arpy3Ka gaHHbIX Ha KapTy

st Toro, 4ytoObl 00pPadOTaTh JAaHHBIC, BaM HAJI0 3arpy3uTh HEOOXOMUMBbIC CJIOM (HAa3BaHHS YJIUII, 30HBI, OCAJIKH,
LIMP, paiioHbl) Ha IOJIOTHO KapThl.

Jnsi BEKTOPOB...
1. KimkH#ATEe Ha KHONIKY ‘! Open Data Source Manager ya ragesin MHCTPYMEHTOB Oucnemuepd UCHOMHUKOE OAHHBIX

Va

Layer » Add Layer » vl.‘: Add Vector Layer....

U aKTUBHUPYITE BKJIAJIKY Vector B OTKpBIBILIEMCS AUAJIOTOBOM OKHE WJIM BOCTIOJIb3YITECh KHOIKON MEHIO

2. Y6enurech, uTo BHIOpaH ® . File.
3. KiMKHMTE Ha KHOIIKY ... KHOIKA JUIsl IPOCMOTpPA BEKTOPHBIX HAOOPOB JAHHBIX.

4. B nosiBUBIIEMCSI AUATOTOBOM OKHE BaM HaJ0 OTKPBITh KaTajor exercise_data/more_analysis/
Streets.

5. BeibGepure ¢aiin Street_Names_UTM33S. shp.
6. Kimkaute Ha KHOMKY Open.

JInanoroBoe OKHO 3aKpOETCs! M MOSIBUTCS HCXOJHOE ANAJIOrOBOE OKHO C YKA3aHUEM ITyTH K (haiiry B TEKCTOBOM
none pspoM ¢ Vector dataset(s). Takum 0Opa3oM Bbl CMOXeTe YOSIUThCs, YTO BHIOpPAH MPABHIbHBINA (haiii.
MoO3KHO Tak’ e BBECTH IyTh K (pailily B 3TOM I10JIe BPYUHYIO, €CIIN 3aXOTHTE.

7. Kinknute Ha KHONIKY Add. BeKTOpHbIi ciioii OyeT 3arpyskeH Ha Bairy Kapty. LBet kapThl OyaeT aBToMartH-
YEeCKHU MPHUCBOEH. Bbl U3MeHuTe ero nosxe.
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8. Ilepemmenyiite cioii Ha St reets.

10.
11.

12.

1. KiukHUTE Ha €ro MpaBoil KHOMKOM MBIIIH B TaHeNU Layers IO YMOJTYaHUIO TaHeJb B JIEBOUM YacTH Kpa-
Ha).

2. KnukHHTE Ha KHOTIKY Rename B IOSBUBIIIEMCS IUATIOTOBOM OKHE 1 [IEpEUMEHYITe ero, HaXkaB Ha KHOITKY
Enter Korga 3akOHYMTE.

IloeTOpUTE rpouece no0aBJeHKs BEKTOPA, HO Ha 3TOT pas BbIOEpHTE haiin
Generalised_Zoning Dissolve_UTM33S. shp B Katajore Zoning.

Ilepenmenyiite ero Ha Zoning.

Taxoke 3arpy3urte BeKTOPHBIH cioit admin_boundaries/Western_Cape_UTM33S. shp B Bamly Kap-
Ty.

Ilepenmenyiite ero Ha Districts.

Ans pacTpos...

KnvkaM Ha KHOTIKY ‘5 Open Data Source Manager iy agrygypyiite manesn FD Raster B OTKpBIBIIIEMCSI T1aJIOTOBOM

OKHE WJIM BOCIIOJIb3yHTech KHOMKOM MeHIo Layer » Add Layer » ™" @ Add Raster Layer....

. Ybenurecn, uTo BHIOpaH ® . File.
. Tlepetinute k cooTBETCTBYIOIIEMY (Daiiily, BHIOEpHTE €r0 U KJIMKHUTE Ha KHOIIKY Open.

. Ilpopenaiite To xe camoe JUIsl KaXAOro U3 CIEIYIOIIMX OBYX pacTpoBbIX (paitnoB, DEM/SRTM.tif u

rainfall/reprojected/rainfall.tif.

. Tlepeumenyiite pactp SRTM Ha DEV, a pactp ocankos/rainfall Ha Rainfall (c 3ariaBHON OYKBBbI).

8.4.5 N3ameHeHMne nopsaka crnoes

Kinukaure n MeperamurTe CJIOM BBEPX U BHU3 B IIaHEJIN Layer S 14 TOro, YTOOBI U3MEHUTD MOpAIOK UX 0T06pa)KCHI/IH
Ha Kapte, YTOOBI BBl MOLJIA BHUJETH KaK MOXXHO 0O0JIbIIIE CIIOEB.

ITocne TOro Kak Bce JaHHBIE 3arpyKEeHbl U COOTBETCTBYIOIMM 0Opa30M BHAHBI, MOKHO HauMHaTh aHanmu3. CHava-
JIa JIydlie ceNaTh ONepanuio 00pe3Ku. DTo Aenaercs sl TOro, YToObl HUKAKash BBIYMCIUTENIbHAS MOIIHOCTh HE
TpaTUIach BIYCTYIO HAa BHIYKMCIICHUE 3HAYEHUH B Y4acTKax, KOTOpbIE B JIIOOOM cily4yae He OyIyT MCIOJIb30BaThCSI.

8.4.6 Hantn npaBunbHble parkoOHbI

C y4e€TOM BbILHGyHOMHHyTOﬁ MECTHOCTH HUCCJIICAOBAHUA HAM H€06XOIII/IMO OrpaHUYIUTLCA CIIEAYIOIUMUA paﬁOHaMI/IZ

Bellville

Cape

Goodwood

Kuils River
Mitchells Plain
Simon Town
Wynberg

KimkauTe paBoii KHOMKOHM MBI Ha cJIoif Districts B maHenu Layers.

2. B nosiBuBIIEMCs1 MeHIO BbiOepuTe IyHKT MeHIo Filter.... [losButcst quanoroBoe okHo Query Builder.
3. Tenepb BaM HaJI0 cO31aTh 3aIPOC, YTOOBI BHIOPATh TOJIBKO Te PaiOHBI, KOTOPBIE SBJISIOTCS KaHIMIATAMH:
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1. B crwcke Fields nBaxapl KIMKHUTE Ha T0j1e NAME_ 2, 9T0OB OHO MOSIBUIOCH B SQL where clause Tek-
CTOBOM ITOJIE HUKE.

2. KimkHute Ha KHOMKY /N uT0OBI 100aBUTH ero k SQL-3armpocy.
3. OrtkpoiiTe CKOOKU.
4. KimkauTe Ha KHOMIKY A/l mof (B HacTosilee BpeMs IycTas) ClickoM Values.

INocne HeOOMBIIION May3bl OH 3aMOJHUT CIIUCOK Values cO 3HAUYSHUSIMU BHIOpAaHHOTO Mojist (NAME_2).

5. IBaxapl KIMKHATE Ha 3HAUeHNe Bel1lville B crucke Values 4toObl jo6aBuTh ero B 3ampoc SQL.

6. JloGaBbTe 3amsTyIO M ABAXK/IbI KIMKHUTE, YTOOBI 100aBUTh palioH Cape.

7. TloBTOpHTE MpEABIAYLIMI MIar JJIs OCTAJIbHBIX PailOHOB.

8. 3akpoiite CKOOKH.
OKoHYaTe bHBIA 3aPOC JIOMKEH ObITh TAKMM (TMIOPSIOK PACIONIOKEHHUS] PAHIOHOB B CKOOKAaxX HE UMeeT
3HAYCHUS):
"NAME_2" in ('Bellville', 'Cape', 'Goodwood', 'Kuils River',

'Mitchells Plain', 'Simon Town', 'Wynberg')

HpnMeanne: BhI Takke MOXeTe UCIIOIb30BaTh orneparop OR; 3arpoc 6yHeT BBIITIACTH TaK:

"NAME_2" = 'Bellville' OR "NAME_2" = 'Cape' OR

"NAME_2" = 'Goodwood' OR "NAME_2" = 'Kuils River' OR
"NAME_2" = 'Mitchells Plain' OR "NAME_2" = 'Simon Town' OR
"NAME_2" = 'Wynberg'

9. Kmmknaute Ha OK nBaXapl.

PaiioHsl, IOKa3aHHBIE Ha Balllel KapTe, TeNeph OrPaHNYEHBI TEMH, KOTOPBIE YKa3aHbI B CIIFICKE BBILIE.

8.4.7 Obpe3ka pacTpos

Teneps, Koraa Bbl CO3/1AJIM MHTEPECYIOLINI Bac PaiioH, BBl MOXKeTe 00pe3arh pacTpsl.

1.

Hazo oTKpBITh AMAIOroBoe OKHO 0Ope3KH, BHIOpAB IyHKT MeHIO Raster » Extraction w Clip Raster by Mask
Layer...

. B packpriBatoiemcst criucke Input layer BbiOepuTe Ciioii BhIOepuUTe Cioi DEM.
. B packpsiBatomemcst criucke Mask layer dBeidepure cioit Districts.

. TIpokpyTHTe BHHU3 M yKaKUTe BBIXOAHOE MECTOMIONIOKEHHE B TekcTe noiist Clipped (mask), KTMKHYB Ha KHOTIKY

... ¥ BbIOpaB Save fo File...
1. Tlepeiinute B KaTajor Rasterprac,
2. Beeaure ums aiina - DEM_clipped.tif,

3. CoxpaHure.

. YBenuch B TOM, 4TO rajouka . Open output file after running algorithm oT™MedeHa.

. Kimmkuwnre Ha Run.

[Mocrie 3aBepieHus onepanyy oOpe3KH OcTaBbTe AuaoroBoe okHo Clip Raster by Mask Layer OTKpPHITHIM 1J1s1
TOTO, YTOOBI MOKHO OBLIO MOBTOPHO UCHOJIb30BATh MECTHOCTb OOPE3KH.

. BoiOepute pactpoBblil cioii Rainfall B pacKpblBalolleMcsl CIUCKe Input layer W COXpaHUTE BbI-

xox/pe3ynbTar Kak Rainfall_clipped.tif.

. He mensiite npyrue napametpsl. OcTaBbTe BCe KaK €CTh U KJIMKHUTE Ha Run.

8.4.

3aHgaTtue: [ononHuTenbHoe ynpaxHeHue 271



QGIS Training Manual

9.

10.

Tocne 3aBepiiieHns1 BTOPOU orepary 0Ope3Ky Bbl MOXKeETe 3aKpbITh Auanoropoe okHo Clip Raster by Mask
Layer.

CoxpaHHTe KapTy.

BbIpOBHSATL pacTpbl

,HHH Haliero aHajin3a HaM HYXXHO, YTOOBI pacTpbl UMEJIN OJUHAKOBLIE CRS u 6butH BBIPOBHECHBI.

CnHayayia Mbl MEHSIEM pa3peuIi€eHME HAllIUX JaHHBIX 1O OCa/IKaM Ha 30 METPOB (paSMep HI/IKCCJ'[H)Z

1.

2.
3.

Hano KIMKHYTH MpaBoil KHOMKOM MBIIIH Ha ciioil Rainfall_clipped u BoiOpaTth Exporte Save As... B
KOHTEKCTHOM MEHIO.

BuyTpu Resolution nactpoiite paspetienue Horizontal n Vertical na 30 (MeTpbl).

Coxpanurte aitn kKak Rainfall30.tif Brainfall/reprojected (File name).

3arem BbipaBHUBaeM LIMP:

1.

5.

Hano KJIMKHYTB [TpaBoii KHOMKOM MbIIIK Ha cjioil DEM__c1 ipped u BiOpath Exporte Save As... B KOHTEKCT-
HOM MEHIO.

2. Hnsa CRS seioepure WGS 84 / UTM zone 33S (EPSG code 32733).
3.
4

BuyTpu Resolution, Hactpoiite pa3pemmenue Horizontal n Vertical Ha 30 (MeTpsI).

. Buytpu Extent, xukaute Ha Calculate from Layer v BoiOepute Rainfall30.

Coxpanure ¢aiin kak DEM30.tif B DEM/reprojected (File name).

Y0081 COOTBETCTBYIOIIIUM 06pa30M YBUIETDH, YTO IPOUCXOIUT, HCO6XOIII/IMO WU3MEHUTD YCJIOBHbBIE 0003HaYEeHHsI CII0-

€B.

8.4.8 NameHeHMe YCNOBHbIX 0603Ha4YeHUN BEKTOPHbIX C/OEB

A

B nanenu Layers KJIMKHUTE NPaBOil KHOMKO MBIILIY Ha CJIOU Streets.

Bribepure Properties 3 TIOSIBUBIIIETOCS. MEHIO.

[epeiinurte Ha BKIAIKy Symbology B IOSBUBILIEMCS IUAJIOTOBOM OKHE.

Kivikau Ha Fill B BepXHel yacTtu.

Bribepure yciioBHOe 0603HaUCHHUE B CITUCKE HIKE WJTA HACTPOUTE HOBHIN (I[BET, IIPO3PAYHOCTS, ... ).

Kiuknure Ha kHoriky OK [Uis TOTo, YTOOBI 3aKPBITh AUATIOTOBON OKHO Layer Properties. 9To U3MeHHUT BU3ya-
JIM3aLMIo ciios Streets.

BrinosiHuTe aHaI0rMYHBIA Mponecc B OTHOIIECHUM CJI0S1 Zonmg n BbI6epI/ITC JJ1d HETrO HO,HXO,HHH_II/IfI OBCT.

8.4.9 U3MmeHeHMe yCNOBHbIX 0603HaYeHUI PacTPOBbIX CIOEB

VcnoBHblE 0003HAYEHUS PpacTpoBOro €04 HECKOJIbKO OTJIMYAIOTCA.

1.

Hapo oTKpbITh IMaIoroBoe OKHO Properties A pacTpoBoro cios Rainfall30.

2. Tlepeiinute Ha BKJIAAKy Symbology. Bbl 3aMeTuTe, 4TO 3TO AUAIOTOBOE OKHO CHUJIBHO OTJIMYAETCsl OT TOM, HC-
TMOJTb3YEeMOU JUTSI BEKTOPHBIX CJIOCB.
3. Pactmpste Min/Max Value Settings.
4. Y6enurecsh, 4To BhiOpaHa KHONKA Mean +/- standard deviation.
5. Ybenutech, 4TO 3HAUCHUE B COOTBETCTBYIOIIEM IMoJie paBHO 2 . 00.
6. B otHomennu Contrast enhancement yoeguTech, 9To TaM yKaszaHo Stretch to MinMax.
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7. Color gradient momensiiite Ha White to Black.
8. Kiuknute OK.

Pactp Rainfall30, eciu OH BUJICH, NOJKEH TIOMEHSITh 1IBETA, U BHI IOJUKHBI YBUIETh Pa3HblC 3HAUCHUS
SIPKOCTH JIJIS1 KQJK/IOTO TTUKCEJIS.

9. TNoBropure 3TOT Hporecc Ais ciosg DEM30, HO HACTPOWTE CTaHJAPTHbIE OTKJIOHEHHUs, UCTIOJb3yeMble IS
pactskenus, Ha 4 . 00.

8.4.10 BbluucTKa KapThbl

1. Vmanurte ucxomusle cion Rainfall u DEM, a Takxke Rainfall_clipped u DEM_clipped B naHenu
Layers:

¢ KimkHHTE 9TH CJIOM NIPaBOi KHOIKOM MBIIIU U BIOepUTe Remove.

IIpumevanne: DTo He MPUBEET K yIAICHHIO IAaHHBIX C BAIlIEr0 yCTPONCTBA XpPaHEHHsI, a POCTO yoepeT
WX C Balllell KapThl.

2. CoxpaHuTe KapTy.

3. T€H6pb Bbl MOXKETE CKPbITb BEKTOPHbIC CJIOU, CHAB (1))'[3)1(01( C AYEeUKHU pAAOM C HUMU B NIAHEIN Layer s. D10
YCKOPUT BblAa41y KapThl U COKOHOMUT BaM BpEM:.

8.4.11 Co3paHue OTMbIBKM

YToObl CO371aTh OTMBIBKY BaM HaJI0 OY/IET UCIIOIb30BATh AJITOPUTM, KOTOPBIA ObUT HATIMCAH JIJIST 3TOM LIeJTH.
1. B manemu Layers yoeautech, uto DEM30 sIBISICTCS aKTUBHBIM CJIOEM (T. €. BBIICJICHO IIETIKOM).
2. Hajo kivkHYyTh Ha MeHIO Raster » Analysis » Hillshade... 4toObl OTKpbITH inaioroBoe okHo Hillshade.

3. IIpokpyrute BHU3 N0 Hillshade w coxpaHuTe pe3ysibTaT/BBIXOJ B BallleM Kartajore Rasterprac Kak
hillshade.tif.

4. Yb6enuch B TOM, UTO rajioguka o Open output file after running algorithm oTMeueHa.
5. Kimkuaure Ha Run.
6. TopoxauTe, MOKa OH 3aKOHYHUT 0OPabOTKY.

Hogwiii cioit hillshade nossnsercs B nanemu Layers.

1. KinuknHure HpaBoﬁ KHOIKOW MBI Ha cioil hillshade B maHenmu Layers M BBI3OBHTE JUAJIOTOBOE OKHO
Properties.

2. Knuknu Ha BKIaaky Transparency u HacTpoute nonsyHok Global Opacity na 20%.
3. Kinuknure OK.

4. O6parute BHUMaHKE Ha 3 dEKT, Korma mpo3payHasi OTMbIBKA HAKJIAIbBaeTCsl Ha oOpe3anHbii [IMP. Bam
TIPUIETCSI, BO3MOKHO, I3MEHHTH IMOPSJOK BAIlIUX CJIOEB WJIM BBIKJIIOUUTH CJIo Rainfall30, 4TOOBI YBUIETH

acpdekr.
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8.4.12 YKNOH

5.
6.

KiukHu Ha yHKT MeHI0 Raster » Analysis » Slope... U1s1 TOT0, 4TOOBI OTKPBITh AITOPUTM Slope.

Bribepure DEM30 B kauectBe Input layer.

OTMeTbTe rajouky oA Slope expressed as percent instead of degrees. YKIIOH MOKeT ObITh BBIPAXEH B Pa3iny-
HBIX eMHMIaX (MIPOLEHTaX WM Tpajaycax). Hamm Kputepuy mpenosaraioT, 4To Halle pacTeHue pacTeT Ha
CKJIOHAaX C YKJIOHOM OT 15% 1o 60%. [losToMy HaM HyXKHO YOEAWTHCS, UTO HAIIM JaHHBIE 00 YKJIOHE BHIpa-
JKEHBI B TIPOLIEHTAX.

Vkaxure COOTBETCTBYIOIIICC UM cpai?ma 1 pacCnoJIORKEHUE Jid BallleTo BBIX0J1a/| pe3yJbTara.

Y6emuce B TOM, YTO TaJlouKa o Open output file after running algorithm oTMeueHa.

Kiukuure Ha Run.

N300paxenue yKIoHa ObLTO BBIUKCIICHO U JOOABICHO Ha KapTy. Kak 00bYHO, OH OTOOpakaeTcst B OTTEHKAX Ceporo.
W3menute ycnoBHOe 0003HaUeHUe Ha 0oJiee KPACOUYHBIH CBET:

1.
2.

OTKpOfITC JIMAJIOTOBOE OKHO CJIos1 Pri oper ties (KaK OOBIYHO YE€pE3 MEHIO MPABOro meJI9Ka C.HOH).

Knvuknu Ha BkIagky Symbology.

. Tam e ckazano Singleband gray (B packpbiBaioiieMcsi MeHIO Render type) m3meHute ero Ha Singleband

pseudocolor.

. Buibepure Mean +/- standard deviation x nyist Min / Max Value Settings co 3HadeHuem 2 . 0.
. Buibepure nogxopsiuii Color ramp.

. Knukuure Ha Run.

8.4.13 NMonpobywnte camu: NMopaboTaTtb C acNeKTOM

IIpumeHunTE TOT K€ TIOJIXO/I, YTO U BBIYKCIICHHSI YKJIOHA, BHIOpPaB Aspect... B MeHIO Raster » Analysis.

HOMHI/ITC, YUTO HAJA0 NEPUOANYICCKHN COXPAHATDL ITPOCKT.

8.4.14 lNepe-knaccucpmukauma pactpos

1.
2.

3.

Bribepure Raster » Raster calculator...

VkaxuTte cBoil kaTanor Rasterprac kak Mecto g Output layer (KJIMKHYA Ha KHOIIKY ...) U COXPaHUTE Kak
slopel5_60.tif.

Vo6emurtecs, uto siueiika Open output file after running algorithm otmedeHa.

B cniicke Raster bands cneBa Bbl yBUANUTE BCE paCTPOBBIE CJION B Ballle aHenu Layers. Eciu Baii ¢oil YkJIoHa
HasbiBaeTcs slope, oH OyJeT yKkaszaH Kak s1lope@1. O603HaYeHue MoJockl 1 pacTpa yKJIOHOB.

4. VKJIOH JoJDKeH OBITh MeXAy 15 u 60 Tpagycamu.

S.

Hcronp3yst 351eMeHTHI CITUCKA M KHOTIKY B MHTepdelice, HaI0 CO3AATh CJIeAyIoIIee BEIPaXKeHNE:

(slopel@l > 15) AND (slope@l < 60)

Hacrpoiite none Output layer B COOTBETCTBYIOIIIEE MECTO U MM (paiiia.

6. KimkHuTe Ha KHOMKY Run.

Teneps HaliaAnTe MPABUJILHBIN ACTIEKT (HaNpaBJIEHHBIM Ha BOCTOK: Mexk Iy 45 1 135 rpagycamu), UCHIONIb3YS TOT Ke
MOZIXO/.

1.

Ioctpoiite cnenyolee BrIpakeHUE:
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(aspect@l > 45) AND (aspect@l < 135)

Bnl HOﬁMCTC, 4TO y BaC BCE NNOJIYyYUJIOCh, KOI'la BCE YKJIOHDbI, HAITPABJICHHBIEC HA BOCTOK, CTAHYT OeNbIMU B BBIXOJJHOM
pactpe (KaK ecv Obl OHM OBLIH OCBEIICHbI YTPEHHUM COJIHEYHbIM CBETOM).

Bam Ha/1o HalTH OMpeNeNNTh MPaBUIbHOE KOJTMIECTBO OCaKOB (0oJbiie, yeM 1000 MM) TakuMm ke oopazom. Uc-
TMOJIB3YHTE ClieyIoIIee BEIpaXKeHNE:

Rainfall30€1 > 1000

Tenepp, koraa y Bac €CTb BCe TPU KPUTEPHS B OTAESIBHBIX PaCTpax, BaM HyXKHO OOBEAUHHUTD UX, YTOOBI ONIPE/eIUTb,
KaK{e Y4acTKM COOTBETCTBYIOT BCeM KpHUTepHAM. Il 3TOro pacTpsl HaJO YMHOXKHTH Ipyr Ha japyra. Korma 3to
MIPOUCXOJUT, BCE MEePEeKphIBAIOIIMECS MTUKCEIN CO 3HaYeHHeM 1 COXpaHAT 3HaueHue 1 (T.e. MECTOMNOJIOKEHUE COOT-
BETCTBYET KPUTEPHUsIM), HO €CJIM NIMKCENb B JIOOOM M3 TPEX pacTpoB MMeeT 3HaueHue O (T.e. MECTOIOJIOKEHNE He
COOTBETCTBYET KPUTEPUSAM), Torga oHo Oyner O B pesyabrarte. Takum o6pa3om, pe3ysibTar OyJeT cofepkaTh TOJIbKO
MEPEKPHIBAIOIINECS YUaCTKH, KOTOPbIE COOTBETCTBYIOT BCEM HEOOXOAMMBIM KPHTEPHSIM.

8.4.15 O6bennHeHue pacTpoB

1. Hano otkpeith Kaavkyasmop pacmpa (Raster » Raster Calculator...).

2. COSﬂaﬁTC cJIeaywuee BbIpakeHNUe (C COOTBETCTBYIOILIMMU HA3BAHUAMU BallIUX CHOGB)Z

[aspectd45_135] * [slopel5_60] * [rainfall_1000]

3. Hacrpoiite BBIXOJHOE MECTOIOJIOKEHHE H KaTaJlor Rasterprac.

4. HazoBuTe BBIXOTHOH pacTp aspect_slope_rainfall.tif.

5. Ybeautech, 4TO OTMEYEHA rajouka o Open output file after running algorithm.

6. Kiuknure Ha Run.
B HOBOM pacTpe Ternepb MPaBUIIbHO OTOOPAKAIOTCS YUACTKH, COOTBETCTBYIOIINE BCEM TPEM KPUTEPHUSIM.
CoxpaHHTe MPOEKT..

CreyoIuii KpUTepHid, B OTHOIIEHUH KOTOPOTO JOJKHO OBITh 00eCIeueHO COOTBETCTBHUE, ITO TO, YTO YIACTOK JO0JI-
JKeH HaXOJIUThCS Ha PACCTOSHUM B 250 M OT FOPOJICKOH 3acTpoiKu. MbI 00ecrieurM COOTBETCTBUE ITOMY TpeOoBa-
HUIO TEM, YTO BBIYHCIISIEMbIe HAMU YJAaCTKH OYAyT HAXOMUTHCS B CEILCKOM MECTHOCTH M B 250 M U HoJiee OT Kpast
ydactka. [ToaTomy, HaM HaJl0 CHavYaJla HAWTH CIHCOK BCEX CENbCKUX HACETEHHBIX ITYHKTOB.

8.4.16 lMNMouck cenbCKMX HaceneHHbIX MYHKTOB

1. Hapmo ckpbITh Bce ciiod B aHeu Layers.
2. TlokaxuTe BEKTOPHBII coi Zoning.

3. KiMKHHTE HA HEro MPaBOW KHOIMKOW MBIIIN U OTKPOITE AUANOroBoe OKHO Aftribute Table. O6partute BHUMA-
HHMe, YTO TaM €CTh MHOXECTBO Pa3/IMYHbIX CIOCOO0OB 30HMPOBaHMUs 3eMii. Ham Hafo M30/MpoBaTth cesbCKue
HaceJIeHHbIE TYHKTHL. 3aKporTe TaHIly aTpuOyTOB/aTpHOyTOB.

4. KnukHuUTE NMpaBOi KHOIMKOW MBIIIM Ha CJIOH Zoning u BoiOepute Filter... 1Jist TOTO, YTOOBI BBI3BATH JHAJIO-
roBoe okHO Query Builder.

5. Cozpaiite creqyOMUH 3aMpoc:

"Gen_Zoning" = 'Rural'

CM. npeplay1yie MHCTPYKIIMH, €CJIU BBI IIe-TO 3acCTpsIHETE.

6. Hayo ki1ukHYyTh Ha KHONKY OK Uit TOrO, 4TOOBI 3aKPHITh AUAIOroBoe oKHO Query Builder. 3anpoc 10JkeH
BEPHYTh OJJHY (PYHKIIHIO.
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BrI yBUOMTE CEbCKHUE MOJUTOHEI B ¢l10€ Zoning. Bam Ha/lo MX COXpaHUTB.

1.

B MeHI10 mociIe HaxaTHsI MPaBOM KHOIIKY MBIIIK Ha Zoning, Halo BeIOpath Export » Save Features As....

2. CoxpaHute CBOM CJION BHYTpU KaTajora Rasterprac.
3.

4. Knuknute OK.

5.

Hazosute BbIxOmHOM aiin rural . shp.

CoxpaHHTe IPOEKT.

Temeppr HAIO WCKITIOUXTD YYACTKH, KOTOPBIE HAXOASTCS HA pacCTOSTHUM 250m OT OKpPauHBI CeJTbCKONH MECTHOCTH.
3TO0 MOXKHO C/ENaTh, CO3/IaB OTPUIIATENIbHBIN Oy(dep, Kak OMMUCAHO HIKE.

8.4.17 Co3paHue oTpuuatenbHoro bydepa

9.
10.

Bam

. Kimnknure Ha myHKT MeH1o Vector » Geoprocessing Tools » Buffer...

B nuanoroBoM okHe, KOTOpOE MOSIBUTCS, BBIOEPHTE CJI0i rural B KAYeCTBE BXOJHOTO BEKTOPHOIO CJIOs (Ta-
nouka B Selected features only He TO/KHA ObITh AKTUBHOM).

Hacrpoiite Distance Ha —250. OTpunartensHoe 3HaUSHHe 03HaYaeT, uto Oydep Oyaer BHyTpeHHUM. Yoeau-
TECh, YTO B PACKPBIBAIOIIEMCSI MEHIO METPhI YKa3aHbl B KAUECTBE eUHHUL] H3MEPESHHUSI.

OTMeTbTe rajnouky o Dissolve result.

B Buffered, nomectute BRIXOOHOM (haiin B Kataynore B Rasterprac u Ha3oBuTe ero rural_buffer.
shp.

Knuknaure Ha kHONKY Save.
KnvkHauTe Ha KHOIIKY Run M JOXAUTECHh 3aBepIIeHHUs] 00paOOTKU.
3akpoiiTe Auanoropoe okHo Buffer.

Y6enurech, uro Bain Oydep oTpadoTas MPaBUIILHO, OCMOTPEB KakK OTIMYaeTcs clioil rural_buffer or
cnost rural. Bam, ckopee Bcero, Hano OyeT M3MEHUTD MOPSIIOK N300PaKEHHUs, YTOOBI YBUIETh PA3HUILY.

Yo6epurte cioit rural.
CoXpaHUTE TIPOEKT.

Teriepb  HEOOXOAMMO  OOBECAMHMTH  Balll BEKTOPHBIA CBOM rural_buffer ¢  pacrpom

aspect_slope_rainfall. [Ins Toro, 4toObl OOBEAMHHUTH WX, HAM HAI0 M3MEHUTh (POpPMAT JAHHBIX O[-
HOT'O U3 cJIoeB. B 3TOM cilyyae BaM HaJI0 BEKTOPU30BATh PacTp, TaK KaK BEKTOPHBIE CJIOU OoJiee YIOOHBI, KOTIa MBI
XOTHUM BBIYUCJIUTD TUIOLIAAN.

8.4.18 BekTopu3auusa pactpa

6.
7.

. Hamo kyMKkHYTh Ha MyHKT MeHI0 Raster » Conversion » Polygonize (Raster to Vector)...

Beibepure pactp aspect_slope_rainfall kak Input layer.

Hacrpoiite Name of the field to create Ha suitable (Ha3BaHHMEe MO MO0 yMoadaHuio DN - [JaHHbIe mugpo-
BOT'O HOMeEpa).

Coxpanure Bbixoa. BHytpu Vectorized Boibepute Save file as. YcraHOBHUTE MECTONIOJIOKEHUE B Rasterprac
1 Ha3oBUTe (ailll aspect_slope_rainfall_all.shp.

Yb6emurech, 9TO OTMeUeHA TATOUKA o Open output file after running algorithm.
Kiuknute Ha Run.

3aKpoiTe AUATOrOBOE OKHO MOCTIE 3aBEPIICHUS 00PaOOTKH.

Bce yuacTku pactpa OblIM BEKTOPU30BAHBI M BaM HaJI0 BHIOPATh TOJILKO T€ YYACTKH, KOTOPhIE MMEIOT 3HaYeHue 1 B
nosie suitable (Ludposoit HOMeD).
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. Otkpoiite quanoroBoe okHO Query Builder (KJIMKHWUTE TMpaBOi KHOIIKOW MBIIM - Filter...) U1 HOBOTO BEK-

TOPHOTO CJIOSI.

Cozpaiite 9TOT 3anpoc:

"suitable" = 1

Kiuknure OK.

Iocne Toro, Kak Bbl Oy/ieTe yBEPEeHbI, YTO 3aIpoC 3aBeplieH (M MOKa3aHbl TOJBKO Te YYACTKH, KOTOPBIE CO-
OTBETCTBYIOT BCEM TPEM KpPUTEpHUsM, T.€. CO 3HAUeHHeM 1 ), co3[aiTe HOBBII BEKTOPHBIN (pailT HA OCHOBE
pe3yabTaToOB, UCNONB3Ysl Export —> Save Features As... 4epe3 MEHIO MpY HAKATUU TMPABOM KHOMKU MBIIIN
TOCJIe HaXkaTusl Ha CJION.

. Coxpanwurte ailn B Karajore Rasterprac.

5
6.
7
8

Hazosute ¢aitn aspect_slope_rainfall_1.shp.

. Ybepure cioit aspect_slope_rainfall_all c Baiiei KapThl.

. CoxpaHute cBOI1 IPOEKT.

IMpu KCHONB30BaHUK ANTOPUTMA JIJIsi BEKTOPHU3AIIMU PACTPa, MHOTIA AITOPUTM BBIIAET TaK HA3BIBAEMbIE «HEBEP-
HbIE TEOMETPHUM», TO €CTh MYCThIE MOJUTOHBI WM TIOJIMIOHBI C OIIMOKaMHU, KOTOpPbIe TPYIHO MPOAHATM3UPOBATDH B
Oymyiiem. Ham Hago ucnonb3oBaTh HHCTpYMEHT “Fix Geometry” (McrnpaBieHHe TeOMETPHN).

8.4.19 UcnpasneHune reomeTpum

5.
6.

. B Processing Toolbox Hano uckath «Fix geometries» U BbIIIOJHUTB ero Execute....

st Input layer Hano BeOpaTh aspect_slope_rainfall_1.

Ion Fixed geometries Hano BuIOpath Save file as v coxpaHUTe BHIXOJ B Rasterprac U Ha3BaTh hailn
fixed_aspect_slope_rainfall.shp.

Yb6emutech, 9TO OTMEUEHA TAIOUKA o Open output file after running algorithm.
Kiuknute Ha Run.

3aKpoiTe AUATOrOBOE OKHO MOCTIE 3aBEPIICHHUST 00PaOOTKH.

BBl BeKTOpU30BaIM pacTp M MCIPABIIM TEOMETPHIO M BB TENeph CMOKETe OOBEIUHUTh KPUTEPUH aCTIeKTa, YKIIO-
Ha M OCAJIKOB C KPUTEPUAMM PACCTOSHHS OT HACEJIECHHBIX ITyHKTOB, ITyTEM OIIPEAEJICHUA NEPECEYEHMS CIIOA
fixed_aspect_slope_rainfallucnoda rural_buffer.

8.4.20 OnpepeneHue nepece4yeHUs BEKTOPOB

®© N o L AW

. Knuknure B nyHkT MeHio Vector » Geoprocessing Tools » Intersection...

. B mnajioroBom okHe, KOTOpO€e MOSIBUTCS, BI)I6epI/ITe ciont rural_buffer kak Input layer.
. st Overlay layer BoiOepute cioli £ixed_aspect_slope_rainfall.

. B Intersection momectute BHIXOJHOH (hailsl B KaTayiore Rasterprac.

. HazoBure BbixoaHoi1 (pailn rural_aspect_slope_rainfall. shp.

KnvknauTe Ha KHOIIKY Save.

. Kiiuknute Ha KHOMKY Run U TOXKAUTECH 3aBepliieHns1 00pabOTKH.

. 3akpoilte TuajloroBoe OKHO Intersection.

YGC,I[I/ITCCI), 4TO Ballle repeceyeHre cpa60Tan0 MMpaBUJIbHO, OTMETHUB, YTO OCTAJIMCh TOJIbKO IEPEKPLIBAIOIIN-
€Cs y4aCTKU.

. CoxpaHuTe MpOEKT.

8.4.
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Crieiy1oluM KpUTEpHEM B CIIUCKE SIBJISETCS TO, YTO pa3Mep ydacTKa JOJDKeH ObITh Oouibiie, yeM 6000 m?2. Bam
HAJI0 BHIYUCIIATD TUIOIIA/IN TTOJMIOHA IJIS1 TOTO, YTOOBI ONPEAEIUTh YIACTKH, KOTOPBIE UMEIOT MOIXOIAIIMA pa3mMep
JUIS 3TOrO MPOEKTA.

8.4.21 BbluMcneHue nnowLanuv aasi Kax.noro nosiMroHa (MHOroyrosibHuKa)

1. OTKpoiiTe MEHI0O HOBOTO BEKTOPHOTIO CJIOS Yepe3 HakaTue MPaBoOil KHOMKY MbIIIH.

2. Bwibepure Open attribute table.

3. Kimuknure Ha knonky Toggleediting g gepypem eBoM yrity TaGauIBI MM KIMKHATE Ctrl+e.

4. KnukHUTE Ha KHOMKY E 5] Open fild caleultor B IIAHEJTM MHCTPYMEHTOB B BEpXHEW YacTH TAOJUIIBI VUK KJIMKHUTE
Ctrl+i.

5. B nosiBUBIIIEMCs IMATIOTOBOM OKHE yOeIUTeCh, YTo 0OTMeveHa raiodka Create new field v nactpouite Output
field name Ha area. T MoJs BRIXOJA JOJDKEH OBITh ASCATHYHBIM YKCIIOM (IekicTBUTE bHBIM). HacTporite
Precision Ha 1 (OIHO JECATUYHOE).

6. B Expression Habepure:

Sarea

10 O3HAYA€T, YTO KAJIBKYJIATOP IOJIA BBIYMCIUT IUIOIAAb KaKAOro IMOJMIOHA B BEKTOPHOM CJIOE€ U 3aTEM
3aTI0JIHUT HOBBIA HGHO‘II/ICHGHHBIﬁ CTOH6€LI (Ha3bIBaeMbIﬁ ar ea) C BbIYMUCJICHHBIM 3HAYCHUEM.

7. Kinuknure OK.

8. Tlponemnaiite TO ke camoe B OTHOILIEHUH APYTOro HOBOTO MoJisA 1o Ha3zBaHueM 1 d. B Field calculator expression
HabepuTe:

$id

3710 06ECTIEUUT TO, YTO KAKABIA MOJTUTOH OyIET UMETh YHUKATBHBIN WICHTU(UKAIIMOHHBIA HOMEep IS Iesei
UAECHTU(PUKALIH.

9. KiukHuTe cHOBa Ha [  Tosgle editing COXpaHUTE Balll U3MEHEHHUS], eCIi OYIeT MPeIOKEHO CAEIaTh TaK.

8.4.22 Bblbop yuacTka 3apjaHHOro pasmepa

Termneps, KOrga BaM U3BECTHBI YUaCTKU:

1. Cospaiite 3ampoc (Kak OOBIYHO), YTOOBI BHIOPATh TOJBKO Te MOJIUTOHBI, KOTOphIe Oosbiie yeM 6000 m2.
3ampoc Takou:

"area" > 6000

2. Coxpanute BBIOOp B Karajore Rasterprac Kak HOBBIH BEKTOPHBI CJIOW C Ha3BaHHWEM
suitable_areas.shp.

V Bac Tenepb MOAXOJALIME YIACTKH, OTBEYAIOIME BCEM KPUTEPHAM Cpefibl OOUTaHUS AJIs1 PEAKOTO pacTeHus (puH-
60c, U3 KOTOPBIX BbI JOJIKHBI BHIOPATh YETHIPE YUacTKa, KOTOPBIE SIBJISIOTCS OnvkaliuvMu K KeiinrayHckoMy yHU-
BEPCUTETY.
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8.4.23 OuucppoBka KenntayHckoro yHusepcureTta

A

10.

11.
12.

13.
14.
15.

Co3paiiTe HOBBIN BEKTOPHBII CJI0i B KaTajiore Rasterprac , Kak U paHbllle, HO Ha 3TOT pa3 UCIOJIb3YyiiTe
Point xak Geometry type v Ha30BUTe €ro university. shp.

Yo6emutecs B npaBmibHOCTH CCK (Project CRS:EPSG:32733 - WGS 84 / UTM zone 33S).
3apepmnTe CO3JaHNE HOBOTO CJI0s1 (KJIIMKHHUTE Ha KHOMKY OK).
CkpoliTe Bce CJIoM, KpOMe HOBOTO CJIos university u cnos Streets.
JHob6asbre horoByio kapty (OSM):
1. 3axogute Ha maHenb Browser u nepevinute K XYZ Tiles » OpenStreetMap.
2. TlepetamuTe u pa3mecTuTe OpenStreetMap B HUXKHIOW YacTh MaHeTu Layers.

B cBoeM uHTEpHET-Opay3epe HaiiauTe pacrosiokenue KeiinrtayHCKOro yHUBepcuTeTa. YUUThIBasK YHUKAIBHYIO
tonorpacgmio Keiinrayna, yHuBepcUTeT HAXOUTCS B OYeHb y3HABaeMOM MecTe. [Ipesk/ie ueM BBl BEpHETeCh B
QGIS, obparute BHUMaHKE HA TO, TJIe HAXOIUTCSI YHUBEPCUTET U YTO HAXOJUTCS PSJIOM C HUM.

VY6eaurech, 4To CIOM St reet s OTMeYeH, B IO univers ity BblAeNeH B maHenu Layers.
Iepeiigure B nyHKT MeHI0 View » Toolbars u yoemurtech, uto BeiOpaH Digitizing. Tlocie 9TOro Bbl JOJKHBI

YBUJIETh Ha TIAHEJIM MHCTPYMEHTOB 3HA4OK ¢ KapaHpamom (# Toegleediing) 3r6 xponka nepexarouenus pe-
OaKmMupoBanusl.

Kimmknure Ha kHONIKY Toggle editing 1u1st TOTO, YTOOBI BOUTU B pedicuMm peOakmupoeanusi. IT0 O3BOJIUT BaM
PENaKTUPOBATh BEKTOPHBII CIIOMA.

@

[+]
KyukHuTe Ha KHomKy ° £3 Add Point Feature

, KOTOpas JI0JIKHA OBITh PAIOM C KHONKo# #  Toggle editing

AXTHBHPOBaB UHCTPYMEHT Add feature, KIMKHUTE JIEBOW KHOIIKOW MBI 110 HanboJiee TOYHOMN OLIEHKE Me-
cronosioxkenus: KefinrayHCcKoro yHuBepcurera.

VYKkaxuTe Npou3BOJIbHOE LIEJI0€ YnciIo id.

Knuknaute OK.

KJIMKHUTE HA KHOIKY [ # Save Layer Edits,
Kiuknure Ha kuonky Toggle editing 1j1st TOTo, 4TOOB OCTAHOBUTH PEKUM PEJAKTUPOBAHMUSL.

CoxpaHHTe TPOEKT.

8.4.24 Mowmck 6nmxanwmnx mect K YHusepcutety KennrayHa

6.
7.

. Hepeitnute B Ianeav uncmpymenmos oopabomku, Haigute Join Attributes by Nearest anroputm (Vector

general » Join Attributes by Nearest) 1 BbIIIOJHUTE €TO.
Input layer nomken ObITh university, a Input layer 2 suitable_areas.
YKkaxuTe COOTBETCTBRYIOIIEE BHIXOAHOE MECTOIOJIOKEeHNE | Ha3BaHue (Joined layer).

Hacrpoiite Maximum nearest neighbors Ha 4.

VY6emutech, 4TO OTMEUEHA rajlouKa o Open output file after running algorithm.
JIJ1s1 OCTANIBHBIX MAPAMETPOB OCTABHTE 3HAUECHUS 110 YMOJTYAHUIO.

Knukuure Ha Run.

BbIXO/IHOI TOYEUHBIH CJI0W OyleT cofiep)aTh YeThipe 00bEKTa - BCe OHM OYIyT MMETh MECTOINOJIOKEHUE YHUBEP-
CHUTETa W €ro aTpuOYTHI, a TaKXe aTpuOyTHl OJIM3JEKAIMX MOAXOJAIINX YYaCTKOB (BKI0Yast 1d) U paccTOsIHUE 10
3TOTrO Y4acTKa.

1.

OtkpoiiTe TabIUILy aTPUOYTOB Pe3yJIbTaTa COeUHEHNUSI.
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2. OrmeTbTe 1d YeThipex ONMKANIIMX HOIXOASIIMX YUACTKOB, a 3aTeM 3aKpONTe TaOJIHILy aTpHOYTOB.
3. Orkporite TabumIy aTpudyTOB cllost suitable_areas.

4. Co3zpaiite 3ampoc, 9ToOBl BHIOPATh YETHIPE MOIXOAIINX YIACTKA, OMVKAUIINX K YHUBEPCUTETY (BHIOMpAst UX
C TIOMOIIBIO TT0JIA 1id).

STO ¥ eCTh OKOHYATEJIbHBIN OTBET Ha BOIIPOC UCCJIENOBAHUA.

Co3paiiTe NMOJHOCTHI0 MAapKHUPOBAaHHBI MAaKeT, KOTOPbIH BKJIOYAET IOJYNPO3PAyHBIA €O OTMBIBKH IOBEPX
pactpa mo Bamiemy BeIOOpy (Hampumep, LIMP wmm pactpa ykiona). Takxke BKIIOUMTE CJIOH YHHUBEpCHTETa
u suitable_areas cBbIIEIEHHBIMU YE€THIPbMS TOJXOASAIIMMH yJaCTKAMH, OMVKaNIIMU K yHUBepcuTety. [1pn
CO3IaHMH BBIXOJHOM KapThl CJIEAyHTE BCEM MEPEA0OBBIM METOIaM KapTorpaduu.
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rnasa 9

Moaynb: [narvHbl

[TnaruHel AaI0T BO3MOKHOCTb paclIMpUTh PyHKIMOHAIBHOCTD QGIS. B aTOM MOAYyJie Mbl BaM MOKaxkeM, KaK aKTH-
BUPOBATH U MCIIOJIb30BATH TUIATHHBI.

9.1 3aHaTUe: YcTaHOBKa U ynpasneHne nnarnHamum

T st Toro, 4ToObl HAYATH MCIIOIb30BATH IUIATMHBI, BaM HYXHO 3HATh, KAK UX 3arpy3UTh, YCTAHABIIMBATh U AKTHBU-
poBath. Bbl HayuuTech ucnosb3oBath Plugin Installer u Plugin Manager.

Hean 3T0ro0 ypoka: IloHsaTs u ucnosyb3oBath cucreMy miaruHos QGIS.

9.1.1 \ Nnem panblie: YnpaesneHue nnaruHamm

1. st Toro, utoObl OTKPHITh Plugin Manager Haio KJIMKHYTh Ha MYHKTY MeHIo Plugins » Manage and Install
Plugins.

2. B oTKpbIBIIEMCS IMAJTIOTOBOM OKHE BaM HaJ0 HaWTH I1aruH Processing plugin:
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Plugins | All (219)

< proce

# Append Features to Layer | This is a core plugin, so you can't uninstall it

4+ Batch Hillshader . "
ot inctaled + Cloud Mzsking Processing
4 Contour plugin
Invalid # dzetsaka : Classification to Spatial data processing framework for QGIS
. Install from ZIP : zf:‘gl:l: Spatial data processing framework for QGIS
# SSIE : ::::ZEOPFOCQSSW Category Analysis
4 Lat Lon Tools More info homepage bug tracker code repository
& MAJIC Author Victor Olaya
4+ Mascaret Installed version 2.12.99
# qgsurf

4 Semi-Automatic Classificati

Help ¥ Close

3. KiukHHTE Ha SYSHKy pSAIOM C STHM IUIArMHOM M CHUMUTE (PIIaXoK, YTOObI IEAaKTUBUPOBATD €TO0.
4. Knuknute Ha kHOnKy Close.

5. TlocMoTpuTe Ha MEHIO, BBl 3aMETUTE, YTO MEHIO Processing uc4e3sno. DTo 03Ha4aeT, 4YTO MHOTHE U3 (PYHKIMNA
00pabOTKH, KOTOPHIMH BHI ITOJIb30BAJIMCE paHee, ucuesim! Hanpumep, mocmotpure Ha MeHio Vector » 1 Raster
». IT0 U3-3a TOTO, YTO OHH SBJISIOTCS YACTBIO IUIaTMHA Processing, KOTOPBIA HEOOXOAUMO aKTHBHUPOBATb,
YTOOBI HCIOIB30BATD HX.

6. Otkpoiite cHoBa Plugin Manager v ak TUBUPYWTE IJIArMH Processing, OTMETUB TaJIOUKY B sTUEHKE PSIIOM C HUM.

7. Close puanoroBoe okHO. MeHIo Processing (DyHKIIMY CHOBA JOJIKHBI CTaTh JOCTYITHBIMU.

9.1.2 \ Npem panblie: YcTaHOBKA HOBbIX NM1arMHOB

Crumcok TUTAarMHOB, KOTOPBIE BBl MOXKETE aKTUBUPOBATH U NCAKTUBUPOBATH, ITOJIYYEH U3 IVIArMHOB, KOTOPLIE BHI B
HacToAlIee BpEMA YCTAaHOBUIIU. ,H,HH TOrO, YTOOBI YCTaHOBUTH HOBBIC IJIArMHBI BaM Ha/10:

1. Bwibepure ommio Not Installed B nuanorosom okue Plugin Manager. Tlnarunel, 1OCTYITHBbIE JUTST YCTAHOBKH,
OyIyT NOKa3aHbl B CIIMCKE. DTOT CIHCOK OyIeT OTINYaThCs B 3aBUCMMOCTH OT Ballleil CyIIeCTBYOILIEH Ha-
CTPOWKH CHUCTEMBI.
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Plugins | Not installed (205)

. All [a]

i installed & AcATaMa “ Not installed plugins
S 4+ Advanced Line Editor
: Here you see the list of all plugins available in the repositories, but
: 4 AmigoCloud ] N
i Not installed 9 which are net yet installed.

4+ Another DXF Importer / DXF2Shape Converter Click on the name to see details.

nvald 4 Append Features to Layer You can change the sorting via the context menu (right click).
T — 4 arrayPlus A plugin can be downloaded and installed by clicking on it's name,
Install from ZIP 4 Asistente LADM_COL and then click the 'Install plugin' button.
# Settings 4 Attribute painter

4+ AttributeAssignment

4+ AustrianElevation

4+ autoSaver

4+ Azimuth and Distance Calculator
4+ Batch Hillshader

4+ Beeline

4+ beePen

4+ Bivariate legend

4+ Buffer by Percentage

4+ CAIGOS PostgreSQL Konnektor
4+ Calculate Geometry

& cartogram3

4 CDAU Downloader

4 Clipper

4 Cloud Masking

4+ ClusterPoints

4 Contour plugin

4+ CoordGuesser

4+ Coordtransform

#. CSManMaker !

| [B|Help | ¥ Close

2. Haiipute cBeaeHus O TUIarMHe, BHIOPAB ero B CIKCKe.

Plugins | Not installed (205)

Batch Hillshader =
et Data Plotly Vs
4 beePen —
4 Bivariate legend D3 Plots for QGIS
% Invalid 4+ Buffer by Percentage Draw D3 plots in QGIS
4+ CAIGOS PostgreSQL Konnektor
Install from ZIP # Calculate Geometry TITTTII0TY 17 rating vote(s), 12489 downloads
4 cartogram3
4+ CDAU Downloader Tags plots.graphs.d3.python,vector
& Clipper More info homepage bug tracker code repository
4 Cloud Masking Author Matteo Ghetta (Faunalia)

4 ClusterPoints
4+ Contour plugin

Available version 1.5

4+ CoordGuesser

4+ Coordtransform

4+ CSMapMaker

4 CZML Generator

4+ D3 Data Visualization

4+ Data Analysis and Visualization

4+ Digitizing Tools

4+ DirectionalSlope

4 Discovery

% Dot Map

4+ DWA M150 XML Import

4+ dzetsaka : Classification tool

4+ EasyCustomLabeling =
4. FcoValuator b’ Install plugin |

| [@lHelp | # Close |

3. VYcraHOoBUTE Te IUIArMHbI, KOTOPHIE Bac MHTEPECYIOT, HakaB Ha KHOMKY /nstall Plugin mop naHebio cBeJeHUH
0 IUTaruHe.

IIpumeuyanne: Eciu B maruHe ectb omuoOKa, OH OylIeT B clMcKe 3akiaiku  Invalid. Bel cMoxeTe cBsizaThes C
BJIa/IeNIbIIeM TUIarMHA, YTOOBI PEIUTh POOIIeMy.
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9.1.3 \ Upem panbuie: Hactponka A0ONOSIHUTENbHbIX Peno3nTopues nna-
rMHOB

Ha60p IJIaruHOB, JOCTYIIHBIX JJId BAC, 3aBUCUT OT TOI'O, HA KAKKWE peno3umopuu TIJIarHOB HACTPOEHA Ballla CUCTEMA.

ITnarunbt QGIS xpaHsiTcs B OHIalH pero3utopusix. [1o yMOTYaHHIO TOIBKO ~OMUIMATLHBINA PENO3UTOPUN —_ SIBJISI-
€TCsI aKTUBHBIM U 3TO O3HAYAET, YTO BbI MOXKETE MOJIYYUTh JOCTYII TOJBKO K TEM ILIarMHaM, KOTOPbIE TaM OITyOJIMKO-
BaHbl. C y4eToM pa3sHO0Opa3usi JOCTYIHBIX HHCTPYMEHTOB, 3TOT PENO3UTOPUI JOKEH YAOBIETBOPUTH OOJIBIIHMH-
CTBO BallIAX NOTPeOHOCTEH.

Tem He MeHee, Bbl CMOXETe MOMPOOOBaTh GOJIbIle TUIATMHOB, YeM Te, KOTOpbIe NOCTYIHbI [0 yMOJT4YaHuio. Bo-
TMIepBbIX, BaM HAJI0 HACTPOUTH JOTOJHUTEbHbIE PEMO3UTOPHHU. [IJ1sl TOrO YTOOHI CENATh 3TO, HEOOXOIUMO:

1. OTKpHITh BKIAAKY Settings B fagoroBoM okHe Plugin Manager.

Plugins | Settings

Check for updates on startup

E ] Installed

73 Not installed

Invalid w V| Show also experimental plugins
7% Install from ZIP Note: Experimental plugins are generally unsuitable for production use. These plugins are in early stages of development,
and should be considered 'incomplete’ or 'proof of concept’ tools. QGIS does not recommend installing these plugins unless
%3} Settings you intend to use them fer testing purposes.

v Show also deprecated plugins

Plugin repositories

Status Name URL
@ connected QGIS Official Plugin Repository https://plugins.qgis.org/plugins/plugins.xml?qgis=3.2

Reload all repositories Add...

# Close

2. Hano KIMKHYTh Ha Add 4TOOBI HAWTH U JOOABUTH HOBBIN PETIO3UTOPHI.

3. Vkaxwure Ha3BaHUE WJIM aIpecC CalTa HOBOTO PEMO3UTOPH S, KOTOPbIN Bbl XOTUTE HACTPOUTD, U YOEAUTECH, YTO
OoTMeueHa rajiouka B ssuelike Enabled.

284 Masa 9. Mopaynb: MnaruHel



QGIS Training Manual

Repository details

Name Faunalia

URL https:/fwww.faunalia.eu/ggis/plugins.xml

Parameters

Authentication Clear | Edit
Enabled v

o conce

4. Bu TEINepb YBUIAUTE peHO3PITOpPII71 HOBOI'O IUIar'MHa B CITMCKE HACTPOCHHBIX PETIO3UTOPHUEB IIJIAruHOB.

Plugins | Settings

e Al Check for updates on startup

E ] Installed

Not installed

Invalid w |v| Show also experimental plugins

r .

Install from ZIP Note: Experimental plugins are generally unsuitable for production use. These plugins are in early stages of development,
and should be considered 'incomplete’ or 'proof of concept’ tools. QGIS does not recommend installing these plugins unless
you intend to use them for testing purposes.

v Show also deprecated plugins

Plugin repositories

Status Name URL

@ connected Faunalia www.faunalia.eu/qgis/plugins.xml?qgis=3.2
[©] connected QGIS Official Plugin Repository https://plugins.qgis.org/plugins/plugins.xmi?qgis=3.2

Reload all repesitories Add... Delete

Help * Close

5. Bbl TakKe MOXeTe BLIOPATh OIMIHI0 0TOOPa)eHHU DKCIIEPUMEHTAIBHBIX [UIATMHOB, BBIOPaB (hiiaxok Show also
experimental plugins.

6. Eciu BbI Tenepb BepHeTech 00paTHO Ha BKIAIKY Not Installed, To BBl yBUIUTE, YTO HOSIBUIKCH JOTIOJTHUATEIb-
HbIE TJIATHHBI [JIS1 YCTAHOBKH.

7. s Toro, 4ToOBbl YCTAHOBUTH IUIATMH, KIMKHHUTE HA HETO B CIMCKE, a 3aTeM Ha KHOIIKY Install plugin.
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9.1.4 B 3aknuyeHumn

VYcranoBka miariHoB B QGIS nosmkHa ObITh Jierkow v 3¢ ek TUBHOM !

9.1.5 Yto panbLie?

,HEUICC MBI PACCKAXXEM BaM O HEKOTOPBIX ITOJIEZHBIX IUIarMHax B KAYECTBE IPUMEPOB.

9.2 3aHdaTtue: NMonesHble nnarnHbl QGIS

Temniepp, Koria BBl MOXKETe YCTAHABIMBATH, BKJIIOYATh M OTKJIIOYATh TUIATMHBI, JaBaiiTe IOCMOTPHUM, KaK 3TO MOXET
BaM MIOMOYb Ha MPAKTUKE. PacCMOTPUM HECKOJILKO IPUMEPOB O TIOJIE3HbIX IJIATMHAX.

Iean 3Toro ypoka: O3HaKOMHTHCSI C MHTep(EHCOM IUIarkHA ¥ y3HATH OOJIbIIE O HEKOTOPBIX IMOJIC3HBIX TUIATMHAX.

9.2.1 \ WUnem panbuwe: MNnarmd QuickMapServices
ITnarun QuickMapServices - 3TO IPOCTO# 1 JIETKUI B UCIOJIb30BAHUH TUIATMH, KOTOPBIH 100aBiIsieT 6a30Bble KapThl
B Batl npoekT QGIS. ¥ Hero MHOro pa3HbIX OMIMIA M HAcCTpoeK. [laBaiiTe M3y4nM HEKOTOpbIE U3 €ro (PYHKIU.

1. Haunute HOBYyI0 KapTy 1 100aBbTe CJIOH roads 3 ['eonakera training_data.

2. ¥Ycranopure wiarnH QuickMapServices.

3. OrtkpoiiTe BKIAKy OMCKA IIaTMHA, HaxkaB Ha Web » QuickMapServices » Search QMS. Dta o 1uiarmHa
JIACT BaM BO3MOXXHOCTb OT(HIIBTPOBATH UMEIOINECs: 0a30Bble KapThI IO TEKYIEMY KCTEHTY XOJICTa KapThl.

4. Knuknure Ha Filter by extent 1 Bbl IOJKHBI YBUJETb OJIHY JOCTYITHYIO YCIIYTY.
5. KimkHuTe Ha KHOMIKY Add psIIoM € KapTOM, YTOOBI 3arpy3HTh ee.

6. BasoBast kapra Oy/ieT 3arpyxeHa, 1 y Bac OyJeT CIIyTHUKOBBIi (DOH Uit KapThl.

ITnarun QuickMapServices Jenaet JOCTYITHBIMA MHOXECTBO OA30BbIX KapT.
1. 3axpoiite nanens Search QMS, KOTOPYIO Mbl OTKPBUIM paHbIIE.

2. Kimuknure eme pa3 Ha Web » QuickMapServices. B iepBoM MeHIO NepeUYUCIIEHbl Pa3IMYHbIE TOCTABIIUKU
KapT ¢ JIOCTYIIHBIMU KapTaMu:
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¥ Landsat -

L Mapsurfer.NET b
@ NASA ,
» O5M r
B eatlas Mos v

(£} Search QM5

(£} Add to Search
¢4 Set proper scale
4 Settings

Ho ectb enie koe-4ro.

Ecmu KapTbl, AOCTYIIHBIE 110 YMOJIYaHHIO, BaM HEAOCTATOYHDI, BbI CMOKETE )106aBI/ITb APYTuX NnoCTaBIIMKOB KapT.

1.
2.

Kmikuaure Ha Web » QuickMapServices » Settings v iepeiinute Bo BKIAIKy More services.

BHuMatenbHO mpodTHTe COOOIIEHME HAa STOW BKJIAJKE M, €CJIM Bbl COIVIACHBI, KJIMKHUTE Ha KHONKY Get
Contributed pack.

Ecmu BbI ceityac otkpoete meHio Web » QuickMapServices, T0 Bbl yBUIUTE, YTO MOCTABIIMKOB KAPT CTAJO OOJbIIIE.
BriGepurte TOro, KTO JIydilie BCEX COOTBETCTBYET BaIllUM MOTPEOHOCTSIM!

9.2.2 \ NUpem panbuwe: NMnarud QuickOSM

Bnaromapst HeBeposiTHO mpocToMy HHTepdeiicy miarnd QuickOSM maeT BaM BO3MOKHOCTh 3arpyKaTh JaHHBIE
“OpenStreetMap " _ data.

1. HavHuTe HOBHI¥ ITyCTOM MPOEKT ¥ H00aBbTe CIOM roads 3 ['eomakera training_data.

2. VYcranoute riarud QuickOSM. Inarus 106aBseT [Be HOBbIE KHOMKH B MaHe b HHCTpyMeHToB QGIS u on
JocTyrieH B MeHIo Vector » QuickOSM.

3. Ortkpoiire gquanorosoe okHO QuickOSM. B miiarune ectb MHOTO pa3HbIX BKJIAJOK: Mbl OYy/IEM HCIIOIb30BaTh
Quick Query.

4. Bbl cMOXeTe 3arpy3uTh Ofpe/ieeHHbie (PyHKIMY, BhIOpaB o0mmit Key wiv KOHKpeTHbI Habop Key u Value.
Cosert: Ecnu Bbl He 3HaKOMBI ¢ cucTeMoit Key u Value, knukaute Ha KHOTIKY Help with key/value. OTkpoetcst
BeO-CTpaHUIIA C TIOJIHBIM onucaHueM KoHmernmu OpenStreetMap.

5. Haiipure railway B menio Key u iycts Value Oyziet myCTbIM: U TaK, Mbl 3arpy’kaeM Bce 00BbeKTHI railway 6e3
yKa3aHHsl KaKUX-JTMOO0 3HAUCHU.

6. Buibepute Layer Extent B CeAyOIeM PacKphIBAIOIIEMCSI MEHIO U BBIOEpUTE roads.

7. KinukHUTe Ha KHONKY Run query.
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QuickOsM

j} Quick query

Help with key/value

' Query Key railway -
W osm File Value Query on all values -
Layer Extent ~ |/ roads -
P Parameters
P Advanced
About show query Run query

Successful query

UYepes HECKOJIBKO CEKYH]I TUIArKH 3arpy3uT Bee 00beKThI, oTMedeHHbIe B OpenStreetMap Kak railway U 3arpy3ur
HX MPsIMO Ha Kapry.

Huuero 6oinbine! Bee cion 3aIr'py’KCHbI B YCJIOBHbIC 0003HaUEHUS U 0T06pa)KaIOTC$I Ha XOJICTE KapThl.

“Untitled Project - Qais
Project Edit View Layer Settings Plugins Vector Raster Database Web Help

DPBRGRRY UL slPPReNE & ~REE I & M
RRV:ZW /B Z T B = 4= SUERY

Layers EE Layer styling B8
“|a .Y / railway -

v — railway
v © rallway
v — roads

& | = single symbol

[
— simple line

Unit | Millimeter
Opacity | 1000%

Color

width |0.46000

< Allsymbols al-

> Layer Rendering

Layers | Browser o[ v/Live update | </ Apply

X Type to locate (Ctrlrk) Ready Coordinate 20.5660,335427 | % Scle 1171500+ | @ Magnifer| 100% 2| Rotation [00° 3| ViRender @ EpsGaszs @

Ipenynpexaenne: QuickOSM co3naer BpeMeHHBIH ClIoM NPpU 3arpy3Ke JaHHbIX. Eciy BBl XOTUTE COXpaHUTD

HX HaBcerja, KJIMKHUTE Ha l::l PSIIOM CO CITOEM U BHIOEpHTE HyKHbIe BaM ONIIUU. B kKauecTBe abTepHATUBHI BB
MOXeTe OTKpPBITh MeHI0 Advanced B QuickOSM u BbIOpath, rae COXpaHUTh JaHHbIE B MeHIO Directory.

9.2.3 ﬂ'—- Unem panbwe: MexaHnam 3anpocoB QuickOSM

Cambiii OBICTpBII CrIOcO0 3arpy3uTh AaHHble U3 tiaruHa QuickOSM 31o ucnosb3oBaHue BKIaaku Quick query u
HAcTpoiiKa HeOOoIbIINX MapamMeTpoB. Ho ecii Bam HykHbI 60J1ee KOHKpPETHbIE JaHHbIE?

Ecnu BB sBiIsIeTeCHh MacTepoM Ho 3anpocaM OpenStreetMap, Bbl cMoxkeTe ucnoib3oBaTh mwiaruH QuickOSM rakxe
C BaIllIMU JIMYHBIMH 3aITPOCaMHU.

QuickOSM umeeT HEBEPOSATHBIN aHATM3ATOP JAHHBIX, KOTOPHIA B COUYETAHWH C YAUBUTEILHBIM MEXaHU3MOM 3aIIpo-
coB Overpass, HO3BOJIUT BaM 3arpyskaTh JaHHbIE C BAIIMMU KOHKPETHBIMH TOTPEOHOCTSIMHU.

Harnpumep: Mbl XOTHM 3arpy3UTh TOPHBIE BEPIIMHbI, OTHOCSIIMECS K ONPEIEIEHHON TOPHON MECTHOCTH, U3BECTHOM
kak “Dolomites ~_

Bbl He MOXKETE PEIMTh 3Ty 3a7a4y C MOMOIIBI0 BKIanku Quick query, Bbl JOJDKHBI 00JIee YETKO MPOIKMCATh CBON
coOcTBeHHbIN 3arpoc. [laBaiite monpodyem 3To clenaTh.

1. HauHute HOBBIN MPOEKT.

2. Otkpoiite miarnH QuickOSM U KJIMKHUTE Ha BKIAAKY Query.
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3. CxonmpyiiTe 1 BCTaBbTe CJEIYIOIMNI KOJI B XOJICT 3aIpoca:

<l——
This shows all mountains (peaks) in the Dolomites.
You may want to use the "zoom onto data" button. =>
——>
<osm-script output="json">
<!-- search the area of the Dolomites —-—>
<gquery type="area">
<has-kv k="place" v="region"/>
<has-kv k="region:type" v="mountain_area"/>
<has—-kv k="name:en" v="Dolomites"/>

</query>
<print mode="body" order="quadtile"/>
<!-- get all peaks in the area —-—>

<query type="node">
<area-query/>
<has-kv k="natural" v="peak"/>

</query>
<print mode="body" order="quadtile"/>
<!-- additionally, show the outline of the area -->

<query type="relation">
<has-kv k="place" v="region"/>
<has-kv k="region:type" v="mountain_area"/>
<has-kv k="name:en" v="Dolomites"/>
</query>
<print mode="body" order="quadtile"/>
<recurse type="down"/>
<print mode="skeleton" order="quadtile"/>
</osm-script>

HpnMeanne: t0T 3alpocC 3arrcaH Ha A3bIKE xml. Eciu BbI Gosibiie ITPUBBIKJIN pa60TaT1> c Overpass
QL, BBl MOXKETE HAITMCATH 3alpoC Ha 3TOM A3bIKE.

4. U ximKHUTE Ha KHOMIKY Run Query:

QuickOSM

1 uick que
7 Q query Overpass query & Reselt
~
'4 Query <l =
— This shows all mountains (peaks) in the Dolomites.
' OSM File You may want to use the "zoom onto data" button. =>
->

N

<osm-script output="json">
Parameters ) P P ) J i

<l--search the area of the Dolomites -->

<query type="area">
* About <has-kv k="place" v="region"/>
- <has-kv k="region:type" v="mountain_area"/>
<has-kv k="name:en" v="Dolomites"/>

[»] Advanced

Generate query Run query

0%

@Overpass Turbo Documentation -
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CJ101i 10 TOPHBIM BepIlMHAM OyZeT 3arpyxeH u nokasaH B QGIS:

sxsAS

Bbl MOXeTe nucaTh CI0KHBIE 3aIPOCHI C UCTIOJIb30BaHUeM SI3bika 3arpocos ~Overpass Query language ~_. ITocmor-
puTe Kakue-HIOYIb IPHIMEPHI U MONPOOYHTE U3YUYHTh SI3BIK 3aIIPOCOB.

9.2.4 \ Upnem panbuie: NMnarud DataPlotly

ITnarun DataPlotly naet Bam Bo3MOXHOCTb co3qaBaTh D3 *_ rpadyiku JaHHBIX BEKTOPHBIX aTpHOYTOB Garojapst
6ubsumoreke “plotly *_.

1. HauHuTte HOBBIN MPOEKT.
2. 3arpysure cnoit sample_points U3 nanku exercise_data/plugins.

3. YcraHoBuUTE IUIArKH, cleLys MHCTPYKUUSM, OIIUCAHHBIM B Moem danvute: Ycmanosra Hogblx naazuHog IOUCK
Data Plotly.

4. OTkpoiiTe IUIarkH, KJIMKHYB Ha HOBBII 3HAYOK Ha MaHeJI HHCTPYMEHTOB WM B MeHIo Plugins » Data Plotly.

B cnenyromem mpumepe Mbl co3daeM NpocTodl Scatter Plot AByX mojed cios sample_points. B nmanemm
DataPlotly:

1. Bwibepure sample_points B punbtpe cios, ¢l nnst X Field u mg nns Y Field:
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DataPlotly = &

Plot Type | ;** Scatter Plot -

w Plot Parameters

Layer 2" sample_points -
X Field 1.z¢l - £
¥ Field 1.2mg - £

w Properties

Marker Color - Marker Size |10 |3
stroke Color | (NG - Stroke Width |1 |S
Marker type | Points -
Point Type 9 -
Transparency | | 0 =
Type of Plot SinglePlot i
4Clean Plot Cavas ] '« Create Plot

2. Ecmm xotute, BBl MOXETE U3MEHHUTH I1BETA, TUIT MAPKEPa, TPO3PAYHOCTh U MHOTHE APYTHe HACTPOUKU: TIOITPO-
OyliTe U3MEHUTh HEKOTOPbIE NapaMeTphl, YTOObI CO3/1aTh IpapuK HIKE.
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DataPlotly = [

C ] = .l

i g cd-mg

55 L
oy * i C]

50 &

rdh

45

a 9P &

g
qr
35
30 +
& o *e
25
& T &
0 o L
50 100 150
cl
£ Reload Live Update = | (B

DataPlotly | Processing Toolbox

3. Tlocne Toro, KaK BhI HaCTpOUTE BCE NMapaMETPbl, KIIMKHUTE Ha KHOIIKY Create Plot nns cozanus rpadmxa.

['paduk SBASETCA MHTEPAKTUBHBIM: TO €CTh BBl MOXETE UCIIOJIB30BATh BCe BEPXHHE KHOMKY /151 H3MEHEeHH s pa3Me-
pa, epeMelleH s M YBeTiYeH s/ yMeHbIleHus: MaciuTaba n3oopaxenus. Kpome Toro, Kaxaplii aieMeHT rpaguka
SIBJIAICTCS] MHTEPAKTHBHBIM: ITPH HAXKATUH WX BEIOOPE OJHOM MJIM HECKOJIBKHX TOYEK Ha rpapuKe COOTBETCTBYIOLINE
TOYKM OyayT BHIOpaHbI Ha XOJICTE rpaduka.

-
Bbl MOKETE COXPAHHTh IPapyK KAK CTATHIHOE M300pakeHHe png WM Kak (aii html, HakaB Ha KHOIKY 18 mm

=0
Ha KHOIIKY B [IPaBOM HIJKHEM YITTy rpacduka.

Ectp eme koe-uto. MHorna styume umeTs aBa (Mm 6oJiee) rpaduka, KOTOpble MOKa3bIBAIOT pa3HbIe TUITH IpadrKoB
C pa3HBIMU NepeMEHHBIMU Ha OJJHOW M TOM jke cTpanuLe. [laBaii cnenaem 31o!
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1. Hano BepHyTbCSl Ha BKJIAZKy OCHOBHBIX HACTpOeK rpaduka, HaxkaB Ha KHOIIKY (f B BEPXHEM JIEBOM YTy
TaHeJ TUIaruHa.

2. Wamenwute Plot Type na Box Plot.
3. Buibepure group xak Grouping Field v ph xak Y Field.

4. B HmxHel yact nanenu usmenure 1Type of Plot n3 SinglePlot na SubPlots v IycTh oIys 1o ymonadanumo Plot
in Rows Gyzet BbIOpaHa.

DataPlotly |

Plot Type | [ Box Plot -

w Plot Parameters

Layer 7" sample_points -

Grouping Field

(Optional) 12 group K2

Y Field 1.2 ph -l £

w Properties

Marker Color | ([ -

stroke Color | (NN - stroke width |1 %

Transparency | | 0 =
Type of Plot SubPlots -
& Plot in Rows Plot in Columns
4Clean Plot Cavas “)Update Plot ./Create Plot
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5. Korna 3akoHumMTE, KIIMKHAUTE Ha KHOTIKY Create Plot nisi pucoBaHus rpaduka.

DataPlotly

@
35
@
o®
o
@
50
o
45
® Q
40 o
@
35
@
30
e & %o
0]
25
o ®0 .
2 @
50 100
*Reload Live Update

150

&
- ..||||.
2 d-mg
o T B oh
7.5
7
6.5
i
5.5
1 2 3
ENEY

Teneps Ha OfHOW CTpaHHIle rpaduka y Bac ecTh JABa Buja rpaduka T.e. TOUSUYHBId U KOpOOYATHIA. Y Bac mo-
NpeKHEMY €CTh BOSMOXHOCTb KIIMKHYTh KXKbIA 9JIEMEHT rpavKa U BHIOPaTh COOTBETCTBYIOIINE OOBEKTHI Ha XOJI-

CTe KapThl.

? o
CoBet: VY Kax0ro rpaduka ectb COOCTBEHHAs! CIIPABOYHAsI CTPAHULIA, AOCTYITHASI BO BKJIaJKe . IMonpobyiite
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U3YYUTb BCE THITBI IPA(pUKOB ¥ TOCMOTPHUTE BCE OCTAIbHBIE JOCTYITHBIE HACTPOUKHU.

9.2.5 B 3aknouyeHvun

EcTb MHOXECTBO HOJIC3HBIX IJTarMHOB, JOCTYIHBIX 1J14 QGIS I/ICHOHLSYH BCTPOCHHBIC MHCTPYMEHTDI JI1 YCTAHOBKH
M YIIPaBJIEHUS 3TUMHU IIJITArMHAMU, BBl CMOXETE HaWTH HOBBIE TJIATUHBI M ONTHUMAJIbHO UX MCIIOJIb30BATh.

9.2.6 Yto panbwe?

,Ila_nee Mbl U3YyYHM, KaK HCIIOJIb30BATh CJIOH, KOTOPLIC Pa3MEIICHbI Ha YAAJICHHBIX CEPBEPAX B PEKHUME PEAJIbHOTO
BPEMCHU.
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QGIS Training Manual

296 Masa 9. Mopaynb: MnaruHel



rnasa 10

Moaynb: OHnanH pecypcsbl

Ipu paccMOTpeHNM MCTOYHHUKOB JIAHHBIX TSI KAPTHL He 0053aTeIbHO OTPaHWUYMBATHCS TAHHBIMH, KOTOPBIE BHI CO-
XpaHWIHA Ha BameM KoMmmbioTepe. CyIIecTBYIOT OHJIAWH MCTOYHWKY JaHHBIX, U3 KOTOPHIX BB MOXKETe 3arpyXkaTb
JIaHHBIE.

B sToM Momysie Mbl paccMoTpuM JBa Tuma Beo-yciyr GIS: Cepauchl BeO-kapt - Web Mapping Services (WMS) u
BeO-cepBuch 00bekTOB - Web Feature Services (WES).

10.1 3aHsaTne: CepBuchbl Be6-kKapT

Cepgruchl Be6-kapT (WMS) - 310 cepBuC, pa3MellleHHbIi Ha yaajaeHHOM cepBepe. Kak u B ciiydae ¢ BeG-caiiToM, Bbl
MOXeTe MOJTyYUTh K HEMY JOCTYII, €CJIN Y Bac eCTh coeAnHeHue ¢ cepsepoM. Mcnonssys QGIS, BbI MOXeTe 3arpy3uTh
WMS npsmMo Ha CBOIO CYIIECTBYIOIIYIO KapTy.

Kak BbI MOMHHTE U3 YPOKa IO IIariHaM, MOXHO, HalTpUMep, 3arpy3uTh HOBOE pacTpoBoe uzodpaxenue u3 Google.
Tem He MeHee, 3TO Pa30Basi OMEPAIIUS: TIOCTIE TOTO, KAK BbI 3arpy3uiid U300paxeHue, OHO He MeHsieTcst. WMS otiu-
YaeTCsi TEM, YTO ITO MHTEPAKTUBHBIN CEPBUC, KOTOPbIN aBTOMATHYECKU OOHOBIISIET CBOI BU/I P IAHOPAMHUPOBAHUM
WM MacIITaOMpPOBAaHUH KAPTHL.

ean 3TOro0 ypoka: Vcrnosnbs3zoBate WMS U NOHATH €€ OrpaHUYEHUSI.

10.1.1 \ Woem panblie: 3arpyxaem cnon WMS

JI71s1 BHITTOJIHEHMST JAHHOTO YNPaKHEHMsI BBl MOKETE MCIOJIb30BaTh MO0 0a30BYI0 KapTy, KOTOPYIO BBl CO3JAJM B
HavaJjie Kypca, WM Xe MPOCTO CO3/1aTh HOBYIO KapTy M 3arpy3uTh B Hee HEKOTOPbIE CYIECTBYIOIINE CJIOH. B mpuse-
JEHHOM IpUMepe MbI UCIIOJIb30BAIM HOBYIO KapTy U 3arpy3uIM UCXOAHbIE ciou places, landuse v protected_areas 1
CKOPPEKTHPOBAJIM YCJIOBHbIE 0O03HAUECHUSI:
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*Untitled Project - QGIS

Project Edit View Layer Settings Plugins Vector Raster Database Web Mesh Progessing Help

[ HY U@L BPPRAIMGHRIR ¢ K-B-,EE# I - [0
LL A A N m W, [E] ® 2

Layers (=]E3]
o« @ T |7 2= g}
v/ * places

v [ ] protected_areas
v [] landuse

Layers = Browser

1 legend entrie Coordinate| 20.2220,-34.0541 % Scale | 1:93042 - | @ Magnifier| 100% % Rotation |0.0°

Q Type to locate (Ctrl+K) +| [V Render @ Epsc43ze @

1. 3arpysute 3T CJIOM Ha HOBYIO KapTy MJIM UCIIONB3YITE CBOIO UCXOIHYIO KAPTY C TOJIBKO STUMH CJIOSIMH.

2. Tlepen tem, Kak 100aBUTh cioir WMS, OTKITIOUUTE MPOEKIMIO «Ha JIeTy» (BKJIaaKa Project » Properties... »
CRS, otmerutb No CRS (or unknown/non-Earth projection). 9T0 MOXET IIPUBECTU K TOMY, YTO CJIOM OOJIbIIIE
He OyIyT NMPaBUILHO MEPEKPHIBATHCSI, HO HE BOJHYHATECh: MBI 9TO UCITPABUM IO3Ke.

3. st Toro, 4to0sl 106aBUTH ciion WMS, KIIMKHUTE Ha KHOIIKY ‘5 JIJI51 TOTO, YTOOBI OTKPHITh UAJIOTOBOE OKHO

Data Source Manager 1 BKJIIIOUUTb BKJIAJKY WMS/WMTS.
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Data Source Manager | WMS/WMTS

Layers Server Search

h Browser

-y Vector

-

4 Raster New Load Add Default Servers

.‘!:_ Mesh ID Name Title Abstract
- Delimited Text

"4 GeoPackage

f_: SpatiaLite
4 PostgresQL
+ MSSQL

Options
D82 pB2

_— Tile size
m Virtual Layer

Request step size
@ WMS/WMTS Feature limit for GetFeaturelnfo

WGS 84

Use contextual WMS Legend

KA ArcGIS Map Server

ArcGIS Feature Layer name
# Server Ready
& GeoNode @Help % Close

BcrniomHuTeE, Kak BbI MOJKTIOYATUCH K 6a3e naHHbIX Spatial.ite wim GeoPackage B Hauase kypca. Ciou landuse,
buildings v roads xpaustcs B 6a3e JaHHBIX. [ TOrO, YTOOBI UCIOTB30BATH STH CJIOH, BaM HAJ0 OBLIO CIiepBa
MOAIKJIIOYUThCS K Oa3e naHHbiX. WMS UCIob3yeTcst aHATOrMIHbIM 00pa3oM, 32 UCKITI0UYEHUEM TOTO, YTO CIIOU
HaXOJISATCS HA YJAJIEHHOM CepBepe.

4. JInst Toro, 4toObl CO3/1aTh HOBOE MOKI0UYeHe K WMS, Halo KJIMKHYTh Ha KHOIIKY New.

J1st mpojiomkeHust paboThl BaM HyskeH agpec WMS. CylecTByeT HECKOJIBKO OecriiaTHbIX cepBepoB WMS.
OnvH U3 HUX "terrestris ~_ , KOTOPBIHA HCTIONb3yeT Habop AaHHBIX  OpenStreetMap ~_ .

5. JI7st TOro, 4ToObl BOCIIONB30BaThCst ITUM WMS, HACTpOIiTe ee B BallleM TEKYILeM JUaJOrOBOM OKHE CJIeIyIo-
UM 00pa3oMm:
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Create a New WMS/WMTS Connection .

Connection Details

Name |terrestris

URL |https:ﬁows.terrestris.defosmfservice

Authentication

Configurations | Basic
Choose or create an authentication configuration

No authentication ~ )

Configurations store encrypted credentials in the QGIS
authentication database.

WMS/WMTS Options
Referer
DPI-Mode | all -
Ignore GetMap/GetTile URI reported in capabilities
Ignore GetFeaturelnfo URI reported in capabilities
Ignore axis orientation (WMS 1.3/WMTS)
Invert axis orientation

Smooth pixmap transform

@Help # cancel <+ OK

o 3pauenue 1o Name NOJKHO ObITh terrestris.
¢ 3navenue nonsg URL momkHO ObITh https://ows.terrestris.de/osm/service.

6. Kimknute Ha kHOnKy OK. Bbl 10/KHBI yBUZIETD B crivicke HOBBIE WMS-cepsep:
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h Browser

-y Vector

4 Raster
X/
_A_+ Mesh
- Delimited Text

‘.-'1 GeoPackage

F 4~ SpatiaLite
4 PostgresQL
+ MSSQL
D82 pB2
lﬁ_ Virtual Layer
@ WMS/WMTS
L wes

4_ WFS

i ArcGIS Map Server

ArcGIS Feature
* Server

- GeoMode

Data Source Manager | Browser | WMS/WMTS

m| Server Search
| terrestris - |
| connect | [ New ] | Edit || Remove | | Load || sSave | |AddDefaultServers|
D Name Title Abstract
Options
Tile size [ |
Request step size | | |
Feature limit for GetFeaturelnfo | |
WGS 84
Use contextual WMS Legend

Layer name |

Ready

| @Help |

| %cClose |

7. Kiuknaure Ha Connect. B crivcke HUXe Bbl JOJIKHBI YBUAETh 9THU HOBLIE 3aI'DYyKEHHBIC 3allMCU:

i Browser
+ Vector

4 Raster
_4:_ Mesh

- Delimited Text
"% GeoPackage
;‘54_ SpatialLite
. PostgreSQL
* MSSQL

D82, pB2

Virtual Layer

‘:@i wcs

g WFS

o ArcGIS Map Server
47" ArcGlIs Feature Server

» GeoNode

Data Source Manager | Browser | WMS/WMTS

Image Encoding

) PNG (® JPEG

Options (0 coordinate reference systems available)

Layers | Server Search
| terrestris - |
[ Connect l | New || Edit || Remove | | Load || save | |AddDefaultServers|
ID ~ Name Title Abstract
* 0 OpenStreetMap WMS
[ | OSM-WMS OpenStreetMap WMS - by terrestris

3 0SM-Overlay-WMs 0SM Overlay WMS - by terrestris

4 TOPO-WMS Topographic WMS - by terrestris

5 TOPQ-0OSM-WMS Topographic OSM WMS - by terrestris

6 SRTM30-Hillshade SRTM30 Hillshade - by terrestris

7 SRTM30-Colored SRTM30 Colored - by terrestris

8 SRTM30-Colored-Hillshade SRTM30 Colored Hillshade - by terrestris

9 SRTM30-Contour SRTM30 Contour Lines - by terrestris

Tile size |

Request step size |

Feature limit for GetFeaturelnfo

Use contextual WMS Legend

10 |

Layer name |

Select layer(s)

| @nelp | | Rlose |
ITO BCe CJIOH, pa3MelieHHble Ha 3ToM cepepe WMS.
8. Kimxknute omuH pa3 Ha cioit OSM-WMS. TlosiButcs ero Coordinate Reference System:
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Data Source Manager | Browser | WMS/WMTS

Browser
i Layers | Layer Order Server Search
. g Vector
* | terrestris - |
- REEET | connect | [ New l | Edit || Remove | | Load || save | |AddDefault Servers|
x|/
!+ Mesh D v Name Title Abstract
v 0 OpenStreetMap WMS
- Delimited Text 1 OSM-WMS OpenStreetMap WMS - by terrestris
. 3 0SM-Overlay-WMs OSM Overlay WMS - by terrestris
"ﬂ GeoPackage 4 TOPO-WMS Topographic WMS - by terrestris
J 5 TOPO-OSM-WMS Topographic OSM WMS - by terrestris
#, spatiaLite 6 SRTM30-Hillshade SRTM30 Hillshade - by terrestris
*® .
7 SRTM30-Colored SRTM30 Colored - by terrestris
PostgresQL 8 SRTM30-Colored-Hillshade SRTM30 Colored Hillshade - by terrestris
* 9 SRTM30-Contour SRTM30 Contour Lines - by terrestris
MSSQL
* Image Encoding
DB2 . ~
i DB2 ) PNG (® JPEG
VA virtual Layer
LP Y Coordinate Reference System (24 available)
WMS/WMTS
@ = Tile size | \ \ \
Request step size | I |
Feature limit For GetFeaturelnfo \10 \
%7 ArcGIS Map Server WGS 84 ‘ Change... |

Use contextual WMS Legend
47 ArcGIS Feature Server

* GeoNode

Layer name |OpenstreetMap WMS - by terrestris |

1 Layer(s) selected
| @Help | | /Add | Xclose |

Tak Kak MBI He UCTIONB3yeM WGS 84 uIs Haimed KapTel, naBaite mocMoTpuM Bce CRS, M3 KOTOpBIX HaM
HY’KHO BBIOPATh.

1. Knukaurte Ha kHONKy Change.... Bl yBuauTe crangapTHoe quanoropoe okHO Coordinate Reference
System Selector.

2. Hawm Hyx)Ha npoeyuposannasi CRS, Tak uto naaiite Beidepem WGS 84 / Pseudo Mercator.
1. BBeaurte 3HaueHue pseudo B noe Filter:

2. Buibepute WGS 84 / Pseudo Mercator (c epsg: 3857) u3 crucka.
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Coordinate Reference System Selector B3

Define this layer's coordinate reference system:

This layer appears to have no projection specification. By default, this layer will now have its projection set
to that of the project, but you may override this by selecting a different projection below.
Filter | <. pseud
Recently used coordinate reference systems

Coordinate Reference System Authority ID

1 2

Coordinate reference systems of the world Hide deprecated CRSs

Coordinate Reference System Authority ID
~ H projected Coordinate Systems
- Mercator

WGS 84 / Pseudo-Mercator EPSG:3857

1

WGS 84 / Pseudo-Mercator

Extent
-180.00, -85.06, 180.00, 85.06

Proj4
+proj=merc +a=6378137 +b=6378137
+lat_ts=0.0 +lon_0=0.0 +x_0=0.0 +y_0=0 +k=1.0
+units=m +nadgrids=@null +wktext +no_defs

@Help # cancel

3. Kimmkaute Ha kHOTIKY OK. CrcTeMa KOOpAWHAT, CB3aHHAS C 3aIKCHI0, I3MEHUIIACh.
9. Kimkuaute Ha Add v TIOSIBUTCS HOBHIM CJION Ha Balel Kapte Kak OpenStreetMap WMS - by terrestris.
10. 3akpoiite quanoroBoe okHO Data Source Manager, ecii OHO He 3aKpbLTach aBTOMATUYECKHU.
11. Ha nanenu Layers KIMKHUTE U MepeTaIIUTE B KOHELl CIIUCKA.

12. Ymenblute MaciuTad Juist TOro, 4To0bl HOIYYUTh OOIIHIA BUJL CJI0eB. Bbl 3ameTHTe, YTO BAIIM CJIOU PACIIOJIO-

JKEHBI HEITPABIIIBHO (PSIIOM C 3alIaHOM A(PHUKOI). DTO MPOU3OIIO TOTOMY, YTO MPOSIIMPOBAHUE «HA JIETY»
OTKJIIOYEHO.
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*Untitled Project - QGIS
Project Edit View Layer Settings Plugins Vector Raster Database Web Mesh Progessing Help

NeERRY e "BPPo GBS @ K-e-EE% Zm- D
A LAY AN TN Jx-8 @008 wqEuewgy R 4 B
3 i . Ho

Layers
« B e T WAL /
* places 2l Greenland
rotected areas ?
landuse
~ v/ ¥ OpenStreetMap WMS - by te...
®  Stadt > 1,000,000 EV
+  Stadt > 250,000 EW
Stadt > 25.000 EW

/ StraBe

Bundesstrafie

/ Autobahn
[ Wasserfiache

Landflache

“ Monglia *

Wald

Wiese / Acker

[ ] cebiuce

Krankenhaus

Layers ‘ Browser R Antarctica

\ Q Type to locate (Ctrl+K) 1legend entries remove Coordinate | 11838951,16718714 | 9§ 5mlel0:1 |-| & Magnifier| 100% | Rotation |0.0° 2| v/Render X @

13. [laBaiiTe CHOBa BKJIIOUMM IT€pe-MPOEIMPOBAHNE, HO HCTIONB3Y S Ty e MPOEKIIMIO, 9To U B ciioe OpenStreetMap
WMS 1.e. WGS 84 / Pseudo Mercator.

1. Otkpoiite BKIaaKy Project » Properties... » CRS.
2. Cuumure pnaxok No CRS (or unknown/non-Earth projection).

3. Buibepure WGS 84 / Pseudo Mercator 13 cniucka.

304 nasa 10. Moaynb: OHNanH pecypchbl



QGIS Training Manual

Project Properties — CRS X

Project Coordinate Reference System (CRS)

e

, General No CRS (or unknown/non-Earth projection)
l [EELEL Filter | @
@ = Recently Used Coordinate Reference Systems
Coordinate Reference System Authority ID

% Default Styles WGS 84 EPSG:4326

B8 Dpatasources

EE Relations

Variables
4 »
B macros Predefined Coordinate Reference Systems Hide deprecated CRSs
QGIS Server Coordinate Reference System Authority ID =
WGS 84 / PDC Mercator EPSG:3349
0 Temporal WGS 84 / PDC Mercator EPSG:3832
'
WGS 84 / Pseudo-Mercator EPSG:6871
WGS 84 / World Mercator EPSG:3395
WGS 84 / World Mercator EPSG:6893
WGS84 WEB MERCATOR SPHERIQUE (VISUALISATION) IGNF:WGS84WMSV -

]

WGS 84 / Pseudo-Mercator =

WKT
PROJCRS["WGS 84 / Pseudo-Mercator",
BASEGEOGCRS["WGS 84",

DATUM["World Geodetic System 1984",

ELLIPSOID["WGS B4",66378137,298.257223563,
LENGTHUNIT["metre”, 1111,

PRIMEM["Greenwich",8,
ANGLEUNIT["degree”,®.0174532925199433]1,

ID["EPSG",4326]],

COMUEDETAML ®Danu] nr Mirnalicatinn Drauds Maresdaet b

b Datum Transformations

@Help @apply || @cancel

4. Kinuknure Ha KHONKY OK.

14. Tenepp KIMKHUTE MPABOM KHOMKOW MBIIIK HA OIHOM U3 BAllIMX CJIOEB B NaHeu Layers U KIIMKHUTE Ha Zoom
to layer extent. Bel yBuaute mectHOCTh Swellendam:

*Untitled Project - QGIS 0
Project Edit View Layer Settings Plugins Vector Raster Database Web Mesh Processing Help

0 ¥ U@L I RPPLRALBENR 66 Ko - LEES sy 0
BV, A% D = o 5 R o

Layers @®
o @ ® T E-B AL

v/ * places

| [[] protected_areas

landuse

" OpenStreetMap WMS - by te...
®  Stadt > 1.000.000 EW

Stadt = 250.000 EW/

Stadt > 25.000 EW

Strafle

Bundesstralie

Autobahn

Wasserflache

Landfidche Bruintjiestivier

Wald

Wiese | Acker
Bréede River

Gebiaude

Krankenhaus
Leeu River

;uﬂe ljagsriver.

(o]

Breede River Buffeljagsiivier

Layers = Browser

Q Type to locate (Ctrl+K) 1 legend entrie Coordinate| 2270396-4020313 | % scale|1:150052 ~ | @ Magnifier| 100% % | Rotation | 0.0° >V Render ®EPSG3857 @
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OO6paTrTe BHUMaHUe, Kak MepeKphIBAIOTCS YuLbl ciost WMS 1 Hallm yjauipl. DTO XOpOLIHUH 3HaK !

CywHocTtb u orpaHudyeHuss WMS

K Hacrosimemy BpeMeHH BbI, BOSMOXHO, 3aMETHJIM, UTO 3TOT cioi WMS Ha camoM fese uMeeT MHOTO (PYHKITHIA.
311ech eCTh YJIHLIBL, PEKH, 3aMI0OBEJHUKH U TakK Jiasiee. [lae eciv OH BHIJISIUT TaK, KaK OYJITO OH COCTOUT U3 BEKTOPOB,
OH OOJIbIIIE CMaXxMBAET Ha PACTP, HO BbI HE MOXKETEe U3MEHHUTD €r0 YCJIOBHbIE 0003HaueHuUs. [Touemy?

Tak paboraer WMS: 310 Kapra, oxoxas Ha 0ObIYHYI0 OYMaXXHYIO KapTy, KOTOPYIO BbI IOJTy4aeTe B BUjle U300pa-
KeHHsl. Y Bac ecTh BeKTOpHBIe ciior, kotopble QGIS otobpaxkaer kak kapry. Ho mpu ncrnons3oBannu WMS 3ti
BEKTOPHBIE CJIOM HaxoaATcs Ha ceppepe WMS, KOTOpBIN 0TOOpakaeT MX Kak KapTy W BBIAAET 3Ty KapTy BaM Kak
m3obpaxenue. QGIS MoxeT Mmokas3aTh 3T0 H300paxKeHHe, HO He MOKET U3MEHATh ero yCJIOBHbIe 0003HaYeHHUs, 110-
TOMY YTO BCe 9TO 0OpabaTeiBacTCs Ha cepBepe.

370 J1aeT BaM HECKOJIBKO MIPEUMYIIECTB, BAM He HYXHO OECIIOKOMTBCSI 00 YCIIOBHBIX 0O03HaueHusIX. OHM yKe OT-
paboTaHbl M Ha HUX MOXHO ITOCMOTPETh Ha OO0 IPaMOTHO CIIPOEKTHpOoBaHHOH WMS.

C zmpyroil CTOpOHBI, BBl HE CMOXKeETe U3MEHUTh yCJIOBHbIE 0003HAYEHNs, €CIM OHM BaM He HPABSITCS, M €CJIM YTO-TO
MeHsieTcst Ha ceppepe WMS, oHM Takke IIOMEHSIOTCS Ha Balllell Kapte. [lo3ToMy MHOrIa BaM 3aX04eTCsl UCTIONb30-
BaTbh BMECTO 3TOro BeO-cepBHUCch 00bekTOB (WES), KOTOpbIe IPeIOCTaBIAI0T BEKTOPHBIE CJIOU OTIENBHO, a HEe KaK
4acTb KapTsl B cruiie WMS.

Irot Borpoc Oy/IeT pacCMOTPEHO B clieayoiieM ypoke. CHavasa 1aBaite nobaBum ere onaut cioit WMS u3 cepBepa
WMS fterrestris.

10.1.2 \ Monpo6ynte camm

1. Hamo ckpeith croit OSM-WSM B manenu Layers.

2. Jobasbre «ZAF CGS 1M Bedrock Lithostratigraphy» WMS cepsep B: URL: http://196.33.85.22/
cgi-bin/ZAF_CGS_Bedrock_Geology/wms.

3. 3arpysure cnoii BEDROCKGEOLOGY Ha xapTy (BBl TaKXe MOXKETe WCIOJb30BaTh KHONKY Layer » Add

T,

T
Layer » S Add WMS/WMTS Layer... nis Toro, 4roObl OTKpHITH AuanoroBoe okHo the Data Source
Manager). Hano nposepuTts, HaxoauTcs i oHa Toil ke WGS 84 / World Mercator TpoeKIIMY Kak U OCTaJIbHas
4yacTh Ballei KapThl!

4. Bel MoxeTe HacTpouTs ero Encoding na JPEG u ero Tile size oo Ha 200 Ha 200, 4T0ObI OHA 3arpyXxaiach
OwicTpee:
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000 Add Layer(s) from a Server
Layer Order | Tileseis | Server Search |
| bedrock 2
[ Connect ] | MNew || Edit || Delete | | Load || Save | | Adddefault servers |
ID A | Name Title Abstract

Coordinate Reference System (1 available)

BEDROCKG... ZAFCGS1... The 1:1 m digital geological map covering the whole of the Republic of South Africa is available in this OGC WMS ...

> 1 ZAF_CGS_1... ZAFCGS1:... ZAF CGS 1:1M Bedrock Lithostratigraphy
Image encoding

()PNG (T)PNG8 (&)JPEG ( )GIF () TIFF

Layer name | BEDROCKGEOLOGY

Tile size |200

| 1200] |

Feature limit for GetFeaturelnfo
WGS 84

| Help | | Add |
1 Layer(s) selected

[10 |

[ Change ... J

IIposepome ceéou pesyrvmamol

10.1.3 / Monpo6yute camm

1. Ckpoiite Bce ocTanbhble cion WMS, 4To0bl OHU He 0TOOpakatich B (POHOBOM pexume Oe3 HaJOOHOCTH.

2. Hob6aBbre «OGC» WMS-cepBep Ha: http://ogc.gbif.org:80/wms.

3. HoGasbte cioit bluemarble.

IIposepvme céou pezynvmamuol

10.1.4 ﬂ'—- Monpo6ynte camu

CnoxHOCTb ucnosb3oBanuss WMS 3akmodaercs B TOM, 4ToObI HaiiTi Xoporuii (OecryIaTHbIN) cepBep.

* Haiigute HOoBylo WMS Ha "directory.spatineo.com ~_ (WJH ellie [ie-TO B MHTepHeTe) 6e3 HaJoOHOCTH OrLIa-
Thl KaKUX-TMOO yCIyr Wi 0e3 OrpaHMYeHUil M OH JOJUKEH OXBAThIBAaTh BCIO TEPPUTOPHIO MCCIICAOBAHUS

Swellendam.

[TomnwuTe, 9tO U1 Micnonb30BaHUA WMS BaM Hy’KeH JIMIIb aipec caiTa (1 )KeJaTesbHO KaKoe-TO OIMCaHHUE).

IIpogepvme ceou pesynomanul

10.1. 3aHaTtne: CepBuchl Beb6-kapT
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10.1.5 B 3aknoyeHun

Hcnonb3yst WMS, Bbl MOXeTe 100aBJISITh HEAKTHBHbIE KAPThl B Ka4ecTBe (pOHA JUIs BAIMX CYLIECTBYIOIMX KapTO-
rpachu4ecKux JaHHbBIX.

10.1.6 JononHutenbHble MaTepunanbl AN YTeHUs

* “Spatineo Directory ~_

¢ “OpenStreetMap.org list of WMS servers *_

10.1.7 Yto panbLie?

ITocrne Toro Kak Bbl JOOABWIIM HEAKTHBHYIO KapTy B KayecTBe (hOHA, BbI OyleTe pabl y3HATh, YTO BBl TAKKE MOXKETE
J00GABISATh OOBEKTHI (HAPUMED, APYTHe BEKTOPHbIE CJION, KOTOPbIE Bbl J00ABIIsUTH paHee). [loGaBieHHe 0ObEKTOB C
yIaJeHHbIX CEPBEPOB BO3MOXKHO C MOMOIIBI0 BeO-cepBrcoB 00bekToB (WFS). D10 Tema crieyroliero ypoka.

10.2 3aHsaTHe: Beb-cepBUCHI 06BEKTOB

Be6-cepuch o6bextoB (WES) nator cBorm nosbzoBatestsim fanHble [ IC B (hopmaTax, KOTOpblE MOKHO 3arpy3HTh
HenocpeacTseHHO B QGIS. B ommune or WMS, koTopast npeocTasiiseT BaM TOJIBKO KapTy, KOTOPYIO Bbl HE MOXETE
penakripoBaTh, WES naer Bam JocTyn kK caMUM OOBEKTaM.

ean 3TOro0 ypoka: VMcrnonn3oBats WES 1 oHATh, 4eM OH oTin4aeTcst oT WMS.

10.2.1 \ WUnem panbue: 3arpyxaem cnon WFS
1. Bamycrute HOBYIO KapTy. BhI iesiaeTe 910 /151 IEeMOHCTPALIMOHHBIX 11eJIel U He OyJeTe ee COXPaHsTh.

2. KimkHWTE Ha KHOTIKY ‘g Open Data Source Manager

3. BruouMre BKJIAKy & WES / OGC API - Features.
4. KnukHuTe Ha KHONKY New.

5. B nosiBuBIIEMCsI AMAJIOTOBOM OKHE HaIo BBeCTH Name B Buzie nsidc.org u aapec caiita URL https://
nsidc.org/cgi-bin/atlas_south?version=1.1.0.
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Create a New WFS Connection X

Connection Details

Name |nsidc.org

URL https://nsidc.org/cgi-bin/atlas_south?version=1.1.0
Authentication

Configurations | Basic

Choose or create an authentication configuration

No Authentication ~ &

Configurations store encrypted credentials in the QGIS
authentication database.

WFS Options

Version Maximum > Detect
Max. number of Features
¥ Enable feature paging
Page size
Ignore axis orientation (WFS 1.1/WFS 2.0)
Invert axis orientation

Use GML2 encoding for transactions

©Help ©cancel QoK

6. Kiukaute Ha KHOIIKY OK ¥ TIOSIBUTCSI HOBOE COCIMHECHUEC B BalllEM Server connections.

7. Knmuknure Ha Connect. IToSIBUTCS CIIUCOK JOCTYIHBIX CJIOEB:
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Data Source Manager | WFS / OGC API - Features X
B Browser Server Connections
\Va nsidc.org .
& Vector
Raster Connect Edit Hamous Load save
*
1:_ Mesh Filter
Title ~ Name Abstract sql =

o Delimited Text
‘.d GeoPackage
i'i SpatiaLite

* PostgreSQL

* MssQL
082, pB2
w Virtual Layer

\ﬁl_ WMS/WMTS

@ WFS / OGC API - Features

=2% Vector Tile
A ArcGIS Map Service
4 ATCGIS Feature Service

» GeoNode

(o]

Antarctic coastline (includes ice shelves)
Antarctic continent

Antarctic grounding line (excludes ice ...
Antarctic ice core locations

Antarctic ice shelves

Antarctic island coastlines

Antarctic island coastlines

Antarctic islands

Antarctic megadunes

Antarctic permanent research stations
Antarctic Polar Front

Antarctic suface elevation contours
Antarctica border

coastlines (excluding Antarctica)
countries (excluding Antarctica)

glacier outlines

glaciers

International Date Line

land (excluding Antarctica)

South Pole of Cold

Use title for layer name

Coordinate Reference System

EPSG:3031

@Help

antarctic_ice_shelves_outline
antarctic_continent
antarctic_coastline
antarctic_ice_cores
antarctic_ice_shelves_Fill
antarctic_islands_coastlines
antarctica_islands_coastlines
antarctic_islands
antarctic_megadunes
antarctic_research_stations
antarctic_polar_front
antarctica_elevation_contours
antarctica_country_border
coastlines_excluding_antarctica
country_borders_excluding_antarctica
glacier_outlines

glaciers

international_date_line
land_excluding_antarctica
south_pole_of_cold

v| Only request features overlapping the view extent

Bohlander, J. and T. Scambos. 2...
Bohlander, J. and T. Scambos. 2...
Maurer, J. compiler. 2009. Dee...
Bohlander, J. and T. Scambos.
Bohlander, J. and T. Scambos.
Bohlander, J. and T. Scambos.
Bohlander, J. and T. Scambos.
Bohlander, J. and T. Scambos. 2...
Wwikipedia contributors. 24 Jan...
Orsi, A. and Ryan, U. 2001. Loca...
Liu, H., K. Jezek, B. Li, and Z. Zh...
Bohlander, J. and T. Scambos. 2...
Center for International Earth ...
Center for International Earth ...
Armstrong, R., B. Raup, 5.J.5. K...
National Imagery and Mapping ...
National Geographic Society. 1...
Center for International Earth ...
Wwikipedia contributors. 23 Jan...

TP PRI

NN NN

Build query

XOJICT Balllen KapTbl MOKET HE MOKPLIBATbL MHTEPECYIONIYI0 HAC MECTHOCTb! AHTapKTI/IIIa.

Change...

@add Dclose

. Cuumure naxok Only request features overlapping the view extent BHU3Y CIHUCKa CJIO€B, TaK KaK TEKYIIUNA

9. Haiinure cnoii antarctica_country_border. Bel MoXkeTe UCIIOIB30BaTh STYEHKY Filter Ha BepXHEH 9acTu.

10.

KinkHute Ha CJ0i, YTOObI BHIOPATH €r0:

11. Haiigute u BeIOEpUTE TaKke CIOH south_poles_wfs. Bam Hamo yaepxkusath Ctrl.

[ Browser

c % Vector

Server Connections

nsidc.org

Data Source Manager | WFS / OGC API - Features

Connect Edit Remove Load Save
. Raster 0
X/ .
Sy Mesh Filter
Title ~ Name Abstract sql =

4 Delimited Text
'4 GeoPackage
;; SpatiaLite

4 PostgresQL

& MssQL

082, pB2
M Virtual Layer
l(ﬁi WMS/WMTS

@ WFS / OGC API - Features

% Vector Ti le
A ArcGIS Map Service
s ArcGIS Feature Service

» GeoNode

Antarctic island coastlines
Antarctic island coastlines
Antarctic islands

Antarctic megadunes

Antarctic permanent research stations
Antarctic Polar Front

Antarctic suface elevation contours
Antarctica border

coastlines (excluding Antarctica)
countries (excluding Antarctica)
glacier outlines

glaciers

International Date Line

land (excluding Antarctica)

South Pole of Cold

South Pole of Inaccessibility

South Pole, Geographic

South Pole, Geomagnetic

South Pole, Magnetic

South Poles

Use title for layer name

antarctic_islands_coastlines
antarctica_islands_coastlines
antarctic_islands
antarctic_megadunes
antarctic_research_stations
antarctic_polar_front
antarctica_elevation_contours
antarctica_count
coastlines_excluding_antarctica
country_borders_excluding_antarctica
glacier_outlines

glaciers

international_date_line
land_excluding_antarctica
south_pole_of cold
south_pole_inaccessibility
south_pole_geographic
south_pole_geomagnetic
south_pole_magnetic
south_poles_wfs

Only request features overlapping the view extent

Coordinate Reference System

EPSG:3031

@ Help

12. Knukuwnre Ha Add.

Bohlander, J. and T. Scambos. 2...
Bohlander, J. and T. Scambos. 2...
Bohlander, J. and T. Scambos. 2...
Bohlander, J. and T. Scambos. 2...
Wikipedia contributors. 24 Jan...
Orsi, A. and Ryan, U. 2001. Loca...

Center for International Earth ...
Center for International Earth ...
Armstrong, R., B. Raup, 5.J.5. K...
National Imagery and Mapping ...
National Geographic Society. 1...
Center for International Earth ...

Wikipedia contributors. 23 Jan...

Wikipedia contributors. 20 Jan.
Labels the location of the Sout...
McClean, S. 24 January 2007. G...
McClean, S. 24 January 2007. G...
Labels the location of variousk...

Build query

Change...

©add Oclose
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3arpyska cJI0eB MOXKET 3aHATh HEKOTopoe BpeMsl. [Tocsie 3arpy3ku OHM MOSIBATCA HAa KapTe, MOKa3blBas Ouep-
TaHUsA AHTapKTHIBI U HECKOJIBKO TOYEK HaJ Heil.

*Untitled Project — QGIS 7b28cc6b0c

Project Edit View Layer Settings Plugins Vector Raster Database web Mesh Processing Help
0 R UL rL,HEPDPD Q4 LIRS £
NGV A% B . T

Layers (2]
¢ @l ® T &~
south_poles wfs
v [ ] antarctica_country_border

(x|

Layers | Browser

L Type to locate (Ctrl+K) oordinat| 3011422,2419184 |9 cal 1:39763080 |~ & lagnific 100% - otatio [0.0° < [v/Render @EPsc3031 @

B yem otimmune ot cinos WMS?

13. BuiGepurte 110001 U3 CJIOEB U Bbl 3aMETHUTE, YTO BKJIIOYEHBI MFHCTPYMEHTHI BHIOOpa OOBEKTOB U TaOJIMIIbI ATPH-
OyTOB. DTO BEKTOPHbIE CJIOM.

14. Buibepute cioit south_poles_wfs n oTKpoiite ero Taduuily arpuOyToB. Bl JOIKHBI YBUAETD 3TO:

south_poles_wfs — Features Total: 1, Filtered: 1, Selected: 0 -

2 s LT E & x':' ¥ B =2 5 &
Id NAME
1/0 Geographic South Pole

T show All Features _ = (m=

Tak Kak TOYKM UMEIOT aTpUOYTHI, Mbl MOXEM IIOMETHTD UX, & TAKXe U3MEHUTh MX YCJIOBHbIE 0O03HAYEHHSI.
Bot npumep:
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*Untitled Project — QGIS 7b28ccéboc - o X

Project Edit View Layer Settings Plugins Vector Raster Database Web Mesh Processing Help

DEERRY O*LLAHAPP RARE LNOR -8 &% GEEKZT -
‘! @1 V/’?’ o @ = W | g By g & @ @
Layers @@

-'.-._@W_Y'_E_,'_l_‘ra

south_poles_wfs
| [ antarctica_country_border

Layers | Browser

L Type to locate (Ctrl+K) sordinat| 4010884,2419184 | % cal|1:39763080 | ~ | & lagnifie 100% = | otatio |0.0° >| v/ Render #EPsG3031 @

Otnnuusa ot cnoes WMS

Be6-cepBrc 06BbEKTOB BO3BpAILIAET CaM CJIOH, a He TOJIBKO KapTy, BU3yaIHM3UPOBAHHYIO U3 HEro. DTo JaeT BaM Npsi-
MO JIOCTYII K IQaHHBIM, a 3HAUHT, Bbl MOXKETe U3MEHATh UX YCJIOBHbIE 0003HAUECHHS U 3aIlycKaTh (DYHKIMM aHAIN3a
9TUX JAaHHBIX. TeM He MeHee, 3TO IPOUCXOUT 32 CUET Tepeiauy ropaszio 0oJbIIero oobemMa JaHHbIX. TO CTAHOBUT-
cs1 0COOEHHO OYEBHIHBIM, €CJIM 3arpyKaeMble BaMHU CJIOM UMEIOT CJIOXKHbIE (pOPMBI, MHOTO aTpHOYTOB WIIM MHOTO
0OBEKTOB; WJIM €CJIM Bl IIPOCTO 3arpy’kaete MHOTO cioeB. M3-3a atoro cion WES 00bIMHO 3arpyskaiorcst OYeHb
JOJITO.

10.2.2 / WUnem panbuwe: 3anpawmsaem cnon WFS

XoTs1 1 MOXHO cJenath 3arpoc ciiosi WES nocne ero 3arpy3ku, Ho vaiie Bcero 6osee 3(h(peKTHBHO 3arpocuTh ero
niepen 3arpy3koii. Takum oOpa3oM, BbI 3alpaliMBaeTe TOJIBKO Te 0ObEKThl, KOTOPbIe BaM HYKHBI,  3TO O3HAYaerT,
YTO BHI MICTIOJIb3YETE TOPas3io MEHbIIYIO IPOMYCKHYIO CIOCOOHOCTb.

Hampumep, Ha cepBepe WES, KOTOPBII MBI CEii9ac HCIIONIb3YeM, ECTh CJIOH, KOTOPBIN Ha3bIBaeTCs countries (excluding
Antarctica). TIpennonoxuM, 4ro Mbl XOTHUM 3HaTh, e Haxogurtcs FOxHas Adpuka MO OTHOIIEHHWIO K CJIOI0
south_poles_wfs (1, BOSMOXHO, TaK)Ke CJION antarctica_country_border), KOTOPbII yKe ObLT 3arpyxXeH.

EcTb 1Ba cioco0a criesiaTs 910. Bbl MOskeTe 3arpy3uThb BECh CIIOH countries ..., a 3aTeM CO3/IaiiTe 3a1poc, Kak 0ObIYHO,
niocyie ero 3arpy3ku. Ho nepenava JaHHBIX 10 BceM CTpaHaM MHpa U IOCIIeIyoIIee UCTIONb30BAHNE IAaHHBIX TOJIBKO
o lOxHoit Aprke KaxeTcsi HOMHOTO PACTOUMTEIILHBIM C TOUKH 3peHHsI IPOITyCKHOM criocoOHocTH. B 3aBHCHMOCTH
OT CKOPOCTH BAlLIero NOJKJIIOUEHHs], 3arpy3Ka 3Toro Habopa JaHHBIX MOKET 3aHATh HECKOJIBKO MUHYT.

AJIbTepHATUBHBIM BAPUAHTOM SIBJISIETCSI CO3[JaHKE 3aIipoca B KauecTBe (PUIIbTpa ellie JI0 3arpy3KH CJosl C cepBepa.
1. Brumounte Briagky WFS / OGC API Features B nuanoroBom okHe Data Source Manager.

2. HOZ[KJIIO‘II/ITCCL K CepBeEpy, KOTOpBIfI MbI UCIIOJIb30BAJIM paHbllI€, U Bbl JOJIZKHBI YBUIACTDH CIIMCOK HOCTYITHBIX
CJIOEB.

3. Haiigute W [BaxJpl KJIUMKHUTE TIO cJoOl0 countries (excluding Antarctica). HazBaHue ciosi Takoe
country_borders_excluding_antarctica. Bo Takke Moxere BHOpaTh CJIOH M KJIMKHYTH Ha
KHONKY Build query B HUKHEW 4acTU AMATIOrOBOIO OKHA!
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Data Source Manager | WFS / OGC API - Features

[ srowser Server Connections

+ g Vector gaideen

5 Raster New Edit Remove Load Save
" Mesh Filter
Delimited Text  JULH ~ Name Abstract sql F
- South Pole of Cold south_pole_of cold wikipedia contributers. 23 January 2007. ...
N4 GeoPackage land (excluding Antarctica) land_excluding_antarctica Center for International Earth Science Inf.

- International Date Line international_date_line National Geographic Society. 1992. Natio...
7 spatialite glaciers glaciers National Imagery and Mapping Agency (N.
glacier outlines glacier_outlines Armstrong, R, B. Raup, S..S. Khalsa, R. Ba...
countries (excluding Antarctica) country_borders_excluding antarctica Center For International Earth Science Inf...
coastlines (excluding Antarctica) coastlines_excluding_antarctica Center for International Earth Science Inf...
Antarctica border antarctica_country_border Bohlander, J. and T. Scambos. 2007. Antar.
DB2 pB2 Antarctic suface elevation contours antarctica_elevation_contours Liu, H., K. Jezek, B. Li, and Z. Zhao. 2001. R...
] antarctic_polar_front orsi, A. and Ryan, U. 2001. Locations of th...
antarctic_research_stations wikipedia contributors. 24 January 200

 PostgresQL

s MSSQL

Virtual Layer

= Antarctic megadunes antarctic_megadunes Bohlander, J. and T. Scambos. 2005. Outli.
Q WMS/WMTS Antare slands antarctic_islands Bohlander, J. and T. Scambos. 2007. Antar...
WFS / 0GC API- Antarctic island coastlines islands_coastlines Bohlander, J. and T. Scambos. 2007. Antar...
Features Antarctic island coastlines antarctica_islands_coastlines Bohlander, J. and T. Scambos. 2007. Antar...
Antarctic ice shelves antarctic_ice_shelves_fill Bohlander, J. and T. Scambos. 2007. Antar...
wcs Antar ice core locations ic_ice_t Maurer, J. compiler. 2009. Deep ice core l....
Antarctic grounding line (excludes ice ... antarctic_coastline Bohlander, J. and T. Scambos. 2007. Antal

- XYZ Antarctic continent antarctic_continent Bohlander, J. and T. Scambos. 2007. Anta

Antarctic coastline (includes ice shelves) antarctic_ice_shelves_outline Bohlander, J. and T. Scambos. 2007. Antar...

Vector Tile
Use title for layer name

ATCGIS Map
* service Only request features overlapping the view extent

ARSI Coordinate Reference System
&% service

g GeoNode EPSG:3031 Change...
@Help Build query @add Dclose
4. B mnosBUBIIEMCS [JMaJOTOBOM OKHE BBeAWTE cCleAylommid 3amnpoc SELECT * FROM
country_borders_excluding_antarctica WHERE "Countryeng" = 'South Africa'

B sueiike SQL Statement.

SQL Query Composer

SELECT * FROM country borders excluding antarctica WHERE "Countryeng" =

SQL Statement South Africa’

Columns | * Data
Columns -

Table(s) |country borders_excluding antarctica

where | Countryeng = 'South Africa’ Functions -

Spatial predicates -

Order by Operators v

©Help (#Reset ©cancel

5. Kimknaure Ha kHOnky OK.

6. Mcnonp3oBaHHOE BhIpakeHue OyJeT 0TOOpaxeHo Kak Sgl 3HaueHue LIeJIeBOro CIIOs:
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Data Source Manager | WFS / OGC API - Features

. Server Connections

nsidc.org -
‘.
New Edit Remove Load Save
*
L Filker
Title ~ Name Abstract sql =
- South Pole of Cold south_pole_of_cold Wikipedia contributors. 23 January 2007. ...
(7 lond (excluding Antarctica) land_excluding_antarctica Center for International Earth Science Inf...
- International Date Line international_date_line National Geographic Society. 1992. Natio...
P glaciers glaciers National Imagery and Mapping Agency (..
glacier outlines glacier_outlines Armstrong, R., B. Raup, 5.J.5. Khalsa, R. Ba
* g Center for International Earth Science Inf SELECT * FROM country_borders_excludi
coastlines (excluding Antarctica) coastlines_excluding_antarctica Center for International Earth Science Inf.
bl Antarctica border antarctica_country_border Bohlander, J. and T. Scambos. 2007. Antar...
Antarctic suface elevation contours antarctica_elevation_contours Liu, H., K. Jezek, B. Li, and Z. Zhao. 2001.
Antarctic Polar Front antarctic_polar_front orsi, A. and Ryan, U. 2001. Locations of
Antarctic permanent research stations ~ antarctic_research_stations Wikipedia contributors. 24 January 2007.
Antarctic megadunes antarctic_megadunes Bohlander, J. and T. Scambos. 2005. Outli
Antarctic islands antarctic_islands Bohlander, J. and T. Scambos. 2007. Antar.

Antarctic island coastlines antarctic_islands_coastlines Bohlander, J. and T. Scambos. 2007. Antar...
Antarctic island coastlines antarctica_islands_coastlines Bohlander, J. and T. Scambos. 2007. Antar.
Antarctic ice shelves antarctic_ice_shelves_fill Bohlander, J. and T. Scambos. 2007. Antar.

Antarctic ice core locations antarctic_ice_cores Maurer, J. compiler. 2009. Deep ice core ...
Antarctic grounding line (excludes ice ... antarctic_coastline Bohlander, J. and T. Scambos. 2007. Antar.
Antarctic continent antarctic_continent Bohlander, J. and T. Scambos. 2007. Antar.

Antarctic coastline (includes ice shelves) antarctic_ice_shelves_outline Bohlander, J. and T. Scambos. 2007. Antar. =

Use title for layer name
Only request features overlapping the view extent
Coordinate Reference System

EPSG:3031 change...

@Help Build query | @Add || @close

7. Knmknure Ha Add ¢ BHIOpaHHBIM cl1oeM, Kak ObUIO MokasaHo Beiie. TosbKo cTpaHa ¢ Count ryeng 3Hade-
HueM South Africa 3arpysurcs us 3TOro cjos:

Project Edit View Layer Settings Plugins Vector Raster Database Web Mesh Processing Help

0 DEY U22LHPRL QR LEBENOR H-§-5-0 & 5 E#I =6
aQV. 2w @ =4 = RFTRRD
Layers ® Processing Toolbox ®

« @ ® T & -8 &L 2e 08 BN
South Africa
-

country_borders_excluding_antarctica
v+ south_poles_wfs
v| [ antarctica_country_border

Q search...

+ (U Recently used
+ @ cartography
» @ Database

+ Q File tools

+ @ Interpolation
+ @ Layer tools
» @ Mesh

» @ Network analysis

+ @ Plots

+ @ Raster analysis

» @ Raster creation

» @ Raster terrain analysis
+ @ Raster tools
»

v

»

>

»

v

»

>

»

v

v

@ Vector analysis
@ Vector creation
@ Vector general
@ Vector geometry
@ Vector overlay
@ Vector selection
@ Vector table

@ Vector tiles

@i GDAL

& GRASS

€ SAGA

Layers | Browser Layerstyling | Processing Toolbox

Q Type to locate (Ctrl+K) Coordinate| -2420925,3486645 | Scale 1:63026552 |~ | @@ Magnifier| 100% +| Rotation |0.0° +|V/Render @®EPSG:3031 @

Brl 3ameriim E 3HAYOK PSAIOM CO cloeM country_borders_excluding_antarctica? D10 yka-
3bIBacT Ha TO, YTO 3arPYKSHHbIN CJION OT(PUIBTPOBAH M HE OTOOpAKAET B MIPOCKTE BCE CBOM OOBEKTHI.

8. Bam He 06s13aTesIbHO 3TO JeJ1aTh, HO €CIH BHI ITOITpo0yeTe 00a MeTo/1a, Bbl 3aMETHTE, YTO 9TO HAMHOTO ObICTpee,
YeM 3arpyxarb BCE CTPaHbI riepe]] nx (puibTpanuei!
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O poctynHoctn WFS

Penko MoXHO HallTH 0OBEKTHI, XpaHuMble B WES, KOTOpBIE BaM HY’KHBI, €CJIH Ballli IOTPEOHOCTH OYeHb Crielug Y-
Hbl. [Ipuunna, o kotopoit WFS oTHOCHTENBHO pelky, 3aKII0YaeTcsi B TOM, YTO JUIsl ONMCAHUsI OObEKTa B LIEJIOM
HEoOXOAMMO TepesiaBaTh OoJble 00beMbl AaHHbIX. [oaToMy He oueHb peHTadenbHO pasmernars WES BmecTo
WMS, KoTopasi mpeqoCcTaBIIseT TOIbKO N300 paKEeHHUS.

Iostomy Haubosee pacripoctpaHeHHbid THIT WFS, ¢ KOTOPBIM BbI CTOJIKHETECh, BEPOSITHO, OyJeT HaXOOUThCS B
JIOKQJIbHOM CETH WJIH JIaXe Ha BallleM COOCTBEHHOM KOMIIbIoTepe, a He B IHTepHeTe.

10.2.3 B 3aknoyeHun
Criou WFS nipennoututenshee yem ciion WMS, eciiv Bam HyKeH MPSIMO JJOCTYIT K aTpudyTaM U TeOMETPHHU CIIOEB.
Tem He MeHee, ¢ y4eToM 00beMa JaHHBIX, KOTOPbIe HEOOXOIMMO 3arpy3UTh (UTO MPMBOAUT K IPOOIEMaM CO CKOPO-

CTBIO, A TAK)KE K OTCYTCTBHIO JIETKOJIOCTYNHBIX cepBepoB WES), He Bceraa Bo3MoxkHO ucrosns3oBath WES BMecTo
WMS.

10.2.4 Yto panbLie?

Haee BbI yBUIUTE, Kak uctoib3oBatk QGIS Server ms npenocrasnenus yeayr OGC.
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Module: QGIS Server

Module contributed by Tudor Barascu.
In this module, we’ll cover how to install and use QGIS Server.

To learn more about QGIS Server, read the QGIS-Server-manual.

11.1 Lesson: Install QGIS Server

The goal for this lesson: To learn how to install QGIS Server on Debian Stretch. With negligible variations you
can also follow it for any Debian based distribution like Ubuntu and its derivatives.

IIpumeuanne: In Ubuntu you can use your regular user, prepending sudo to commands requiring admin
permissions. In Debian you can work as admin (root), without using sudo.

11.1.1 / Follow Along: Install from packages

In this lesson we’re going to do only the install from packages as shown here .

Install QGIS Server with:

apt install ggis-server —--no-install-recommends —--no-install-suggests

# 1f you want to install server plugins, also:
apt install python-ggis

QGIS Server should be used in production without QGIS Desktop (with the accompanying X Server) installed on
the same machine.
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11.1.2 / Follow Along: QGIS Server Executable

The QGIS Server executable is ggis_mapserv.fcgi. You can check where it has been installed by running
find / -name 'ggis_mapserv.fcgi' which should output something like /usr/lib/cgi-bin/
gqgis_mapserv. fcgi.

Optionally, if you want to do a command line test at this time you can run the /usr/lib/cgi-bin/
qgis_mapserv.fcgi command which should output something like:

QFSFileEngine::open: No file name specified

Warning 1: Unable to find driver ECW to unload from GDAL_SKIP environment variable.
Warning 1: Unable to find driver ECW to unload from GDAL_SKIP environment variable.
Warning 1: Unable to find driver JP2ECW to unload from GDAL_SKIP environment.
—variable.

Warning 1: Unable to find driver ECW to unload from GDAL_SKIP environment variable.
Warning 1: Unable to find driver JP2ECW to unload from GDAL_SKIP environment.
—variable.

Content-Length: 206

Content-Type: text/xml; charset=utf-8

<ServiceExceptionReport version="1.3.0" xmlns="https://www.opengis.net/ogc">
<ServiceException code="Service configuration error">Service unknown or.
—unsupported</ServiceException>

</ServiceExceptionReport>

This is a good thing, it tells you we're on the right track as the server is saying that we haven’t asked for a supported
service. We'll see later on how to make WMS requests.

11.1.3 == HTTP Server Configuration

In order to access on the installed QGIS server from an Internet Browser we need to use an HTTP server. The
Apache HTTP Server installation process is detailed in httpserver section.

IIpumeuanne: If you installed QGIS Server without running an X Server (included in Linux Desktop) and if you
also want to use the GetPrint command then you should install a fake X Server and tell QGIS Server to use it.
You can do that by following the Xvfb installation process.

11.14 / Follow Along: Create another virtual host

Let’s create another Apache virtual host pointing to QGIS Server. You can choose whatever name you like (coco.
bango, super.duper.training, example. com, etc.) but for simplicity sake we’re going to use myhost.

e Let’s set up the myhost name to point to the localhost IP by adding 127.0.0.1 xtothe /etc/hosts
with the following command: sh -c¢ "echo '127.0.0.1 myhost' >> /etc/hosts" or by
manually editing the file with gedit /etc/hosts.

e We can check that myhost points to the localhost by running in the terminal the ping myhost command
which should output:

qgis@ggis:~$ ping myhost

PING myhost (127.0.0.1) 56(84) bytes of data.

64 bytes from localhost (127.0.0.1): icmp seg=1 ttl=64 time=0.024 ms
64 bytes from localhost (127.0.0.1): icmp_seg=2 ttl=64 time=0.029 ms
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e Let’s try if we can access QGIS Server from the myhost site by doing: curl http://myhost/
cgi-bin/ggis_mapserv.fcgi or by accessing the url from your Debian box browser. You will

probably get:
<!DOCTYPE HTML PUBLIC "-//IETF//DTD HTML 2.0//EN">
<html><head>
<title>404 Not Found</title>
</head><body>

<hl1>Not Found</hl>

<p>The requested URL /cgi-bin/qggis_mapserv.fcgi was not found on this server.</p>
<hr>

<address>Apache/2.4.25 (Debian) Server at myhost Port 80</address>

</body></html>

* Apache doesn’t know that he’s supposed to answer requests pointing to the server named myhost. In
order to setup the virtual host the simplest way would be to make a myhost.conf file in the /etc/
apache2/sites—-available directory that has the same content as ggis.demo.conf except for
the ServerName line that should be ServerName myhost. You could also change where the logs go as
otherwise the logs for the two virtual hosts would be shared but this is optional.

¢ Let’s now enable the virtual host with a2ensite myhost.conf and then reload the Apache service with
service apache2 reload.

* If you try again to access the http://myhost/cgi-bin/qgis_mapserv.fcgi url you'll notice everything is working
now!

11.1.5 In Conclusion

You learned how to install different QGIS Server versions from packages, how to configure Apache with QGIS
Server, on Debian based Linux distros.

11.1.6 What’s Next?

Now that you’ve installed QGIS Server and it’s accessible through the HTTP protocol, we need to learn how to
access some of the services it can offer. The topic of the next lesson is to learn how to access QGIS Server WMS
services.

11.2 Lesson: Serving WMS

The data used for this exercise are available in the qgis-server—-tutorial-data subdirectory of the training
data you downloaded. For convenience and to avoid possible permissions problems, we will assume that these files
are stored in /home/qgis/projects directory. Hence, adapt the following instructions to your path.

The demo data contains a QGIS project named wor1d. ggs thatis already prepared to be served with QGIS Server.
If you want to use your own project or you want to learn how a project is prepared see the Creatingwmsfromproject
section.

IIpumeuanne: This module presents the URLs so that the audience can easily distinguish the parameters and
parameters values. While the normal format is:

...&fieldl=valuelsfield2=value2s&field3=value3

this tutorial uses:

sfieldl=valuel
sfield2=value?2
&field3=value3
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Pasting them into Mozilla Firefox works properly but other web browsers like Chrome may add unwanted spaces
between the field:parameter pairs. So, if you encounter this issue you can either use Firefox or modify the
URLS so that they’re in one line format.

Let’s make a WMS GetCapabilities request in the web browser or with curl:

http://ggisplatform.demo/cgi-bin/ggis_mapserv.fcgi
?SERVICE=WMS

&VERSION=1.3.0

&REQUEST=GetCapabilities
&map=/home/qgis/projects/world.qgs

In the Apache config from the previous lesson the QGIS_PROJECT_FILE variable sets the default project to
/home/ggis/projects/world.ggs. However, in the above request we made use of the map parameter to
be explicit and to show it can be used to point at any project. If you delete the map parameter from the above
request QGIS Server will output the same response.

By pointing any WMS client to the Get Capabilities URL, the client gets in response an XML document with
metadata of the Web Map Server’s information, e.g. what layers does it serve, the geographical coverage, in what
format, what version of WMS etc.

As QGIS is also a ogc-wms you can create a new WMS server connection with the help of the above GetCapabilities
url. See the 3arnsmue: Cepsucer 6eo-kapm or the ogc-wms-servers section on how to do it.

By adding the countries WMS layer to your QGIS project you should get an image like the one below:
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21887735 - 4740653
47406537 -1338612

Puc. 11.1: QGIS Desktop consuming the QGIS Server countries layer WMS service

IIpumeuyanne: QGIS Server serves layers that are defined in the world. ggs project. By opening the project
with QGIS you can see there are multiple styles for the countries layer. QGIS Server is also aware of this and you can
choose the style you want in your request. The classified_by_population style was chosen in the above
image.
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11.2.1 JlorrupoBaHue
When you’re setting up a server, the logs are always important as they show you what’s going on. We have setup in
the * . conf file the following logs:

¢ QGIS Server log at /logs/ggisserver.log

* ggisplatform.demo Apache access logat ggisplatform.demo.access.log

* ggisplatform.demo Apache error log at gqgisplatform.demo.error.log

The log files are simply text files so you can use a text editor to check them out. You can also use the tai 1l command
in a terminal: sudo tail -f /logs/ggisserver.log.

This will continuously output in the terminal what’s written in that log file. You can also have three terminals opened
for each of the log files like so:

qgis@qgis: ~ - o x
File Edit View Search Terminal Help
ggi s:~$% sudo tail -f /var/log/apache2/qgisplatform.demo.error.log
*E
1s@qgis:~$ sudo tail -f /var/log/apache2/qgisplatform.demo.error.log

qgis@qgis: ~ - @ x

File Edit Wiew Search Terminal Help

200 11378 "-" "curl/7.52.1"

127.0.0.1 - - [17/Mar/2017:04:09:41 -0400] "GET /cgi-bin/qgis mapserv.fcgi?SERVICE=W
MS&VERSION=1.3.0&REQUEST=GetCapabilities&map=/home/qgis/projects/world.qgs HTTP/1.1"
200 11378 *-* "curl/7.52.1"

127.0.0.1 - - [17/Mar/2017:04:09:42 -04008] "GET /cgi-bin/qgis mapserv.fcgi?SERVICE=W
MS&VERSION=1.3.0&REQUEST=GetCapabilities&map=/home/qgis/projects/world.qgs HTTP/1.1"
208 11378 "-" "curl/7.52.1" I

qgis@qgis: ~ = o x
File Edit Wiew Search Terminal Help

[1732][04:09:42] Sent 1 blocks of 11205 bytes
[1732][04:09:42] Request finished in 3 ms

e 0
gois@ggis:~$ sudo tail -T /logs/qgisserver.log
ﬁl?32][04:@9:42] MAP: /home/qgis/projects/world.qgs
11732][04:09:42] REQUEST:GetCapabilities

[1732][04:09:42] SERVICE:WMS

[1732][04:09:42] VERSION:1.3.0

[1732][04:09:42] Found capabilities document in cache
[1732][04:09:42] Checking byte array is ok to set...
[1732][04:09:42] Byte array looks good, setting response...
[1732][04:09:42] Sending HTTP response

[1732][04:09:42] Sent 1 blocks of 11205 bytes
[1732][04:09:42] Request finished in 3 ms

Puc. 11.2: Using the tail command to visualise QGIS Server logs output

When you use QGIS Desktop to consume the QGIS Server WMS services you will see all the requests QGIS sends
to the Server in the access log, the errors of QGIS Server in the QGIS Server log etc.

IIpumeuanue:
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* If you look at the logs in the following sections you should get a better understanding on what’s happening.

* By restarting Apache while looking in the QGIS Server log you can find some extra pointers on how things

work.

11.2.2 GetMap requests

In order to display the countries layer, QGIS Desktop, like any other WMS client, is using GetMap requests.

A simple request looks like:

http://gqgisplatform.demo/cgi-bin/ggis_mapserv.fcgi

?MAP=/home/qggis/projects/world.qgs

& SERVICE=WMS

&VERSTION=1.3.0

&REQUEST=GetMap
-432786,4372992,3358959, 7513746
EPSG:3857

HT=551
S=countries
&FORMAT=1image/ jpeg

The above request should output the following image:

Figure: simple GetMap request to QGIS Server
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Puc. 11.3: Qgis Server response after a simple GetMap request

11.23 / Try Yourself Change the Image and Layers parameters

Based on the request above, let’s replace the count ries layer with another.

In order to see what other layers are available you could open up the world. ggs project in QGIS and look at its
contents. Keep in mind though that the WMS clients don’t have access to the QGIS project, they just look at the
capabilities document contents.

Also, there’s a configuration option so that some of the layers existing in the QGIS project are ignored by QGIS
when serving the WMS service.

So, you could look at the layer list when you point QGIS Desktop to the GetCapabilities URL or you could
try yourself finding other layer names in the GetCapabilities XML response.

One of the layer names that you could find and works is countries_shapeburst. You may find others but
keep in mind some may not be visible at such a small scale so you could get a blank image as response.

You can also play around with others parameters from above, like changing the returned image type to image /png.
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11.24 / Follow Along: Use Filter, Opacities and Styles parameters

Let’s do another request that adds another layer, some of the extra-getmap-parameters, FILTER and OPACITIES,
but also uses the standard STYLES parameter.

http://ggisplatform.demo/cgi-bin/qggis_mapserv.fcgi
?MAP=/home/qggis/projects/world.qgs

& SERVICE=WMS

&VERSTION=1.3.0

&REQUEST=GetMap
&BBOX=-432786,4372992,3358959, 7513746
&SRS=EPSG:3857

&WIDTH=665

&HEIGHT=551

&FORMAT=image/jpeg

&LAYERS=countries, countries_shapeburst
&STYLES=classified_by_name,blue

&OPACITIES=255, 30

&FILTER=countries:"name" IN ( 'Germany' , 'Italy' )

The above request should output the following image:

Puc. 11.4: Response to a GetMap request with FILTER and OPACITIES parameters

As you can see from the above image, among other things, we told QGIS Server to render only Germany and Italy
from the countries layer.
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11.2.5 / Follow Along: Use Redlining

Let’s do another GetMap request that makes use of the qgisserver-redlining feature and of the SELECTION
parameter detailed in the extra-getmap-parameters section:

http://ggisplatform.demo/cgi-bin/ggis_mapserv.fcgi
?MAP=/home/ggis/projects/world.qgs

& SERVICE=WMS

&VERSION=1.3.0

&REQUEST=GetMap

&BBOX=-432786,4372992,3358959, 7513746

&SRS=EPSG:3857

&WIDTH=665

&HETIGHT=551

&LAYERS=countries, countries_shapeburst

&FORMAT=1image/jpeg

&HIGHLIGHT_GEOM=POLYGON ( (590000 6900000, 590000 7363000, 2500000 7363000, 2500000.
—~6900000, 590000 6900000))

&HIGHLIGHT SYMBOL=<StyledLayerDescriptor><UserStyle><Name>Highlight</Name>
—<FeatureTypeStyle><Rule><Name>Symbol</Name><LineSymbolizer><Stroke><SvgParameter.
—name="stroke">%$233a093a</SvgParameter><SvgParameter name="stroke-opacity">1</
—SvgParameter><SvgParameter name="stroke-width">1.6</SvgParameter></Stroke></
—LineSymbolizer></Rule></FeatureTypeStyle></UserStyle></StyledLayerDescriptor>
&HIGHLIGHT LABELSTRING=QGIS Tutorial

&HIGHLIGHT_LABELSIZE=30

&HIGHLIGHT_LABELCOLOR=%23000000

&HIGHLIGHT_LABELBUFFERCOLOR=%23FFFFFF

&HIGHLIGHT_LABELBUFFERSIZE=3

&SELECTION=countries:171, 65

Pasting the above request in your web browser should output the following image:
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France

Puc. 11.5: Response to a request with the REDLINING feature and SELECTION parameter

You can see from the above image that the countries with the 171 and 65 ids were highlighted in yellow (Romania
and France) by using the SELECTION parameter and we used the REDLINING feature to overlay a rectangle
with the QGIS Tutorial label.

11.2.6 GetPrint requests
One very nice feature of QGIS Server is that it makes use of the QGIS Desktop print layouts. You can learn about
it in the server_wms_getprint section.

If you open the world.qggs project with QGIS Desktop you will find a print layout named Population
distribution. A simplified GetPrint request that exemplifies this amazing feature is:

http://ggisplatform.demo/cgi-bin/ggis_mapserv.fcgi
?map=/home/qggis/projects/world.qgs
&SERVICE=WMS

&VERSTION=1.3.0&

REQUEST=GetPrint

&FORMAT=pdf

&TRANSPARENT=true

&SRS=EPSG:3857

&DPI=300

&TEMPLATE=Population distribution
smap0:extent=-432786,4372992,3358959, 7513746
&LAYERS=countries
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Puc. 11.6: Shows the pdf resulted from the above GetPrint request

Naturally, it’s hard to write your GetMap, GetPrint etc. requests.

QGIS Web Client or QWC is a Web client project that can work alongside QGIS Server so that you can publish
your projects on the Web or help you create QGIS Server requests for a better understanding about the possibilities.

You can install it like this:
e Asuser ggis go to the home directory with cd /home/ggis.
¢ Download the QWC project from here and unzip it.

e Make a symbolic link to the /var/www/html directory as it’s the DocumentRoot that we’ve setup
in the virtual host configuration. If you unzipped the archive under /home/ggis/Downloads/
QGIS-Web-Client-master we can do that with sudo 1n -s /home/qgis/Downloads/
QGIS-Web-Client-master /var/www/html/.

e Access http://qgisplatform.demo/QGIS- Web- Client-master/site/qgiswebclient.html ?map=/home/qgis/
projects/world.qgs from your Web browser.

Now you should be able to see the Map as in the following figure:
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[]OpenCycleMap
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[]Google Satellite
[]Google Map

Layer order 21 Mode: navigation. Shift/rectangle or mouse wheel for zooming. Coordinate: -362278,635102(

Puc. 11.7: QGIS Web Client consuming the world.qgs project

If you click the Print button in QWC you can interactively create GetPrint requests. You can also click the ?
icon in the QWC to access the available help so that you can better discover the QWC possibilities.

11.2.7 In Conclusion

You learned how use QGIS Server to provide WMS Services.

11.2.8 What’s Next?

Next, you'll see how to use QGIS as a frontend for the famous GRASS GIS.
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Module: GRASS

GRASS (Geographic Resources Analysis Support System) is a well-known open source GIS with a wide array of
useful GIS functions. It was first released in 1984, and has seen much improvement and additional functionality
since then. QGIS allows you to make use of GRASS* powerful GIS tools directly.

12.1 Lesson: GRASS Setup

Using GRASS in QGIS requires you to think of the interface in a slightly different way. Remember that you're not
working in QGIS directly, but working in GRASS via QGIS. Hence, make sure you have installed QGIS Desktop
with Grass support.

£7 To open a QGIS session with GRASS available on Windows you have to click on the QGIS Desktop with
GRASS icon.

The goal for this lesson: To begin a GRASS project in QGIS.

12.1.1 \ Follow Along: Start a New GRASS Session

To launch GRASS from within QGIS, you need to activate it as with any other plugin:
1. First, open a new QGIS project.
2. In the Plugin Manager, enable GRASS in the list:
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Plugins | Installed (14)

| @ search

& _ MACOSX
<+ Coordinate Capture
% Not installed V| & DB Manager G RAS s 7 %
i eVis
[ Geometry Checker GRASS 7 (Geographic Resources Analysis Support System)
1 Georeferencer GDAL
£ GPS Tools
ﬁ Settings CARSGHAS N :
v/ @& MetaSearch Catalog Client
 OfflineEditing
v| £} Plugin Reloader
V| &¢ Processing
V| 4 QuickOsM
#¢ Topology Checker

This is a core plugin, so you can't uninstall it

Invalid

o

Install from ZIP .
SRR £ Category Plugins
Installed version Version 2.0

| ElHelp |

¥ Close

The GRASS toolbar and the GRASS panel will appear:

Puc. 12.1: GRASS toolbar

332 Fnaea 12. Module: GRASS



QGIS Training Manual

DALY Bosed L

Ko magaet i open. You can open & GRASS mapee! o the brower unng thae
mapiet e conlexl meany hon Jpen musgeed

Puc. 12.2: GRASS Panel

The GRASS panel is not active because, before you can use GRASS, you need to create a Mapset. GRASS always
works in a database environment, which means that you need to import all the data you want to use into a GRASS
database.

The GRASS database has a straightforward structure, even if at a first look it seems very complicated. The most
important thing you should know is that the upper level of the database is the Location. Each Location can
contain different Mapset:in every Mapset you will find the PERMANENT Mapset because it is created by default
by GRASS. Each Mapset contains the data (raster, vector, etc) in a particular structure, but don’t worry, GRASS
will take care of this for you.

Just remember: Location contains Mapset that contains the data. For more information visit the GRASS
website.
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Database Location Mapset Maps
grassdata nc_spm PERMANENT
new_highway raster elevation
landcover
vector streets
buildings
3D raster soils
temporal landsat
wake_county
usa_albers

world_lat_lon

Puc. 12.3: GRASS database structure (from GRASS docs)

12.1.2 \ Follow Along: Start a New GRASS Project

1. Click on the Plugins —> GRASS —> New Mapset menu:

*Untitled Project - QGIS [tm] = o x
Project Edit View Layer Settings [JNE[i Vector Raster Database Web Processing Help
B B [ @ | % Manage and Install Plugins... 4 L EERZ =P 0
y R BB | @, python Console bl L P
Layers L Open Mapset S Tools

3 Plugin Reloader »
« @l ® T & - B D ‘mapset is open. You can open a GRASS mapset from the browser using the

set item's context menu action Open mapset.
4 Open GRASS Tools |

|}

EASHS

A GRASS Options |

Ly,

‘ Layers | Browser

| & Type to locate (Ctrl+K) | Ready Coordinate| -0.405,1.194 | Scale|1:1692146 ~ | @ Magnifier| 100% \:\ Rotation | 0.0 * 2| ¥ Render # EpsGia3ze &

You'll be asked to choose the location of the GRASS database.
2. Set it as the directory that will be used by GRASS to set up its database:
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New Mapset

GRASS Database

Database directory |jhn mefmatteo/exercise_data/grassdata Browse...

GRASS data are stored in tree directory structure. The GRASS database is the
top-level directory in this tree structure.

| Mext > | Cancel

3. Click Next.

GRASS needs to create a Locat ion, which describes the maximum extent of the geographic area you'll be working
in, also known as Grass Region.

IIpumeuanue: the Region is extremely important for GRASS because it describes the area in which all layers will
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be taken into account for GRASS. Everything that is outside will not be considered. Don’t worry, you can always

change the extent of the GRASS Region after the Location has been created

1. Call the new location SouthAfrica:
New Mapset

GRASS Location

® Create new location |SouthAfrica

The GRASS location is a collection of maps for a particular territory or project.

< Back Next > | Cancel

2. Click Next.

3. We'll be working with WGS 84, so search for and select this CRS:
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New Mapset
Projection

) Not defined

(8 Projection

Filter | ©. 4326

Recently used coordinate reference systems

Coordinate Reference System Authority ID

i
Coordinate reference systems of the world

Coordinate Reference System Authority ID

ID
Hide deprecated CRSs

~ & Geographic Coordinate Sy...
WGSs 84 EPSG:4326

4

Selected CRS 'WGS 84

Extent: -180.00, -90.00, 180.00, 90.00
Projd: +proj=longlat +datum=WGS84
+no_defs

< Back |’ Next = l| Cancel

4. Click Next.

5. Now select the region South Africa from the dropdown and click Set:

12.1. Lesson: GRASS Setup
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New Mapset

Default GRASS Region

North |-21.27 |

13.68 | West East |33.98 |

South |-35.9 |

Set current QGIS extent | || South Africa - | [ Set ]

The GRASS region defines a workspace for raster modules. The default region is
valid for one location. It is possible to set a different region in each mapset. It is
possible to change the default location region later.

<Back || Next> | Cancel |

6. Click Next.

7. Create a mapset, which is the map file that you’ll be working with.
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New Mapset

Mapset

New mapset

grass_mapset

The GRASS mapset is a collection of maps used by one user. A user can read maps
from all mapsets in the location but he can open for writing only his mapset
{owned by user).

= Back | Next > | Cancel

Once you're done, you’ll see a dialog asking with a summary of all the information entered.
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New Mapset

Create New Mapset

Database : /home/matteo/exercise_data/grassdata

Location : SouthAfrica

Mapset : grass_mapset

v Open new mapset

< Back | Finish | Cancel

8. Click Finish.

9. Click OK on the success dialog.

You will see that the GRASS Panel will become active and you can start to use all GRASS tools.
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12.1.3 \ Follow Along: Loading Vector Data into GRASS

You have now a blank map and before you can start to use all the GRASS tools you have to load data into the
GRASS database, specifically into the Mapset. You cannot use GRASS tools with layer that are not loaded into a
GRASS Mapset.

There are many different ways to load data in the GRASS database. Let’s start with the first one.

\ Follow Along: Load data using the QGIS Browser

In section /lanenw Opayzepa we saw that the easiest and quickest way to load the data in QGIS is the Browser Panel.

GRASS data are recognized from the QGIS Browser as real GRASS data and you can notice it because you will see
[

%

the GRASS icon next to the GRASS Mapset. Moreover you will see the %% icon next to the Mapset that is opened.

Browser &
L &THO
d Favorites m
= B9 training manual
v B forms

~ B8 grass
~ B9 grassdata

v [ SouthAfrica
* & SouthAfrica
& grass_mapset
b PERMANENT

v [ postgis
v [ processing
v [ projected data
v [ ggis-server-tutorial-data

IIpumeuanne: You will see a replication of the GRASS Location as normal folder: GRASS Mapset data are

those within the N folder

You can easily drag and drop layers from a folder to the GRASS Mapset.
Let’s try to import the roads layer into the grass_mapset Mapset of the SouthAfrica Location.

Go to the Browser, and simply drag the roads layer from the training_data.gpkg GeoPackage file into the
grass_mapset Mapset.
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Browser (&) (]
LT ™O
Y |
* [ exercise data 1=
5 forms
v 5 grass

v [ grassdata
» 5 SouthAfrica
* 4 SouthAfrica

» ¢ grass_mapset
(= reclass_aspect.txt
(~ reclass_g_dem.kxt
network_analysis
plugins
poskgis
processing
projected data
qgis-server-tutorial-data
raster
school_property _photos
shapefile
styles
symbols
world

() example
» =l landuse.sqlite
* = training_data.gpkg

- buildings
= restaurankts

. roads = |

b . . . . . . .

FAR AR AR AR AR AW AN AW AN AW AN

v v

1 b

That’s it! If you expand the Mapset you will see the imported roads layer. You can now load in QGIS the imported
layer like all the other layers.

Coget: You can also load layers from the Layer Legend Panel to Mapset in the Browser Panel. This will speed up
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incredibly your workflow!

\ Follow Along: Load data using the GRASS Panel

We will use now the long method to load the rivers. shp layer into the same Mapset.

1. Load data into QGIS as usual. Use the rivers.shp dataset (found in the exercise_data/
shapefile/ folder)

2. As soon as it is loaded, click on the Filter box of the GRASS Panel and find the vector import tool by
entering the term v.in.ogr.ggis:

IIpenynpe:xaenne: There are 2 similar tools: v.in.ogr.qggis and v.in.ogr.ggis.loc. We
are looking for the first one.

GRASS Tools: SouthAfrica/grass_mapset (= ()
Modules | Region [G]close mapset
: | Filter |v.in.ogr.ggis f |

* GRASS MODLULES
~ Create new GRASS location and transfer data into it
+ Create new GRASS location from vector data
/ " w.in.ogr.ggis.loc
' Import loaded vector and create a fitted location
= File management
= Import into GRASS
= Import vector into GRASS
/ U v.in.ogr.qgis
' Import loaded vector

The v stands for vector, in means a function to import data into the GRASS database, ogr is the software

library used to read vector data, and ggis means that the tool will look for a vector from among the vectors
already loaded into QGIS.

3. Once you've found this tool, click on it to bring up the tool itself. Choose the rivers layer in the Loaded Layer
box and type and name it g_rivers to prevent confusion:
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GRASS Tools: SouthAfrica/grass mapset () (]

Modules = Region ¥ [G]close mapset

Module: v.in.ogr.qqgis

Options | Output = Manual

Loaded layer

rivers v

Password

Mame for output vector map

| g_fivers

Show advanced options >=

Run Close

IIpumeuanue: s Note the extra import options provided under Advanced Options. These include
the ability to add a WHERE clause for the SQL query used for importing the data.

4. Click Run to begin the import.
5. When it’s done, click the View output button to see the newly imported GRASS layer in the map.

6. Close first the import tool (click the Close button to the immediate right of View output), then close the GRASS
Tools window.

7. Remove the original rivers layer.

Now you are left with only the imported GRASS layer as displayed in your QGIS map.
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12.1.4 \ Follow Along: Loading Raster Data into GRASS

You can import a raster layer in the same ways we imported vector layers.

We are going to import in the GRASS Mapset the layer srtm_41_19_4326.t1if.

IIpumeuanmne: the raster layer is already in the correct CRS, WGS 84. If you have layers in different CRS you
must reproject them in the same CRS of the GRASS Mapset

1. Load the srtm_41_19_4326.t1if layer in QGIS
Open the GRASS Tools dialog again.
Click on the Modules List tab.

Search for r.in.gdal.qggis and double click the tool to open the tool’s dialog.

A

Set it up so that the input layer is srtm_41_19_4326.tif and the output is g_dem.
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GRASS Tools: SouthAfrica/grass_mapset (=) (%)
Meodules  Region | T ¥ |@{:Inse mapset |

Module: r.in.gdal.qqgis

Options | Output ~ Manual

Loaded layer

|srtm_41_19_4326 - |

Password

Name for output raster map

|g_dem

'Show advanced options >>

Run | |View output| | Close |

6. Click Run.
7. When the process is done, click View output.

8. Close the current tab, and then Close the whole dialog.
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= i

"

L

- b
"

-

aye | —

9. You may now remove the original srtm_41_19_4326.tif layer.

1215 \ Try Yourself Add Layers to Mapset

Try to import in the GRASS Mapset the vector layers water.shp and places.shp from the
exercise_data/shapefile/ folder. As we did for rivers rename the imported layer as g_water and
g_places to avoid confusion

Check your results

12.1.6 \ Open an existing GRASS Mapset

If you have an existing GRASS Mapset you can easily reopen it in another session of QGIS.
You have several method to open a GRASS Mapset, let’s explore some of them.

Let’s close the Mapset by clicking on the Close Mapset button of the GRASS Tools window.

\ Follow Along: Using the GRASS plugin

1. Click on the Plugins —> GRASS —> Open Mapset menu next to the Plugins —> GRASS —> New Mapset menu
that we saw in the previous section.

2. Browse to the GRASS database folder: be careful! You must choose the parent folder, not the GRASS Mapset
one. Indeed GRASS will read all the Locat ions of the database and all the Mapsets of each Location:
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Select GRASS Mapset

Gisdbase g manual data/grass/grassdata| | Browse...

Location | SouthAfrica -

Mapset grass_mapset -

@ Cancel @QK

3. Choose the Locat ion SouthAfrica and the Mapset grass_mapset that we have created before.

That’s it! The GRASS Panel will become active meaning that the Mapset has been correctly opened.

\ Follow Along: Using the QGIS Browser

Even faster and easier is opening a Mapset using the QGIS Browser:
1. Close the Mapset (if it is open) by clicking on the Close Mapset button of the GRASS Tools window.
2. In the QGIS Browser, browse to the folder of the GRASS database.
3. Right click on the Mapset (remember, the Mapset has the ¥ GRASS icon next to it). You will see some
options.

4. Click on Open mapset:
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Browser
L&ETHO
- Favorites
~ B9 training manual
v [ forms
~ B grass

-~ B9 grassdata
v [ SouthAfrica
* & SouthaAfrica

I:IF-EIEE [aalatalnlats

» & PERMA Add as a Favorite

[l postgis Properties...

EJ processing Hide from Browser
[l projected _data

[ qgis-server-tutor
B raster GRASS Options

5 s soper T S
[l shapefiles

Mew Point Layer

Fast Scan this Directory

b . . T . . . . .

B styles _

H symbols MNew Line Layer

[ world Mew Polygon Layer

() example N
» [ Home

» B/

v &% GeoPackage
£ SpatiaLite
@ Postais
B mssqL

The Mapset is now open and ready to use!

Coget: Right click on a GRASS Mapset offers you a lot of different settings. Try to explore them and see all the
useful options.
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12.1.7 In Conclusion
The GRASS workflow for ingesting data is somewhat different from the QGIS method because GRASS loads its

data into a spatial database structure. However, by using QGIS as a frontend, you can make the setup of a GRASS
mapset easier by using existing layers in QGIS as data sources for GRASS.

12.1.8 What’s Next?

Now that the data is imported into GRASS, we can look at the advanced analysis operations that GRASS offers.

12.2 Lesson: GRASS Tools

In this lesson we will present a selection of tools to give you an idea of the capabilities of GRASS.

12.2.1 \ Follow Along: Create an aspect map

1. Open the GRASS Tools tab
2. Load the g_dem raster layer from the grass_mapset Mapset
3. Look for the r.aspect module by searching for it in the Filter field of the Modules List tab

4. Open the tool and set it up like this and click on the Run button:
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GRASS Tools: SouthAfrica/grass_mapset

Modules  Region e A

Module: r.aspect
Options | Qutput = Manual

Name of input elevation raster map

g_dem

Mame for output aspect raster map

(= (]

@Clﬂse mapset

g_aspect

Run

Close

5. When the process is finished click on View Output to load the resulting layer in the canvas:
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The g_aspect layer is stored within the grass_mapset Mapset so you can remove the layer from the canvas and
reload it whenever you want.

12.2.2 \ Follow Along: Get basic statistic of raster layer

We want to know some basic statistics of the g_ dem raster layer.
1. Open the GRASS Tools tab
2. Load the g_dem raster layer from the grass_mapset Mapset
3. Look for the r.info module by searching for it in the Filter field of the Modules List tab
4. Set up the tool like this and click on Run:
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GRASS Tools: SouthAfrica/grass_mapset

Modules Region i O

Module: r.info

Options | OQutput = Manual

Name of raster map

(& )

[G]close mapset

g_dem

Print raster history instead of info

Print extended metadata information in shell script style

Run

Close

5. Within the Output tab you will see some raster information printed, like the path of the file, the number of

rows and columns and other useful information:
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GRASS Tools: SouthAfricafgrass_mapset @ )
Modules Region i O [@]close mapset

Module: r.info

Options | Output | Manual

r.info map=g_dem@grass_mapset

| Map: g_dem@grass_mapset Date: Mon Aug 6 10:48:55 2018 |
| Mapset: grass _mapset Login of Creator: matteo |
| Location: SouthAfrica |
| DataBase: fhome/matteo/exercise datafgrass/grassdata |
| Title: g_dem |
| Timestamp: none |

Type of Map: raster Number of Categories: @
Data Type: FCELL

Rows : 619

Columns: 919

I I
I I
I I
I I
I I
| Total Cells: 568861 |
| Projection: Latitude-Longitude |
| M: 33:45:02.7900255 S: 34:16:12.8387725 Res: 0:80:03.01978 |
| E: 20:50:22.030235E W: 20:04:06.845095E Res: 0:88:03.01978 |
| Range of data: min = @ max = 1699 |
I I
| Data Description: |
| generated by r.in.gdal |
I I
I I
I I
I I
I I
I I

Comments:
r.in.gdal input="/home/matteo/lavori/miei/grant tm/0GIS-Training-Dath,

a/training manual data/raster/SRTM/srtm 41 19 4326.tif" output="g de\
m" memory=300 offset=0 num_digits=0

Successfully finished

12.2.3 / Follow Along: The Reclass Tool

Reclassifying a raster layer is a very useful task. We just created the g_aspect layer from the g_dem one. The
value range gets from O (North) passing through 90 (East), 180 (South), 270 (West) and finally to 360 (North again).
We can reclassify the g_aspect layer to have just 4 categories following specific rules (North = 1, East = 2, South
=3 and West =4).

Grass reclassify tool accepts a t xt file with the defined rules. Writing the rules is very simple and the GRASS
Manual contains very good description.

Coset: Each GRASS tool has its own Manual tab. Take the time to read the description of the tool you are using
to don’t miss some useful parameters

1. Load the g_aspect layer or, if you don’t have create it, go back to the Follow Along: Create an aspect map
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section.
2. Look for the r.reclass module by searching for it in the Filter field of the Modules List tab

3. Open the tool and set it up like the following picture. The file containing the rules is in the
exercise_data/grass/ folder, named reclass_aspect.txt.

4. Click on Run and wait until the process is finished:
GRASS Tools: SouthAfrica/grass_mapset = =

Modules  Region 4 T E.I]Elu ce mapset

Maodule: r.reclass

Options | OQutput = Manual
Name of raster map to be reclassified
g_aspect -1

File containing reclass rules

fhome/matteo/exercise_data/grass/reclass_aspect.txt

Name for output raster map

|g_reclassified

Run Close

5. Click on View Output to load the reclassified raster in the canvas
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The new layer is made up by just 4 values (1, 2, 3, and 4) and it is easier to manage and to process.

Coset: Openthe reclass_aspect.txt witha text editor to see the rules and to start becoming used to them.
Moreover, take a deep look at the GRASS manual: a lot of different examples are pointed out.

12.24 / Try Yourself Reclassify with your rules

Try to reclassify the g_dem layer into 3 new categories:
e from 0 to 1000, new value = 1
¢ from 1000 to 1400, new value =2
¢ from 1400 to the maximum raster value, new value = 3

Check your results

12.25 / Follow Along: The Mapcalic Tool

The Mapcalc tools is similar to the Raster Calculator of QGIS. You can perform mathematical operation on one or
more raster layers and the final result will be a new layer with the calculated values.

The aim of the next exercise is to extract the values greater than 1000 from the g_ dem raster layer.
1. Look for the r.mapcalc module by searching for it in the Filter field of the Modules List tab.
2. Start the tool.

The Mapcalc dialog allows you to construct a sequence of analyses to be performed on a raster, or collection
of rasters. You will use these tools to do so:
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B i 4 & Iy 0 = 4

In order, they are:

L]

L]

Add map: Add a raster file from your current GRASS mapset.
Add constant value: Add a constant value to be used in functions, 1000 in this case

Add operator or function: Add an operator or function to be connected to inputs and outputs, we will
use the operator greater equals than

Add connection: Connect elements. Using this tool, click and drag from the red dot on one item to the
red dot on another item. Dots that are correctly connected to a connector line will turn gray. If the line
or dot is red, it is not properly connected!

Select item: Select an item and move selected items.

Delete selected item: Removes the selected item from the current mapcalc sheet, but not from the mapset
(if it is an existing raster)

Open: Open an existing file with the operation defined
Save: Save all the operation in a file

Save as: Save all the operations as a new file on the disk.

3. Using these tools, construct the following algorithm:
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GRASS Tools: SouthAfrica/grass_mapset

Modules ] Region ‘ = I

[G]close mapset

Module: r.-mapcalc

Options [ Output [ Manual l

By e eil0oEa0H

Output |g_dem_1000

]

Run

] |'~Iiew |:>ut|:n..t| [ Close ]

4. Click on Run and then on View output to see the output displayed in your map:
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This shows all the areas where the terrain is higher than 1000 meters.

CoBet: You can also save the formula you have created and load it in another QGIS project by clicking on the last
button on the GRASS Mapcalc toolbar.

12.2.6 In Conclusion

In this lesson, we have covered only a few of the many tools GRASS offers. To explore the capabilities of GRASS
for yourself, open the GRASS Tools dialog and scroll down the Modules List. Or for a more structured approach,
look under the Modules Tree tab, which organizes tools by type.
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Module: Assessment

Use your own data for this section. You will need:
* a point vector dataset of points of interest, with point names and multiple categories
* aline vector dataset of roads
* a polygon vector dataset of land use (using property boundaries)
* avisual-spectrum image (such as an aerial photograph)

¢ a DEM (downloadable from the CGIAR-CSI if you don’t have your own)

13.1 Create a base map

Before doing any data analysis, you will need a base map, which will provide your analysis result with context.

13.1.1 Add the point layer

¢ Add in the point layer. Based on the level that you're doing the course at, do only what is listed in the
appropriate section below:

\

 Label the points according to a unique attribute, such as place names. Use a small font and keep the labels
inconspicuous. The information should be available, but shouldn’t be a main feature of the map.

¢ Classify the points themselves into different colors based on a category. For example, categories could include
«tourist destination», «police station», and «town center».
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/

¢ Do the same as the \ section.

¢ Classify the point size by importance: the more significant a feature, the larger its point. However, don’t
exceed the point size of 2. 00.

 For features that aren’t located at a single point (for example, provincial/regional names, or town names at a
large scale), don’t assign any point at all.

* Don’t use point symbols to symbolize the layer at all. Instead, use labels centered over the points; the point
symbols themselves should have no size.

» Use Data defined settings to style the labels into meaningful categories.

¢ Add appropriate columns to the attribute data if necessary. When doing so, don’t create fictional data - rather,
use the Field Calculator to populate the new columns, based on appropriate existing values in the dataset.

13.1.2 Add the line layer

¢ Add the road layer and then change its symbology. Don’t label the roads.

\

¢ Change the road symbology to a light color with a broad line. Make it somewhat transparent as well.

/

¢ Create a symbol with multiple symbol layers. The resulting symbol should look like a real road. You can use
a simple symbol for this; for example, a black line with a thin white solid line running down the center. It can
be more elaborate as well, but the resulting map should not look too busy.

* If your dataset has a high density of roads at the scale you want to show the map at, you should have two road
layers: the elaborate road-like symbol, and a simpler symbol at smaller scales. (Use scale-based visibility to
make them switch out at appropriate scales.)

* All symbols should have multiple symbol layers. Use symbols to make them display correctly.

¢ Do the same as in the / section above.

¢ In addition, roads should be classified. When using realistic road-like symbols, each type of road should have
an appropriate symbol; for example, a highway should appear to have two lanes in either direction.
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13.1.3 Add the polygon layer

¢ Add the land use layer and change its symbology.

\

¢ Classify the layer according to land use. Use solid colors.

/

¢ Classify the layer according to land use. Where appropriate, incorporate symbol layers, different symbol
types, etc. Keep the results looking subdued and uniform, however. Keep in mind that this will be part of a
backdrop!

 Use rule-based classification to classify the land use into general categories, such as «urban», «rural», «nature
reserve», etc.

13.1.4 Create the raster backdrop

¢ Create a hillshade from the DEM, and use it as an overlay for a classified version of the DEM itself. You
could also use the Relief plugin (as shown in the lesson on plugins).

13.1.5 Finalize the base map

* Using the resources above, create a base map using some or all of the layers. This map should include all the
basic information needed to orient the user, as well as being visually unified / «simple».

13.2 Analyze the data

* You are looking for a property that satisfies certain criteria.
* You can decide on your own criteria, which you must document.
* There are some guidelines for these criteria:
— the target property should be of (a) certain type(s) of land use
— it should be within a given distance from roads, or be crossed by a road

— it should be within a given distance from some category of points, like a hospital for example
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13.2.1 / / —

¢ Include raster analysis in your results. Consider at least one derived property of the raster, such as its aspect
or slope.

13.3 Final Map

» Use the Print Layout to create a final map, which incorporates your analysis results.

¢ Include this map in a document along with your documented criteria. If the map has become too visually busy
due to the added layer(s), deselect the layers which you feel are the least necessary.

* Your map must include a title and a legend.
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Module: Forestry Application

In modules 1 through 13, you have already learned quite a lot about QGIS and how to work with it. If you are
interested in learning about some basic forestry applications of GIS, following this module will give you the ability
to apply what you have learned and will show you some new useful tools.

European Union
European Regional Development Fund
European Social Fund

The development of this module has been sponsored by the European Union.

14.1 Lesson: Forestry Module Presentation

Following this module about a forestry application requires the knowledge you have learned through the modules 1
to 11 of this training manual. The exercises in the following lessons assume you are already capable of doing many
of the basic operations in QGIS and only tools that have not been used before are presented in more detail.

Nevertheless, the module follows a basic level throughout the lessons so that if you have previous experience with
QGIS, you can probably follow the instructions without problems.

Note that you need to download an additional data package for this module.
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14.1.1 Forestry Sample Data

IIpumeuanne: The sample data used in this module is part of the training manual data set and is available in the
exercise_data\forestry)\ folder.

The forestry related sample data (forestry map, forest data), has been provided by the EVO-HAMK forestry school.
The datasets have been modified to adapt to the lessons needs.

The general sample data (aerial images, LIDAR data, basic maps) has been obtained from the National Land Survey
of Finland open data service, and adapted for the purposes of the exercises. The open data file download service
can be accessed in English here.

IIpenynpexaenue: Asfor the rest of the training manual, this module includes instructions on adding, deleting
and altering GIS datasets. We have provided training datasets for this purpose. Before using the techniques
described here on your own data, always ensure you have proper backups!

14.2 Lesson: Georeferencing a Map

A common forestry task would be the update of the information for a forestry area. It is possible that the previous
information for that area dates several years back and was collected analogically (that is, in paper) or perhaps it was
digitized but all you have left is the paper version of that inventory data.

Most likely you would like to use that information in your GIS to, for example, compare later with later inventories.
This means that you will need to digitize the information at hand using your GIS software. But before you can start
the digitizing, there is an important first step to be done, scanning and georeferencing your paper map.

The goal for this lesson: To learn to use the Georeferencer tool in QGIS.

14.2.1 \ Scan the map

The first task you will have to do is to scan your map. If your map is too big, then you can scan it in different parts
but keep in mind that you will have to repeat preprocessing and georeferencing tasks for each part. So if possible,
scan the map in as few parts as possible.

If you are going to use a different map that the one provided with this manual, use your own scanner to scan the
map as an image file, a resolution of 300 DPI will do. If your map has colors, scan the image in color so that you
can later use those colors to separate information from your map into different layers (for ex., forest stands, contour
lines, roads...).

For this exercise you will use a previously scanned map, you can find it as raut jarvi_map.tif in the data
folder exercise_data/forestry

14.2.2 \ Follow Along: Georeferencing the scanned map

Open QGIS and set the project’s CRS to ETRS89 / ETRS-TM35FIN in Project » Properties » CRS, which is
the currently used CRS in Finland.
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/' Project Properties | CRS

% Enable 'on the fly' CRS transformation

Filter | ETRS-TM35FIN L

Recently used coordinate reference systems

|Coordinate Reference System Autharity ID
% Defauit styles ETRS8S / ETRSTM35FIM EPSG:3067

I8 ows server

.:;'..@ Macros [II | [III]
g

Coordinate reference systems of the world Hide deprecated CRSs

= Relations

|Coordinate Reference System Authority ID
El-fH Projected Coordinate Systems
Bl Linfversal Transverse Mercator (L)
*-ETRS89 J ETRS-TM35FIM EP5G:3067

(4] | ()

Selected CRS: | ETRS59 / ETRS-TM3SFIN

+proj=utm +zone=35 +ellps =GRS80 +towgs&4=0,0,0,0,0,0,0 +units=m +no_defs

Save the QGIS project asmap_digitizing.ggs.

You will use the georeferencing plugin from QGIS, the plugin is already installed in QGIS. Activate the plugin using
the plugin manager as you have done in previous modules. The plugin is named Georeferencer GDAL.

To georeference the map:
* Open the georeference tool, Raster » Georeferencer » Georeferencer.
¢ Add the map image file, raut jarvi_map.t1if, as the image to georeference, File » Open raster.

* When prompted find and select the KKJ / Finland zone 2 CRS,itis the CRS that was used in Finland
back in 1994 when this map was created.

* Click OK.
Next you should define the transformation settings for georeferencing the map:
* Open Settings » Transformation settings.

¢ Click the icon next to the Output raster box, go to the folder and create the folder exercise_data\
forestry\digitizing and name the file as raut jarvi_georef.tif.

* Set the rest of parameters as shown below.
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' Transformation settings @l
Transformation type: | Linear -
Resampling method: | Nearest neighbour -
Compression: MOME -

Create world file

Qutput raster: datafforestry/digitizing frautjarvi_georef. tif ?

Target SRS EPSG: 2392 E

Generate pdf map: r_",;;

Generate pdf report: ‘Ta
Set Target Resolution

Horizontal | 1.00000

Vertical

Use 0 for transparency when needed
X Load in QGIS when done

* Click OK.

The map contains several cross-hairs marking the coordinates in the map, we will use those to georeference
this image. You can use the zooming and panning tools as you usually do in QGIS to inspect the image in the
Georeferencer’s window.

* Zoom in to the left lower corner of the map and note that there is a cross-hair with a coordinate pair, X and Y,
that as mentioned before are in KKJ / Finland zone 2 CRS. You will use this point as the first ground control
point for the georeferencing your map.

* Select the Add point tool and click in the intersection of the cross-hairs (pan and zoom as needed).

 In the Enter map coordinates dialogue write the coordinates that appear in the map (X: 2557000 and Y:
6786000).

* Click OK.
The first coordinate for the georeferencing is now ready.

Look for other cross-hairs in the black lines image, they are separated 1000 meters from each other both in North
and East direction. You should be able to calculate the coordinates of those points in relation to the first one.

Zoom out in the image and move to the right until you find other cross-hair, and estimate how many kilometres you
have moved. Try to get ground control points as far from each other as possible. Digitize at least three more ground
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control points in the same way you did the first one. You should end up with something similar to this:

g Georeferencer - rautjarvi_map.tif = |—|:|—||—EI—|M
File Edit View Settings Help

B> L5636 @ 63 OBL - e~

GCP w=ble
on/foff id arc srcy dst dsty d¥ [pinels] df [pinels]
»® 0 473.10| -4352,93 | 2557000.00 |6786000.00 7.65 4.95
® 1 | 2838.78| -3185.77 | 2558000.00 6787000.00 5.58 -7.35
™ 5 | 2849.87| -825.55|2559000.00 |5789000.00 -5.51 6.06
™ 3 488.49| -811.03|2557000.00 -7.73 8.45
(4]

| a0

|Trar|slatiur| (2.55659 +06, 6.79222 +06) Scale (0.846165, 1.23642) Rotation: 0Mez ||  3876,-5025 |m y
~

With already three digitized ground control points you will be able to see the georeferencing error as a red line
coming out of the points. The error in pixels can be seen also in the GCP fable in the dX[pixels] and dY[pixels]
columns. The error in pixels should not be higher than 10 pixels, if it is you should review the points you have
digitized and the coordinates you have entered to find what the problem is. You can use the image above as a guide.

Once you are happy with your control points, you can save them for later use:
e File » Save GCP points as....

¢ In the folder exercise_data\forestry\digitizing, name the file raut jarvi_map.tif.
points.

Finally, georeference you map:
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e File » Start georeferencing.

* Note that you named the file already as raut jarvi_georef.tif when you edited the Georeferencer
settings.

Now you can see the map in QGIS project as a georeferenced raster. Note that the raster seems to be slightly
rotated, but that is simply because the data is KKJ / Finland zone 2 and your project is in ETRS89 /
ETRS-TM35FIN.

To check that your data is properly georeferenced you can open the aerial image in the exercise_data\
forestry folder, named raut jarvi_aerial.tif. Your map and this image should match quite well. Set
the map transparency to 50% and compare it to the aerial image.

ay

T

war
24

Save the changes to your QGIS project, you will continue from this point for the next lesson.
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14.2.3 In Conclusion

You have now georeferenced a paper map, making it possible to use it as a map layer in QGIS.

14.2.4 What’s Next?

In the next lesson, you will digitize the forest stands in your map as polygons and add the inventory data to them.

14.3 Lesson: Digitizing Forest Stands

Unless you are going to use your georeferenced map as a simple background image, the next natural step is to digitize
elements from it. You have already done so in the exercises about creating vector data in 3ansmue: Cozoanue 1osozo
Haoopa eexmopHuix dannwix, when you digitized the school fields. In this lesson, you are going to digitize the forest
stands® borders that appear in the map as green lines but instead of doing it using an aerial image, you will use your
georeferenced map.

The goal for this lesson: Learn a technique to help the digitizing task, digitizing forest stands and finally adding
the inventory data to them.

14.3.1 \ Follow Along: Extracting the Forest Stands Borders

Open your map_digitizing.qggs project in QGIS, that you saved from the previous lesson.

Once you have scanned and georeferenced your map you could start to digitize directly by looking at the image as a
guide. That would most likely be the way to go if the image you are going to digitize from is, for example, an aerial
photograph.

If what you are using to digitize is a good map, as it is in our case, it is likely that the information is clearly displayed
as lines with different colors for each type of element. Those colors can be relatively easy extracted as individual
images using an image processing software like GIMP. Such separate images can be used to assist the digitizing, as
you will see below.

The first step will be to use GIMP to obtain an image that contains only the forest stands, that is, all those greenish
lines that you could see in the original scanned map:

¢ Open GIMP (if you don’t have it installed yet, download it from the internet or ask your teacher).

¢ Open the original map image, File » Open, raut jarvi_map.tifintheexercise_data/forestry
folder. Note that the forest stands are represented as green lines (with the number of the stand also in green
inside each polygon).
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Now you can select the pixels in the image that are making up the forest stands“ borders (the greenish pixels):

¢ Open the tool Select » By color.

* With the tool active, zoom into the image (Ctrl + mouse wheel) so that a forest stand line is close enough to

differentiate the pixels forming the line. See the left image below.

¢ Click and drag the mouse cursor in the middle of the line so that the tool will collect several pixel color values.

* Release the mouse click and wait a few seconds. The pixels matching the colors collected by the tool will be
selected through the whole image.

e Zoom out to see how the greenish pixels have been selected throughout the image.

* If you are not happy with the result, repeat the click and drag operation.

* Your pixel selection should look something like the right image below.
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Once you are done with the selection you need to copy this selection as a new layer and then save it as separate
image file:

* Copy (Ctr+C) the selected pixels.

¢ And paste the pixels directly (Ctr+ V), GIMP will display the pasted pixels as a new temporary layer in the
Layers - Brushes panel as a Floating Selection (Pasted Layer).

 Right click that temporary layer and select To New Layer.

* Click the «eye» icon next to the original image layer to switch it off, so that only the Pasted Layer is visible:

 *[rautjarvi_map] (imported)-1.0 (RGB color, 2 layers) 3507x4960 o |FE][EES] || Layers - Brushes (=]
Eile Edit Select View Image Layer Colors Tools Filters Windows Help gglﬁgl&}) )
= 1109 1320g 1300 1409 i

Mode Mormal IZ‘

Joeecy o,

lock g [
E < . Pasted Layer
rautjanvi_map.tif

[T
|va I 100% :] Pasted Layer (251.5 ME)
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* Finally, select File » Export..., set Select File Type (By Extension) as a TIFF image, select the digitizing
folder and name it raut jarvi_map_green.tif. Select no compression when asked.

You could do the same process with other elements in the image, for example extracting the black lines that represent
roads or the brown ones that represent the terrain“ contour lines. But for us, the forest stands is enough.

14.3.2 \ Try Yourself Georeference the Green Pixels Image
As you did in the previous lesson, you need to georeference this new image to be able to use it with the rest of your
data.

Note that you don’t need to digitize the ground control points any more because this image is basically the same
image as the original map image, as far as the Georeferencer tool is concerned. Here are some things you should
remember:

 This image is also, of course, in KKJ / Finland zone 2 CRS.

* You should use the ground control points you saved, File » Load GCP points.

¢ Remember to review the Transformation settings.

* Name the output raster as raut jarvi_green_georef.tif inthe digitizing folder.

Check that the new raster is fitting nicely with the original map.

14.3.3 \ Follow Along: Creating Supporting Points for Digitizing

Having in mind the digitizing tools in QGIS, you might already be thinking that it would be helpful to snap to those
green pixels while digitizing. That is precisely what you are going to do next create points from those pixels to use
them later to help you follow the forest stands“ borders when digitizing, by using the snapping tools available in
QGIS.

 Use the Raster » Conversion » Polygonize (Raster to Vector) tool to vectorize your green lines to polygons.
If you don’t remember how, you can review it in Sausmue: [Ipeobpazosarue pacmposozo é ekmoproe.

e Save as raut jarvi_green_polygon. shp inside the digitizing folder.

Zoom in and see what the polygons look like. You will get something like this:
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Next one option to get points out of those polygons is to get their centroids:
¢ Open Vector » Geometry tools » Polygon centroids.
* Set the polygon layer you just got as the input file for the tool.
¢ Name the output as green_centroids. shp inside the digitizing folder.
* Check Add result to canvas.

* Run the tool to calculate the centroids for the polygons.
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Now you can remove the rautjarvi_green_polygon layer from the TOC.
Change the symbology of the centroids layer as:

* Open the Layer Properties for green_centroids.

* Go to the Symbology tab.

* Set the Unit to Map unit.

* Set the Size to 1.

It is not necessary to differentiate points from each other, you just need them to be there for the snapping tools to
use them. You can use those points now to follow the original lines much easily than without them.

14.3.4 \ Follow Along: Digitize the Forest Stands

Now you are ready to start with the actual digitizing work. You would start by creating a vector file of polygon
type, but for this exercise, there is a shapefile with part of the area of interest already digitized. You will just finish
digitizing the half of the forest stands that are left between the main roads (wide pink lines) and the lake:

376 naea 14. Module: Forestry Application



QGIS Training Manual

T
1O, 0 g

s

Perkangas

H#?meenrinnaan

¢ Go to the digitizing folder using your file manager browser.
* Drag and drop the forest_stands. shp vector file to your map.
Change the new layer’s symbology so that it will be easier to see what polygons have already been digitized:
¢ The filling of the polygon to green.
¢ The polygons® borders to 1 mm.
¢ and set the transparency to 50%.

Now, if you remember past modules, we have to set up and activate the snapping options:

14.3. Lesson: Digitizing Forest Stands 377



QGIS Training Manual

Go to Project » Snapping options....

Activate the snapping for the green_centroids and the forest_stands layers.
Set their Tolerance to 5 map units.

Check the Avoid Int. box for the forest_stands layer.

Check Enable topological editing.

Click Apply.

K Snapping options @

Layer Mode Tolerance | Units | Avoid Int. |
¥ green_centroids to vertex rig map units | |.-5.w:|iu:| intersections of new polygons
X forest_stands to vertex * 5 map units| * X%

%/ Enable topological editing Enable snapping on intersection Cancel Apply

With these snapping settings, whenever you are digitizing and get close enough to one of the points in the centroids
layer or any vertex of your digitized polygons, a pink cross will appear on the point that will be snapped to.

Finally, turn off the visibility of all the layers except forest_stands and rautjarvi_georef. Make sure
that the map image has not transparency any more.

A couple of important things to note before you start digitizing:

Don’t try to be too accurate with the digitizing of the borders.
If a border is a straight line, digitize it with just two nodes. In general, digitize using as few nodes as possible.

Zoom in to close ranges only if you feel that you need to be accurate, for example, at some corners or when
you want a polygon to connect with another polygon at a certain node.

Use the mouse’s middle button to zoom in/out and to pan as you digitize.
Digitize only one polygon at a time.

After digitizing one polygon, write the forest stand id that you can see from the map.

Now you can start digitizing:

Locate the forest stand number 357 in the map window.
Enable editing for the forest_stands. shp layer.

Select the Add feature tool.

Start digitizing the stand 357 by connecting some of the dots.

Note the pink crosses indicating the snapping.
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* When you are done, right click to end digitizing that polygon.

¢ Enter the forest stand id (in this case 357).
¢ Click OK.

If you were not prompted for the polygon id when you finished digitizing it, go to Settings » Options » Digitizing
and make sure that the Suppress attribute form pop-up after feature creation is not checked.

Your digitized polygon will look like this:
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Now for the second polygon, pick up the stand number 358. Make sure that the Avoid int. is checked for the
forest_stands layer. This option does not allow intersecting polygons at digitizing, so that if you digitize over
an existing polygon, the new polygon will be trimmed to meet the border of the already existing polygons. You can
use this characteristic to automatically obtain a common border.

* Begin digitizing the stand 358 at one of the common corners with the stand 357.
* Then continue normally until you get to the other common corner for both stands.

* Finally, digitize a few points inside polygon 357 making sure that the common border is not intersected. See
left image below.

* Right click to finish editing the forest stand 358.
* Enter the 1d as 358.

* Click OK, your new polygon should show a common border with the stand 357 as you can see in the image
on the right.

380 naea 14. Module: Forestry Application



QGIS Training Manual

The part of the polygon that was overlapping the existing polygon has been automatically trimmed out and you are
left with a common border, as you intended it to be.

14.3.5 \ Try Yourself Finish Digitizing the Forest Stands

Now you have two forest stands ready. And a good idea on how to proceed. Continue digitizing on your own until
you have digitized all the forest stands that are limited by the main road and the lake.

It might look like a lot of work, but you will soon get used to digitizing the forest stands. It should take you about
15 minutes.

During the digitizing you might need to edit or delete nodes, split or merge polygons. You learned about the necessary
tools in 3ansimue: Tononozus pyHryuii, now is probably a good moment to go read about them again.

Remember that having Enable topological editing activated, allows you to move nodes common to two polygons so
that the common border is edited at the same time for both polygons.

Your result will look like this:
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14.3.6 \ Follow Along: Joining the Forest Stand Data

It is possible that the forest inventory data you have for you map is also written in paper. In that case, you would
have to first write that data to a text file or a spreadsheet. For this exercise, the information from the inventory for
1994 (the same inventory as the map) is ready as a comma separated text (csv) file.

Open the raut jarvi_1994.csv file from the exercise_data\forestry directory in a text editor and
note that the inventory data file has an attribute called ID that has the numbers of the forest stands. Those numbers
are the same as the forest stands ids you have entered for your polygons and can be used to link the data from the text
file to your vector file. You can see the metadata for this inventory data in the file raut jarvi_1994_legend.
txt in the same folder.

* Open the . csv in QGIS with the Layer » Add Delimited Text Layer... tool. In the dialog, set it as follows:

382 naea 14. Module: Forestry Application



QGIS Training Manual

1 Createa Layer frem a Delimited Text File @
File Mame | C:fggis_forestryfexercse_data/forestryfrautjarvi_1994. cav Browse...
Layer name | rautjarvi_1934 Encoding | UTF-8 "
File format ® C5V (comma separated values) Custom delimiters Regular expression delimiter
Fecord options Murnber of header lines to discard | 0 = | % First record has field names
Field aptions Trim fields Discard empty fields Decimal separator is comma
Geometry definition Point coordinates Well known text (WKT) @ Mo geometry (attribute only table)
Layer settings [] Use =patial index IUze subset index Watch file
| o |Hab | Devi | Age | BA | vol | Mainsp | Mainperc
376 |4 o o o |o 0
3344 |v1 |15 |74 |54 |1 100
36 (4 s0 [0 |0 [0 |1 0 @

To add the data from the . csv file:
* Open the Layer Properties for the forest_stands layer.
* Go to the Joins tab.
* Click the plus sign on the bottom of the dialog box.
e Select rautjarvi_1994.csv as the Join layer and ID as the Join field.
¢ Make sure that the Target field is also set to id.
¢ Click OK two times.

The data from the text file should be now linked to your vector file. To see what has happened, open the attribute
table for the forest_stands layer. You can see that all the attributes from the inventory data file are now linked
to your digitized vector layer.

14.3.7 \ Try Yourself Renaming Attribute Names and Adding Area and
Perimeter

The data from the . csv file is just linked to your vector file. To make this link permanent, so that the data is
actually recorded to the vector file you need to save the forest_stands layer as a new vector file. Close the
attribute table and right click the forest_stands layer to save itas forest_stands_1994. shp.

Open your new forest_stands_1994.shp in your map if you did not added yet. Then open the attribute
table. You notice that the names of the columns that you just added are no very useful. To solve this:

* Add the plugin Table Manager as you have done with other plugins before.
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* Make sure the plugin is activated.
¢ In the TOC select the layer forest_stands_1994. shp.
* Then, go to Vector » Table Manager » Table manager.

 Use the dialogue box to edit the names of the columns to match the ones in the . csv file.

| Table Manager: forest_stands_1994 @
Fields Table preview
B Mame | Type | & Move Up
11D String = Move Down
; Hab Integer - | P—
; Devl String 3 Delete
: Age Integer ES) Insert
i - Real - Clone
6 | Vol Integer
? Main5p Integer
; MainPerc Integer
“ ] | | Save ‘ ‘ 4 Save as... ‘

* Click on Save.
* Select Yes to keep the layer style.
¢ Close the Table Manager dialogue.

To finish gathering the information related to these forest stands, you might calculate the area and the perimeter of
the stands. You calculated areas for polygons in 3awnsmue: JJonoanumensrioe ynpasxcrerue. Go back to that lesson
if you need to and calculate the areas for the forest stands, name the new attribute Area and make sure that the
values calculated are in hectares.

Now your forest_stands_1994. shp layer is ready and packed with all the available information.

Save your project to keep the current map presentation in case you need to come back later to it.
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14.3.8 In Conclusion

It has taken a few clicks of the mouse but you now have your old inventory data in digital format and ready for use
in QGIS.

14.3.9 What’s Next?

You could start doing different analysis with your brand new dataset, but you might be more interested in performing
analysis in a dataset more up to date. The topic of the next lesson will be the creation of forest stands using current
aerial photos and the addition of some relevant information to your dataset.

14.4 Lesson: Updating Forest Stands

Now that you have digitized the information from the old inventory maps and added the corresponding information
to the forest stands, the next step would be to create the inventory of the current state of the forest.

You will digitize new forest stands from scratch following an aerial photo from that forest area. The forestry map you
digitized in the previous lesson was created from an aerial Color Infrared (CIR) photograph. This type of imagery,
where the infrared light is recorded instead of the blue light, are widely used to study vegetated areas. You will also
use a CIR photograph in this lesson.

After digitizing the forest stands, you will add information such as new constraints given by conservation regulations.

The goal for this lesson: To digitize a new set of forest stands from CIR aerial photographs and add information
from other data-sets.

1441 \ Comparing the Old Forest Stands to Current Aerial Photographs

The National Land Survey of Finland has an open data policy that allows you downloading a variety of geographical
data like aerial imagery, traditional topographic maps, DEM, LiDAR data, etc. The service can be accessed also
in English here. The aerial image used in this exercise has been created from two orthorectified CIR images
downloaded from that service (M4134F_21062012 and M4143E_21062012).

¢ Open QGIS and set the project’s CRS to ETRS89 / ETRS-TM35FIN in Project » Properties... » CRS.

* From the exercise_data\forestry)\ folder, add the CIR image raut jarvi_aerial.tif that
is containing the digitized lakes.

¢ Then save the QGIS projectas digitizing_2012.ggs.

The CIR images are from 2012. You can compare the stands that were created in 1994 with the situation almost 20
years later.

* Add your forest_stands_1994. shp layer.
* Set its styling so that you can see through your polygons.
» Review how the old forest stands follow (or not) what you might visually interpret as an homogeneous forest.

Zoom and pan around the area. You probably will notice that some of the old forest stands might be still
corresponding with the image but others are not.

This is a normal situation, as some 20 years have passed by and different forest operations have been done
(harvesting, thinning...). It is also possible that the forest stands looked homogeneous back in 1992 to the person
who digitized them but as time has passed some forest has developed in different ways. Or simply the priorities for
the forest inventory were different that they are today.

Next, you will create new forest stands for this image without using the old ones. Later you can compare them to
see the differences.
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14.4.2 \ Interpreting the CIR Image

Let’s digitize the same area that was covered by the old inventory, limited by the roads and the lake. You don’t have
to digitize the whole area, as in the previous exercise you can start with a vector file that already contains most of
the forest stands.

e Remove the forest_stands_1994. shp layer.

¢ Addthe forest_stands_2012. shp layer, located in the exercise_data\forestry\ folder.

* Set the styling of this layer so that the polygons have no fill and the borders are visible.

You can see that a region to the North of the inventory area is still missing. That will be your task, digitizing the
missing forest stands.

386 naea 14. Module: Forestry Application



QGIS Training Manual

But before you start, spend some time reviewing the forest stands already digitized and the corresponding forest in
the image. Try to get an idea about how the stands borders are decided, it helps if you have some forestry knowledge.

Some ideas about what you could identify from the images:

What forests are deciduous species (in Finland mostly birch forests) and which ones are conifers (in this
region pine or spruce). In CIR images, deciduous species will often come as bright red color whereas conifers
present dark green colors.

When a forest stand age changes, by looking at the sizes of the tree crowns that can be identified in the
imagery.

The different forest stands* densities, for example forest stand were a thinning operation has recently been
done would clearly show spaces between the tree crowns and should be easy to differentiate from other forest
stands around it.

Blueish areas indicate barren terrain, roads and urban areas, crops that have not started to grow etc.

Don’t use zooms too close to the image when trying to identify forest stands. A scale between 1:3 000 and 1:
5 000 should be enough for this imagery. See the image below (1:4000 scale):
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14.4.3 \ Try Yourself Digitizing Forest Stands from CIR Imagery

When digitizing the forest stands, you should try to get forest areas that are as homogeneous as possible in terms
of tree species, forest age, stand density... Don’t be too detailed though, or you will end up making hundreds of
small forest stands that would not be useful at all. You should try to get stands that are meaningful in the context of
forestry, not too small (at least 0.5 ha) but not too big either (no more than 3 ha).

With this indications in mind, you can now digitize the missing forest stands.
* Enable editing for forest_stands_2012. shp.
 Set up the snapping and topology options as in the image.

e Remember to click Apply or OK.

" Snapping optiens (-8 (]
l:l Layer Mode Tolerance | Units Avoid Int. |
X forest_stands_2012 ito vertex iv g map unitz |+« 3
¥ Enable topological editing Enable snapping on intersection Cancel Apply

Start digitizing as you did in the previous lesson, with the only difference that you don’t have any point layer that you
are snapping to. For this area you should get around 14 new forest stands. While digitizing, fill in the Stand_id
field with numbers starting at 901.

When you are finished your layer should look something like:
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Now you have a new set of polygons defining the different forest stands for the current situation as can interpreted
from the CIR images. But you are obviously still missing the forest inventory data, right? For that you will still need
to visit the forest and get some sample data that you will use to estimate the forest attributes for each of the forest
stands. You will see how to do that in the next lesson.

For the moment, you still can improve your vector layer with some extra information that you have about
conservation regulation that should be taken into account for this area.

14.4.4 \ Follow Along: Updating Forest Stands with Conservation
Information

For the area you are working with, it has been researched that the following conservation regulations must be taken
into account while doing the forest planning:

* Two locations of a protected species of Siberian flying squirrel (Pteromys volans) have been identified.
According to the regulation, an area of 15 meters around the spots must be left untouched.

* A riparian forest of special interest growing along a stream in the area must be protected. In a visit to the
field, it was found that 20 meters to both sides of the stream must be protected.

You have one vector file containing the information about the squirrel locations and another containing the digitized
stream running in the North area towards the lake. From the exercise_data\forestry\ folder, add the
vector files squirrel.shp and stream. shp.
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For the protection of the squirrels locations, you are going to add a new attribute (column) to your new forest stands
that will contain information about point locations that have to be protected. That information will later be available
whenever a forest operation is planned, and the field team will be able to mark the area that has to be left untouched
before the work starts.

Open the attribute table for the squirrel layer.

You can see that there are two locations that are defined as Siberian flying squirrel, and that the area to be
protected is indicated by a distance of 15 meters from the locations.

To join the information about the squirrels to your forest stands, you can use the Join attributes by location:

Open Vector » Data Management Tools w Join attributes by location.
Set the forest_stands_2012. shp layer as the Target vector layer.
As Join vector layer select the squirrel. shp point layer.

Name the output file as stands_squirrel. shp.

In Output table select Keep all records (including non-matching target records). So that you keep all the forest
stands in the layer instead of only keeping those that are spatially related to the squirrel locations.

Click OK.
Select Yes when prompted to add the layer to the TOC.

Close the dialogue box.
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1 Join attributes by location @

Target vector layer

forest_stands_2012 -

Join vector layer

forest_stands_2012 -
Attribute Surmnmary

® Take attributes of first located feature
Take summary of intersecting features

M Mean [ Min [ IMax []sum [ ] Median

Output Shapefile
Browse
QOutput table

Only keep matching records
® Keep all records (induding non-matching target records)

[ 0% || ok Close

Now you have a new forest stands layer, stands_squirrel where there are new attributes corresponding to the
protection information related to the Siberian flying squirrel.

Open the table of the new layer and order it so that the forest stands with information for the Protection attribute
are on top. You should have now two forest stands where the squirrel has been located:
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' Attribute table - stands_squirrel :: Features total: 96, filtered: 96, 5 <= |..| = || @ [[=23]
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Although this information might be enough, look at what areas related to the squirrels should be protected. You
know that you have to leave a buffer of 15 meters around the squirrels location:

* Open Vector » Geoprocessing Tools » Buffer.
* Make a buffer of 15 meters for the squirrel layer.

¢ Name the result squirrel_15m. shp.

& Buffer(s)

Input vector layer

squirrel -

Use only selected features

segments to approximate | 5 :
@ Buffer distance 15
Buffer distance field
id_pr -

Dissolve buffer results

Qutput shapefile

orestry/digitizing /squirrel_15m.shp Browse |

¥ Add result to canvas

Il o oK Close
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You will notice that if you zoom in to the location in the Northern part of the area, the buffer area extends to the
neighbouring stand as well. This means that whenever a forest operation would take place in that stand, the protected
location should also be taken into account.

From your previous analysis, you did not get that stand to register information about the protection status. To solve
this problem:

* Run the Join attributes by location tool again.
* But this time use the squirrel_15m layer as join layer.

* Name the output file as stands_squirrel_15m. shp.

14.4. Lesson: Updating Forest Stands 393



QGIS Training Manual
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Open the attribute table for the this new layer and note that now you have three forest stands that have the information
about the protection locations. The information in the forest stands data will indicate to the forest manager that there
are protection considerations to be taken into account. Then he or she can get the location from the squirrel
dataset, and visit the area to mark the corresponding buffer around the location so that the operators in the field can
avoid disturbing the squirrels environment.

1445 \ Try Yourself Updating Forest Stands with Distance to the Stream

Following the same approach as indicated for the protected squirrel locations you can now update your forest stands
with protection information related to the stream identified in the field:

¢ Remember that the buffer in this case is 20 meters around it.

* You want to have all the protection information in the same vector file, so use the stands_squirrel_15m
layer as the target.

* Name your output as forest_stands_2012_protect.shp.

Open the attributes table for the new vector layer and confirm that you now have all the protection information for
the stands that are affected by the protection measures to protect the riparian forest associated with the stream.
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Save your QGIS project.

14.4.6 In Conclusion

You have seen how to interpret CIR images to digitize forest stands. Of course it would take some practice to make
more accurate stands and usually using other information like soil maps would give better results, but you know
now the basis for this type of task. And adding information from other datasets resulted to be quite a trivial task.

14.4.7 What’s Next?

The forest stands you digitized will be used for planning forestry operations in the future, but you still need to get
more information about the forest. In the next lesson, you will see how to plan a set of sampling plots to inventory
the forest area you just digitized, and get the overall estimate of forest parameters.

14.5 Lesson: Systematic Sampling Design

You have already digitized a set of polygons that represent the forest stands, but you don’t have information about
the forest just yet. For that purpose you can design a survey to inventory the whole forest area and then estimate its
parameters. In this lesson you will create a systematic set of sampling plots.

When you start planning your forest inventory it is important to clearly define the objectives, the types of sample
plots that will be used, and the data that will be collected to achieve the objectives. For each individual case, those
will depend on the type of forest and the management purpose; and should be carefully planned by someone with
forestry knowledge. In this lesson, you will implement a theoretical inventory based on a systematic sampling plot
design.

The goal for this lesson: To create a systematic sampling plot design to survey the forest area.

14.5.1 Inventorying the Forest

There are several methods to inventory forests, each of them suiting different purposes and conditions. For example,
one very accurate way to inventory a forest (if you consider only tree species) would be to visit the forest and make
a list of every tree and their characteristics. As you can imagine this is not commonly applicable except for some
small areas or some special situations.

The most common way to find out about a forest is by sampling it, that is, taking measurements in different locations
at the forest and generalizing that information to the whole forest. These measurements are often made in sample
plots that are smaller forest areas that can be easily measured. The sample plots can be of any size (for ex. 50 m2, 0.5
ha) and form (for ex. circular, rectangular, variable size), and can be located in the forest in different ways (for ex.
randomly, systematically, along lines). The size, form and location of the sample plots are usually decided following
statistical, economical and practical considerations. If you have no forestry knowledge, you might be interested in
reading this Wikipedia article.

14.5.2 \ Follow Along: Implementing a Systematic Sampling Plot Design

For the forest you are working with, the manager has decided that a systematic sampling design is the most
appropriate for this forest and has decided that a fixed distance of 80 meters between the sample plots and sampling
lines will yield reliable results (for this case, +- 5% average error at a probability of 68%). Variable size plots has
been decided to be the most effective method for this inventory, for growing and mature stands, but a 4 meters
fixed radius plots will be used for seedling stands.

In practice, you simply need to represented the sample plots as points that will be used by the field teams later:

e Openyour digitizing_2012.ggs project from the previous lesson.
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¢ Remove all the layers except for forest_stands_2012.
* Save your project now as forest_inventory.qgs
Now you need to create a rectangular grid of points separated 80 meters from each other:
* Open Vector » Research Tools » Regular points.
¢ In the Area definitions select Input Boundary Layer.
* And as input layer set the forest_stands_2012 layer.
* In the Grid Spacing settings, select Use this point spacing and set it to 80.
¢ Save the output as systematic_plots.shpinthe forestry\sampling\ folder.
* Check Add result to canvas.

* Click OK.

IIpumeuanne: The suggested Regular points creates the systematic points starting in the corner upper-left corner
of the extent of the selected polygon layer. If you want to add some randomness to this regular points, you could
use a randomly calculated number between 0 and 80 (80 is the distance between our points), and then write it as the
Initial inset from corner (LH side) parameter in the tool’s dialog.

You notice that the tool has used the whole extent of your stands layer to generate a rectangular grid of points. But
you are only interested on those points that are actually inside your forest area (see the images below):

¢ Open Vector » Geoprocessing Tools » Clip.

e Select systematic_plots as Input vector layer.
* Set forest_stands_2012 as the Clip layer.

* Save the result as systematic_plots_clip.shp.
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e Check Add result to canvas.
¢ Click OK.

You have now the points that the field teams will use to navigate to the designed sample plots locations. You can
still prepare these points so that they are more useful for the field work. At the least you will have to add meaningful
names for the points and export them to a format that can be used in their GPS devices.

Lets start with the naming of the sample plots. If you check the Afribute table for the plots inside the forest area,
you can see that you have the default id field automatically generated by the Regular points tool. Label the points to
see them in the map and consider if you could use those numbers as part of your sample plot naming:

* Open the Layer Properties —> Labels for your systematic_plots_clip.
e Check Label this layer with and select the field ID.

* Go to the Buffer options and check the Draw text buffer, set the Size to 1.

¢ Click OK.

Now look at the labels on your map. You can see that the points have been created and numbered first West to
East and then North to South. If you look at the attribute table again, you will notice that the order in the table is
following also that pattern. Unless you would have a reason to name the sample plots in a different way, naming
them in a West-East/North-South fashion follows a logical order and is a good option.

IIpumeuanne: If you would like to order or name them in a different way, you could use a spreadsheet to be able
to order and combine rows and columns in any different way.

Nevertheless, the number values in the 1d field are not so good. It would be better if the naming would be something
likep_1, p_2....Youcan create a new column for the systematic_plots_clip layer:

¢ Go to the Attribute table for systematic_plots_clip.

* Enable the edit mode.

¢ Open the Field calculator and name the new column P1lot_id.
 Set the Output field type'to :kbd: Text (string).

¢ In the Expression field, write, copy or construct this formula concat ('P_"', S$rownum ). Remember
that you can also double click on the elements inside the Function list. The concat function can be found
under String and the $rownum parameter can be found under Record.

* Click OK.
* Disable the edit mode and save your changes.

Now you have a new column with plot names that are meaningful to you. For the systematic_plots_clip
layer, change the field used for labeling to your new P1ot_id field.
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14.5.3 \ Follow Along: Exporting Sample Plots as GPX format

The field teams will be probably using a GPS device to locate the sample plots you planned. The next step is to export
the points you created to a format that your GPS can read. QGIS allows you to save your point and line vector data
in GPS eXchange Format (GPX)<https://en.wikipedia.org/wiki/GPS_Exchange_Format>, which is an standard GPS
data format that can be read by most of the specialized software. You need to be careful with selecting the CRS

when you save your data:
¢ Rightclick systematic_plots_clip and select Save as.
* In Format select GPS eXchange Format [GPX].
» Save the output as plots_wgs84.gpx.
* In CRS select Selected CRS.

¢ Browse for WGS 84 (EPSG:4326).

IIpumeuanue: The GPX format accepts only this CRS, if you select a different one, QGIS will give no error but

you will get an empty file.

* Click OK.

* In the dialog that opens, select only the waypoints layer (the rest of the layers are empty).

[l

¥ Save vector layer as...

2]

Format PS5 eXchange Format [GPX] -

Save as

_datafforestry/sampling/plots_wgs84.gpx Browse

Encoding System -

CRS Selected CRS b
WG5S 84 Browse

Symbology export Mo symbology -

Scale 1:50000 =

Skip attribute creation
® Add saved file to map

More Options ==

Help
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The inventory sample plots are now in a standard format that can be managed by most of the GPS software. The
field teams can now upload the locations of the sample plots to their devices. That would be done by using the
specific devices own software and the plots_wgs84 . gpx file you just saved. Other option would be to use the
GPS Tools plugin but it would most likely involve setting the tool to work with your specific GPS device. If you are
working with your own data and want to see how the tool works you can find out information about it in the section
working_gps in the QGIS User Manual.

Save your QGIS project now.

14.5.4 In Conclusion

You just saw how easily you can create a systematic sampling design to be used in a forest inventory. Creating other
types of sampling designs will involve the use of different tools within QGIS, spreadsheets or scripting to calculate
the coordinates of the sample plots, but the general idea remains the same.

14.5.5 What’s Next?

In the next lesson you will see how to use the Atlas capabilities in QGIS to automatically generate detailed maps
that the field teams will be using to navigate to the sample plots assigned to them.

14.6 Lesson: Creating Detailed Maps with the Atlas Tool

The systematic sampling design is ready and the field teams have loaded the GPS coordinates in their navigation
devices. They also have a field data form where they will collect the information measured at every sample plot.
To easier find their way to every sample plot, they have requested a number of detail maps where some ground
information can be clearly seen along with a smaller subset of sample plots and some information about the map
area. You can use the Atlas tool to automatically generate a number of maps with a common format.

The goal for this lesson: Learn to use the Atlas tool in QGIS to generate detailed printable maps to assist in the
field inventory work.

14.6.1 \ Follow Along: Preparing the Print Layout

Before we can automate the detailed maps of the forest area and our sampling plots, we need to create a map template
with all the elements we consider useful for the field work. Of course the most important will be a properly styled
but, as you have seen before, you will also need to add lots of other elements that complete the printed map.

Open the QGIS project from the previous lesson forest_inventory.qggs. You should have at least the
following layers:

e forest_stands_2012 (with a 50% transparency, green fill and darker green border lines).
* systematic_plots_clip.
* rautjarvi_aerial.
Save the project with a new name, map_creation.qgs.
To create a printable map, remember that you use the Layout Manager:
¢ Open Project » Layout Manager....
* In the Layout manager dialog.
¢ Click the Add button and name your print layout forest_map.
* Click OK.
* Click the Show button.
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Set up the printer options so that your maps will suit your paper and margins, for an A4 paper:
¢ Open menuselection:Layout —> Page Setup....
e Sizeis A4 (217 x 297 mm).
e Orientation is Landscape.
* Margins (millimeters) are all set to 5.

In the Print Layout window, go to the Composition tab (on the right panel) and make sure that these settings for
Paper and quality are the same you defined for the printer:

e Size: A4 (210x297mm) .
* Orientation: Landscape.
* Quality: 300dp1.

Composing a map is easier if you make use of the canvas grid to position the different elements. Review the settings
for the layout grid:

¢ In the Composition tab expand the Grid region.
* Check that Spacing is set to 10 mm.
¢ And that Tolerance is set to 2 mm.
You need to activate the use of the grid:
e Open the View menu.
* Check Show grid.
¢ Check Snap to grid.

* Notice that options for using guides are checked by default, which allows you to see red guiding lines when
you are moving elements in the layout.

Now you can start to add elements to your layout. Add first a map element so you can review how the map canvas
looks as you will be making changes in the layers symbology:

* Click on the 1 g2 AddMap py¢¢0n,

¢ Click and drag a box on the canvas so that the map occupies most of it.
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Notice how the mouse cursor snaps to the canvas grid. Use this function when you add other elements. If you want
to have more accuracy, change the grid Spacing setting. If for some reason you don’t want to snap to the grid at some
point, you can always check or uncheck it in the View menu.

14.6.2 \ Follow Along: Adding Background Map

Leave the layout open but go back to the map. Lets add some background data and create some styling so that the
map content is as clear as possible.

¢ Add the background raster basic_map.tif that you can find in the exercise_data\forestry\
folder.

* When prompted select the ETRS89 / ETRS-TM35FIN CRS for the raster.

As you can see the background map is already styled. This type of ready to use cartography raster is very common.
It is created from vector data, styled in a standard format and stored as a raster so that you don’t have to bother
styling several vector layers and worrying about getting a good result.

¢ Now zoom to your sample plots, so that you can see only about four or five lines of plots.

The current styling of the sample plots is not the best, but how does it look in the print layout?:
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While during the last exercises, the white buffer was OK on top of the aerial image, now that the background image
is mostly white you barely can see the labels. You can also check how it looks like on the layout:

¢ Go to the Print Layout window.

_—
» Use the h button to select the map element in the layout.

¢ Go to the Item properties tab.

* Under Extents click on Set to map canvas extent.

* If you need to refresh the element, under Main properties click on the Update preview.

Obviously this is not good enough, you want to make the plot numbers as clearly visible as possible for the field
teams.

14.6.3 \ Try Yourself Changing the Symbology of the Layers

You have been working in Moodyav: Cozdanue u usyuenue 6azoeoii kapmer with symbology and in Mooyaw: Kaac-
cugpurxayust sexmopnvix oannwix With labeling. Go back to those modules if you need to refresh about some of the
available options and tools. Your goal is to get the plots locations and their name to be as clearly visible as possible
but always allowing to see the background map elements. You can take some guidance from this image:

\ [ —
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You will use later the the green styling of the forest_stands_2012 layer. In order to keep it, and have a
visualization of it that shows only the stand borders:

* Rightclick on forest_stands_2012 and select Duplicate

¢ you get a new layer named forest_stands_2012 copy that you can use to define a different style, for
example with no filling and red borders.

Now you have two different visualizations of the forest stands and you can decide which one to display for your
detail map.

Go back to the Print Layout window often to see what the map would look like. For the purposes of creating detailed
maps, you are looking for a symbology that looks good not at the scale of the whole forest area (left image below)
but at a closer scale (right image below). Remember to use Update preview and Set to map canvas extent whenever
you change the zoom in your map or the layout.
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14.6.4 \ Try Yourself Create a Basic Map Template

Once you have a symbology your happy with, you are ready to add some more information to your printed map.
Add at least the following elements:

* Title.

* A scale bar.

* Grid frame for your map.

¢ Coordinates on the sides of the grid.

You have created a similar composition already in Moodyaw: Cocmasnerue 6azosoii kapmei. Go back to that module
as you need. You can look at this example image for reference:
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Export your map as an image and look at it.
e Layout » Export as Image....
¢ Use for example the JPG format.

That is what it will look like when printed.

14.6.5 \

Follow Along: Adding More Elements to the Print Layout

As you probably noticed in the suggested map template images, there are plenty of room on the right side of the
canvas. Lets see what else could go in there. For the purposes of our map, a legend is not really necessary, but an
overview map and some text boxes could add value to the map.

The overview map will help the field teams place the detail map inside the general forest area:

¢ Add another map element to the canvas, right under the title text.

¢ In the Item properties tab, open the Overview dropdown.

* Set the Overview frame to Map 0. This creates a shadowed rectangle over the smaller map representing the

extent visible in the bigger map.

¢ Check also the Frame option with a black color and a Thickness of 0. 30.
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Notice that your overview map is not really giving an overview of the forest area which is what you want. You
want this map to represent the whole forest area and you want it to show only the background map and the
forest_stands_2012 layer, and not display the sample plots. And also you want to lock its view so it does not
change anymore whenever you change the visibility or order of the layers.

* Go back to the map, but don’t close the Print Layout.

* Right click the forest_stands_2012 layer and click on Zoom to Layer Extent.
¢ Deactivate all layers except for basic_map and forest_stands_2012.

¢ Go back to the Print Layout.

¢ With the small map selected, click the Set to map canvas extent to set its extents to what you can see in the
map window.

¢ Lock the view for the overview map by checking Lock layers for map item under Main properties.

Now your overview map is more what you expected and its view will not change anymore. But, of course, now your
detail map is not showing anymore the stand borders nor the sample plots. Lets fix that:

* Go to the map window again and select the layers you want to be visible (systematic_plots_clip,
forest_stands_2012 copy and Basic_map).

e Zoom again to have only a few lines of sample plots visible.

* Go back to the Print Layout window.

¢ Select the bigger map in your layout (:%).
* In Item properties click on Update preview and Set to map canvas extent.

Notice that only the bigger map is displaying the current map view, and the small overview map is keeping the same
view you had when you locked it.

Note also that the overview is showing a shaded frame for the extent shown in the detail map.
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Your template map is almost ready. Add now two text boxes below the map, one containing the text ,,Detailed map
zone: ,, and the other one ,,Remarks: ,,. Place them as you can see in the image above.

You can also add a North arrow to the overview map:

¢ Use the Add image tool, :-D

* Click at the upper right corner of the overview map.

* In Item properties open Search directories and browse for an arrow image.

» Under Image rotation, check the Sync with map and select Map 1 (the overview map).
e Uncheck Background.

* Resize the arrow image to a size that looks good on the small map.

The basic map layout is ready, now you want to make use of the Atlas tool to generate as many detail maps in this
format as you consider necessary.

14.6.6 \ Follow Along: Creating an Atlas Coverage

The Atlas coverage is just a vector layer that will be used to generate the detail maps, one map for every feature in
the coverage. To get an idea of what you will do next, here is a full set of detail maps for the forest area:
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The coverage could be any existing layer, but usually it makes more sense to create one for the specific purpose.
Let’s create a grid of polygons covering the forest area:

¢ In the QGIS map view, open Vector » Research Tools » Vector grid.

* Set the tool as shown in this image:
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Grid extent
forest_stands_2012

Align extents and resolution to selected raster layer

& Vector grid @

Update extents from layer

| Update extents from canvas

X Min | 397024, 141 Y Min | 6735465.69525
X Max 398082.827472 ¥ Max 6787173.746
Parameters

¥ | a00.0000000000
Lock 1:1 ratio

Ak Ak

Y| 300,0000000000
® Cutput grid as polygons

QOutput grid as lines

Output shapefile
cize_dataforestry fsampling/atlas_coverage.shp

X Add result to canvas

[ 0% | oK Close

 Save the output as at las_coverage. shp.

* Style the new at las_coverage layer so that the polygons have no filling.

The new polygons are covering the whole forest area and they give you an idea of what each map (created from

each polygon) will contain.

14.6. Lesson: Creating Detailed Maps with the Atlas Tool
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14.6.7 \ Follow Along: Setting Up the Atlas Tool

The last step is to set up the Atlas tool:

¢ Go back to the Print Layout.

¢ In the panel on the right, go to the Atlas generation tab.

* Set the options as follows:

410
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Composition Item properties Atlas generation

Atlas generation
X Generate an atlas
w Configuration
Coverage layer atlas_coverage -

X Hidden coverage layer
Filter with

w Output

Qutput filename expression
|fieldmap| '||¢feature

Single file export when possible

Sortby |ID B3 D

That tells the Atlas tool to use the features (polygons) inside at las_coverage as the focus for every detail map.
It will output one map for every feature in the layer. The Hidden coverage layer tells the Atlas to not show the
polygons in the output maps.

One more thing needs to be done. You need to tell the Atlas tool what map element is going to be updated for
every output map. By now, you probably can guess that the map to be changed for every feature is the one you have
prepared to contain detail views of the sample plots, that is the bigger map element in your canvas:

* Select the bigger map element.
* Go to the Item properties tab.
* In the list, check Controlled by atlas.

e And set the Marging around feature to 10%. The view extent will be 10% bigger than the polygons, which
means that your detail maps will have a 10% overlap.
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Compasition Item properties
[tem propertes
Map

Atlas generation

X

P Main properties

P Extents
w X Controlled by atlas
® Margin around feature

Fixed scale

10%

1k

B ¥ Show grid

B Overview

P Position and size

P Rotation

3 Frame

:

Now you can use the preview tool for Atlas maps to review what your maps will look like:

* Activate the Atlas previews using the button or if your Atlas toolbar is not visible, via Aflas » Preview

* You can use the arrows in the Atlas tool bar or in the Atlas menu to move through maps that will be created.

Note that some of them cover areas that are not interesting. Lets do something about it and save some trees by not
printing those useless maps.

14.6.8 \

Follow Along: Editing the Coverage Layer

Besides removing the polygons for those areas that are not interesting, you can also customize the text labels in your
map to be generated with content from the A#tribute table of your coverage layer:

* Go back to the map view.

Enable editing for the at 1as_coverage layer.

Remove the selected polygons.

Disable editing and save the edits.

Select the polygons that are selected (in yellow) in the image below.
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You can go back to the Print Layout and check that the previews of the Atlas use only the polygons you left in the
layer.

The coverage layer you are using does not yet have useful information that you could use to customize the content
of the labels in your map. The first step is to create them, you can add for example a zone code for the polygon
areas and a field with some remarks for the field teams to have into account:

* Open the Attribute table for the at las_coverage layer.

* Enable editing.

e Use the calculator to create and populate the following two fields.

* Create a field named Zone and type Whole number (integer).

* In the Expression box write/copy/construct $rownum.

¢ Create another field named Remarks, of type Text (string) and a width of 255.

¢ In the Expression box write 'No remarks. '. This will set all the default value for all the polygons.

The forest manager will have some information about the area that might be useful when visiting the area. For
example, the existence of a bridge, a swamp or the location of a protected species. The at las_coverage layer
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is probably in edit mode still, add the following text in the Remarks field to the corresponding polygons (double
click the cell to edit it):

Forthe Zone 2: Bridge to the North of plot 19. Siberian squirrel between p_13
and p_14..

For the Zone 6: Difficult to transit in swamp to the North of the lake..
For the Zone 7: Siberian squirrel to the South East of p_94..

Disable editing and save your edits.

Almost ready, now you have to tell the Atlas tool that you want some of the text labels to use the information from
the at las_coverage layer’s attribute table.

Go back to the Print Layout.

Select the text label containing Detailed map. . ..

Set the Font size to 12.

Set the cursor at the end of the text in the label.

In the Item properties tab, inside the Main properties click on Insert or Edit an Expression....
In the Function list double click on the field Zone under Field and Values.

Click OK.

The text inside the box in the Ifem properties should show Detail map inventory zone: [%$ "Zone"
%]1.Note that the [%$ "Zone" %] will be substituted by the value of the field Zone for the corresponding
feature from the layer at las_coverage.

Test the contents of the label by looking at the different Atlas preview maps.

Do the same for the labels with the text Remarks: using the field with the zone information. You can leave a
break line before you enter the expression. You can see the result for the preview of zone 2 in the image below:

E'JQ?'I!'J 397100 397200 397300 327400 397500 397600 g
E ) -+ E Rautjarvi Forest Area
\ — Inventory 2012
—i;%l [

I / /
B\)72.0 :
2 -,,-’ ( — |

/ -/ ]

g } g
g — g

bt T ap h \

L —
:a: E D i i i :a:
— = |De’GiI map inventory zone: 2 |

— A\

[ r Memarks: m| I—|
— P p P EJ%B prab s g |Bridge to the North of plot 19.
B 4: + = Siberian squirrel between p_13
[ | L I g —|E and p_14.

: ) i T i n#3h @ i : | d
: { &

2l ™M | 2, 3
D p P P m P %{B -
- —L 1 [ VJ
397000 397100 397200 397300 WT400 387500 aTE00
0 100 200 m

414

naea 14. Module: Forestry Application



QGIS Training Manual

Use the Atlas preview to browse through all the maps you will be creating soon and enjoy!

14.6.9 \ Follow Along: Printing the Maps

Last but not least, printing or exporting your maps to image files or PDF files. You can use the Atlas » Export Atlas
as Images... or Atlas » Export Atlas as PDF.... Currently the SVG export format is not working properly and will
give a poor result.

Lets print the maps as a single PDF that you can send to the field office for printing:
* Go to the Atlas generation tab on the right panel.

e Under the Output check the Single file export when possible. This will put all the maps together into a PDF
file, if this option is not checked you will get one file for every map.

e Open Layout » Export as PDF....

e Save the PDF file as inventory_2012_maps.pdf in your exercise_datal\forestry\
samplig\map_creation)\ folder.

Open the PDF file to check that everything went as expected.

You could just as easily create separate images for every map (remember to uncheck the single file creation), here
you can see the thumbnails of the images that would be created:
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In the Print Layout, save your map as a layout template as forestry_atlas.gpt inyour exercise_data\
forestry\map_creation) folder. Use Layout » Save as Template. You will be able to use this template again
and again.

Close the Print Layout and save your QGIS project.

14.6.10 In Conclusion

You have managed to create a template map that can be used to automatically generate detail maps to be used in
the field to help navigate to the different plots. As you noticed, this was not an easy task but the benefit will come
when you need to create similar maps for other regions and you can use the template you just saved.
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14.6.11 What’s Next?

In the next lesson, you will see how you can use LiDAR data to create a DEM and then use it to your enhance your
data and maps visibility.

14.7 Lesson: Calculating the Forest Parameters

Estimating the parameters of the forest is the goal of the forest inventory. Continuing the example from previous
lesson, you will use the inventory information gathered in the field to calculate the forest parameters, for the whole
forest first, and then for the stands you digitized before.

The goal for this lesson: Calculate forest parameters at general and stand level.

14.71 \ Follow Along: Adding the Inventory Results

The field teams visited the forest and with the help of the information you provided, gathered information about
the forest at every sample plot.

Most often the information will be collected into paper forms in the field, then typed to a spreadsheet. The sample
plots information has been condensed into a . csv file that can be easily open in QGIS.

Continue with the QGIS project from the lesson about designing the inventory, you probably named it
forest_inventory.qgs.

First, add the sample plots measurements to your QGIS project:
1. Go to Layer » Add Delimited Text Layer....

2. Browse to the file systematic_inventory_results.csv located in exercise_data/
forestry/results/.

Make sure that the Point coordinates option is checked.

Set the fields for the coordinates to the X and Y fields.

Click OK.

When prompted, select ETRS89 / ETRS-TM35FIN as the CRS.

A

7. Open the new layer’s Attribute table and have a look at the data.

You can read the type of data that is contained in the sample plots measurements in the text file
legend_2012_inventorydata.txt located in the exercise_data/forestry/results/ folder.

The systematic_inventory_results layer you just added is actually just a virtual representation of the
text information in the . csv file. Before you continue, convert the inventory results to a real spatial dataset:

1. Right click on the systematic_inventory_results layer.
Browse to exercise_data/forestry/results/ folder.
Name the file sample_plots_results.shp.

Check Add saved file to map.

A

Remove the systematic_inventory_results layer from your project.
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14.7.2 \ Follow Along: Whole Forest Parameters Estimation

You can calculate the averages for this whole forest area from the inventory results for the some interesting
parameters, like the volume and the number of stems per hectare. Since the systematic sample plots represent

equal areas, you can directly calculate the averages of the volumes and number of stems per hectare from the
sample_plots_results layer.

You can calculate the average of a field in a vector layer using the Basic statistics tool:
1. Open Vector » Analysis Tools w Basic statistics for Fields.

2. Select sample_plots_results as the Input Vector Layer.
3. Select Vol as Target field.
4. Click OK.

The average volume in the forestis 135.2 m3/ha.

You can calculate the average for the number of stems in the same way, 2745 stems/ha.

! Basics statistics @] ! Basics statistics @]
Input Vector Layer Input Vector Layer
sample_plots_results v sample_plots_results v
Use only selected features Use only selected features
Target field Target field
Vol v iStems iv
Statistics output Statistics output
Parameter Value !:l | Parameter Value !:l
Mean 135.153153153 Mean 2744.65765766
StdDev 69.966941769 StdDev 2775.63980935
Sum 15002.0 Sum 304657.0
Min 15.0 m Min 167.0 m
-~ -~
Max 333.0 E] Max 11400.0 E]
Press Ctrl+C to copy results to the clipboard Press Ctrl+C to copy results to the clipboard
0 0% ] [ o Close 0 0% ] [ o Close
4 4

14.7.3 \ Follow Along: Estimating Stand Parameters

You can make use of those same systematic sample plots to calculate estimates for the different forest stands you
digitized previously. Some of the forest stands did not get any sample plot and for those you will not get information.
You could have planned some extra sample plots when you planned the systematic inventory, so that the field teams
would have measured a few extra sample plots for this purpose. Or you could send a field team later to get estimates

of the missing forest stands to complete the stand inventory. Nevertheless, you will get information for a good
number of stands just using the planned plots.

What you need is to get the averages of the sample plots that are falling within each of the forest stands. When you
want to combine information based on their relative locations, you perform a spatial join:

1. Open the Vector » Data Management » Join attributes by location tool.
2. Set forest_stands_2012 as the Target vector layer. The layer you want the results for.

3. Set sample_plots_results as the Join vector layer. The layer you want to calculate estimates from.

4. Check Take summary of intersecting features.
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5. Check to calculate only the Mean.

6. Name the result as forest_stands_2012_results.shp and save it in the exercise_data/
forestry/results/ folder.

7. Finally select Keep all records..., so you can check later what stands did not get information.
8. Click OK.
9. Accept adding the new layer to your project when prompted.

10. Close the Join attributes by location tool.

Open the Attribute table for forest_stands_2012_results and review the results you got. Note that a number of forest
stands have NULL as the value for the calculations, those are the ones having no sample plots. Select them all and
view them in the map, they are some of the smaller stands:
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Lets calculate now the same averages for the whole forest as you did before, only this time you will use the averages
you got for the stands as the bases for the calculation. Remember that in the previous situation, each sample plot
represented a theoretical stand of 80x80 m. Now you have to consider the area of each of the stands individually
instead. That way, again, the average values of the parameters that are in, for example, m3/ha for the volumes are
converted to total volumes for the stands.

You need to first calculate the areas for the stands and then calculate total volumes and stem numbers for each of
them:

1. In the Attribute table enable editing.

2. Open the Field calculator.
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A

7.

Create a new field called area.

Set the Output field type to Decimal number (real).

Set the Precision to 2.

In the Expression box, write $Sarea / 10000. This will calculate the area of the forest stands in ha.

Click OK.

Now calculate a field with the total volumes and number of stems estimated for every stand:

1.
2.
3.

4.
5.

Name the fields s_vol and s_stem.
The fields can be integer numbers or you can use real numbers also.

Use the expressions "area" * "MEANVol" and "area" * "MEANStems" for total volumes and total
stems respectively.

Save the edits when you are finished.

Disable editing.

In the previous situation, the areas represented by every sample plot were the same, so it was enough to calculate
the average of the sample plots. Now to calculate the estimates, you need to divide the sum of the stands volumes
or number of stems by the sum of the areas of the stands containing information.

1. In the A#tribute table for the forest_stands_2012_results layer, select all the stands containing
information.
2. Open Vector » Analysis Tools » Basic statistics for fields.
3. Select the forest_stands_2012_results as the Input layer.
4. Select area as Field to calculate statistics on.
5. Check the Selected features only
6. Click OK.
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1 Basics statistics R
Input Vector Layer
forest_stands_2012_results -

X Use only selected features
Target field

dlred o

Statistics output

Parameter Value
Mean 0.971161764706
StdDev 0.688308297253
Sum 06,039

Min 0.181 E
Maw 3. 726
Press Cirl+C to copy results to the dipboard

i o |

As you can see, the total sum of the stands® areas is 66 .04 ha. Note that the area of the missing forest stands is
only about 7 ha.

In the same way, you can calculate that the total volume for these stands is 8908 m3/ha and the total number of
stemsis 179594 stems.

Using the information from the forest stands, instead of directly using that from the sample plots, gives the following
average estimates:

e 184.9 m3/ha and
e 2719 stems/ha.

Save your QGIS project, forest_inventory.ggs.

14.7.4 In Conclusion

You managed to calculate forest estimates for the whole forest using the information from your systematic sample
plots, first without considering the forest characteristics and also using the interpretation of the aerial image into
forest stands. And you also got some valuable information about the particular stands, which could be used to plan
the management of the forest in the coming years.
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14.7.5 What’s Next?

In the following lesson, you will first create a hillshade background from a LiDAR dataset which you will use to
prepare a map presentation with the forest results you just calculated.

14.8 Lesson: DEM from LiDAR Data

You can improve the look of your maps by using different background images. You could use the basic map or the
aerial image you have been using before, but a hillshade raster of the terrain will look nicer in some situations.

You will use LAStools to extract a DEM from a LiDAR dataset and then create a hillshade raster to use in your map
presentation later.

The goal for this lesson: Install LAStools and calculate a DEM from LiDAR data and a hillshade raster.

14.8.1 \ Follow Along: Installing Lastools

Managing LiDAR data within QGIS is possible using the Processing framework and the algorithms provided by
LAStools.

You can obtain a digital elevation model (DEM) from a LiDAR point cloud and then create a hillshade raster that
is visually more intuitive for presentation purposes. First you will have to set up the Processing framework settings
to properly work with LAStools:

* Close QGIS, if you have already started it.

¢ An old lidar plugin might be installed by default in your system in the folder C: /Program Files/QGIS
Valmiera/apps/ggis/python/plugins/processing/.

* If you have a folder named 1idar, delete it. This is valid for some installations of QGIS 2.2 and 2.4.
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RS Q=N FOR (=)
@U" ;% apps » gqgis » python » plugins » processing » - | 3 | Search proc.. P |
Organize « = Open Include in library = Share with - Burn » ==« [ .@.
Mame Date modified Type Size i
, admintools 6/5/2014 3:20 PM File folder
| algs 6/5/2014 2:20 PM File folder
J commander 6/5/2014 3:20 PM File folder
| core 6/5/2014 3:20 PM File folder i
, exampleprovider 6/5/2014 3:20 PM File folder 1
J gdal 6/5/2014 3:20 PM File folder
J grass 6/5/2014 3:20 PM File folder
J gui 6/5/2014 3:20 PM File folder
J images 6/5/2014 2:20 PM File folder —
. lidar 6/5/2014 3:20 PM File folder
, modeler 6/5/2014 3:20 PM File folder
J oth 6/5/2014 3:20 PM File folder
J ocutputs 6/5/2014 3:20 PM File folder
J pararmneters 6/5/2014 3:20 PM File folder
§r 6/5/2014 3:20 PM File folder
lidar Date modified: 6/5/2014 3:20 PM
' File folder

* Go to the exercise_datal\forestry\lidar\ folder, there you can find the file
QGIS_2_2_toolbox.zip. Open itand extract the 1idar folder to replace the one you just deleted.

* If you are using a different QGIS version, you can see more installation instructions in this tutorial.

Now you need to install the LAStools to your computer. Get the newest lastools version here and extract the
content of the lastools.zip file into a folder in your system, for example, C:\lastools\. The path to
the lastools folder cannot have spaces or special characters.

IIpumeuanne: Read the LICENSE. txt file inside the 1astools folder. Some of the LAStools are open source
and other are closed source and require licensing for most commercial and governmental use. For education and
evaluation purposes you can use and test LAStools as much as you need to.

The plugin and the actual algorithms are now installed in your computer and almost ready to use, you just need to
set up the Processing framework to start using them:

¢ Open a new project in QGIS.
 Set the project’s CRS to ETRS89 / ETRS-TM35FIN.
* Save the projectas forest_lidar.qggs.
To setup the LAStools in QGIS:
¢ Go to Processing » Options and configuration.
* In the Processing options dialog, go to Providers and then to Tools for LiDAR data.
* Check Activate.
* For LAStools folder set c:\1lastools\ (or the folder you extracted LAStools to).
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iy Processing options

Search...

Setting Value
-- General
Iiﬂ Maodels
Ei Providers
& & GDAL/OGR
-y GRASS commands
“|&] GeoServer/PostGIS tools
- o Modeler-only toals
ﬁ Orfeo Toclbox (Image analysis)
- ﬁ QGIS geealgorithms
'@' R scripts
& SAGA
-- TauDEM (hydrolegic analysis)
- ¥, Tools for LiDAR data
¥, Activate b

----- k Fusion folder

- 3 LAStools folder Ci\lastools

B |E Scripts

14.8.2 \ Follow Along: Calculating a DEM with LAStools
You have already used the Processing toolbox in 3ansmue: Ilpocmparncmeennas cmamucmura to run some SAGA
algorithms. Now you are going to use it to run LAStools programs:

* Open Processing » Toolbox.

¢ In the dropdown menu at the bottom, select Advanced interface.

* You should see the Tools for LIDAR data category.
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- -

Processing Toolbox

Search. ..

&

Recently used algorithms

GDAL/OGR. [32 geoalgorithms]

-y GRASS commands [157 geoalgorithms]

* = GeoServer [PostGIS tools [8 geoalgorithms]

r-ﬂ Models [12 geoalgorithms]

g Orfeo Toolbox (Image analysis) [76 geoalgorithms]
QGIS geoalgorithms [67 geoalgorithms]

% SAGA [243 geoalgorithms]
Scripts [11 geoalgorithms]

k Tools for LIDAR. data [55 geoalgorithms]

Advanced interface

&l

Simplified interface
II

* Expand it to see the tools available, and expand also the LAStools category (the number of algorithms may

vary).

¢ Scroll down until you find the lasview algorithm, double click it to open.

e At Input LAS/LAZ file, browse to exercise_data\forestry\lidar\ and select the
rautjarvi_lidar.laz file.
o . - lasclip
& lasview @ —|ascolar
- lasduplicate
Parameters | Log | Help - lasgrid
- - lasground
- lasheight
verbose - lagindex
- lasinfo
o v - lasmerge
. - lasnoise
input LAS/LAZ file - |asoverage
C:\qais_forestry\exercise_data\forestrylidaryrautiarvi_lidar.laz I] - lasoverlap
- laspredision
- |lasguery
- lassort
- lassplit
- lasthin
- lastile
- lasvalidate
- lasview
[I 0% ] - laszip
- shp2las
Run Close tsdlzjiﬂas
.| AC+mndla Mimaliomn
¢ Click Run.
Now you can see the LiDAR data in the just a litfle LAS and LAZ viewer dialog window:
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1 just a little LAS and LAZ viewer =N B ==

pan

There are many things you can do within this viewer, but for now you can just click and drag on the viewer to pan
the LiDAR point cloud to see what it looks like.

IIpumeuanne: If you want to know further details on how the LAStools work, you can read the README text
files about each of the tools, in the C: \1lastools\bin\ folder. Tutorials and other materials are available at the
Rapidlasso webpage.

* Close the viewer when you are ready.

Creating a DEM with LAStools can be done in two steps, first one to classify the point cloud into ground and no
ground points and then calculating a DEM using only the ground points.

¢ Go back to the Processing Toolbox.
¢ Note the Search... box, write 1lasground.

* Double click to open the lasground tool and set it as shown in this image:
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r

g lasground @

Parameters Log Help

verbose
Mo -
input LAS/LAZ file
Ci\qois_forestry\exerdse_data\forestryVidar\rautjarvi_lidar.laz :]
horizontal feet
Mo -
vertical feet
Mo -
airborne LIDAR
Yes -
terrain type
wilderness -
preprocessing
default - =]
il
u o )

Run Close Cancel

* The output file is saved to the same folder where the raut jarvi_lidar.laz is located and it is named
rautjarvi_lidar_1.las.

You can open it with lasview if you want to check it.
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7 just a little LAS and LAZ viewer eS|

The brown points are the points classified as ground and the gray ones are the rest, you can click the letter g to
visualize only the ground points or the letter u to see only the unclassified points. Click the letter a to see all the
points again. Check the lasview_README. txt file for more commands. If you are interested, also this tutorial
about editing LiDAR points manually will show you different operations within the viewer.

¢ Close the viewer again.
¢ In the Processing Toolbox, search for 1as2dem.

¢ Open the las2dem tool and set it as shown in this image:
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- =

M las2dem @

Parameters Log Help

S

verbose

Mo -
input LAS/LAZ file

C:\gois_forestry\exerdse_data\forestryllidarrautjarvi_lidar _1.1as [:]
filter (by return, dassification, flags)

——— -

step size [ pixel size

1000000 = E]
Attribute
elevation -
Product
actual values -
Cutput raster file

C:fqais_forestryfexerdse_datafforestryfresults frautjarvi_dem. tif

% Open output file after running algorithm

[ 0% )

Run Close Cancel

The result DEM is added to your map with the generic name Output raster file.

IMpumeuanue: The lasground and las2dem tools require licensing. You can use the unlicensed tool as indicated in
the license file, but you get the diagonals you can appreciate in the image results.

14.8.3 \ Follow Along: Creating a Terrain Hillshade

For visualization purposes, a hillshade generated from a DEM gives a better visualization of the terrain:
* Open Raster » Terrain analysis » Hillshade.

* As the Output layer, browse to exercise_data\forestry\lidar\ and name the file hillshade.
tif.

* Leave the rest of parameters with the default settings.
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' Hillshade ="
Elevation layer rautjarvi_dem -
COutput layer 2stry flidar frautjarvi_hillshade. tif E]
QOutput format GeoTIFF -

Z factor 1

X Add result to project

Tlumination
Azimuth (haorizontal angle) 300.00 :
vertical angle 40.00 :

* Select ETRS89 / ETRS-TM35FIN as the CRS when prompted.

Despite the diagonal lines remaining in the hillshade raster result, you can clearly see an accurate relief of the area.
You can even see the different soil drains that have been dug in the forests.
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14.8.4 In Conclusion

Using LiDAR data to get a DEM, specially in forested areas, gives good results with not much effort. You could
also use ready LiDAR derived DEMs or other sources like the SRTM 9m resolution DEMs. Either way, you can
use them to create a hillshade raster to use in your map presentations.
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14.8.5 What’s Next?

In the next, and final step in this module, lesson you will use the hillshade raster and the forest inventory results to
create a map presentation of the results.

14.9 Lesson: Map Presentation

In the previous lessons you have imported an old forest inventor as a GIS project, updated it to the current situation,
designed a forest inventory, created maps for the field work and calculated forest parameters from the field
measurements.

It is often important to create maps with the results of a GIS project. A map presenting the results of the forest
inventory will make it easier for anyone to have a good idea of what the results are in a quick glance, without
looking at the specific numbers.

The goal for this lesson: Create a map to present the inventory results using a hillshade raster as background.

14.9.1 \ Follow Along: Preparing the Map Data

Open the QGIS project from the parameters calculations lesson, forest_inventory.ggs. Keep at least the
following layers:

e forest_stands_2012_results.

* basic_map.

* rautjarvi_aerial.

¢ lakes (if you don’t have it, add it from the exercise_data\forestry\ folder).

You are going to present the average volumes of your forest stands in a map. If you open the Attribute table for the
forest_stands_2012_results layer, you can see the NULL values for the stands without information. To
be able to get also those stands into your symbology you should change the NULL values to, for example, —999,
knowing that those negative numbers mean there is no data for those polygons.

For the forest_stands_2012_results layer:
* Open the A#tribute table and enable editing.
* Select the polygons with NULL values.
* Use the calculator to update the values of the MEANVo1 field to —999 only for the selected features.
* Disable editing and save the changes.
Now you can use a saved style for this layer:
* Go to the Symbology tab.
¢ Click on Style » Load Style....

e Select the forest_stands_2012_results.gml from the exercise_data\forestry\
results)\ folder.

* Click OK.
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/1 Layer Properties - forest_stands_2012_results | Style

W Layer rendering

Layer transparency ¥; =
Layer blending mode Hard light ~ | Feature blending mode Mormal -
* Graduated -
Column MEANp_vol - | E.
Rendering
Symbol . Change... Classes | 7 =
Display
Color ramp - [source] - Invert Mode | Natural Breaks (Jenks) -
Actions
Symbal | Value | Label |
-299,0000 - 0.0000 Mo data
0.0000 - 15.0000 0-15
15.0000 - 25.0000  15-25
25,0000 - 50,0000 25-50
50,0000 - 100.0000 50 - 100
100.0000 - 150.00... 100 - 150
150.0000 - 300.00... 150 - 300
Classify Add dass Delete Delete all Advanced ~
Load Style ... Save As Default Restore Default Style Save Style =
OK Cancel Apply Help

Your map will look something like this:
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' QGIS 2.20-Valmiera - lidar =R ==
Project Edit Wiew Layer Settings Plugine Vector Raster Database MMQGIS Processing  Help
TEEROR 0% L2LsAPLAL » & B>
Layes EE T ) B T R
El- (% (iforest stands 2012 results
i B Mo data
0-15
15-25
25-50
50 - 100
100 - 150
150 - 300
' I lakes
% x E hillshade
=]
Cé
%
‘\J; -
I8
.
_\lT
==
b
\P
|There is a plugin update available ||I|| 397138,6737216 - |E|| 1:8,810 - ||$ Render ||I| Yy

14.9.2 \ Try Yourself Try Different Blending Modes

The style you loaded:
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100.0000 - 150.00... 100 - 150
150.0000 - 300.00... 150 - 300

Classify Add dass Delete

Load Style ...

Delete all

Save As Default

Restore Default Style

OK

/' Layer Properties - forest_stands_2012_results | Style
W Layer rendering
Layer transparency ¥; =
Layer blending mode Hard light ~ | Feature blending mode Mormal -
€ Labels
* Graduated -
B Fields
- Column MEANp_vol - | E.
§ Rendering
Symbol . Change... Classes | 7 =
- Display
Color ramp - [source] - Invert Mode | Natural Breaks (Jenks) -
G’ Actions :
- Symbol | Value | Label |
+ 4 10ins -393,0000 - 0.0000  No data
0.0000 - 15.0000 0-15
IER Diagrams 15,0000 - 25,0000 15-25
25,0000 - 50,0000 25-50
(i' Metadata 50,0000 - 100.0000 50 - 100

Advanced ~

Save Style =

Cancel

Apply Help

is using the Hard 1ight mode for the Layer blending mode. Note that the different modes apply different filters
combining the underlying and overlying layers, in this case the hillshade raster and your forest stands are used. You

can read about these modes in the User Guide.

Try with different modes and see the differences in your map. Then choose the one you like better for your final

map.

14.9.3 \ Try Yourself Using a Layout Template to Create the Map result

Use a template prepared in advanced to present the results. The template forest_map.gpt is located in the
exercise_data\forestry\results\ folder. Load it using the Project » Layout Manager... dialog.
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Create unigue print composer title
(titte generated if left empty)

| results -

w New from template

sroise_data/forestryfresults fforest_map.gpt

Open template directory LIsEer default

Shaw Duplicate Remove Rename Cloze

Ve

Open the print layout and edit the final map to get a result you are happy with.

The map template you are using will give a map similar to this one:
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RAUTIJARVI FOREST
- INVENTORY RESULTS 2012 -

397000 397500 FHE000

Stand Results

Stand Volume (m3/ha)

I no data
[ ]0-15
[]15-25
I 25-50
B s0- 100
Bl 100 - 150
Il 150 - 300

397500

- Results for the whole forest area -

Using Systematic Sample plots Using Stand Sample Plots Averages
Total area: 72.9 Total area: 72.9
Total volume (m3): 9856 Total volume (m3): 13479
Average volume (m3/ha): 135.2 Average volume (m3/ha); 184.9

Save your QGIS project for future references.
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14.9.4 In Conclusion

Through this module you have seen how a basic forest inventory can be planned and presented with QGIS. Many
more forest analysis are possible with the variety of tools that you can access, but hopefully this manual has given
you a good starting point to explore how you could achieve the specific results you need.
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Module: Database Concepts with PostgreSQL

Relational Databases are an important part of any GIS system. In this module, you’ll learn about Relational Database
Management System (RDBMS) concepts and you will use PostgreSQL to create a new database to store data, as
well as learning about other typical RDBMS functions.

15.1 Lesson: Introduction to Databases

Before using PostgreSQL, let’s make sure of our ground by covering general database theory. You will not need to
enter any of the example code; it’s only there for illustration purposes.

The goal for this lesson: To understand fundamental database concepts.

15.1.1 What is a Database?

A database consists of an organized collection of data for one or more uses, typically in digital form. - Wikipedia

A database management system (DBMS) consists of software that operates databases, providing storage, access,
security, backup and other facilities. - Wikipedia

15.1.2 Tables

In relational databases and flat file databases, a table is a set of data elements (values) that is organized using a model
of vertical columns (which are identified by their name) and horizontal rows. A table has a specified number of
columns, but can have any number of rows. Each row is identified by the values appearing in a particular column
subset which has been identified as a candidate key. - Wikipedia

id | name | age
B PR
1 | Tim | 20
2 | Horst | 88

(2 rows)

In SQL databases a table is also known as a relation.
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15.1.3 Columns / Fields

A column is a set of data values of a particular simple type, one for each row of the table. The columns provide
the structure according to which the rows are composed. The term field is often used interchangeably with column,
although many consider it more correct to use field (or field value) to refer specifically to the single item that exists
at the intersection between one row and one column. - Wikipedia

A column:

A field:

| Horst |

15.1.4 Records

A record is the information stored in a table row. Each record will have a field for each of the columns in the table.

2 | Horst | 88 <—-- one record

15.1.5 Datatypes

Datatypes restrict the kind of information that can be stored in a column. - Tim and Horst
There are many kinds of datatypes. Let’s focus on the most common:

e String - to store free-form text data

e Integer - to store whole numbers

¢ Real - to store decimal numbers

* Date - to store Horst’s birthday so no one forgets

* Boolean - to store simple true/false values

You can tell the database to allow you to also store nothing in a field. If there is nothing in a field, then the field
content is referred to as a ,,null* value:

insert into person (age) wvalues (40);

select * from person;

Pesynprar:
id | name | age
g f—
1 | Tim | 20
2 | Horst | 88
4 | | 40 <—-— null for name
(3 rows)

There are many more datatypes you can use - check the PostgreSQL manual!
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15.1.6 Modelling an Address Database

Let’s use a simple case study to see how a database is constructed. We want to create an address database.

Try Yourself \

Write down the properties which make up a simple address and which we would want to store in our database.

Check your results

Address Structure

The properties that describe an address are the columns. The type of information stored in each column is its
datatype. In the next section we will analyse our conceptual address table to see how we can make it better!

15.1.7 Database Theory

The process of creating a database involves creating a model of the real world; taking real world concepts and
representing them in the database as entities.

15.1.8 Normalisation
One of the main ideas in a database is to avoid data duplication / redundancy. The process of removing redundancy
from a database is called Normalisation.

Normalization is a systematic way of ensuring that a database structure is suitable for general-purpose querying and
free of certain undesirable characteristics - insertion, update, and deletion anomalies - that could lead to a loss of
data integrity. - Wikipedia

There are different kinds of normalisation ,,forms*.

Let’s take a look at a simple example:

Table "public.people"

Column | Type | Modifiers
,,,,,,,,,, e
id | integer | not null default
| | nextval ('people_id_seq'::regclass)
\ \
name | character varying(50) |
address | character varying(200) | not null
phone_no | character varying |
Indexes:

"people_pkey" PRIMARY KEY, btree (id)

select * from people;

id | name | address |  phone_no
——— o o
1 | Tim Sutton | 3 Buirski Plein, Swellendam | 071 123 123
2 | Horst Duester | 4 Avenue du Roix, Geneva | 072 121 122

(2 rows)

Imagine you have many friends with the same street name or city. Every time this data is duplicated, it consumes
space. Worse still, if a city name changes, you have to do a lot of work to update your database.
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15.1.9 Try Yourself \

Redesign the theoretical people table above to reduce duplication and to normalise the data structure.
You can read more about database normalisation here

Check your results

15.1.10 Indexes

A database index is a data structure that improves the speed of data retrieval operations on a database table. -
Wikipedia
Imagine you are reading a textbook and looking for the explanation of a concept - and the textbook has no index!

You will have to start reading at one cover and work your way through the entire book until you find the information
you need. The index at the back of a book helps you to jump quickly to the page with the relevant information:

create index person_name_idx on people (name);

Now searches on name will be faster:

Table "public.people"
Column | Type | Modifiers

not null default
nextval ('people_id_seq'::regclass)

integer

name character varying (50)

address character varying(200) not null
phone_no character varying

Indexes:

"people_pkey" PRIMARY KEY, btree (id)
"person_name_idx" btree (name)

15.1.11 Sequences

A sequence is a unique number generator. It is normally used to create a unique identifier for a column in a table.

In this example, id is a sequence - the number is incremented each time a record is added to the table:

id | name | address | phone_no
———e Fm e ——
1 | Tim Sutton | 3 Buirski Plein, Swellendam | 071 123 123
2 | Horst Duster | 4 Avenue du Roix, Geneva | 072 121 122

15.1.12 Entity Relationship Diagramming

In a normalised database, you typically have many relations (tables). The entity-relationship diagram (ER Diagram)
is used to design the logical dependencies between the relations. Consider our non-normalised people table from
earlier in the lesson:

select * from people;

id | name | address | phone_no
e o Fm
1 | Tim Sutton | 3 Buirski Plein, Swellendam | 071 123 123

(continues on next page)
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2 | Horst Duster | 4 Avenue du Roix, Geneva | 072 121 122
(2 rows)

With a little work we can split it into two tables, removing the need to repeat the street name for individuals who
live in the same street:

select * from streets;

id | name
e
1 | Plein Street
(1 row)

and:

select * from people;

id | name | house_no | street_id | phone_no
e Fom e —— fom fom
1 | Horst Duster | 4 | 1 | 072 121 122

(1 row)

We can then link the two tables using the ,keys“ streets.id and people.streets_id.

If we draw an ER Diagram for these two tables it would look something like this:

People > Streets

The ER Diagram helps us to express ,,one to many“ relationships. In this case the arrow symbol show that one street
can have many people living on it.

Try Yourself /

Our people model still has some normalisation issues - try to see if you can normalise it further and show your
thoughts by means of an ER Diagram.

Check your results

15.1.13 Constraints, Primary Keys and Foreign Keys
A database constraint is used to ensure that data in a relation matches the modeller’s view of how that data should be
stored. For example a constraint on your postal code could ensure that the number falls between 1000 and 9999.

A Primary key is one or more field values that make a record unique. Usually the primary key is called id and is a
sequence.

A Foreign key is used to refer to a unique record on another table (using that other table’s primary key).
In ER Diagramming, the linkage between tables is normally based on Foreign keys linking to Primary keys.

If we look at our people example, the table definition shows that the street column is a foreign key that references
the primary key on the streets table:
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Table "public.people"

Column | Type | Modifiers
,,,,,,,,,,, S
id | integer | not null default

| | nextval ('people_id_seq'::regclass)
name | character varying(50)
house_no | integer | not null
street_id | integer | not null

| |

phone_no
Indexes:
"people_pkey" PRIMARY KEY, btree (id)

Foreign-key constraints:

"people_street_id_fkey" FOREIGN KEY (street_id) REFERENCES streets (id)

character varying

15.1.14 Transactions

When adding, changing, or deleting data in a database, it is always important that the database is left in a good state
if something goes wrong. Most databases provide a feature called transaction support. Transactions allow you to
create a rollback position that you can return to if your modifications to the database did not run as planned.

Take a scenario where you have an accounting system. You need to transfer funds from one account and add them
to another. The sequence of steps would go like this:

¢ remove R20 from Joe
¢ add R20 to Anne

If something goes wrong during the process (e.g. power failure), the transaction will be rolled back.

15.1.15 In Conclusion

Databases allow you to manage data in a structured way using simple code structures.

15.1.16 What’s Next?

Now that we’ve looked at how databases work in theory, let’s create a new database to implement the theory we’ve
covered.

15.2 Lesson: Implementing the Data Model

Now that we’ve covered all the theory, let’s create a new database. This database will be used for our exercises for
the lessons that will follow afterwards.

The goal for this lesson: To install the required software and use it to implement our example database.
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15.2.1 Install PostgreSQL

IIpumeuanue: You can find PostGreSQL packages and installation instructions for your operating system at https:
/Iwww .postgresql.org/download/. Please note that the documentation will assume users are running QGIS under
Ubuntu.

Under Ubuntu:

sudo apt install postgresgl-9.1

You should get a message like this:

[sudo] password for ggis:

Reading package lists... Done

Building dependency tree

Reading state information... Done

The following extra packages will be installed:
postgresgl-client-9.1 postgresgl-client—-common postgresgl-common
Suggested packages:

oidentd ident-server postgresgl-doc-9.1

The following NEW packages will be installed:

postgresgl-9.1 postgresgl-client-9.1 postgresqgl-client-common postgresgl-common
0 upgraded, 4 newly installed, 0 to remove and 5 not upgraded.

Need to get 5,012kB of archives.

After this operation, 19.0MB of additional disk space will be used.
Do you want to continue [Y/n]?

Press Y and Enter and wait for the download and installation to finish.

15.2.2 Cnpaska

PostgreSQL has very good online documentation.

15.2.3 Create a database user

Under Ubuntu:

After the installation is complete, run this command to become the postgres user and then create a new database
user:

sudo su — postgres

Type in your normal log in password when prompted (you need to have sudo rights).

Now, at the postgres user’s bash prompt, create the database user. Make sure the user name matches your unix login
name: it will make your life much easier, as postgres will automatically authenticate you when you are logged in as
that user:

createuser -d -E -1 -1 -P -r -s qggis

Enter a password when prompted. You should use a different password to your login password.

What do those options mean?

-d, —-—-createdb role can create new databases

-E, ——encrypted encrypt stored password

-1, —-—inherit role inherits privileges of roles it is a member of (default)
-1, --login role can login (default)

(continues on next page)
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-P, ——pwprompt
-r, ——createrole
-s, ——superuser

assign a password to new role
role can create new roles
role will be superuser

Now you should leave the postgres user’s bash shell environment by typing:

’exit

15.2.4 Verify the new account

’psql -1

Should return something like this:

Name |  Owner | Encoding
,,,,,,,,,, e
postgres | postgres | UTF8
templateO | postgres | UTFS8
templatel | postgres | UTFS8

(3 rows)

Collation | Ctype |
777777777777 R
en_ZA.utf8 | en_ZA.utf8
en_ZA.utf8 | en_ZA.utfs8
|

en_ZA.utf8

en_7ZA.utf8

Type Q to exit.

15.2.5 Create a database

The createdb command is used to create a new database. It should be run from the bash shell prompt:

’createdb address -0 ggis

You can verify the existence of your new database by using this command:

’psql -1

Which should return something like this:

Name | Owner | Encoding | Collation | Ctype | Access privileges
—————————— e
address | ggis | UTFS8 | en_ZA.utf8 | en_ZA.utfs8

postgres | postgres | UTF8 | en_ZA.utf8 | en_ZA.utf8 |

templateO | postgres | UTFS8 | en_ZA.utf8 | en_ZA.utf8 | =c/postgres:.
—postgres=CTc/postgres

templatel | postgres | UTFS8 | en_ZA.utf8 | en_ZA.utf8 | =c/postgres:.
—postgres=CTc/postgres

(4 rows)

Type Q to exit.
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15.2.6 Starting a database shell session

You can connect to your database easily like this:

’psql address

To exit out of the psql database shell, type:

E

For help in using the shell, type:

’\?

For help in using sql commands, type:

’\help

To get help on a specific command, type (for example):

’\help create table

See also the Psql cheat sheet.

15.2.7 Make Tables in SQL

Let’s start making some tables! We will use our ER Diagram as a guide. First, connect to the address db:

’psql address

Then create a st reets table:

’create table streets (id serial not null primary key, name varchar (50));

serial and varchar are data types. serial tells PostgreSQL to start an integer sequence (auto-number) to
populate the id automatically for every new record. varchar (50) tells PostgreSQL to create a character field

of 50 characters in length.

You will notice that the command ends with a ; - all SQL commands should be terminated this way. When you

press Enter, psql will report something like this:

for serial column "streets.id"

CREATE TABLE

NOTICE: CREATE TABLE will create implicit sequence "streets_id seq"

NOTICE: CREATE TABLE / PRIMARY KEY will create implicit index
"streets_pkey" for table "streets"

That means your table was created successfully, with a primary key st reets_pkey using streets.id.

Note: If you hit return without entering a ; , then you will get a prompt like this: address—#. This is because PG
is expecting you to enter more. Enter ; to run your command.

To view your table schema, you can do this:

\d streets

Which should show something like this:

Table "public.streets"
Column | Type |

,,,,,,,, S

Modifiers

(continues on next page)
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id | integer | not null default

| | nextval ('streets_id_seq'::regclass)
name | character varying(50) |
Indexes:

"streets_pkey" PRIMARY KEY, btree (id)

To view your table contents, you can do this:

select * from streets;

Which should show something like this:

(0 rows)

As you can see, our table is currently empty.

Try Yourself /

Use the approach shown above to make a table called people:

Add fields such as phone number, home address, name, etc. (these aren’t all valid names: change them to make them
valid). Make sure you give the table an ID column with the same data-type as above.

Check your results

15.2.8 Create Keys in SQL

The problem with our solution above is that the database doesn’t know that people and streets have a logical
relationship. To express this relationship, we have to define a foreign key that points to the primary key of the
streets table.

People > Streets

There are two ways to do this:
¢ Add the key after the table has been created
 Define the key at time of table creation

Our table has already been created, so let’s do it the first way:

alter table people
add constraint people_streets_fk foreign key (street_id) references streets(id);

That tells the people table that its st reet_id fields must match a valid street 1d from the st reets table.

The more usual way to create a constraint is to do it when you create the table:

create table people (id serial not null primary key,
name varchar (50),
house_no int not null,
street_id int references streets(id) not null,

(continues on next page)
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phone_no varchar null);

\d people

After adding the constraint, our table schema looks like this now:

Table "public.people"

Column | Type | Modifiers
,,,,,,,,,,, T
id | integer | not null default

| | nextval ('people_id_seqg'::regclass)

name | character varying(50)

house_no | integer | not null

street_id | integer | not null

phone_no | character varying |
Indexes:

"people_pkey" PRIMARY KEY, btree (id)
Foreign-key constraints:
"people_streets_fk" FOREIGN KEY (id) REFERENCES streets (id)

15.2.9 Create Indexes in SQL

We want lightning fast searches on peoples names. To provide for this, we can create an index on the name column
of our people table:

create index people_name_idx on people (name) ;

\d people

Which results in:

Table "public.people"

Column | Type | Modifiers
___________ S
id | integer | not null default nextval
| | ('people_id_seq'::regclass)

name | character varying(50)

house_no | integer | not null

street_id | integer | not null

phone_no | character varying
Indexes:

"people_pkey" PRIMARY KEY, btree (id)

"people_name_idx" btree (name) <—-— new index added!

Foreign-key constraints:
"people_streets_fk" FOREIGN KEY (id) REFERENCES streets (id)
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15.2.10 Dropping Tables in SQL

If you want to get rid of a table you can use the drop command:

drop table streets;

IIpumeuanne: In our current example, the above command would not work. Why not? See why

If you used the same drop table command on the people table, it would be successful:

drop table people;

IIpumeuanue: If you actually did enter that command and dropped the people table, now would be a good time
to rebuild it, as you will need it in the next exercises.

15.2.11 A word on pgAdmin Il

We are showing you the SQL commands from the psgl prompt because it’s a very useful way to learn about databases.
However, there are quicker and easier ways to do a lot of what we are showing you. Install pgAdmin III and you can
create, drop, alter etc tables using ,,point and click® operations in a GUL

Under Ubuntu, you can install it like this:

sudo apt install pgadmin3

pgAdmin IIT will be covered in more detail in another module.

15.2.12 In Conclusion

You have now seen how to create a brand new database, starting completely from scratch.

15.2.13 What’s Next?

Next you’ll learn how to use the DBMS to add new data.

15.3 Lesson: Adding Data to the Model

The models we’ve created will now need to be populated with the data they’re intended to contain.

The goal for this lesson: To learn how to insert new data into the database models.
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15.3.1 Insert statement

How do you add data to a table? The sql INSERT statement provides the functionality for this:

insert into streets (name) wvalues ('High street');

A couple of things to note:

 After the table name (st reets), you list the column names that you will be populating (in this case only the
name column).

» After the values keyword, place the list of field values.
* Strings should be quoted using single quotes.
* Note that we did not insert a value for the id column; this is because it is a sequence and will be auto-generated.
* If you do manually set the id, you may cause serious problems with the integrity of your database.
You should see INSERT 0 1 if it is successful.

You can see the result of your insert action by selecting all the data in the table:

select * from streets;

Pesynbrar:

select * from streets;
id | name
e

1 | High street
(1 row)

Try Yourself \

Use the INSERT command to add a new street to the st reet s table.

Check your results

15.3.2 Sequencing Data Addition According to Constraints

15.3.3 Try Yourself /

Try to add a person object to the people table with the following details:

Name: Joe Smith
House Number: 55
Street: Main Street
Phone: 072 882 33 21

IIpumeuanne: Recall that in this example, we defined phone numbers as strings, not integers.

At this point, you should have an error report if you try to do this without first creating a record for Main Street in
the streets table.

You should have also noticed that:

* You can’t add the street using its name
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* You can’t add a street using a street 1 d before first creating the street record on the streets table

Remember that our two tables are linked via a Primary/Foreign Key pair. This means that no valid person can be
created without there also being a valid corresponding street record.

Using the above knowledge, add the new person to the database.

Check your results

15.3.4 Select data

We have already shown you the syntax for selecting records. Let’s look at a few more examples:

’select name from streets;

’select * from streets;

’select * from streets where name='Main Road';

In later sessions we will go into more detail on how to select and filter data.

15.3.5 Update data

What if you want to make a change to some existing data? For example, a street name is changed:

update streets set name='New Main Road' where name='Main Road';

Be very careful using such update statements - if more than one record matches your WHERE clause, they will all
be updated!

A better solution is to use the primary key of the table to reference the record to be changed:

update streets set name='New Main Road' where id=2;

It should return UPDATE 1.

IIpumeuanue: the WHERE statement criteria are case sensitive Main Road is not the same as Main road

15.3.6 Delete Data

In order to delete an object from a table, use the DELETE command:

delete from people where name = 'Joe Smith';

Let’s look at our people table now:

address=# select * from people;

id | name | house_no | street_id | phone_no
—————————— Fom e ——— Fom Fomm———————
(0 rows)
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15.3.7 Try Yourself —

Use the skills you have learned to add some new friends to your database:

name | house_no | street_id | phone_no
77777777777777777 Bt it
Joe Bloggs | 3 | 2 | 072 887 23 45
Jane Smith | 55 | 3 | 072 837 33 35
Roger Jones \ 33 | 1 | 072 832 31 38
Sally Norman | 83 | 1 | 072 932 31 32

15.3.8 In Conclusion

Now you know how to add new data to the existing models you created previously. Remember that if you want to
add new kinds of data, you may want to modify and/or create new models to contain that data.

15.3.9 What’s Next?

Now that you've added some data, you’ll learn how to use queries to access this data in various ways.

15.4 Lesson: Queries

When you write a SELECT ... command it is commonly known as a query - you are interrogating the database
for information.

The goal of this lesson: To learn how to create queries that will return useful information.

IIpumeuanne: If you did not do so in the previous lesson, add the following people objects to your people table.
If you receive any errors related to foreign key constraints, you will need to add the ,,Main Road” object to your
streets table first

insert into people (name,house_no, street_id, phone_no)
values ('Joe Bloggs',3,2,'072 887 23 45'");
insert into people (name,house_no, street_id, phone_no)
values ('Jane Smith',55,3,'072 837 33 35');
insert into people (name,house_no, street_id, phone_no)
values ('Roger Jones',33,1,'072 832 31 38'");
insert into people (name,house_no, street_id, phone_no)
values ('Sally Norman',83,1,'072 932 31 32'");

15.4.1 Ordering Results

Let’s retrieve a list of people ordered by their house numbers:

select name, house_no from people order by house_no;

Pesynprar:
name | house_no
,,,,,,,,,,,,,, e
Joe Bloggs | 3
Roger Jones | 33

(continues on next page)
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(IPOJIOJIKEHNE C MTPEbIIYLIEH CTPaHULIBI)

Jane Smith | 55
Sally Norman 83
(4 rows)

You can sort the results by the values of more than one column:

select name, house_no from people order by name, house_no;

Pesynprar:
name | house_no
,,,,,,,,,,,,,, e
Jane Smith | 55
Joe Bloggs | 3
Roger Jones | 33
Sally Norman | 83
(4 rows)

15.4.2 Filtering

Often you won’t want to see every single record in the database - especially if there are thousands of records and
you are only interested in seeing one or two.

Here is an example of a numerical filter which only returns objects whose house_no is less than 50:

select name, house_no from people where house_no < 50;

name | house_no
,,,,,,,,,,,,, P
Joe Bloggs | 3
Roger Jones | 33
(2 rows)

You can combine filters (defined using the WHERE clause) with sorting (defined using the ORDER BY clause):

select name, house_no from people where house_no < 50 order by house_no;

name | house_no
,,,,,,,,,,,,, P
Joe Bloggs | 3
Roger Jones | 33
(2 rows)

You can also filter based on text data:

select name, house_no from people where name like

name | house_no
,,,,,,,,,,,,, P
Joe Bloggs | 3
Roger Jones | 33
(2 rows)

Here we used the LIKE clause to find all names with an s in them. You’'ll notice that this query is case-sensitive,
so the Sally Norman entry has not been returned.

If you want to search for a string of letters regardless of case, you can do a case in-sensitive search using the ILIKE

clause:
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o

R

oe
~

select name, house_no from people where name ilike

name | house_no
,,,,,,,,,,,,,, e
Roger Jones | 33
Sally Norman | 83

(2 rows)

That query returned every people object with an r or R in their name.

15.4.3 Joins

What if you want to see the person’s details and their street’s name instead of the ID? In order to do that, you need
to join the two tables together in a single query. Lets look at an example:

select people.name, house_no, streets.name
from people, streets
where people.street_id=streets.id;

IIpumeuanne: With joins, you will always state the two tables the information is coming from, in this case people
and streets. You also need to specify which two keys must match (foreign key & primary key). If you don’t specify
that, you will get a list of all possible combinations of people and streets, but no way to know who actually lives on
which street!

Here is what the correct output will look like:

name | house_no | name
,,,,,,,,,,,,,, S
Joe Bloggs | 3 | Low Street
Roger Jones | 33 | High street
Sally Norman | 83 | High street
Jane Smith | 55 | Main Road

(4 rows)

We will revisit joins as we create more complex queries later. Just remember they provide a simple way to combine
the information from two or more tables.

15.4.4 Sub-Select

Sub-selections allow you to select objects from one table based on the data from another table which is linked via
a foreign key relationship. In our case, we want to find people who live on a specific street.

First, let’s do a little tweaking of our data:

insert into streets (name) wvalues ('QGIS Road');
insert into streets (name) wvalues ('OGR Corner');
insert into streets (name) wvalues('Goodle Square');
update people set street_id = 2 where id=2;

update people set street_id = 3 where id=3;

Let’s take a quick look at our data after those changes: we can reuse our query from the previous section:

select people.name, house_no, streets.name
from people, streets
where people.street_id=streets.id;

Pesynprar:
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Roger Jones High street

\
Sally Norman 83 | High street
Jane Smith 55 | Main Road
Joe Bloggs 3 | Low Street
(4 rows)

Now let’s show you a sub-selection on this data. We want to show only people who live in st reet_1id number 1:

select people.name
from people, (
select *
from streets
where id=1
) as streets_subset
where people.street_id = streets_subset.id;

Pesynbrar:

Roger Jones
Sally Norman
(2 rows)

Although this is a very simple example and unnecessary with our small data-sets, it illustrates how useful and
important sub-selections can be when querying large and complex data-sets.

15.4.5 Aggregate Queries

One of the powerful features of a database is its ability to summarise the data in its tables. These summaries are
called aggregate queries. Here is a typical example which tells us how many people objects are in our people table:

select count (*) from people;

Pesynprar:

If we want the counts to be summarised by street name we can do this:

select count (name), street_id
from people
group by street_id;

Pesysnprar:
count | street_id
,,,,,,, e
2 1
1 3
1] 2
(3 rows)
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IIpumeuanue: Because we have not used an ORDER BY clause, the order of your results may not match what is
shown here.

Try Yourself /

Summarise the people by street name and show the actual street names instead of the street_ids.

Check your results

15.4.6 In Conclusion

You've seen how to use queries to return the data in your database in a way that allows you to extract useful
information from it.

15.4.7 What’s Next?

Next you'll see how to create views from the queries that you've written.

15.5 Lesson: pencraBneHus

Korzma Bsl mummre 3anpoc, Bam npuxoanTcesi TpaTUTh MHOTO BPEMEHM M YCWIIMH AJIsI €ro cospanus. Mcmons3ys
npeJicTaBIeHus, Bel MoxkeTe coxpaHuth TekcT SQL 3arpoca B ,,BUPTYaJIbHOH TaOauIe 1Jisi MHOTOKPATHOTO HC-
MOJIb30BaHUSI.

HeJIl) 9TOro ypoka: COXpaHI/ITI) 3allpocC Kak MpeaACTaBJICHUE.

15.5.1 CospaHue npencrasneHus

Br1 MoskeTe ucros30BaTh IMPEACTaBJIC€HUE TOYHO TaK XK€, KaK 1 Ta6JII/IL[y, HO IIPYU 3TOM UCTOYHUKOM JaHHBIX ABJIAETCA
3arpoc. IIaBaﬁTC co3aaguM MPOCTOE MPEACTABJICHUE Ha OCHOBE BbINIEU3JIOKEHHOTO:

create view roads_count_v as
select count (people.name), streets.name
from people, streets where people.street_id=streets.id
group by people.street_id, streets.name;

Kak Bsl MOXeTe BUIETh, JOOABHIIOCHh TOJIBKO create view roads_count_v as nepej HA4yaJoM 3arpoca.
Tenepb Mbl MOKEM NOJTYYUTh JaHHbBIE U3 PECTABICHUS:

select * from roads_count_v;

Pesysnprar:

Main Road
High street
Low Street
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15.5.2 N3MmeHeHue npeacrasneHUst

[IpencraBneHue He sIBJISIETCS HEU3MEHSIEMbIM, M B HEM HE COJIEPKUTCS ,,peaibHbIX JAHHBIX . DTO O3HAUYAET, 4TO Bb
MOJKETe JIETKO U3MEHSITh er0, He BO3/ICIICTBYSI Ha JaHHBIe B Barreli 6a3e qaHHbIX:

CREATE OR REPLACE VIEW roads_count_v AS
SELECT count (people.name), streets.name
FROM people, streets WHERE people.street_id=streets.id
GROUP BY people.street_id, streets.name
ORDER BY streets.name;

(T0T MpUMeEp TaKke MOKa3bIBACT UCIIOJIb30BAHME OOIEIIPUHSATOrO MTPaBMJIa HAIMCAHKS BCEX KIIOUYEBBIX cJIoB SQL
B BEPXHEM PEI'ICTPE).

Bhl YBUAUTE, YTO KOrJa Mbl )IO6aBI/IJ'II/I MPEIJIOKEHUE ORDER BY, CTPOKH B HallIEM MPEACTABJICHUA CTaJI1 KPACUBO
OTCOPTUPOBAHBI:

select * from roads_count_v;

2 | High street

1 | Low Street

1 | Main Road
(3 rows)

15.5.3 YpaneHuve npeancraBneHus

Ecmn Bam Gosblie He Hy)KHO NpeACTaBlIeHue, Bbl MoxeTe yoaluTh ero TakKuM CIIocoO0M:

drop view roads_count_v;

15.5.4 In Conclusion

Hcrone3ys npencraBienne, Bel MokeTe COXpaHUTD 3alIpOC U MCIOJIb30BATh PE3YJIbTATHI €ro BHIIOJTHEHUs TaK, KaK
ecyi OBl 3TO ObUTa TAOIMIIA.

15.5.5 What’s Next?

WHorma, npyu U3MEeHEHUH JaHHBIX, BAM XOYETCs, YTOObI Bary u3MeHeHHsT OTPa3WIKCh Ie-To elle B 0a3e JaHHbBIX.
B cnenymwoinem ypoke OyeT MOKa3aHo, KaK 3TO CIesaTh.

15.6 Lesson: Rules

Rules allow the «query tree» of an incoming query to be rewritten. One common usage is to implement views,
including updatable view. - Wikipedia

The goal for this lesson: To learn how to create new rules for the database.
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15.6.1 Creating a logging rule

Say you want to log every change of phone_no in your people table in to a people_log table. So you set up a new
table:

create table people_log (name text, time timestamp default NOW());

In the next step, create a rule that logs every change of a phone_no in the people table into the people_log table:

create rule people_log as on update to people
where NEW.phone_no <> OLD.phone_no
do insert into people_log values (OLD.name);

To test that the rule works, let’s modify a phone number:

update people set phone_no = '082 555 1234' where id = 2;

Check that the people table was updated correctly:

select * from people where id=2;
id | name | house_no | street_id | phone_no

2 | Joe Bloggs | 3 2 | 082 555 1234
(1 row)

Now, thanks to the rule we created, the people_1og table will look like this:

select * from people_log;

name | time
,,,,,,,,,,,, e
Joe Bloggs | 2014-01-11 14:15:11.953141
(1 row)

IIpumeuanne: The value of the t ime field will depend on the current date and time.

15.6.2 In Conclusion

Rules allow you to automatically add or change data in your database to reflect changes in other parts of the database.

15.6.3 What’s Next?

The next module will introduce you to Spatial Database using PostGIS, which takes these database concepts and
applies them to GIS data.
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Module: Spatial Database Concepts with PostGIS

Spatial Databases allow the storage of the geometries of records inside a Database as well as providing functionality
for querying and retrieving the records using these Geometries. In this module we will use PostGIS, an extension to
PostgreSQL, to learn how to setup a spatial database, import data into the database and make use of the geographic
functions that PostGIS offers.

While working through this section, you may want to keep a copy of the PostGIS cheat sheet available from Boston
GIS user group. Another useful resource is the online PostGIS documentation.

There are also some more extensive tutorials on PostGIS and Spatial Databases available from Boundless Geo:
* Introduction to PostGIS
* Spatial Database Tips and Tricks

See also PostGIS In Action.

16.1 Lesson: PostGIS Setup

Setting up PostGIS functions will allow you to access spatial functions from within PostgreSQL.

The goal for this lesson: To install spatial functions and briefly demo their effects.

IIpumeuanne: We will assume the use of PostGIS version 2.1 or newer in this exercise. The installation and
database configuration are different for older versions, but the rest of this material in this module will still work.
Consult the documentation for your platform for help with installation and database configuration.
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16.1.1 Installing under Ubuntu

Postgis is easily installed from apt.

$ sudo apt install postgresql
$ sudo apt install postgis

CepbE3HO, 3TO Tak IPOCTO. ..

IIpumeuanne: The exact versions that will be installed depend on which version of Ubuntu you are using
and which repositories you have configured. After installing you can check the version by issuing a select
PostGIS_full_version () ; query with psql or another tool.

To install a specific version (eg, PostgreSQL version 13 and PostGIS 3), you can use the following commands.

$ sudo apt install wget ca-certificates

S sudo lsb_release -a

$ wget —-—quiet -0 - https://www.postgresgl.org/media/keys/ACCC4CF8.asc | sudo apt-
—key add -

$ sudo sh —c 'echo "deb http://apt.postgresgl.org/pub/repos/apt/ "lsb_release —-cs -
—pgdg main" >> /etc/apt/sources.list.d/pgdg.list’

$ sudo apt-get update

$ sudo apt install postgis postgresql-13-postgis-3

16.1.2 Installing under Windows

Installing on Windows can be done from binary packages using a normal Windows installation dialogs.
First Visit the download page. Then follow this guide.

More information about installing on Windows can be found on the PostGIS website.

16.1.3 Installing on Other Platforms

The PostGIS website download has information about installing on other platforms including macOS and on other
Linux distributions

16.1.4 Configuring Databases to use PostGIS

Once PostGIS is installed, you will need to configure your database to use the extensions. If you have installed
PostGIS version > 2.0, this is as simple as issuing the following command with psql using the address database from
our previous exercise.

$ psgl -d address -c "CREATE EXTENSION postgis;"

IIpumeuanne: Depending on your version, you could find more instructions on how to spatially enable a database
at https://postgis.net/docs/postgis_administration.html#create_spatial_db.
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16.1.5 Looking at the installed PostGIS functions

PostGIS can be thought of as a collection of in-database functions that extend the core capabilities of PostgreSQL
so that it can deal with spatial data. By ,,deal with“, we mean store, retrieve, query and manipulate. In order to do
this, a number of functions are installed into the database.

Our PostgreSQL address database is now geospatially enabled, thanks to PostGIS. We are going to delve a lot
deeper into this in the coming sections, but let’s give you a quick little taster. Let’s say we want to create a point
from text. First we use the psql command to find functions relating to point. If you are not already connected to the
address database, do so now. Then run:

\df *point*

This is the command we’re looking for: st _point fromtext. To page through the list, use the down arrow, then
press Q to quit back to the psql shell.

Try running this command:

select st_pointfromtext ('POINT (1 1)");

Pesynprar:

st_pointfromtext

0101000000000000000000F03F000000000000F0O3F
(1 row)

Three things to note:
* We defined a point at position 1,1 (EPSG:4326 is assumed) using POINT (1 1),
* We ran an sql statement, but not on any table, just on data entered from the SQL prompt,
 The resulting row does not make much sense.

The resulting row is in the OGC format called ,,Well Known Binary” (WKB). We will look at this format in detail
in the next section.

To get the results back as text, we can do a quick scan through the function list for something that returns text:

’\df *text ‘

The query we’re looking for now is st _astext. Let’s combine it with the previous query:

’select st_astext (st_pointfromtext ("POINT (1 1)")); ‘

Pesynprar:

st_astext

POINT (1 1)
(1 row)

Here, we entered the string POINT (1, 1), turned it into a point using st_pointfromtext (), and turned it
back into a human-readable form with st_astext (), which gave us back our original string.

One last example before we really get into the detail of using PostGIS:

select st_astext (st_buffer (st_pointfromtext ('POINT (1 1)'),1.0));

What did that do? It created a buffer of 1 degree around our point, and returned the result as text.
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16.1.6 Spatial Reference Systems

In addition to the PostGIS functions, the extension contains a collection of spatial reference system (SRS) definitions
as defined by the European Petroleum Survey Group (EPSG). These are used during operations such as coordinate
reference system (CRS) conversions.

We can inspect these SRS definitions in our database as they are stored in normal database tables.

First, let’s look at the schema of the table by entering the following command in the psql prompt:

\d spatial_ref_sys

The result should be this:

Table "public.spatial_ref_ sys"

Column \ Type | Modifiers
,,,,,,,,,,, U
srid | integer | not null
auth_name | character varying(256) |
auth_srid | integer |
srtext | character varying(2048) |

projd4text | character varying(2048) |

Indexes:

"spatial_ref_ sys_pkey" PRIMARY KEY, btree (srid)

You can use standard SQL queries (as we have learned from our introductory sections), to view and manipulate this
table - though its not a good idea to update or delete any records unless you know what you are doing.

One SRID you may be interested in is EPSG:4326 - the geographic / lat lon reference system using the WGS 84
ellipsoid. Let’s take a look at it:

select * from spatial_ref_sys where srid=4326;

Pesynprar:

srid | 4326
auth_name | EPSG
auth_srid | 4326
srtext | GEOGCS["WGS 84",DATUM["WGS_1984", SPHEROID["WGS
84",6378137,298.257223563, AUTHORITY ["EPSG","7030"]], TOWGS84 [0,
0,0,0,0,0,0],AUTHORITY["EPSG","6326"]],PRIMEM["Greenwich", 0,
AUTHORITY["EPSG","8901"]]1,UNIT["degree",0.01745329251994328,
AUTHORITY["EPSG","9122"]],AUTHORITY["EPSG","4326"]]

projdtext | +proj=longlat +ellps=WGS84 +datum=WGS84 +no_defs

The srtext is the projection definition in well known text (you may recognise this from .prj files in your shapefile
collection).

16.1.7 In Conclusion

You now have PostGIS functions installed in your copy of PostgreSQL. With this you'll be able to make use of
PostGIS* extensive spatial functions.
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16.1.8 What’s Next?

Next you'll learn how spatial features are represented in a database.

16.2 Lesson: Simple Feature Model

How can we store and represent geographic features in a database? In this lesson we’ll cover one approach, the
Simple Feature Model as defined by the OGC.

The goal for this lesson: To learn what the SFS Model is and how to use it.

16.2.1 What is OGC

The Open Geospatial Consortium (OGC), an international voluntary consensus standards organization, originated
in 1994. In the OGC, more than 370+ commercial, governmental, nonprofit and research organizations worldwide
collaborate in an open consensus process encouraging development and implementation of standards for geospatial
content and services, GIS data processing and data sharing. - Wikipedia

16.2.2 What is the SFS Model

The Simple Feature for SQL (SFS) Model is a non-topological way to store geospatial data in a database and defines
functions for accessing, operating, and constructing these data.

Geomelry |0, .* SpatialReferenceSystem
.-’?\
I A I l
Paint Curve Surface | GeometryCollection |
2.'
RS A\ L’% Zlk
n T |
LineString Polygon } ;
1 . MultiSurface MultiCurve T
= ) 1
[;5 A e Z}. .
4 MultiPolygon MultiLineString
Line LinearRing

The model defines geospatial data from Point, Linestring, and Polygon types (and aggregations of them to Multi
objects).

For further information, have a look at the OGC Simple Feature for SQL standard.
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16.2.3 Add a geometry field to table

Let’s add a point field to our people table:

alter table people add column the_geom geometry;

16.2.4 Add a constraint based on geometry type

You will notice that the geometry field type does not implicitly specify what type of geometry for the field - for that
we need a constraint:

alter table people
add constraint people_geom_point_chk
check (st_geometrytype (the_geom) = 'ST Point'::text
OR the_geom IS NULL);

This adds a constraint to the table so that it will only accept a point geometry or a null value.

16.2.5 Try Yourself -—

Create a new table called cities and give it some appropriate columns, including a geometry field for storing polygons
(the city boundaries). Make sure it has a constraint enforcing geometries to be polygons.

Check your results

16.2.6 Populate geometry_columns table

At this point you should also add an entry into the geometry_columns table:

insert into geometry_columns values
("', 'public', "people', 'the_geom',2,4326, "POINT") ;

Why? geometry_columns is used by certain applications to be aware of which tables in the database contain
geometry data.

IIpumeuanue: If the above INSERT statement causes an error, run this query first:

select * from geometry_columns;

If the column f_table_name contains the value people, then this table has already been registered and you
don’t need to do anything more.

The value 2 refers to the number of dimensions; in this case, two: X and Y.

The value 4326 refers to the projection we are using; in this case, WGS 84, which is referred to by the number
4326 (refer to the earlier discussion about the EPSG).
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Try Yourself \

Add an appropriate geometry_columns entry for your new cities layer

Check your results

16.2.7 Add geometry record to table using SQL

Now that our tables are geo-enabled, we can store geometries in them:

insert into people (name,house_no, street_id, phone_no, the_geom)
values ('Fault Towers',
34,
3!
'072 812 31 28",
'SRID=4326;POINT (33 -33)");

IIpumeuanne: In the new entry above, you will need to specify which projection (SRID) you want to use. This is
because you entered the geometry of the new point using a plain string of text, which does not automatically add
the correct projection information. Obviously, the new point needs to use the same SRID as the data-set it is being
added to, so you need to specify it.

If at this point you were using a graphical interface, for example, specifying the projection for each point would be
automatic. In other words, you usually won’t need to worry about using the correct projection for every point you
want to add if you've already specified it for that data-set, as we did earlier.

Now is probably a good time to open QGIS and try to view your people table. Also, we should try editing / adding
/ deleting records and then performing select queries in the database to see how the data has changed.

To load a PostGIS layer in QGIS, use the Layer » Add PostGIS Layers menu option or toolbar button:
2

This will open the dialog:
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800 Add PostCIS Table(s)
Connections
Connect |[ New || Edit Delete l Load ] l Save ]
Schema v Table Column Data Type Spatial Type SRID

[ | Also list tables with no geometry

-
[ | Search options

[(Help ] = Add Set Filter | Close |

Click on the New button to open this dialog:
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O O 0O  Create a New PostGIS connection
Connection Information

Name I

Service |

Host |

Port 5432

Database |
551 mode [ disable

Username |

Password |

| | Save Username

| | Save Password Test Connect

| | Only look in the layer registries

| | Don't resclve type of unrestricted columns (GEOMETRY)
| | Only look in the 'public’ schema

| | Also list tables with no geometry

| | Use estimated table metadata

Help | | Cancel | [_ox_]/

Then define a new connection, e.g.:

Name: myPG
Service:

Host: localhost
Port: 5432
Database: address
User:

Password:

To see whether QGIS has found the address database and that your username and password are correct, click
Test Connect. If it works, check the boxes next to Save Username and Save Password. Then click OK to create this
connection.

Back in the Add PostGIS Layers dialog, click Connect and add layers to your project as usual.
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Try Yourself /

Formulate a query that shows a person’s name, street name and position (from the the_geom column) as plain text.

Check your results

16.2.8 In Conclusion

You have seen how to add spatial objects to your database and view them in GIS software.

16.2.9 What’s Next?

Next you'll see how to import data into, and export data from, your database.

16.3 Lesson: Import and Export

Of course, a database with no easy way to migrate data into it and out of it would not be of much use. Fortunately,
there are a number of tools that will let you easily move data into and out of PostGIS.

16.3.1 shp2pgsq|l

shp2pgsql is a commandline tool to import ESRI Shapefile to the database. Under Unix, you can use the following
command for importing a new PostGIS table:

shp2pgsgl —-s <SRID> -c -D -I <path to shapefile> <schema>.<table> | \
psgl —-d <databasename> -h <hostname> -U <username>

Under Windows, you have to perform the import process in two steps:

shp2pgsgl -s <SRID> -c -D -I <path to shapefile> <schema>.<table> > import.sqgl
psgl psgl -d <databasename> -h <hostname> -U <username> -f import.sqgl

You may encounter this error:

ERROR: operator class "gist_geometry_ ops" does not exist for access method
" 1 n
gist

This is a known issue regarding the creation in situ of a spatial index for the data you're importing. To avoid the
error, exclude the —I parameter. This will mean that no spatial index is being created directly, and you’ll need to
create it in the database after the data have been imported. (The creation of a spatial index will be covered in the
next lesson.)

16.3.2 pgsql2shp

pgsql2shp is a commandline tool to export PostGIS Tables, Views or SQL select queries. To do this under Unix:

pgsql2shp —-f <path to new shapefile> —-g <geometry column name> \
-h <hostname> -U <username> <databasename> <table | view>

To export the data using a query:

pgsgl2shp —-f <path to new shapefile> —-g <geometry column name> \
—-h <hostname> -U <username> "<query>"
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16.3.3 ogr2ogr

ogr2ogr is a very powerful tool to convert data into and from postgis to many data formats. ogr2ogr is part of the
GDAL/OGR Software and has to be installed separately. To export a table from PostGIS to GML, you can use this
command:

ogr2ogr —-f GML export.gml PG:'dbname=<databasename> user=<username>
host=<hostname>' <Name of PostGIS-Table>

16.3.4 DB Manager
You may have noticed another option in the Database menu labeled DB Manager. This is a tool that provides a
unified interface for interacting with spatial databases including PostGIS. It also allows you to import and export

from databases to other formats. Since the next module is largely devoted to using this tool, we will only briefly
mention it here.

16.3.5 In Conclusion

Importing and exporting data to and from the database can be done in many various ways. Especially when using
disparate data sources, you will probably use these functions (or others like them) on a regular basis.

16.3.6 What’s Next?

Next we'll look at how to query the data we’ve created before.

16.4 Lesson: Spatial Queries

Spatial queries are no different from other database queries. You can use the geometry column like any other
database column. With the installation of PostGIS in our database, we have additional functions to query our
database.

The goal for this lesson: To see how spatial functions are implemented similarly to «normal» non-spatial functions.

16.4.1 Spatial Operators

When you want to know which points are within a distance of 2 degrees to a point(X,Y) you can do this with:

select *

from people

where st_distance (the_geom, 'SRID=4326;POINT (33 -34)") < 2;
Peszynbrar:

id | name | house_no | street_id | phone_no | the_geom
————e e ——— Fm—— o o Fm————
6 | Fault Towers | 34 | 3 ] 072 812 31 28 | 01010008040cC0

(1 row)

IIpumeuanue: the_geom value above was truncated for space on this page. If you want to see the point in human-
readable coordinates, try something similar to what you did in the section «View a point as WKT», above.
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How do we know that the query above returns all the points within 2 degrees? Why not 2 meters? Or any other unit,
for that matter?

Check your results

16.4.2 Spatial Indexes

We also can define spatial indexes. A spatial index makes your spatial queries much faster. To create a spatial index
on the geometry column use:

CREATE INDEX people_geo_idx
ON people
USING gist
(the_geom) ;

\d people

Pesynprar:

Table "public.people"

Column | Type | Modifiers
___________ S
id | integer | not null default
| | nextval ('people_id _seq'::regclass)
name | character wvarying (50) |
house_no | integer | not null
street_id | integer | not null
phone_no | character wvarying |
the_geom | geometry |
Indexes:

"people_pkey" PRIMARY KEY, btree (id)
"people_geo_idx" gist (the_geom) <-—- new spatial key added
"people_name_idx" btree (name)

Check constraints:
"people_geom_point_chk" CHECK (st_geometrytype (the_geom) = 'ST_Point'::text
OR the_geom IS NULL)

Foreign-key constraints:
"people_street_id_fkey" FOREIGN KEY (street_id) REFERENCES streets (id)

16.4.3 Try Yourself /

Modify the cities table so its geometry column is spatially indexed.

Check your results

16.4.4 PostGIS Spatial Functions Demo

In order to demo PostGIS spatial functions, we’ll create a new database containing some (fictional) data.

To start, create a new database (exit the psql shell first):

’createdb postgis_demo

Remember to install the postgis extensions:

’psql -d postgis_demo -c "CREATE EXTENSION postgis;"
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Next, import the data provided in the exercise_data/postgis/ directory. Refer back to the previous lesson
for instructions, but remember that you'll need to create a new PostGIS connection to the new database. You can
import from the terminal or via DB Manager. Import the files into the following database tables:

¢ points.shpintobuilding
e lines.shpinto road
¢ polygons.shp into region

Load these three database layers into QGIS via the Add PostGIS Layers dialog, as usual. When you open their
attribute tables, you'll note that they have both an id field and a gid field created by the PostGIS import.

Now that the tables are imported, we can use PostGIS to query the data. Go back to your terminal (command line)
and enter the psql prompt by running:

psgl postgis_demo

We’ll demo some of these select statements by creating views from them, so that you can open them in QGIS and
see the results.

Select by location

Get all the buildings in the KwaZulu region:

SELECT a.id, a.name, st_astext(a.the_geom) as point
FROM building a, region b
WHERE st_within(a.the_geom, b.the_geom)

AND b.name = 'Kwazulu';
Pesynprar:
id | name | point
+ +
30 | York | POINT(1622345.23785063 6940490.65844485)
33 | York | POINT(1622495.65620524 6940403.87862489)
35 | York | POINT(1622403.09106394 6940212.96302097)
36 | York | POINT(1622287.38463732 6940357.59605424)
40 | York | POINT(1621888.19746548 6940508.01440885)
(5 rows)

Or, if we create a view from it:

CREATE VIEW vw_select_location AS
SELECT a.gid, a.name, a.the_geom
FROM building a, region b
WHERE st_within(a.the_geom, b.the_geom)
AND b.name = 'Kwazulu';

Add the view as a layer and view it in QGIS:
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1620863.86,6938236 84 : 1624491.93,6940563.41

Coordnate Soalo 1233565585 1) (3] & Roncr EPSQ:6028

Select neighbors

Show a list of all the names of regions adjoining the Hokkaido region:

SELECT Db.name
FROM region a, region b
WHERE st_touches (a.the_geom, b.the_geom)
AND a.name = 'Hokkaido';

Pesynbrat:

Missouri
Saskatchewan
Wales

(3 rows)

As a view:

CREATE VIEW vw_regions_adjoining_hokkaido AS
SELECT b.gid, b.name, b.the_geom
FROM region a, region b
WHERE TOUCHES (a.the_geom, b.the_geom)
AND a.name = 'Hokkaido';

In QGIS:

474 naea 16. Module: Spatial Database Concepts with PostGIS




QGIS Training Manual

666 QGIS 2.0.1-Dufour
DOBELQIKNSLALANPLIAMLR & 6B e BE & 50 I BW
A / LI‘ Lﬁ /& 5 =% @8 [=g] LSRR

PR BRRBECOR® L C BB A KDEN ML

00 Layors

v ™  vw_regions_adjoining_hokkaido

v @ - ww_selsct location

v @ - bulding

5]

v @V rosd

PADHDIINSNMS |

<

61 S

TN Browser
1619011.83,6936223.12 : 1626836.32,6941240.73 [&] Coordinate: 1625604,6937291 Scale (133565585 |+ |§| (M Render EPSG:4326 (@) (4] y

Note the missing region (Queensland). This may be due to a topology error. Artifacts such as this can alert us to
potential problems in the data. To solve this enigma without getting caught up in the anomalies the data may have,
we could use a buffer intersect instead:

CREATE VIEW vw_hokkaido_buffer AS
SELECT gid, ST_BUFFER(the_geom, 100) as the_geom
FROM region
WHERE name = 'Hokkaido';

This creates a buffer of 100 meters around the region Hokkaido.

The darker area is the buffer:
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Select using the buffer:

CREATE VIEW vw_hokkaido_buffer_select AS
SELECT b.gid, b.name, b.the_geom
FROM
(
SELECT * FROM
vw_hokkaido_buffer

) al

region b

WHERE ST_INTERSECTS (a.the_geom, b.the_geom)
AND b.name != 'Hokkaido';

In this query, the original buffer view is used as any other table would be. It is given the alias a, and its geometry field,
a.the_geom, is used to select any polygon in the region table (alias b) that intersects it. However, Hokkaido
itself is excluded from this select statement, because we don’t want it; we only want the regions adjoining it.

In QGIS:
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It is also possible to select all objects within a given distance, without the extra step of creating a buffer:

CREATE VIEW vw_hokkaido_distance_select AS
SELECT b.gid, b.name, b.the_geom
FROM region a, region b
WHERE ST_DISTANCE (a.the_geom, b.the_geom) < 100
AND a.name = 'Hokkaido'
AND b.name != 'Hokkaido';

This achieves the same result, without need for the interim buffer step:
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Select unique values

Show a list of unique town names for all buildings in the Queensland region:

SELECT DISTINCT a.name
FROM building a, region b
WHERE st_within(a.the_geom, b.the_geom)
AND b.name = 'Queensland';

Pesynprar:

Beijing
Berlin
Atlanta
(3 rows)

Further examples ...

CREATE VIEW vw_shortestline AS
SELECT b.gid AS gid,
ST_ASTEXT (ST_SHORTESTLINE (a.the_geom, b.the_geom)) as text,
ST_SHORTESTLINE (a.the_geom, b.the_geom) AS the_geom
FROM road a, building b
WHERE a.id=5 AND b.id=22;

CREATE VIEW vw_longestline AS
SELECT b.gid AS gid,
ST_ASTEXT (ST_LONGESTLINE (a.the_geom, b.the_geom)) as text,
ST_LONGESTLINE (a.the_geom, b.the_geom) AS the_geom
FROM road a, building b
WHERE a.id=5 AND b.id=22;

CREATE VIEW vw_road_centroid AS
SELECT a.gid as gid, ST_CENTROID (a.the_geom) as the_geom
FROM road a
WHERE a.id = 1;

CREATE VIEW vw_region_centroid AS
SELECT a.gid as gid, ST_CENTROID (a.the_geom) as the_geom
FROM region a
WHERE a.name = 'Saskatchewan';

SELECT ST_PERIMETER (a.the_geom)
FROM region a
WHERE a.name='Queensland';

SELECT ST_AREA (a.the_geom)
FROM region a
WHERE a.name='Queensland';

CREATE VIEW vw_simplify AS
SELECT gid, ST_Simplify(the_geom, 20) AS the_geom
FROM road;

CREATE VIEW vw_simplify_more AS
SELECT gid, ST_Simplify(the_geom, 50) AS the_geom
FROM road;
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CREATE VIEW vw_convex_hull AS
SELECT
ROW_NUMBER () over (order by a.name) as id,
a.name as town,
ST_CONVEXHULL (ST_COLLECT (a.the_geom)) AS the_geom
FROM building a
GROUP BY a.name;

16.4.5 In Conclusion

You have seen how to query spatial objects using the new database functions from PostGIS.

16.4.6 What’s Next?

Next we're going to investigate the structures of more complex geometries and how to create them using PostGIS.

16.5 Lesson: Geometry Construction

In this section we are going to delve a little deeper into how simple geometries are constructed in SQL. In reality, you
will probably use a GIS like QGIS to create complex geometries using their digitising tools; however, understanding
how they are formulated can be handy for writing queries and understanding how the database is assembled.

The goal of this lesson: To better understand how to create spatial entities directly in PostgreSQL/PostGIS.

16.5.1 Creating Linestrings

Going back to our address database, let’s get our streets table matching the others; i.e., having a constraint on the
geometry, an index and an entry in the geometry_columns table.

16.5.2 Try Yourself /

* Modify the st reets table so that it has a geometry column of type ST_LineString.
* Don’t forget to do the accompanying update to the geometry columns table!
¢ Also add a constraint to prevent any geometries being added that are not LINESTRINGS or null.
* Create a spatial index on the new geometry column
Check your results

Now let’s insert a linestring into our streets table. In this case we will update an existing street record:

update streets
set the_geom = 'SRID=4326; LINESTRING (20 -33, 21 -34, 24 -33)"
where streets.id=2;

Take a look at the results in QGIS. (You may need to right-click on the streets layer in the ,Layers® panel, and
choose ,,Zoom to layer extent®.)

Now create some more streets entries - some in QGIS and some from the command line.
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16.5.3 Creating Polygons

Creating polygons is just as easy. One thing to remember is that by definition, polygons have at least four vertices,
with the last and first being co-located:

insert into cities (name, the_geom)
values ('Tokyo', 'SRID=4326;POLYGON( (10 -10, 5 -32, 30 -27, 10 -10))");

IIpumeuanne: A polygon requires double brackets around its coordinate list; this is to allow you to add complex
polygons with multiple unconnected areas. For instance

insert into cities (name, the_geom)
values ('Tokyo Outer Wards',
'"SRID=4326;POLYGON( (20 10, 20 20, 35 20, 20 10),
(-10 -30, -5 0, -15 -15, -10 =-30))"
)

If you followed this step, you can check what it did by loading the cities dataset into QGIS, opening its attribute
table, and selecting the new entry. Note how the two new polygons behave like one polygon.

16.5.4 Exercise: Linking Cities to People

For this exercise you should do the following:
¢ Delete all data from your people table.
* Add a foreign key column to people that references the primary key of the cities table.
* Use QGIS to capture some cities.
» Use SQL to insert some new people records, ensuring that each has an associated street and city.

Your updated people schema should look something like this:

\d people

Table "public.people"

Column | Type | Modifiers
___________ T

id | integer | not null

| | default nextval ('people_id_seq'::regclass)

name | character varying(50) |

house_no | integer | not null

street_id | integer | not null

phone_no | character varying |

the_geom | geometry |

city_id | integer | not null
Indexes:

"people_pkey" PRIMARY KEY, btree (id)
"people_name_idx" btree (name)
Check constraints:
"people_geom_point_chk" CHECK (st_geometrytype (the_geom) =
'ST_Point'::text OR the_geom IS NULL)
Foreign-key constraints:
"people_city_id_fkey" FOREIGN KEY (city_id) REFERENCES cities (id)
"people_street_id_fkey" FOREIGN KEY (street_id) REFERENCES streets (id)

Check your results
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16.5.5 Looking at Our Schema

By now our schema should be looking like this:

cities

Oid
Unarme

Uthe_geom

16.5.6 Try Yourself

people

Oid

Uname
Uhaouse_no
U gireet_id
U phone_no
U ithe_geom
O city_id

streets

Oid
Hhname
Uthe_geom

Create city boundaries by computing the minimum convex hull of all addresses for that city and computing a buffer

around that area.

16.5.7 Access Sub-Objects

With the SFS-Model functions, you have a wide variety of options to access sub-objects of SFS Geometries. When
you want to select the first vertex point of every polygon geometry in the table myPolygonTable, you have to do

this in this way:

 Transform the polygon boundary to a linestring:

select st_boundary (geometry)

from myPolygonTable;

* Select the first vertex point of the resultant linestring:

from (

select st_boundary (geometry)
from myPolygonTable)

select st_startpoint (myGeometry)

as foo;

as myGeometry

16.5.8 Data Processing

PostGIS supports all OGC SFS/MM standard conform functions. All these functions start with ST_.
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16.5.9 Clipping

To clip a subpart of your data you can use the ST_INTERSECT () function. To avoid empty geometries, use:

where not st_isempty(st_intersection(a.the_geom, b.the_geom))

\\‘:I «

select st_intersection(a.the_geom, b.the_geom), b.*

from clip as a, road_lines as b

where not st_isempty(st_intersection(st_setsrid(a.the_geom, 32734),
b.the_geom));
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16.5.10 Building Geometries from Other Geometries

From a given point table, you want to generate a linestring. The order of the points is defined by their id. Another
ordering method could be a timestamp, such as the one you get when you capture waypoints with a GPS receiver.
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To create a linestring from a new point layer called ,,points®, you can run the following command:

select ST_LineFromMultiPoint (st_collect (the_geom)), 1 as id
from (

select the_geom

from points

order by id
) as foo;

To see how it works without creating a new layer, you could also run this command on the ,,people” layer, although
of course it would make little real-world sense to do this.
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16.5.11 Geometry Cleaning

You can get more information for this topic in this blog entry.

16.5.12 Differences between tables

To detect the difference between two tables with the same structure, you can use the PostgreSQL keyword EXCEPT:

select * from table_a
except
select * from table_b;

As the result, you will get all records from table_a which are not stored in table_b.
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16.5.13 Tablespaces

You can define where postgres should store its data on disk by creating tablespaces:

’CREATE TABLESPACE homespace LOCATION '/home/pg'; ‘

When you create a database, you can then specify which tablespace to use e.g.:

’createdb ——tablespace=homespace t4a

16.5.14 In Conclusion

You've learned how to create more complex geometries using PostGIS statements. Keep in mind that this is mostly
to improve your tacit knowledge when working with geo-enabled databases through a GIS frontend. You usually
won't need to actually enter these statements manually, but having a general idea of their structure will help you
when using a GIS, especially if you encounter errors that would otherwise seem cryptic.
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The QGIS processing guide

This module contributed by Victor Olaya and Paolo Cavallini.

Contents:

17.1 BBepeHue

This guide describes how to use the QGIS processing framework. It assumes no previous knowledge of the
Processing framework or any of the applications that it rely on. It assumes basic knowledge of QGIS. The chapters
about scripting assume you have some basic knowledge of Python and maybe the QGIS Python API.

This guide is designed for self-study or to be used for running a processing workshop.
Examples in this guide use QGIS 3.4. They might not work or not be available in versions other than that one.

This guide is comprised of a set of small exercises of progressive complexity. If you have never used the processing
framework, you should start from the very beginning. If you have some previous experience, feel free to skip lessons.
They are more or less independent of each other, and each one introduces some new concept or some new element,
as indicated in the chapter title and the short introduction at the beginning of each chapter. That should make it easy
to locate lessons dealing with a particular topic.

For a more systematic description of all the framework components and their usage, it is recommended to check
the corresponding chapter in the user manual. Use it as a support text along with this guide.

All the exercises in this guide use the same free dataset used throughout the training manual and referenced at
section /Jannwie. The zip file to download contains several folders corresponding to each one of the lessons in this
guide. In each of them you will find a QGIS project file. Just open it and you will be ready to start the lesson.

Enjoy!
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17.2 An important warning before starting

Just like the manual of a word processor doesn’t teach you how to write a novel or a poem, or a CAD tutorial doesn’t
show you how to calculate the size of a beam for a building, this guide will not teach you spatial analysis. Instead,
it will show you how to use the QGIS Processing framework, a powerful tool for performing spatial analysis. It is
up to you to learn the required concepts that are needed to understand that type of analysis. Without them, there is
no point in using the framework and its algorithms, although you might be tempted to try.

Let’s show this more clearly with an example.

Given a set of points and a value of a given variable value at each point, you can calculate a raster layer from them
using the Kriging geoalgorithm. The parameters dialog for that module is like the following one.

Ordinary Kriging

Parameters | Log

Points =
points [EPSG:27700] v | e[| @

Attribute

123 |d =

Type of Quality Measure

v Logarithmic Transformation

v Block Kriging

Block Size

100.000000 -
Maximum Distance

-1.000000 =
Lag Distance Classes

100 v
Skip

1 a
Variogram Model

at+b*x

Output extent (xmin, xmax, ymin, ymax) [optional]

[Leave blank to use min covering extent]

Cellsize

1.000000 =
Fit

Search Range

0%

Run as Batch Process...  Close | Run |

It looks complex, right?

By reading this manual, you will learn things such as how to use that module, how to run it in a batch process to
create raster layers from hundreds of points layers in a single run, or what happens if the input layer has some
points selected. However, the parameters themselves are not explained. A seasoned analyst with a good knowledge
of geostatistics will have no problem understanding those parameters. If you are not one of them and sill, range, or
nugget are not familiar concepts to you, then you should not use the Kriging module. More than that, you are far from
being ready to use the Kriging module, since it requires learning about concepts such as spatial autocorrelation or
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semivariograms, which probably you also haven’t heard before, or at least haven’t studied long enough. You should
first study and understand them, and then come back to QGIS to actually run it and perform the analysis. Ignoring
this will result in wrong results and poor (and most likely useless) analysis.

Although not all algorithms are as complex as kriging (but some of them are even more complex!), almost all of
them require understanding the fundamental analysis ideas that they are based on. Without that knowledge, using
them will most likely lead to poor results.

Using geoalgorithms without having a good foundation of spatial analysis is like trying to write a novel without
knowing anything about grammar or syntax, and having no knowledge about storytelling. You might get a result, but
it is likely to have no value at all. Please, don’t fool yourself and think that after reading this guide you are already
capable of performing spatial analysis and get sound results. You need to study spatial analysis as well.

Here is a good reference that you can read to learn more about spatial data analysis.

Geospatial Analysis (3rd Edition): A Comprehensive Guide to Principles, Techniques and Software Tools Michael
John De Smith, Michael F. Goodchild, Paul A. Longley

It is available online here

17.3 Setting-up the processing framework

The first thing to do before using the processing framework is to configure it. There is not much to set-up, so this
is an easy task.

Later on we will show how to configure the external applications that are used for extending the list of available
algorithms, but for now we are just going to work with the framework itself.

The processing framework is a core QGIS plugin, which means that it should already be installed in your system,
since it is included with QGIS. In case it is active, you should see a menu called Processing in your menu bar. There
you can access all the framework components.

Processing s

] Toolbox Ctrl+Alt+T
#: Graphical Modeler... Ctri+Alt+M
(L) History... Ctrl+Alt+H
= Results Viewer Ctri+Alt+R

Edit Features In-Place

If you cannot find that menu, you have to enable the plugin by going to the plugin manager and activating it.
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Plugins | Installed (36)

| @ processing a |

* Processing This is a core plugin, so you can't uninstall it

Processing
2% Upgradeable
* New Spatial data processing framework for QGIS
¥ Install from ZIP Spatial data processing framework for QGIS

£ settings

Category Analysis
More info homepage bug tracker code repository
Author Victor Olaya

Installed version 2.12.99

| Upgrade All |

| [@Help | | # Close |

The main element that we are going to work with is the toolbox. Click on the corresponding menu entry and you
will see the toolbox docked at the right side of the QGIS window.
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Processing Toolbox S
ey & E B

» (Y Recently used
Cartography
Database
File tools
Graphics
Interpolation
Layer tools
MWetwork analysis
Raster analysis
Raster terrain analysis
Raster tools

Vector analysis
Vector creation
Vector general
Vector geometry
Vector overlay
Vector selection
Vector table

GDAL

GRASS

» ¥ Models

ERDDDDDDDDDDDLDDDDL

Browser | Processing Toolbox

The toolbox contains a list of all the available algorithms, divided in groups called Providers. Providers can be
(de)activated in the Settings » Options » Processing. We will discuss that dialog later in this manual.

By default, only providers that do not rely on third-party applications (that is, those that only require QGIS elements
to be run) are active. Algorithms requiring external applications might need additional configuration. Configuring
providers is explained in a later chapter in this manual.

If you have reached this point, now you are ready to use geoalgorithms. There is no need to configure anything else
by now. We can already run our first algorithm, which we will do i